1. Introduction .......................................................................................................................... 5
  1.1. About This User Guide ........................................................................................................ 6
  1.2. M-Files Terminology .......................................................................................................... 7
  1.3. Getting Started with M-Files .............................................................................................. 11
    1.3.1. Opening M-Files Desktop and Accessing a Vault ...................................................... 13
    1.3.2. Getting Familiar with the M-Files User Interface ..................................................... 15
    1.3.3. Searching for Documents ........................................................................................... 17
    1.3.4. Getting Familiar with Using Metadata ....................................................................... 18
    1.3.5. Getting Familiar with Documents and Other Object Types .................................... 19
    1.3.6. Creating New Objects and Saving Documents to M-Files ......................................... 20
    1.3.7. Using Document Templates ....................................................................................... 25
    1.3.8. Saving Emails from Microsoft Outlook to M-Files ................................................... 31
    1.3.9. Getting Familiar with Views ......................................................................................... 33
    1.3.10. Working Offline ........................................................................................................... 33
  2. Daily Use .................................................................................................................................. 35
    2.1. Getting Familiar with the User Interface .......................................................................... 36
      2.1.1. Logging in to and out of the Vault .............................................................................. 37
      2.1.2. M-Files Desktop User Interface .............................................................................. 38
      2.1.3. Accessing M-Files with M-Files Web ...................................................................... 53
      2.1.4. Accessing M-Files with M-Files Mobile ................................................................. 54
      2.1.5. Keyboard Shortcuts in M-Files Desktop ................................................................. 56
      2.1.6. Offline Use .................................................................................................................. 56
      2.1.7. Adding New Content to a Vault ................................................................................ 57
      2.1.8. Removing and Archiving Content ............................................................................ 98
      2.1.9. Editing Content .......................................................................................................... 99
      2.1.10. Object Relationships ............................................................................................... 120
      2.1.11. Document Collections ........................................................................................... 124
      2.1.12. Offline Use .............................................................................................................. 125
    2.2. Managing Content ........................................................................................................... 56
      2.2.1. Adding New Content to a Vault ................................................................................ 57
      2.2.2. Removing and Archiving Content ............................................................................ 98
      2.2.3. Editing Content ......................................................................................................... 99
      2.2.4. Object Relationships ............................................................................................... 120
      2.2.5. Document Collections ........................................................................................... 124
      2.2.6. Offline Use .............................................................................................................. 125
      2.2.7. Editing Content ......................................................................................................... 99
      2.2.8. Object Relationships ............................................................................................... 120
      2.2.9. Document Collections ........................................................................................... 124
      2.2.10. Offline Use ............................................................................................................. 125
    2.3. Sharing Content .............................................................................................................. 128
      2.3.1. Sharing Links and Shortcuts .................................................................................... 129
      2.3.2. Sharing Public Links ............................................................................................... 133
      2.3.3. Sharing, E-mail and PDF ......................................................................................... 135
    2.4. Finding Content .............................................................................................................. 136
      2.4.1. Searching .................................................................................................................. 137
      2.4.2. Using Views .............................................................................................................. 166
    2.5. User Settings ................................................................................................................... 186
      2.5.1. M-Files Desktop Settings ......................................................................................... 186
      2.5.2. Editing Notification Settings in M-Files Desktop ..................................................... 200
      2.5.3. Managing Vault Applications in M-Files Desktop .................................................... 206
      2.5.4. Substitute Users ....................................................................................................... 207
      2.5.5. Changing the Software and Vault Language ............................................................ 208
      2.5.6. Changing the M-Files Password .............................................................................. 209
      2.5.7. Clearing the Local Cache of the Vault ...................................................................... 209
      2.5.8. Show Status ............................................................................................................. 211
      2.5.9. Refreshing External Objects ..................................................................................... 212
      2.5.10. Updating M-Files .................................................................................................... 212
3. System Administration................................................................. 215
   3.1. Setting Up and Maintaining M-Files........................................... 215
      3.1.1. System Overview................................................................. 216
      3.1.2. Installing and Upgrading M-Files....................................... 224
      3.1.3. M-Files Admin................................................................. 245
      3.1.4. Server Connections......................................................... 247
      3.1.5. Managing Document Vaults.............................................. 272
   3.2. Configuring M-Files............................................................... 404
      3.2.1. Editing the Vault Metadata Structure................................. 405
      3.2.2. Managing Users and User Groups..................................... 491
      3.2.3. Configuring Workflows.................................................... 509
      3.2.4. Named Access Control Lists............................................ 541
      3.2.5. Installing and Managing Vault Applications...................... 547
      3.2.6. Using the Configurations Editor....................................... 549
      3.2.7. Editing Notification Settings in M-Files Admin.................. 564
      3.2.8. Setting Up Web and Mobile Access to M-Files.................... 575
      3.2.9. Reporting and Data Export............................................... 586
      3.2.10. Event Handlers and Scripts............................................. 596
      3.2.11. Intelligent Metadata Layer............................................. 625
      3.2.12. Customizing Server and Vault Behavior............................ 645
   3.2.13. Event Handlers and Scripts............................................... 596
   3.2.14. Intelligent Metadata Layer.............................................. 625
   3.2.15. Customizing Server and Vault Behavior.............................. 645

4. FAQ............................................................................................ 682
   4.1. Daily Use of M-Files............................................................... 684
      4.1.1. Can I do the same stuff with M-Files Mobile as with M-Files Desktop? 684
      4.1.2. How can I add a new item to a value list?........................... 687
      4.1.3. How can I add a new property to a class?............................ 687
      4.1.4. How can I create a document that is only visible to me?......... 687
      4.1.5. How can I create a new view in which the objects are displayed by customer? 687
      4.1.6. How can I find the documents I have created myself?............ 688
      4.1.7. How do I change the name of my computer without interfering with M-Files functionality? 688
      4.1.8. Why can't I edit a document that has been checked out?........ 688
   4.2. Administration of M-Files....................................................... 689
      4.2.1. How can I add a new item to a value list?........................... 689
      4.2.2. How can I add a new user to the document vault?................ 689
      4.2.3. How can I add a new property to a class?............................ 691
      4.2.4. How do I change the login account of a user?....................... 691
      4.2.5. How do I format the date in M-Files?.................................. 692
      4.2.6. How do I import e-mail messages from a specific IMAP folder? 693
      4.2.7. What is the difference between a user and a login account?.... 694
      4.2.8. Why are there objects with the same ID in the vault?............. 694
      4.2.9. Why does the intelligence service not extract metadata from some of the files? .... 695
   4.3. Maintenance of M-Files.......................................................... 695
      4.3.1. How do I maintain the M-Files server machine?.................... 696
      4.3.2. Why is my M-Files not as fast as it used to be?.................... 700
      4.3.3. How do I migrate my document vaults to a new server?.......... 705
      4.3.4. How do the automatic updates work?................................... 709
      4.3.5. How much disk space do encrypting file data and taking backups require? 710
      4.3.6. How often should I make backups?..................................... 710
      4.3.7. How often should I reboot the M-Files server machine?........... 711
      4.3.8. What is not included in the backups?................................. 711
      4.3.9. What kind of operations can I schedule to be run at specific intervals in M-Files? ... 712
      4.3.10. How do I check the location of the active search indexes?..... 712

  4.4.1. Why can't I access the document vault? .............................................................. 715
  4.4.2. Why can't I convert a document to PDF format or annotate a document? ....... 715
  4.4.3. Why can't I find the Checked Out to Me view? ................................................. 717
  4.4.4. Why can't I save an e-mail message as an Outlook message to M-Files? ....... 717
  4.4.5. Why did a file with a grayed-out icon appear on the M-Files drive when I saved a
         new document in Microsoft Word? ................................................................. 717
  4.4.6. Why do document timestamps have the wrong time? ....................................... 717
4.5. General Questions ................................................................................................... 717
  4.5.1. Where can I find more information when I need it? ........................................... 718
  4.5.2. What are the hardware requirements and recommendations? ......................... 718
  4.5.3. What's new in this M-Files version? ................................................................. 718
  4.5.4. How do the automatic updates work? ............................................................... 719
  4.5.5. Can I use M-Files programmatically? .............................................................. 719
  4.5.6. How do I write VBScript code for M-Files purposes? ..................................... 719
  4.5.7. What is the difference between a named access control list (NACL) and a user
         group? .............................................................................................................. 724

5. Support .................................................................................................................... 726

6. Add-on Tools ........................................................................................................... 729
  6.1. M-Files Process Maps Tool .................................................................................. 729
  6.1.1. Introduction to M-Files Process Maps ............................................................ 729
  6.1.2. Designing Process Maps ................................................................................ 743

Index ............................................................................................................................ 758
1. Introduction

This section introduces common M-Files terminology, a getting started guide for new users as well as information about this user guide.

M-Files® intelligent information management software helps you easily store, organize, and access all kinds of documents and information. Our revolutionary approach organizes content based on what something is (and what it relates to) instead of where it is stored.

M-Files can be deployed on-premise, in the cloud, or a hybrid of both. For more information, see System Overview.

Accessing the user guide

You can access this help documentation anytime M-Files is active by pressing the F1 key on your keyboard. Opening the user guide via F1 adds the advantage of directly accessing a topic that is related to what you are doing at the moment in M-Files.

You can also open the documentation via the M-Files icon on the Windows notification area, as well as via numerous help buttons in the M-Files user interface.

In addition, the user guide is available as a PDF version. You can download it by clicking the PDF icon in the upper right corner of the web help documentation.

This user guide contains a number of typographic and writing conventions as well as visual elements that will help you to better understand information and to perform tasks instructed in this guide. For a comprehensive list of these conventions, see About This User Guide.
Additional documentation

For more information, consult the following sources:

- M-Files knowledge base
- M-Files Community

If you are a developer or an M-Files system administrator, you might be interested in our documentation for:

- M-Files API
- M-Files Web Service
- M-Files UI Extensibility Framework

For a full list of M-Files documentation, please visit m-files.com.

In this chapter

- About This User Guide
- M-Files Terminology
- Getting Started with M-Files

1.1. About This User Guide

This user guide contains a number of typographic and writing conventions as well as visual elements that will help you to better understand information and to perform tasks.

Terms and writing conventions

The following writing conventions are used in this user guide:

<table>
<thead>
<tr>
<th>Writing convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;version&gt;</td>
<td>Indicates that you must replace the text enclosed in angled brackets with information specific to your installation or environment. For example, in the registry path <code>HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files\&lt;version&gt;\Client</code>, you would replace <code>&lt;version&gt;</code> with the version number of your specific M-Files installation.</td>
</tr>
<tr>
<td>File &gt; Save</td>
<td>The &gt; symbol indicates that you need to select an item from a menu. For example, Settings &gt; Applications indicates that you need to open the menu bar and select the Applications item from the Settings menu.</td>
</tr>
<tr>
<td>Optional</td>
<td>Indicates that a step in a task is optional and up to the users to decide whether or not they need to complete the step.</td>
</tr>
<tr>
<td>Info</td>
<td>Highlights important information related to a specific step in a task. This information is always listed under the related step.</td>
</tr>
<tr>
<td>Example</td>
<td>Highlights an example of how a given step should be completed. This information is always listed under the related step.</td>
</tr>
</tbody>
</table>
### Writing convention

<table>
<thead>
<tr>
<th>Writing convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result</td>
<td>Highlights a description of the expected results for successfully completing a task step.</td>
</tr>
</tbody>
</table>

For a list of terms commonly referenced in this user guide, see M-Files Terminology.

### Typographic conventions

The following typographic conventions are used in this user guide:

<table>
<thead>
<tr>
<th>Typographic convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bold</strong></td>
<td>Bolded text indicates user interface elements, such as buttons, menu items, and dialog names.</td>
</tr>
<tr>
<td></td>
<td>Examples:</td>
</tr>
<tr>
<td></td>
<td>Click OK to continue.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Object Type Properties</strong> dialog is opened.</td>
</tr>
<tr>
<td><strong>Blue text</strong></td>
<td>Blue underlined text indicates hyperlinks. There are mainly three types of hyperlinks in this user guide:</td>
</tr>
<tr>
<td></td>
<td>• Links leading to other parts in the user guide</td>
</tr>
<tr>
<td></td>
<td>• Links leading to M-Files knowledge base articles</td>
</tr>
<tr>
<td></td>
<td>• Links leading to external pages</td>
</tr>
</tbody>
</table>

### Main heading

The main heading of a single topic.

### Section heading

These headings further divide the main topic into smaller sections.

### 1.2. M-Files Terminology

The following table describes daily M-Files terminology.

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-Files software</td>
<td>The M-Files document management software consists of the following components: <em>M-Files Desktop</em>, <em>M-Files Admin</em>, <em>M-Files Desktop Settings</em>, <em>Show Status</em> and <em>M-Files Server</em>. You can also use M-Files with a web browser (see Accessing M-Files with M-Files Web) or a mobile device (see Accessing M-Files with M-Files Mobile).</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>File vs. document</td>
<td>An example of a file is a memo created using Microsoft Word and saved on the C:\ drive. The file becomes a document only after you have associated metadata with it. Once you have installed M-Files and start transferring existing files to M-Files, you add metadata to the files to make them documents. In addition to documents, an M-Files vault can also store other types of objects, such as customers, assignments, or project data.</td>
</tr>
<tr>
<td>Multi-file document</td>
<td>A multi-file document is a special M-Files document type that can contain more than one file. The files share one set of metadata. Typical uses include linking of an electronic document with its signed and scanned counterpart, an email and all its attachments, or any such case where files need to be linked together and treated as one unit.</td>
</tr>
<tr>
<td>Metadata</td>
<td><em>Metadata</em> consists of information about the document's properties, such as the parties of a contract or the recipient of a letter. Metadata is used to, for example, search for and organize documents.</td>
</tr>
<tr>
<td>Document and object permissions</td>
<td>Each document can be assigned <em>permissions</em> to specify the access rights of a <em>user</em> or <em>user group</em>. The permissions can be either allowed or denied separately. One user can have <em>allowed</em> or <em>denied</em> permissions in two different ways: the permissions have been specified for that particular user, or the user belongs to a user group for which the permissions have been specified. If no permissions have been specified for a user, the user cannot view the document or access it in any way. If certain permissions have been allowed, the user can perform the procedures determined by these permissions.</td>
</tr>
<tr>
<td>Vault</td>
<td>A vault is a centralized storage location for documents and other objects. Its physical location is on the server running M-Files Server. Regardless of the physical location, all users see the document vault as a directory on their local computer's M-Files drive. This means that using a document vault is similar to using a local hard drive.</td>
</tr>
<tr>
<td>View</td>
<td>Views are locations in which the documents and other objects are listed based on the metadata they contain.</td>
</tr>
<tr>
<td>Virtual folder</td>
<td>The objects and documents in the views include virtual folders (property folders). Virtual folders enable sorting documents in the view into categories.</td>
</tr>
<tr>
<td>Traditional folder</td>
<td>You can create <em>traditional folders</em> in M-Files. These folders do not have the additional properties provided by views. Traditional folders are comparable to, for example, folders on your C:\ drive and can be used for importing files to M-Files. Traditional folders allow you to retain the original folder structure of the imported files.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Client</strong></td>
<td>A <em>client</em> is the regular M-Files user’s computer or mobile device and the software installed on it. The regular user performs operations like creating documents and exploring the document vault.</td>
</tr>
<tr>
<td><strong>Object type</strong></td>
<td>By defining <em>object types</em>, you can create different types of objects. <em>Document</em> is one of such object types, one that every vault contains. In addition, the M-Files administrator can create other object types for the vault, such as <em>customer</em>, <em>contact</em>, and <em>project</em>. This way, you can use M-Files to, for example, store the company's customer and project databases.</td>
</tr>
<tr>
<td><strong>Object</strong></td>
<td>The term <em>object</em> refers to instances of various object types – that is, individual objects created using object types. For example, one contact person in the document vault is an object. Most functions are identical for documents and for other objects. This user guide often represents operations as being performed on documents, but the same operations are available for document sets and other objects. An individual document can therefore also be thought of as an object.</td>
</tr>
<tr>
<td><strong>Document</strong></td>
<td><em>Document collections</em> are collections of individual documents in the document vault. Each collection member document has its own metadata. In addition, the document collection has a collective set of metadata independently of member documents (compare with multi-file document). Each document in the collection can still be accessed as an individual document but also through the document collection.</td>
</tr>
<tr>
<td><strong>Relationships</strong></td>
<td>You can also define the <em>relationships</em> between objects. Using relationships you can, for example, indicate that two documents are related. Relationships enable easy tracking of all documents related to an issue.</td>
</tr>
<tr>
<td><strong>Template</strong></td>
<td>You can use another object as a template for creating a new object. When you select a template from the list, the metadata card adjusts itself to the specifications of the template object. Specify an object as a template by setting its <em>Is template</em> property to <em>Yes</em>.</td>
</tr>
<tr>
<td><strong>Workflow</strong></td>
<td>The M-Files Workflow feature enables modeling object lifecycles according to real world processes. The workflow is grouped into states that correspond to the working stages of the document or other object. The M-Files administrator can easily define workflows to meet company requirements. For more information on workflows, see Configuring Workflows.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Server</td>
<td>M-Files Server runs on a server computer. Clients connect to the server and retrieve data so that the contents of the document can be viewed on the clients. The server is the physical location of the document vault.</td>
</tr>
<tr>
<td>Login account</td>
<td>Login accounts are server-level (or in some cases vault-level) accounts that are used for authenticating users to M-Files Server. A login account can be associated with multiple users, but only one user per vault. Compare with users.</td>
</tr>
<tr>
<td>User</td>
<td>Users are vault-level objects that store user-specific settings and user history and that have permissions to perform specific operations in a vault. A user is linked to one and only one login account. Compare with login accounts.</td>
</tr>
<tr>
<td>Intelligent Metadata Layer</td>
<td>Intelligent Metadata Layer, abbreviated as IML, is a repository-neutral approach to intelligent information management that unifies information across the enterprise based on context, not on the system or folder in which the information is stored. In addition, IML categorizes documents and records automatically and provides metadata suggestions with the aid of artificial intelligence. See Intelligent Metadata Layer for more information.</td>
</tr>
<tr>
<td>Managed object</td>
<td>A managed object is either an internal M-Files object stored in a document vault or a promoted external repository object. Managed objects have metadata in M-Files and can be managed using various M-Files functionalities, such as version history or workflows. A managed external repository object can be demoted to an unmanaged object by removing its metadata. Compare with unmanaged object.</td>
</tr>
<tr>
<td>Unmanaged object</td>
<td>An unmanaged object in M-Files represents a file in an external repository. An unmanaged object does not have M-Files metadata and it cannot be managed via M-Files version history or workflows. An unmanaged object can be promoted into a managed object by adding metadata to it. Compare with managed object.</td>
</tr>
<tr>
<td>Repository</td>
<td>A repository is any accessible place where information can be stored and accessed, such as an M-Files document vault, or an external location such as a network folder or a SharePoint site. Compare with external repository.</td>
</tr>
<tr>
<td>External repository</td>
<td>A repository that is other than an M-Files vault and the contents of which are displayed and can be edited via the M-Files user interfaces. Compare with repository.</td>
</tr>
</tbody>
</table>
### 1.3. Getting Started with M-Files

This section helps you to get up to speed with M-Files. If you are new to M-Files, it is recommended that you read the entire section before you start using M-Files.

This section assumes that M-Files is already installed and ready to use. For instructions on installing M-Files, see Installing and Upgrading M-Files.

There are three ways you can use M-Files:

- **M-Files Desktop** is a desktop application available for the Microsoft Windows operating system.
- **M-Files Web** is a web application that runs natively in most web browsers.
- **M-Files Mobile** is a mobile application available for iOS and Android devices.
M-Files Desktop

The M-Files desktop application is the premier tool for using M-Files. It is equipped with all the features and functions available in the M-Files ecosystem, and therefore it is the go-to choice for power users whose day-to-day M-Files activities typically involve creating and editing documents.

M-Files Desktop is a native Microsoft Windows application that runs on all the latest Windows versions. For a complete list of compatible Microsoft Windows versions, see System Requirements.

To get yourself started and comfortable with M-Files Desktop, complete these quick tutorials:

1. Opening M-Files Desktop and Accessing a Vault
2. Getting Familiar with the M-Files User Interface
3. Searching for Documents
4. Getting Familiar with Using Metadata
5. Getting Familiar with Documents and Other Object Types
6. Creating New Objects and Saving Documents to M-Files
7. Using Document Templates
8. Saving Emails from Microsoft Outlook to M-Files
9. Getting Familiar with Views
10. Working Offline

M-Files Web

M-Files can also be accessed using a web browser. M-Files Web is implemented using modern web technologies and standards, such as HTML5, JavaScript, and Ajax. It aims to offer a similar user experience as M-Files Desktop, and as such, it offers most of the same features as the desktop application. For more information, see Accessing M-Files with M-Files Web.

M-Files Mobile

The M-Files mobile applications allow you to use M-Files and access document vaults on your mobile device. Many of the features of M-Files Desktop are also available in the mobile applications. For a feature comparison between M-Files Mobile and M-Files Desktop, see Can I do the same stuff with M-Files Mobile as with M-Files Desktop?
More information

For additional introductory information, see the M-Files Guided Tour section on our website. Once you are familiar with the basics of M-Files and want to know more, this user guide is a great reference to the features and benefits of the M-Files software.

In this chapter

- Opening M-Files Desktop and Accessing a Vault
- Getting Familiar with the M-Files User Interface
- Searching for Documents
- Getting Familiar with Using Metadata
- Getting Familiar with Documents and Other Object Types
- Creating New Objects and Saving Documents to M-Files
- Using Document Templates
- Saving Emails from Microsoft Outlook to M-Files
- Getting Familiar with Views
- Working Offline

1.3.1. Opening M-Files Desktop and Accessing a Vault

You can open M-Files Desktop via the shortcut icon on the Microsoft Windows desktop, via the M-Files icon on the Microsoft Windows notification area, or by accessing the M-Files drive via File Explorer.

Do the following steps to open M-Files Desktop:

1. Either:
   a. Double-click the shortcut icon on the Microsoft Windows desktop:

   ![M-Files Desktop icon]

   or

   b. Double-click the M-Files icon on the Microsoft Windows notification area:

   ![M-Files notification area icon]
or

c. Open File Explorer, and then double-click the M-Files drive:

![File Explorer with M-Files drive]

2. Optional: Double-click the document vault that you want to access. If you have only one document vault connection, you are taken to the vault login prompt or home screen automatically.

3. Optional: Depending on your vault connection, you may need to provide your M-Files credentials to log in. Enter your username and password, and then click OK to continue:

![Log In to M-Files]

You are now greeted with the home screen of the vault. You can quickly access different areas of the vault via the home screen. For more information, see Home screen.
Now that you have successfully opened M-Files Desktop and accessed a vault, the next logical step is to get accustomed to the M-Files user interface. Proceed to Getting Familiar with the M-Files User Interface.

1.3.2. Getting Familiar with the M-Files User Interface

The M-Files Desktop user interface bears a close resemblance to Microsoft Windows File Explorer. If you are a seasoned Microsoft Windows user, you will feel right at home using M-Files.

The M-Files Desktop user interface is composed of four main parts:

- **The task area** (A) on the left contains frequently used commands and shortcuts.
- **The right pane** (B) displays the Metadata, Preview, Filters, and Pinned tabs.
- **The quick search** bar (C) on the top allows you to search for documents and other objects in M-Files.
- **The listing area** (D) in the center lists views, objects, and your search results.
Task area

The task area contains frequently used commands and shortcuts divided into separate sections. You can, for example, create a new document or other object by clicking the appropriate command under the Create section in the task area. You can customize the task area to better suit your needs.

For more information, see Task Area.

Tip: If the task area is not visible, you can display it by clicking the gray, vertical tab on left edge of the user interface.

Right pane

In the right pane, you can alternate between the Metadata, Preview, Filters, and Pinned tabs.

The Metadata tab displays the metadata card of the currently selected object. Every object in M-Files is associated with metadata, which allows objects to be organized and located on the basis of subject terms describing a document or any other object. The metadata card is a tool for viewing and modifying object metadata. For more information, see Metadata Card.

The Preview tab allows you to preview the contents of the currently selected document. For more information, see Preview.

The Filters tab contains options for narrowing or broadening your search. The tab is automatically opened whenever you activate the search bar. For more information, see The Filters Tab.

The Pinned tab allows you to collect items that you frequently use into a single tab. The Pinned tab is a visual collection of shortcuts that provides quick access to resources, such as objects in the vault. For more information, see The Pinned Tab.
Quick search

The quick search at the top of the user interface allows you to search for documents and other objects in M-Files. For a quick tutorial on using M-Files search features, see Searching for Documents. For a more thorough description of the different search functions, see Searching.

Listing area

The listing area normally contains views and objects. The area functions very similarly to the one in File Explorer in Microsoft Windows. In M-Files Desktop, however, users can expand or collapse objects to view and hide, for instance, the content of a multi-file document. For more information, see Listing area.

For more information on the M-Files Desktop user interface, see M-Files Desktop User Interface.

Now that you are familiar with the M-Files Desktop user interface, proceed to Searching for Documents for a tutorial on using the search functions of M-Files.

1.3.3. Searching for Documents

Quick Search at the top of the user interface allows you to search for documents and other objects in M-Files. Use multiple keywords in your search to limit your search results: instead of searching for the word proposal, try proposal followed by the customer name:

You can use the search options and the Filters tab in conjunction with Quick Search to narrow or broaden your search. You can display the search options by clicking the search options button ( ) and the search filters by clicking the Filters tab. Enter the appropriate search options and then click the search button ( ), or use the the search filters in the right pane, to refine your search.

For more information on M-Files search functions, see Searching.
Now that you are familiar with the search functions of M-Files, proceed to Getting Familiar with Using Metadata to familiarize yourself with using metadata in M-Files.

1.3.4. Getting Familiar with Using Metadata

Metadata is used to further describe documents and objects in M-Files. Typical metadata properties are, for instance, Class, Customer, and Project. Metadata properties, in turn, have their own property values. The value of the Class property, for example, can be Proposal or Employment Agreement. Every object in M-Files has a metadata card, which can be used for viewing and modifying the metadata of an object.
Notice that metadata properties are class-specific in M-Files. Some properties are mandatory and some optional. Your administrator can configure the metadata structure of your M-Files document vault using the M-Files Admin tool.

All documents in M-Files are tagged with metadata. Metadata makes it easier to find the information you are looking for in the vault. Regardless of the way documents are saved to M-Files, you always have to fill in the metadata card prior to saving the document.

If you have the appropriate permissions, you may edit the property values on the metadata card by clicking the desired property value field. After you have made the necessary changes, click **Save** on the metadata card to save them.

For more information on using the metadata card, see **Metadata Card**. Additionally, **Efficient Use of the Metadata Card** explains how you can use keyboard shortcuts to enter the required metadata even faster and more easily.

Now that you are familiar with how metadata is used in M-Files, proceed to **Getting Familiar with Documents and Other Object Types** for a quick tutorial on the different object types in M-Files.

### 1.3.5. Getting Familiar with Documents and Other Object Types

The **Document** object type is perhaps the most basic object type in M-Files. Documents in M-Files consist of files and metadata.

#### Documents vs. files

A document in M-Files is an object type that can contain zero or more files. A single-file document contains one file and metadata associated with the file.

![Proposal 7720 - ESTT Corporation (IT).doc](image)

Multi-file documents can contain multiple files, but all files share the same metadata.

![Project Agreement - Reece, Murphy and Partners (11/2004)](image)

Files in a multi-file document can be expanded by clicking the arrow icon to the left of the multi-file document in the listing area.

#### Other object types

You can manage all kinds of data objects in M-Files, not just documents. Typical object types are customers and projects, for example. Documents are often associated with customers and projects, and with these object types, you can manage additional information related to these objects, such as the address details of the customers, and project deadline dates.

For more information on object types, see **Object Types**.

Now that you are familiar with the different object types in M-Files, proceed to **Creating New Objects and Saving Documents to M-Files** for a quick tutorial on how you can create and save new documents in M-Files.
1.3.6. Creating New Objects and Saving Documents to M-Files

Creating new documents or other objects in M-Files, or saving documents from other applications to M-Files, is very simple and straightforward. This quick tutorial shows you how it is done.

Creating New Objects in M-Files

You can create new objects by clicking the Create button, or by clicking the desired button under the Create section in the task area:

1. Either:
   a. Click the Create (CREATE) button and select the desired object type from the context menu.
   or
   b. In the task area, under the Create section, click the desired object type.

If you chose to create a new document, the New Document dialog is opened. Otherwise the metadata card for the new object is opened.

2. Optional: If you are creating a new document, select a class and a template, and then click Next.
3. Fill in the necessary metadata and then click **Create**.

The object is added to the vault with the metadata details that you have provided.
Saving Documents to M-Files from Other Applications

M-Files supports all file types and you can save documents from any application to M-Files. Documents are saved to a document vault and then described with metadata. You do not have to save documents into a particular folder or location as M-Files organizes content automatically into relevant views based on document metadata.

Certain applications, such as AutoCAD, Microsoft Word, Microsoft Excel, or Microsoft PowerPoint, have an M-Files ribbon that you can use to easily save new documents to M-Files. If the application you are using does not have the ribbon, you can still use the Save As... function of the application to save your document to M-Files.

Complete the following steps to save a document to M-Files from another application:

1. Either:
   
a. If you are using an application that is equipped with the M-Files ribbon, open it and then click Save to M-Files. If you have more than one vault connection, select the appropriate vault from the context menu.
b. If the application does not have the **Save to M-Files** feature, select **File > Save As...** from the menu bar, select M-Files as the location, and if necessary, select the appropriate vault. Finally click **Save**.

![Save As dialog box](image)

The metadata card for the new document is opened.
2. Fill in the appropriate metadata and then click **Create**.

The selected document is saved to the vault with the metadata that you have provided.

For more information on creating objects and saving documents in M-Files, see *Adding New Content to a Vault*. 
Now that you are up to speed with the ways documents are created and saved to M-Files, proceed to Using Document Templates for a tutorial on how to take advantage of document templates when creating new documents.

1.3.7. Using Document Templates

Complete the following steps to create a new document using a document template:

1. Click the Create button and then select Document... from the context menu.
   - The New Document dialog is opened.

2. Select an appropriate class from the drop-down menu.
   - The available templates for the selected class are displayed.
3. Select an appropriate template, and then click **Next**.

The metadata card for the new document is opened and some of the properties may be prefilled according to the selected class and template.
4. Fill in the necessary remaining properties, and then click **Create**.

The new document is opened in the editor associated with the file type, and document contents are prefilled based on the metadata you have specified.
5. When you are finished editing the document, do either of the following:

a. Open the M-Files tab and click **Check In**.

   or

b. If the M-Files tab is not available, close the document and when you are prompted to check in the document, click **Yes**.

6. If you are prompted to save your changes, click **Yes**.

Your new document is saved using a predefined document template and stored to the vault.

**Creating a New Document Template**

You can convert any document in an M-Files document vault to a document template that can then be used for creating standardized documents for a specific purpose.

Complete the following steps to convert a document in M-Files to a document template:
1. Locate and select the document that you want to use as a template.

![M-Files sample vault](image)

2. On the metadata card, click **Add property**.

   ![Add property](image)

   A new property field is added to the metadata card:

   - **Class**: Other Document
   - **Name or title**: Technical article template
   - **Keywords**: document template
   - **Description**: This is the new document template to be used for technical articles.

3. Use the drop-down menu to select the property **Is template**.

4. Check the **Is template** check box.

   ![Is template](image)

5. Click **Save** to save your changes.

The selected document is now a document template in the vault. You may modify the template at any time by right-clicking the document and selecting **Open** from the context menu.
Adding Automatically Filled Fields to a Template

You can add to your document template fields that are automatically filled when you create a new document based on the template. The fields are filled with values of predefined properties specified in the metadata of the new document.

Complete the following to add an automatically filled field to your document template:

1. Right-click your document template and select **Open** from the context menu.
2. If you are prompted to check out the document, click **Check Out**.
3. Click the position in the template where you want the automatically filled field to appear.
4. Open the **M-Files** tab and click **Insert Property**.

The **Insert M-Files Property** dialog is opened.
5. Select the metadata property that you want to fill the field with and then click **OK**.

Now, when you create a new document based on the template, the predefined field in the document is filled with the property value that you have specified in the metadata of the new document.

Now that you are familiar with document templates, proceed to **Saving Emails from Microsoft Outlook to M-Files** for a tutorial on how you can easily save e-mail messages in Microsoft Outlook to M-Files.

### 1.3.8. Saving Emails from Microsoft Outlook to M-Files

M-Files is integrated with Microsoft Outlook and it creates a folder in Microsoft Outlook for every document vault. You can save emails with or without attachment files simply by dragging messages to the desired vault folder in Microsoft Outlook.

**Tip:** You can also drag and drop an email message directly to the M-Files user interface, and for instance, add the message file to an existing multi-file document by dropping it on top of the document object in the listing area.
When a message is added to M-Files, it is automatically tagged with the correct customer and contact person in M-Files, based on the domain of the sender's email address.

If, for example, the document vault contains the *M-Files Inc.* customer object and the email address of the customer is set to `pr@m-files.com` in the customer object metadata, all emails from the `m-files.com` domain are automatically associated with the customer when the messages are added to M-Files.

Do the following steps to save an email message in Microsoft Outlook to M-Files:

1. In Microsoft Outlook, drag and drop a message to a vault folder under the **M-Files** section.

   ![Metadata card for new document](image)

   - The metadata card for the new document is opened.

   - **Save as type**: Outlook message (*.msg)
   - **Class**: 
   - **Name or title**: Updates from All Company

2. Use the **Class** drop-down menu to select an appropriate class for the message.

3. Fill in any other metadata properties that you want, and then click **Create**.
The email message is saved to the selected vault with the metadata that you have provided.

For more information on M-Files functions in Microsoft Outlook, see Functions in Microsoft Outlook.

Now that you are up to speed with saving email messages to M-Files, proceed to Getting Familiar with Views for a tutorial on using views in M-Files.

### 1.3.9. Getting Familiar with Views

Views are essentially locations in which the objects are listed based on their metadata. In addition to the M-Files search functions, well-defined views allow you to quickly and easily locate the information you need.

M-Files gathers the contents of a view based on 1) the view filter, which defines the criteria that the object must fulfill to be displayed, and 2) the grouping level settings, which define the categories in which the objects are grouped in the view. As views are based on various metadata-specific criteria, objects can appear in several views at once.

As a very simple example, let’s look at the view called **Documents by Class**. This is a view where the **filter** simply states that the object type must be **Document**. As a result, all the documents contained in the vault are listed in this view regardless of their class or any other properties they might have. However, as the name of the view implies, its settings also define a **grouping level** that categorizes the documents into various virtual folders based on the value of their **Class** property. This way, we end up with a view like the one shown in the image below.

![Figure 2: A view where documents are categorized by class.](image)

Now, as you can see from the image, views can be further divided into subviews if need be. Virtual folders can also be converted into views, if you so wish. For more information, see Converting a Virtual Folder into a View.

For instructions on creating a new view and adjusting its settings, see Creating a View.

Now that you have familiarized yourself with views, proceed to Working Offline for a tutorial on how you can use M-Files offline.

### 1.3.10. Working Offline

You can access and modify documents stored in an M-Files vault without a network connection – as long as they have been marked to be available offline. There are two ways to do this: you can 1) explicitly...
Mark individual documents to be available offline or 2) create offline filters to make sure documents with a defined set of properties are always available regardless of your network connection.

**Mark for offline availability**

To mark a single document available in offline mode, right-click it and select **Offline Availability > Mark for Offline Availability** from the context menu.

**Offline filters**

With offline filters, you can mark documents to be available offline according to certain criteria. You can, for example, choose to have all the documents you have read or modified within the last two weeks, or all the documents related to a certain customer, to be available whether you are online or not. This is a dynamic way to define offline availability for documents: M-Files periodically checks whether there are new documents that fulfill the criteria of your filter, and then makes sure they are all at your disposal when you do not have a network connection available.

You can create a new offline filter by right-clicking an existing view in the vault and by then selecting **Mark for Offline Availability** from the context menu, or by creating a new offline filter from scratch. For instructions on how to do that, see **Offline Filters**.

![Figure 3: Marking an existing view to be available offline.](image)

**Accessing and editing documents in offline mode**

You can access the offline mode by clicking on your username in the upper-right corner of the user interface and selecting **Go Offline** from the context menu.
When you are in offline mode, you can find the documents available to you via the built-in view called, you guessed it, Offline. You can read and edit documents the same way as when you are online. The only difference is that when you are offline, you cannot check in any objects once you have checked them out for editing. They can be checked in as soon as you are online again.

You can find the Go Online command above the listing area or via the same menu you used to activate the offline mode.

2. Daily Use

This section explains the day-to-day use of M-Files for vault users.

This section explains the day-to-day use of M-Files for vault users. It includes, among other things, a presentation of the user interface, instructions for carrying out basic operations, and information on how make the most out of the M-Files search functions.

1. User interface
2. Managing content
3. Sharing content
4. Finding content
5. User settings

In this chapter

- Getting Familiar with the User Interface
- Managing Content
- Sharing Content
- Finding Content
- User Settings

2.1. Getting Familiar with the User Interface

The objective of this section is to provide an overview of the M-Files Desktop interface.

>Note: At this stage, the following steps must have been completed:

- *M-Files Server* has been installed in your organization.
- The M-Files system administrator of your organization has created a document vault, login accounts and users.
- The document vault has been set up on your computer with M-Files Desktop Settings.

You should now be able to start using your M-Files vault by clicking the icon on your desktop, by using the Microsoft Windows Start menu, or via the virtual M-Files drive (as seen below). *Explore M-Files* can also be opened via the M-Files icon in the Microsoft Windows notification area.

>Note: The virtual M-Files drive does not, in fact, take up any space from your actual hard drive. Microsoft Windows requires drives to report their capacity and the amount of free space available in File Explorer. The default reported size of the M-Files drive is 1 terabyte, and the amount of reported free space is 90 percent.
In this chapter

- Logging in to and out of the Vault
- M-Files Desktop User Interface
- Accessing M-Files with M-Files Web
- Accessing M-Files with M-Files Mobile
- Keyboard Shortcuts in M-Files Desktop

2.1.1. Logging in to and out of the Vault

Once M-Files Desktop has been installed and your vault connections are set up via M-Files Desktop Settings, you should be able to see all the vault connections on your M-Files drive (for instance via the File Explorer).

Logging in

You can log in by double-clicking the vault. If you want to log in as a different user than the default one, right-click the vault and select Log In as... from the context menu. Unless you have already logged in during Windows login, the system prompts for your credentials upon opening the vault.

Note: M-Files can be configured to use single sign-on (SSO) with various solutions for federated authentication. Using SSO promotes productivity by reducing password fatigue and time spent on re-entering login credentials. For more information, refer to Using Federated Authentication with M-Files.
Logging out

Once logged in, you can log out from the vault by clicking your user name in the top-right corner of the interface and then selecting **Log Out** from the context menu. Alternatively, you can press the Alt key and select **Operations > Log Out** from the menu bar.

2.1.2. M-Files Desktop User Interface

This section describes how the M-Files Desktop user interface works.

Home screen

When you log in to a document vault, you are first greeted with the home screen of the vault. The home screen comprises the quick view area on the left and the **Pinned** tab on the right.

![Figure 6: The M-Files home screen.](image)

**The quick view area** contains four separate quick views that give you a good overview of the vault and the objects that are important to you. Using quick views, you can browse vault contents or open documents that you have recently accessed, or view tasks assigned to you. You can expand a quick view by clicking the title bar of a quick view.

You can use **the Pinned tab** to collect items that you regularly use into a single tab. The tab can contain shortcuts to vault objects, external repositories, views, or other resources. For more information on how to make use of the tab, see **The Pinned Tab**.

You may return to the home screen at any time by clicking the M-Files logo in the upper left corner of the user interface or by clicking **Home** on the task area.

User interface components

The M-Files Desktop user interface is composed of four main components:

- Listing area
• Right pane
• Task area
• Search

**Listing area**

The listing area in the center displays the objects or subviews contained in the selected view, or the results of your search. For more information, see [Listing Area](#).

**Right pane**

When an object is selected in the listing area, you can click the **Metadata** tab to view the metadata card of the object (see [Metadata Card](#)) in the right pane, or you can click the **Preview** tab to preview the contents of the object.

In addition, the right pane includes the **Filters** tab that contains options for refining your search. The **Filters** tab is opened whenever you activate the quick search field. For more information on search functions, see [Searching](#).

Lastly, you can access the **Pinned** tab in the right pane. You can use the tab to collect shortcuts to vault objects, external repositories, views, and other resources. For more information, see [The Pinned Tab](#).

You can hide the right pane altogether by clicking the vertical tab on the left edge of the right pane.

The right pane can also contain customized content and can be modified according to individual needs.

**Task area**

The task area is located on the left side of the window. It can be hidden or displayed by clicking the vertical tab on the right edge of the task area. By default, it contains options for creating new objects (**Create**) as well as a **Go To** section for quickly navigating to useful views, such as the **Favorites** and **Recently Accessed by Me**. For more information, see [Task Area](#).

**Search**

The search field is located on top of the user interface. For more information on search functions, see [Searching](#).

Right above the search word field, there is a breadcrumb indicator displaying the vault and the view that you are currently in. The breadcrumb can be, for instance, **Sample Vault > Documents > By Customer > A&A Consulting**.

**User menu**

The top right corner of the interface displays the name of the user logged into the vault. Clicking the username opens a context menu with the following options:

• About M-Files
• Notification Settings
• Substitute Users
• Shared by Me
• Change Language...
• Go Offline
• Log Out
External Repositories

Customization

The M-Files Desktop user interface can be customized according to various user requirements. For example, users can change the position of the metadata card on the user interface.

Figure 7: An overall view of the M-Files user interface with the metadata positioned at the bottom and the preview on the right side.

Connection status

The connection status icon () in the upper right corner to the left of the username displays the status of your connection to the document vault by measuring the round-trip time to the server that hosts the vault. The icon has five different statuses:

- The round-trip time to the server is less than 50 milliseconds.
- The round-trip time to the server is from 50 to 149 milliseconds.
- The round-trip time to the server is from 150 to 299 milliseconds.
- The round-trip time to the server is 300 milliseconds or more.
- You have no connection to the server.

To display additional information about your connection, click the connection status icon () to display the Connection Status dialog.
One of the following messages is displayed in the dialog:

- Your network connection is working properly.
- Your network connection is slow.
- No connection to the server or the server is unavailable.

If your connection is slow or you have no connection to the server, contact your M-Files system administrator. You can click Refresh to refresh the information regarding your connection status. Clicking Analyze Connection shows you additional details about your connection status.

Display mode settings

You can change various display settings via the Display Mode options. You can view the settings either by right-clicking on an empty space in the listing area and selecting Display Mode or by pressing the Alt key and selecting View > Display Mode in the menu bar.

With the Display Mode options you can:

- Choose whether you want objects to be displayed as icons or as a details list.
- Move the metadata card from the right side of the user interface to the bottom, and vice versa.
- Turn the Windows Explorer navigation pane on and off.
- Change the right pane and the bottom pane to be displayed in the minimized mode, or turn them off completely.
- Choose whether M-Files annotations are shown or not.
- Enable or disable object type based object grouping as well as view and folder grouping.
- Choose between a normal and a compact layout for the user interface.

In this chapter

- Listing Area
- Metadata Card
- The Pinned Tab
- Task Area

Listing Area

The listing area in M-Files Desktop normally contains views and objects. The area functions very similarly to the one in Windows File Explorer. In M-Files Desktop, however, users can expand or collapse objects to view and hide, for instance, the content of an M-Files multi-file document.
If the listing exceeds the number of objects to be displayed in a single listing, the option **Show more results** is shown in the grouping title. By clicking this option, you can enter the **paginated view**.

![Tip](image)

**Tip:** You can quickly browse objects in the listing with your keyboard. Just select your preferred tab for the right pane (for instance the **Preview** tab), and start browsing with the up and down arrow keys.

![Note](image)

**Note:** Some of the item names in the listing view may be displayed in gray text. This means that the full item path is too long for Windows (more than 259 characters) and that parts of it should be renamed to make the content function properly. If you are using Microsoft Windows 10, however, you can ask your system administrator to enable longer paths to be used via the registry setting mentioned in these Microsoft instructions.

![Note](image)

**Note:** The **Size** column for an object may in some cases be empty. This means that the size of the object is temporarily unknown. When the object is opened, the size of the object is updated in the **Size** column.

**Grouping views on the main level**

The main-level views have been grouped into **My Views**, **Common Views**, **External Views** and **Other Views**. In addition, traditional folders are in a separate group. This makes it easier for the user to distinguish among these different views and navigate to **My Views**. Also, the regular user often does not have the permission for editing common views, so grouping common views separately clarifies the distinction between common views and the user's own views.

It is also possible to display predefined views, such as **Favorites**, **Assigned to Me** or **Recently Accessed by Me**, at the bottom of the listing view.

**Related objects listed below the main object**

Objects related to a particular object can easily be browsed directly from the view or from the search result by means of the expand and collapse arrow buttons. M-Files shows all related objects below the main object. This allows you to easily browse, for example, documents and contact persons related to the project, directly from the listing view.

**Grouping titles**

Related objects are automatically grouped by object type or by property definition. This allows you to find the desired document or other object quickly and easily. For example, if you are looking for contact persons related to the project, you can find them easily under the grouping title **Contact persons**.

**Sorting by columns**

You can change the sort order the objects in the listing area by clicking a specific column heading in the listing area. The objects can be sorted, for example, alphabetically, in the order of relevance or by date. Clicking the column heading once more changes the sort order from ascending to descending, or vice versa. By holding down the Ctrl key and clicking another column heading, you can select secondary, tertiary and further sortings orders. You can add more columns to the listing area by right-clicking on the column heading area and selecting **Choose Columns...** from the context menu.

**Listing pagination**

If the listing exceeds the total number of objects allowed to be displayed in a single listing, the option **Show more results** is shown in the grouping title. By clicking this option, you can enter the paginated view.
The paginated listing displays the range and total number of objects in the view, as well as the commands **Previous** and **Next** that allow you to move to the next and previous pages in the view.

You can change the number results shown per page by completing the following steps:

1. Open the menu bar by pressing Alt on your keyboard.
2. Select **View** > **Display Mode** > **Objects per Group** from the menu bar.
3. Select any of the options in the menu.

**Metadata Card**

By default, the metadata card and the preview pane are positioned on the right side of the user interface. The size of the right pane can be adjusted according to different user needs and preferences.

The metadata card comprises the following elements (from top to bottom):

- Title area
- Option ribbon
- Property listing
- Permission and workflow options

The title area displays the name, type, ID and the M-Files version of the object, as well as the creation and modification dates.

**Tip:** When **translatable object titles** are enabled, objects can have multilingual names. The translated object titles can be used in searches and they are displayed instead of **Name or Title** property on the title area of the metadata card, listing area as well as in notifications and value lists when a specific vault language is selected.

The option ribbon contains various options related to the currently selected object and the metadata card. For more information, see **Metadata card option ribbon**.
The property listing area displays all the object's properties, property groups, as well as the option for adding new properties. See Object Metadata for instructions on adding and editing properties.

**Note:** M-Files can be configured to use dynamic properties as well as property groupings. Dynamic properties enable administrators to define “trigger” properties that, when set, automatically generate additional properties to the metadata card. Property groupings can be used to group properties together on the metadata card to better organize the metadata cards of objects that contain a large number of properties. See Metadata Card Configuration for more information.

The ribbon below the properties area enables you to modify the permission settings of the object, as well as to assign and change workflows and workflow states. For further information, see Object Permissions and Using Workflows.

**Metadata card option ribbon**

There are five icons in the ribbon below the title of the object:

- flag
- pin
- star
- cogwheel
- arrowhead

With the **flag** icon, you can mark the object as followed or unfollowed. When the object is marked as followed, you get an email notification when the object is modified.

Clicking the **pin** icon pins (or unpins) the selected object to the Pinned tab.

Clicking the **star** icon adds (or removes) the object to your Favorites view.

The **cogwheel** icon opens a list of options, including the options for changing the metadata card location and detaching the metadata card into a new window.

By clicking the **arrowhead** icon, you can hide or show the title area of the metadata card.
Follow this object

When the option **Follow this object** or **Follow this document** is enabled, M-Files sends you an email message when the object or document is modified.

These modifications can be of the following types:

- The metadata or the file content of the followed object is modified.
- The followed object is deleted or destroyed.
- The metadata or file content of an object or a document related to the followed object is changed. For instance, a document related to a project is modified.
- A document or an object related to the followed object is created, deleted or destroyed.
Note: The person who modified the object will not receive a notification.

Positioning the metadata card

In some cases, such as when working with views that show multiple columns in the listings, or when working with a smaller screen, it makes more sense to show the metadata card in the bottom pane. You can change the position of the metadata card to the bottom pane by opening the context menu in the listing view and selecting Display Mode > Show Metadata in Bottom Pane. Alternatively, you can do this by clicking the Settings icon (the cogwheel) on the metadata card and selecting Toggle Metadata Card Location from the context menu. You can also hide the right pane altogether by clicking the vertical tab on the left edge of the right pane.

Comments view

The comments view can be accessed by clicking the Comments icon on the metadata card. This view displays all the comments added to the object in chronological order, as well as the option to add new comments.

Note: Comments retain their permission settings. This means that they are visible only to the users defined in the permission settings that were in use when the comment was added.

Clicking the Properties icon in the comments view brings you back to the properties view.

Preview

You can open the document preview by clicking the Preview tab of the right pane. If the pane is not enabled, you can display it by right-clicking an empty space in the listing area and selecting Display Mode > Right Pane > Normal from the context menu.

You can also open the metadata card in a separate window by clicking the Settings icon and selecting Pop Out the Metadata Card from the menu. This option allows you to view and edit several metadata cards in parallel and also to view the document metadata and the preview window side by side.

Once the metadata card has been detached from its default position, it can be operated as any normal window in the user interface.
In the preview mode, you can easily browse and copy document content. You can preview for instance Microsoft Word, Microsoft Excel, Microsoft PowerPoint, PDF, and AutoCAD files. The preview is possible if the software supporting the relevant file format has been installed on your computer and is chosen as the default application for that file format. For example, preview for Microsoft Office documents requires Microsoft Office 2010 or higher, and preview of PDF files requires Adobe Acrobat Reader 8 or higher.

**Tip:** When you are transferring files to M-Files, the preview function makes it easier to fill in the metadata.

Contents of the following types of files can be viewed on the **Preview** tab:

- Email files (eml, emlx, msg)
- HTML and web archive files (htm, html, mht, mhtml)
- Image files (tif, tiff, jpg, jpeg, bmp, gif, png)
- Microsoft Excel files (xlsx, xlsm, xlt, xltm, xslb, xls, xlt)
- Microsoft PowerPoint files (pptx, pptm, ppsx, ppsm, potx, potm, ppt, pps, pot)
- Microsoft Word files (docx, docm, dotx, dotm, doc, dot)
- OpenDocument files (odt, odt, ods, odp)
- PDF files
- RTF files
- Text files (txt)
- Visio drawings (vsd, vdx, vss, vsx, vst, vtw, vdw)

You can also zoom PDF files. On the **Preview** tab, right-click and select **Zoom In Tool** from the context menu. You can then use the different zoom tools from the context menu. In the listing area, the zoom tools work also with the following types of files:

- Email files (eml, emlx, msg)
- Microsoft Excel files (xlsx, xlsm, xlt, xltm, xslb, xls, xlt)
- Microsoft PowerPoint files (pptx, pptm, ppsx, ppsm, potx, potm, ppt, pps, pot)
- Microsoft Word files (docx, docm, dotx, dotm, doc, dot)
- OpenDocument files (odt, ott, ods, odp)
- PDF files
- RTF files
- Visio drawings (vsd, vdx, vss, vsx, vst, vtx, vdw)

In M-Files Web, you can easily browse through the document in the **Preview** tab via the thumbnail view by first clicking the **Toggle Side Panel** button and then clicking the **Thumbnails** button. You also use the preview search function by clicking the **Search** button in the **Preview** tab.

**Figure 11**: The **Preview** tab in M-Files Web.

**Metadata suggestions**

**Note:**

This feature requires that an Intelligent Metadata Layer license is installed and that appropriate intelligence services are installed and properly configured.
For more information on Intelligent Metadata Layer, see Intelligent Metadata Layer.

When you add an existing document to M-Files, you must first fill in the metadata to describe the document. When Intelligent Metadata Layer and intelligence services are in use, metadata suggestions based on document contents are offered on the metadata card of a new document:

You may click a suggestion to add it as a value for the property right above the suggestion. If there is a plus sign (+) preceding the suggested value, it means that the value will be added as a new object or value list item. Depending on the type of the property, you may add one or more of the suggested values.

**Note:** Metadata suggestions are not available if the metadata card is positioned in the bottom pane.

**In this chapter**

- Efficient Use of the Metadata Card
Efficient Use of the Metadata Card

The metadata card can be fully operated with your mouse (except for typing in values, of course), but there are also several ways for you to optimize the process of filling in the metadata by using your keyboard. The aim of this chapter is to make you even more proficient in using the metadata card, which is essentially one of the key components of the M-Files user interface.

First, you can use the Tab key to move from one property field to the next. You can also go back to the previous field by pressing Shift + Tab.

You can add and remove fields via the toolbar shown above the active field by using your mouse, but it might be faster to use the keyboard shortcuts: use Ctrl + I to add a new field, Ctrl + D to delete the selected field, or Ctrl + N to add a new value to the value list.

As a recap, here are the shortcuts that you can use on the metadata card:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>Move to the next property field.</td>
</tr>
<tr>
<td>⧿ Shift + Tab</td>
<td>Move to the previous property field.</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td>Insert a new value field for a property.</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td>Delete the selected property field.</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td>Add a new value to the value list and set it as the property value.</td>
</tr>
<tr>
<td>↑ / ↓</td>
<td>Move between available property value options.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td>Save metadata.</td>
</tr>
</tbody>
</table>

Selecting multiple items from a value list

You can select multiple items from a value list by opening the value list drop-down menu on the metadata card, and then performing either of the following actions:

- If you want to select a range of items, hold down the Ctrl key and select the first item in the range of items that you want to add, and then hold down the Shift key and select the last item in the range of items that you want to add.

  videos/value_list_select_range.mp4

- If you want to select multiple individual items, hold down the Ctrl key while selecting multiple individual items from the value list.

  videos/value_list_select_individual_items.mp4

Finally click Save on the metadata card to save your changes.

The Pinned Tab

The Pinned tab allows you to collect items that you frequently use into a single tab. The Pinned tab is a visual collection of shortcuts that provides quick access to resources, such as objects in the vault or external repositories. Click the Pinned tab on the right pane to view your pinned items.
Click an item on the **Pinned** tab to view it on the listing area, or double-click it to perform the default action of the object. Double-clicking a document that you can edit, for instance, would open the checkout prompt for the document. You may reorganize the items on the tab by dragging and dropping them.

To pin an item to the **Pinned** tab, do the following steps:

1. In M-Files Desktop, locate and select the item that you want to pin by using either the search or views.
2. Either:
   a. Drag and drop the item from the listing area to the **Pinned** tab.
b. Right-click the item and select **Pin** from the context menu.

or

c. Click the **pin** icon (🌟) on option ribbon of the metadata card.

The selected item is pinned to the **Pinned** tab. If you wish to unpin an item, right-click it on the **Pinned** tab and select **Unpin** from the context menu.

**Task Area**

The task area is located on the left side of the user interface and it can be expanded or collapsed by clicking the gray vertical tab. The task area contains a number of context-sensitive shortcuts:

Under the **Create** section, you can find quick links for creating new objects by object type.

Under the **View and Modify** section, you can select object-specific operations, such as **Check Out** and **Check In** or **Make Copy**. You can add new shortcuts to the list by right-clicking an empty space on the task area and selecting a shortcut from the **Commands** menu.

The **Go To** section lists a number of predefined links to the most commonly used views, such as **Favorites** and **Checked Out to Me**.

In addition, you can add new shortcuts under the **Go To** section yourself. To add a shortcut to the selected view or virtual folder, right-click on it and select **Add Shortcut to Task Area** from the context menu. To add an object to the list, select the object, open the menu bar with the Alt key on your keyboard, and then select **Operations** > **Add Shortcut to Task Area**.

You can rename, delete, and organize shortcuts on the task area by right-clicking a shortcut and selecting the appropriate command from the context menu.

You can also define **common task area settings**, although this requires that you have at least the **Manage common views and notification rules** administrative right in the vault. At the same time, you can also delete **users' custom task area settings** to immediately activate the common settings. Alternatively, the common settings can be activated by restoring the common default settings. The user can also restore the **M-Files software default settings**.

You can open and close the quick links below each title by clicking the arrowheads in the title.

**Favorites**

In addition to **My Views** and task area shortcuts, you can add documents and other objects to favorites. Favorites are user-specific.

You can add objects to favorites and remove them via the **Operations** menu, the context menu, or via the object’s metadata card.

*Note:* You cannot delete favorites with the **Delete** command.

You can conveniently access your favorites via the quick link in the task area.
Changing the workflow state

You can change the workflow state directly via the task area. The various workflow states are available for selection via the Change State command. You can move the object to the desired state by selecting the state from the State transition drop-down menu. If you wish, you can add a comment about the state change at this point.

Note: The Change State command is displayed in the task area only if the object has an associated workflow for whose state changes the user has the required permissions.

You can also change the state by clicking the workflow name or state control in the metadata card.

Setting the initial state of the task area

By default, the task area is collapsed along the left side of the user interface and it can be expanded by the user. In some cases it may be a good idea to have the task area visible by default.

Add the registry key below on the client computer to define whether task area is visible or hidden by default. Note that this setting must be added before the user has logged in to the vault for the first time, otherwise it is not effective. Therefore it is recommended that this setting is configured before upgrading to M-Files 2018 or later.

<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
<th>Value type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>TaskPaneInitialState</td>
<td>REG_DWORD</td>
<td>Defines whether the task area is hidden, visible, or completely disabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The task area is hidden by default and users can choose to display it via the M-Files client. You can change the behavior by using this registry key.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>The task area is hidden.</td>
</tr>
<tr>
<td>0</td>
<td>The task area is disabled and cannot be opened by the user.</td>
</tr>
<tr>
<td>1</td>
<td>The task area is hidden by default but can be expanded by the user.</td>
</tr>
<tr>
<td>2</td>
<td>The task area is visible by default but can be hidden by the user.</td>
</tr>
</tbody>
</table>

2.1.3. Accessing M-Files with M-Files Web

You can access M-Files vaults also via the M-Files Web browser interface. It enables you to use all the basic M-Files functions.

The user interface is highly similar to that of M-Files Desktop. See the M-Files Desktop User Interface section for more details about the user interface components.
Ask your system administrator for the address of M-Files Web in your organization. Or if you are looking for instructions on how to set up the M-Files Web connection in your organization, refer to Setting Up Web and Mobile Access to M-Files.

**Note:** M-Files Web is, by default, installed and configured to run on the same computer with M-Files Server, providing access to the vaults on this server. If you need to set M-Files Web to use M-Files Server located on another computer, refer to the document How to Configure M-Files Web Access on a Separate Server Computer.

### Logging in to M-Files Web

1. Navigate in your web browser to the M-Files Web address provided by your system administrator or an M-Files consultant.

   Let’s say the name of your vault is *Sales Tracker*. In that case, the address can be, for example, https://sales-tracker.cloudvault.m-files.com for cloud-based deployments, or http://sales-tracker.mydomain.com for on-premises vaults. Within your corporate network, the connection protocol might be HTTP instead of HTTPS.

2. Input your login credentials or select **Log in with current Windows credentials**.

3. If you have access to several vaults, select the vault you want to connect to.

   **If you have access to only one vault, you will be connected automatically.**

You should now be logged in and you should see the M-Files home screen.

### 2.1.4. Accessing M-Files with M-Files Mobile

M-Files is also available as a mobile application for iOS and Android devices. The mobile applications enable you to, for example, gain access to all vault content and mark your assignments as complete on the go, as well as to create and share new objects with your mobile device.
You can download the latest version of the mobile applications from your application store:

- M-Files for iOS (iPhone and iPad)
- M-Files for Android (phones and tablets)

For a description of functional differences between the mobile applications, see the knowledge base article M-Files Mobile Apps Feature Comparison.

For instructions on setting up mobile access to M-Files, see Setting Up Web and Mobile Access to M-Files.

Figure 13: The M-Files mobile apps.

Application language

M-Files mobile applications use the language settings of your device for determining the user interface language.

Logging in to M-Files Mobile

1. Ask your vault administrator or an M-Files consultant for the login details of the document vault.
2. Open the M-Files mobile app on your device.
3. On the login screen, input the server address and your username and password.

   Let’s say the name of your vault is Sales Tracker. In that case, the address can be, for example, https://sales-tracker.cloudvault.m-files.com for cloud-based deployments, or http://sales-tracker.mydomain.com for on-premises vaults. Within your corporate network, the connection protocol might be HTTP instead of HTTPS.

   For cloud vaults hosted in the M-Files cloud, M-Files recognizes the server address even if you only enter the sales-tracker part. Although, to be absolutely sure that the correct protocol and address is used, it is always recommended to use the full server address.

4. Tap Log in.
5. If you have access to several vaults, select the vault you want to connect to.

   If you have access to only one vault, you will be connected automatically.

You should now be logged in and you should see the M-Files home screen.
2.1.5. Keyboard Shortcuts in M-Files Desktop

These keyboard shortcuts can be used when the listing area is active:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Keys</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Search</td>
<td>Ctrl + F</td>
<td>Move the focus to the Quick Search filter.</td>
<td>Quick Search.</td>
</tr>
</tbody>
</table>

These shortcuts are available when an object has been selected on the listing area:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Keys</th>
<th>Description</th>
<th>See</th>
</tr>
</thead>
<tbody>
<tr>
<td>Check Out</td>
<td>Ctrl + O</td>
<td>Move to the Check Out dialog.</td>
<td>Checking Out a Document.</td>
</tr>
<tr>
<td>Check In</td>
<td>Ctrl + I</td>
<td>Move to the Check In dialog.</td>
<td>Checking In a Document.</td>
</tr>
<tr>
<td>Check in with comments</td>
<td>Ctrl + ⌘ Shift + I</td>
<td>Move to the Check In dialog with comments</td>
<td>Checking In a Document.</td>
</tr>
<tr>
<td>Collection members</td>
<td>Ctrl + ⌘ Shift + L</td>
<td>Move to the Collection Members dialog</td>
<td>Using the Collection Members dialog.</td>
</tr>
<tr>
<td>Comments</td>
<td>Ctrl + M</td>
<td>Move to the Comments dialog.</td>
<td>Object Comments.</td>
</tr>
<tr>
<td>Subobjects</td>
<td>Ctrl + J</td>
<td>Move to the Subobjects dialog.</td>
<td>Subobjects.</td>
</tr>
<tr>
<td>History</td>
<td>Ctrl + H</td>
<td>Move to the History dialog.</td>
<td>Version History.</td>
</tr>
</tbody>
</table>

Below are the shortcuts that you can use on the metadata card:

<table>
<thead>
<tr>
<th>Shortcut</th>
<th>Keys</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tab</td>
<td>⇥</td>
<td>Move to the next property field.</td>
</tr>
<tr>
<td>⌘ Shift + Tab</td>
<td>⇥</td>
<td>Move to the previous property field.</td>
</tr>
<tr>
<td>Ctrl + I</td>
<td></td>
<td>Insert a new value field for a property.</td>
</tr>
<tr>
<td>Ctrl + D</td>
<td></td>
<td>Delete the selected property field.</td>
</tr>
<tr>
<td>Ctrl + N</td>
<td></td>
<td>Add a new value to the value list and set it as the property value.</td>
</tr>
<tr>
<td>↑ / ↓</td>
<td></td>
<td>Move between available property value options.</td>
</tr>
<tr>
<td>Ctrl + S</td>
<td></td>
<td>Save metadata.</td>
</tr>
</tbody>
</table>

2.2. Managing Content

This section contains instructions for basic operations related to managing content in M-Files Desktop via topics discussing adding, removing, archiving, and editing content; viewing and editing object relationships; using document collections; and offline use.

1. Add
2. Remove and archive
3. Edit
2.2.1. Adding New Content to a Vault

This section describes the various ways for adding new or existing content to your M-Files vault.

In this chapter

- Saving in M-Files
- Detecting Duplicate Files
- Transferring Existing Files to M-Files
- Creating Documents and Other Objects
- Creating and Completing Assignments
- Making a Copy of an Existing Object
- Functions in Microsoft Outlook

Saving in M-Files

When using M-Files, you no longer save documents in a single folder but on the M-Files drive, which can be found on your computer like a hard drive. You do not need to specify any other location than the document vault, as M-Files locates the document in the correct views on the basis of the metadata you define in the metadata card.

You can save the documents directly to M-Files from the applications that you use. The new save location is the document vault.
Figure 14: Saving a document to a document vault.

Tip: On the left side of the save dialog, you can usually see a quick link to M-Files.

See Example: Saving a Microsoft PowerPoint Presentation to M-Files and Example: Saving a Microsoft PowerPoint Presentation to M-Files by Using the M-Files Tab for examples on how you can save your work directly from an application to M-Files. The first example applies to virtually every desktop application. The second example applies to Office products (Office 2010 and newer).

Example: Saving a Microsoft PowerPoint Presentation to M-Files

1. Open Microsoft PowerPoint and create a new presentation or open an existing one.
2. Once your presentation is ready, select File > Save As > Computer > Browse.
   - The Save As dialog is opened.
3. On the left pane of the Save As dialog...
   - Click the Computer location and on the right pane, double-click M-Files.
     - or
   - Click the arrow next to Computer to expand the location and click M-Files.
4. Double-click the vault where you want to save your presentation.

5. Enter a file name for your presentation in the **File name** field.

6. Click **Save**.

   - The **New Document** dialog is opened.

7. Select an appropriate class for your presentation from the **Class** drop-down menu.

8. Optional: Enter other optional property values.

   - Click **Add property** to add additional properties.

9. Click **Create**.

   Your presentation is saved to M-Files.

**Example: Saving a Microsoft PowerPoint Presentation to M-Files by Using the M-Files Tab**

1. Open Microsoft PowerPoint and create a new presentation or open an existing one.

2. Once your presentation is ready, select the **M-Files** tab on the Microsoft PowerPoint ribbon.

3. Click **Save to M-Files**.

4. In the drop-down menu that opens, click the vault where you want to save your presentation.

   - The **New Document** dialog is opened.

5. Select an appropriate class for your presentation from the **Class** drop-down menu.

6. Optional: Enter other optional property values.

   - Click **Add property** to add additional properties.

7. Click **Create**.

   Your presentation is saved to M-Files.

**Detecting Duplicate Files**

M-Files automatically detects if there are documents with identical file contents in a vault. M-Files shows the file content matches for existing and new documents. You can see only the duplicate files that you have rights to.

- **Note**: M-Files compares only the file contents. The metadata can be different in the compared documents.

The duplicate files can have a different file name, different related objects, version history, permissions, workflow, and other document data when compared to each other. The duplicate detection works with all file types, for example text files, pictures, and ZIP files.

When you find out that there is an identical content match, you might still want to preserve the duplicate files or create a document with identical file contents compared to an already existing file. An example of this kind of a situation is when you need to have different workflows for the objects.
Duplicate file contents is shown:

- In the listing area, where you can see the documents containing duplicate file contents by expanding the object with the arrow button. The duplicate files are shown under the Duplicate File Content node.
- When creating new objects, M-Files detects if documents with exactly the same file contents are found in the vault.

Do the following steps to see if your new content has identical content matches:

1. **Add new content** to the vault.

   - M-Files shows the documents with duplicate file contents in a dialog. If no duplicates were found, the Create Document dialog opens.

2. Select one of the options:
   
   a. Select **Do Not Create** if you do not want to add the document with identical file contents.
   
      or
   
   b. Select **Create Anyway** if you want to add the document regardless of the identical file contents.

**Transferring Existing Files to M-Files**

Transferring files to M-Files is very easy. Files can be transferred by dragging and dropping or by copying files or folders to the M-Files document vault.

If you transfer one file only, M-Files asks you to fill in a metadata card for the file, which makes the file a document. It is very important to understand the difference between a file and a document. An M-Files document consists of zero or more document files and metadata.

For instance, when transferring a folder with subfolders or several individual files at a time, M-Files is able to preserve the old folder structure. If you wish the folder structure to be preserved, the contents transferred are organized into traditional folders created in the document vault by M-Files. You can fill in the document property data while transferring or later on. For more information, refer to Transferring Folders to M-Files by Using the Import Files and Folders Dialog.

You can also use existing files directly from their original locations. This way, the additional properties provided by M-Files (such as version management) are available for these files, while they can still be used externally to M-Files. You can add metadata to the documents later on as necessary. For more information, refer to External File Sources.

Different databases can also be used and imported into M-Files. For example, the data in the customer database can be added to the M-Files metadata structure. This way the information does not have to be copied from one location to another. For more information, refer to Object Types and Value Lists.

When you add metadata to documents imported to M-Files, these documents are displayed both in traditional folders and in M-Files dynamic views.

**Tip:** If you are transferring several individual files with the same metadata, such as the same customer, remember to ensure that the metadata you specify the first time will be used by default for the next files. You can do this when filling in the metadata card by checking the **Use these values as defaults for the next document** box (see the image below).
Tip: With the Skip This button, you can choose not to transfer a certain file. This is useful if you are transferring a large number of files and notice that you do not want to transfer one of the files after all.

Converting a temporary local file to a document

The Convert to Document operation is available for documents that are imported to M-Files in some unusual manner, such as by using a command prompt, M-Files indicates these temporary local files with a grayed-out icon. If you want to convert a temporary local file into a normal M-Files document, right-click the temporary local file and select Convert to Document from the context menu.
In this chapter

- Transferring Files to M-Files by Dragging and Dropping
- Transferring Files to M-Files by Copying and Pasting
- Transferring Folders to M-Files by Using the Import Files and Folders Dialog

Transferring Files to M-Files by Dragging and Dropping

1. Locate a file you need to transfer in File Explorer.
2. Select the file and drag and drop it to M-Files, onto an empty space in the listing area.
   - The New Document dialog is opened.
3. Select an appropriate class for the file from the Class drop-down menu.
4. Enter other optional property values.
   - Click Add property to add additional properties.
5. Click Create.

Transferring Files to M-Files by Copying and Pasting

1. Locate a file you need to transfer in File Explorer.
2. Right-click the file and select Copy.
3. Switch over to the M-Files window, right-click on an empty space in the listing area and select Paste.
   - The New Document dialog is opened.
4. Select an appropriate class for the file from the Class drop-down menu.
5. Enter other optional property values.
   - Click Add property to add additional properties.
6. Click Create.

Transferring Folders to M-Files by Using the Import Files and Folders Dialog

1. In M-Files Desktop, press the Alt key to open the menu bar.
2. Select **Create > Import Files and Folders...** from the menu bar.

3. Click ... to select the folder you want to import.

4. Select:
   
   a. **Do not preserve old folder structure** to discard the folder structure of the folder you are importing. 
      
      or
   
   b. **Preserve old folder structure** to preserve the folder structure of the folder you are importing. You need to select a folder in M-Files for the content to be imported. You can create a new folder by clicking **New Folder**.

5. Optional: Uncheck the **Prompt for metadata** check box if you do not want to add metadata for the content you are importing.

6. Click **OK**.
If you checked the **Prompt for metadata** check box, do the steps from 7 to 9 for every file you are importing.

7. In the **New Document** dialog, select an appropriate class for the file from the **Class** drop-down menu.

8. Enter other optional property values.

   - Click **Add property** to add additional properties.

9. Click **Create**.

The folder is imported to M-Files. If you chose the **Preserve old folder structure** option, the imported folder appears as a new traditional folder in M-Files.

**Creating Documents and Other Objects**

This section describes how you can create various types of new objects in the vault. For the distinction between documents and other types of objects, see the definition of an object in **M-Files Terminology**.

**In this chapter**

- **Object Metadata**
- **Creating a Document**
- **Creating Non-Document Objects**
- **Adding Content via Scanner**
- **Replacing the Content of a Document File**
- **Object Permissions**

**Object Metadata**

Metadata is an essential part of any M-Files object. Whenever you create a new object in M-Files, you need to enter at least some metadata to identify what the object is about and what it relates to. Is it, for instance, a project plan, a new customer, or a sales invoice?

You can edit the metadata directly by modifying the property values via the metadata card. In addition to being able to directly edit property values, you can add or remove properties, change workflow-related information and modify permissions of the selected items.

**Tip:** You can use keyboard shortcuts while editing the metadata. See Efficient Use of the Metadata Card.

You can easily add metadata fields to the metadata card by clicking the **Add property** label at the end of the property list. If you want to create new properties, open **M-Files Admin** and refer to **Property Definitions**.

Clicking on a property on the metadata card activates the edit mode, which displays the **Save** and **Discard** options at the bottom of the page. Clicking the **Save** button saves the changes, creates a new version of the object and returns the metadata card to view mode. Selecting **Discard** returns the metadata card to view mode without saving any modifications.

M-Files fills in the **Created** and **Added by** fields automatically on the basis of the current M-Files user information and timestamp data. M-Files is also able to fill in other fields, depending on where you save the document. The **Name** or **Title** field must be filled in, as the title constitutes the name displayed in various lists. An asterisk (*) next to a field indicates that the field must be filled in for you to be able to create the object.
Tip: When translatable object titles are enabled, objects can have multilingual names. The translated object titles can be used in searches and they are displayed instead of **Name or Title** property on the title area of the metadata card, listing area as well as in notifications and value lists when a specific vault language is selected.

### Using the metadata card toolbar

A toolbar is displayed for properties that can have additional functionalities. Only the functions available for the chosen property are displayed.

![Metadata Card Example](image)

**Figure 16:** The five functions of the toolbar: Add field, Remove Field, Refresh, Add value and Edit.

You can use the + and - icons to add or remove fields in a multi-select property. This enables you to link a document to multiple properties, such as a number of various projects.

The **Refresh** icon updates the values of a property based on a value list. Additionally, you can create more values to a property by selecting the **Add value** icon. With the **Edit** icon you can open a dialog for modifying the chosen value.

**Editing the properties of multiple objects**

You can select multiple objects in M-Files by doing any of the following:

- Hold down the ▲ Shift key while selecting objects in the listing area to select a group of consecutive objects.
- Hold down the Ctrl key while selecting objects in the listing area to select multiple individual objects.
- Click and drag a box around the objects that you want to select in the listing area.

When you have multiple objects selected, you should see the collective metadata of the objects you have selected on the metadata card:
The metadata card shows all the properties of the selected objects. If the objects have the same value for a property, the value is shown in the property field. If, on the other hand, the objects have differing values for a property, the property looks something like one of the following:

<table>
<thead>
<tr>
<th>Example property</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Telephone number (varies)</td>
<td>The selected objects have varying values for the property.</td>
</tr>
</tbody>
</table>
The selected objects have different values selected for the property:

- If the check box is unchecked, it means that none of the selected objects have the value selected.
- If the check box is checked, it means that all of the selected objects have the value selected.
- If half of the check box is filled with gray, it means that some of the selected objects have the value selected.

The selected objects have different values selected for the property:

- If the radio button is not selected, it means that none of the selected objects have the value selected.
- If the radio button is selected, it means that all of the selected objects have the value selected.
- If half of the radio button is filled with gray, it means that some of the selected objects have the value selected.

Now, when you edit a property value, you change the value for all the selected objects collectively. If you enter a new value in place of (varies), the same property value is set for all the selected objects. Or, if you check or uncheck a check box, or select or unselect a radio button, the value is added or removed for all the selected objects collectively.

### Creating a Document

You can create documents just like before and save them directly to the M-Files drive. You can also create other types of objects, such as customers or assignments. See Creating Non-Document Objects and Creating and Completing Assignments for more information.

Start creating a new document by first clicking the Create button and then selecting Document... from the context menu, or by pressing Ctrl + N in the M-Files user interface. The new document dialog helps you select the right template and class for the new document. Templates can also be searched by typing a search term. The search displays all templates and file formats that match the search criteria, and highlight the results.
Figure 17: The new document creation wizard.

Selecting **All** displays all templates and file formats that are defined for the vault in question. The **Recently Used** option shows all the templates you have recently accessed. Recently used templates are also shown by default when you open the template selection wizard. The **Blank** option shows all the file formats that can be selected for a new document.

These predefined options are followed by a list of classes that can also be used for the template selection. Selecting a class displays the templates that are available for that class.

After you have selected a template or a blank document, a metadata card for the new document opens and you can start editing the properties. Properties marked with an asterisk (*) are mandatory.
Tip: You can use keyboard shortcuts while editing the metadata. See Efficient Use of the Metadata Card.

Figure 18: The metadata card of a new document.

Clicking Create saves the document and adds the object to the vault. Selecting Open for editing makes sure that the document is checked out to you for editing until you manually check it in, and opens the new file in a suitable application for editing. If you have selected Check in immediately, the document will be available for others right away. Clicking Cancel discards all the changes and closes the dialog.

When you create a document in some other application, you fill in the metadata card only when you save the document in the document vault on the M-Files drive.
Tip: When filling in the metadata card, you can specify the permissions for the document in the Permissions field. This way, you can specify who can view, open, or edit the document.

In this chapter

- Example: Creating A New Document
- Using Document Templates
- Single-File and Multi-File Documents

Example: Creating A New Document

1. Open M-Files Desktop and navigate to a vault.
2. Click the Create button and then select Document... from the context menu.

   The New Document dialog is opened.

3. Either:
   a. Enter a search term to the search field and select a template based on the search results.
   or
   b. Use the Select class drop-down menu to select a class and then select a template belonging to the selected class.
   or
   c. Select a template via the Recently Used, All, or Blank quick lists.

4. Click Next.

5. In the Name or title field, enter a name for the document.

6. At minimum, enter values to the mandatory metadata fields (marked with an asterisk).

   You may want to add additional metadata fields by clicking the Add property command below the last metadata property on the list.

7. Optional: Click the permission options at the bottom of the dialog to define permissions for your document.

   For more information on setting document permissions, see Object Permissions.

8. Optional: Click the workflow options to select a workflow and a workflow state for the document.

   For more information about workflows, see Configuring Workflows.

9. Either:
   a. Select Open for editing if you want to modify the content before checking the document in.
   or
   b. Select Check in immediately if you are planning on adding the content later on, or having someone else add it.
10. Click Create.

Your newly created document has been added to the vault.

*Using Document Templates*

You can create a new document by using a predefined template. When you select a template in the new document creation wizard, the metadata card is populated with the data contained in the template. You can also edit and add metadata. The new document contains the contents of the template.

Examples of useful templates include *Proposal template, Order template* and *PowerPoint presentation template*.

To specify a document or other object as a template, add the property *Is template* and set it to *Yes*. Templates are class-specific, but you can specify the template to affect several classes by adding the *Additional Classes* property for the object.

---

**Note:** When you want to save a document as a document template to be used in M-Files, save the document as an Microsoft Office document, that is, in the format *.doc(x), .ppt(x), .xls(x)* or similar. Do not use the template formats offered by Microsoft Office applications (for instance the Word template, *.dotx)*.

For more information, see *New Class*, as well as *Automatic Values* for information on using document templates with automatic values.

---

*Single-File and Multi-File Documents*

In M-Files, you can create *multi-file* or *single-file documents*.

A multi-file document usually contains several files, that is, files that together with the metadata constitute one multi-file document. You can view the contents of a multi-file document by double-clicking it. In other words, a multi-file document is a fixed entity that contains several document files. For example, it is usually a good idea to include a proposal and its attachment in the same multi-file document.

---

**Tip:** Multi-file documents can be set to use a primary file type, changing how these documents behave in the user interface. See *Setting a Primary File Type for Multi-File Documents* for details.

You can later convert a single-file document to a multi-file document and vice versa.

---

![Figure 19: Multi-file document and single-file Microsoft Word documents in the listing area.](image-url)
Converting a multi-file document to a single-file document

When a multi-file document contains exactly one file, you can convert it to a regular single-file document by right-clicking it, and then selecting **Convert to Single-file Document**.

Converting a single-file document to a multi-file document

You can convert a single-file document to a multi-file document by right-clicking a single-file document and selecting **Convert to Multi-file Document** from the context menu.

In this chapter

- Adding New Files to Multi-File Documents

Adding New Files to Multi-File Documents

The **Add File** function can be used for creating new document files for a **multi-file document**.

Note, however, that a multi-file document in M-Files does not equal to a folder in Windows. A multi-file document is a single document that contains zero or more document files and one common set of metadata. A document file is a fixed component of a multi-file document. For example, a contract scanned from a paper copy can be a multi-file document and its pages can be the document files.

**Note:** Use the **Import File...** function to add an existing file to the multi-file document. Alternatively, you can drag and drop a file on top of a multi-file document.

Do the following steps to add a new file to a multi-file document:

1. Right-click the multi-file document of your choice.
2. Select **Add File** to show a list of file types.

3. Select a type for the new file.

   The document is checked out to you and a new file representing the type of your choice is added to the multi-file document.

4. Enter a suitable name for the newly added file.

   A new file with the name and type of your choice is added to the multi-file document.

**Creating Non-Document Objects**

Besides documents, you can also create other objects like customers and projects. You can therefore use M-Files to manage, for instance, your customer database by adding and editing customer objects in the document vault. Similar to documents, objects such as customers and projects have a metadata card, but they can exist without any files. They are also deleted and edited the same way as documents.

When you start creating a new object, the first thing you will see is the metadata card.
After you have entered the values for the mandatory fields (marked with an asterisk), the object can be saved by clicking **Create**. Clicking **Cancel** deletes the newly created object.

The **Check in immediately** option is selected by default to ensure that the new object is saved to the repository immediately after clicking **Create**. You can leave the object checked out to you if you plan to add additional metadata to it before saving the information to the vault.

Object types are defined using M-Files Admin. For more information, see **Object Types**.
Example: Creating a New Customer

1. Click the Create button and then select Customer... from the context menu.
   ✔ The New Customer dialog is opened.

2. In the Customer name field, enter the customer’s name.

3. Optional: Enter other customer details in the available fields.
   📘 Click Add property to add additional customer properties.

4. Click Create once you are ready.

A new customer object is added to the vault.

Adding Content via Scanner

This section offers instructions on how to add new files to the vault – or to replace existing vault content – by using a scanner.

In this chapter

• Adding Documents from the Scanner
• Adding Documents from the Scanner to a Multi-File Document
• Replacing a Document with a Document from the Scanner
• Scanning and Text Recognition (OCR)

Adding Documents from the Scanner

1. In M-Files, click the Create button and select Add Document from Scanner... from the context menu.

2. Optional: If the Select Source dialog appears, select your scanner from the list and click Select.

3. Scan your document using the scanner application.
   ✔ When the scanning is complete, the Scanner Job dialog appears.

4. Select one of the following options:
   Select the option... If you...
   Scanning done do not want to scan additional documents.
   Scan more pages to the current document want to scan another document and combine it with the previously scanned document.
   Scan another document want to scan another document and do not wish to combine it with the previously scanned document.

5. Optional: If the Conversion to Searchable PDF dialog appears, select Convert if you want to convert the scanned document into a searchable PDF. Otherwise, click Skip Conversion.
   📘 For more information on converting scanned documents to searchable PDFs, see Scanning and Text Recognition (OCR).

6. When the New Document dialog appears, fill in the metadata and click Create once you are done.

The scanned document or documents are added to M-Files.
**Adding Documents from the Scanner to a Multi-File Document**

Complete the following steps to add documents from a scanner to a multi-file document. For instructions on converting single-file documents to multi-file documents, see Single-File and Multi-File Documents.

1. In M-Files, locate the multi-file document for which you want to add a file from the scanner.

2. Right-click the multi-file document and select **Add File > Add File From Scanner...** from the context menu.

3. Optional: If the **Select Source** dialog appears, select your scanner from the list and click **Select**.

4. Scan your document using the scanner application.

   ![When the scanning is complete, the Scanner Job dialog appears.]

5. Select one of the following options:

   - **Select the option...**
     - **Scanning done**
       - If you do not want to scan additional documents.
     - **Scan more pages to the current document**
       - If you want to scan another document and combine it with the previously scanned document.
     - **Scan another document**
       - If you want to scan another document and do not wish to combine it with the previously scanned document.

6. Optional: If the **Conversion to Searchable PDF** dialog appears, select **Convert** if you want to convert the scanned document into a searchable PDF. Otherwise, click **Skip Conversion**.

   ![For more information on converting scanned documents to searchable PDFs, see Scanning and Text Recognition (OCR).]

The scanned document or documents are added to the multi-file document.

**Note:** The multi-file document only has one set of metadata and separate files belonging to the multi-file do not have any separate metadata.

**Replacing a Document with a Document from the Scanner**

1. In M-Files, locate and select the document that you want to replace with a document from the scanner.

   ![Single-file documents and documents in a multi-file document can be replaced with a document from the scanner.]

2. Press Alt to display the menu bar and select **Operations > Scanning and Text Recognition (OCR) > Replace with File from Scanner...** from the menu bar.

   ![Alternatively, you can right-click the document and select Scanning and Text Recognition (OCR) > Replace with File from Scanner... from the context menu.]

3. Optional: If the **Select Source** dialog appears, select your scanner from the list and click **Select**.

4. Scan your document using the scanner application.

   ![When the scanning is complete, the Scanner Job dialog appears.]

---

*For full accessibility options, please contact support.*
5. Select one of the following options:

Select the option... If you...

Scanning done do not want to scan additional documents.

Scan more pages to the current document want to scan another document and combine it with the previously scanned document.

Scan another document want to scan another document and do not wish to combine it with the previously scanned document.

6. Optional: If the Conversion to Searchable PDF dialog appears, select Convert if you want to convert the scanned document into a searchable PDF. Otherwise, click Skip Conversion.

For more information on converting scanned documents to searchable PDFs, see Scanning and Text Recognition (OCR).

The existing document in M-Files is replaced with the document from the scanner.

**Scanning and Text Recognition (OCR)**

Paper documents can be added to M-Files by using a network scanner or a local scanner. For more information on network scanning, refer to Scanner Sources. When using local scanning, the scanner must be directly connected to the computer that is used to add the scanned file to M-Files. The scanning functions can be accessed by pressing the Alt key and then opening the Operations menu.

**Note:** Scanner integration in M-Files Desktop uses the TWAIN and WIA technologies. Only scanners that can be equipped with a TWAIN or WIA driver are supported.

If the M-Files OCR (optical character recognition) module is enabled, M-Files suggests that the scanned file can be converted to a searchable PDF by character recognition once the scanning is completed. You can activate the character recognition or ignore it. You can also define advanced settings for the character recognition.

**Note:** The M-Files OCR module is an M-Files add-on product available for extra fee. It can be activated with a license code. For more information, see Enabling the M-Files OCR Module and Managing Server Licenses. M-Files uses an OCR engine offered by IRIS. For the M-Files OCR module purchase inquiries, please contact our sales team at sales@m-files.com.

You can convert an image file to a searchable PDF as well. The optical character recognition is performed on the image file to enable full-text searching across the file. After the conversion, you can find, for example, a contract document converted from an image by performing a search using the names of the contracting parties or any other text included in the original image file.

M-Files also automatically suggests the character recognition if you drag an image file to M-Files, provided that you have the M-Files OCR module installed. M-Files does not suggest the character recognition for PDF files, because performing the optical character recognition on an already searchable PDF reduces the quality and increases the size of the PDF file. You must convert non-searchable PDF files into searchable PDF files manually via the context menu of the PDF file.

Optical character recognition can be performed on the following file formats:

- TIF
- TIFF
- JPG
- JPEG
- BMP
- PNG
- PDF

TIFF files using an alpha channel or JPEG compression are not supported.

Note: If text recognition is performed on an image file which was not saved and returned to M-Files, the file will only be saved as a PDF. Otherwise, the original image file can be found in the document version history.

Importing Image Files as Searchable PDFs

To import a picture file to the vault as a searchable PDF:

1. Drag and drop an image file to M-Files.

2. Optional: In the Conversion to Searchable PDF dialog, check the Use automatic language detection checkbox to set M-Files to automatically detect the document language.

3. Optional: In the Conversion to Searchable PDF dialog, click Advanced to improve the quality of the text recognition by selecting primary and secondary language options to match the language used in the image.

   Opening the advanced options disables the option to use automatic language detection.

4. Click Convert to start the conversion.

5. Once the conversion is complete, the New Document dialog appears. Finish importing the image by filling in the metadata and clicking Create.

The image file is imported to the vault as a searchable PDF, allowing you to locate it by using the M-Files search functions.

Converting an Image File Stored in M-Files to a Searchable PDF

1. In M-Files, locate the image file that you want to convert to a searchable PDF.

2. Right-click the file and select Scanning and Text Recognition (OCR) > Convert to Searchable PDF... from the context menu.

3. Optional: In the Conversion to Searchable PDF dialog, check the Use automatic language detection checkbox to set M-Files to automatically detect the document language.

4. Optional: In the Conversion to Searchable PDF dialog, click Advanced to improve the quality of the text recognition by selecting primary and secondary language options to match the language used in the image.

   Opening the advanced options disables the option to use automatic language detection.

5. Click Convert to start the conversion.

The image file is converted into a searchable PDF and any textual content in the image can be found using the search functions of M-Files.

Replacing the Content of a Document File

You can use the Replace with File... command to select another document or file whose content (data in the file) is to replace the content of the selected document.

The first version of the replaced document file will nevertheless be kept, as M-Files made a new version of the document when it was checked out. The metadata remains unchanged, so the command affects
the contents of the file only. You can view the version history by opening the History dialog (see Version History).

To replace the content of a document with that of another one:

1. Right-click the document file the content of which you want to replace.
2. Press the Alt key and select Operations > Replace with File... from the menu bar.
3. Locate and select the file that you want to use for replacing the original file content.
4. Click OK.

The content of the original file is replaced with the content of the file that you selected. Document metadata is unaffected.

Object Permissions

To open the permissions dialog of an M-Files object, click the permissions area at the bottom of the metadata card.

![Permissions dialog](image)

Figure 21: The permissions area is displayed at the bottom of a metadata card.

You can quickly select the document permissions from the drop-down menu in the Permissions dialog. These predefined permissions, or named access control lists, can be modified with M-Files Admin. An access control list consists of various user groups or users and definitions of their permissions.

Editing permissions

You can edit the permissions by first clicking the Permissions area on the metadata card and the clicking the Edit... button in the Permissions dialog.

When you want to edit the permissions, first deselect the Use named access control list checkbox. By clicking the Add... button, you can display all users, user groups, and pseudo-users registered in M-Files and edit the permissions for each of them. With the Remove button, you can remove users, user groups, and pseudo-users from the access control list. If you want to edit the user list, open M-Files Admin and refer to Managing Users and User Groups.
Multilevel permission system

You can view and modify the permissions of the object via the permissions area at the bottom of the metadata card. The options available are All, Change permissions, Remove, Edit, and Read. You can allow a permission by selecting Allow and deny it by selecting Deny.

A user with Read permissions is allowed to open the files contained by the object, as well as to view its properties. The user cannot check out the document, and is thus not able to make any changes to it. If the user does not have Read permissions to the document, it will not be visible to the user in views or search results.

Edit permissions enable users to freely edit the document. These permissions automatically include Read permission and Edit permissions. Edit permissions do not encompass any deletion rights.

Remove permissions allow users to delete the document but not destroy it altogether. Deletion rights do not encompass any other rights.

The right to Change permissions determines whether the user is allowed to change the permissions for the document in question. These permissions do not include any other permissions, and they can be used independently of the other permissions.

Note: Users with the right to Change permissions enable them to specify any other permission for themselves.

Example

Denied permissions always take precedence over allowed permissions. This means, for instance, the following: User A is a member of user group B. User group B has the Edit permission for document C. User A, on the other hand, does not have Edit permissions for document C. Even though user A has Edit permissions for document C by means of user group B, user A cannot modify the document, because it has been separately denied from user A.

Selected permissions

If the effective permissions of the object are affected by multiple sources, meaning that – in addition to its own permissions settings – its access rights are affected by automatic permissions, the Permissions dialog displays the Selected permission settings section.
In the Permissions dialog, you can select the final permissions of the object. In order for any specific permission, such as read or edit access, to be granted for a specific user, all of the permissions in effect, at all levels, must allow it simultaneously.

The Selected permission settings section contains the columns explained below.

**Source**

The Source column indicates the source from which the object has received a given permission. In the example image further above, the object has automatic permissions granted via the project IT Training, and the object’s own permissions (This object). Both of them restrict the final permissions of the object.

**Description**

To be applicable, any given permission must be granted in all active permission settings chosen.

Use simplified permissions

Effective permissions

The information shown below may not be up to date until you apply the changes on the server.

<table>
<thead>
<tr>
<th>User</th>
<th>Read</th>
<th>Edit</th>
<th>Delete</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>(current user)</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alex Kramer</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Andy Nash</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bill Richards</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>John Stewart</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Jonathan Lockhart</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Kimberley Miller</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Mike Taylor</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Samuel Lewis</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tina Smith</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tommy Hart</td>
<td>✓</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Show: Users with read access
The **Description** column provides descriptive text for the permission. If you have created an automatic permission rule based on a value, a value list, or an object type and named it, the name is displayed in this column.

**Active**

If you are allowed to bypass the automatic permissions when specifying automatic permissions for the relevant value, value list, or object type, you can deactivate the automatic permissions granted via the value by deselecting the permission in question. Then the permission setting is not active anymore and it does not influence the final permissions of the object.

**In this chapter**

- Effective Permissions
- Pseudo-users

*Effective Permissions*

An object may have various permissions of its own, as well as automatic permissions. All these permissions restrict the use of the object when the extended automatic permissions have been activated. In order for specific access rights, such as read or edit permissions, to be granted to a certain user, all settings must allow it simultaneously. That is, any given permission must be granted by all active settings in order for it to be effective.

**Example:**
**Automatic permissions for objects via any project**

The access that was specified for the object itself may cover full control of the document for all users while the automatic permissions via a project may restrict the use of the document in such a way that full control is granted to project managers only and all other users have read-only access.
Figure 23: Automatic permissions via a project may restrict the object’s permissions.

**Tip:** You can quickly check the effective permissions by user and access right via the table shown in the **Permissions** dialog.

**Example:**

**Internal restrictions to permissions**

- The permission settings of the object allow full control for all users.
- Via its class, the object has been granted permissions that give full control to management and read-only access to all other users.
- Via its safety class property, the object has been granted permissions that give full control to management and edit rights to the HR department.
Since any given right must be allowed by all of these settings to be valid, the settings mentioned above restrict each other in such a way that the following permissions are ultimately valid:

- Full control for the management.
- Read-only access to the HR department.
- No rights at all for other users.

The final restrictions are always determined by the strictest settings. As explained further above, all settings must allow the permissions simultaneously in order for them to be effective.

**Changing the final permissions of the document or other object**

Because all permissions restrict the use of the objects, changes to final access rights can be made in different ways. In the client software, you can change access rights as follows:

You can change the object's own permissions from the **Permissions** dialog. If the object has permissions granted via properties, the **Details** button is displayed on the **Permissions** tab. The button can be used to change the object's own permissions (activate *This object* first).

If deactivation of the automatic permissions is allowed, you can deactivate the automatic permissions by property.

You can change the object's properties via which automatic permissions were granted to the object (if allowed).

If you cannot change the permissions or properties associated with the object itself and the automatic permissions granted via them, you should contact the administrator for changes of access rights.

**Pseudo-users**

Instead of just adding users or user groups to the permissions of an object, you can also add so-called pseudo-users, or users from metadata as well.

You can specify pseudo-users directly for the object and use these automatic pseudo-users for automatic permissions and named access control lists. Pseudo-users that are specified via properties can also be used in workflows when you want to specify people for tasks, send a notification to users, or define permissions for different states.

You can specify pseudo-users via only those properties that are based on a **Users** or **User groups** value list.

**Example:**

You can specify that the project manager for a certain project always has access to an object if this project is indicated in the object's metadata. Then the project manager information is automatically delivered to the object with the project and, on the basis of automatic permissions, the user is granted project manager access rights to the object. If the project manager is changed, the project manager information can easily be changed for the project. This information is transferred to the documents or other objects as a background task (see this note), so updating their project manager information separately is not necessary.

You can also perform multilevel user definitions via properties. For example, you can define the project manager via the related project property (see the image below). This way, the project manager information is kept up to date constantly, as it is associated with the project instead of each separate document. You can specify access for these pseudo-users by object or utilize them when defining automatic permissions.
You can specify automatic permissions and utilize the pseudo-user definitions in, for example, the "contract of employment" class, which grants specific rights automatically to, for instance, an employee's supervisor. In this case, the supervisor is automatically found with the employee information and the supervisor is granted the appropriate rights. If the employee's supervisor changes, these rights are automatically granted to the new supervisor.

**Note:** Object permissions are updated as an asynchronous background task. Object permissions may be updated when, for example, a named access control list, a user, a user group, or the value of a pseudo-user (such as a project manager) is modified. You may monitor the progress of the task in M-Files Admin in the **Background Tasks** section. For more information, see Monitoring Background Tasks.

For more information on automatic permissions, see [Automatic Permissions for Value List Items](#).

**Creating and Completing Assignments**

Assignments transfer information and responsibility for task execution to the correct person. Assignments can be used, for instance, to request a colleague to look over a proposal before it is sent to the customer.

Assignments can be included in a workflow, or they can be independent. For more information on automatic assignments included in workflows, refer to Assign to user.

To submit a new assignment, create a new **Assignment** object. Because assignments are objects, you can define the same assignment for several objects. Or, inversely, add several different objects to the same assignment. For example, you can assign several drafts to a colleague for inspection with a single assignment.

Because the assignments are separate objects they have their own version history and permissions. For this reason, the document and assignment included in it can have separate permissions, and therefore only a user who has reading rights to the document can mark the assignment completed. The user does not need to have rights to edit the document, meaning that users with a read-only license to M-Files can also mark the assignment completed.

You have three ways to create an assignment:
• Create an assignment and add objects to it either by dragging and dropping or by using the *Add File* function from the context menu.
• Select one or more documents and select *Assignment* from the *Create* menu.
• Create an assignment without adding an object to it and define the entire task in the description field of the assignment.

![New Assignment](image)

Figure 25: The metadata card for a new assignment.

**Assignment description**

Add a free-form description of the task. The assignment notice by email displays the description to the person to whom the task was assigned.
Assigned to

Select the persons you wish to assign the task to. You can add more users by clicking the plus button (+) on the toolbar. Whenever an assignment is a separate object, all persons to whom the task was assigned must mark the assignment as complete before it is switched to the "complete" state.

Deadline

If desired, you can select a deadline for the assignment. The user gets an automatic reminder if he has not marked the assignment as completed when the deadline is approaching. The reminder will be sent using a common notification rule which can be deleted by the administrator.

The deadline can also be useful for creating views. The administrator or user can create a view to display objects whose deadline is approaching. For more information about views, refer to Creating a View.

Monitored by

You can use the Monitored by field to define the users you wish to notify every time a task is marked as complete. The person submitting the assignment is automatically defined as a task monitor as soon as the object is saved for the first time. Once the property has been automatically or manually added to the metadata card, you can change or add more monitors by clicking the plus button (+) on the toolbar.

Mark as complete icon

You can mark the assignment complete by clicking the icon next to the Assigned to field.

Creating a New Assignment for an Existing Document

1. In M-Files, locate the document for which you want to create a new assignment.
2. Right-click the document and select Create > Assignment... from the context menu.
3. In the Name or title field, enter a descriptive title for the assignment.
4. In the Assignment description field, enter a detailed description of the assignment to ensure that the assignee is properly informed about the details of the assignment.
5. From the Assigned to drop-down menu, select the person to whom this assignment is assigned to.
6. Optional: In the Deadline field, select a deadline date by which the assignment must be completed.
7. Optional: Via the workflow controls at the bottom of the New Assignment dialog, select a workflow for the assignment.
8. Click Create to create the assignment.

The new assignment appears in the Assigned to Me view of the assignee and they are informed by e-mail about the new assignment.

Creating a New Assignment for a New Document

1. In M-Files Desktop, click the Create button and select Assignment... from the context menu.
2. In the Name or title field, enter a descriptive title for the assignment.
3. In the Assignment description field, enter a detailed description of the assignment to ensure that the assignee is properly informed about the details of the assignment.
4. From the Assigned to drop-down menu, select the person to whom this assignment is assigned to.
5. Optional: In the **Deadline** field, select a deadline date by which the assignment must be completed.

6. Optional: Via the workflow controls at the bottom of the **New Assignment** dialog, select a workflow for the assignment.

7. Click **Create** to create the assignment.

8. Once the new assignment has been created, right-click the assignment in the listing area and select **Add File** and choose a suitable file format for the new file.

9. Rename the new file accordingly.

10. Optional: Double-click the newly added file to edit it.

The new assignment appears in the **Assigned to Me** view of the assignee and they are informed by e-mail about the new assignment.

**Completing an Assignment**

Once you have been given an assignment, you have to complete the tasks associated with the assignment and mark the assignment complete to indicate that you, the task assignee, have completed the assignment given to you.

1. In M-Files, locate and select the assignment that has been assigned to you.

   You can find all the assignments assigned to you in the **Assigned to Me** view.

2. Complete all the tasks required in the assignment.

3. Mark the assignment complete by doing one of the following:

   a. On the metadata card, click the ✓ (Mark complete) icon next to your name in the **Assigned to** field.
   
      or
   
   b. In the task area, select **View and Modify > Mark Complete**.
   
      or
   
   c. Right-click the assignment and select **Workflow > Mark Complete**.

4. Optional: Depending on the workflow settings of the assignment, you may still need to add an electronic signature to authorize the assignment completion.

The assignment is completed and it is removed from the **Assigned to Me** view.

**Completing an Approval Assignment**

Once you have been given an approval assignment, you have to complete the tasks associated with the assignment and mark the assignment either approved or rejected to indicate that you, the task assignee, either approve or reject the target of the assignment. You could mark an assignment rejected, for instance, if you consider the target document to be unpublishable.

1. In M-Files, locate and select the assignment that has been assigned to you.

   You can find all the assignments assigned to you in the **Assigned to Me** view.

2. Complete all the tasks required in the assignment.
3. Mark the assignment either approved or rejected by doing one of the following:
   a. On the metadata card, click either the ✓ or X icon next to your name in the Assigned to field.
      or
   b. In the task area, select View and Modify > Mark Approved/Rejected.
      or
   c. Right-click the assignment and select Workflow > Mark Approved/Rejected.
4. Optional: Depending on the workflow settings of the assignment, you may still need to add an electronic signature to authorize the operation.

   The assignment is completed and it is removed from the Assigned to Me view. The user defined in the Monitored by property gets a notification e-mail of the approval or rejection.

Making a Copy of an Existing Object

To create a copy of an existing object in the vault, right-click the object of your choice and select Make Copy from the context menu. This command creates an entirely new object using the metadata and contents of the source object. The version history is not copied to the new object.

Functions in Microsoft Outlook

M-Files offers several features and diverse benefits for the daily handling of e-mail messages and for their utilization in customer relationships. For example, you can automate storing messages in M-Files by utilizing Microsoft Outlook rules and M-Files features. Extensive integration with Microsoft Outlook provides you with, for example, the following features:

• E-mail messages and attachments can be saved to M-Files in various file formats.
• You can send an e-mail message and, at the same time, save it to an M-Files vault of your choice by using the Send and Save to M-Files button in the M-Files tab for Microsoft Outlook.
• E-mail messages can also be saved automatically with their metadata by means of Outlook rules and M-Files features.
• Contact persons and customers can be automatically associated with e-mail messages.
• The M-Files flag indicates messages that have been saved to M-Files.
• Messages related to a particular subject are interlinked in M-Files. Thanks to this, the entire message thread is easily accessible and readable in M-Files.
• The Show in M-Files function allows you to open a stored message in the M-Files user interface.
• When an e-mail message is saved to M-Files in Microsoft Outlook, the document date will automatically be the same as the e-mail date, no matter when the message is saved to M-Files.

Note:

If you want to disable the Send and Save to M-Files button in Microsoft Outlook, configure the following registry setting on the client computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
<th>Value type</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files&lt;version&gt;\Client\Common&lt;vault name&gt;\MSOutlookRibbon</td>
<td>ShowSendAndSaveInMFilesTab</td>
<td>REG_DWORD</td>
</tr>
</tbody>
</table>
If you want to add the **Send and Save to M-Files** button to the default composer window in Microsoft Outlook, configure the following registry setting on the client computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files&lt;version&gt;\Client \Common&lt;vault name&gt;\MSOutlookRibbon</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>ShowSendAndSaveInBuiltInTab</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>Description</td>
<td>When enabled, the <strong>Send and Save to M-Files</strong> button is visible in the default composer window of Microsoft Outlook.</td>
</tr>
<tr>
<td>Default value</td>
<td>0 Disabled</td>
</tr>
<tr>
<td>Value</td>
<td>0 Disabled</td>
</tr>
<tr>
<td></td>
<td>1 Enabled</td>
</tr>
</tbody>
</table>

The M-Files system administrator may also distribute these settings to multiple client computers. For more information, see Configuration Options for the "Send and Save to M-Files" Button.

**In this chapter**

- Saving An E-Mail Message in Microsoft Outlook to M-Files
- Storage Formats
- Creating a Microsoft Outlook Rule for M-Files
- Saving messages in M-Files Folders
- Associating Messages with Contacts
- The M-Files Flag

**Saving An E-Mail Message in Microsoft Outlook to M-Files**

1. In Microsoft Outlook, do one of the following operations:
   
   a. Locate the e-mail message that you want to save to M-Files, right-click the message and select **Save to M-Files**, and then select the vault where you want to save the selected e-mail message.
   
   or
   
   b. Locate the e-mail message that you want to save to M-Files, and then drag and drop the message to the preferred M-Files folder located in the Microsoft Outlook navigation pane.
or

c. First compose a new e-mail message, then, in the **Message** window, open the **M-Files** tab and click **Send and Save to M-Files**, and finally select the appropriate vault from the drop-down menu.

The **New Document** dialog is opened.

2. From the **Save as type** drop-down menu, select the format in which the e-mail message is saved.

   For more information about e-mail message storage formats, see **Storage Formats**.

3. Fill in the metadata for the e-mail message and click **Create** once you are done.

   Note that some properties may be automatically populated. For more information, see **Automatically Populated Metadata**.

The selected e-mail message is added to the selected vault in M-Files. An M-Files flag is also added to the message in Microsoft Outlook as an indication that the message has been saved to M-Files.

**Storage Formats**

E-mail messages and attachments can easily be saved from Microsoft Outlook directly to M-Files. The M-Files capabilities described in this section are available in Microsoft Outlook versions 2010, 2013, 2016, and 2019, as well as in Office 365 ProPlus versions currently supported by Microsoft according to their lifecycle policy.

Microsoft Outlook offers the following options for the **Save to M-Files** feature:

![New Document dialog](image)

**Figure 26**: E-mail messages can be saved to M-Files in many formats.

**Microsoft Outlook message (*.msg)**
The e-mail message and any attachments are stored in M-Files in MSG format. The stored file and its attachments open as a message in Microsoft Outlook.

**Microsoft Outlook message; separate attachments (*.msg; *.*)**

The e-mail message is stored as a multi-file document: message text is stored in MSG format and the attachments in their native file formats. The stored MSG file opens as a message in Microsoft Outlook. The attachments open in the applications associated with the file format.

**Text only; no attachments (*.txt)**

The e-mail message is stored as a text file. The stored file opens in, for example, Notepad. Attachments are not saved.

**Text only; separate attachments (*.txt; *.*)**

The e-mail message is stored as a multi-file document: message text is stored as plain text and the attachments in their native file formats. The attachments open in the applications associated with the file format.

**MHTML document; no attachments (*.mht)**

The e-mail message is stored in M-Files in MHT format. The stored file is opened in a program that supports reading of MHT files such as Internet Explorer.

**MHTML document; separate attachments (*.mht; *.*)**

The e-mail message is stored as a multi-file document: the content of the message is stored in MHT format and the attachments in their native file formats. The attachments open in the applications associated with the file format.

**Save Attachments to M-Files**

The **Save Attachments to M-Files** function stores only e-mail attachments. The attachments are stored in their native file formats. If an e-mail message contains several files as attachments, these files are saved as a multi-file document. If the message contains one attachment, the file is saved as a single-file document. The attachments open in the applications associated with the file format.

- **Note:** If you would prefer to store multiple attachments as separate documents rather than as a single multi-file document, please contact your M-Files consultant for additional information.

**Creating a Microsoft Outlook Rule for M-Files**

By utilizing Microsoft Outlook rules, you can easily automate saving specific kinds of email messages to M-Files on the basis of, for example, the sender, subject, or recipient of a message. For instance, you can specify that all proposal messages that you send are to be saved to M-Files on the basis that the subject field contains the word *proposal*.

- **Note:** These instructions are for Microsoft Outlook 2013. If you are using a different version of Microsoft Outlook, there may be minor differences in how rules are created.

Complete the following steps to create a Microsoft Outlook rule for M-Files:
1. Open Microsoft Outlook and select an email message that represents the type of message for which you want to create a rule.

   You can select the message and create the rule on the basis of, for example, the sender of the message, text in the subject field, or the recipient of the message.

2. On the **Home** tab, in the **Move** section, click **Rules** and the select **Create Rule...** from the menu.

   The **Create Rule** dialog is opened.

3. Click the **Advanced Options...** button.

   The **Rules Wizard** dialog is opened.

4. Check the condition or conditions that an email message must meet for this rule to be applied.

   If you want to create a rule that applies to messages that are sent by the selected sender, check the **from <sender>** check box.

5. Optional: If necessary, click an underlined value in the rule description field to edit the rule condition.

6. Click **Next**.

7. Check the **move a copy to the specified folder** check box.

   You can also move the messages themselves directly to M-Files so that they are deleted from Microsoft Outlook once they are moved, but the best practice normally is to **move a copy** of the message to M-Files, in which case the actual message remains in the original folder, such as the **Inbox** or **Outbox** folder.

8. Click **specified** in the rule description field.

   The **Rules and Alerts** dialog is opened.

9. Expand the **M-Files** node and then select the vault to which you want to move copies of messages that match this rule.

10. Click **OK** to close the **Rules and Alerts** dialog and then click **Next**.

11. Optional: If you need to make exceptions to this rule, check any exception check box that you want to be applied and edit the exception in the rule description field, if necessary.

12. Click **Next**.

13. In the text field, enter a descriptive name for the rule.

14. Check the **Run this rule now on messages already in...** and **Turn on this rule** check boxes and click **Finish** to finish creating the rule.

The email messages in Microsoft Outlook that match the rule that you have just specified are moved automatically to the selected vault in M-Files.

**Note:** If Microsoft Outlook is not open when you receive a message that matches this rule and would therefore be automatically saved to M-Files, M-Files will suggest that you **Save pending messages now** when Microsoft Outlook is opened the next time.
Saving messages in M-Files Folders

In addition to using the Save to M-Files function, you can save messages to M-Files by using M-Files folders. This offers several additional features for saving messages:

- You can save messages quickly and easily by dragging them to M-Files folders in Microsoft Outlook.
- M-Files folders are automatically available to you in Microsoft Outlook if M-Files has been installed on your computer. Automatically used M-Files folders correspond to the M-Files vaults to which you have added a document vault connection.
- The messages are always copied from their original folder in Microsoft Outlook: messages are not removed from their original Microsoft Outlook folder when you move them to the M-Files folder.
- You can specify automatically populated metadata for each M-Files folder.

The functions described in this section are available in Microsoft Outlook versions 2010, 2013, 2016, and 2019, as well as in Office 365 ProPlus versions currently supported by Microsoft according to their lifecycle policy.

In this chapter

- Automatically Populated Metadata

Automatically Populated Metadata

You can specify automatically populated properties to be added to e-mail messages when you save them to M-Files by dragging them to M-Files folders in Microsoft Outlook. These settings are folder-specific, allowing you to utilize multiple subfolders for a variety of use cases. The function is available in Microsoft Outlook versions 2010, 2013, 2016, and 2019, as well as in Office 365 ProPlus versions currently supported by Microsoft according to their lifecycle policy.

Note: These folders need to be added as subfolders under the automatically created M-Files folders (representing your M-Files vault connections). If you create a folder directly on the main level, you create a normal Microsoft Outlook folder, for which you cannot specify M-Files properties.

You can find the Specify M-Files Properties function in Microsoft Outlook by right-clicking an M-Files folder.
Click the **Add...** button to define a new property.

You can, for instance, use the property **Project** and set it to have the fixed value *Hospital Expansion (Miami, FL)*. This way, the messages dragged into that folder are automatically associated with the *Hospital Expansion (Miami, FL)*. Alternatively, if you wish to save all job applications in the *Job application* class, select the folder property **Class** and set its value to *Job application*.

You may also specify M-Files folder properties to be read from the e-mail message itself. In this case, select **Add...**, then the **Read from the e-mail message** option and choose a suitable field from the drop-down menu.

**Allow users to retain the property value for this folder**

This setting (visible only to users with at least the right to manage common views) adds a **Retain** column to the folder properties dialog. The **Retain** option is available for all users, and also controlled by each
individual user. Activating the **Retain** option for a property tells M-Files to remember the latest value provided by the user, ignoring the original fixed value set by the administrator.

Let's say the organization is connected to two projects with the same customer, and the default project has been set to *Alpha*. The project manager for project *Beta* would probably want to enable the **Retain** option, because this way the property needs to be changed only once. After this, M-Files remembers that the project manager wants to associate his e-mails with project *Beta*, not *Alpha*, even though the default project was set to *Alpha*.

**Permissions**

The **Permissions** option enables you to define user permissions for the messages that are saved in this M-Files folder. This should not be confused with the view permissions for common folders (see below).

**Prompt for metadata**

You can specify whether the metadata card is to be displayed when messages are dragged into the M-Files folder. The metadata card should be displayed if you wish to check or modify automatically populated metadata during saving, or if you have not defined any folder-specific properties.

**Specifying common M-Files folders**

You can also specify that the M-Files subfolder you created is common to all users, in which case the folder will be displayed in Microsoft Outlook to all users. A common M-Files subfolder can be created and specified by a user with at least the right to manage common views. When the user drags a message to a common folder, the message automatically receives the metadata (properties) that have been specified for the common folder.

The common folder settings are applied once the user starts Microsoft Outlook while being logged into the vault.

**Common folder view permissions**

As soon as the **Common to all users** option has been enabled, the **Permissions** tab appears next to the **Metadata** tab. This allows you to select view permissions for the common folder. This should not be confused with the **Permissions** option on the **Metadata** tab (see above).

**Defining Automatically Populated Metadata**

1. In Microsoft Outlook, select an existing M-Files folder or create a new M-Files folder:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do the following...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define automatically populated metadata for an existing M-Files folder</td>
<td>Right-click an existing M-Files folder in the navigation pane and select <strong>Specify M-Files Properties</strong> from the context menu.</td>
</tr>
<tr>
<td>Define automatically populated metadata for a new M-Files folder</td>
<td>Right-click a vault in the navigation pane, select <strong>New Folder...</strong> from the context menu, name the folder and press the Enter key.</td>
</tr>
</tbody>
</table>

✔️ The **Properties** dialog is opened.

2. Click **Add...** to define a new property.

✔️ The **Define Property** dialog is opened.
3. From the **Property** drop-down menu, select an M-Files property that you want to automatically populate, and then select either:

   a. **Use a fixed value** and enter or select a value in the field below if you want to populate the property value with a fixed value.

   or

   b. **Read from the e-mail message** and select an e-mail header field to read information from by using the **Field** drop-down menu if you want to populate the property value with information read from the imported e-mail message.

4. Click **OK** to close the **Define Property** dialog.

   The automatically populated property is added to the **Properties** list in the **Properties** dialog.

5. Optional: On the **Properties** list in the **Properties** dialog, check the **Retain** check box of an automatically populated property if you wish M-Files to always remember the most recent value set by any user for this property, ignoring the original value set in this dialog.

6. Using the **Permissions** drop-down menu, define the permissions for documents created via this folder.

7. Optional: Check the **Prompt for metadata** check box if you wish to display the metadata card and prompt for additional metadata whenever an e-mail message is dragged and dropped to this folder.

8. Using the **Save as type** drop-down menu, select the e-mail message format for the messages saved to this folder.

9. Optional: Check the **Common to all users** check box if you wish to display this folder to all vault users in Microsoft Outlook.

   If the **Common to all users** option is enabled, you can specify the users who may see this folder on the **Permissions** tab.

When an e-mail message is dragged and dropped to the Microsoft Outlook folder for which you have just set automatically populated metadata definitions, the message is saved to M-Files with automatically populated metadata.

**Associating Messages with Contacts**

You can use M-Files Admin for specifying messages to be automatically associated with contact persons and customers saved in M-Files on the basis of the sender and recipient information. A message from, for example, **matt.bay@estt.com** can be automatically associated with the contact person **Matt Bay** and the customer **ESTT**.

**Note:** This feature is available in Microsoft Outlook versions 2010, 2013, 2016, and 2019, as well as in Office 365 ProPlus versions currently supported by Microsoft according to their lifecycle policy.

When the user is saving an e-mail message to M-Files in Microsoft Outlook, M-Files looks for similarity between the e-mail addresses in the message and the properties that have been specified in M-Files Admin. On the basis of similarity and the properties specified by the administrator, M-Files automatically associates the message with customers or contact persons when the message is saved in the M-Files folder in Microsoft Outlook.

This automation takes place on a vault-specific basis (with a vault-specific M-Files folder in Microsoft Outlook), also applying to all subfolders of the M-Files folder in question.
The M-Files Flag

The M-Files flag, shown in the Microsoft Outlook message listing, indicates that you have already saved the message to M-Files.

If some other user (for instance another recipient) has saved the same message to M-Files, M-Files prompts you to confirm whether you wish to save that message again. Even if you do not save the message again, the M-Files flag will now be displayed in Microsoft Outlook for that message.

With the Update M-Files Status function in the context menu of the message, you can easily display all M-Files flags. Also messages saved in M-Files by other users will then have an M-Files flag in Microsoft Outlook.

2.2.2. Removing and Archiving Content

This section deals with ways you can remove objects from your vault, as well as with archiving vault content.

In this chapter

- Deleting and Undeleting Objects
- Archiving

Deleting and Undeleting Objects

Deleting objects

If you want to delete an object, right-click it and select Delete from the context menu. The object is not lost permanently, but it becomes deleted and can still be found by performing a filtered search (see Deleted under Status-Based Conditions).

Please note, however, that you can see deleted objects only if you have the appropriate permissions. If you have the system administrator permissions, full control of vault or the right to see and read all objects (including deleted ones), you can use a view that shows all the deleted objects (see Creating a View).

Undeleting objects

The Undelete option can be used to restore deleted objects. First, find the deleted item either via the Deleted view or using advanced search options, and then right-click the deleted item and select Undelete from the context menu.

Destroying objects

If you want to remove an object permanently, right-click a deleted one and select Destroy. Alternatively, when you are deleting an object, you can check the Destroy permanently check box.

Archiving

When documents are no longer actively needed in the document vault, they can be archived. For example, the system administrator can store all documents marked for archiving by users in a separate archive file, from which they can also be restored to active use.
Mark for archiving

You can specify objects to be archived by selecting them in the listing area, right-clicking one of them, and then selecting Archiving > Mark for Archiving from the context menu. The archiving operation performed via M-Files Admin moves the marked objects from the vault to a separate archive file. For more information, see Archiving Old Versions.

Clear Archiving Marker

You can remove the archiving marker of the selected object by right-clicking it and selecting Archiving > Clear Archiving Marker from the context menu.

2.2.3. Editing Content

This section explains how documents are edited in M-Files via first checking them out for editing or co-authoring and then, when you are done with your changes, checking them back in to the vault. The section also describes how to enable and use the Annotations and Redlining feature, how to use object comments, workflows, and version history, and how to compare document content.

In this chapter

• Checking Out a Document
• Checking Out a Document for Co-Authoring
• Checking Out a Document for Co-Authoring via Microsoft SharePoint
• Checking In a Document
• Annotations and Redlining
• Object Comments
• Using Workflows
• Version History
• Comparing Documents
• Functions in Microsoft Word, Microsoft Excel and Microsoft PowerPoint
• Functions in AutoCAD and AutoCAD LT

Checking Out a Document

Checking out a document is an M-Files function that prevents concurrent editing. A checked out document can still be viewed and opened in read-only mode by other users.

When you are opening a document that has not yet been checked out, the following message is displayed:

![M-Files](image)

Figure 28: The checkout message.
When you check out a document, a small check mark appears on the document icon to indicate that it has been checked out to you. A red sign indicates that the document has been checked out to someone else, in which case you are only able to open it in read-only mode.

![Project Plan](image1) ![Project Plan](image2)

Figure 29: An object checked out to someone else and an object checked out to you.

**Note:** When you check out a document in M-Files Desktop, the M-Files Web user interface indicates that the same document is checked out to someone else even when you are using exactly the same user account in both clients. The same applies the other way around, meaning that when you check out a document in M-Files Web and view it in M-Files Desktop, it will appear to be checked out to somebody else. This happens because the two clients use a different client cache. You can, however, use the **Undo Checkout** command.

**Functions without checkout**

You can add files to and remove files from a multi-file document without checking it out for editing. You can also rename and replace files without checking them out.

**Sending a check-in request**

If you need to edit a document that is currently checked out to some other user, you can send the user a check-in request by right-clicking the document and selecting **Send Check-in Request** from the context menu. The user then receives an e-mail message informing them that you are requesting the document to be checked in. The message also contains a link to the document in question. The check-in request is sent to the e-mail address associated with the user's login account.

**Undoing Document Checkout**

With the **Undo Checkout** function, you can undo checking out a document without saving the changes on the server. In this case, you lose all changes you made to the document during the checkout. This function is useful when you have checked a document out, made changes and saved the document, but do not want the changes to take effect. In other words, you want to restore the document to how it was before you checked it out.

If the document has never been checked in, it is deleted when the **Undo Checkout** function is used.

**Checking Out a Document for Co-Authoring**

With M-Files, several users can edit a document at the same time. You can check out a document for co-authoring via Microsoft Office for the web when the Microsoft Office for the web tools and co-authoring have been enabled for your vault or vaults.

**Editing an Office Document in the Co-Authoring Mode**

You need to have an Office 365 account and **editing permissions** to the document you want to edit via co-authoring.

To check out a document for co-authoring:
1. Locate the object you want to make available for co-authoring in M-Files Desktop or in M-Files Web.

2. Right-click the document and select **Check Out for Co-authoring** in the context menu.

   - **Note:** Co-authoring is only available for single-file DOCX, XLSX, XLSM, and PPTX documents.

   - In M-Files Desktop, a security warning is opened about who can view and modify the file during co-authoring. If you are using M-Files Web, skip to step 4.

3. In the **Security Warning** dialog in M-Files Desktop, click **Begin Co-authoring**.

   - The document is opened in Microsoft Office for the web.

4. Edit the document in the browser.

   - **Tip:** If you are using Google Chrome and the browser cannot complete loading the editor, check whether the address bar contains an icon informing the user about a blocked redirection. If it does, go ahead and click it, and allow the redirection to be carried out. Finally, close the browser window or tab and double-click the document in M-Files to reopen the editor.

5. Once you are done, click **End Co-authoring** to close the editor.

   - In M-Files Web, this command is called **Save and return to M-Files**.
6. To end co-authoring, right-click the object in M-Files Desktop or M-Files Web and select **Check In** in the context menu.

   - The user who checks out the document for co-authoring must be the one who also checks it in. The changes made during co-authoring are attributed to the user who checked out the document for co-authoring and checked in the new version.

   - You can reject the changes made in co-authoring by right-clicking the object and selecting **Undo Checkout** from the context menu.

The changes made by you and anyone else during co-authoring are saved to M-Files, unless you selected **Undo Checkout** instead of checking in the document.

**Participating in Co-Authoring**

When a document has been checked for co-authoring, you can take part in the authoring process by doing the following steps:

1. Locate the co-authored document in M-Files Desktop or M-Files Web and double-click it to open it in the co-authoring mode.

   - A co-authored document is marked with a yellow icon containing a white checkmark.

   - A dialog about editing the document in the co-authoring or opening it in read-only mode is opened.

2. Select **Edit (Co-authoring)**.

   - The document is opened in Microsoft Office for the web.

   - **Tip:** If you are using Google Chrome and the browser cannot complete loading the editor, check whether the address bar contains an icon informing the user about a blocked redirection. If it does, go ahead and click it, and allow the redirection to be carried out. Finally, close the browser window or tab and double-click the document in M-Files to reopen the editor.
3. Edit the document in the browser.
   
   Microsoft Office automatically saves your document when you make changes to it.

4. Once you are done, click **End Co-authoring** to close the editor.
   
   In M-Files Web, this command is called **Save and return to M-Files**.

The changes you made to the document are saved to M-Files once the user who started the co-authoring has ended the co-authoring and checked in the document.

**Checking Out a Document for Co-Authoring via Microsoft SharePoint**

If you are not using Microsoft Office for the web, you can use the co-authoring functionality via Microsoft SharePoint. In co-authoring via Microsoft SharePoint, also a person without an M-Files account can participate in the co-authoring process. For instructions on how to set the co-authoring features to be used via Microsoft SharePoint, see the knowledge base article **Customizing Co-Authoring and Sharing Features**.

**Editing an Office Document in the Co-Authoring Mode via Microsoft SharePoint**

You need to have a Microsoft account for co-authoring Office documents. If you do not have one, you can create the account the first time you check out an object for co-authoring.

1. Locate the object you want to make available for co-authoring in M-Files.

2. Either:
   
   a. Right-click the object and select **Check Out for Co-authoring** from the context menu.
   
   or

   b. Right-click the object and select **Begin Co-authoring** from the context menu if the file is part of a multi-file document or if it is already checked out to you.

   
   [Note: By default, co-authoring is available for DOCX, XLSX, and PPTX files only.

   A security warning is opened about who can view and modify the file during co-authoring.

3. Click **Begin Co-authoring** in the **Security Warning** dialog.

4. In the **Co-authoring** dialog, click **Send Link** to send the shared object link to co-authoring participants via your mail client.

   You can also right-click the object you have checked out for co-authoring and select **Send Co-authoring Link...** whenever you want to share the co-authoring link to someone.

   Please note that anyone with the link can view and modify the file.

5. Double-click the object in the listing area to begin co-authoring.

   The document is opened in Microsoft Office for the web.
6. Click **Edit in Browser** in the upper right corner to begin editing in the co-authoring mode.

   M-Files functions (such as adding metadata to the content) are not available during co-authoring.

7. Optional: Click **Open in Word** (or **Open in Excel** or **Open in PowerPoint**) above the Office ribbon to begin co-authoring in the desktop application.

8. Save your changes if you are using the desktop application.

   Microsoft Office automatically saves your document when you make changes to it.


10. Right-click the object in M-Files, and select **End Co-authoring** from the context menu.

11. Finally, right-click the object again and select **Check In** to check in the changes.

   The user who checks out the document for co-authoring must be the one who also checks it in. This M-Files user is responsible for the changes made in the document. The changes made during co-authoring are attributed to the user who checked out the document for co-authoring and checked in the new version.

   You can reject the changes made in co-authoring by right-clicking the object and selecting **Undo Checkout** from the context menu.

   The changes made by you and anyone else during co-authoring are saved to M-Files. If you want to share the document for co-authoring again, check out the file for co-authoring and send a new link to the file.

**Participating in Co-Authoring via Microsoft SharePoint**

When a document has been checked for co-authoring, there are two ways you can take part in co-authoring the document.

1. Either:

   a. If you receive a link to a co-authored document, click the link to open the document in the co-authoring mode.

   or

   b. Locate the co-authored document in M-Files and double-click it to open it in the co-authoring mode (a co-authored document is marked with a red cloud on top of its icon) and click **Edit (Co-authoring)** in the Co-authoring dialog.

2. Click **Edit in Browser** in the upper right corner to begin editing in the co-authoring mode.

3. Optional: Click **Open in Word** (or **Open in Excel** or **Open in PowerPoint**) above the Office ribbon to begin co-authoring in the desktop application.

4. Save your changes if you are using the desktop application.

   Microsoft Office automatically saves your document when you make changes to it.

5. Close the document.

   The changes you made to the document are saved to M-Files once the user who started the co-authoring has ended the co-authoring and checked in the document.
Checking In a Document

When you have edited and saved a document and are no longer using it, you should save the changes on the server by right-clicking the object and selecting Check In from the context menu. Alternatively, you can select the object and press the Alt key, and then select Operations > Check In from the menu bar. After this, other users will be able to check out the document and edit it.

Tip: You can simultaneously check in all documents that you have checked out in the Checked Out to Me view. The shortcut for checking in a document is Ctrl + I.

Checking in with comments

You can easily comment on changes you made when checking in a document by right-clicking it and selecting Check In with Comments... from the context menu. Alternatively, you can select the object and press the Alt key, and then select Operations > Check In with Comments... from the menu bar. In the Check In dialog, you can enter a free-form description of the changes you made. The comments are displayed in the Comments view of the object.

Note: Comments retain their permission settings. This means that they are visible only to the users defined in the permission settings that were in use when the comment was added.

Annotations and Redlining

You can add various comments and stamps, as well as draw arrows, boxes and other shapes to your documents. The feature supports most common file types, including Microsoft Word, Microsoft Excel, Microsoft PowerPoint and Visio documents, email files, RTF files, HTML and web archive files as well as OpenDocument files and PDF documents.

Note: The annotations are not added to the documents themselves, but rather as detachable layers that can also be hidden if need be.

Note: The M-Files system administrator must first enable the annotations and redlining feature before documents can be annotated. For more information, see Annotations and redlining.

Enabling annotations in the user interface

To make sure that annotations are enabled in your user interface:

1. Open M-Files Desktop and access your vault.
2. Press the Alt key on your keyboard.
3. Open the View menu.
4. Enable the Show Annotations option.

Annotation objects

Your annotations are saved as separate Annotation objects under the main document. M-Files automatically creates these objects every time you start creating new annotations. Annotation objects contain an XFDF file (XML Forms Data Format) that basically tells M-Files the type, form, and location of your annotations.

Creating and editing annotations

Please see the topic Using Annotations for instructions on adding and editing annotations.
Supported file formats

This feature supports the following file formats:

- Email files (eml, emlx, msg)
- HTML and web archive files (htm, html, mht, mhtml)
- Image files (tif, tiff, jpg, jpeg, bmp, gif, png)
- Microsoft Excel files (xlsx, xlsm, xltx, xltm, xlsb, xls, xlt)
- Microsoft PowerPoint files (pptx, pptm, ppsx, ppsm, potx, potm, ppt, pps, pot)
- Microsoft Word files (docx, docm, dotx, dotm, doc, dot)
- OpenDocument files (odt, ott, ods, odp)
- PDF files
- RTF files
- Text files (txt)
- Visio drawings (vsd, vdx, vss, vsx, vst, vtx, vdw)

Troubleshooting

If you are running into issues with annotations or are unable to use them, see Why can't I convert a document to PDF format or annotate a document? for assistance.

In this chapter

- Using Annotations

Using Annotations

The annotation options are shown in the Alt menu and in the task area on the left-hand side of the M-Files Desktop user interface.

Creating a new annotation object

To start creating new annotations to a document:

1. Select a document in suitable format (for instance, a DOC or PDF).
2. Make sure the Preview tab (not, for example, the Metadata tab) is selected in the right pane.
3. Select the New Annotations command via the task area on the left-hand side of the user interface.

This should create a new Annotation object under your document, visible via the listing view, and open the annotation toolbar in the preview window.

Note: The task area displays the New Annotations option only for documents that do not yet have any annotations. If you want to create another annotation object, you can do so by pressing the Alt key and selecting Create > Annotation... from the menu. It is, however, recommended to have only one annotation object for each document.

Adding annotations

The annotation toolbar includes a number of different ways for you to highlight parts of the document.
You can add comments as well as text emphasis in the form of text highlighting, strikethrough text and text underlines. You can also add arrows, lines, rectangles and various other shapes for emphasis, including text boxes. In addition to these elements, there is a pencil tool coupled with an eraser if you make a mistake. Finally, you can add various built-in stamps, such as "Draft", "Approved" or "Final".

**Saving and printing annotated documents**

The toolbar also displays icons for printing and saving. You can use these functions to print the annotated document or to save a copy to people with no access to your document vault. Saving a copy is also a convenient way for embedding all the annotations to a single PDF file.

**Saving annotations**

Once you have finished making annotations, you can save your changes by selecting the **Save Annotations** option via the task area. Alternatively, you can select another document, which triggers M-Files to ask if you want to check in the annotated document. The modifications are saved once the document has been checked in.

**Editing annotations**

To edit previously added annotation objects:

1. Select the annotated document or the annotation object.
2. Make sure the **Preview** tab is active.
3. Select **Edit Annotations** via the task area.

This should open the annotation toolbar in the preview window.

**Showing and hiding annotations**

When you have an annotated document selected, the task area should display the options to display or hide the annotations.
To hide the annotations, select the *Hide Annotations* option via the task area. Alternatively, select the *Show Annotations* if they are not visible.

**Object Comments**

You can add free-form comments to objects in the document vault with the **Comments** function. Saved comments are saved and displayed in the comment history.

**Note:** Comments retain their permission settings. This means that they are visible only to the users defined in the permission settings that were in use when the comment was added.

**Note:** You can only add comments for objects for which you have edit permissions, and only when you are *not* using a read-only license. As an exception, you can add a comment for an object when you are changing its workflow state by right-clicking the object and selecting a command under the **Workflow** menu or via the workflow commands in the task area.

Comments can be displayed by right-clicking an object and selecting **Comments** from the context menu or via the metadata card.

See also **Checking in with comments**.

**Using Workflows**

Each document has a lifecycle, during which it is processed and edited. During the lifecycle, the contributors may change and different persons may be responsible for different decisions. However, it is important that every person participating in the process is aware of their own areas of responsibility and the working stage.

The M-Files workflows enable modeling document lifecycles according to real world processes. The workflows are grouped into states that represent the working stages of the document or other object.

![Workflow Diagram](image)

**Figure 31:** Workflows facilitate routine tasks of the organization, such as processing purchase invoices.

Workflows are created and modified in M-Files Admin by M-Files system administrators. For more information about creating and editing workflows, see **Configuring Workflows**.

Workflows and workflow state transitions can be selected in M-Files Desktop via the workflow controls at the bottom of the metadata card.

**Changing the workflow state**

You can change the workflow state in various different ways:

- Select the object on the listing area, then click the workflow state field at the bottom of the metadata card and select the new state. This opens the **Change State** dialog that allows you to add comments about the state transition to the object. If you click **Cancel**, the state transition is made but no comment
is added. If you click OK, the state transition is made and the possible comment is added, but the metadata card is not yet saved. Finally, click Save.

- Right-click the object and select Workflow > Change State... from the context menu. This opens the Change State dialog that allows you to move the object to a new workflow state. You can also add comments about the state transition to the object. If you click Cancel, the state transition is not made. If you click OK, the state transition is made and the metadata card is saved.

![Change State](image)

**Electronic signatures**

If an electronic signature has been defined for the state transition, you must give your authentication data (user ID and password) and log in to perform a state transition. In order for the state to change, the object must be checked in. Transitions requiring a signature can only be performed one object at a time.

The electronic signature does not refer to an electronic "fingerprint"; it always requires entering the user identification and logging in. For more information, see **Electronic Signatures**.

**Version History**

One of the many advantages of M-Files is the fact that the earlier versions of objects are retained. You can go back in the object history according to the times the object has been checked out and checked back in.

When you create a document and check it in, the first version of the document is saved on the server. When you later check out the document and open it, make changes, save the document and check it back in, the second version of the document is saved on the server. You can later roll back to either of these two versions.

In the History dialog, the ![icon](image) icon marks an earlier version of the object, in this example a Microsoft Word document. You cannot change the content or metadata of earlier versions.
Add Label to This Version

You can assign a label to a document version. The label will be displayed in the Version label column in the History dialog.

To assign a label to the selected document version, click Add Label to This Version... and then select a label from the drop-down menu. You can also add a new version label to the list by clicking the small arrow next to the drop-down menu and selecting New Value (Version label)... from the context menu. By default, no labels are assigned to any version.

Clear this label from the other versions of the object

If you have the System administrator server role or the Full control of vault vault user rights and if you want the selected label to be cleared from the other versions, check the Clear this version label from the other versions of the object check box. This is useful if you want only one version of a contract to be labeled as approved.

Modify Version Details

The Modify Version Details... option allows you to assign one or more version labels to the document version and to add a free-form comment that will be displayed in the History dialog. These comments are also displayed in the comments view of the object's metadata card and in the comment history of the Comments function (see Object Comments).

Roll Back

By default, the different versions of an object are listed from the oldest to the newest on the basis of their creation date. You can restore old versions of documents with the Roll Back option.
The option creates a new version of the document with the contents of the old version while preserving any intermediate versions. This function is useful when you have made and saved changes in a document but do not want them to take effect. You can use the Roll Back option only when the document is not checked out.

Note: You need to have the appropriate permissions on the object to be able to restore a previous version of it. For example, if you are rolling back to a previous version where the permission settings and the metadata of the object have changed, you need to have the change permissions and edit rights on the object. If, on the other hand, only the metadata or the contents of the object have changed, you must have at least edit rights on the object.

Version History and Permissions

To be able to access a previous version of an object, the user needs to have access rights to the version in question as well as to the latest checked in version.

Comparing Documents

Once the Document Compare feature has been set up as explained in the document Setting Up M-Files Document Compare, you can use M-Files to compare the content of two documents or two versions of the same document. This section describes a few ways you can use the feature.

Note: The file extension of the compared documents must be either DOC, DOCX, PDF, or RTF, and their combined file size must be less than 16 MB.

Comparing Document Content via the Listing Area

To start comparing the content the most recent version of a document with that of another version or document, follow the steps provided below. If you need to compare two specific versions of a document with each other, see Comparing Document Content via the History Dialog.

1. Log in to the vault of your choice.
2. Locate the document you want to compare, for example via a search or a view.
3. Right-click the document on the listing area, and in the context menu, select either:

   a. **Compare > Compare with Previous Version** to compare the current document version with the previous version.

   or

   b. **Compare > Compare with Another Version...** to compare the current document version with an earlier version. This command opens the History dialog from which you can select the desired document version to compare the content with.

   or

   c. **Compare > Compare with Another Document...** to compare the current document version with another document entirely. This command opens the Windows Open dialog that you can use to select the desired document to compare the content with.

   The Document Compare window is opened.
4. Review the modifications by using the **Previous Change** and **Next Change** buttons, the navigation links in the **Change Summary** list, or simply by scrolling through the document.

5. Optional: Save a copy of the comparison in PDF or DOCX format by using the commands **Save as PDF**, **Save as DOCX**, or **Track Changes**.

   - **Save as DOCX** creates a simple Microsoft Word rendition of the comparison that you see in the **Document Compare** dialog, whereas **Track Changes** creates a document that allows you control the tracked changes via the **Review** tab in Microsoft Word.

**Comparing Document Content via the History Dialog**

Starting the comparison via the M-Files Desktop listing area allows you to compare the most recent version of the selected document with another version or document, but if you want to compare two specific versions of a document with each other, you need to start the comparison via the **History** dialog.

To start comparing the document content of two specific document versions:

1. **Log in** to the vault of your choice.
2. Locate the document you want to compare, for example via a search or a view.
3. Right-click the document and select **History** in the context menu.

   - The **History** dialog is opened.
4. Hold down the Ctrl key and select the two versions that you want to compare from the list.

5. Right-click on one of the selected versions and select **Compare Selected Documents**.

   The **Document Compare** window is opened.

6. Review the modifications by using the **Previous Change** and **Next Change** buttons, the navigation links in the **Change Summary** list, or simply by scrolling through the document.
7. Optional: Save a copy of the comparison in PDF or DOCX format by using the commands **Save as PDF**, **Save as DOCX**, or **Track Changes**.

**Save as DOCX** creates a simple Microsoft Word rendition of the comparison that you see in the **Document Compare** dialog, whereas **Track Changes** creates a document that allows you control the tracked changes via the **Review** tab in Microsoft Word.

**Comparing Document Content via the Microsoft Word Ribbon**

The **Compare** functionality is only available for documents that are stored in M-Files.

To start comparing the content of the document you are editing in Microsoft Word with that of another document or document version:

1. In the Microsoft Word menu ribbon, select the M-Files section and then **Compare**.

2. Select either:

   a. **Compare > Compare with Previous Version** to compare the current document version with the previous version.

   or

   b. **Compare > Compare with Another Version...** to compare the current document version with an earlier version. This command opens the **History** dialog from which you can select the desired document version to compare the content with.

   or

   c. **Compare > Compare with Another Document...** to compare the current document version with another document entirely. This command opens the Windows **Open** dialog that you can use to select the desired document to compare the content with.

3. Review the modifications by using the **Previous Change** and **Next Change** buttons, the navigation links in the **Change Summary** list, or simply by scrolling through the document.
4. Optional: Save a copy of the comparison in PDF or DOCX format by using the commands **Save as PDF**, **Save as DOCX**, or **Track Changes**.

   **Save as DOCX** creates a simple Microsoft Word rendition of the comparison that you see in the **Document Compare** dialog, whereas **Track Changes** creates a document that allows you control the tracked changes via the **Review** tab in Microsoft Word.

**Functions in Microsoft Word, Microsoft Excel and Microsoft PowerPoint**

The M-Files functions accessible directly in Microsoft Word, Microsoft Excel and Microsoft PowerPoint for Microsoft Windows make it easy to work with documents. You can access the functions from the **File** menu, **Office** menu, or **M-Files** menu. The menus may look a little different, depending on the software versions in use.

![M-Files functions menu](image)

Figure 33: All M-Files functions are available through the M-Files menu.

The M-Files functions discussed in this section are available in Microsoft Word, Microsoft Excel, and Microsoft PowerPoint versions 2010, 2013, 2016, and 2019, as well as in Office 365 ProPlus versions currently supported by Microsoft according to their lifecycle policy.

**Open From M-Files**

You can open a document for reading or editing directly from the document vault. If you are using several document vaults, use the **Open from M-Files** function to select the desired document vault. This function is also available on the **File** and **Office** menus.

**Save to M-Files**

**Save** is the handiest way to save a new or edited document to M-Files. When you save to M-Files directly, the metadata card opens for editing just as it does when you create a new document via M-Files Desktop. For more information, see **Creating a Document**. If you are using several document vaults, choose the target document vault in the **Save** submenu. This function is also available on the **File** and **Office** menus.

**Explore M-Files**

You can open the M-Files user interface at the same time. If the opened file is in M-Files, the **Explore M-Files** function displays the file in M-Files, making it easier to perform other M-Files functions on the file (such as copying or sending a link by e-mail).

**Check Out**

The **Check Out** function checks out for editing a document that has been opened as read-only. This function converts a read-only document into an editable document.

**Note:** If the document is in read-only mode and has been edited, and the **Check Out** function is then executed, all changes will be lost.
Check In

Once you are finished editing a document, use the **Check In** function to check in the document to the document vault. The **Check In** function saves the document you have edited to the vault and then the document is closed in Microsoft Word.

Check In Changes

The **Check In Changes** function allows you to check in your changes to the vault while you continue editing the document. This function allows other vault users to see your changes in the vault while you are still editing the document. If you no longer need to edit the document, use the **Check In** function instead.

Undo Checkout

The **Undo Checkout** function closes the current document and cancels its checkout without saving changes. If the **Undo Checkout** function is performed on a document that has been edited, all changes made after the document was checked out will be lost.

**Note:** **Undo Checkout** cannot be used on a single file of a multi-file document. In this case, the function is not available in the M-Files menu.

Compare

With **Compare**, you can compare the content of the current document to an earlier version of the same document or to another document entirely. See **Comparing Documents** for more information.

**Note:** **Compare** is available in Microsoft Word only.

Insert Property

For more information, see **Insert M-Files Property**.

Properties

The **Properties** function allows you to view document properties defined in M-Files. When you click the **Properties** button, the metadata card that is opened is the same as the metadata card in M-Files.

The document properties can also be edited and saved as in M-Files. For more information, see **Document Properties**.

In this chapter

- **Insert M-Files Property**

Insert M-Files Property

Document metadata stored in M-Files can be included in document contents by using the **Insert Property** function.
You can set up text fields or cells in Microsoft Word, Microsoft Excel, and Microsoft PowerPoint documents in which the selected M-Files properties are filled in automatically. For example, you can select a customer name and address from the document properties and insert them as the recipient's contact information in a proposal.

Other M-Files properties can be added in a similar way. For example, you might insert the name of your proposal document as the heading of the cover letter or add product information to the proposal.
Figure 35: The "Insert Property" function automatically inserts selected document properties into the document content.

You can also add an electronic signature to an Microsoft Word document by selecting the **Insert property** function. For more information, see [Electronic Signatures](#).

Document metadata can also be edited by using the **Properties** function when the document is opened in Microsoft Word, Microsoft Excel, or Microsoft PowerPoint. For more information, see [Properties](#).

**Note:** In Microsoft PowerPoint, the **Insert Property** function is available in versions 2010, 2013, 2016, and 2019, as well as in Office 365 ProPlus versions currently supported by Microsoft according to their lifecycle policy.

**Note:**

If required, you can limit the number of characters inserted into Microsoft Word documents via the **Insert Property** feature by adding the following Microsoft Windows registry setting to the client computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
<th>Value type</th>
<th>Description</th>
<th>Default value</th>
<th>Valid values</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Client\MOfficeAddin</td>
<td></td>
<td>Defines whether users are allowed to insert long property values (that is, values of over 255 characters) to Microsoft Word documents via the M-Files <strong>Insert Property</strong> feature.</td>
<td>1</td>
<td>0 Inserting a long property value to a Microsoft Word document only displays the first 255 characters. 1 Inserting long values is allowed. The number of inserted characters is not limited to 255 characters.</td>
</tr>
</tbody>
</table>

**Note:** If you wish to enable this feature for M-Files Web and M-Files Mobile, see [Enabling Metadata Field Updates for M-Files Web and M-Files Mobile](#) for instructions.
Utilizing Insert Property with document templates

The **Insert Property** function can be used to conveniently create document templates. Text fields or cells defined in the template are automatically populated with the selected properties when a new document is created. For example, a proposal template can be set up to include fields for the properties **Customer, Contact, Address, and Country**. When a new proposal is created using the template, the customer information in the metadata is automatically inserted into the fields. This means that address information no longer has to be separately copied from the customer contact information.

An existing document can be defined as a document template in M-Files by selecting the **Is template** option. The property definition permissions in M-Files Admin are used for controlling which users are able to set documents as templates.

If a property does not have a value, the text fields or cells in the document templates may also be left empty. When a user creates a new document using the template, these text fields and cells are automatically populated with the current property values.

An M-Files property inserted into a Microsoft Word document is displayed as a text field, which by default turns gray when clicked. In Microsoft Excel documents, M-Files properties are displayed as cell formulas and in Microsoft PowerPoint documents as text areas.

Note, however, that inserting metadata in a document does not in itself require the document to be defined as a **template**.

*Example: Inserting M-Files Properties in Microsoft Word*

1. In M-Files, locate a Microsoft Word document of your choice, double-click it, and then click the **Check Out** button.
   - The selected document is opened in Microsoft Word.

2. In Microsoft Word, place the cursor where you want the M-Files property to appear in the document.

3. Open the M-Files ribbon and click **Insert Property**.
   - The **Insert M-Files Property** dialog is opened.

4. The properties and property values of the current document are listed in the **M-Files properties** list. Select a property by clicking the name of the property.

5. Click **OK** to close the **Insert M-Files Property** dialog.

The property value of the selected property is inserted in the selected location of the Microsoft Word document.

*Functions in AutoCAD and AutoCAD LT*

The M-Files functions accessible directly in AutoCAD and AutoCAD LT make it easy to work with CAD drawings. You can access the functions from the **File** menu or the **M-Files** menu. The menus may look a little different, depending on the version of AutoCAD or AutoCAD LT in use.

The following M-Files functions are available in Autodesk AutoCAD versions 2017–2020 and AutoCAD LT versions 2017–2018. The functions are also available in discipline-specific products based on these versions of AutoCAD, such as AutoCAD Architecture, AutoCAD Civil 3D, AutoCAD Map 3D, and AutoCAD MEP.
M-Files functions in AutoCAD and AutoCAD LT are:

- Open from M-Files
- Save to M-Files
- Check Out
- Check In
- Undo Checkout

For more information about these functions, see Functions in Microsoft Word, Microsoft Excel and Microsoft PowerPoint.

Properties

For more information about this function, see Properties.

Insert Field

With the Insert Field option, you can add M-Files metadata to drawings along with AutoCAD fields. The M-Files metadata fields are located in the M-Files field category in the Field selection dialog in AutoCAD.

For more information, see Insert M-Files Property.

2.2.4. Object Relationships

You can define relationships between objects to link interrelated documents. For instance, an offer could contain an offer document and a related price list along with a company brochure. Each object can be updated separately and they have separate version histories. Relationships do not create copies of linked objects, they simply establish references between objects.

By using relationships, you can define metadata connections between objects, just as via the metadata card. For example, you can link a customer with an object. The customer then also appears in the metadata of the object. Likewise, the relationships entered via the metadata card will appear in the Relationships dialog.

Tip: You can utilize the properties of a related object in creating indirect views and searches or in defining filter settings (for more information, see Indirect searches).

Complete the following steps to modify the relationships of an object:

- In M-Files Desktop, right-click an object and select Relationships from the context menu.

  The Relationships dialog is opened.
To add a relationship for the selected object, complete the following steps:

a) On either the Relationships From This Object or All Relationships tab, click the Add Relationship... button.

b) In the Select Target Object dialog, select the target object by using either the search or the views, or right-click an object and select History from the context menu to select a specific version of the target object.

Tip: Instead of using the Select Target Object dialog, you can also drag and drop objects from other windows onto the Relationships dialog to form several relationships at once.

c) Click Open.

d) In the Define Relationship dialog, select between the Latest version and Specific version option.

This option defines the version of the target object to which the relationship applies. If you select Latest version, the relationship always points to the latest version of the target object. If you select Specific version, the relationships points to a particular version of the target object and therefore, if the object is updated, the modifications are not shown via the relationship. You can select an older version of the target object via the History dialog.

e) Click OK to form the relationship.
To edit a relationship of the selected object, complete the following steps:

a) If the object is not checked out, click **Check Out** in the **Relationships** dialog to be able to edit its relationships.

b) On either the **Relationships From This Object** or **All Relationships** tab, select the relationship that you want to edit and then click the **Edit Relationship...** button.

c) In the **Relationship Properties** dialog, select between the **Latest version** and **Specific version** option.

   This option defines the version of the target object to which the relationship applies. If you select **Latest version**, the relationship always points to the latest version of the target object. If you select **Specific version**, the relationships points to a particular version of the target object and therefore, if the object is updated, the modifications are not shown via the relationship. You can select an older version of the target object via the **History** dialog.

d) Click **OK** to finish editing the relationship.

To remove a relationship of the selected object, complete the following steps:

a) If the object is not checked out, click **Check Out** in the **Relationships** dialog to be able to remove a relationship.

b) On either the **Relationships From This Object** or **All Relationships** tab, select the relationship that you want to remove and then click **Remove Relationship**.

c) In the **Confirm Delete** dialog, click **Yes** to confirm that you want to remove the selected relationship.

Click **Close** to close the **Relationships** dialog.

In this chapter

- Adding a Relationship Between Two Objects
- Relationships Between Objects in Separate Vaults
- Subobjects

Adding a Relationship Between Two Objects

1. In M-Files, locate and select the object from which you want to add a relationship to another object.

2. Either:

   a. Press Alt to display the menu bar and select **Operations > Relationships**.

   or

   b. Right-click the object and select **Relationships**.

3. Either on the **Relationships From This Object** or **All Relationships** tab, click the **Add Relationship...** button.

4. In the **Select Target Object** window, locate the object to which you want to add a relationship from this object and click **Open**.

5. Select either:

   a. **Latest version** if you want the relationship to always point to the latest version of the object.

   or

   b. **Specific version** if you want to add a relationship to the current version of the object, so that if the object is updated, the relationship still points to the object version that was the latest version of the object when the relationship was created.
6. Click OK to create the relationship.

The objects between which you have added the relationship should now have relationship links to each other. When you expand either of the objects in the listing area, you should see the linked object under the node representing the type of the referenced object, for instance Documents or Customers.

**Relationships Between Objects in Separate Vaults**

Relationships can also be created between objects residing in different vaults. Then the objects are not exported from a vault to another but the relationship is created by referring to an object in another vault, that is, a link is created to the original object.

You can create a relationship by dragging an object from one vault to another or by using the Relationships function in the same way as when adding a relationship to an object in the same vault.

In addition, you can replace a file with a file in another vault as if the two files were in the same vault.

**Shortcuts**

The related object in another vault is displayed as a shortcut in the target vault. When you double-click this object, M-Files shows the object in the original vault in the same way as when M-Files shortcuts are used.

In the target vault, you can see the basic properties of the related object (shortcut) and information for the original vault, but the actual changes and opening of the object are performed in the original vault. You must have permissions for the original vault and original object if you want to view and edit the related object in the original vault.

You can rename the shortcut in the target vault if so desired; this change does not change the name of the original object in the source vault and does not cause any conflicts between vaults.

**Shortcut permissions**

The shortcuts have their own permissions. The default setting is the target vault's default permission for new objects set by object type.

**Shortcuts created through synchronization**

When data is synchronized between vaults, for such purposes as archiving or publishing, shortcuts are created in certain cases through metadata of the imported objects. For example, if a document related to a certain project is imported to the target vault but the project is not imported, M-Files creates a shortcut for the project in the target vault. Then this shortcut is a link to an object in the other vault. The requirement is that the Project property definition be associable between the source and target vaults. The metadata definitions themselves must always be associable so that their related objects and values can be displayed or imported as shortcuts.

**Requirements**

M-Files automatically creates a relationship to objects that have a built-in object type (for instance, Document or Document collection). If the object type of the object is created by the user (Customer, Project, etc.), you should ensure that the metadata definitions of the object types can be matched between vaults.
Subobjects

Objects can also have subobjects. For example, a customer object may have a contact person as a subobject. The system administrator can define object types and relationships between them via M-Files Admin.

The Ctrl + J shortcut displays the object's subobjects and allows you to edit and remove them if necessary. This function enables, for instance, adding a new contact person directly by finding the desired customer from the document vault and using the Subobjects option to create a new contact person.

2.2.5. Document Collections

A document collection is a set of interrelated documents. The difference from a multi-file document is that each member of a document collection is independent and has its own metadata. In addition, the document collection has a collective set of metadata that is independent of the member documents. By contrast, in a multi-file document, all document files share the document's properties.

To create a document collection in M-Files, click the Create button and select Document collection... from the list. Then select a class and fill in the shared metadata of the collection.

Tip: If the document collection object type does not appear on the list, press the Alt key on your keyboard and select Create > Document Collection... via the menu bar. The list under the Create menu in the top pane and task area only shows object types that have the Show the creation command in the task area setting enabled.

Example:

A company is preparing a new marketing authorization application. A marketing authorization application consists of the following separate documents: cover letter, general product description, technical product specification, statement by the safety authorities, and the company's financial statement. Because the company wants to utilize the application's member documents in other document collections and as separate documents, it makes sense to create a document collection for the application.

Using the Collection Members dialog

Once you have created a document collection, you can open the the Collection Members dialog to manage its content. To open the dialog, right-click the document collection and select Collection Members from the context menu.
Adding, editing, and removing collection members

Use the buttons along the bottom of the dialog to add, edit, and remove collection members. To add several objects at once, you can drag and drop members from the listing view.

Note: You can edit and remove documents only by first checking out the document collection.

Latest versions and specific versions

When you add a relationship, M-Files prompts for the desired behavior regarding the version of the added document. You can set the relationship to always apply to the latest version or to the current version. In the latter case, further editing of the document will not be reflected in the document inside the document collection.

2.2.6. Offline Use

This section describes how you can make content available offline, how editing documents works in the offline mode, and what happens when you go back online.

In this chapter

- Offline Availability
- Going Offline
• Going Online

Offline Availability

You can mark objects to be available in the offline mode individually or use Offline Filters.

Mark for Offline Availability

You can select Operations > Offline Availability > Mark for Offline Availability from the menu bar to specify documents and other objects to be available offline when you do not have a network connection. The selected documents will be shown in the Offline view.

You can select individual objects, a group of objects, view entities, or virtual folders to be available offline. If you select a view or virtual directory to be available offline, M-Files creates a new offline filter corresponding to the view in question. This way, all new objects conforming to the filter conditions will automatically be available offline according to the filter settings. You can also edit the offline filter you have created. For more information about offline filters, see Offline Filters.

You can go offline by selecting Operations > Go Offline from the menu bar, and conversely, go back online by selecting Operations > Go Online from the menu bar. For more information, see Going Offline and Going Online.

Remove Offline Availability

You can remove the offline availability of the selected object by selecting Operations > Offline Availability > Remove Offline Availability from the menu bar.

In this chapter

• Offline Filters

Offline Filters

Navigate to the Offline view (accessed via Other Views of the home screen). In this view, you can define filters ensuring that all important objects are accessible even without a network connection.

To remove the offline filter, select Delete from the filter context menu. This only removes the offline filter, not the view itself.

Example: Creating an Offline Filter for a Project

1. On the M-Files home screen, navigate to Other Views > Offline.
2. Press Alt to open the menu bar.
3. Select Create > Offline Filter...

✓ The Offline Filter Properties dialog is opened.

4. In the Name field, enter a name for your offline filter.

✓ The name will appear in the listing area under Other Views > Offline.
5. Click Define Filter... to specify the conditions that objects must meet to be shown in this view.

The Define Filter dialog is opened.

6. On the Properties tab, click Add Condition and add the following condition:

   a) From the Property drop-down menu, select Project.
   b) Select = from the Operator drop-down menu.
   c) From the Value drop-down menu, select a desired project.

7. Click OK to close the Define Filter dialog and to return to the Offline Filter Properties dialog.

8. If unchecked, check the Show documents and other objects check box.

9. Click OK to finish creating the offline filter.

The offline filter you have created appears under Other Views > Offline. Every document and object in this view can be accessed even when the connection to M-Files Server is unavailable.

Going Offline

You can use M-Files without a network connection as well.

You can start using M-Files without a network connection by pressing the Alt key and selecting Operations > Go Offline from the menu bar, or by clicking your username in the top-right corner of the user interface and selecting Go Offline from the context menu. You will then have access to the Offline view, which shows all the objects that have been made available offline. In other words, the documents and objects in this view can be accessed even when a connection to M-Files Server is unavailable.

The Go Offline command prepares M-Files so that it can also be used offline. The same preparation procedures are performed during a normal logout and when Windows is being shut down.

Example: A sales representative is leaving the office to give a presentation to a customer. She makes a PowerPoint presentation and intends to present it offline. She will have no access to the corporate network from the customer premises, but M-Files offers access to the PowerPoint document through the Offline view.
You can make the desired documents and other objects available offline by using the **Mark for Offline Availability** command. For more information, see [Offline Availability](#). Collection members, relationship objects, and subobjects are also automatically available offline if they are associated with objects marked as available offline.

When you are using the offline mode, you can create new objects and edit objects available offline.

**Going Online**

You can move back online from the offline mode by pressing the Alt key and selecting **Operations > Go Online** from the menu bar, or by clicking your username in the top-right corner of the user interface and selecting **Go Online** from the context menu. Once you are online, M-Files restores all other views and you can continue browsing the document vault normally. You can also, for example, check in documents shown in the **Offline** view and therefore save the changes on the server.

When switching to online mode, M-Files detects whether the changes made offline cannot be checked in to the server directly. For instance, somebody may have edited the document on the server while you were editing it offline. If the latest version checked in to the server matches the version you started to edit offline, the version edited offline can be saved as the new document version. In this case, no changes have been made to the object in question during offline editing. However, if the server contains a new versions created during the time offline, M-Files notifies the user, who can then choose from the following procedures:

- Save the version edited offline as a new document (the document on the server remains unchanged).
- Reject the changes made (accepts the new version on the server and rejects changes made offline).
- Cancel **Go Online**.

**Tip:** If you check out the document online, editing offline should not create unclear situations. The user can edit the document normally while offline, and other users can see that the document is checked out to the user in question.

### 2.3. Sharing Content

This section describes how you can share vault content to both people that have access to the same vault as you and to people outside your organization.

![Diagram of vault content sharing](https://via.placeholder.com/150)

**Figure 38:** You can share vault content in a number of ways, both to users with vault access and to people that do not use M-Files.
In this chapter

- Sharing Links and Shortcuts
- Sharing Public Links
- Sharing, E-mail and PDF

2.3.1. Sharing Links and Shortcuts

M-Files users may have document vault connections with different names, and each user may have different views. M-Files provides a function to create shortcuts that are not affected by these factors. Such links might be used for instance in e-mail messages with references to the documents of the organizations.

The Get Hyperlink dialog

To create links or shortcuts to a document, right-click the document and select Get Hyperlink... from the context menu. The dialog offers four different ways to share your link.

![Get Hyperlink dialog](image)

Figure 39: The Get Hyperlink dialog.

**Note:** For instructions on creating links to objects, files and views via M-Files Web, see Creating M-Files Web URLs.

Creating a Windows or an M-Files shortcut

Use these options to create a shortcut to your Windows desktop. Opening the Windows shortcut opens the document in the default application for the document type, and the M-Files shortcut opens the document or object in M-Files Desktop.

Sending an M-Files shortcut by e-mail
This option automatically creates and opens a new e-mail message with a shortcut included in the message. The Send Link by E-Mail function under the Sharing, E-mail and PDF context menu item creates a new e-mail message with shortcuts in the same way.

**Copying a hyperlink to clipboard**

This option enables you to copy an object hyperlink to your clipboard. By using this option, you can ensure that the link remains usable even if the document is renamed. You can paste the link to e-mail messages in HTML format, or open the document directly in M-Files by entering the path in the Windows Run function.

If you need the link – or, for example, just the M-Files Desktop link – in plain text format only, you can copy the URL from the text field to your clipboard, and then click Cancel or close the dialog with the X button.

**Tip:**

The command in the plain text URL can also be manually changed if you want the link to do something else than to just open the object or file. The available commands are: show, showmetadata, open, view and edit. The table below describes how these commands function.

<table>
<thead>
<tr>
<th>Command</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>show</td>
<td>Displays the object in M-Files Desktop.</td>
</tr>
<tr>
<td>showmetadata</td>
<td>Shows the metadata card for the object.</td>
</tr>
<tr>
<td>open</td>
<td>Shows the check-out dialog and opens the document in the default application.</td>
</tr>
<tr>
<td>view</td>
<td>Opens the document in the default application in read-only mode without prompting the user to check it out.</td>
</tr>
<tr>
<td>edit</td>
<td>Checks out the object and opens it for editing in the default application.</td>
</tr>
</tbody>
</table>

For instance, the command `m-files://edit/<vault GUID>/<object name>/<id>` would check out the document and open it for editing in the associated default program.

For more information about M-Files URL properties, refer to this knowledge base article.

**Advanced**

The advanced settings enable you to specify whether you want the link to always point to the latest version of the document (Latest version) or to the version that you have selected (This version).

**Modifying the appearance of the hyperlinks**

You can also change how the hyperlinks are displayed. See Modifying the Appearance of Hyperlinks for more information.

**Public web links**

It is also possible to use web links to publicly share documents contained in M-Files. This can be achieved in two ways:

- M-Files Web can be used as a content management system for sharing documents with interested parties. For more information, see Document-Specific Publishing via a Web Link.
- Documents in M-Files can be shared publicly by creating temporary public links to specific documents, making the documents available to anyone who is given the link. For more information, see Sharing Public Links.
In this chapter

- Creating Shortcuts
- Sending Shortcuts
- Copying Hyperlinks
- Modifying the Appearance of Hyperlinks

Creating Shortcuts

1. In M-Files, right-click the object for which you want to create a link and select Get Hyperlink... from the context menu.

   The Get Hyperlink dialog is opened.

2. Select one of the following options and click OK:

<table>
<thead>
<tr>
<th>Select...</th>
<th>If you...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Windows shortcut (.lnk)</td>
<td>want to create a shortcut that opens the selected object in the default application for the file type.</td>
</tr>
<tr>
<td>Create M-Files shortcut (.mflink)</td>
<td>want to create a shortcut that displays the selected object in M-Files Desktop.</td>
</tr>
</tbody>
</table>

3. Click Yes when you are prompted to place the shortcut on your desktop.

The shortcut that you have just created is placed on your desktop. Double-clicking the shortcut, depending on the shortcut type, either opens the object in the default application for the file type or displays the object in M-Files Desktop.

Sending Shortcuts

1. In M-Files, right-click the object for which you want to create a link and select Get Hyperlink... from the context menu.

   The Get Hyperlink dialog is opened.

2. Select the Send M-Files shortcut (.mflink) by e-mail option.

A new e-mail message is opened in your e-mail client, containing the M-Files shortcut as an attachment.

Copying Hyperlinks

1. In M-Files, right-click the object for which you want to create a link and select Get Hyperlink... from the context menu.

   The Get Hyperlink dialog is opened.

2. Select the Copy hyperlink to clipboard option.

3. Either:

   a. If you want the link in HTML format, click OK to copy the hyperlink to the clipboard.

   or

   b. If you want the link in plain text format, select and copy the text in the text field and click Cancel.
You now have the link to the selected object copied to your clipboard. If you chose the HTML format and you paste the link, for example, to a new Outlook message, the link is pasted to the message in the following HTML format, provided that you have HTML formatting enabled in Outlook:

Order for Structural Engineering.doc (Desktop, Web, Mobile)

If you copied the plain text format instead, or you paste the link in HTML format to an editor or e-mail client that does not support HTML formatting, the link is pasted as plain text.

Modifying the Appearance of Hyperlinks

The appearance of M-Files hyperlinks can be modified with a few registry settings. The registry settings can be added either to `HKEY_LOCAL_MACHINE` for client-wide settings, to `HKEY_CURRENT_USER` for settings specific to user and vault, or to both. If both are used, `HKEY_CURRENT_USER` takes precedence.

In `HKEY_LOCAL_MACHINE`, the key name is: `HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files \<version>\Common\Settings\Hyperlinks`.

In `HKEY_CURRENT_USER`, the key name is: `HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files \<version>\Client\MFShell\<vault>\Hyperlinks`.

For both keys, the actual settings are as described in the tables below.

<table>
<thead>
<tr>
<th>Value name: FriendlyNameModeForHTML</th>
<th>Value Type</th>
<th>REG_DWORD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Defines whether the object title acts as a link in the HTML version of the hyperlink. Values from 1 to 3 also define the type of the link.</td>
<td></td>
</tr>
</tbody>
</table>
| Value Data                        | • 0: No hyperlink  
  • 1: Desktop hyperlink (default)  
  • 2: Web hyperlink  
  • 3: Mobile hyperlink |

**Tip:** M-Files also adds the link to your clipboard in the XML Spreadsheet format for pasting the link to, for example, a cell in Microsoft Excel. The type of the link is specified via the `FriendlyNameModeForHTML` value. If its value has either been set to 0 or not been specified at all, the link opens the object in M-Files Desktop.

<table>
<thead>
<tr>
<th>Value name: CanShowSpecificLinks</th>
<th>Value Type</th>
<th>REG_DWORD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Controls whether the HTML version of the hyperlink can include client-specific links after the object title.</td>
<td></td>
</tr>
</tbody>
</table>
| Value Data                      | • 0: No client-specific links are appended.  
  • 1: Client-specific links are appended as specified via the "SpecificLinksMode" value (see further below). |

<table>
<thead>
<tr>
<th>Value name: SpecificLinksMode</th>
<th>Value Type</th>
<th>REG_DWORD</th>
</tr>
</thead>
</table>
2. Daily Use

<table>
<thead>
<tr>
<th>Value name: SpecificLinksMode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description: If <code>CanShowSpecificLinks</code> is set to &quot;1&quot;, controls which of the client-specific links are appended to the HTML version of the hyperlink after the object title.</td>
</tr>
<tr>
<td>Value Data</td>
</tr>
<tr>
<td>• 0: None</td>
</tr>
<tr>
<td>• 1: Desktop</td>
</tr>
<tr>
<td>• 2: Web</td>
</tr>
<tr>
<td>• 3: Desktop and Web</td>
</tr>
<tr>
<td>• 4: Mobile</td>
</tr>
<tr>
<td>• 5: Desktop and Mobile</td>
</tr>
<tr>
<td>• 6: Web and Mobile</td>
</tr>
<tr>
<td>• 7: Desktop, Web, and Mobile</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Value name: PlainTextModeForClipboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value Type: REG_DWORD</td>
</tr>
<tr>
<td>Description: Controls the content of the plain-text version of the hyperlink copied to the clipboard.</td>
</tr>
<tr>
<td>Value Data</td>
</tr>
<tr>
<td>• 0: All hyperlinks</td>
</tr>
<tr>
<td>• 1: Desktop hyperlink only</td>
</tr>
<tr>
<td>• 2: Web hyperlink only</td>
</tr>
<tr>
<td>• 3: Mobile hyperlink only</td>
</tr>
</tbody>
</table>

2.3.2. Sharing Public Links

Documents in M-Files can be shared publically by creating temporary public links to selected documents, making the documents available to anyone who is given the link.

Before you begin, make sure that M-Files Web is up and running (see Setting Up Web and Mobile Access to M-Files for more information) and that the M-Files Web home page is specified in the Document Vault Properties dialog (see M-Files Web for more information).

**Note:** For configuration options of public links, see Configuration Options for Public Links.

Do the following steps to create a public link:

1. In M-Files locate the object that you want to share using the search or views.
2. Optional: If you want to share an earlier version of the object, right-click the object and select History.
3. Right-click the object (or the object version) and select Share Public Link... from the context menu.

   The Share Public Link dialog is opened.
4. Use the **Expiration date (local time)** date and time picker to select the expiration date after which the public link will no longer be active.

5. Optional: In the **Description** field, enter a description to be shown in the **Description** column of the **Shared by Me** dialog.

6. Click **Create Public Link**.

   ![Create Public Link dialog](image)

   The public link is created in the **Public link** field.

7. Click **Copy** to copy the public link to the clipboard.

8. Click **Close** to close the **Share Public Link** dialog.
You can now share the public link to anyone who may be interested. The link becomes inactive after the set expiration date. If you want to view or remove your shared public links, see Managing and Removing Shared Public Links.

Managing and Removing Shared Public Links

You can view and remove public links that you have shared in the Shared by Me window. Users with the administrative rights Full control of vault or See and read all vault content can see and manage the public links shared by all vault users.

1. In M-Files Desktop, click your username in the top-right corner and select Shared by Me from the context menu (or Shared Files (All Users) if you have the Full control of vault or See and read all vault content rights).

The Shared by Me window is opened, displaying all the public links that you have shared.

2. To copy a shared public link to the clipboard, locate the desired link in the list, and click Copy Link.

3. To remove a shared public link, locate the desired link in the list, and click Stop Sharing.

A confirmation dialog is opened.

4. Click Yes to confirm removing the public link.

The link that you have just removed is no longer active and can no longer be used to access the previously public object.

2.3.3. Sharing, E-mail and PDF

The Sharing, E-mail and PDF menu offers the following sharing options:

- Send Link by E-mail
• Send Copy by E-mail and Send as PDF by E-mail
• Save as PDF
• Convert to PDF

Send Link by E-mail

With this option, M-Files creates a new e-mail message with a link to the file. The recipient must have access to the document vault and the file.

Send Copy by E-mail and Send as PDF by E-mail

You can send a file directly in PDF format by selecting Operations > Sharing, E-mail and PDF > Send as PDF by E-mail from the menu bar, whereby the file will be converted to PDF format prior to sending. When the PDF file is ready, M-Files creates a new e-mail message with the PDF file already attached. Alternatively, you can send the file in its original format by selecting Operations > Sharing, E-mail and PDF > Send Copy by E-mail from the menu bar. In both cases, the file is sent as an e-mail attachment without any linking to M-Files.

Save as PDF

You can save a file directly as a PDF file by using selecting Operations > Sharing, E-mail and PDF > Save as PDF... from the menu bar. This enables you to save the file as a PDF file in M-Files without needing to open the file.

If you save a single-file document as a PDF file, M-Files creates a new document in PDF format. If you save a file in a multi-file document as a PDF file, M-Files suggests saving the file in the same multi-file document by default.

Convert to PDF

You can also convert a file to PDF. In this case, the original file (for example, a Word file) is replaced with the corresponding PDF file.

You can select Operations > Sharing, E-mail and PDF > Convert to PDF (adds separate file) from the menu bar when you want to keep the original version of the selected document and then have a PDF version of it. If you are converting a single-file document using this option, M-Files will convert it to multi-file document while the PDF conversion is made.

Troubleshooting

If you are running into issues converting documents to PDF, see Why can't I convert a document to PDF format or annotate a document? for assistance.

2.4. Finding Content

This section describes how you can locate the content you are looking for by using the M-Files search functions and views.
In this chapter

- Searching
- Using Views

2.4.1. Searching

The most efficient way of finding your documents and other objects is to use the M-Files search functions. This is especially useful when you remember only a single detail about the document or object, such as the creation date or the user who created the document.

Quick search

With quick searches, you can search for words associated with the object.

Search options and filters

The search options and filters allow you to define more search criteria related to the properties and location of the objects that you are searching for. You can expand the search options for quick search by clicking the search options button ( ) to the right of the quick search field. The search filters can be opened by clicking the Filters tab in the right pane.
For example, if you want to view the documents that a certain user has checked out during last month, this is easier to do by defining search criteria in the search options than by creating a new view.

**Search result sorting**

The order in which the search results are listed is based mainly on frequency or recency of use. The main idea is to emphasize things that are relevant for the user. The following information is of primary importance for providing search results:

- When was this document or other object **created**?
- When and how many times was the document or other object **edited**?
- When and how many times was it **processed**?

By using this information, you will find relevant data on the **newest and most commonly used objects in the organization**. If several years have passed since the creation of the document and the document has not been updated for a long time, the document is perhaps not considered very relevant for the user and is therefore not included among the first search results.

In addition to the information related to object handling mentioned above, the occurrence of the search string in metadata or file contents influences the order of the search results. The ranking of an item among the search results is influenced by the search string appearing in the following places:

1. The name or title of the document or other object
2. Other metadata than the name or title of the document or other object
3. File contents

The name is of special importance because the document or object name often contains essential information about the content. Additionally, M-Files ignores certain metadata that tend to decrease the relevance of the search results. Full-text search in files is influenced by, for example, the length of the file in such a way that the shorter document is given more importance than the long one when the two have the same number of matches for the search string. In any case, the order of the search results is always more dependent on metadata than file content.

**Tip:** When **translatable object titles** are enabled, objects can have multilingual names. The translated object titles can be used in searches and they are displayed instead of **Name or Title** property on the title area of the metadata card, listing area as well as in notifications and value lists when a specific vault language is selected.

**Disabling relevance sorting**

The M-Files system administrator can set the results to be sorted according to the user’s preference instead of the default relevance settings. For more information, see Disabled the Sorting of Search Results by Their Relevance.

**Search word emphasis in the results**

When you make a search, your search terms are marked in yellow on the listing area as well as on the metadata card and file content (preview). When preview is in use, search terms are highlighted in yellow in the file contents for common file formats (Word, Excel, PowerPoint, Outlook, and so on).
Contents of the following types of files can be highlighted in the **Preview** tab:

- Email files (eml, emlx, msg)
- HTML and web archive files (htm, html, mht, mhtml)
- Microsoft Excel files (xlsx, xlsm, xltx, xltm, xlsb, xls, xlt)
- Microsoft PowerPoint files (pptx, pptm, ppsx, ppsm, potx, potm, ppt, pps, pot)
- Microsoft Word files (docx, docm, dotx, dotm, doc, dot)
- OpenDocument files (odt, ott, ods, odp)
- PDF files
- RTF files
- Text files (txt)

**Note:** If you search for an exact match using quotation marks in your search query, such as "dat sports", any partial matches, such as sports, are highlighted in addition to exact matches in document contents and metadata.

**Search results in other vaults**

When you perform a search in M-Files, the **Search Results in Other Vaults** pane at the bottom of the search results listing shows you the number of results in any other vaults you are connected to. If the vault icon next to the vault name is blue, it means that there are matches to your query in the vault. If, on the other hand, the vault icon is gray, it means that the search results are not yet available or there are no matches to your query in the vault.

Note that the search results in other vaults are not updated if your search is filtered by additional conditions or search refinements.

**Tip:**

The search results are retrieved only from the vaults that you are currently logged in to. You can click **Show all** to view also the vaults you are currently not logged in to.
You can set your login account to be automatically logged in to a vault when Windows is started. For instructions, see Log in automatically when Windows is started.

When you click any of the vaults in this pane, you are taken to the vault in question and the search results for your query are displayed.

The Search Results in Other Vaults pane can be hidden or displayed by right-clicking on an empty space in the listing area and selecting Display Mode > Show Search Results in Other Vaults from the context menu.

You can also show the Search Results in Other Vaults pane minimized by default, so that only the heading of the pane is displayed until you expand the pane. To display the pane minimized by default, right-click on an empty space in the listing area and select Display Mode > Bottom Pane > Minimized from the context menu. Note that this setting affects all the panes that are displayed at the bottom of the listing area.

Note:

If you want the Search Results in Other Vaults pane to be disabled by default, you may adjust the following registry setting on the client computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_CURRENT_USER\SOFTWARE\Motive\M-Files&lt;version&gt;\Client\MFSHELL&lt;vault&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>MultiVaultSearchEnabled</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>Description</td>
<td>Enables or disables the Search Results in Other Vaults pane.</td>
</tr>
<tr>
<td>Default value</td>
<td>1</td>
</tr>
<tr>
<td>Valid values</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

In this chapter

• Quick Search
• The Filters Tab
• Additional Conditions
• Search Result Groupings

Quick Search

Quick Search is a useful way to search for documents and other objects in the vault. Quick Search looks for objects that contain the search word in the file contents or metadata. You can choose whether to search metadata, file contents, or both by selecting the Metadata, File contents or Both option in the Filters tab. By default, both metadata and file contents are searched. This setting is retained for all subsequent searches. See The Filters Tab for more ways to refine your search.
In the search field, enter a search string that has to do with the object, such as the title, the login account of a person who has edited it, or a customer related to it, and click the search button. The search string does not need to be a whole word — you can truncate the word by using an asterisk. For example, when you search for data in the Demo Vault with the search string specific*, you will find a document named Technical Specifications, because the name contains the string searched for. For a comprehensive list of different operators and special characters you can use in your search query, see Operators and Special Characters.

If you cannot find what you are searching for, there are plenty of ways with which you can narrow your search and get more focused search results, such as:

- using quotation marks or other operators and special characters, such as AND
- using search options for quick search
- using a more accurate search term by adding keywords or using more focused keywords
- refining your search using the advanced search features on the Filters tab

To search for a particular word form, disable the Look for different inflected forms of the words in Quick Search option in the Additional Conditions dialog. This option is enabled by default. When you do this to search for, say, the word "corporation", the search results include only those objects that match this exact word, not corporate, incorporated, and so on.

Words and phrases searched for are stored in the search drop-down menu, making it easy to repeat recent searches.

![Employment Agreement](image)

Figure 42: In the quick search, you only need to enter the search word.

**Search options for Quick Search**

You may expand the search options for Quick Search by clicking the search options button (…) to the right of the Quick Search field. When the button is clicked, the following search options are displayed:

- **Search type**
- **Property condition**
- **Additional Conditions**

**Search type**

You can specify the way your search queries are matched by selecting one of the following options:

- **All words**
  Matched objects contain all the specified search words.

- **Any word**
  The search will return all objects that contain at least one of the specified search words.
**Boolean**

The search allows you to use more specific search phrases and different operators.

**Property condition**

Each object has property values that can be used as search criteria. The value of the property *Project* can be for instance *Hospital Expansion (Florida)*. If you perform a search with these values, the search returns all the documents in which the *Project* property contains the value *Hospital Expansion (Florida)*.

You can define a property condition by selecting a property, a condition, and a property value using the drop-down menus in the search options section. You may define additional property conditions by clicking the plus icon (+).

**Subordination of search criteria**

You can easily specify search criteria by utilizing their subordination, so the options shown in the lists are filtered on the basis of other list choices. For example, if you have selected a certain workflow as the search criterion, the state options are filtered in such a way that only the states related to your selected workflow are visible and selectable. Corresponding filtering will be performed automatically for other interdependent value lists as well. For example, contact persons are filtered by customer if these value lists have a hierarchical relationship.

Subordinate search criteria can be used with the "is" operator. In the **Additional Conditions** dialog, the operator "one of" can also be used.

**Indirect searches**

You can specify search criteria also by means of *property relationships*, which means that the object itself need not have the property in question. Instead, the property selected as the search criterion is in this case the property of a related object.

By using indirect search, you can, for example, find agreements related to a specific country; even if the *Country* property has not been defined for the actual agreement, it is enough if it can be found via a customer associated with the agreement. In this case, the search criterion is specified as *Customer.Country*.

You can specify these indirect search properties by clicking the plus-sign button in the list and then selecting the property of a related object to be used as the search criterion. In the example below, *Customer* was selected from the list first, and then the customer's *Country* property, which resulted in the search criterion with a period, "*Customer.Country*", being displayed in the search field.

By using additional conditions, you can create three-level indirect search criteria.
Tip: You can specify indirect views in the same manner, by using the properties of related objects. You can utilize indirectness in specification of filter settings as well. For more information on creating views, see Creating a View.

In this chapter

- Operators and Special Characters

Operators and Special Characters

You can also use different operators and special characters in your search query to find documents and objects that strictly meet your search criteria. The table below lists the operators and special characters that can be used to broaden or narrow a search.
<table>
<thead>
<tr>
<th>Search type</th>
<th>Operator or special character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exact match</td>
<td>Quotation marks: &quot;phrase&quot;</td>
<td>Enclose the search words in quotation marks to find objects that contain all of the search terms in the given order.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example search: &quot;functional specification&quot;</td>
</tr>
<tr>
<td>Any single character</td>
<td>Question mark: appl?</td>
<td>The ? character matches any single character except a whitespace or underscore character (_) in its position.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example search: appl? matches both &quot;apply&quot; and &quot;apple&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: This character cannot be used as the first character in a search term.</td>
</tr>
<tr>
<td>Any single digit</td>
<td>Hash: 201#</td>
<td>The # character matches any single digit in its position.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example search: 201# matches, for example, &quot;2017&quot; and &quot;2018&quot;.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: This character cannot be used as the first character in a search term.</td>
</tr>
<tr>
<td>Any number of characters</td>
<td>Asterisk: market*</td>
<td>The * character matches any number of characters in its position.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example search: market* matches &quot;markets&quot;, &quot;marketing&quot;, and so on.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note: This character cannot be used as the first character in a search term.</td>
</tr>
<tr>
<td>All of the search terms must be</td>
<td>AND (Boolean search only)</td>
<td>The AND operator combines two search terms. Documents found contain both terms.</td>
</tr>
<tr>
<td>found</td>
<td></td>
<td>Example search: functional AND specification</td>
</tr>
<tr>
<td>One of the search terms must be</td>
<td>OR (Boolean search only)</td>
<td>The OR operator retrieves all documents which contain at least one of the terms entered.</td>
</tr>
<tr>
<td>found</td>
<td></td>
<td>Example search: agenda OR minutes</td>
</tr>
<tr>
<td>Exclude a search term</td>
<td>NOT (Boolean search only)</td>
<td>The NOT operator excludes a search term from the search results. It can be used in conjunction with AND, OR of NOT/AND.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Example search: agenda AND NOT minutes</td>
</tr>
<tr>
<td>Search type</td>
<td>Operator or special character</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Required search term and an optional search term</td>
<td>AndAny (Boolean search only)</td>
<td>The <strong>AndAny</strong> operator combines required search terms with optional ones. Search terms before the <strong>AndAny</strong> operator are required and terms appearing after the operator are optional. In other words, search terms after the <strong>AndAny</strong> operator are considered as matches only if the search terms before the operator are also found in the document.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Example search:</strong> <em>agenda AndAny minutes</em></td>
</tr>
<tr>
<td>Faceted query</td>
<td>( ) (Boolean search only)</td>
<td>Brackets are used to group search terms together.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Example search:</strong> <em>(agenda OR minutes) AND market</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>This search returns all objects which contain the word &quot;agenda&quot; or &quot;minutes&quot; and which also contain a word or words beginning with &quot;market&quot;.</td>
</tr>
<tr>
<td>Proximity search</td>
<td>W/N (Boolean search only)</td>
<td>The <strong>W/N</strong> operator retrieves objects that contain two words or phrases within a certain distance of one another. The <strong>N</strong> value indicates the number of intervening words between the search words or phrases.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Example search:</strong> <em>agenda W/4 2015</em></td>
</tr>
<tr>
<td>Fuzzy search</td>
<td>Vertical bar: que</td>
<td><strong>Vertical bars</strong> can be used for searching for spelling variations of the search term. The number of **</td>
</tr>
<tr>
<td></td>
<td>ry</td>
<td><strong>Example search:</strong> *release s</td>
</tr>
</tbody>
</table>

**Note:** Fuzzy search is disabled by default and must be enabled by the M-Files system administrator. See [Enabling Phonic and Fuzzy Searches](#) for more information.
<table>
<thead>
<tr>
<th>Search type</th>
<th>Operator or special character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phonic search</td>
<td>The grave accent mark (｀): `query</td>
<td>You can use the grave accent mark (｀) for searching for words that sound like the word in your search query and begins with the same letter. Add the ` character in front of the search word to search for its phonic matches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Example search:</strong> <code>John Doe</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> This feature is supported only by the dtSearch search engine.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Phonic search is disabled by default and must be enabled by the M-Files system administrator. For more information, see Enabling Phonic and Fuzzy Searches.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Phonic searches are inclusive by nature, and therefore they may occasionally produce too many search results or their search precision may be low.</td>
</tr>
<tr>
<td>Synonym search</td>
<td></td>
<td>Documents containing synonyms of a word included in your search query may also be listed in the search results.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>For example, if you search for announcement, the search results may also list documents containing words such as notice, bulletin, publication, or statement, in addition to the word announcement.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Synonym search is disabled by default and must be enabled by the M-Files system administrator. See Setting Up Synonym Search for more information.</td>
</tr>
<tr>
<td>Underscore:</td>
<td>2018_01</td>
<td>The _ character matches a whitespace. Consequently, the next character starts a search term and cannot be a wildcard character ?, #, or *.</td>
</tr>
</tbody>
</table>
|               |                              | **Example search:** 2018_01 matches both “2018_01” and “2018 01”.

**The Filters Tab**

With the advanced search features on the Filters tab, you can define more specific search criteria for the document or object you are looking for. The more search criteria you use in the advanced search, the more likely you are to find the exact object you want. This way, you can prevent the search from returning too many results.

Advanced search features can be opened by clicking the Filters tab in the right pane. The Filters tab is also opened whenever you activate the quick search field.
Your search results are updated in real time according to the selected search filters.

The **Filters** tab contains the following search options:

- **Scope**
- **View**
- **Location**
- **Object type**
• Search refinements

Scope

You can choose whether to search metadata, file contents, or both. By default, both metadata and file contents are searched.

View

When you have a specific view open, you can choose to search only within the view that you are currently in. Note that the View option is shown only if you currently have a view open on the listing area. The View option is shown also for external views. However, the View option does not work if your system administrator has not rebuilt the search index of the external repository.

Location

You may broaden or narrow down your search by selecting the repositories that you want to include in your search. To do so, check the repositories that you want to include in your search.

Object type

You can also narrow down your search by selecting one or more of the object types in the list.

Search refinements

Note: This functionality is available only if your document vault is using the Micro Focus IDOL search engine.

You can refine your search results by selecting one or more of the available criteria in this section. For more information, see Search Refinements.

Default search filters

You can set frequently used search options to be remembered by M-Files so that you do not need to reselect them in the future. For more information, see Default Search Filters.

In this chapter

• Search Refinements
• Default Search Filters

Search Refinements

Note: This functionality is available only if your document vault is using the Micro Focus IDOL search engine. For further information, contact sales@m-files.com.

You can refine your search results on the Filters tab by selecting one or more of the available criteria in the section below the Scope, Object type, and Location options. You can, for instance, choose to only search for objects that were created in 2017, modified within the last week, and that refer to a certain vault user.

To view more criteria in a specific category, click the Show more option.
Search refinements only apply to objects with M-Files metadata. In other words, any objects that do not have metadata in M-Files (such as so-called unmanaged external repository objects) are hidden in the search results if search refinements are selected.

Once your search results have been refined to match your search query as well as the criterion or criteria you have selected, you can refine your search even more by selecting additional criteria. Note that after you have refined your search, the criteria for which there are no longer matches are now grayed out.

**Default Search Filters**

You can set default search filters that will be remembered by M-Files always when you log in to the vault using M-Files Desktop. This is useful, if you often select the same search options on the Filters tab when searching for documents or objects.

Do the following steps to set default search filters:

1. In M-Files Desktop, perform a search.  

   ![The Filters tab is opened in the right pane.](image)
2. On the Filters tab, hover over the search criterion you want to select as your default search filter.

   Note: If your vault uses the Micro Focus IDOL search engine, you can set any search filter as default. If dtSearch is used instead, you can select filters from the Scope, Object Type, and Location search options as default.

   The open lock icon (🔒) appears in front of the check box.

3. Click the open lock icon (🔒).

   The search criterion is shown in bold and it appears with closed lock icon (🔒) under Your default filters at the top of the Filters tab.

4. Set as many filters as desired by repeating the steps 2 and 3.

5. Optional: To unselect a default search filter, click it under Your default filters.

   The search filter is removed from the list.

When searching for documents and objects in M-Files Desktop, the set default filters are automatically used as search criteria.

You can view your current default search filters and refine them on the Filters tab. The default search filters are shown in bold and they are listed under Your default filters.

To remove all default filters, click Reset all filters.

Additional Conditions

The Additional Conditions dialog can be opened by first clicking the search options button (🔍) and then clicking the Additional Conditions button. After you have applied additional conditions and close the dialog, the number of active conditions is shown in parentheses in the Additional Conditions button.

Look for different inflected forms of the words in Quick Search

To search for a particular word form, disable the option Look for different inflected forms of the words in Quick Search in the Additional Conditions dialog. When you do this to search for, say, the word corporation, the search results include only those objects that match this exact word, not corporate, incorporated, and so on.

   Note: The search for inflected forms is enabled by default. If needed, the M-Files system administrator can disable this option for all vault users. For more information, see Disabling the Search for Inflected Forms.

Look in the metadata of all versions

When you select the Look in the metadata of all versions option, the search operation looks for results in the metadata of all object versions instead of just the latest ones.

   Note: This option does not apply to quick searches.
Show latest version

When you select **Look in the metadata of all versions**, the search will be performed on all versions of each object. If the option **Show latest version** is on as well, M-Files shows the newest version of each returned object instead of showing the old version that actually matched the search conditions.

Exporting search conditions

You can use the **Export Conditions** function to save the search criteria. To access this search-related function, press the Alt key on your keyboard and select **File > Export Conditions**.

The generated text file contains the search criteria as a string that can be used with the M-Files API method **SearchForObjectsByExportedSearchConditions**. For more information on the method, see the M-Files API documentation.

In this chapter

- Status-Based Conditions
- Property-Based Conditions
- File Information Based Conditions
- Permissions-Based Conditions

Status-Based Conditions

The search criteria related to the **object status** are specified on the **Status** tab.

**Object type**

Define the object type of the objects being searched for. If the object type is not specified, the search will be performed on all objects.

**Object ID**

Each object has an **individual ID** that M-Files Server automatically creates for each new object using consecutive numbers. With the ID search criterion, you can find the objects efficiently according to their ID numbers. You can make the ID search more specific by using **operators**. For more information, refer to Property-Based Conditions.

**Checked out**

If you specify as a search criterion that the document has been **checked out** and select **Yes** from the drop-down menu, the search returns all documents that have been checked out for editing. This search criterion is useful, for example, when you want to see all documents in the vault that have been checked out to any user.

**Checked out to**

You can also search for documents that have been **checked out to** specific **users** of the document vault. For example, if you want to find all the documents in the **Demo Vault** that have been checked out to the user **AndyN**, choose **=** as the operator and select **AndyN** from the user list. You can also select **!=**, in which case you will see all the documents that have been checked out by users other than **AndyN**. **Checked Out to Me** shows all the documents that have been checked out to the user logged in to the document vault.
**Checked out between**

When you check out a document, it remains checked out until you check it in. Thus you can also search for documents that have been checked out earlier but have not been checked back in. For example, if you want to find all documents that were checked out between February 16 and 17, 2013, select 2/16/2013 as the start date and 2/17/2013 as the end date.

**Object flags**

Interaction between vaults has imported special objects to M-Files which are used to process data between vaults. These are described as conflicts and shortcuts. Conflicts are created when the versions in separate vaults differ. Shortcuts refer to objects that are located in different vaults.

When a filter is used, these special objects can be included in the search or omitted from it.

**Deleted**

If you specify as a search criterion that the document has been deleted, you will see all deleted documents. M-Files preserves all deleted documents. In order to perform this search, you need permissions for viewing deleted documents.

*Example: Searching Only for Deleted Projects*

You need to have permissions to see deleted objects.

1. Click the advanced search options button ( ) to the right of the Quick Search field.
2. Click the **Additional Conditions** button.

   The **Additional Conditions** dialog is opened.

   ![Additional Conditions dialog](image)
3. Check the **Object type** check box, select = from the first drop-down menu, and finally select **Projects** from the rightmost drop-down menu.

4. Check the **Deleted** check box and select **Yes** from the drop-down menu.

5. Click **OK** to close the **Additional Conditions** dialog.

6. Enter a search term in the **Quick Search** field or leave it empty if you do not want to filter your search any further.

7. Press **Enter** or click the arrow button next the **Quick Search** field to start your search.

The search results show the deleted projects for your search term or all the deleted projects if you omitted the search term.

**Property-Based Conditions**

Each object has property values that are assigned to it in the metadata card. These property values can be used to search for documents in a precise manner. A document property can be for example **Project**, and the value of this project can be **Hospital Expansion (Florida)**. If you perform an advanced search with these values, the search returns all documents for which **Hospital Expansion (Florida)** has been defined as the value of the **Project** property.

To get started, click **Add Condition** and define the values of the condition according to the instructions in this section. To remove the selected property condition, click **Remove Condition**. Note that the checkbox next to the property name does not indicate selection for this purpose, but instead specifies whether or not the condition is in use.

**Note:** Any disabled conditions are automatically removed when the properties dialog is closed.

**Properties**

The criterion defined in the **Property** column can either refer to the value of 1) a certain, single property or 2) that of all properties that have been defined to show values from a certain value list (see below for an example).

**What does any property in the property name mean?**

Many of the properties are accompanied by the expression **any property**. If you use this type of property as a search criterion, it means that the search results will include all objects where the property value matches your search term **no matter what the name of the property is** as long as it has been defined to show values from the specified list. This is perhaps best explained with an example:

**Example:** If you have installed M-Files for evaluation, the properties **Supervisor** and **Project manager** in the sample vault both show values from the list **Employees**. If you now select **Employee (any property)** as a search criterion, the search returns all objects where the **Supervisor** or **Project manager** property has the value that you searched for. If, on the other hand, you use the **Supervisor** property as your search criterion, the search only returns objects that contain the **Supervisor** property with the specified value.
Figure 44: The properties tab of the additional search conditions dialog.

Operators

In the *Operator* field, you can also determine other criteria than *equal to*. See the table below for the list of available operators.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>Equal to</td>
</tr>
<tr>
<td>!=</td>
<td>Unequal to</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than</td>
</tr>
</tbody>
</table>

This operator is useful when the *value* to be selected contains numbers. You can easily find all values that are greater than the value you have specified. For example, if your document vault contains the data type of the *Department* property as numbers, the search criterion > 10 returns the documents whose *Department* value is greater than 10.

<p>| &gt;=       | Greater than or equal to |</p>
<table>
<thead>
<tr>
<th>Operator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;</code></td>
<td>Less than</td>
</tr>
<tr>
<td><code>&lt;=</code></td>
<td>Less than or equal to</td>
</tr>
</tbody>
</table>

**One of**

You can select some property values for the search, for instance certain projects but not all of them. In this case, the search results are just the documents whose Project property has one of the values you selected with the One of operator. For example, the Project property of the document *Window Chart E12.dwg* is "Hospital Expansion (Florida)".

**Not one of**

This search option is the opposite of the previous one.

**Contains**

When you want to search for documents by letter combination, for instance a word, you can use the Contains operator. For example, if you want to find all documents in the *Demo Vault* whose Project property value contains the letters *pan*, the search results include the document *Window Chart E12.dwg*, whose Project property is "Hospital Expansion (Florida)". The word *Expansion* contains the letters *pan* that were determined as the search criterion. If you want to include wildcards in your search criterion, use the *Matches wildcard pattern* option.

**Does not contain**

This search option is the opposite of the previous one.

**Starts with**

The Starts with option works in almost the same way as the Contains option. Here, the word must start with the value specified.

**Does not start with**

This search option is the opposite of the previous one.

**Matches wildcard pattern**

The matches wildcard pattern option can be used with the wildcards `?` and `*`. The `?` character replaces any single character, and the `*` character replaces any number of characters. See further below for an example.

**Does not match wildcard pattern**

This search option is the opposite of the previous one.

**Is empty**

In some cases, the properties of a document have no value. This happens when no value is specified for the property at the stage of filling in the metadata card – e.g., when no value has been specified for the Project property. The Is empty operator utilizes the missing value in the search. For example, you can easily find all documents whose Project property has no value.

**Is not empty**

This search option is the opposite of the previous one.
Values

From the Value column, you select the value for the selected property that is used as the search criterion. You can filter the list of available values by right-clicking Filter: * and selecting Set Filter from the context menu. Enter a suitable filter word in the Set Filter to List dialog. Note that you can enter only one filter value in the text field. If you need to select multiple values from the Value column, you can try extending your filter by using wildcards. If not applicable, you must select the values without a filter.

Note: You can select multiple values by holding down the Ctrl key while clicking values.

For instance, when you search for projects with the Matches wildcard pattern operator and the search term ???house*, the results include all the objects whose Project property value begins with any four-character string, followed by the word house, and then a string with any number of any characters. If the vault has a document with a Project property Warehouse Management System Development, it is shown in the search results.
Figure 46: Utilizing the "matches wildcard pattern" operator.

If a property definition based on a hierarchical value list is selected as the search criterion, you can also select whether to include the values higher and lower in the hierarchy in the search.

**Options**

If your search criteria includes a property containing a timestamp, you can make the search more specific by selecting an option from the **Options** column, selecting an operator, and entering a suitable value in the **Value** field. For example, you can find all recently created documents. Give "Created < 7" as your search criterion, and select the option **DaysFrom()**. The search will return all documents created over the last seven days. See the table below for the list of available options for timestamp properties and their descriptions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date()</td>
<td>Created = 18.12.2015</td>
<td>Returns objects that have a given timestamp property containing a given date.</td>
</tr>
<tr>
<td>DaysFrom()</td>
<td>Created &lt; 7</td>
<td>Returns objects with a given timestamp property containing a date within a given number of days <strong>preceding</strong> the current date.</td>
</tr>
<tr>
<td>DaysTo()</td>
<td>Effective through &lt; 10</td>
<td>Returns objects with a given timestamp property containing a date within a given number of days <strong>following</strong> the current date.</td>
</tr>
<tr>
<td>Option</td>
<td>Example</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Month()</td>
<td>Created = 05</td>
<td>Returns objects that have a given timestamp property containing a date with a given month. Use the format MM.</td>
</tr>
<tr>
<td>Year()</td>
<td>Document date = 2015</td>
<td>Returns objects that have a given timestamp property containing a date with a given year. Use the format YYYY.</td>
</tr>
<tr>
<td>YearAndMonth()</td>
<td>Created = 2015-12</td>
<td>Returns objects that have a given timestamp property containing a date with a given year and month. Use the format YYYY-MM.</td>
</tr>
</tbody>
</table>

Figure 47: Utilizing options for properties of the timestamp data type.

Also refer to Subordination of search criteria and Indirect searches under The Filters Tab. You can always utilize indirectness for specifying the properties in filter settings.

Example: Searching for Ongoing Projects for American Customers

1. Click the advanced search options button ( ) to the right of the Quick Search field.

2. Click the Additional Conditions button.

✓ The Additional Conditions dialog is opened.
3. Go to the Properties tab and click Add Condition to add a property condition.

4. From the topmost Property drop-down menu, select In progress.

5. From the topmost Operator drop-down menu, select =.

6. From the topmost Value drop-down menu, select Yes.

7. Click Add Condition again to add another property condition.

8. Locate Customer in the next Property drop-down menu and click the plus sign next to Customer to expand its properties and select the Country customer property.

   This creates an indirect property association that uses the Country property of the customer object to define a country for the project. As the project object does not include country data in this case, the customer object can be used indirectly to provide it.

9. From the Operator drop-down menu, select =.

10. From the Value drop-down menu, select USA.

   The Additional Conditions dialog should now look like this:
11. Click OK to close the Additional Conditions dialog.

12. Enter a search term in the Quick Search field or leave it empty if you do not want to filter your search any further.

13. Press Enter or click the arrow button next the Quick Search field to start your search.

The search results show the projects (for the search term or all the projects if no search term was given) that are in progress for customers from the United States.

File Information Based Conditions

An M-Files document consists of metadata and zero or more files. The Files tab is used to specify search criteria related to files, that is, not metadata, which is specified on the Properties and Status tabs.
File name

If you can remember the file name or parts of it, File name is an efficient search criterion. If you remember the exact name, select the equals sign and enter the name of the file in the next field. If you cannot remember the exact name, you can use other operator settings than the equals sign. For more information on the available operators, see Property-Based Conditions.

File size (KB)

If you want the search to return files of a certain size, you can specify the minimum and maximum file size here.

File created, File changed

Searches can also be performed according to the timestamps of files, that is, creation and modification dates. The use of dates as search criteria works in the same manner in all searches. For more information about the use of dates as search criteria, see Status-Based Conditions.

Linked to external location

You can also perform a search on files that are linked to an external location. You can choose to search within files that are all linked to one and the same external location, or within all linked files that are external to M-Files. For more information about linking files, see External File Sources.
Example: Searching for PNG Images

1. Click the advanced search options button (🔍) to the right of the Quick Search field.

2. Click the **Additional Conditions** button.

   ![Additional Conditions dialog]

   The **Additional Conditions** dialog is opened.

3. Go to the **Files** tab, check the **Contains files** check box, and select **Yes** from the adjacent drop-down menu.

4. Check the **File name** check box and select **matches wildcard pattern** from the adjacent drop-down menu.

5. Enter `*.png` in the text field next to the drop-down menu.

   ![Files tab]

   The **Files** tab should now look like this:
6. Click OK to close the Additional Conditions dialog.

7. Enter a search term in the Quick Search field or leave it empty if you do not want to filter your search any further.

8. Press Enter or click the arrow button next the Quick Search field to start your search.

The search results show the PNG images found for your search term or all the PNG images in the vault if you omitted the search term.

Permissions-Based Conditions

Each object has permission settings that are assigned to it on the Permissions tab of the metadata card. Objects can also be searched according to their permission settings. You can, for example, create a search listing all objects that are visible to the company management only. This way, you can also change the permissions of specific objects.
When applying the condition **Access control list** and selecting a named access control list that uses pseudo-users via metadata properties, the search results may not be accurate or you might get no results. For more information, refer to [Pseudo-users](#) and [Named Access Control Lists](#).

**Example: Searching for Objects That Are Visible to the HR Department**

Your vault needs to have the **HR Department** user group and you need to be a member of that group.

1. Click the advanced search options button (확장 검색 옵션) to the right of the Quick Search field.

2. Click the **Additional Conditions** button.

   The **Additional Conditions** dialog is opened.
3. Go to the Permissions tab and check the Visible to user/group check box.

4. From the Operator drop-down menu, select includes.

5. From the Value drop-down menu, select HR Department.

6. Click OK to close the Additional Conditions dialog.

7. Enter a search term in the Quick Search field or leave it empty if you do not want to filter your search any further.

8. Press Enter or click the arrow button next the Quick Search field to start your search.

The search results show the objects that match your search term and are visible only to the HR department.

**Search Result Groupings**

M-Files automatically groups search results by object type. Thanks to this, you can quickly and easily find the desired object, regardless of whether you are looking for, for example, a document or a project.

If there is a large number of search results among one object type, not all of the results are shown at once. You can display more search results by clicking Show more results.
2.4.2. Using Views

Your day-to-day use of M-Files mainly involves browsing views in which documents and other objects have been grouped according to object metadata, such as project or customer information.

For example, all objects for which the *Project* metadata has been specified can be grouped by project. For more information on configuring views and grouping levels, see *Creating a View*. 
Figure 51: Views organize objects in the vault by the metadata properties of objects. Views can be based on, for example, object types, such as Customer or Project, and they can be further subdivided by the properties of the listed objects, such as Country or Customer.

In this chapter

- Creating a View
- Traditional Folders
- View-Specific Operations

Creating a View

In M-Files, documents and other objects can be categorized into different views according to their metadata. Creating views is largely based on specifying the metadata used for searching and categorizing documents.

Views allow you to save frequently used searches and define grouping levels. For information about searching for documents, refer to Searching.

To create a view:

1. In M-Files, open the document vault to which you want to create the view.
2. Click the Create button and select View... from the context menu.

   The Define View dialog is opened.

There are two phases in determining a view:

1. Specify a filter to ensure that the view only displays objects you want to see. Specifying filters is similar to defining search criteria.
2. Determine the folder structure of the objects. This is useful when you have a large number of objects and you want to group them into different levels according to specific properties.
In the example shown above, the documents must be checked out to the user Andy Nash, they must not have been deleted, and they must be of the type *Drawing*. No properties have been added to the display hierarchy in this window, so all documents that meet the criteria are displayed in a single list.

**Name**

Start by assigning a name to the view. The name should be as descriptive of the contents of the view as possible, so that users can deduce from the name of the view what kind of objects it contains.
Common to all users

Normally, views are created for personal use only. If you wish, you can define the view to be a common view visible to a desired user group. To define a common view, you need the document vault permission for managing the common document vault’s common views.

You should carefully consider which views are needed by all M-Files users. For instance, the Documents by Projects view is often necessary. The users of the client software can hide unnecessary views from their own computers, and the administrator can restrict the visibility of the views by setting appropriate permissions. The views also can be assembled in groups (view bundles) from which, for example, the views used by the sales department are easy to find.

Defining the filter

See Defining a Filter for a View.

Show documents and other objects

By default, the view shows documents and objects according to the filter settings and folder structure. This option can be deselected if, for instance, new views are created under the current view. Note: When creating a new view inside the current view, the conditions of the upper view remain simultaneously valid. In other words, the sub-view results only include objects that also meet the conditions of the upper view.

Look in all versions

If you leave the Look in all versions box unchecked, the view will only list those objects whose latest version meets the specified criteria.

If you check the box, the filtered search will be performed on all versions of each document. Only the newest version meeting the criteria will be displayed. For example, if TinaS has modified versions 1 and 2 of a document, and AndyN has updated the document to version 3, search criterion Last Modified By = TinaS will return version 2 of the document.

Show latest version

If the option Show latest version is on, M-Files will show the newest version of each returned object instead of showing the old version that actually matched the search conditions.

Folder structure

See Grouping Levels.

In this chapter

• Defining a Filter for a View
• Grouping Levels
• View Advanced Settings and Permissions
• Creating a View in a Virtual Folder
• Converting a Virtual Folder into a View
• Example: Creating a New View for French Customers
• Example: Creating a Common View Containing All the Documents Created by the Current User
Defining a Filter for a View

When defining a filter for the view, you specify the conditions according to which the objects are to be listed in the view. You can define criteria for the view on the Status, Properties, Files and Permissions tabs.

![Define Filter dialog](image)

Figure 53: The Define Filter dialog.

For more information about the available filters, see Status-Based Conditions, Property-Based Conditions, File Information Based Conditions, and Permissions-Based Conditions.

Grouping Levels

When creating a view that contains documents or other objects, you can use properties to further group objects in the view. For example, you can create a view that shows documents grouped in folders by customers.

Complete the following steps to define a grouping level for a view:

1. In M-Files Desktop, either:
   a. Navigate to a view for which you want to define a grouping level, right-click an empty area in the listing area, and then select Properties from the context menu.
   or
   b. If you want to define a new view, navigate to the location in which you want to create a new view, right-click an empty area in the listing area, and then select New View... from the context menu. For instructions on defining a new view, see Creating a View.

2. In the Properties dialog of the view, in the Folder structure section, either:
   a. Select the appropriate grouping level in the Grouping levels list and click Add... to create a new grouping level.
or

b. Select an existing grouping level and click **Edit...** to edit the selected grouping level.

The **Define Grouping Level** dialog is opened.

3. Use the **Group by** drop-down menu to select the object type, value list, or function by which you want to group objects on the selected level.

4. Optional: If you selected an object type for grouping the selected level, you may click **Define Filter...** to specify the conditions for including folders in the grouping level. For more information on defining the conditions, see **Status-Based Conditions**, **Property-Based Conditions**, **File Information Based Conditions**, and **Permissions-Based Conditions**.
5. If you selected an object type for grouping the selected level, use the **Reference direction** option to select the metadata reference direction between the object type of the grouping level and the objects in the view:

   a. **To <selected object type>:** The objects in this view have metadata that refer to the object type used as the grouping level. In other words, the reference direction is from the objects in the view to the object type used as the grouping level (see the example further below).

   or

   b. **From <selected object type>:** The object type used as the grouping level has metadata that refers to the objects in this view. In other words, the reference direction is to the objects in this view from the object type used as the grouping level. This option is used when the objects in the view do not have metadata references to the object type used for grouping the view (see the example further below).

   ![Diagram](image)

   **Note:** Views and virtual folders that use property references of the **From <selected object type>** type cannot be marked for offline availability.

The **Reference direction** selection is dependent on the metadata structure of the vault. As an example, take a look at this graphical representation of a simple vault metadata structure:

Say that you want to have a view that contains projects grouped by customers. You would then filter the view by the **Project** object type and add the **Customer** object type as a grouping level with **To Customer** as the reference direction because the **Project** objects in the view refer to the object type used for grouping the view (**Customer**).
On the other hand, say that you want to have a view that contains customers grouped by projects. The first thing to note here is that the Customer object type does not have any metadata information about projects (as seen in the metadata structure image further above). This means that the reference direction needs to be from the grouping object type, Project, to the Customer objects. So, in this scenario, you would add the Project object type as a grouping level with From Project as the reference direction, and select Customer as the property used by the grouping level object type. Filtering the view separately in this instance is not necessary.
because the *Customer* property selected for the grouping level filters the view to contain only customers.

**Customers by project**

- **Filter**: none
- **Grouping level**: Project
  - **Reference direction**: From Project
  - **Property**: Customer

6. Use the **Property** drop-down menu to select the property that is utilized by the item selected in the **Group by** drop-down menu. This selection defines the property that you want to group by on this grouping level.

**Note:** If you would like to disable the **Reference direction** setting in the vault, see Disabling the Reference Direction Setting for Grouping Levels.
7. Optional: If you selected `IntegerSegment()` in the Group by drop-down menu and a property of the Number (integer) or Number (real) data type in the Property drop-down menu, in the Segment size field, define a segment size that you want to group objects by on the selected grouping level.

If you set, say, 10 as the segment size, objects are grouped into virtual folders by segments 0-9, 10-19, 20-29, and so on. If you set 100 as the segment size, objects are grouped by segments 0-99, 100-199, 200-299, and so on.

8. Optional: Check the Show empty folders check box if you want to include empty virtual folders on this grouping level, that is, virtual folders that do not contain any objects because the object on which the virtual folder is based is not referenced by any other object or it does not refer to any other object in the view.

9. Optional: Check the Show objects that have an empty value for this property check box if you want to include on this grouping level objects that do not have a value for the property selected in the Property drop-down menu as the grouping property, and then select either:

   a. Show objects on this level: Select this option if you want to list within the grouping level the individual objects that do not have a value for the selected grouping property.

   or

   b. Show objects in a separate folder: Select this option if you want to list objects that do not have a value for the selected grouping property in a separate folder in the grouping level. In the Folder name field, enter the name of the folder under which such objects are listed.

10. Optional: Open the Advanced tab to modify the performance options for viewing and accessing the virtual folders in this grouping level. Modifying these settings may be beneficial for views or virtual folders that contain a large number of folders. For more information, see Grouping Level Advanced Options.

11. Click OK to finish creating the grouping level.

The objects in the selected view are now grouped by the grouping level that you have just defined.

In this chapter

- Grouping Level Advanced Options
- Grouping Options in the M-Files Desktop User Interface

Grouping Level Advanced Options

The Advanced tab of the grouping level settings contains performance options for viewing and accessing virtual folders. Modifying these settings may be beneficial for views or virtual folders that contain a large number of folders.
Show only subfolders that were recently selected by the user

In the advanced settings for the view grouping level, you can specify whether the user is to be shown all virtual folders belonging to the level or whether the user may select the folders to be used. Folder selection is useful when the view or virtual folder includes a large number of subfolders (more than 500). By means of folder selection, the user can easily select the folders to be modified. The use of folder selection is significantly quicker than, for example, grouping by first letter when the number of objects is large (more than 10,000).

For instance, if the view has been defined By Customer or By Project and the company has thousands of customers or projects, user-specific folder selection makes it easier for users to perform their daily tasks in the required customer or project folders. In this case, the user employs the Select Folder function to select only the folders that should be used.

Important remarks

- The set of folders selected for each grouping level is cleared when the user session ends. In other words, the folders need to be reselected, for instance, after the user logs out from the vault.
- The setting is specific to each grouping level.
- Folder limitation can be used if the grouping level is specified on the basis of a property that utilizes a value list.
- For common views, folder limitation can be specified by a user with at least the right to manage common views.
Other performance options

If the retrieval of the subfolder listing is slow, you can try each algorithm in order to determine which is fastest for this type of view.

Activate the **Do not check object permissions for hiding subfolders** option to improve browsing performance. This may, however, cause empty folders to be displayed in the listing.

Grouping Options in the M-Files Desktop User Interface

You can add, change or remove grouping levels directly in the M-Files Desktop user interface by doing the following:

1. Open M-Files Desktop and any vault connection.
2. Open a view of your choice.
3. Right-click an empty space in the listing area.
4. Perform one of the following operations:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do the following steps:</th>
</tr>
</thead>
</table>
| Add a grouping level to a view that does not yet have any grouping defined | a. Open the **Group By** menu. 
b. Select the grouping level from the list of choices or select **Define...** to define your own. |
| Add an additional grouping level to a view             | a. Open the **Add Grouping Level** menu. 
b. Select the grouping level from the list of choices or select **Define...** to define your own. |
| Change the current grouping level                      | a. Open the **Current Grouping Level** menu. 
b. Select a new grouping level to replace the current one or select **Define...** to create a new grouping level. |
| Remove the current grouping level                      | a. Select **Remove Current Grouping Level**. |

5. Optional: If you want to categorize the objects or virtual folders alphabetically, right-click an empty space in the listing area and select **Group by First Letter(s)** or **Group Folders by First Letter(s)**.

For the **Group by First Letter(s)** command to work, the **Allow this property to be used as a grouping level in views** option of the **Name or title** property has to be enabled.

View Advanced Settings and Permissions

You can create a subview in a virtual folder of a certain view (see Creating a View in a Virtual Folder). The **Advanced** tab of the **Define View** dialog allows you to determine whether the view is also displayed in other folders of the same level.

**Note:** If the same level contains views and folders, views created in the folders will not be created in the views of the same level. The selection applies only to the folders of the level.
To display your view in all the other folders of the same level, select the **In all folders of this level** option. In the above example, the newly created view would be visible in all the virtual folders under the view *By Customer and Class*.

**Indexing the view**

Indexing of the view can be used to speed up the use of certain important views in a large document vault, if the filter criteria for the view sufficiently filter the group of objects. Indexing of the view is recommended.
only if the view does not include many objects (for instance, 10,000 objects in a vault with a total of 1,000,000 objects) and if the view is used daily and is working slowly.

Indexing views should be used sparingly and only for views that benefit significantly from it, since each indexed view in the vault slightly slows down the creation and editing of documents and other objects.

View-specific indexing can be activated by a user with at least the right to manage common views.

**Permissions tab**

The Permissions tab of the Define View dialog allows you to specify the users who are able to see the view. The tab is visible only when you are defining common views.

**Creating a View in a Virtual Folder**

New views can also be created in virtual folders. Open the virtual folder where you want to create a new view. Select Create > View... and define its settings as instructed in Creating a View. For example, you can create a Proposals that expire this week view in the Proposals folder.

**Note:** When creating a new view in a folder, the parent view and folder conditions are valid at the same time. This means that the new view only accepts objects that also meet the conditions of the parent view and folder.

**Converting a Virtual Folder into a View**

Virtual folders can also be converted into views via the Customize tab of the virtual folder Properties dialog, or by right-clicking a virtual folder and selecting Customize Folder.

After the customization, you can modify the display settings of the new view and create grouping levels in the same way as for other views. Then, for example, in the Memo view, created on the basis of the Memo virtual folder, you can group documents according to meeting types.

**Note:** Because views can be created in folders, and folders can be converted to views, views and virtual folders may be available parallel in the listing area. Views can therefore contain folders as well as views, and folders can contain views as well as folders.

A folder that has been converted into a view can be restored as a folder by right-clicking it and selecting Remove Folder Customization from the context menu.

**Example: Creating a New View for French Customers**

1. In M-Files, open the document vault to which you want to create the view.

2. Click the Create button and select View... from the context menu.

   The Define View dialog is opened.
3. In the **Name** field, enter the name *French customers*.

   The name will appear in the listing area under **My Views**.

4. Optional: Check the **Common to all users** check box if you want to define this view as a common view.

5. Click **Define Filter...** to specify the conditions that objects must meet to be shown in this view.

   The **Define Filter** dialog is opened.
6. On the **Status** tab, check the **Object type** check box, select the equal (=) operator from the adjacent drop-down menu, and select the **Customer** from the rightmost drop-down menu.

7. Go to the **Properties** tab.

   The **Properties** tab is opened.

8. Click **Add Condition** and add the following condition:
   
   a) Use the **Property** drop-down menu to select the **Country** property.
   
   b) Use the **Operator** drop-down menu to select the equal (=) operator.
   
   c) Use the **Value** drop-down menu to select **France** as the country.

9. Click **OK** to close the **Define Filter** dialog and to return to the **Define View** dialog.

10. Check the **Show documents and other objects** option check box.
11. Click **OK** to finish creating the view.

The view you have just defined appears in the listing area under **My Views** and it contains all the objects and documents that meet the conditions that you have specified in the filter settings of your view.

**Example: Creating a Common View Containing All the Documents Created by the Current User**

You must be either a vault administrator or a system administrator to be able to define a common view.

1. In M-Files, open the document vault to which you want to create the view.
2. Press Alt to open the menu bar.
3. Select **Create > View...**

   ✔️ The **Define View** dialog is opened.
4. In the **Name** field, enter a descriptive name for the view.
   
   The name of the view can be, for example, *Documents Created by Me*.

5. Check the **Common to all users** check box.

6. Click the **Define Filter...** button.
   
   The **Define Filter** dialog is opened.
7. Go to the **Properties** tab.

The **Properties** tab is opened.

8. Click **Add Condition** and add the following condition:
   
   a) Use the **Property** drop-down menu to select the **Created by** property.
   
   b) Use the **Operator** drop-down menu to select the equal (\(=\)) operator.
   
   c) Use the **Value** drop-down menu to select the \((\text{current user})\) option.

9. Click **OK** to close the **Define Filter** dialog.

10. Click **OK** to close the **Define View** dialog and to finish creating the view.
All users of the vault should now have a new view under **Common Views**. They can use the view to list all the documents that they have created in the vault.

**Traditional Folders**

You can create *traditional folders* in M-Files. These folders do not have the additional properties provided by views. Traditional folders are comparable to, for example, folders on your c: drive and can be used for importing files to M-Files. Traditional folders allow you to retain the original folder structure of the imported files. See also Transferring Folders to M-Files by Using the Import Files and Folders Dialog.

**Creating a New Traditional Folder**

1. In M-Files Desktop, press Alt to display the menu bar and select **Create > Traditional Folder** from the menu.

2. Optional: Right-click the traditional folder that you have just created and select **Rename** to rename the folder.

A new traditional folder is created and added in the **Traditional Folders** view. You can use the folder for importing files and folders to M-Files.

**View-Specific Operations**

This topic compiles a list of various, view-specific commands and features.

**Using the Clean View, Hide View, and Unhide Views commands**

**Clean View**... is a command that a user logged in to the document vault can perform for any view. It is used for removing temporary local files and all empty folders automatically. To do this, press the Alt key and select **View > Clean View**... from the menu.

Some views of the M-Files sample vault cannot be removed, but they can be hidden. A regular user cannot remove views that have been created in M-Files Admin. In such cases, you can right-click the view on the listing area and **Hide View** from the context menu.

To unhide views, press the Alt key and select **View > Unhide Views**... from the menu.

**Tip:** You can create a view showing all the deleted objects if you have any of the following permissions: full control of vault, permission to see all objects, or permission to see deleted objects. Just create a view with the filter Deleted = Yes (see **Status-Based Conditions**).

**Saving the display settings of a view as common display settings**

M-Files allows you to save the display settings of a view as common display settings. To use this function, you need administrative rights to the relevant vault. The function saves the display settings common to users view-specifically. You can choose whether the function is to be applied for all users or only those users who have not yet modified their own display settings. With the function, you can, for example, define specific columns to be displayed for all users.

To do this, press the Alt key and select **View > Save As Common Display Settings**... from the menu.

**Resetting the display settings to their defaults**

By using this function, you can reset modified display setting values to the defaults set by the system administrator. Alternatively, you can reset the display settings to the M-Files software defaults.
To do this, press the Alt key and select **View > Reset Display Settings to Defaults...** from the menu.

**Binding a report to a view**

You can bind a report for example to the view **Sales by customer** or **Proposals by salesperson.** With the options under **View > Reports** in the menu bar, you can bind a report to a view and specify its location. If you want this setting to apply for all users, enable the option **Common to all users** in the view settings. To define a common view, however, you need the permissions for managing the vault's common views.

For more information on reports, see Reporting and Data Export.

**Exporting results of views or searches**

To export views or search results, press the Alt key and select **File > Export...** from the menu, or right-click an empty area in a view and select **Export...** from the context menu. This command enables you to save the results of views or searches in CSV (comma-separated values) format.

Use this command to export metadata and, optionally, object files from M-Files. After exporting the metadata, you can view the CSV files, for instance, using Microsoft Excel or Apache OpenOffice Calc.

**Note:** The number of exported results can be modified by using a registry setting. Contact M-Files consulting services for additional information if you need to limit or expand the number of exported search results.

### 2.5. User Settings

This section details various settings and user operations available in M-Files Desktop.

**In this chapter**

- M-Files Desktop Settings
- Editing Notification Settings in M-Files Desktop
- Managing Vault Applications in M-Files Desktop
- Substitute Users
- Changing the Software and Vault Language
- Changing the M-Files Password
- Clearing the Local Cache of the Vault
- Show Status
- Refreshing External Objects
- Updating M-Files

#### 2.5.1. M-Files Desktop Settings

M-Files Desktop Settings allow you to add, edit, remove, and test vault connections. Additionally, on the **Settings** tab, you can modify various options related to the user- and computer-specific behavior of the client software, such as disabling the automatic check-in prompt or changing the M-Files drive letter.
When you open M-Files Desktop Settings, you will first see the Document Vault Connections tab. If you want to add a new vault connection, click the Add... button and follow the instructions in Adding a Vault Connection.

Note: Before you start setting up your document vault connection, consult your M-Files system administrator to ensure that M-Files Server and the document vault have been installed.

In this chapter

- Adding a Vault Connection
- User-specific Settings
- Computer-Specific Drive and Cache Settings
- Other Computer-Specific Settings
- Exporting Vault Connections and Settings

Adding a Vault Connection

You can start adding a new vault connection by clicking Add... in the M-Files Desktop Settings main window.
Note: If the connecting computer is using Windows Server 2012 and the server computer has been set to only accept Transport Layer Security (TLS) 1.2 connections, TLS 1.2 must be enabled on the client computers by following the instructions in Enabling TLS 1.2 on Windows Server 2012 Computers.

To establish the connection, you first need to specify a few properties.

Name

Begin by assigning a name to the document vault connection. The name can be anything, but it is a good idea to make it descriptive. The name will be displayed on the M:\ drive as a directory containing the contents of the document vault.
Server/Name

Enter the network name or IP address of the server on which M-Files Server has been installed and that contains the document vault.

Server / Port number

Specify the port to connect to on the server. The default TCP/IP port for M-Files is 2266.

Server/Protocol

Define the protocol to be used for the network connection. The following protocols are available:

- TCP/IP
- SPX
- Local Procedure Call (LPC)
- HTTPS

Encrypted connection

Enable this option to secure the communication between M-Files Desktop and M-Files Server. RPC encryption does not require Internet Information Services or any other additional components and is often the simplest way to achieve encryption of network communication between M-Files Desktop and M-Files Server in the organization’s internal network.

The option is available for the TCP/IP protocol only. If the protocol is HTTPS, the connection is always encrypted at the HTTPS protocol level. For connections from outside the organization’s internal network, HTTPS or VPN should still be used, as RPC communication to the default TCP port, 2266, is often blocked by firewalls.

Note: For RPC encryption to work, the user as well as the computer must be able to authenticate to the server computer. In practice, this requires that the client computer belongs to the Windows domain and that the user is a domain user.

For more information on encrypted connections and for instructions on how to configure the server to require encrypted connections, refer to Protecting Data in Transit with Encryption in M-Files.

It is also possible to use pre-shared keys in combination with HTTPS for securing a VPN-less access from outside the organization’s private network.

HTTP proxy settings

You may specify an explicit HTTP proxy server for document vault connections that use the HTTPS protocol. This option may be needed if your organization wants to route all traffic through an HTTP proxy server. To use an HTTP proxy server for a document vault connection, enable the option Specify HTTP proxy settings and in the HTTP proxy server field, type in the address of the proxy server and optionally the port number in the format <server address>:<port number>.

Server / Test Connection

You can use this button to check that the server connection works correctly.
Authentication

Specify the method the document vault is to use for authenticating the user. The authentication options are *Current Windows user*, *Specific Windows user*, and *M-Files user*.

The user is always authenticated on M-Files Server when logging in to the document vault, for example. M-Files Server is capable of checking the login accounts and passwords of all M-Files users. This is the M-Files authentication method. When Windows authentication is used, M-Files Server has the passwords checked by the domain server.

With Windows authentication, users log in to the database with same information that they use to log in to the local computer or the organization domain. If the organization uses a domain, using the domain logins and passwords is the quickest and easiest authentication method. This means that new passwords and logins are not needed, which makes this a rather user-friendly method.

**Differences between the various authentication methods**

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Current Windows user</strong></td>
<td>You can use the <em>Current Windows user</em> method to log in with your current Windows credentials.</td>
</tr>
<tr>
<td><strong>Specific Windows user</strong></td>
<td>Selecting <em>Specific Windows user</em> means that you need to enter your Windows username, password, and domain information when you log in. This option allows you to log in with a different account than the one you used for accessing Windows.</td>
</tr>
<tr>
<td><strong>M-Files user</strong></td>
<td>The M-Files authentication method allows you to log in to M-Files only. If your organization does not have a Windows domain or you do not have access to it, you should select <em>M-Files authentication</em> for logging in.</td>
</tr>
</tbody>
</table>

**Vault on server**

When there are several document vaults on the server, you can use this field to specify the document vault to connect to.

**Log in automatically when Windows is started**

You can choose to establish the connection to the document vault whenever Windows is started. This is a useful option if you are going to use the document vault daily. For more information, refer to Login Accounts.

**Visible to all users on this computer**

In Windows, there can be several users who each have their own user-specific settings. It is possible to provide user-specific access to M-Files document vaults. If you want the document vault to be visible to all users on this computer that have been defined in the operating system, check this box.

**Test Connection to Document Vault**

After specifying the contents of the above fields, you can check whether you can successfully connect to the document vault. If the connection works, the server has responded to the connection test.
Analyze connection

When you have created the vault connection and open the Document Vault Connection Properties dialog by double-clicking the vault connection in the M-Files Desktop Settings dialog, you can use the Analyze Connection button to display further details about the connection. The analysis measures the round-trip time between the client and the server, as well as the download and upload speeds.

User-specific Settings

These settings allow you to modify certain aspects of the M-Files Desktop behavior specific to your Windows user account. To open the User-specific Settings dialog:

1. Open M-Files Desktop Settings.
2. Open the Settings tab.
3. Click User-specific Settings.
Figure 58: The user-specific settings are specific to Windows users per workstation.

**Dialog boxes and prompts**

You can define comments to be asked of the user upon each check-in. If the **Check in immediately** option has been selected for file closure, comments are not requested.
By default, a warning is always displayed when the user logs out if the user has objects checked out. Dialog boxes are also closed after a default timeout.

**Behavior at file open**

You can define for each file extension type whether the specific file format is always opened in *Check Out* or *Open as read-only* state. You can also specify for each extension type that, upon opening each file, the software asks the state in which the file is to be opened.

**Behavior at file close**

You can define which actions are performed on the file upon closing it. The definition applies to all file formats. By default, the user will be asked what they wish to do to the file upon closing it. If the user does not change the default procedure (*Do not check in*), the dialog will be automatically closed after a chosen time and the document will remain checked out.

**Computer-Specific Drive and Cache Settings**

These workstation-specific settings allow you to change the M-Files drive letter and to control options related to the local data cache. To open these settings:

1. Open M-Files Desktop Settings.
2. Open the **Settings** tab.
3. Click **Computer-specific Settings**.
Drive
Select the drive letter for the M-Files drive. The default drive is M:\.

Local cache
When using M-Files, the documents are retrieved from the server to your local hard drive. The local cache makes M-Files significantly faster to use over slow connections.

Maximum in-memory cache size per vault
Here you can specify the amount of the computer's main memory that the document cache is allowed to take up.
Maximum on-disk cache size per vault

Here you can specify the amount of the computer’s disk space that the document cache is allowed to take up.

Destroy local data

M-Files saves information about vault contents locally in the computer cache. The data remains on the server, but the cache makes M-Files faster to use. Local files take up space on the computer’s hard drive and for this reason, it may sometimes be necessary to destroy local data. This function can be used to destroy locally cached data by user and by document vault.

Note that the Destroy Local Data function may delete data that cannot be restored from the M-Files server such as currently checked-out files on your computer, offline content, and temporary local files. Therefore it is important to ensure that you have saved and checked in all the documents that you need before destroying local data.

Figure 60: The local vault and user combinations are listed in the Destroy Local Data dialog.

Note:

If you only want to delete temporary local files and empty the metadata cache, see Clearing the Local Cache of the Vault.

The table below compares the locally cached elements that are either deleted or preserved when Clear Local Cache or Destroy Local Data is run.

<table>
<thead>
<tr>
<th>Cached content</th>
<th>Clear Local Cache</th>
<th>Destroy Local Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temporary local files</td>
<td>Optional</td>
<td>Delete</td>
</tr>
<tr>
<td>Metadata</td>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Checked-out documents</td>
<td>Keep</td>
<td>Delete</td>
</tr>
<tr>
<td>Document preview data</td>
<td>Keep</td>
<td>Delete</td>
</tr>
</tbody>
</table>
Other Computer-Specific Settings

These workstation-specific settings allow you to change M-Files Desktop behavior related to dialog boxes and prompts, vault security, file saving, and offline mode. To open these settings:

1. Open M-Files Desktop Settings.
2. Open the Settings tab.
3. Click Computer-specific Settings.
4. Open the Miscellaneous tab.

Figure 61: The Miscellaneous tab contains different computer-specific settings.
Dialog boxes, prompts, and security

The default settings are:

- Display a warning if M-Files Desktop is connected to an older M-Files server.
- Allow this M-Files client to use applications that are installed in the document vault.

Saving to M-Files

You can customize application-specific rules for saving files to M-Files. Application-specific rules can be used to, for example, exclude temporary files and other unwanted files from being saved to the document vault. Rules can also be used to allow operation with applications that use special file saving methods. The rules guarantee that, for instance, a metadata card of new files is displayed if automatic identification is not functioning.

![Specify Process-specific Save Behavior](image)

Figure 62: Add and edit process-specific saving behavior.

Add a new behavior by first clicking Customize... and then clicking the Add... button.

**Process-specific Save Behavior / General tab**

General settings can be used to disable the default setting Detect file save operations from standard file dialog boxes.

You can also define process-specific file formats that are always accepted or never accepted for saving in M-Files. Use of an asterisk (*) defines that the process-specific setting is valid for all file formats.
In the advanced settings, you can disable the default setting Detect file closing and apply user-specific check-in behavior.

You can also define process-specific file formats that will be immediately checked-in when the new file with the extension in question has been saved and the metadata card has been completed.
Offline mode

By default, the documents are kept ready for the offline state. If the workstation is never used offline, the documents need not be ready for the offline state. The selection can also be removed if the offline state is seldom used or seems to cause additional load for the machine.

Exporting Vault Connections and Settings

Document vault connections and settings can be exported to a Windows registry file. By running the exported registry file on other computers, you can use the same M-Files configuration data on several computers.

To export vault connections and settings:
1. Open M-Files Desktop Settings.

2. Open the Settings tab,

3. In the Export section, select the components that you want to export by checking the appropriate check boxes.

4. Click the Export... button.

   ✓ The Save As dialog is opened.

5. Specify the target location and file name for the REG file.

6. Click Save.

   The settings for the components of your choice are saved to a REG file and stored to the location that you defined in the Save As dialog.

### 2.5.2. Editing Notification Settings in M-Files Desktop

You can set M-Files to inform you by email about certain events, for instance about changes made to objects. This is useful, for example, when you wish to keep track of modifications made to a certain document.

**Note:** To be able to use this feature, event logging and notifications must be enabled on the M-Files server. For more information about server settings, refer to Editing Notification Settings in M-Files Admin.

You can access the Notification Settings dialog in M-Files Desktop by clicking your username in the upper right corner and selecting Notification Settings.
Creating a new notification rule

Open the New Notification Rule dialog by clicking the Add... button in the Notification Settings dialog.

Give the rule a name. Under Notification sent, select When a selected event occurs or When object matches the conditions of the filter. The content of the dialog changes based on your selection.

Message delivery

Select one of the message delivery options explained in the table below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notification messages disabled</td>
<td>Select this option to disable notification messages.</td>
</tr>
<tr>
<td>A separate notification message for each event</td>
<td>Select this option if you wish to receive a separate message for every event that meets the rule. The message is sent immediately whenever the notification rule is met.</td>
</tr>
</tbody>
</table>

Note: This option is not available if you selected When object matches the conditions of the filter under Notification sent.
### Option Description

**A digest message once a day**
Select this option if you wish to be informed of events via a digest message once a day.

If you selected **When object matches the conditions of the filter** under **Notification sent**, select the days on which you wish to receive the digest message.

The time when the message is sent is set by the system administrator in M-Files Admin. For more information, see [Editing Notification Settings in M-Files Admin](https://www.m-files.com/products/m-files-administration-manual).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Notification recurrence</strong></td>
<td>Select whether you want to receive a notification for an object only once or on each day that you selected in <strong>Message delivery</strong>. The selection is available only if you selected <strong>When object matches the conditions of the filter</strong> under <strong>Notification sent</strong>.</td>
</tr>
<tr>
<td><strong>Filter</strong></td>
<td>Define a filter. The filter determines the group of objects to which the notification rule applies. For more information about filters, see <a href="https://www.m-files.com/products/m-files-administration-manual">Defining a Filter for a View</a>.</td>
</tr>
<tr>
<td><strong>Event subscriptions</strong></td>
<td>If you selected <strong>When a selected event occurs</strong>, enable the check box for all the events that should trigger a notification message to be sent.</td>
</tr>
<tr>
<td><strong>Exclude notifications of events caused by the current user</strong></td>
<td>Select this option if you do not wish to be informed of events caused by yourself, such as modifications that you yourself have made to an object. This option is available only if you selected <strong>When a selected event occurs</strong> under <strong>Notification sent</strong>.</td>
</tr>
<tr>
<td><strong>Private and common rules</strong></td>
<td>If you want a notification message to be sent only to you, select <strong>Private rule</strong>. If you want a notification message to be sent to several selected recipients, select <strong>Common rule</strong>. M-Files Admin is used for specifying the permissions for creating a common rule. For more information, see <a href="https://www.m-files.com/products/m-files-administration-manual">Manage common views and notification rules</a> in this table.</td>
</tr>
<tr>
<td><strong>Recipients</strong></td>
<td>Specify the users or user groups who will receive notifications on the basis of this rule.</td>
</tr>
<tr>
<td><strong>Enabling push notifications for the M-Files mobile apps</strong></td>
<td>You can enable push notifications for M-Files Mobile by following the instructions in <a href="https://www.m-files.com/products/m-files-mobile-apps">Setting Up Push Notifications for the M-Files Mobile Apps</a></td>
</tr>
</tbody>
</table>
In this chapter

- Example: Daily Notifications for New Orders
- Example: Reminder Messages for Contracts

Example: Daily Notifications for New Orders

This example shows how you can create a private notification rule for sending you a daily digest message of all the new order objects in the vault.

Note: To be able to use this feature, event logging and notifications must be enabled on the M-Files server. For more information about server settings, refer to Editing Notification Settings in M-Files Admin.

1. Open M-Files Desktop.
2. Click your username in the upper right corner.
3. Click Notification Settings.
   
   The Notification Settings dialog is opened.

4. Click the Add... button.
   
   A dialog for creating a new notification rule is opened.

5. In the Name field, give your rule a name, such as New orders.
6. In Notification sent, select When a selected event occurs.
7. In Message delivery, select A digest message once a day.
8. Click the **Define Filter**... button.

The **Define Filter** dialog is opened.

9. Open the **Properties** tab.

10. Click **Add Condition**.

11. For the newly added property condition, select **Class** as the property, **=** as the operator, and **Order** as the value.

12. Click **OK** to close the **Define Filter** dialog.

The property condition 'Class' = 'Order' is now shown in the **Filter** field of the **Notification Rule Properties** dialog.

13. Enable notifications for the event **New document or other object**.

14. Optional: If you do not want to receive notifications for order objects created by yourself, enable the option **Exclude notifications of events caused by the current user**.

15. Once you are done, click **OK** to save the rule and close the dialog.

The new notification rule is added to the list in the **Notification Settings** dialog.

**Example: Reminder Messages for Contracts**

This example shows how you can create a common notification rule for contracts that have their deadline in 30 days. You will be notified every day starting 30 days before the deadline until the deadline is met.

**Note:** To be able to use this feature, event logging and notifications must be enabled on the M-Files server. For more information about server settings, refer to [Editing Notification Settings in M-Files Admin](#).

1. Open M-Files Desktop.

2. Click your username in the upper right corner.
3. Click **Notification Settings**.
   
   The **Notification Settings** dialog is opened.

   ![Notification Settings dialog]

4. Click the **Add...** button.
   
   A dialog for creating a new notification rule is opened.

5. In the **Name** field, give your rule a name, such as *Contract reminder*.

6. In **Notification sent**, select *When object matches the conditions of the filter*.

7. In **Message delivery**, select *A digest message once a day*.
   
   All days of the week are selected by default.

8. In **Notification recurrence**, select *Notify of each matching object repeatedly*.

9. Click the **Define Filter...** button.
   
   The **Define Filter** dialog is opened.
10. Click the **Add Condition** button twice.

11. For the first condition, select *Assigned to* as the property, = as the operator, and *(current user and users for whom the current user is a substitute)* as the value.

12. For the second condition, select *Deadline* as the property, <= as the operator, 30 as the value, and *DaysTo()* as the option.

13. Click **OK** to close the Define Filter dialog.

   - The property condition ‘Assigned to’ = *(current user and users for whom the current user is a substitute)* AND *DaysTo( ‘Deadline’ )* <= 30 is now shown in the **Filter** field of the Notification Rule Properties dialog.

14. Once you are done, click **OK** to save the rule and close the dialog.

   The new notification rule is added to the list in the **Notification Settings** dialog.

### 2.5.3. Managing Vault Applications in M-Files Desktop

Various third-party applications can be used for modifying and extending M-Files Desktop and M-Files Server behavior. For information on managing and installing the applications, see Installing and Managing Vault Applications.

#### Managing the vault applications

After a vault-specific client application has been installed via M-Files Admin, it is available for M-Files Desktop users. Upon logging in to the vault, M-Files prompts you to enable the new application. If the administrator requires the application to be enabled, you cannot log in and use the vault until you have approved the use of the application.

You can manage computer-specific client applications by pressing the Alt key and selecting **Settings > Applications** from the menu bar.
Computer-specific settings

Note that the computer-specific settings influence the use of the applications as well. By default, the user computer-specifically allows M-Files to use applications that are installed in the document vault. If this setting is disabled, neither the optional nor compulsory vault-specific applications are available.

To enable or disable this setting:

1. Open M-Files Desktop Settings.
2. Select the Settings tab.
3. Click Computer-specific Settings.
4. Select the Miscellaneous tab.
5. Enable or disable the application setting under the Security heading.

2.5.4. Substitute Users

You can define substitute users for periods of absence. The substitute users you specify have the rights to carry out assignments given to you during this period. For step-by-step instructions on how to assign yourself a substitute user, see Appointing a Substitute User.

Assignments and user permissions

Assignment and document permissions may differ. If the assignment requires the assignee to edit a document, the substitute user of the assignee must have:

- edit rights to the document
- either a named user license or a concurrent user license (see License type)

For more information about assignments, see Creating and Completing Assignments.

Assignment notifications

If the assignment is created after the substitute user has been specified, the substitute user will also receive notification of the assignment. If the substitute user is specified after creating the assignment, the substitute user will not receive any separate notification of the assignment.

Viewing assignments

You can see all the tasks assigned to you in the Assigned to Me view that you can access by opening the Assigned tab in M-Files Desktop.

In this chapter

- Appointing a Substitute User

Appointing a Substitute User

1. In M-Files Desktop, press the Alt key to display the menu bar and select Settings > Substitute Users from the menu.

Alternatively, you can click your username in the upper right corner and select Substitute Users from the context menu.

The Substitute Users dialog is opened.
2. Click Add... to select the substitute user or users.

The Select Users dialog is opened.

3. Select the preferred user or users and click Add.

You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the Shift key to select adjacent items on the list.

The Select Users dialog is closed and the selected user or users are added to the Substitute users list.

4. Click OK to close the Substitute Users dialog.

The users who you have just appointed as your substitute users will now be able to complete assignments assigned to you and will receive notifications about such assignments.

2.5.5. Changing the Software and Vault Language

You can change both the M-Files software and the vault language via M-Files Desktop. For a list of the supported user interface languages, see Language Versions of the M-Files Software. For information about creating new vault localizations, see Translating the Metadata Structure.

Do the following steps to change the software and the vault language:

1. In M-Files Desktop, press Alt and select Settings > Change Language... from the menu bar.

The Change Language dialog is opened.

2. Use the Software language drop-down menu to change the language of the M-Files user interface.
3. Use the **Vault language** drop-down menu to change the language of the current vault.

   The vault language selection contains all languages that the document vault has been translated into.

4. Click **OK** to change the languages and to close the **Change Language** dialog.

### 2.5.6. Changing the M-Files Password

If you are using M-Files authentication, you can change your password by completing the steps provided below.

**Note:** If you cannot see this option, it means that your login account is not using M-Files authentication, and thus you have no separate M-Files password for the selected vault.

To change your M-Files password:

1. Enter a vault via M-Files Desktop.

2. Either:
   
   a. Click your username in the top-right corner of the user interface to open the user menu and select **Change Password**... from the context menu.

   or

   b. Press the Alt key and select **Settings > Change Password**... from the menu bar.

   The **Change M-Files Password** dialog is opened.

3. Enter your current password in the **Old password** field.

4. Enter a new password in the **New password** field.

5. Confirm your new password by retyping it in the **Confirm new password** field.

6. Click **OK** to save your changes.

Your M-Files password should now be changed to the one you specified in the **New password** field.

### 2.5.7. Clearing the Local Cache of the Vault

You can remove temporary local files from a document vault by pressing the Alt key in the M-Files Desktop user interface and then selecting **Settings > Clear Local Cache**... from the menu bar.
Select the temporary local files that you want to delete and click **Delete**, or click **Delete All** to delete all temporary local files in the vault. When you click **Finish**, the metadata cache in the vault is cleared. The cache is used to store data such as property values and object references.

For instructions on converting temporary local files into documents, see Converting a temporary local file to a document.

**Note:**

If you want to delete all locally cached data in a vault, see Destroy local data. Note that the **Destroy Local Data** function may delete data that cannot be restored from the M-Files server such as currently checked-out files on your computer, offline content, and temporary local files.

The table below compares the locally cached elements that are either deleted or preserved when **Clear Local Cache** or **Destroy Local Data** is run.

<table>
<thead>
<tr>
<th>Cached content</th>
<th>Clear Local Cache</th>
<th>Destroy Local Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temporary local files</td>
<td>Optional</td>
<td>Delete</td>
</tr>
<tr>
<td>Metadata</td>
<td>Delete</td>
<td>Delete</td>
</tr>
<tr>
<td>Checked-out documents</td>
<td>Keep</td>
<td>Delete</td>
</tr>
<tr>
<td>Document preview data</td>
<td>Keep</td>
<td>Delete</td>
</tr>
<tr>
<td>Offline content</td>
<td>Keep</td>
<td>Delete</td>
</tr>
</tbody>
</table>
2.5.8. Show Status

In M-Files, objects are kept on the M-Files server and transferred to the caches of M-Files users’ computers to make sure using M-Files Desktop is as fast as possible.

With the Show Status component, you can monitor the file transfers from the server to your computer and find out how long it will take to download a document. This tool is particularly useful if you are using M-Files over a slow connection. In regular local area network use, documents are usually transferred so quickly that there is no time or any reason to even check the status information.

You can open the Show Status dialog either via the Windows start menu shortcut or by right-clicking the M-Files icon in the Windows notification area and selecting Show Status.

The File Transfer tab

The Status column in the File Transfer tab indicates whether the file has been transferred or is being transferred. The status is indicated as a percentage. You can stop the transfer by selecting the document and clicking Stop.

![Figure 66: The File Transfer tab of the Show Status component.]

The Configure... button opens M-Files Desktop Settings. For more information, refer to M-Files Desktop Settings.

Document vault connections

On the Document Vault Connections tab, you can see which document vault connections are available and whether the vault is online.
Go Online, Go Offline

These functions allow you to switch between the Offline and Online modes. The function of the button changes according to the current status. See also Going Offline and Going Online.

Log Out, Log In

If you are logged in to a document vault, you can use the Log Out button to log out and quit M-Files Desktop. The function of the button changes according to your current status.

2.5.9. Refreshing External Objects

M-Files can also be connected to external databases. This way, a two-way connection can be set up between M-Files and, for example, a customer database. Customer data can be accessed through M-Files as well as through the user interface of the external database. You can refresh data automatically in both directions.

By pressing the Alt key in the M-Files Desktop interface and then selecting Settings > Refresh External Objects from the menu bar, you can make sure that M-Files contains up-to-date external object information.

For more information on external objects, see Connections to External Databases for Object Types.

2.5.10. Updating M-Files

Automatic updates keep the M-Files software up to date. If a newer version of M-Files becomes available, it is downloaded to client computers and installed automatically. Users can delay automatic updates for a limited time if they are working on something important while an automatic update becomes available.
Note: Users do not need local administrative rights on their computers for the automatic updates to run.

Figure 68: In M-Files Desktop, vault users are notified when a new M-Files version becomes available. By clicking Options, users can schedule or initiate the M-Files software update.

Figure 69: Vault users can choose between updating M-Files right away or at a later time.

The feature obtains the latest update information from the update server using HTTPS on TCP port 443. This means that normally you do not need to change any firewall settings.

For information on updating M-Files manually, see Manually Updating M-Files.

Settings for automatic updates

You can open the settings for automatic updates by choosing Automatic Updates from the Microsoft Windows start menu, and then by opening the Settings tab in the Automatic Updates window.

Note: The M-Files system administrator may preset these settings, in which case they cannot be changed via the Settings tab.
If you wish to disable automatic updates, uncheck the **Download updates automatically** check box. You can always check for updates manually by opening the **Installation** tab and clicking the **Check Now** button. This way an update is downloaded to your computer if there is one available. For a high-level description on how M-Files downloads the update packages when the **Download updates automatically** option is enabled, see [Update Download Process](#).

If you wish to disable the automatic installation of updates, uncheck the **Install updates automatically** check box. You can always start the installation of available updates manually by opening the **Installation** tab and clicking the **Install** button. If the **Install** button is disabled, it means that there are no updates available for installation.

In the **Installation schedule** section, you may select the preferred days and time of installing M-Files updates. It is recommended that you select a date and time that is outside of working hours so that installing updates does not interrupt M-Files operations in your organization. Note that the computer must be running and not in sleep or hibernate mode when the update is scheduled to be installed. If the computer is not running when the scheduled installation time occurs, the update is attempted to be installed or scheduled the next time the computer is started.

**Note:** It is strongly recommended that you keep automatic updates enabled to ensure that your M-Files software is always up to date. For more information on scheduling update installations and disabling automatic updates, see [Configuring Automatic Updates via Registry Settings](#).
3. System Administration

This section, intended mainly for M-Files system administrators, explains how to manage, maintain, and configure the M-Files system.

This section, intended mainly to M-Files system administrators, explains how to manage, maintain, and configure the M-Files system.

The first subsection, Setting Up and Maintaining M-Files, introduces the M-Files system, provides instructions for installing and upgrading the system, and explains how server connections and document vaults are managed.

The second subsection, Configuring M-Files, discusses the various ways you can configure and personalize your system to match your specific requirements and processes. It includes themes such as modifying the metadata structure of the vault, configuring workflows, using vault applications, making use of event handlers and scripts, and so forth.

In this chapter

- Setting Up and Maintaining M-Files
- Configuring M-Files

3.1. Setting Up and Maintaining M-Files

This section describes what the M-Files system consists of, how you can set it up, and how to make sure everything is running as intended. For instructions on how to, for instance, modify the vault metadata structure, object workflows, or the metadata card behavior, or on how to install and use vault applications, see Configuring M-Files.
In this chapter

- System Overview
- Installing and Upgrading M-Files
- M-Files Admin
- Server Connections
- Managing Document Vaults

3.1.1. System Overview

An M-Files system consists of the following components:

1. a server computer (or multiple servers) running the M-Files Server component and containing the document vault or vaults
2. M-Files clients used for displaying and editing the vault-stored information via the end-users' computers or mobile devices

You can access document vaults in the following ways:

- by installing M-Files Desktop on your desktop or laptop
- by accessing M-Files Web via any web browser
- with the M-Files mobile apps for iOS and Android devices

The image above offers a high-level description of the M-Files system: the clients (M-Files Desktop, M-Files Web, or any of the M-Files mobile applications) on the left are used for accessing the server computer (center of the image), which in turn manages one or more document vaults (on the right). Alternatively, M-Files Server and the document vaults may be located on a cloud-based server (see Deployment Options for M-Files Server).

You can edit server settings and the document vault structure with M-Files Admin. With M-Files Desktop Settings, you can add, remove and edit vault connections. For more information about using M-Files Web
and the mobile applications, see the topics Accessing M-Files with M-Files Web and Accessing M-Files with M-Files Mobile.

M-Files Server Deployment Options

M-Files Server can be set up on-premises, in the cloud, or as a hybrid deployment, the latter combining the advantages of on-premises and cloud-based systems. Refer to Deployment Options for M-Files Server for more information.

M-Files software languages

The M-Files user interface is available in multiple languages. For a list of the currently available M-Files software languages, see Language Versions of the M-Files Software. For information about localizing the vaults and for making sure all the interface components are shown in the language of your preference, see Languages and Translations.

In this chapter

- System Components
- Deployment Options for M-Files Server
- Language Versions of the M-Files Software
- Security and Authentication
- Electronic Signing and Compliance

System Components

Your M-Files software includes the following components:

- **M-Files Setup**: Use this to install M-Files.
- **M-Files Desktop**: The most commonly used component that displays content in various views and is tightly integrated into Windows.
- **M-Files Desktop Settings**: Use this component to connect your client computer to document vaults on M-Files Server, and to edit other local settings.
- **M-Files Server**: This component manages the centralized saving and sharing of content.
- **M-Files Admin**: A tool used by your company's information systems administrator for adjusting M-Files Server settings, managing the document vault, and modifying the vault structure.
- **Show Status**: With this component, you can monitor file transfer status. This is useful if you are using M-Files over a slow connection and need to view the transfer progress.
- **M-Files Web**: In addition to using the M-Files Desktop, you can access M-Files by using a web browser.
- **M-Files Mobile**: To access M-Files with your mobile device, you can use the M-Files mobile apps for iOS and Android.
- **Automatic Updates**: Automatically keep your M-Files software up to date.

M-Files also includes an ActiveX/COM API as well as the M-Files Web Service API that allows programmatic access to M-Files through a REST-like interface. The M-Files API and its documentation are included within the installation of the M-Files software, and the M-Files Web Service API is documented at: www.m-files.com/mfws.

Deployment Options for M-Files Server

M-Files offers several server deployment options, giving you the flexibility to leverage M-Files based on the model that best suits your organization's business needs and budget. Below is a short description of each server deployment option. Contact M-Files sales at sales@m-files.com if you need more information and advice on finding the best solution for your organization.
You can access your vaults with M-Files Desktop, M-Files Web, and M-Files Mobile regardless of the server deployment solution that you decide is best suited for your organization.

**On-premises server**

An on-premises server deployment is best suited for organizations that have already invested in existing servers and systems, or are required to use an on-premises solution deployed behind the organization’s own firewall for regulatory reasons.

Using on-premises servers for M-Files vaults does not, however, mean that they could not be securely accessed from outside (or inside) the company network. The vaults in the organization’s private network can be accessed via M-Files Web, M-Files mobile applications, or M-Files Desktop (via a VPN connection or by using a pre-shared key) regardless of your location.

**Cloud server**

Document and intelligent information management via a cloud-based server deployment provides software as service (SaaS) flexibility associated with licensing and scalability (such as the ability to easily expand storage, or to modify the number of user licenses as necessary) without significant capital investment and incremental resources to support it. In addition, cloud-based solutions offer inherent remote access to company documents, and flexible monthly billing. Powered by the Microsoft Azure cloud platform, M-Files Cloud Vault delivers additional redundancy and automated third-party backup that offers greater protection against data loss or theft.

Please note that using a cloud-based deployment also enables you to use all the client options for connecting to your vaults.

**Cloud Vault Subscription Management Portal**

The M-Files Cloud Vault Subscription Management Portal allows end user administrators to manage their subscriptions online.

The portal enables the following functions:

- Adding new licenses and removing existing licenses.
- Adding new user accounts and removing existing ones.
• Changing user details and license types.
• Downloading M-Files installers.

**Self-hosted cloud server**

The managed instance deployment option of the Microsoft Azure SQL Database allows to host your database engine by your organization. A managed instance of the Microsoft Azure SQL Database is a fully managed SQL Server Database Engine instance hosted in Azure cloud.

**Hybrid server**

With an M-Files hybrid deployment, organizations can both leverage their existing on-premises technology investments and take advantage of an award-winning document and intelligent information management solution running in the public cloud or a private cloud, as needed.

Furthermore, M-Files Cloud Vault can be seamlessly integrated with existing on-premises systems like an ERP or CRM, such as SAP or Microsoft Dynamics GP and AX. Conversely, an on-premises deployment of M-Files can be easily integrated into existing cloud-based business applications, such as Salesforce, Microsoft Dynamics Online, or NetSuite.

The same client options (M-Files Desktop, M-Files Web, or any of the M-Files mobile applications) are equally available for organizations using a hybrid server deployment.

**Language Versions of the M-Files Software**

The M-Files software is currently available in the following languages:

- Albanian
- Arabic
- Bulgarian
- Chinese (Simplified/PRC)
- Chinese (Traditional/Taiwan)
- Croatian
- Czech
- Danish
- Dutch
- English
- Estonian
- Finnish
- French
- German
- Greek
- Hebrew
- Hungarian
- Italian
- Japanese
- Korean
- Macedonian
- Mongolian
- Norwegian
- Polish
- Portuguese (Brazil)
- Romanian
- Russian
- Serbian (Cyrillic)
- Serbian (Latin)
- Slovak
- Slovenian
- Spanish
- Swedish
- Thai
- Turkish
- Ukrainian
- Vietnamese

You may change the language of the software and the document vault (metadata structure) while the software is running. Even if, for example, a Finnish version of M-Files has been installed on the computer, you can easily switch to the English version without reinstalling the software. This is a significant benefit when shared computers are used.
Note: Only when 1) the software installation language, 2) the vault language, and 3) the Windows display language are the same, all the M-Files functions and the metadata structure of the document vault are displayed in the language in question. For more information, see Languages and Translations.

Security and Authentication

This section discusses various topics regarding system security as well as connections to M-Files Server and the M-Files vaults.

In this chapter

- M-Files and Virus Scanning
- Accessing M-Files Vaults without VPN
- HTTPS Connections to M-Files Server
- M-Files and Federated Authentication

M-Files and Virus Scanning

M-Files is compatible with all commonly used virus scanning products.

It is, however, important to ensure that the virus scanners on the end users’ computers do not perform scheduled scanning for the virtual M-Files drive (the \M: drive by default). A scheduled scan for the M-Files drive would load all the content from the M-Files server to the user’s client and unnecessarily strain both the network and the server.

Additionally, for best performance, you may wish to disable any real-time scanning for the virtual M-Files drive (the \M: drive by default) and the M-Files installation folder (C:\Program Files\M-Files\ by default). Excluding these locations from real-time scans can help prevent unnecessary system load and possible conflicts between M-Files and the anti-virus software.

Excluding the M-Files drive and installation folder from virus scanning

To exclude the M-Files drive and the installation folder from virus scanning, you should add their paths to the appropriate exclusion lists or exceptions lists in the anti-virus software. For example with Symantec Endpoint Protection Manager (SEPM), this would be done via an exceptions policy as described in the Symantec knowledge base article Create Centralized Exceptions Policies in Endpoint Protection Manager 12.1. Other commonly used anti-virus software products may use terminology such as “excluded items list”, “exclude objects”, or “exclude from scanning”.

There are typically separate exclusion lists for scheduled scanning and real-time scanning.

Excluding the M-Files Client process from virus scanning

If your anti-virus software supports excluding processes by name, it is usually a good idea to exclude the MFClient.exe process from any real-time scanning on the client computers. By default, the path to MFClient.exe is C:\Program Files\M-Files\<version>\Bin\x64\MFClient.exe on 64-bit systems and C:\Program Files\M-Files\<version>\Bin\x86\MFClient.exe on 32-bit systems. With SEPM, for instance, this can be done by following the instructions in the Symantec knowledge base article How to create an application exception in the Symantec Endpoint Protection Manager.

Excluding the MFClient.exe process from real-time scanning can help improve performance by preventing the virus scanner from scanning the same files twice: once when the application opens the file and another time when MFClient.exe performs an internal open operation on the same file.
Excluding M-Files Server processes and vault data from virus scanning on the M-Files server machine

On the M-Files server machine, you should ensure that the following processes are excluded from any real-time virus scanning:

- MFServer.exe
- MFServerAux.exe
- MFIndexer.exe
- MFIndexingManager.exe
- MFDataExport.exe

The default location of these processes on 64-bit systems is `C:\Program Files\M-Files\<version>\Bin\x64\`, and on 32-bit systems the default location is `C:\Program Files\M-Files\<version>\Bin\x86\`, with the exception of MFServerAux.exe, which is found in `C:\Program Files\M-Files\<version>\Bin\x86\` on both 32-bit and 64-bit systems.

In addition, you should ensure that the following folders are excluded from virus scanning:

- the M-Files installation folder, which is located in `C:\Program Files\M-Files\` by default
- the vault data folder, which is located in `C:\Program Files\M-Files\Server Vaults\` by default

If the processes and folders listed above are not excluded from virus scanning on the M-Files server machine, users may experience poor vault performance or it may cause faulty backups of the vault data.

Excluding Microsoft Windows processes

You should ensure that the `pdfSaver.exe` process is excluded from real-time virus scanning. The default location of the process is `C:\Program Files\Tracker Software\PDF-XChange Standard`. Excluding the `pdfSaver.exe` process from real-time scanning helps improve the performance when the user is converting documents to PDF.

Antimalware Support

M-Files Server supports antimalware checks on Windows Server 2016 and newer. If you are using an anti-virus software that is compatible with Windows Antimalware Scan Interface (AMSI), such as Windows Defender, and if real-time scanning is enabled, files uploaded to M-Files Server can be scanned for viruses and malware before saving them in the repository.

To enable the antimalware checks, add the following values to the Windows registry of the M-Files Server computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
<th>Value type</th>
<th>Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server \MFServer</td>
<td>EnableAntimalwareScanner</td>
<td>REG_DWORD</td>
<td>1</td>
<td>Enables antimalware scanning on Windows 10, Windows Server 2016, and newer.</td>
</tr>
</tbody>
</table>
## Key: HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server \MFServer

<table>
<thead>
<tr>
<th>Value name</th>
<th>TreatAntimalwareScannerErrorsAsTransferBlockingErrors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>Description</td>
<td>Specifies whether file transfers to M-Files Server are blocked in case the antimalware software is not available or has not been properly configured. The default value is 0.</td>
</tr>
<tr>
<td>Value</td>
<td>0  Do not block file transfers if antimalware software is not available or is misconfigured.</td>
</tr>
</tbody>
</table>

### Accessing M-Files Vaults without VPN

Organizations have traditionally relied on Virtual Private Network (VPN) technology to secure access to corporate resources (such as M-Files vaults) from outside the private network of the organization. M-Files versions 10.2 and later enable you to provide secure access to the M-Files system without the downsides of the traditional VPN-based approach.

The security of this approach is based on encrypting all network traffic between client devices and the server with HTTPS (SSL/TLS) and on using a pre-shared key as an additional "shared secret" in authentication to ensure that only authorized devices can attempt to connect to the system.

**Note:** Cloud-based servers, M-Files Web, and the mobile applications use the HTTPS protocol by default, but for pre-shared keys to work on desktop clients connecting to an on-premises server, "RPC over HTTP with SSL" communication between the server and the desktop clients needs to be enabled. For more information, refer to the document Enabling RPC over HTTPS connections to M-Files Server.

Together, the HTTPS encryption and the use of a pre-shared key as a second factor in authentication provide similar security as VPN but without the complexity and compatibility challenges of VPN. However, it needs to be noted that the approach is not identical to VPN from the security point of view, and that each organization needs to determine if granting access to M-Files vaults without VPN is appropriate considering the organization's business needs and security requirements.

For more information about using pre-shared keys for secure M-Files access, please refer to Securing Access to M-Files Vaults with a Pre-Shared Key.

### HTTPS Connections to M-Files Server

The communication between M-Files Server and the M-Files clients can be accomplished by using various connection protocols. Cloud-based servers (as well as the M-Files Web client and the M-Files mobile applications) only accept communication via the HTTPS protocol, whereas the default way for M-Files Desktop to communicate with an on-premises M-Files server is to use the Remote Procedure Call (RPC) protocol (TCP/IP, port 2266). Since this mode of communication does not require any additional configuration steps, it is usually the preferred way of communicating inside the organization's internal network.

In some situations, however, it is preferable to enable M-Files Desktop to communicate with M-Files Server via the HTTPS protocol instead of RPC. This is especially useful if clients are connecting from outside the company's internal network. HTTPS connections are always encrypted and are typically not blocked in hotel networks or other public networks.

For instructions on how to enable "RPC over HTTP with SSL" communication between M-Files Desktop and M-Files Server, refer to the document Enabling RPC over HTTPS connections to M-Files Server.
the configuration described in the document, all traffic from M-Files Desktop is encrypted and tunneled through TCP port 443.

Once the "RPC over HTTP with SSL" connections have been enabled on the server, end users will be able to use the HTTPS protocol while adding or editing a document vault connection in M-Files Desktop Settings.

**M-Files and Federated Authentication**

Traditionally, the need to verify user identity has been met by using software-specific credentials or Windows credentials. Federated authentication offers organizations the possibility to use an authentication system that is completely external to M-Files. Federated authentication allows M-Files users to be authenticated using third-party services called identity providers, such as Google or Azure AD. In many cases, having a centralized repository for all the M-Files user credentials completely outside the M-Files system can be very useful. Federated identity management also enables single sign-on, and provides the opportunity for the users to utilize their existing credentials.

![Authentication flow in a federated authentication system.](image)

The figure gives an overview of the federated authentication process:

1. An M-Files user attempts to log in to a vault, and the client, be it M-Files Desktop or any other M-Files client, sends an authentication request to M-Files Server.
2. M-Files Server creates an authorization request, which it sends to the identity provider.
3. The user is then redirected to the identity provider’s login page where the user provides her credentials.
4. After the identity provider has validated the credentials, it returns a response to M-Files Server in the form of an identity token, which contains an assertion affirming that the user has been authenticated.
5. M-Files Server verifies the identity token and grants the user access to the vault.

You may use the configurations editor in M-Files Admin to enable federated authentication in your vault. For more information, see Using the Configurations Editor.

For more information about using federated authentication with M-Files, see the article Using Federated Authentication with M-Files.

**Electronic Signing and Compliance**

Companies using M-Files can manage their documents and processes efficiently and with quality. M-Files can be used for compliance with various specifications, good manufacturing practices, general procedures, and documentation according to standards. Moreover, M-Files provides functions to manage and monitor general documents associated with daily business.
M-Files also meets the special requirements related to records and following various specifications and standards. For example, M-Files complies with the following standards and guidelines:

- ISO 9001 series
- FDA 21 CFR Part 11
- EU GMP Annex 11
- HIPAA
- Sarbanes-Oxley

M-Files can also be used to implement TLL-4-compliant data systems (TLL-4 is a data security classification used in public administration and defense forces).

M-Files supports the administration of electronic records and signatures in compliance with FDA 21 CFR Part 11. This involves maintenance of the detailed audit trail of actions performed on the documents, secure monitoring of individual actions, and certification of electronic signatures with usernames.

**Activation**

The Electronic Signatures and Advanced Logging module includes the event logging extensions mentioned above and the electronic signature functionality. The module is available for a separate fee.

For you to activate the module, an appropriate license code must be activated on your system. The license is provided on a subscription basis. Activate or update the license code in M-Files Admin (for more information, see Managing Server Licenses). In addition to this, the audit trail features of the vault must be activated (see Document Vault Advanced Properties). If you do not have M-Files Compliance Kit installed, you also need to add the electronic signature metadata structure to your vault manually (for instructions, see Metadata Definitions for an Electronic Signature Object).

**More information**

For more information on the Electronic Signatures and Advanced Logging module related extensions for event logging and electronic signatures, refer to Vault Event Log and Electronic Signatures.

M-Files can also be used to address other standards, quality management systems, compliance requirements, guidelines, and procedures and processes in different fields. Log entries, audit trails, version history, and electronic signatures form one set of functions that M-Files can offer. To find out how M-Files can support your business by complying with applicable standards and specifications, please contact us at sales@m-files.com.

### 3.1.2. Installing and Upgrading M-Files

This section guides you through the steps and requirements for an M-Files installation or upgrade, along with describing how to set up a vault, add users to it, and establish a vault connection.

**In this chapter**

- System Requirements and Technical Details
- Installing the Software
- Updating M-Files
- Manually Updating M-Files
System Requirements and Technical Details

This section lists the system requirements for the various M-Files components, as well as technical details, for instance, about using M-Files in special environments, securing information with file data encryption, and integrating 3rd party applications to M-Files.

In this chapter

- System Requirements
- Technical Details

System Requirements

This topic lists the system requirements for the various M-Files components.

Operating system requirements

M-Files Desktop:

- Microsoft Windows 10
- Microsoft Windows 8.1
- Microsoft Windows Server 2019
- Microsoft Windows Server 2016
- Microsoft Windows Server 2012 R2

Note: In environments where the servers have been set to only accept TLS 1.2 connections, connecting computers using Microsoft Windows Server 2012 must be set to use TLS 1.2 connections by following the instructions in Enabling TLS 1.2 on Windows Server 2012 Computers.

M-Files Server:

- Microsoft Windows Server 2019 (recommended)
- Microsoft Windows Server 2016 (recommended)
- Microsoft Windows Server 2012 R2
- Microsoft Windows Server 2012
- Microsoft Windows 10
- Microsoft Windows 8.1

Note: This M-Files version does not support Microsoft Windows 8.

The operating system version can be either Workstation or Server. M-Files Server can be installed either on a physical or a virtualized server, for instance using Hyper-V or VMWare ESXi.

Running M-Files in a Windows Container or Nano Server environment is currently not supported.

For data security reasons, we do not recommended installing M-Files Server on a computer that is also used as a Microsoft domain controller. However, M-Files Server can technically run on a Microsoft domain controller server.

Linux and macOS

Linux and macOS users can access M-Files via M-Files Web. For macOS users, we recommend using M-Files Web with Google Chrome and the M-Files for Chrome extension. See the knowledge base document...
Installing and Enabling the M-Files for Chrome Extension for instructions on how to install and enable the extension.

32/64-bit support

M-Files is compatible with both 32-bit and 64-bit Microsoft Windows operating systems. The 32-bit and 64-bit systems have separate installation programs.

.NET Framework requirements

Both the server computer and client workstations must have Microsoft .NET Framework 4.0 or later installed in order for all M-Files functions to work properly. M-Files Compliance Kit installations require Microsoft .NET Framework 4.5 or later to be installed on both the server and client computers. Intelligent Metadata Layer features require Microsoft .NET Framework 4.5 or later to be installed on the server computer.

Server requirements

The M-Files system can be set up to run on a single server machine or on dedicated database, application, and search servers.

Single-server environments

The minimum requirements and recommended hardware setups are listed below for environments where the M-Files server machine is running both the M-Files Server application and the database server (Firebird or Microsoft SQL Server).

Minimum requirements:

<table>
<thead>
<tr>
<th>CPU</th>
<th>2 cores</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>1 GB</td>
</tr>
<tr>
<td>Storage</td>
<td>300 MB disk space for M-Files Server</td>
</tr>
</tbody>
</table>

Recommendation for up to 50,000 objects:

<table>
<thead>
<tr>
<th>CPU</th>
<th>4 cores</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>4 GB</td>
</tr>
<tr>
<td>Storage</td>
<td>RAID 1 or RAID 5 disks and enough disk space for files, database, and backups</td>
</tr>
</tbody>
</table>

Recommendation for up to 1 million objects:

<table>
<thead>
<tr>
<th>CPU</th>
<th>8 cores</th>
</tr>
</thead>
<tbody>
<tr>
<td>Memory</td>
<td>16 GB</td>
</tr>
<tr>
<td>Storage</td>
<td>RAID 1 or RAID 5 disks and enough disk space for files, database files, and backups. Database files, Microsoft SQL Server transaction logs, and search index files should be stored on solid state drives (SSD) for optimal performance.</td>
</tr>
<tr>
<td>Operating system</td>
<td>64-bit operating system</td>
</tr>
</tbody>
</table>
Multi-server environments

For environments with a large number of objects and users, it is recommended to have separate dedicated server machines for the M-Files Server application, the vault database, and the full-text search indexing.

Below are recommended example configurations for three different environments. Notice that the performance of the system also depends on the degree of concurrent activity (concurrent user sessions) as well as on the type of operations being performed in the vault. For instance, records management and archiving typically requires less hardware resources than managing active content with workflows.

Recommendation for up to 5 million object versions and 5 terabytes of files:

<table>
<thead>
<tr>
<th>System component</th>
<th>Database server</th>
<th>Application server</th>
<th>Indexing and search server</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>16 cores</td>
<td>8 cores</td>
<td>8 cores</td>
</tr>
<tr>
<td>Memory</td>
<td>32 GB</td>
<td>16 to 32 GB</td>
<td>16 to 32 GB</td>
</tr>
<tr>
<td>Storage</td>
<td>RAID 1 or RAID 5 disks (SSD)</td>
<td>RAID 1 or RAID 5 disks (HDD)</td>
<td>Five RAID 1 HDD or SSD disks</td>
</tr>
<tr>
<td></td>
<td></td>
<td>15 TB HDD for file data and backups. The file storage can be attached to the application server or the application server can connect to a separate file server.</td>
<td></td>
</tr>
<tr>
<td>Database management system</td>
<td>MS SQL Server 2017 or later, Standard or Enterprise Edition</td>
<td></td>
<td></td>
</tr>
<tr>
<td>M-Files Server license</td>
<td></td>
<td>Medium Server (billed separately)</td>
<td></td>
</tr>
</tbody>
</table>

Note: In these type of environments, configurations without a separate indexing and search server may be sufficient as well. The hardware recommendations are highly dependent on the performance expectations of each organization.

Recommendation for up to 15 million object versions and 8 terabytes of files:
<table>
<thead>
<tr>
<th>System component</th>
<th>Database server</th>
<th>Application server</th>
<th>Indexing server</th>
<th>Two search servers</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>32 cores</td>
<td>16 cores</td>
<td>8 cores</td>
<td>16 cores per server</td>
</tr>
<tr>
<td>Memory</td>
<td>128 GB</td>
<td>32 GB</td>
<td>128 GB</td>
<td>128 GB per server</td>
</tr>
<tr>
<td>Storage</td>
<td>256 GB SSD drive for operating system</td>
<td>256 GB SSD drive for operating system</td>
<td>256 GB SSD drive for operating system</td>
<td>256 GB SSD drive for operating system</td>
</tr>
<tr>
<td></td>
<td>Two 512 GB SSD drives for database data</td>
<td>25 TB HDD for file data and backups. The file storage can be attached to the application server or the application server can connect to a separate file server.</td>
<td>146 GB partition for IDOL distribution components</td>
<td>146 GB partition for IDOL distribution components</td>
</tr>
<tr>
<td></td>
<td>Two 128 GB SSD drives for database transaction log</td>
<td></td>
<td>256 GB SSD partition for the IDOL engine</td>
<td>Ten 300 GB partitions for the IDOL engines</td>
</tr>
<tr>
<td></td>
<td>All partitions in RAID 1 or similar</td>
<td></td>
<td>All partitions in RAID 1</td>
<td>All partitions should be in RAID 1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Each partition should have dedicated SAS drives (or equivalent)</td>
</tr>
<tr>
<td>Database management system</td>
<td>MS SQL Server 2017 or later, Standard or Enterprise Edition</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>M-Files Server license</td>
<td>Large Server (billed separately)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Recommendation for up to 50 million object versions and 10 terabytes of files:

<table>
<thead>
<tr>
<th>System component</th>
<th>Database server</th>
<th>Application server</th>
<th>Indexing server</th>
<th>Five search servers</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>32 cores</td>
<td>16 cores</td>
<td>8 cores</td>
<td>16 cores per server</td>
</tr>
<tr>
<td>Memory</td>
<td>512 GB</td>
<td>32 GB</td>
<td>128 GB</td>
<td>128 GB per server</td>
</tr>
<tr>
<td>System component</td>
<td>Database server</td>
<td>Application server</td>
<td>Indexing server</td>
<td>Five search servers</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------</td>
<td>--------------------</td>
<td>----------------</td>
<td>-------------------</td>
</tr>
<tr>
<td><strong>Storage</strong></td>
<td>256 GB SSD drive for operating system</td>
<td>256 GB SSD drive for operating system</td>
<td>256 GB SSD drive for operating system</td>
<td>256 GB SSD drive for operating system</td>
</tr>
<tr>
<td></td>
<td>Two 1 TB SSD drives for database data</td>
<td>30 TB HDD for file data and backups. The file storage can be attached to the application server or the application server can connect to a separate file server.</td>
<td>146 GB partition for IDOL distribution components</td>
<td>146 GB partition for IDOL distribution components</td>
</tr>
<tr>
<td></td>
<td>Two 256 GB SSD drives for database transaction logs</td>
<td></td>
<td>256 GB SSD partition for the IDOL engine</td>
<td>Ten 300 GB partitions for the IDOL engines</td>
</tr>
<tr>
<td></td>
<td>All partitions in RAID 1 or similar</td>
<td></td>
<td>All partitions in RAID 1</td>
<td>Each partition should have dedicated SAS drives (or equivalent)</td>
</tr>
<tr>
<td><strong>Database management system</strong></td>
<td>MS SQL Server 2017 or later, Enterprise Edition</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>M-Files Server license</strong></td>
<td>Large Server (billed separately)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Recommendation for up to one million objects when the Microsoft SQL Server is on a separate server:

<table>
<thead>
<tr>
<th>System component</th>
<th>M-Files Server</th>
<th>Microsoft SQL Server</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CPU</strong></td>
<td>4 cores (recommendation 8 cores)</td>
<td>4 cores (recommendation 8 cores)</td>
</tr>
<tr>
<td><strong>Memory</strong></td>
<td>8 GB (recommendation 16 GB)</td>
<td>16 GB (recommendation 32 GB)</td>
</tr>
<tr>
<td><strong>File system</strong></td>
<td>10 TB in total (4 TB for files + 4 TB for indexing + 20% as a buffer)</td>
<td>2 TB SSD drive</td>
</tr>
</tbody>
</table>

It is also recommended to have a separate SSD drive for indexing on the M-Files Server. The requirements on the table assume that the file data is stored on the M-Files Server according to the recommendation.

The structure of the vault influences the requirements. You can follow these recommendations for simple vaults without complex access definitions.
Supported operating systems for the M-Files Mobile apps

The M-Files Mobile apps support the following mobile operating systems:

<table>
<thead>
<tr>
<th>App name</th>
<th>Required OS version</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-Files Mobile for iOS</td>
<td>iOS 9 or later</td>
</tr>
<tr>
<td>M-Files Mobile for Android</td>
<td>Android 5.0 or later</td>
</tr>
</tbody>
</table>

Recommended browsers for M-Files Web

For optimal user experience, consider using M-Files Web with Google Chrome and the M-Files for Chrome extension available in the Chrome Store.

The supported browser versions for M-Files Web are:

<table>
<thead>
<tr>
<th>Web browser</th>
<th>Recommended version</th>
<th>Operating system</th>
</tr>
</thead>
<tbody>
<tr>
<td>Google Chrome (recommended)</td>
<td>Latest available version</td>
<td>Microsoft Windows, macOS</td>
</tr>
<tr>
<td>Internet Explorer</td>
<td>IE11</td>
<td>Microsoft Windows</td>
</tr>
<tr>
<td>Mozilla Firefox</td>
<td>Latest available version</td>
<td>Microsoft Windows</td>
</tr>
<tr>
<td>Safari</td>
<td>Latest available version</td>
<td>macOS</td>
</tr>
<tr>
<td>Microsoft Edge (limited)</td>
<td>Latest available version</td>
<td>Microsoft Windows</td>
</tr>
</tbody>
</table>

Tip: If you cannot use Google Chrome and need to frequently edit documents with M-Files Web, we recommend you to integrate M-Files Web with Microsoft Office for the web.

Note: Internet Explorer versions older than IE11 are not supported by M-Files Web. If you are using Internet Explorer 11, you should take the M-Files Web Java applet into use. See Enabling the Java Applet for M-Files Web for instructions on enabling the applet in your vaults. Note that any of the other listed browsers do not support Java applets.

M-Files Server disk space requirements

Metadata database

- Local hard disk drive
- 2–5 GB of disk space for 100,000 objects
- 20–50 GB of disk space for 1,000,000 objects

Please also note that the hard disk space requirements for the metadata database highly depend on the complexity of the metadata structure as well as on the number of object versions in the database. The estimates above apply to typical document management use cases.

File data

- Local hard disk drive OR a network file server
- Sufficient disk space for storing the document files, thumbnails, viewer files, and full-text search index files

M-Files uses a binary delta algorithm to process old versions of document files. This reduces the disk space consumption of old file versions considerably.
Administrators can free disk space by archiving or destroying old versions.

**Microsoft SQL Server requirements**

You can use Microsoft SQL Server 2012, 2014, 2016, 2017, 2019, or later with its latest service pack as the vault database engine. This covers all the Microsoft SQL Server editions, such as Express Edition, Standard Edition, and Enterprise Edition. M-Files supports the use of Microsoft SQL Server on Microsoft Windows. With your self-hosted cloud-based SQL database, you can also use Microsoft Azure SQL Database managed instance as the database engine.

**Note:** M-Files uses an SQL server assembly that must be running in the SQL server instance for M-Files to operate. Normally, M-Files loads this assembly to the SQL server instance automatically, but may sometimes fail to do so, for instance, due to inadequate rights to the SQL server instance. In this case, you need to manually allow the use of the assembly (see the support article M-Files and SQL Server 2017 compatibility).

Additionally, please take into consideration that the SQL server assembly may be updated from time to time, so you may need to repeat the whitelisting process after an upgrade.

The following features need to be enabled if you wish to use Microsoft SQL Server as the M-Files database engine:

**Instance features:**

- Database Engine Services
- Reporting Services, Native Mode (if reporting is used)

**Shared features:**

- Management Tools, Basic
- Management Tools, Complete (if reporting is used)

**In this chapter**

- Enabling the Java Applet for M-Files Web

**Enabling the Java Applet for M-Files Web**

If you need to frequently edit documents in M-Files Web with Internet Explorer 11 and the Integration with Office for the web is not an option for you, enable the M-Files Web Java applet in your vaults. The Java applet is disabled by default unless you are upgrading from a previous M-Files installation.

**Enabling the applet**

Follow these steps to enable the Java applet for M-Files Web in a vault of your choice:

1. Open your web browser.
2. Open the address http(s)://<Your M-Files Web domain>/configuration.aspx.
3. Log in with system administrator credentials.
5. Set the **Java applet** option to **Enable**.
6. Optional: Repeat the steps from 4 to 5 if you want to enable the Java applet for other vaults as well.

The Java applet is now enabled for the vault of your choice.

**Technical Details**

**Database engine and data storage**

M-Files Server includes Firebird Embedded, a powerful SQL database engine. Firebird is the default database engine of M-Files. Purchasing additional database software is thus not required. When using Firebird as the database engine of M-Files, the metadata of documents and other objects will be stored in a SQL database. The data files of objects are stored in the file system.


**Tip:** For the best performance, we recommend using Microsoft SQL Server 2016 Service Pack 1 or later as they support updateable columnstore indices, enabling better performance when opening sub-levels of views (such as *Documents by project*).

When using Microsoft SQL Server as the database engine of M-Files, the metadata of documents and other objects will be stored in a SQL database. The data files of objects can be stored either in the MS SQL database or in the file system. Microsoft SQL Server can be installed on the M-Files Server computer, or alternatively, the M-Files Server computer can connect to an existing SQL Server farm. In the latter case, the processor and RAM requirements of the M-Files Server may be smaller than indicated above.

If your organization wants to use a self-hosted cloud-based SQL database, you can use the managed instance deployment option of the Microsoft Azure SQL Database. A managed instance of the Microsoft Azure SQL Database is a fully managed SQL Server Database Engine instance hosted in Azure cloud.

M-Files uses Unicode and thus supports storing and finding data in East Asian languages as well. The data saved in the file system can be encrypted with the AES-256 algorithm. For more information, refer to Protecting File Data at Rest with Encryption in M-Files.

**Network communication**

M-Files Desktop communicates with M-Files Server via TCP/IP or HTTPS protocol. M-Files Web and the M-Files Mobile apps communicate with M-Files Server via HTTP or HTTPS protocol.

It is recommended to use encrypted connections in all client-to-server communication. For more information, see Protecting Data in Transit with Encryption in M-Files.

**Special environments**

M-Files is compatible with the following special environments:

- Remote Desktop Services (Terminal Services)
- Citrix XenApp
  
  M-Files is Citrix Ready for Citrix XenApp 7.6. See M-Files and Citrix XenApp for the configuration details.
- Linux file servers
- Novell networks
User authentication

M-Files supports multiple authentication methods (can be mixed):

<table>
<thead>
<tr>
<th>Authentication Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows authentication</td>
<td>Users are authenticated using their Windows account names and passwords. Login accounts can be imported from Active Directory (LDAP).</td>
</tr>
<tr>
<td>Federated authentication</td>
<td>Users are authenticated against an external Identity Provider (IdP), such as Azure Active Directory. See Using Federated Authentication with M-Files for more information.</td>
</tr>
<tr>
<td>M-Files authentication</td>
<td>Users are authenticated with usernames and passwords specified within M-Files.</td>
</tr>
</tbody>
</table>

M-Files supports using pre-shared keys for an additional level of security. For more information, see Securing Access to M-Files Vaults with a Pre-Shared Key.

Database connections

M-Files Server can be integrated with existing databases, such as CRM and ERP databases. All databases with an OLE DB or ODBC driver are supported (includes SQL Server, Access, Oracle, and MySQL).

Integrations with 3rd party applications

Numerous 3rd party applications can be integrated to M-Files. See www.m-files.com/integrations and https://catalog.m-files.com for examples.

Application programming interface (API)

M-Files includes an ActiveX/COM API. Supported languages include VB.NET, C#, Visual Basic, VBScript, and C++. Additionally, M-Files includes the M-Files Web Service API that allows programmatic access to M-Files through a REST-like interface.

M-Files API is included within the installation of the M-Files software. The API documentation is available as an online version and as a Microsoft HTML Help file, which you can download at https://www.m-files.com/api.

M-Files Web Service API is documented at https://www.m-files.com/mfws.

M-Files UI Extensibility Framework allows external add-ins (M-Files Applications) to be used for personalizing the behavior of M-Files Desktop. With these applications, the M-Files experience can be modified to better match specific business areas and needs. For more information, please refer to the UI Extensibility Framework documentation.

Backups and maintenance

M-Files automatically optimizes the vault database once a week. No other regular database maintenance is needed.

M-Files supports scheduled full and differential backups. When using Firebird as the database engine, document vaults are backed up using the M-Files Admin tool.
When using Microsoft SQL Server as the database engine, document vaults are backed up using the management tools of Microsoft SQL Server and file system level backup tools. Any backup system compatible with Microsoft SQL Server can be used.

**Technical assistance**

For further technical inquiries, please contact support@m-files.com.

**Installing the Software**

M-Files can be installed as a single installation or distributed and installed on several computers at once. These instructions are for executing a single M-Files installation. For advanced installation options, such as customizing the installation package to automatically configure client or server connections, disabling automatic checking for software updates or using Active Directory group policies in distributing M-Files, refer to the document *M-Files Setup: Advanced User's Guide*.

**Tip:** While the M-Files installation is in progress, you may want to see information about M-Files and Virus Scanning.

- Both the server computer and client workstations must have Microsoft .NET Framework 4.0 or later installed in order for all M-Files functions to work properly. M-Files Compliance Kit installations require Microsoft .NET Framework 4.5 or later to be installed on both the server and client computers. Intelligent Metadata Layer features require Microsoft .NET Framework 4.5 or later to be installed on the server computer.
- You have received the M-Files setup file from your system administrator, or you have downloaded it via the M-Files download page.

For a single M-Files installation, follow these steps:

1. Quit all other applications running on your computer and double-click the M-Files setup file.
   - The welcome screen of the installation wizard appears.
2. Click **Next**.
3. Read and accept the end-user license agreement to be able to continue.
4. Click **Next**.
5. Select the software components to be installed.
   - You can install M-Files for evaluation or perform a normal installation.

   If you are not an M-Files system administrator in your organization, you only need to install M-Files Desktop. In this case, M-Files Server has been installed on your organization's local area network, and your M-Files system administrator has the M-Files Server Tools (M-Files Admin) installed. After the normal installation, you can connect to the document vault(s) on your M-Files server via M-Files Desktop Settings.

   The evaluation installation includes all the software components as well as a sample vault, which you can start exploring immediately after installation.
6. Continue the installation by clicking **Next**.
7. Specify the installation location and click **Next**.
8. If you do not want to change anything, click **Next** to start the installation.
9. Select whether or not you would like to see the Guided Tour and click Finish to complete the installation process.

The M-Files software has now been installed on your computer. If you have performed an evaluation installation, you can continue familiarizing yourself with the software by opening the Guided Tour via the Windows Programs menu.

In this chapter

• Example: Single-Instance Installation of M-Files

Example: Single-Instance Installation of M-Files

This is a short description of a basic M-Files installation to a single computer that, in this case, serves as both the server machine and the client. The purpose of this example is to provide the main steps of setting up the elementary components of an M-Files system.

Complete the following steps:

1. Install the M-Files software as instructed in Installing the Software.

2. Create a document vault as instructed in Creating a New Document Vault.

   Note, however, that with the evaluation installation option, two vaults are automatically deployed. Sample Vault contains a reference metadata structure and views for some common information management processes as well as sample files to help you to easily evaluate the search. My Vault contains the same metadata structure and views as Sample Vault but does not contain the sample content. You can use the structure of My Vault as a foundation for your purposes instead of creating a new vault from scratch. You can also restore the sample structure from the M-Files Server installation folder (C:\Program Files\M-Files\<version>\Server\sample\My Vault.mfb by default).

3. Create a new login account to the server as instructed in Creating a Login Account.

4. Create a new user (or multiple users) to your vault as instructed in Creating a User.

   At this point, the following tasks should be completed:
   • M-Files Server, M-Files Admin, and M-Files Desktop have been installed.
   • There is a document vault on the server – either one of the vaults that come with the evaluation installation or one that you have created from scratch.
   • There is at least one login account on the server.
   • There is at least one user in your vault.

5. Open M-Files Desktop Settings and create a connection to the vault as instructed in Adding a Vault Connection.

You should now have a vault on the M-Files server with a user whose credentials you can use to log in to the vault and start browsing the content with M-Files Desktop.

Updating M-Files

Automatic updates keep the M-Files software up to date. If a newer version of M-Files becomes available, it is downloaded to client computers and installed automatically. Users can delay automatic updates for a limited time if they are working on something important while an automatic update becomes available.
Note: Users do not need local administrative rights on their computers for the automatic updates to run.

Figure 75: In M-Files Desktop, vault users are notified when a new M-Files version becomes available. By clicking Options, users can schedule or initiate the M-Files software update.

Figure 76: Vault users can choose between updating M-Files right away or at a later time.

The feature obtains the latest update information from the update server using HTTPS on TCP port 443. This means that normally you do not need to change any firewall settings.

For information on updating M-Files manually, see Manually Updating M-Files.

Settings for automatic updates

You can open the settings for automatic updates by choosing Automatic Updates from the Microsoft Windows start menu, and then by opening the Settings tab in the Automatic Updates window.

Note: The M-Files system administrator may preset these settings, in which case they cannot be changed via the Settings tab.
If you wish to disable automatic updates, uncheck the **Download updates automatically** check box. You can always check for updates manually by opening the **Installation** tab and clicking the **Check Now** button. This way an update is downloaded to your computer if there is one available. For a high-level description on how M-Files downloads the update packages when the **Download updates automatically** option is enabled, see **Update Download Process**.

If you wish to disable the automatic installation of updates, uncheck the **Install updates automatically** check box. You can always start the installation of available updates manually by opening the **Installation** tab and clicking the **Install** button. If the **Install** button is disabled, it means that there are no updates available for installation.

In the **Installation schedule** section, you may select the preferred days and time of installing M-Files updates. It is recommended that you select a date and time that is outside of working hours so that installing updates does not interrupt M-Files operations in your organization. Note that the computer must be running and not in sleep or hibernate mode when the update is scheduled to be installed. If the computer is not running when the scheduled installation time occurs, the update is attempted to be installed or scheduled the next time the computer is started.

**Note:** It is strongly recommended that you keep automatic updates enabled to ensure that your M-Files software is always up to date. For more information on scheduling update installations and disabling automatic updates, see **Configuring Automatic Updates via Registry Settings**.
In this chapter

- Configuring Automatic Updates via Registry Settings
- Update Download Process

Configuring Automatic Updates via Registry Settings

In addition to using the Automatic Updates window, you can configure automatic updates on both the server computer and client computers via Microsoft Windows registry settings. For more information on automatic updates, see Updating M-Files.

Tip: In Microsoft Windows, you can use Group Policy Objects for distributing registry settings to multiple computers.

Disabling or enabling automatic updates

You can disable or enable the automatic updates by adding or editing the following registry setting on the target computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\Common\Updates</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>Enabled</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>Description</td>
<td>If the value is set to 0, automatic updates disabled on the target computer, including manual update checks by using the Automatic Updates window. You can update the software by downloading and running the installation package by hand.</td>
</tr>
<tr>
<td>Default value</td>
<td>1</td>
</tr>
<tr>
<td>Valid values</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>

Disabling or enabling automatic update downloads

You can disable or enable the automatic downloading of updates by adding or editing the following registry setting on the target computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Common\MFAUClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>EnableUpdates</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>Description</td>
<td>If the value is set to 0, M-Files no longer downloads updates automatically, but you can run the update check manually via the Installation tab in the Automatic Updates window.</td>
</tr>
<tr>
<td>Default value</td>
<td>1</td>
</tr>
<tr>
<td>Valid values</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
</tr>
</tbody>
</table>
Disabling or enabling automatic update installations

You can disable or enable the automatic installation of updates by adding or editing the following registry setting on the target computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Common\MFAUClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>AllowToUseAutoInstallationFeature</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>Description</td>
<td>If the value is set to 0, installing automatic updates is disabled and only the Download updates automatically option is available on the Settings tab in the Automatic Updates window. You can still install updates via the Installation tab in the Automatic Updates window.</td>
</tr>
<tr>
<td>Default value</td>
<td>1 (M-Files Online)</td>
</tr>
<tr>
<td></td>
<td>0 (M-Files 2018)</td>
</tr>
<tr>
<td>Valid values</td>
<td>1 Installing automatic updates is enabled.</td>
</tr>
<tr>
<td></td>
<td>0 Installing automatic updates is disabled.</td>
</tr>
</tbody>
</table>

Disabling or enabling automatic update options in the user interface

You can disable the automatic update options in the Automatic Updates window on the Settings tab by adding or editing the following registry setting on the target computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Common\MFAUClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>CanConfigureAutoInstallingViaUi</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>Description</td>
<td>If the value is set to 0, the settings shown on the Settings tab in the Automatic Updates window cannot be changed.</td>
</tr>
<tr>
<td>Default value</td>
<td>1 (Windows Server)</td>
</tr>
<tr>
<td></td>
<td>0 (other operating systems)</td>
</tr>
<tr>
<td>Valid values</td>
<td>1 Settings shown on the Settings tab in the Automatic Updates window can be changed.</td>
</tr>
<tr>
<td></td>
<td>0 Settings shown on the Settings tab in the Automatic Updates window cannot be changed.</td>
</tr>
</tbody>
</table>

Controlling the installation deadline

If need be, you can adjust the installation deadline and the amount of time by which users can delay the installation. Add the following registry settings on the target computer to adjust the installation deadline:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Common\MFAUClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>PostponeDurationInHours</td>
</tr>
</tbody>
</table>
### Defining the installation schedule

You may select the preferred days and time of installing M-Files updates. It is recommended that you select a date and time that is outside working hours so that installing updates does not interrupt daily M-Files tasks in the organization.

Note that the computer must be running and not in sleep or hibernate mode when the update is scheduled to be installed. If the computer is not running when the scheduled installation time occurs, the update is attempted to be installed or scheduled the next time the computer is started.

Add the following registry settings on the target computer to define an installation schedule:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files*\Common\MFAUClient</td>
<td>REG_SZ</td>
<td>One or more days when automatic updates are attempted to be installed. Separate multiple values with a semicolon.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Default value</th>
<th>Valid values</th>
</tr>
</thead>
<tbody>
<tr>
<td>mon; tue; wed; thu; fri; sat; sun</td>
<td>Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key</th>
<th>Value type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files*\Common\MFAUClient</td>
<td>REG_SZ</td>
<td>The time of day in 24-hour format when automatic updates are attempted to be installed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Default value</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>02:00</td>
<td>By default, automatic updates are attempted to be installed at 02:00.</td>
</tr>
</tbody>
</table>
Defining the maximum random added delay before the update

You can add random delay to the beginning of the automatic updates by adding the following registry setting on the target computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Common \MFAUClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Valid values</td>
<td>Any valid time of day.</td>
</tr>
</tbody>
</table>

**Value name**: AdditionalMaxRandomSleepingPeriod

**Value type**: REG_DWORD

**Description**: The maximum value for the random delay (in other words sleeping) added to the main sleeping period (default: one hour) at the beginning of the automatic updates poll-download-install cycle. The randomness establishes a crude form of load balancing in a network. When defining the value, take into consideration that too large values may impact polling frequency and that also several other registry settings affect the sleeping period and installation. Their combined effect can result in unwanted consequences, such as preventing a user from postponing the installation during office hours or delaying the download to occur only after a weekly installation day. With the default settings, the poll-download-install cycle restarts every 1-2 hours with a mean value of 1.5 hours.

**Default value**: 3600

The default maximum added delay value is one hour (3600 seconds).

**Valid values**: 0

No random added delay.

<1-86400>

Maximum random added delay in seconds.

Update Download Process

When the **Download updates automatically** option is enabled, M-Files automatically requests for an update package from the default update server (**findupdates.m-files.com**) every hour. If a new version is available, the automatic update server sends the new version number and an HTTPS URL for the update package to M-Files.

**Note**: Update packages for new versions are made available gradually after an update is released.

After receiving the download URL, M-Files checks that it starts with **https**, and if it does, downloads the digitally signed update package with Background Intelligent Transfer Service (**BITS**). M-Files then proceeds to verify that the update package has been created and signed by M-Files and that it has not been tampered with, therefore making sure that it can be safely installed, and finally makes the new version available for installation.

![Figure 78: The download and installation process of an M-Files update.](image)
Manually Updating M-Files

Note: By default, M-Files is automatically updated and it does need to be manually updated. For more information on automatic updates, see Updating M-Files.

The M-Files installer automatically detects the previous versions of the software and can migrate the settings from the old to the new version. Hence, do not uninstall any previous versions of M-Files before updating.

Perform the following tasks to update M-Files to a newer version:

1. Execute the M-Files installer for the new version.
2. Select the Simple upgrade option.

With the Simple upgrade option selected, the setup automatically installs the same components that were installed in the earlier M-Files version. The setup installs the new version and transfers the M-Files settings along with all local data from the earlier version to the new version. Finally, the setup uninstalls the earlier version.

Important remarks

- Speed and performance improvements in M-Files 2015.2 and newer can cause some empty virtual folders to appear in views in which empty folders are set to be hidden. Because of this, we recommend reading the document Security Aspects to Consider When Upgrading to M-Files 2015.2 before upgrading your system.
- If you are upgrading from a version that is older than M-Files 2015, note that the new installation includes significant improvements to the vault database structure. This means that — especially with large document vaults — the upgrade process might take substantially longer than usual. It is also recommended to ensure that the server computer has at least twice the amount of free space required by the metadata database file (the FDB file for Firebird and MDF file for Microsoft SQL Server databases). The database structure is upgraded automatically by the M-Files installer.
- Property group and dynamic property configuration for M-Files 10.2 and M-Files 2015 has been replaced with more versatile configuration options in M-Files 2015.1 and later. See the document Configuring the Metadata Card (M-Files 2018) for more details.
- If you are upgrading M-Files Server from M-Files 2015.2 or earlier to M-Files 2015.3 or later and both of the following are true:
  - You have a document vault that contains documents either in the Chinese, Japanese, or Korean language.
  - The selected primary or secondary language for the full-text search features of the vault is some other than Chinese, Japanese, or Korean. For more information, see Creating a New Document Vault.

  In such a case, you should rebuild the full-text search index of the vault after the upgrade is complete so that the documents in the aforementioned languages are still retrievable by searching their contents. For instructions, see Vault Maintenance.
- In M-Files 2018 and later, the task area is collapsed by default along the left side of the user interface and it can be expanded by the user. In some cases it may be a good idea to have the task area visible by default. The initial state of the task area can be configured with a registry setting that should be configured before upgrading to M-Files 2018 and later. For more information, see Setting the initial state of the task area.
Installation preconditions

- All M-Files Server instances in a replication setup must have the same four-digit build number (for instance 11.2.4320.32 and 11.2.4320.33).
- M-Files Admin and M-Files Server must have the same four-digit build number (for instance 11.2.4320.32 and 11.2.4320.33).

You can use the following table to verify the compatibility between M-Files Server and M-Files Desktop:

<table>
<thead>
<tr>
<th>M-Files Server (M-Files 2015 and 2015.x)</th>
<th>M-Files Desktop (M-Files 2015 and 2015.x)</th>
<th>M-Files Desktop (M-Files 2018)</th>
<th>M-Files Desktop (M-Files Online)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compatible</td>
<td>Compatible</td>
<td>Compatible</td>
<td>Not compatible</td>
</tr>
<tr>
<td>M-Files Server (M-Files 2018)</td>
<td>Compatible</td>
<td>Compatible</td>
<td>Compatible</td>
</tr>
<tr>
<td>M-Files Server (M-Files Online)</td>
<td>Not compatible</td>
<td>Compatible</td>
<td>Compatible</td>
</tr>
</tbody>
</table>

To verify compatibility with M-Files API and replication, see M-Files version compatibility regarding API and Replication.

Note: In some cases, you may need to set the Windows services for M-Files Server and M-Files Server Auxiliary Services to log on as Local System account and to disable your antivirus software for the duration of the upgrade process.

Note: As an exception to the compatibility chart, M-Files Desktop 2015 cannot connect to M-Files Server 2015.3 or later if vault-specific login accounts are in use.

Installation order

You can choose to either first upgrade the client computers and then the server computer, or first the server computer and then the client computers. If you do not upgrade to the immediately subsequent M-Files version, make sure that the new version is compatible with the old version to avoid unnecessary interruptions (see the compatibility chart above). In such a case it is also recommended that you first upgrade the server and then the client computers.

Note: Some of the new properties of the higher M-Files version may not be available until both M-Files Desktop and M-Files Server have been upgraded to the new version.

Upgrading offline vaults

As the internal database structure of the document vault changes during a software upgrade, the document vaults must be upgraded as well. All the vault in the online state are upgraded automatically during a software upgrade, but if any of the vaults are in the offline state, they need to be upgraded manually. To do this, open the vault context menu in M-Files Admin and select Upgrade.

Preparing for the server upgrade

Before installing the upgrade on M-Files Server, ensure that the following conditions are met:

- Make sure that your server fulfills the hardware and software requirements of the new version (see System Requirements).
• The administrator should also ensure that recent backups of the document vaults are available and usable. The backups may be useful should an unexpected fault situation occur during the server upgrade.
• The administrator should also take backups of the master database.
• The backups should preferably be stored on a separate disk drive.

In the event of a fault situation, contact M-Files customer support immediately. Do not attempt to rectify the fault yourself, as solving the fault situation is usually much easier if no additional actions have been performed.

Service releases

Service releases are smaller M-Files software upgrades that share the same main version number (for example "11.0" for M-Files 2015), followed by the four-digit version ID for the service release. For instance, versions 11.0.4300.47 and 11.0.4300.58 are service releases for M-Files 2015 (11.0.4300.27). Usually, the service releases do not contain any new properties, but rather are released if faults requiring repair are detected in the software, or if compatibility with higher versions of other software requires changes to M-Files.

Service release versions are fully compatible between each other and can be installed in whichever order. In other words, whether the service release is installed first on the workstations and then on the server, or vice versa, makes no difference.

Upgrading the M-Files OCR module for versions M-Files 2015 and later

M-Files Server versions for M-Files 2015 and later do not support the OCR module of the M-Files versions prior to M-Files 2015, so you might need to upgrade this module after upgrading the server software. See Instructions for enabling the M-Files OCR Module for detailed instructions.

Centralized deployment via Windows Group Policy

You can use the Windows Group Policy feature to automatically distribute M-Files to client computers. Alternatively, you may use any other centralized deployment mechanism that you are familiar with. You can also customize the behavior of the M-Files setup program. For further information on these options, refer to M-Files Setup: Advanced User's Guide.

Troubleshooting

Issue: The setup process fails to start due to insufficient service privileges.

Possible solution: In some cases, you may need to set the Windows services for M-Files Server and M-Files Server Auxiliary Services to log on as Local System account and to disable your antivirus software for the duration of the upgrade process.

To change the log on settings of a service:

1. Press Win+R.
2. When the Run dialog opens, type in services.msc and click OK.
3. Locate the service in the list.
4. Right-click the service and select Properties from the context menu.
5. Open the Log On tab.
3.1.3. M-Files Admin

M-Files Admin is a tool that is used for administrating and maintaining M-Files document vaults and M-Files Server connections.

M-Files Server is the backbone of the M-Files system. It saves all objects (such as documents, employees and customers), controls access rights, registers object modifications (version history), and allows the system administrator to configure connections also to other systems (such as a customer registry). Basically, M-Files Server saves and controls all information related to the M-Files system.

Technically, M-Files Server, like M-Files Desktop, is a service. This means that M-Files Server starts automatically when the server computer starts. The M-Files Server software is run even if there are no users logged in on the computer running the M-Files Server software.

![Figure 79: The M-Files Admin main window displaying the different levels inside a document vault.](image)

**M-Files Admin Terminology**

- **Login account**: The M-Files Server login account that is used to log in to M-Files Server and on the basis of which a new user can be added to the document vault.
Metadata

In M-Files Admin, you can change the structures of metadata (for example, value lists, property definitions, document classes, and document class groups) and create new metadata, whereas you just specify values for these metadata items in the day-to-day use of M-Files. Compare with M-Files Terminology.

Object type

Besides documents, you can also manage other objects, such as customers and projects. These data set definitions are called object types. Document is one object type.

Property Definition

Property definitions are used to determine properties associated with document classes. A property definition is used to define the property name (which should be descriptive) and data type, which determines the type of the data entered (in relation to the property).

Role

Roles can be used to provide users with permissions that mainly affect M-Files Server Administration. The permissions gained through roles always take precedence over document and object permissions. User who has all permissions to a document vault can access any object, even if the access of a particular user to a document has been denied by means of object-specific permissions.

System administrator

A system administrator is a user who has been assigned the role of system administrator. A system administrator automatically receives all permissions to every document vault, that is, he can perform all possible functions in M-Files. A system administrator can add the role of system administrator to any other user. However, a system administrator cannot log in to a document vault if he has not been added as a user of that particular vault.

User

The M-Files user, who, at the server level, can be either a regular user or a system administrator. Users can be added to the desired document vaults, and a user's document vault administration permissions depend on the document-vault-level roles assigned to the user. On the document vault level, roles mainly determine the user's permissions to document vault administration. A regular user's basic permissions are also assigned by means of roles.

Users can be grouped into external and internal users. For example, you can define your customers as external users. External users can only see and access documents and objects specifically marked for them. By default, they do not have permissions to view any documents.
User group

You can create *user groups* on the M-Files server to which individual users can be added. Each user automatically belongs to the user group *All internal and external users*. In addition, each internal user automatically belongs to user group *All internal users*. User groups are specified on the document vault level. User groups can be used to define the permissions to an object, that is, to specify the users who may access it.

Value List

A value list is a list that contains various values, such as the names of all customers. The same value list can be utilized in several different properties.

Vault

The *document vault* is managed with M-Files Admin. This is where you can add users to the document vault, change the metadata structures of objects, and edit views visible to all users. See also *M-Files Terminology*.

Workflow

Workflows define how the organization manages a process. An example of a workflow is *invoice circulation*. The workflow has related states and definitions regarding the task performer, permissions, and state transitions.

### 3.1.4. Server Connections

This section offers an information about various operations and settings related to M-Files Server.

*Note:* It is recommended to use Universal Naming Convention (UNC) paths (such as `\ServerName\`) when you are defining a connection to a network drive, as the letter assigned to the drive may not be visible to the M-Files server. In addition, Windows drive letter assignments are frequently user-specific. A network drive may, for example, contain an external database for a value list.

**In this chapter**

- Adding a New Server Connection
- Managing Server Licenses
- Login Accounts
- Scheduled Jobs
- Server Activity Monitor
- Backing Up the Master Database

**Adding a New Server Connection**

Start setting up a new server connection in M-Files Admin by selecting *Connections to M-Files Servers* in the left-side tree view and selecting *Action > New Connection to M-Files Server*... from the menu bar.

*Note:* If the connecting computer is using Windows Server 2012 and the server computer has been set to only accept Transport Layer Security (TLS) 1.2 connections, TLS 1.2 must be enabled on the client computers by following the instructions in *Enabling TLS 1.2 on Windows Server 2012 Computers*. 
**Name**

First assign a name to the server connection.

**Connection / Server Name**

Enter the network name or IP address of the server on which M-Files Server has been installed and that contains the document vault.

**Connection / Port Number**

The server was specified in the previous field, and in this field you specify the port to connect to on the server. Enter the server port number to connect to. M-Files uses port 2266 by default.
**Connection/Protocol**

Specify the protocol to be used for the network connection. The following protocols are available:

- TCP/IP
- SPX
- Local Procedure Call (LPC)
- HTTPS

**Encrypted connection**

Activate this option to enable RPC encryption between M-Files Admin and M-Files Server.

The option is available for the TCP/IP protocol only. If the protocol is HTTPS, the connection is always encrypted at the HTTPS protocol level. For connections from outside the organization's internal network, HTTPS or VPN should still be used, as RPC communication to the default TCP port, 2266, is often blocked by firewalls.

**(Note:** For RPC encryption to work, the user as well as the computer must be able to authenticate to the server computer. In practice, this requires that the client computer belongs to the Windows domain and that the user is a domain user.

For more information on encrypted connections and for instructions on how to configure the server to require encrypted connections, refer to Protecting Data in Transit with Encryption in M-Files.

**Connection / Test Connection**

You can test the operation of the server connection with the **Test Connection** button.

**Authentication**

Specify the method M-Files Server is to use for authenticating the user. The authentication options are *Current Windows user*, *Specific Windows user* and *M-Files user*.

**In this chapter**

- Connecting to and Disconnecting from the Server

**Connecting to and Disconnecting from the Server**

You can use the **Disconnect** function to disconnect the network connection to the server. You can reconnect the connection later without having to specify the server registration properties again.

To disconnect:

1. Open M-Files Admin.
2. Select the server connection of your choice.
3. Open the **Action** menu.
4. Select **Disconnect**.

To reconnect:

1. Open M-Files Admin.
2. Select the server connection of your choice.
3. Open the **Action** menu.
4. Select **Connect**.

**Managing Server Licenses**

License management settings in M-Files Admin are accessed by right-clicking the M-Files server in the left-side tree view and selecting **License Management** from the context menu.

![M-Files license management window](image)

*Figure 81: M-Files license management window.*
License status

The status of the license is shown here. Users receive a notification before the license expires.

Serial number

This is your M-Files serial number.

Licensed to

The license holder is displayed here. This confirms that your organization is the registered user of the software.

Subscription expires

Subscription expiry date. During the subscription period, you are entitled to all M-Files version updates free of charge. You also need to have an active M-Files subscription for receiving customer support free of charge.

Number of named user licenses / In use

The number of licenses installed is displayed for each license type separately. Below that, you can see the number of licenses in use. Named user licenses are assigned to individual login accounts. For more information about license types, refer to License type.

Number of concurrent user licenses / In use

The number of concurrent user licenses in use is determined by the number of currently logged in users using this license type. A license is reserved when a user using this license type logs in to M-Files. When the user logs out of M-Files, the license becomes available. For more information about license types, refer to License type.

Number of read-only licenses / In use

A read-only license allows the user only to read content. It does not allow the user to create or modify documents in the document vault. For more information about license types, refer to License type.

Additional modules

Here you can see the additional modules to which you have access, such as the OCR module.

Refresh

The Refresh button brings the “in use” license data up to date.

Install License

When the evaluation period expires, you need a license to be able to use M-Files. Install your license by clicking the Install License... button. Enter the serial number and license code you have obtained, and then click OK.
Login Accounts

The vault has users who must first authenticate themselves to M-Files Server. Before creating the users, you must create login accounts on M-Files Server. These login accounts are added to vaults as users. The same server login can be added to several vaults.

### Domain accounts

<table>
<thead>
<tr>
<th>Domain</th>
<th>Login accounts</th>
<th>Vault users</th>
</tr>
</thead>
<tbody>
<tr>
<td>john.smith</td>
<td>john.smith</td>
<td>John Smith</td>
</tr>
<tr>
<td>mike.taylor</td>
<td>mike.taylor</td>
<td>Tina Smith</td>
</tr>
<tr>
<td>tina.smith</td>
<td>tina.smith</td>
<td>Vault #2</td>
</tr>
<tr>
<td>tommy.hart</td>
<td>tommy.hart</td>
<td>Tina Smith</td>
</tr>
<tr>
<td>alex.kramer</td>
<td>alex.kramer</td>
<td>Alex Kramer</td>
</tr>
<tr>
<td>bill.richards</td>
<td>bill.richards</td>
<td>Vault #3</td>
</tr>
<tr>
<td>samuel.lewis</td>
<td>samuel.lewis</td>
<td>Alex Kramer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Samuel Lewis</td>
</tr>
</tbody>
</table>

Figure 82: Login accounts are used for authenticating M-Files users to M-Files Server. They can be imported from a domain to M-Files Server. Login accounts are associated with vault-specific users.

### In this chapter

- Login Account Properties
- Creating a Login Account
- Importing Login Accounts
- Changing the Login Account of a User
- Performing Actions on Multiple Login Accounts
- Viewing Logged-In Users
Login Account Properties

You can start creating a new login account in M-Files Admin by right-clicking Login Accounts in the left-side tree view and selecting New Login Account... from the context menu. For a step-by-step guide, see Creating a Login Account.

Tip: You can also import Windows login accounts to M-Files. For more information, refer to Importing Login Accounts.
Windows authentication

Windows authentication can be used for authentication on M-Files Server, in which case the user logs in to the document vault with the same login information used to log in to Windows or the organization's domain.
Using the domain logins is the quickest and easiest authentication method. This means that new passwords and logins are not needed, which makes this a rather user-friendly method. For more information, refer to table Differences between the various user authentication methods.

Note: If your organization is using federated identity management, refer to Using Federated Authentication with M-Files.

M-Files authentication

The M-Files authentication method allows the user to log in to M-Files only. If the organization does not have a Windows domain or the user is not to have access to it, it is a good idea to use M-Files authentication for the document vault.

Personal information

Enter an e-mail address and a full name for the login account. This information is used for sending notifications. For more information about notifications, refer to Editing Notification Settings in M-Files Admin. If the authentication method used is Windows authentication, you can retrieve the personal information from the domain by clicking Update Information from Domain.

License type

Select a license type for the login account. The different license types are listed below.

Named user license

Named user licenses are assigned to individual login accounts. This license allows the login account to use M-Files any time, independent of other users.

Concurrent user license

When a login account entitled to a concurrent user license logs in, one license of this type is taken up. When the login account logs out, the license becomes available for use by other login accounts that use this same license type.

Read-only license

Read-only licenses are assigned to individual login accounts. This license allows the login account to use M-Files at any time, independent of other users. The license is limited in the sense that not all M-Files features are available for use: the user is only able to read but not to create or modify documents.

External Connector license

External Connector licenses enable 3rd party systems to anonymously read M-Files database. The license type is needed for example when M-Files data is published programmatically in an intranet or extranet environment to an unrestricted number of users.

Account is disabled

This function provides an easy way to specify whether the user is allowed to log in to the server or not. This function is useful if you do not want to remove the login account altogether, but to disable it for the time being.
Server roles: System administrator

This role entitles the user to make any changes on the server level. These include changing the server logins and creating and deleting document vaults. In other words, a system administrator can perform any operation on a document vault.

See the table below for a comparison between the permissions of a system administrator and a user with the Full control of vault administrative rights. For a description of the administrator permissions in the Advanced Vault Settings section of the M-Files Admin configurations editor, refer to Configuring Advanced Vault Settings.

<table>
<thead>
<tr>
<th>Operation</th>
<th>System administrator</th>
<th>Vault administrator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Attach a vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Restore a vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Detach a vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Back up a vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Copy a vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Destroy a vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Optimize the database</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Back up the master database</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Restore the master database</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Take a vault offline</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Rebuild the full-text search index</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Reset thumbnail images in a vault</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Verify and repair a vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Migrate to Microsoft SQL Server</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Create a cached replicate vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Create or import a login account</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Create a scheduled job</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Change M-Files Server notification settings</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Manage M-Files licenses</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Configure web and mobile access</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Shut down M-Files Server</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Log in to any vault</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Create and import users</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Import user groups</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Create user groups</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>See and read all vault content (including deleted objects)</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Operation</td>
<td>System administrator</td>
<td>Vault administrator</td>
</tr>
<tr>
<td>--------------------------------------------------------------------------</td>
<td>----------------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>See and undelete deleted objects</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Destroy objects</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Force undo checkout</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Change permissions for all objects</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Change metadata structure</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Manage workflows</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Manage login accounts</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Manage common views and notification rules</td>
<td>Allowed</td>
<td>Allowed</td>
</tr>
<tr>
<td>Manage vault applications</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Edit scripts (for example related to event handlers, workflow states,</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>and automatic property values)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manage connections to external sources</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Disable or enable vault event logging</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
<tr>
<td>See and manage scheduled jobs</td>
<td>Allowed</td>
<td>Not allowed</td>
</tr>
</tbody>
</table>

**Creating a Login Account**

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. Click **Login Accounts** in the left-side tree view.
4. Click **New Login Account...** on the task area.
   
   ✓ The New Login Account dialog is opened.
5. Enter a username.
6. Select an authentication method by clicking the appropriate radio button and enter authentication details in the fields below the selected authentication method.
7. Enter an email address and a full name in the personal information fields.
   
   ⚠ If you are using Windows authentication, you can click **Update Information from Domain** to retrieve personal information from the domain's directory service.
8. Select a license from the **License type** drop-down menu to set an appropriate license for the login account.
   
   ⚠ For information about the license types, see **License type**.
9. Optional: Check the **Login account is disabled** check box if you want to disable the login account for the time being.
10. Optional: Check the **System administrator** check box if you want to assign a system administrator role for the login account. This role entitles the user to make any changes on the server level, including *changing the server logins and creating and deleting document vaults.*

11. Click **OK** once you are done.

You should now have a new login account and it should appear in the **Login Accounts** list when you highlight **Login Accounts** in the left-side tree view in M-Files Admin.

### Importing Login Accounts

Do the following steps to import login accounts to M-Files Server:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, select **Login Accounts**.

4. Click **Import Login Accounts...** on the task area.

   ✓ The **Import Login Accounts** dialog is opened.

5. Select either:

   a. **Choose from list** to select the user group using drop-down menus. In **Domain**, select the desired domain. In **Organizational unit**, select the desired organizational unit within that domain. Finally, in **User group**, select the user group that you want to import.

   or

   b. **Enter Name**. This option is especially useful if you have so many user groups that searching the correct one from list is hard. Enter the name of the user group in the format `<domain>\<user group>` and click **Show**.

   ✓ The list area in the dialog is populated with the members of the selected user group.

6. Optional: Check the **Include users from nested groups** check box to be able to import login accounts from nested groups within the selected user group.

   ✓ The list area in the dialog is populated with the members of the selected user group and the members of any user group nested within the selected user group.

7. Select the login account or login accounts by clicking a login account on the list.

   You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the ⇧ Shift key to select adjacent items on the list.

8. Using the **License type for new login accounts** drop-down menu, select the license type for the login accounts to be imported.

   ✓ For more information about license types, see **License type**.

9. Click **OK** to import the selected login accounts.

The selected login accounts are imported to M-Files Server and should now appear in the **Login Accounts** list when you click **Login Accounts** in the left-side tree view in M-Files Admin.
Changing the Login Account of a User

Sometimes it may be necessary to change the login account for a user. The user’s login account may have to be changed when, for example, the user needs a new login account due to his or her last name being changed or when login accounts are moved from one domain to another.

When a user login account must be changed, it is important to preserve the vault user associated with the original login account and to associate the same user with the new login account to preserve the user history and the user’s personal settings in the vault.

Note: It is important to distinguish between login accounts and users:

- Login accounts are server-level (or in some cases vault-level) accounts that are used for authenticating users to M-Files Server. A login account can be associated with multiple users, but only one user per vault.
- Users are vault-level objects that store user-specific settings and user history and that have permissions to perform specific operations in a vault. A user is linked to one and only one login account.

Do the following steps to correctly change a login account for a user after new login accounts have been created in M-Files:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Users.
   - The Users list is opened in the right-side pane.
5. Right-click the user whose login account you need to change and select Properties from the context menu.
   - If new login accounts are synchronized from an Active Directory source, M-Files automatically creates new users for the new login accounts. To associate the new login account with the correct existing user, you must first delete the new, automatically created user.
   - The User Properties dialog is opened.
6. Use the Login account drop-down menu to select a new login account for the user.
7. Click OK to close the User Properties dialog and to save your changes.

The new login account is now correctly associated with the existing user. Now when the user logs in using the new credentials, their previous user history and personal settings in the vault are available.

Performing Actions on Multiple Login Accounts

You can perform certain actions on many login accounts at the same time. This is useful if you have a lot of login accounts in M-Files and you need to, for example, change the license type of multiple login accounts. When you have selected multiple login accounts, the actions available are Enable, Disable, Delete, and Change License Type.

Do the following steps to perform actions on many login accounts at the same time:
1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. Click **Login Accounts** in the left-side tree view.

4. To select many login accounts, perform either of the following actions:
   a. If you want to select a range of login accounts, click the first login account, hold down the ⌧ Shift key and select the last login account in the range.

   or

   b. If you want to select multiple individual login accounts, hold down the Ctrl key and select the desired login accounts.

5. Click the desired option on the task area.

**Viewing Logged-In Users**

You can server-specifically view the currently logged-in users and their license types.

Do the following steps to view the users who are currently logged in to the server:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. Click **Login Accounts** in the left-side tree view.

4. Click **Show Logged-in Users** on the task area.

   ✔️

The **Logged-in Users** dialog is opened, showing the users who are currently logged in. You can click **Refresh** to update the view.

If necessary, you can also force certain users to log out by selecting the user and clicking **Force Logout**. This might be very useful, for instance, when concurrent licenses are used: The operation enables you to force the logout of idle users to release the license to be used by someone who actually needs it at the moment. Forcing active users to log out, however, normally does not affect them at all. Active users immediately get a license if available licenses exist.

**Note:** Displaying the logged-in users and forcing their logout requires you to have administrator rights.

**Scheduled Jobs**

Backups can be automated with **Scheduled Jobs**, which you can find at the bottom of the left-side tree structure in M-Files Admin. Backups can be restored later on, if need be (see **Restoring a Document Vault** for instructions). In addition to backups, scheduled jobs scheduled tasks can be used for other tasks, such as optimization of the vault database.

**In this chapter**

- Creating a New Scheduled Job
- Scheduled Backup Jobs
Creating a New Scheduled Job

Note: If you are looking for information on scheduled export and import jobs, see Scheduled Export and Import.

Complete the following steps to define a new scheduled backup job:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, click Scheduled Jobs.
4. Click New Scheduled Backup Job... in the task area.

The Scheduled Job Properties dialog is opened.

5. In the Description field, enter a description for the new scheduled job.
6. To define a schedule for this task, complete the following steps:
   a) Click the Schedule... button.

   ![Define Schedule dialog](image)

   b) Define the appropriate schedule using the available options.

   - The schedule option **When idle** is not supported in M-Files.

   c) Click OK to close the Define Schedule dialog.

7. Click Backup to open the Backup tab.

   ![Backup tab](image)

   - The Backup tab is opened.
8. Select either:

a. **Master database**: Select this option if you want to schedule a backup job for the master database.

   or

b. **Vault**: Select this option if you want to schedule a backup job for a document vault. Use the **Vault** drop-down menu to select the vault that you want to back up and the **Backup type** drop-down menu to select either the **Full backup** or **Differential backup** backup type.

   **Note**: A full backup is the most complete copy that can be produced with M-Files. It contains, for example, the history information of all documents. You cannot make a differential backup if you have not made a full backup first. A differential backup contains all data that has been changed after the last full backup.

9. Click the ... button to select the destination of the M-Files backup file (MFB).

10. Optional: To specify an account other than the Local System account for running this task, complete the following steps:

a) Click the **Set Account...** button.

   The **Set Account** dialog is opened.
b) Select the **This account** option.

c) In the **This account** field, enter the name of the user account.

d) In the **Password** and **Confirm password** fields, enter the password of the user account.

e) Click **OK** to close the **Set Account** dialog.

Setting the account may be necessary especially if the location you have selected is on a network drive that the Local System account cannot access.

11. Optional: If you want to divide the vault backup into multiple files, check the **Divide to multiple files** check box and set the file size limit.

    The names of the backup files should not be modified as they might no longer be recognized during a backup operation later on.

12. Optional: Check the **Overwrite existing files** check box if you want your new backup files to replace any existing files with the same file name.

13. Click **OK** to finish creating the scheduled backup job.

The scheduled backup job you have defined is added to the **Scheduled Jobs** list and it is run according to the specified schedule.

**Scheduled Backup Jobs**

The **Backup** tab of the **Scheduled Job Properties** dialog enables you to define what needs to be backed up and to which location. You can also specify whether to divide the backup into multiple files and whether to overwrite existing backup files.

For step-by-step instructions on how to create a vault backup, see [Backing Up a Document Vault](#).
Backup types

Two kinds of backups can be made of document vaults: full backups and differential backups. Only full backups can be made of the master database.

A full backup is the most complete copy that can be produced with M-Files. It contains, for example, the history information of all documents. You cannot make a differential backup if you have not made a full backup first.

To save disk space, full backups should be scheduled to occur less frequently, for instance once a week, and differential backups for example once a day. Be sure to specify backups separately for both the document vault and the master database.

The differential backup contains all data that has been changed after the last full backup. When restoring a differential backup, you will need the full backup and the files from the last differential backup.
Server Activity Monitor

M-Files Admin includes a tool called Server Activity Monitor for observing events, processes, and tasks executed by vault users or M-Files Server. The tool enables you to easily identify possible issues related to operations taking place on the server.

Note: The activity monitor records a limited number of events. This means that once the record is full, every time a new event is recorded, the oldest event is removed from the list.

This topic describes the various views included in the monitoring tool, but let's first see how to access Server Activity Monitor in M-Files Admin.

To open the server monitoring tool:

1. Open M-Files Admin.
2. In the left-side tree view, expand the server connection node of your choice.
3. In the left-side tree view, select Server Activity Monitor.

As a result, you should see the activity monitor on the right side window of M-Files Admin.

Note: The views are not updated in real time. You can use the Refresh and Reset commands on the task pane to update and clear the views. The activity monitor is always on, so you do not need to separately activate it.

Figure 85: Server Activity Monitor in M-Files Admin.

Tip: You can sort the information by any numerical column in any of the views by clicking the column heading of your choice.

Tip: You can easily copy any of the server activity listings shown by selecting and copying a listing and pasting the selection into, say, Microsoft Excel or Microsoft Word. If you paste the selection
into a Microsoft Excel worksheet, the copied listing is separated into multiple cells, preserving the original row and column format.

**Task pane commands**

The commands on the task pane allow you to perform various operations in Server Activity Monitor:

- **Refresh** updates the server activity data with up-to-date information.
- **Reset** removes all the existing server activity data and restarts the monitoring.
- **Show System Sessions / Hide System Sessions** shows or hides active system sessions and operations. If system sessions are hidden, only user activity is shown.
- **Export Server Activity...** allows you to export the current server activity data to a JSON file.
- **Import Server Activity...** allows you to import and view server activity data previously exported to a JSON file.

**Active sessions on server**

This view lists all the active user and system sessions by vault connection. If the connection is listed as (server), the connection is not to any of the vaults, but to the server itself.

**Most active sessions**

This view lists the total number (Count) and duration of operations (Total duration) by user, the description of the operation (Operation), the average duration per operation (Average), and the vault connection (Vault).

The **Total** row shows the total duration and number of operations for the entire period server activity has been monitored, and the number of operation calls made per second during the monitoring period.

**Note:** This view lists only thirty operations at a time, whereas the **Total** row displays the total number and duration of operations for the entire period of time server activity has been monitored. Therefore the calculated total number and duration of the operations visible in the view may not be equal to the figures shown in the **Total** row.

**Objects modified**

This view displays the number of object modifications by user and vault.

The types of modification listed in this view are:

- object creation
- object modification
- object deletion

The **Total** row shows the total number of object modifications for the monitoring period and the average number of object modifications made per second.

**Note:** This view lists only thirty operations at a time, whereas the **Total** row displays the total number of operations for the entire period of time server activity has been monitored. Therefore the calculated total number of the operations visible in the view may not be equal to the figures shown in the **Total** row.
Views and searches

This section lists the views accessed and searches initiated by the user. It displays the total duration, the number of uses, and the average duration per use of a single view (such as Recently Accessed by Me) or a search. Each row displays the user who accessed the view or performed the search, as well as the vault in which the operation was performed.

The Total row shows the total duration it has taken to open views and perform searches during the monitoring period. It also displays the total number of searches performed and views opened, and the average number of such operations made per second.

Note: This view lists only thirty operations at a time, whereas the Total row displays the total number and duration of operations for the entire period of time server activity has been monitored. Therefore the calculated total number and duration of the operations visible in the view may not be equal to the figures shown in the Total row.

Background processes

The Background processes view lists activities automatically executed by M-Files Server, such as scheduled maintenance tasks and processing of automatic state transitions. In addition to the name of the process, the view displays the affected vault, as well as the duration, the last start time, and – for periodic events – the next start time of the process.

Backing Up the Master Database

The M-Files master database contains the server login accounts and scheduled backup jobs. For example in case of a hardware failure, the master database can be restored from the backup so that login information and server-specific settings like scheduled backup jobs are not lost.

Complete the following steps to back up the master database:

1. Open M-Files Admin.
2. In the left-side tree view, right-click the server connection of your choice and select Back Up Master Database... from the context menu.

The Back Up Master Database dialog is opened.
3. In the **Destination** section, click ... to browse for the location where you would like to have the backup file placed.

4. Optional: To specify an account other than the Local System account for running this task, complete the following steps:
   a) Click the **Set Account...** button.

   The **Set Account** dialog is opened.
b) Select the **This account** option.

c) In the **This account** field, enter the name of the user account.

d) In the **Password** and **Confirm password** fields, enter the password of the user account.

e) Click **OK** to close the **Set Account** dialog.

Setting the account may be necessary especially if the location you have selected is on a network drive that the Local System account cannot access.

5. Optional: Check the **Divide to multiple files** check box if you want to divide the backup into multiple files of given size.

Use the **File size limit** spinner to specify the size of the split backup files.

6. Optional: Check the **Overwrite existing files** check box if you want to overwrite any existing backup files in the location you have selected.

7. Optional: In the **Scheduling** section, select the **Add to scheduled jobs** option if you want to specify a recurring schedule for backing up the master database.

a) Click the **...** button.

The **Define Schedule** dialog is opened.
b) Define the appropriate schedule using the available options.

   The schedule option **When idle** is not supported in M-Files.

   c) Click **OK** to close the **Define Schedule** dialog.

8. Click **OK** to back up the master database.

The master database backup is stored in the location you have selected.

**Restoring the Master Database**

Complete the following steps to restore the master database:

1. Open M-Files Admin.

2. In the left-side tree view, right-click the server connection of your choice and select **Restore Master Database**... from the context menu.

   The **Restore Master Database** dialog is opened.
3. Click ... to browse for the location of the master database backup file.

4. Optional: To specify an account other than the Local System account for running this task, complete the following steps:
   a) Click the Set Account... button.

   b) Select the This account option.
   c) In the This account field, enter the name of the user account.
   d) In the Password and Confirm password fields, enter the password of the user account.
   e) Click OK to close the Set Account dialog.

   Setting the account may be necessary especially if the location you have selected is on a network drive that the Local System account cannot access.

5. Click OK to restore the master database.

   A confirmation message is displayed after the master database has been restored.

3.1.5. Managing Document Vaults

This section describes how you can create, operate and maintain document vaults, and deals with various other aspects closely related to document vaults, such as content replication, vault languages, and connections to external databases.

In this chapter

- Vault Operations
- Vault Maintenance
- Languages and Translations
- Connections to External Sources
• E-Mail Client Integration Settings
• Monitoring Background Tasks
• Measuring Vault Performance
• Content Replication and Archiving
• Vault Event Log
• Interaction Among Several Vaults

Vault Operations

This section provides instructions for various administrative document vault operations, such as creating, copying, backing up, or restoring a document vault, or taking a vault offline and bringing it back online, which is an operation that must be occasionally carried out to make vault configuration changes effective.

In this chapter

• Creating a New Document Vault
• Copying a Document Vault
• Attaching a Document Vault
• Detaching a Document Vault
• Backing Up a Document Vault
• Restoring a Document Vault
• Backing Up and Restoring the Vault Search Index
• Destroying a Document Vault
• Upgrading a Document Vault
• Migrating the Vault Database to Microsoft SQL Server
• Taking a Vault Offline and Bringing a Vault Online
• Logging in to and out of a Vault in M-Files Admin

Creating a New Document Vault

If you want to create a new vault in a language other than the currently selected software language, you must first change the software language and restart the M-Files Server service via Windows Task Manager before creating the vault. For instructions on changing the software language, see Selecting the Software and Vault Language.

Do the following steps to create a new document vault:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. Select Document Vaults in the left-side tree view.
   - The Document Vaults list is opened in the right-side pane.
4. Click New Document Vault... on the task area.
   - The Document Vault Properties dialog for a new vault is opened.
5. In the **Name** field, enter a name for the new document vault.

6. Use the **Primary language** and **Secondary language** drop-down menus to select the primary and secondary languages for full-text search features.

   These selections affect, for example, the way inflected or irregular forms of words or compounds are dealt with in searches. If the document vault is to contain material in several languages, it is recommended to select the language that is used most as the primary language and a less commonly used language as the secondary language.
Selecting a language or languages improves the probability of finding the right search results. Even if a certain language was not selected as the primary or secondary language, the full-text search will nevertheless return results if words in this language were used in the search.

7. Optional: Click Import... to change the vault icon to facilitate finding the right vault if you are using multiple vaults.
   a) In the Change Icon dialog, select an item from the list or click Browse... to search for a different icon.
   b) Click OK once you have selected the new icon.

   You can revert back to the default icon by clicking Use Default.

8. Optional: Change the advanced settings on the Advanced tab.

9. Click OK once you are done.

You should now have created the document vault and it should appear on the left-side tree view of M-Files Admin under Document Vaults.

Note: When you create a document vault, M-Files automatically creates an ID for it. The ID can be changed later in the Document Vault Properties dialog of the vault by clicking the Change Unique ID button.

After you have created the vault, the users of the vault must add a connection to it via M-Files Desktop settings. For instructions, see Adding a Vault Connection.

In this chapter

- Document Vault Advanced Properties
- Document Vault Authentication

Document Vault Advanced Properties

In the document vault advanced settings, you can define whether you want to use Firebird or Microsoft SQL Server for saving document vault information.

Firebird is a SQL database engine integrated in M-Files. As part of the M-Files Server service, it requires no separate installation and is therefore very easy to use. Choose Firebird as the database engine, unless you have a particular reason to choose Microsoft SQL Server. Switching from Firebird to Microsoft SQL Server can be easily done later on if necessary. Changing from Microsoft SQL Server to Firebird is not, however, possible.

Microsoft SQL Server is a SQL database engine that requires purchasing and separate installation. It is recommended to use Microsoft SQL Server with large document vaults, but it also requires that the administrator is already familiar with the Microsoft SQL Server management.

Note: Never modify the content structure of the document vault database directly using, for instance, database system management tools. The database contents may be modified with the M-Files Server service only. Other modifications endanger the logical integrity of the database, which may cause faulty operation of the software and loss of data. The structure and contents of the document vault may only be modified via M-Files Desktop, M-Files Admin, and M-Files API.
Use Firebird

See Using Firebird as the Database Engine.

Use Microsoft SQL Server

See Using Microsoft SQL Server as the Database Engine.

Audit trail features

M-Files supports the administration of electronic records and signatures in compliance with FDA 21 CFR Part 11. Electronic signing requires the Electronic Signatures and Advanced Logging module, which is available for a separate fee. The module includes event logging extensions and electronic signature functionality. The module is activated with an appropriate license code.

In addition to this, vault-specific properties of the audit trail must be activated. Open the Properties dialog of the vault for which you want to activate these features and, on the Advanced tab, enable Advanced
**Event Log features** under **Audit trail features**. Electronic signatures are automatically enabled as soon as the license code is activated. For more information, see **Electronic Signing and Compliance**.

For a list of the event types recorded to the event log, see section **Number of events, and event types**.

**Tip:** If you want to give system administrators more visibility into actions that vault users perform in a vault, see **User Action Log**.

**Security features**

**Extended metadata-driven permissions**

For vaults created with version 8.0 (or later), the extended metadata-driven permissions are active by default. Otherwise they need to be manually activated. Please bear in mind that you cannot undo the operation.

**Note:** If you have assigned automatic permissions to values in earlier versions of M-Files, it is strongly recommended to check that the permissions are still working as desired.

For more information on automatic permissions, refer to **Automatic Permissions for Value List Items**. You can activate the automatic permissions by value, value list, object type, or class. For you to be able to use the automatic permissions via a specific property, you should also allow this in the property definition’s properties. For more information, see **New Property Definition**.

**Enable file data encryption at rest**

This option allows you to use the AES-256 algorithm for encryption of the vault file data at rest. The encryption is compliant with the Federal Information Processing Standard (FIPS) publication 140-2.

This option only encrypts file data that is stored to the vault after the feature has been turned on. If you want to encrypt existing data:

1. Select the vault in the left-side tree view of M-Files Admin.
2. Select **Action > Maintenance > Update encryption status of existing files**.

From the perspective of the end-user, file data encryption is not visible in any way.

**Note:** Especially when encryption is enabled, it is crucial for the administrator to have thorough and frequent back-up processes in place. The combination of encrypted file data, hard drive failure and inadequate backup system could eventually lead to the loss of all data.

**Annotations and redlining**

The **Annotation and redlining** feature enables you to add annotations to documents in the document vault. You can enable the annotations and redlining feature by checking the **Annotations and redlining** check box in the **Document Vault Properties** dialog. For more information about annotations in M-Files, see the topics **Annotations and Redlining** and **Using Annotations**.

**M-Files Web**

In this field, enter the URL to your M-Files Web home page. Creating M-Files hyperlinks for documents and objects stored in the vault requires this to be able to include M-Files Web URLs in the hyperlinks. The URL is also required to include M-Files Web links in notification messages.

Make sure the URL starts either with **http://** or **https://**. For example: **https://myserver.mydomain.com**.
In this chapter

- Using Firebird as the Database Engine
- Using Microsoft SQL Server as the Database Engine

Using Firebird as the Database Engine

Firebird is an SQL database engine integrated in M-Files.

Note: M-Files uses Firebird as the default vault database engine. However, if a vault contains several tens of thousands of objects, it is recommended to use Microsoft SQL Server as the database engine. If a vault has originally been set up to use Firebird but the number of objects in the vault and the size of the metadata file has since then significantly increased, it might be beneficial to have the vault use Microsoft SQL Server as the database engine instead (see Migrating the Vault Database to Microsoft SQL Server).

In practice, when the size of the metadata file for a single vault reaches 1 GB (see Checking the Size of a Firebird Metadata File for instructions on checking the metadata file size), a registry setting (see Registry Setting for Extending Firebird Usability) can be applied to extend Firebird usability to up to 2 GB per vault, but it might also be a good idea to start planning Microsoft SQL Server migration (see Migrating the Vault Database to Microsoft SQL Server). Firebird can be used when the size of the metadata file for a single vault exceeds 2 GB, but for performance reasons we recommend migrating to Microsoft SQL Server.

To open the vault settings for the Firebird engine, complete the following steps:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, then right-click the document vault of your choice, and finally select Properties from the context menu.

The Document Vault Properties dialog is opened.
4. Open the **Advanced** tab.

   The **Advanced** tab is opened.
5. Click **Define...** under the **Use Firebird** option to open the settings for the Firebird engine.

✓ The Firebird settings dialog is opened.
In the Firebird settings dialog, you may complete the following operations:

- Changing the Location of the Vault Data
- Defining A Separate Location for Vault File Data

Changing the Location of the Vault Data

If necessary, you may change the default location of the vault data, that is, the file data and the metadata of the vault. Note that the vault metadata must be stored on the local drive of the M-Files Server computer. If you wish to store the file data of the vault in a separate location (which can be, for example, a network drive), see Defining A Separate Location for Vault File Data.

Before you begin, take the vault offline for the duration of the operation. For instructions, see Taking a Vault Offline.

To change the location of vault data, complete the following steps:

1. Open the vault database engine settings.
   
   The current location of the vault data is shown in the vault database engine settings dialog.

2. Using File Explorer or any other file manager, copy the FileData and the MetaData folders from their current location to the new location.

3. Click the ... button to browse for the new file data location.
   
   The Browse For Folder dialog is opened.

4. Select the new location for vault data, and then click OK to close the Browse For Folder dialog.
   
   Note that the selected location should be on the local drive of the M-Files Server computer and it should contain the FileData and MetaData folders.

5. Click OK to close the vault database engine dialog, and finally click OK to close the Document Vault Properties dialog.
After the operation is complete, bring the vault back online. For instructions, see Bringing a Vault Online.

Defining A Separate Location for Vault File Data

By default, vault file data is stored in the same folder as vault metadata. If necessary, you can define a separate location for the file data of the vault. This enables you to locate your file data on a large network drive or file server. It is, however, recommended to store the metadata and files in the same location.

Before you begin, take the vault offline for the duration of the operation. For instructions, see Taking a Vault Offline.

To define a separate location for file data, complete the following steps:

1. Open the vault database engine settings.

   The current location of the vault file data is shown in the vault database engine settings dialog.

2. Using File Explorer or any other file manager, copy the folder FileData from its current location to the new location.

3. Click the Advanced... button.

   The Advanced dialog is opened.

4. Enable the Separate location for file data option.

5. Click the ... button to browse for the new file data location.

   The Browse For Folder dialog is opened.

6. Select the new location for vault file data, and then click OK to close the Browse For Folder dialog.

   Note that the selected location should contain the FileData folder. The location can also be a UNC path to a network drive.

7. Optional: Click Set Account for File Data... to select the account that M-Files Server uses for accessing the vault file data. This may be necessary if the local system account does not have permission to access the selected location.

   a) Select the This account option.
   b) In the This account field, specify the account that M-Files Server should use for accessing vault file data in the selected location.
   c) In the Password and Confirm password fields, enter the password of the account.
   d) Click OK to close the Set Account dialog.

8. Click OK to close the Advanced dialog.

9. Click OK to close the vault database engine dialog, and finally click OK to close the Document Vault Properties dialog.

After the operation is complete, bring the vault back online. For instructions, see Bringing a Vault Online.
Using Microsoft SQL Server as the Database Engine

Instead of Firebird, you can use Microsoft SQL Server 2012, 2014, 2016, 2017, 2019, or later with its latest service pack as the database engine. M-Files supports all the SQL Server editions (Express, Standard, Enterprise, etc.). For the best performance, we recommend using SQL Server 2016 Service Pack 1 or later. M-Files supports the use of Microsoft SQL Server on Microsoft Windows.

**Note:** In new installations, we recommend using Microsoft SQL Server Enterprise Edition 2017 Service Pack 1 or later. If you are already using Microsoft SQL Server as the database engine for one or more vaults, and are interested in upgrading to a newer version for performance reasons, we recommend consulting our customer support at support@m-files.com before upgrading.

The Microsoft SQL Server Enterprise Edition versions 2008–2017 provide the possibility for compressing table data and indexes. This reduces the input/output activity of the disk, but also increases the CPU load by about 10 percent. Typically this means reduced database sizes.

Microsoft SQL Server 2016 Service Pack 1 and above support updateable columnstore indexes (in earlier versions, columnstore indexes are only available in Enterprise Edition), enabling better performance when opening sub-levels of views (such as Documents by project). This is especially beneficial when empty virtual folders are set to be hidden.

Using SQL Server means that the database server memory can be more efficiently used and the backup storage of large data vaults is improved. In the event of problems, errors etc., you can switch to the mirrored database server without delay.

We recommend using Microsoft SQL Server with large document vaults that contain several hundreds of thousands or more documents or other objects. With large document vaults, Microsoft SQL Server provides better overall efficiency than Firebird. However, use of the Microsoft SQL Server database engine requires that the administrator is already familiar with the Microsoft SQL Server management.

**Note:** Microsoft SQL Server licenses are not included in M-Files licenses and must be purchased separately.

Microsoft SQL Server may be located on the same machine as the M-Files Server, or it can be installed on another server. If SQL Server is installed on another server, M-Files Server and SQL Server must be linked with a fast network connection. Instructions for ensuring the efficient operation of SQL Server can be found in the Microsoft SQL Server documentation. Firstly, it is recommended to ensure that the SQL Server machine has a sufficient amount of memory. The number and speed of processors and hard drives also have a significant impact on the efficiency.
If your SQL Server does not use the default port (1433), the server name must be given as <server name>,<port>.

When Microsoft SQL Server is used as the document vault database engine, M-Files Server stores data in the document vault in the associated database. Certain secondary data that do not require a backup, such as search indexes, are left outside the database.

**File Data Location**

File data can be saved in the Microsoft SQL Server database or other location, such as a network drive.

You can choose to:

- **Store file data in the vault database**
• **Store file data in a file-system folder**: With this option, you can freely specify the location for saving the files to a network drive or to another location. You can keep the file data secure by designating a specific account for processing the file data.

  **Note**: If you want to use a network drive for storing file data, you must use the format `//<server>/<path>` for specifying the file data location.

  **Note**: In M-Files builds older than 12.0.6661.0, the vault is offline for the entire duration of changing the file data location. Note that if your vault contains large amounts of file data (for instance over one terabyte of data), changing the location may take several days, or even over a week, to complete.

  With the build 12.0.6661.0 and later, the vault remains online and fully operational for the majority of the duration of changing the file data location. Only when the new file data location is taken into use, is the vault offline for the duration of taking the new location into use. If you cancel the operation of changing the file data location, you can always resume it by selecting the same location as you previously selected for file data.

  For further instructions, see [Changing the Location of the Vault File Data](#).

### Backing Up

The administrator is responsible for making backup copies and timing the backup copies of the document vault database. Backup copying is performed using SQL Server's own management tools and backup copying solutions offered by third parties. When restoring a backup copy, the administrator first returns the document vault database to the SQL Server using the desired method, and then reattaches the document vault to M-Files using the [Attach Document Vault](#) function.

If you are using Microsoft SQL Server as the database engine and your file data is stored on the file system separately from the database, administrators must back up both the Microsoft SQL database and the files on the file system separately.

**Important**: Always back up the SQL database first and then the file system data to avoid references to non-existing object files.

The steps to be followed in this case are:

1. Back up the Microsoft SQL database first (metadata).
2. **Do not** run M-Files Server optimization at this point, as this would remove files that might have been marked for destruction after step 1 was performed.
3. Back up file system data (object files).

For more comprehensive backup instructions, see the M-Files knowledge base article [M-Files Backup Policy](#).

### Migrating to Microsoft SQL Server

The document vault database engine can also be changed from Firebird to Microsoft SQL. For more information, see [Migrating the Vault Database to Microsoft SQL Server](#).

**In this chapter**

- Changing the Location of the Vault File Data
Changing the Location of the Vault File Data

If you are using Microsoft SQL Server and your file data of the vault is stored either in the vault database or the file system, you may change the location of the vault file data.

To change the location of the vault file data, complete the following steps:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, then right-click the document vault of your choice, and finally select Properties from the context menu.

4. Open the Advanced tab.

5. Under the Use Microsoft SQL Server option, click the Define... button.

The Document Vault - Microsoft SQL Server dialog is opened.
6. Click the **File Data Location...** button.

The **File Data Location** dialog is opened.

- Choose the appropriate option for storing file data:
  - Store file data in the vault database
  - Store file data in a file-system folder

Click **OK** to save the settings.
7. Either:
   
a. If you want to change the location of the vault file data from the vault database to the file system, or from one folder in the file system to another, select the option **Store file data in a file-system folder** and then click the **Define...** button.
   
   or

   b. If you want to change the location of the vault file data from the file system to the vault database, select the option **Store file data in the vault database** and then click **OK**.

8. If you selected the option **Store file data in a file-system folder**, complete the following steps:
   
a) Optional: If you are changing the vault file data location from one folder in the file system to another, using File Explorer or any other file manager, copy the **FileData** folder from its current location to the new location.

   b) In the **File-System Folder** dialog, click the **...** button to browse for the new file data location, or type in the location in the text field.

   The location can also be a UNC path to a network drive.

   ![File-System Folder dialog]

   c) Optional: Click **Set Account for File Data...** to use an account other than the Local System account for accessing file data.

   Setting the account may be necessary especially if the file data is located on a network drive that the Local System account cannot access.

   d) Click **OK** to close the **File-System Folder** dialog.

9. Click **OK** to close the **File Data Location** dialog and the vault database engine dialog, and finally click **OK** to close the **Document Vault Properties** dialog.

10. If you are changing the vault file data location from the vault database to the file system, or from the file system to the vault database, you are prompted to confirm that you want to change the file data location. Click **Yes**.

   The file data of the vault is then copied to the new location.

   ![Checkmark icon]

   **Note:**

   In M-Files builds older than 12.0.6661.0, the vault is offline for the entire duration of changing the file data location. Note that if your vault contains large amounts of file data (for instance over one terabyte of data), changing the location may take several days, or even over a week, to complete.

   With the build 12.0.6661.0 and later, the vault remains online and fully operational for the majority of the duration of changing the file data location. Only when the new file data
location is taken into use, is the vault offline for the duration of taking the new location into use. If you cancel the operation of changing the file data location, you can always resume it by selecting the same location as you previously selected for file data.

Your vault now uses the specified location for storing and accessing the file data of the vault.

Document Vault Authentication

The **Authentication** tab of the **Document Vault Properties** dialog contains settings related to vault user authentication.

**Note:** This tab is only available in the **Document Vault Properties** dialog of existing vaults. When you are creating a new vault, this tab is not shown.

Azure AD Authentication

Enable the option **Use Azure AD for authentication** if you wish to use Azure AD for vault user authentication. When this option is enabled, two applications are registered in the Azure portal and they are then used for authenticating M-Files users in Azure AD.
The applications in the Azure portal must be granted permissions to access user information in Azure AD. You may choose from two different options for granting the permissions:

- **Prompt each user for consent upon first vault access:** Select this option if you want to give each vault user the choice to decide whether they want to grant the applications access to their user credentials in Azure AD.

- **Give consent on behalf of all users in the directory (requires Azure AD administrator rights):** Select this option if you want to grant the applications access to user credentials in Azure AD on behalf of all vault users collectively. Note that you must have Azure AD global administrator rights to give consent on behalf of other users.

If the option **Prompt each user for consent upon first vault access** is selected, the Azure AD prompt for giving the appropriate permissions to the applications is displayed when the user logs in to the vault for the first time.

If the option **Give consent on behalf of all users in the directory (requires Azure AD administrator rights)** is selected, on the other hand, the prompt for giving the appropriate permissions is displayed for the administrator after Azure AD authentication has been enabled.

**Note:** Before enabling this feature, log out of any Azure AD account that is not intended to be used for logging in to M-Files.

After enabling Azure AD authentication and clicking **OK** or **Apply** in the **Document Vault Properties** dialog, a login prompt is displayed, in which the administrator should provide the credentials for the Azure AD account that will be used for logging in to M-Files.

**Note:**

If you wish to enable this feature in your on-premises environment, you should create the registry setting described below on the M-Files server computer.

Note that by default M-Files Web and M-Files Mobile do not work with Azure AD authentication in on-premises environments. If you wish to use either M-Files Web or M-Files Mobile with this setup, you need to configure an Azure AD application for OAuth 2.0 authentication and then configure M-Files for OAuth 2.0 authentication. For further instructions, contact our customer support at support@m-files.com, and see also the document **Configuring OpenID Connect and OAuth 2.0 for M-Files Authentication**.

<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
<th>Value type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server \Common</td>
<td></td>
<td>The value defines mappings between incoming connections and document vaults.</td>
</tr>
</tbody>
</table>
### Allow users and user groups to be synchronized from Azure AD to M-Files

By enabling the option **Allow users and user groups to be synchronized from Azure AD to M-Files** you can set M-Files to allow users and user groups to be imported from Azure AD to M-Files. If the users and user groups are removed or modified in Azure AD, they are correspondingly removed or modified in M-Files as well. You can use the **License type for new login accounts** drop-down menu to select the license type to be used for any new login accounts that are created via the synchronization.

**Note:** For instructions on how to enable user synchronization on the Azure AD side, see the document [Synchronizing Users from Azure Active Directory to M-Files](#).

**Note:** If you want to enable this option in an on-premises environment, you first need to set up vault-specific login accounts. For instructions on how to do this, please contact our customer support at [support@m-files.com](mailto:support@m-files.com).

### Copying a Document Vault

You can use the **Copy Document Vault** operation to create a copy of a document vault. You can copy a document vault in its entirety or select specific data components to be included in the copy.

For example, if you have found the structure of an old document vault useful and want to copy it to a new vault without the actual content, you can easily do this by copying the vault structure only. This way you can utilize, for instance, the sample vault included in the M-Files installation.

Complete the following steps to copy a document vault:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, select the document vault of your choice.

---

<table>
<thead>
<tr>
<th><strong>Key</strong></th>
<th><strong>Value</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server\Common</td>
<td>https://&lt;DNS name for the vault 1&gt;={&lt;vault GUID for the vault 1&gt;}</td>
</tr>
<tr>
<td></td>
<td>https://&lt;DNS name for the vault 2&gt;={&lt;vault GUID for the vault 2&gt;}</td>
</tr>
</tbody>
</table>

For example:

https://vault1.company.com={990827D8-8AF2-4A4E-B121-4C1A8AD8ECD0}  
https://vault2.company.com={F565EDFE-939E-4507-B078-D06902888C98}
4. Right-click the vault and select **Operations > Copy Document Vault...** from the menu bar.

The **Copy Document Vault** dialog is opened.
5. In the **Name** field, enter a name for the copy of the document vault.

6. Click **Define...** to define the vault data location on the server to which you want to copy the document vault.

   The **Document Vault** dialog is opened.

   ![Document Vault Dialog](image)

7. Click the **...** button to browse for the vault data location.

8. Optional: If you need to define a separate location for file data, do the following steps:
   a) Click **Advanced**.

      The **Advanced** dialog is opened.

   b) Check the **Separate location for file data** check box.
   c) Click the **...** button to browse for the separate location for file data.
   d) Click **Set Account for File Data...** if you need to define a separate account for copying file data.
   e) Click **OK** to close the **Advanced** dialog.

9. Once you have defined the location for the document vault copy, click **OK** to close the **Document Vault** dialog.

10. In the **Data to copy** section, select the vault data components that you want to copy.

    You can click **All** to select all components or **Structure Only** to select only the structure components of the vault.

    If the **Documents and other objects** check box is selected, for troubleshooting purposes you may exclude file data from the vault copy by clicking **Advanced...** and selecting the **Exclude file data from the vault copy** check box.

11. Click **OK** to copy the vault.

    The selected components of the document vault are copied to the location that you have defined.
Attaching a Document Vault

A document vault may be detached from M-Files Server (see Detaching a Document Vault), in which case all data in the document vault is kept in a file folder on a hard drive but the document vault is not registered on the server. If you know the name of the document vault and want to start using it again, you can do so by attaching the vault back to M-Files Server using M-Files Admin.

![Diagram of detaching and attaching a document vault]

Figure 88: When the vault is detached from the server, it is not displayed in the list of available document vaults in M-Files Admin and users cannot access it, but all the data stored in the vault stays intact. You can, for instance, move a detached vault to a another server machine and take it back into use by attaching it to the new server.

If, for example, lack of space makes it necessary to move a document vault from one server to another, this can be done with the Detach and Attach functions: simply detach the vault on server A, copy the vault data to server B, and attach the vault on server B.

Do the following steps to attach a document vault:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
4. Click Attach Document Vault... on the task area.

   The Attach Document Vault dialog is opened.
5. In the **Name** field, enter the name of the detached document vault.

   You may look for the name of the detached vault on the server computer in the folder `C:\<M-Files installation directory>\Server Vaults`.

6. Select either:

   a. **Attach using original identity**: Select this option if you want to use the existing ID of the vault.

      or

   b. **Attach as a different vault (new identity)**: Select this option if you want to create a new unique ID for the vault.

   The vault identity is used in establishing document vault connections to the server.
7. Optional: On the Advanced tab, you may select and configure the database engine for storing document vault data.

- See Using Firebird as the Database Engine and Using Microsoft SQL Server as the Database Engine for more information.

8. Click OK.

The Attach Vault Options dialog is displayed.

9. Select the features that you would like to disable and then click Disable selected to confirm your selection.

- If you are unsure about which features to disable or to keep enabled, do not make any changes in this dialog.

- A dialog is displayed listing the features that will be in use in the attached vault.

10. In the Attach Vault dialog, click Attach.

The selected document vault is attached to M-Files Server and can be accessed again.

The users of the document vault must add a connection to it via M-Files Desktop settings. For instructions, see Adding a Vault Connection.

Detaching a Document Vault

You can detach a document vault from the server connection, in which case the vault data is not destroyed but kept on the hard drive of the server computer. A document vault that has been detached can be attached back to M-Files Server from the hard drive. For more information on attaching a document vault, see Attaching a Document Vault.
Do the following steps to detach a document vault:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
4. Select a document vault that you want to detach and click Detach on the task area.
5. Click Yes at the prompt to confirm your action.

The selected document vault is detached from M-Files Server.

**Backing Up a Document Vault**

The vault backup function can be used for backing up the document vault or for scheduling a recurring vault backup job. For more information about scheduled backups, refer to Scheduled Backup Jobs.

- **Note:** If you are using Microsoft SQL Server as the database engine of your vault, see Backing Up for instructions on backing up and restoring your vault data.

It also is important to note that M-Files stores on the hard drive of the server machine a vault-specific set of secondary data that is not included in a vault backup, but instead re-created after the vault backup has been restored. This data includes PDF renditions for hit-highlighting and preview, thumbnails, and most importantly, the search index of the vault. As rebuilding the search index for a large vault can take a significant amount of time, you should always consider backing up and restoring the search index as well. For instructions, see Backing Up and Restoring the Vault Search Index.

To back up a document vault, do the following steps:
1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, select a vault of your choice.

4. Right-click the vault and select **Operations** > **Back Up...** from the context menu.

   The **Back Up Document Vault** dialog is opened.
5. Using the **Backup type** drop-down menu, select either **Full backup** or **Differential backup**.

A full backup is the most complete copy that can be produced with M-Files. It contains, for example, the history information of all documents. You cannot make a differential backup if you have not made a full backup first. A differential backup contains all data that has been changed after the last full backup.

6. Click the ... button to select the destination of the M-Files backup file (MFB).

7. Optional: To specify an account other than the Local System account for running this task, complete the following steps:
   a) Click the **Set Account**... button.
   b) Select the **This account** option.
   c) In the **This account** field, enter the name of the user account.
   d) In the **Password** and **Confirm password** fields, enter the password of the user account.
   e) Click **OK** to close the **Set Account** dialog.

   Setting the account may be necessary especially if the location you have selected is on a network drive that the Local System account cannot access.

8. Optional: If you want to divide the vault backup into multiple files, check the **Divide to multiple files** check box and set the file size limit.

   The names of the backup files should not be modified as they might no longer be recognized during a backup operation later on.

9. Optional: Check the **Overwrite existing files** check box if you want your new backup files to replace any existing files with the same file name.

10. Select either:
    a. **Run immediately** to start the backup job right away.
    
   or
    
    b. **Add to scheduled jobs** and click the ... button to schedule the backup job as a recurring task.

   ≡ **Note**: For more information about scheduled jobs, see **Scheduled Jobs**.

11. Click **OK** to either start the backup process or to add the scheduled task to the list of **scheduled jobs**.
The vault backup should now be run or added to the list of scheduled jobs, depending on your choice under the Scheduling header of the dialog.

**Restoring a Document Vault**

Even if a document vault is destroyed or the data is somehow corrupted, you can always restore the healthy vault from a backup. For more information about creating backups, see Backing Up a Document Vault and Scheduled Backup Jobs.

❗ **Note:** If you are using Microsoft SQL Server as the database engine of your vault, see Backing Up for instructions on backing up and restoring your vault data.

---

**Figure 90:** You can restore a backup of a document vault using M-Files Admin.

Do the following steps to restore a document vault from a backup file:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. Still in the left-side tree view, select **Document Vaults**.
4. Click **Restore Document Vault...** on the task area.

 ✓ The **Restore Document Vault** dialog is opened.
5. In the **Full backup** field, specify the location of the backup file on the server from which the full backup is to be restored.

6. Optional: In the **Differential backup (optional)** field, specify the location of the differential backup file to restore a differential backup on top of the full backup.
7. Select either:

a. **Restore using original identity**: Select this option to use the existing ID of the document vault.

or

b. **Restore as a different vault (new identity)**: Select this option to generate a new unique ID and to specify a new name for the vault to be restored.

The identity is used in establishing document vault connections to the server. The name of the vault can be changed on the server, and the document vault connection can have any name in the client software of the end user.

8. In the **Location for vault data on server** field, specify the location where the data of the document vault is saved.

9. Optional: Click **Advanced...** if you want to define a separate location for file data.

10. Optional: Check the **Overwrite existing files** check box if you want to overwrite existing files in the selected metadata and file data locations.

11. Click **OK**.

The **Attach Vault Options** dialog is displayed.

12. Select the features that you would like to disable and then click **Disable selected** to confirm your selection.

If you are unsure about which features to disable or to keep enabled, do not make any changes in this dialog.

A dialog is displayed listing the features that will be in use in the attached vault.

13. In the **Attach Vault** dialog, click **Attach**.

A document vault is restored from the selected backup file.
The users of the document vault must add a connection to it via M-Files Desktop settings. For instructions, see Adding a Vault Connection.

**Backing Up and Restoring the Vault Search Index**

As the search index of the vault is not included in a vault backup, and since re-creating the index for a large vault can take a large amount of time, you should always consider backing up the search index together with a vault backup. This section provides instructions for backing up and restoring the search index of your vault.

*Backing up and restoring the vault search index (dtSearch)*

Do the following steps to back up the vault search index when you are using dtSearch as your search engine:

1. Copy the **Indexes** folder from the location of the vault data on the server (for example `C:\Program Files\M-Files\Server Vaults\<vault name>\Indexes`).
2. Store the copied folder in a safe place.
   - The index itself stores its state, and your backup of the index does not need to be as new as the vault backup.

Once you have a backup of your search index, do the following steps to restore the backed up search index:

3. Take the vault offline.
   - For instructions, see Taking a Vault Offline.
4. Delete the **Indexes** folder and replace the folder with the backup.
5. Bring the vault online.
   - For instructions, see Bringing a Vault Online.

The indexing begins to catch up until the search index is completely up-to-date.

*Backing up and restoring the vault search index (IDOL)*

Do the following steps to back up the vault search index when you are using Micro Focus IDOL version 12 as your search engine:

1. Use Windows Task Manager to stop the **MFIndexingManager** service.
   - When the indexing service is stopped, no new material is added to the index.

   **Note:** In M-Files May '20 Update or later, M-Files Server migrates the index log files to IDOL and deletes the index log files from M-Files Server. If you are using M-Files May '20 Update or later, you do not need to perform the following step.
2. Copy the existing index log files **IndexFLog.log** and **IndexMLog.log** or **IndexCLog.log** (in case of an external repository) and store the copied files in a safe place.

   - The usual location of the log files is in the **FileData** and **MetaData** folders in `C:\Program Files\M-Files\Server Vaults\<vault name>\Indexes\Combined\M-Files`. 
3. Wait until all IDOL indexing queues in each content engine are empty.

   The queues are empty when the folders in the IDOL indexing queue are empty. The location of the IDOL indexing queue is for example E:\IDOL12\data\PROD1-content-12000\index\status.

4. On the IDOL frontend server, open a browser.

   Note: If you have existing backup files created by the DREEXPORT command and you have not deleted them, you have to give new names to the backup files because the process does not overwrite.

   Note: You need to perform the following step on each backend engine and the daily index content engine.

5. On the address bar of the browser, give the command http://<content engine IP address>:<content engine indexing port number>/DREEXPORTIDX?

   FileName=<optional path and backup file name>.

   Example: http://192.168.75.130:10001/DREEXPORTIDX?FileName=BU

   The command generates a file called <file name>-0.idx.gz into the folder of the content engine, for example in E:\IDOL12\data\PROD1-content-12000\index. The file includes all index data to the point of last full indexing batch.

6. Start the MFIndexingManager service.

7. Copy the backup files of the content engines from <IDOL installation directory or drive>\<content engine>\bin\single<content engine port range>\content into a safe place.

Once you have the backup of your search index in place, you can start the restore process. By default, the restore process uses the same folders as the backup. Do the following steps to restore the backed up search index:

8. Use Windows Task Manager to stop the MFIndexingManager service.

   When the indexing service is stopped, no new material is added to the index.

9. Wait until all IDOL indexing queues in each content engine are empty.

   The queues are empty when the folders in the IDOL indexing queue are empty. The location of the IDOL indexing queue is for example E:\IDOL12\data\PROD1-content-12000\index\status.

10. On the IDOL frontend server, open a browser.

   Note: You need to perform the following step on each backend engine and the daily index content engine.

11. To clear the whole index, give the command http://<content engine IP address>:<DIH/DAH indexing port>/DREINITIAL? on the address bar of the browser.

   Note: You need to perform the following step on each backend engine and the daily index content engine.
12. Add the index from the corresponding backup by giving the command `http://<content engine IP address>:<content engine indexing port>/DREADD?<optional backup file path and file name>-0.idx.gz`.

   Example: `http://192.168.75.120:10001/DREADD?BU-0.idx.gz`

13. Check the number of documents with MFAutonomyConsole using the `getstatus` action against the DIH and DAH engines.

   Note: If the backup has been taken before the M-Files May '20 Update, you have the index log files in addition to the IDOL index. In this case, perform the following step. If the backup has been taken after the M-Files May '20 Update, you do not need to perform the following step.

14. Overwrite the index log files `IndexFLog.log` and `IndexMLog.log` or `IndexCLog.log` (in case of an external repository) with the backup files.

   The usual location of the log files is in the `FileData` and `MetaData` folders in `C:\Program Files\M-Files\Server Vaults\<vault name>\Indexes\Combined\M-Files`.

15. Start the `MFIndexingManager` service.

You can run multiple backups or restores simultaneously with a PowerShell script in the backend engines and the daily index content engine.

Example of a backup script:

```
$navOpenInBackgroundTab = 0x1000;
$ie = new-object -com InternetExplorer.Application
# backup from Daily
$ie.Navigate2("http://192.168.75.130:10001/DREEXPORTIDX?FileName=BU", $navOpenInBackgroundTab);
# backup from backend server 1, engine 10001
$ie.Navigate2("http://192.168.75.131:20001/DREEXPORTIDX?FileName=BU", $navOpenInBackgroundTab);
# backup from backend server 2, engine 20001
$ie.Visible = $true;
```

Example of a restore script:

```
$navOpenInBackgroundTab = 0x1000;
$ie = new-object -com InternetExplorer.Application
#$ie.Navigate2("http://192.168.75.128:9001/DREADD? BU-0.idx.gz ");
# restore Daily
$ie.Navigate2("http://192.168.75.130:10001/DREADD?BU-0.idx.gz", $navOpenInBackgroundTab);
# restore backend server 1, engine 10001
$ie.Navigate2("http://192.168.75.131:20001/DREADD?BU-0.idx.gz", $navOpenInBackgroundTab);
# restore backend server 2, engine 20001
$ie.Visible = $true;
```
Destroying a Document Vault

The **Destroy** function can be used to permanently destroy all data from a document vault.

⚠️ **Warning:** When you destroy a vault, the following operations are carried out:
- All the vault file data on the M-Files server is permanently deleted.
- The vault database is permanently deleted.

Complete the following steps if you wish to destroy a vault:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, select **Document Vaults**.
4. Right-click the document vault that you want to destroy, and then select **Operations > Destroy** from the context menu.

   You are prompted to make sure that you want to destroy the selected vault.

5. Click **Yes** at the prompt.

The selected document vault, including its file data and its database, are permanently deleted and the vault can no longer be accessed by users.

网讯: The **Destroy** function naturally does not affect backups located on the hard drive. The document vault can thus be restored if backups have been made.

Upgrading a Document Vault

If the internal database structure of the document vault changes, which usually happens during a software upgrade, the document vault must be upgraded. During a software upgrade, this is done automatically for all the vaults that are in the online state. If the vault is offline during a software upgrade, it can only be used after it has been manually upgraded. To do this, right-click a vault in M-Files Admin and select **Operations > Upgrade** from the context menu.

网讯: Upgrading a document vault makes it incompatible with older M-Files Server versions.

Migrating the Vault Database to Microsoft SQL Server

M-Files uses Firebird as the default vault database engine. For vaults that contain several hundreds of thousands of objects, it is recommended to use Microsoft SQL Server as the database engine. If a vault has originally been set up to use Firebird but the number of objects in the vault has significantly increased, it might be beneficial to have the vault use Microsoft SQL Server as the database engine instead. You can migrate your vault database from Firebird to Microsoft SQL Server via M-Files Admin.

网讯: You can only migrate the document vault database engine from Firebird to Microsoft SQL Server. Migrating from Microsoft SQL Server to Firebird is not supported.

- Your vault must currently use Firebird as the database engine.
- You need to have a Microsoft SQL Server connection.
If you want to change the file data location before or after the migration, take the vault offline, move the file data to a different location on the disk, define the location of the vault file data, and bring the vault back online.

To migrate your vault database from Firebird to Microsoft SQL Server, complete the following steps:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, right-click the document vault of your choice and select Operations > Take Offline from the context menu.

4. Click Yes to confirm that you want to take the document vault offline.

5. Optional: It is recommended that you back up the document vault at this point.
   
   For instructions on backing up the document vault, see Backing Up a Document Vault.

6. In the left-side tree view, right-click the vault again and select Operations > Migrate to Microsoft SQL Server... from the context menu.

   The Document Vault - Microsoft SQL Server dialog is opened.
7. In the **Server name** field, enter the connection address to your Microsoft SQL Server, such as `mysqlserver.mydomain.local`.

8. In the **Database name** field, enter the name of the database to be created for the vault.

   - It is recommended to use the same name as the vault has on M-Files Server.
9. In the **Administrator credentials** and **Basic user credentials** sections, fill in the credentials in one of the two following ways:

<table>
<thead>
<tr>
<th>Option</th>
<th>Steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the credentials for a login that has the <code>sysadmin</code> server role</td>
<td>a. In the <strong>Administrator credentials</strong> section, enter the credentials for a login that has the <code>sysadmin</code> server role on your Microsoft SQL Server.</td>
</tr>
<tr>
<td>on your Microsoft SQL Server, giving M-Files Server the rights to make</td>
<td>b. In the <strong>Basic user credentials</strong> section, select the <strong>Use an automatically generated login</strong> option.</td>
</tr>
<tr>
<td>the necessary migration-related operations.</td>
<td></td>
</tr>
<tr>
<td>Manually create the Microsoft SQL Server database and login</td>
<td>a. By using Microsoft SQL Server Management Studio, create an empty database for the vault.</td>
</tr>
<tr>
<td>accounts (without the <code>sysadmin</code> server role) and use the non-<code>sysadmin</code></td>
<td>b. Still in Microsoft SQL Server Management Studio, create two login accounts without the <code>sysadmin</code> server role, for example User A and User B.</td>
</tr>
<tr>
<td>credentials for M-Files Server.</td>
<td>c. Back in M-Files Admin and the <strong>Document Vault - Microsoft SQL Server</strong> dialog, in the <strong>Administrator credentials</strong> section, enter the credentials for User A.</td>
</tr>
<tr>
<td></td>
<td>d. In the <strong>Basic user credentials</strong> section, first select the <strong>Use an existing login</strong> option and then enter the credentials for User B.</td>
</tr>
</tbody>
</table>

The easiest way is to select the first option, and to let M-Files Server make all the necessary changes on your Microsoft SQL Server. In some cases, however, system administrators may need to withhold Microsoft SQL Server `sysadmin` credentials from M-Files Server. In these cases, the vault database and the Microsoft SQL Server login accounts need to be created manually (the second option).

M-Files Server uses the basic user credentials for almost all vault operations, and the administrator credentials – in addition to creating the database and the login accounts – for some of the maintenance operations.

10. Optional: Click **Test Connection** to test the connection to your Microsoft SQL Server.

11. Once you are done, click **OK**. You are then warned that this operation cannot be undone.

12. Click **Yes** to close the warning dialog and to start the migration process.

13. After the migration is complete, in the left-side tree view, right-click the document vault and select **Operations > Bring Online** from the context menu.

Once the migration process is complete, the database of your M-Files vault is located on the Microsoft SQL Server that you specified.

After migrating the vault database to Microsoft SQL Server, you need to create a backup job for the database in Microsoft SQL Server Management Studio. For more details and recommendations, see M-Files Backup Policy.

**In this chapter**

- Migrating the Vault Database from One Microsoft SQL Server to Another
Migrating the Vault Database from One Microsoft SQL Server to Another

When migrating from one Microsoft SQL Server to another, the new Microsoft SQL Server should be running the same or newer version of Microsoft SQL Server, and the Microsoft SQL Server edition (Enterprise or Standard) should also be the same or higher than that of the old Microsoft SQL Server.

In other words, do not migrate vault databases from Microsoft SQL Server to an older version or lower edition of Microsoft SQL Server.

Complete the following steps to migrate a vault database from one Microsoft SQL Server to another:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, right-click the document vault of your choice and select **Operations > Take Offline** from the context menu.
4. Open Microsoft SQL Server Management Studio and take a full backup of the vault database.
5. Restore the database to the new Microsoft SQL Server as a new database.
6. In M-Files Admin, right-click the document vault and select **Properties** from the context menu.

   - The **Document Vault Properties** dialog is opened.
7. Open the **Advanced** tab.
8. Under the **Use Microsoft SQL Server** option, click the **Define...** button.

   - The **Document Vault - Microsoft SQL Server** dialog is opened.
9. In the **Server name** field, specify the name of the new Microsoft SQL Server.
10. In the **Database name** field, specify the name of the new database.
11. In the **Administrator credentials** and **Basic user credentials** sections, specify the new authentication settings.
12. Click **OK** to close the **Document Vault - Microsoft SQL Server** dialog and then click **OK** to close the **Document Vault Properties** dialog.
13. In the left-side tree view, right-click the document vault and select **Operations > Bring Online** from the context menu.

From this point forward, the M-Files server will access the vault database from the new Microsoft SQL Server.

After migrating the vault database to the new Microsoft SQL Server, you need to create a backup job for the new database in Microsoft SQL Server Management Studio on the new Microsoft SQL Server. For more details and recommendations, see **M-Files Backup Policy**.

**Taking a Vault Offline and Bringing a Vault Online**

When you take a document vault offline, M-Files closes the vault. This also closes any open sessions that users may have. Users cannot log in to a document vault that has been taken offline until the vault has been brought back online.
Figure 91: When a vault is taken offline, all vault users are disconnected. If a user checks out a document for editing and makes modifications to the content, during which the vault administrator takes the vault offline, the user is unable to check in the document until the vault is brought back online. It is therefore not recommended to carry out unscheduled operations that require the vault to be taken offline.

**Vault offline**

Taking a Vault Offline

To take a vault offline:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. Still in the left-side tree view, right-click a vault which is in the online state.
4. Select **Operations > Take Offline**.

Bringing a Vault Online

To bring a vault online:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. Still in the left-side tree view, right-click a vault which is in the offline state.
4. Select **Operations > Bring Online**.
Logging in to and out of a Vault in M-Files Admin

To log out of a vault on the server level, select the vault via the left-side tree view in M-Files Admin, and then select Action > Log Out from the menu bar.

When you have logged out from the document vault, the name of this function changes to Log In, allowing you to log back in.

Vault Maintenance

Regular vault maintenance ensures high performance even with vaults containing a large number of objects. The Maintenance submenu for a vault in M-Files Admin contains functions for verifying and optimizing the integrity of the internal database structure as well as for rebuilding the full-text search index and for resetting thumbnail images in the vault. In addition, it is important to regularly verify the integrity of your vault and master database backups.

Optimize Database

The Optimize Database (Thorough) operation attempts to improve the performance of the vault database by defragmenting indexes, updating database statistics, and compressing the full-text search index.

M-Files automatically runs the Optimize Database (Thorough) operation once a week, so you do not normally need to do this yourself at all. If the vault is, however, responding more slowly than usual, you may want to try running the operation. This may happen, for instance, after a large number of objects has been imported to the vault (for instance if the number of objects in a vault using Firebird as the database engine quickly increases from 0 to 10,000 objects).

The operation can be run in the Quick mode first, but we recommend using the Thorough mode in most cases.

The following tasks are performed when you run the Optimize Database (Thorough) maintenance operation:

1. taking the vault offline (only for vaults that use Firebird as the database engine)
2. rebuilding metadata indexes
3. recalculating relevance scores for objects
4. cleaning out unused access control lists
5. clearing the change logs of object types
6. upgrading the vault database for improving performance
7. backing up metadata (only for vaults that use Firebird as the database engine)
8. restoring metadata (only for vaults that use Firebird as the database engine)
9. rebuilding database indexes
10. updating the statistics for database objects
11. compressing the full-text search index
12. finalizing the operation
13. bringing the vault online (only for vaults that use Firebird as the database engine)

For Optimize Database (Quick), the following tasks are performed when the operation is run:

1. rebuilding metadata indexes
2. recalculating relevance scores for objects
3. clearing the change logs of object types
4. updating the statistics for database objects
Update encryption status of existing files

Depending on the state of the setting **Enable encryption for file data at rest** in the **Document Vault Advanced Properties**, the **Update encryption status of existing files** does one of the following:

- If the **Enable encryption for file data at rest** has been enabled, all the files in the vault previously not encrypted are now encrypted as well.
- If the **Enable encryption for file data at rest** has been disabled, the encryption of all the encrypted files in the vault is removed.

**Rebuild Full-text Search Index**

This operation completely rebuilds the full-text search index, and may take up an extensive amount of time in large repositories. For instance, in vaults with tens of gigabytes of data, the operation may take several days.

We recommend running this operation if you think the search index might be corrupted or if the search operations are more sluggish than usual. In large repositories, especially if the objects get modified a lot, we recommend running this operation twice per year.

Note: Normally, the operation disables search functions in the vault. See the knowledge base document **Rebuilding the dtSearch Full-Text Search Index** for instructions on how to perform the rebuild process without having to disable search functions for the duration of the operation.

**Reset Thumbnail Images**

You can reset the thumbnail image cache for the vault if you are using the thumbnail view in M-Files Desktop and if the images are not working correctly. This might happen, for instance, after installing a software capable of displaying thumbnails that could not previously be shown.

**Verify and Repair**

This operation can be used for verifying that the database is intact and that all the data has been saved correctly to M-Files. The **Thorough** mode additionally checks whether file checksums of the physical files in the vault file data location match those reported by the metadata database.

If errors are found, some of them can be repaired automatically by M-Files, but some errors might need additional user actions. If you have errors that cannot be resolved automatically, and that you cannot fix yourself, please contact our customer support at support@m-files.com.

We recommend running the **Verify and Repair (Thorough)** operation twice per year.

The following tasks are performed when you run the **Verify and Repair** maintenance operation:

1. verifying vault information
2. verifying special records
3. verifying data file records
4. verifying physical data files
5. verifying file records
6. verifying file link records
7. verifying object versions
8. verifying object properties (general integrity checks)
9. verifying object properties (detailed integrity checks)
10. finalizing the operation
The steps that are carried out during the **Verify and Repair (Thorough)** and **Verify and Repair (Quick)** operations are the same, with the exception that during the verification of physical data files (step 4) for **Verify and Repair (Thorough)**, file checksums are calculated and compared against the checksums recorded in the metadata database.

### Maintenance recommendations

Here is a short roundup of the recommended maintenance operations:

- The **Optimize Database** operation does not need to be run regularly. It is automatically taken care of by M-Files.
- The **Rebuild Full-text Search Index** operation should be run twice a year for large repositories (with hundreds of thousands of objects and hundreds of gigabytes of data).
- The **Reset Thumbnail Images** operation only needs to be used if the thumbnail images are not working correctly.
- The **Verify and Repair (Thorough)** operation should be run twice a year for all repositories.
- The integrity of your vault and master database backups should be verified two to four times a year, at minimum. If the embedded Firebird SQL database is used, see [Backing Up a Document Vault](#), [Restoring a Document Vault](#), and [Backing Up the Master Database](#). If Microsoft SQL Server is used, refer to the documentation of the backup tools you are using for creating the backups. Additionally, see [M-Files Backup Policy](#) for further guidelines and best practices related to backups.

### Languages and Translations

The language of the M-Files user interface depends on three factors:

- M-Files software language
- Vault language
- Windows display language

You can switch to using any of the software languages easily via the language setting as described further below. For instructions on how to translate the vault metadata structure to the language of your choice, see section [Translating the metadata structure](#).

Changing the Windows display language depends on your Windows version. For instance in Windows 10, you can change the display language via **Control Panel > Language**.

**Note:** M-Files Web has different requirements for a fully localized user experience. See [this note](#) for more information.

### Changing the software language

M-Files software can be used in several different languages. Changing the language is easy and the change can also be done during use. You can open the **Change Language** dialog by clicking on the M-Files icon on the Windows notification area and by selecting **Settings > Change Language**. M-Files software offers these languages automatically.

If, for example, English is selected as the software language, the following options are displayed in English: **Check Out**, **Check In** and **Workflow**. If Finnish were to be chosen, the same options would be shown in Finnish: **Varaa muokattavaksi**, **Palauta muokkauksesta** and **Työnkulku**.

Additional language versions to those currently supported are available by separate agreement with M-Files.
Translating the metadata structure

The document vault metadata structure can be translated into different languages. The document vault metadata structure refers to the vault's object types, classes, property definitions, value lists, workflows, and so on. The document class titles, such as Proposal, Order and Contract, can be translated into the desired languages.

The company can translate the metadata structure independently or have it translated by a third party. Managing the translation material is easy: the administrator can export the translation material in the XML file format. The material can then either be translated in-house or by a professional translation agency. The actual translation process is not dependent on M-Files Admin or its permissions.

Translating the metadata structure can be particularly beneficial for companies with operations in more than one country, or companies with more than one in-house language. This enables users to add documents and other objects using the metadata structure in their own language. The multilingual metadata structure can also be useful if the company uses several languages for other than geographical reasons.

See Multilingual Metadata Structures for further information on how to create a localized version of the metadata structure of your vault.

Tip: When translatable object titles are enabled, objects can have multilingual names. The translated object titles can be used in searches and they are displayed instead of Name or Title property on the title area of the metadata card, listing area as well as in notifications and value lists when a specific vault language is selected.

Different language for software and metadata structure

Besides the M-Files functions, metadata specific to document vaults can be selected and edited in a user-specified language if the metadata structure has also been translated. If the metadata structure has not been translated into the relevant language(s), for instance, from Finnish to English, it can be difficult for the user to understand why some information is displayed in Finnish and some in English. Only users with administrator rights can view and edit the actual content of the metadata structure.

For example, the class Proposal, object type Customer and property definition Document date belong to the metadata structure. If the user has selected Finnish as the software language but the metadata structure has not been translated into Finnish, the user will see these options in English only because they have been added to the metadata structure and titled in English.

Thus, for instance, when creating a new document, some metadata card information will be displayed in Finnish (Lisää ominaisuus, Aava muokattavaksi and Luo) and some in English (Proposal, Customer and Project). This is because some of the texts, such as Luo, are part of the M-Files software that has been already translated into Finnish but the Proposal concept in the metadata structure has not yet been translated.
In this chapter

- Multilingual Metadata Structures
- Selecting the Software and Vault Language
- Enabling Translatable Object Titles

Multilingual Metadata Structures

The metadata structure is always specific to the document vault and the vault can have a multilingual metadata structure. For example, the following elements of the metadata structure can be translated:
• names of classes and class groups
• names of object types
• names and values of value lists (for instance meeting types)
• names of property definitions
• names of user groups and named access control lists
• names of workflows and their states
• names of views

The default setting for value lists is that the contents of the value list are not translated. If you want to translate the contents of the value list, meaning the actual values, complete the following steps:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Metadata Structure (Flat View) and then select Value Lists.
   - The Value Lists list is opened in the right pane.
5. Double-click the value list that you want to edit.
   - The Value List Properties dialog is opened.
6. Open the Advanced tab.
7. Enable the option The contents of this value list can be translated.
8. Click OK to close the Value List Properties dialog.

The contents of the selected value list can now be translated.

In this chapter

• Translating the Metadata Structure

Translating the Metadata Structure

Using the Languages and Translations dialog, you can export the translatable content of the metadata structure and translate the exported structure in Excel, Word, or a professional translation program, such as SDL Trados or SDL Passolo.

To translate the metadata structure of the vault, follow the steps provided below.

First, you need to open the Languages and Translations dialog.

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. Select the desired vault.
4. Open the **Action** menu and select **Languages and Translations**.

   The **Languages and Translations** dialog for the selected vault is displayed.

   ![Languages and Translations dialog](image)

   Next, add your language to the list and export the list of terms to an XML or XLIFF file.

5. Click the **Add...** button.

   The **Language** dialog is opened.

6. In the **Name** field, enter the language name.

7. Optional: In the **Code** field, enter a code of your choice for the language.

   This can be, for instance, an ISO 639-1 code.

8. Click **OK** to close the **Language** dialog.

9. Select the newly added language from the list.

10. Click the **Export...** button.

   The **Export Strings** dialog is opened.

11. Define the settings for your language export.

    For more information, see **Adding and Exporting Languages**.
12. Define the location for your export file and click **Save**.

   ✔ The export file is saved as an XML or XLIFF file to the location you specified.

Once the export has completed, you can start working on the actual translation.

13. Open the exported file in the software of your choice and add the translations.

   ✔ For instructions on completing the process with Microsoft Excel, see Translating in Microsoft Excel.

The final step is to import the completed translation back to M-Files.

14. Return to M-Files Admin and repeat the steps from 2 to 4 to open the **Languages and Translations** dialog.

15. Click the **Import...** button.

16. Select the target language and click **Open**.

17. Select whether you want to import all strings or just the ones that have been marked as translated.

   ✔ For more information, see Importing Translations.

18. Click **OK**.

19. Once the import is complete, click **Close** to close the **Languages and Translations** dialog.

Translations for the newly added language have been imported to M-Files and you can select the vault language in M-Files Desktop.

In this chapter

- Adding and Exporting Languages
- Translating in Microsoft Excel
- Importing Translations

Adding and Exporting Languages

The **Export** function of the **Languages and Translations** dialog can be used to specify the target language of the translation and the format of the material to be translated:
Languages

Select the source and target languages. Note that you can translate the metadata structure only one language at a time.

If you are working in Excel, both the source and target language need to be exported. The source language character strings, that is, the words to translate, are in their specific column and the target language translations are added to a column of their own.

You can also export the source language only. If you are using a translation agency or separate translation software for translating, you should determine the required format for the translation material.

Strings

When commencing the translation process for the first time, select Export all strings. A string refers to one concept or a specific attribute in the metadata structure, thus usually, a word or a phrase. Each language has its own strings, that is, a specific vocabulary for the metadata structure.
You can later use the *Export only strings that have not been marked as translated* option to export the new or changed strings only.

**File format**

The available file formats are *Simple XML* and *XLIFF*.

Select *Simple XML*, if you want to translate the strings in Microsoft Word or Excel. Select XLIFF, if you want to use a professional translation tool, such as SDL Trados or SDL Passolo.

Translating in Microsoft Excel

Translating the metadata structure into the target language in Excel is quite straightforward. Simply open the XML file in Excel: choose the default settings *As an XML table* and *Excel will create a schema based on the XML source data*.

**Identifier** is the identifier of the concept, meaning the word or phrase to be translated. For example, an identifier starting with *PropertyDef* indicates that it is a property definition name. *ObjectType* is an object type name and *UserGroup* is a user group name. M-Files creates these identifiers automatically. The translator does not need to pay much attention to these identifiers as such, although they can be helpful pointers when choosing a suitable translation. For a closer look at how the identifiers are named, see *Naming convention of the identifiers*.

The **Source** column contains the concepts to be translated. The **Target** column is empty. The translator enters the translations in this column.

![Figure 94: The exported XML table opened in Excel for translation.](image)
In the above example, a translation from English to the target language has been started. The translation for each source language string is to be placed in the *target* column. When the translation has been added, the 0 in the *translated* column should be replaced with 1. This tells M-Files that the strings has been translated.

**Naming convention of the identifiers**

The identifiers are formed as follows: `TableID_ResourceID1_ResourceID2_StringID`.

- **Table ID**: Identifies the type of the metadata structure element in question.
  - PropertyDef
  - ObjectType
  - Item (referring to any translatable value list item)
  - NamedACL
  - View
  - Language
- **Record ID 1**: The ID number of the metadata element in question. For instance, the `Document` object type has the identifier `ObjectType_0_0_Name`, where `ObjectType` is the table ID and the first 0 is the record ID 1. The record ID 2 is always 0 for elements other than `Item`.
- **Record ID 2**: The ID number of the item in question. For example, the workflow `Processing job applications` in the M-Files sample vault has the identifier `Item_7_105_Name`, where `Item` is the table ID, 7 the record ID 1, and 105 the record ID 2 identifying the item on the `Workflows` value list.
- **String ID** (`Name` or `NamePlural`): The part of the identifier that specifies whether the translation should be in the singular or plural form.

**Importing Translations**

When translating in Microsoft Excel, the string can be marked as translated by changing the cell value of the *translated* column from 0 to 1. However, if the *Import all strings* option is selected when re-importing the translation back to M-Files, all strings are imported to M-Files regardless of whether the value of the *translated* column.

**Note**: If the *target* column is left empty and the value of the *translated* column is set to 1, M-Files uses the source language string as the translation.

If you only want to import the strings marked as translated, select the *Import only strings that have been marked as translated* option. This way, only the strings with the value 1 in the *translated* column are imported to M-Files. For example, if new additions are made to the source language at a later stage, this selection can be used to import only the translations of the new additions to M-Files.

If changes are made in the source language, this version data can be found in the *source-version* column of the exported XML file: when changes are made to the source language string, the value of this string cell is always increased by one. The target language translation must then be checked and changed to correspond to the change in the source language.

Also, if the values of the translated strings in the *translated* column have previously been changed to 1, they will be reset to 0 if changes are made to the source language of these strings. For this reason, it is recommended to instruct the translator to mark the translated and accepted translations as translated, after which the value 1 indicates that the target language translations are up to date.

To import the translation back to M-Files from Microsoft Excel, save the translated XML file in Microsoft Excel in *XML Data* format. You can then import the file to M-Files using the *Import* function of the *Languages and Translations* dialog. It is alright for the file to have different name when importing and exporting.
Importing a translation to M-Files is quite straightforward. Just select the appropriate target language and whether you want to import all the strings or just the ones marked as translated.

After importing, M-Files asks if you want to rebuild the full-text search index for the metadata. Edited translations cannot be used in searches until the search index is rebuilt. This may take several minutes or even hours depending on the number of objects in the document vault.

Selecting the Software and Vault Language

Users can change both the software language and vault language via M-Files Desktop. The software language refers to the texts and labels that you see in the M-Files user interface, such as button texts, dialog titles, warning messages, and so on. The vault language refers to the metadata structure language, which is always specific to a given document vault.

Do the following steps to change the software and the vault language:

1. In M-Files Desktop, press Alt and select Settings > Change Language... from the menu bar.

   The Change Language dialog is opened.

2. Use the Software language drop-down menu to change the language of the M-Files user interface.

3. Use the Vault language drop-down menu to change the language of the current vault.

   The vault language selection contains all languages that the document vault has been translated into.

4. Click OK to change the languages and to close the Change Language dialog.

The M-Files user interface language and the current vault language are changed accordingly.

If 1) the software installation language, 2) the vault language, and 3) the Windows display language are the same, all the M-Files functions and the metadata structure of the document vault are displayed in the language in question.

Note: If you want to create a new vault in a language other than the currently selected software language, you must first change the software language and restart the M-Files Server service via Windows Task Manager before creating the vault.

Note: If the user adds a new value to the value list, the new value (concept) will be added to the original metadata structure, that is, the source language contents, regardless of the user’s vault language. For example, a user with Finnish as the vault language, can add a new value LVI-piirustus to the value list Drawing Types/Piirustustyypit. If the source language was English, the new Finnish value "LVI-piirustus" is displayed among the English values: "Architectural, LVI-piirustus, Mechanical, Services", and so on. The name of this value can be changed in Value List Properties to correspond the source language, after which it can be re-translated into Finnish. Common views can be named in the same way according to the text added by the user, regardless of the source language.

Note: If the metadata structure is translated into several languages, the software or the vault language selected by the user does not affect the search results. For example, if the user has selected Finnish as the language and added a document to class Hinnasto, the document in question is included in the search results when using the search criterion Price List. However, then the concepts Price List and Hinnasto must be translations of each other, that is, different translations of the same concept.
Changing the User-Specific Default Vault Language

Administrators can also change the default language of a vault for a specific user. The selected default language can be any of the vault languages. If neither the user nor the administrator changes the vault language, M-Files will use the vault source language as the default.

Do the following steps to change the default vault language for a specific user:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Users.
   - The Users list is opened in the right-side pane.
5. Right-click the user whose default vault language you want to change and select Properties from the context menu.
   - The User Properties dialog is opened.
6. Use the Vault language drop-down menu to change the default vault language for the selected user.
7. Click OK to save your changes and to close the User Properties dialog.

The default language in the selected vault is changed for the selected user.

Enabling Translatable Object Titles

To use translatable object titles, you need to have the desired languages added as vault languages in the Languages and Translations dialog. However, it is not required that the metadata structure is translated into those languages.

**Note:** This feature is not supported in the M-Files add-ins such as M-Files Add-in for Teams and SharePoint Online.

The translatable object title configuration allows you to give objects titles in different languages. When an object has multilingual titles, the translated names can be used as search criteria. You can search for and find documents and other objects in your own language regardless of the original object’s language. The language version that matches the Vault language in the Change Language dialog is used on the title area of the metadata card, listing area as well as in notifications and value lists.

To enable translatable object titles, do the following steps:

1. Check that the desired languages with language codes are listed in the Languages and Translations dialog.
   - If a language or a code is missing from the list, add it according to the instructions in Translating the Metadata Structure. Note down of the language codes.
2. Open M-Files Admin and access the document vault of your choice.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

3. Still in the left-side tree view, expand Metadata Structure (Flat View), and then select Property Definitions.
   - The Property Definitions dialog is opened.

4. Click New Property Definition... on the task area to create property definitions for the desired object title languages.
   - Note: The data type of the property definitions must be Text.

   For instructions on creating property definitions, see Creating a New Property Definition.

   If you want to allow adding a Finnish title for an object, you can create a property definition called Title in Finnish.

5. Select Configurations and expand Advanced Vault Settings.

6. Expand the Configuration node and select Translatable Object Titles.

7. Specify the settings according to the information in the following table.

<table>
<thead>
<tr>
<th>Setting name</th>
<th>Description</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object Types Using Translated Titles</td>
<td>Specify the object types that can use translated title properties.</td>
<td>Document</td>
</tr>
</tbody>
</table>
| Translated Title Properties      | Specify the property definitions that are used as an alternative language title, each with their corresponding language code. Use the language codes noted down from the Languages and Translations dialog. | Language Code: fi
|                                  | Title Property: Title in Finnish                                           |                                      |

8. Click Save.

Now you are ready to enter translated titles for objects of the specified object type. After you have added the properties to the metadata of an object and entered the translated names, the title is shown according to the selected vault language on the title area of the metadata card, listing area as well as in notifications and value lists. Translated object titles do not affect pinned shortcuts or notifications sent to unknown or multiple recipients.
Notes: After you have saved the changes and M-Files Server has been restarted, end users must log out from and log back in to the vault to be able to use translatable object titles. You can log out all vault users by restarting the vault, but taking a vault offline should always be done in a controlled manner and the vault users should be notified beforehand.

Tip: You can use metadata card configuration rules to show the translated object titles after the actual Name or title property.

Connections to External Sources

M-Files offers flexible approaches for information presentation and transfer also from external sources. Databases, for example, are required to support OLE DB or Open Database Connectivity (ODBC) connections. The type of a database connection can be either read-only or two-way. With a read-only connection, M-Files is reading from an external database, such as a customer database, but you are not allowed to enter new data via M-Files. With a two-way connection, changes and additions made in M-Files are saved in the external database.

A good example of an external database connection is a connection between M-Files and an external customer database. Many organizations already have a vast database of customer information, consisting of tables populated with customer information. When the user creates a new offer document in M-Files, it makes sense to add the existing customer information to it. M-Files can be set to import customer information from an external database. The information can then be accessed directly from, for example, the metadata card when a new document is created.

You can also import and link existing files from external objects. This makes deploying M-Files easy and quick, since all existing files can be accessed via M-Files without a separate transfer process. When you access files via M-Files, it makes sense to enrich them with metadata at the same time. Furthermore, among other things, version history is created in M-Files; concurrent editing is avoided; and, thanks to M-Files scheduled jobs, backups are easy to manage. Adding metadata also enables you to better take advantage of the search capabilities of M-Files.
In this chapter

- External File Sources
- Scanner Sources
- Mail Sources

External File Sources

By using connections to external sources, you can import or link files from external file sources to M-Files and significantly speed up the launch of M-Files. You can, for example, create a link between an existing network drive and M-Files, which makes it possible to modify files both in M-Files and externally to M-Files, using the network drive.

You can also import files from an external source. Importing involves copying the files to M-Files. This means that modifying imported files to M-Files does not affect the original files.

You can also use this function to create a link between M-Files and, for example, a scanner. The M-Files server can be set to import new files from a source folder where scanned documents are saved. For more information, refer to Scanner Sources.

In this chapter

- Creating a New Connection to an External Source
- Defining Metadata for an External File Source
- Searchable PDF
- Deleting a Connection to an External Source

Creating a New Connection to an External Source

Before you begin, you might want to look at this remark if you are planning on using the Link files option and preserving the original files in the external location.

Follow these instructions to define a new connection to an external source.

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Connections to External Sources and then select File Sources.
5. Click New File Source... on the task area to start creating a new connection to an external source.

   - The Connection Properties dialog is opened.
6. In the **Description** field, provide a description for the new connection. You can, for example, describe the external source for which this connection is used.

7. In the **Path from the server** field, enter the path to the external location that you wish to connect to M-Files. The location can be, for example, a network drive of a scanner.

   - **The path must be specified from the point of view of the M-Files server.**
8. Optional: Check the **Include subfolders** check box if you wish to include in the connection the entire folder structure of the specified path.

9. Click **Set Account**... to specify an account in M-Files to be used for processing files from the external location.
   - By default, M-Files uses the server identity (Local System account) as the account.

10. Optional: Click **Filters**... to define the files to be processed.
    a) In the **Include files that match any of the following filters** field, enter the filter or filters for the files that are to be included via this connection.
    b) In the **Exclude files that match any of the following filters field**, enter the filter or filter for the files that are to be excluded from this connection.
   - By default, all files are included except for BAK and TMP files.
   - You may use wildcards to define a filter (for example, *. * or *. docx). Multiple filters are separated with semicolons (;).

11. Select either:
    a. **Link files**: Select this option if you wish to modify the files of the external source both in M-Files and externally. Modifications made in M-Files are also visible to external users, and modifications made outside M-Files are visible in M-Files.
       - **Note**: M-Files will store a version history of the linked documents, so that all versions modified in M-Files, as well as every first preceding version modified outside M-Files before a new version is created in M-Files, will be available for future use.
       - **Important**: If the M-Files user group *All internal users* or *All internal and external users* does not have edit access to a linked document, the document is deleted from the external file source when it is added to M-Files. If this happens, you can at any time copy the file back to the external location simply by adding edit access to either the *All internal users* or *All internal and external users* user group (see Object Permissions).

       This behavior can be prevented with a registry setting. For instructions, see Preventing Linked Documents from Being Removed.

    or

    b. **Import files**: Select this option if you want the files of the external source to be copied to M-Files. Modifying imported documents in M-Files will not have an effect on the original files.

       You may also check the **Delete source file after importing** check box if you want the source files to be deleted after they have been imported to M-Files. This option may be useful, for example, when importing scanned documents to M-Files.

12. Optional: Select the **Preserve folder structure** check box and in the **Target folder** field, enter a target folder for the external files if you wish to preserve the original folder structure of the external source in M-Files using traditional folders.
   - You may click the ► (right-pointing triangle) icon to refresh the list of traditional folders or to add a new traditional folder to the vault.

13. Optional: Select the **Check for new and deleted files periodically** check box if you want M-Files to automatically check the source folder at predefined intervals and update itself according to which files
and folders are new and which have been deleted. Enabling this option makes any changes in the source folder automatically visible in M-Files as well.

a) In the Delay between checks field, enter the interval in seconds between the automatic source folder checks to define how frequently you want M-Files to check the changes made to the source folder.

14. Optional: You may click Refresh Now to connect to the external source immediately.

- Click Refreshing Status... to display additional information about the process of refreshing the external source.

15. Optional: On the Metadata tab, define the metadata to be added for externally created objects.

- For more information, see Defining Metadata for an External File Source.

16. Optional: On the Advanced tab, you can specify an alias for the new connection.

- For more information, see Associating the Metadata Definitions.

  When you have automatic aliases in use and you write a name on the General tab, the Aliases field on the Advanced tab is automatically filled in. The alias has the format \textit{<predefined prefix>.<name>}. Define automatic aliases for your vault in the configurations editor.

17. Click OK.

The new connection to an external source is created and added to the File Sources list. Files are added from the external source to M-Files on the basis of the settings you have defined for the connection.

Defining Metadata for an External File Source

Follow these steps to define automatic metadata for externally created documents.

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand Connections to External Sources and then select File Sources.

5. On the File Sources list, double-click the file source that you want to edit.

- The Connection Properties dialog is opened.
6. Click the **Metadata** tab.

✔ The **Metadata** tab is opened.
7. Using the **Object type** drop-down menu, select the object type that the external objects get when they are imported or linked to M-Files.

8. Click **Add...** to define a new property and value to be added automatically for objects created from external files, or select one of the existing properties and click **Edit...** to edit it.

The **Define Property** dialog is opened.
9. Use the Property drop-down menu to select the property for which you want to define a value.

10. In the Define Property dialog, select one of the following options:

   a. Use a fixed value: Use this option to specify a fixed property value.

   or

   b. Read from an XML file produced by HP DSS: Use this option if you want to obtain a property value from user-provided metadata when a document is scanned and OCR'd using HP DSS.

   or

   c. Read from an XML file: Use this option to read a property value from an XML file using an XPath expression. The name of the XML file must match the name of the file to be imported. For instance, when the name of the file is filename.txt, the XML file must be named filename.xml.

For example, say you have the following XML file:

```xml
<?xml version="1.0" encoding="UTF-8"?>
<document>
    <name>The name of the document</name>
    <keywords>Keywords in an XML file</keywords>
</document>
```
Now, to use the text inside the \texttt{keywords} element in the XML file as the value for the selected property, you would enter \texttt{document/keywords} in the \textit{Read from an XML file} field, and thus you would get \textit{Keywords in an XML file} as the property value. The string \texttt{document/keywords} is a simple XPath expression that selects all \texttt{keywords} elements that are children of the \texttt{document} element.

XPath is a W3C standard syntax for defining locations in an XML document. For detailed information on XPath syntax, see the \textit{W3Schools XPath Tutorial}.

\textbf{Note:} If the XML file uses \textit{namespaces}, you need to take them into account in the XPath expression. You can use the namespace prefixes in the expression. Note that the default namespace, however, has no prefix. Selecting from the default namespace is possible, for instance, by using the \texttt{namespace-uri()} or the \texttt{local-name()} XPath function, or both, in the expression. Multiple namespaces with the same prefix are not supported.

For example:

\begin{verbatim}
mynamespace:document/keywords
\end{verbatim}

or

\begin{verbatim}
\end{verbatim}

or

d. \textbf{Use an OCR value source:} Click \textit{Define...} to define a zone in a scanned document from which to capture the property value. For detailed instructions, see \textit{Defining an OCR Value Source}.

or

e. \textbf{Read from the properties of the imported file:} Use this option to populate the property value with a Microsoft Windows file property value. Use the \textit{File property} drop-down menu to select the appropriate file property. The accepted data types for the file properties are as follows:

- \textbf{Name:} Text, Text (multi-line)
- \textbf{Directory:} Text, Text (multi-line)
- \textbf{Extension:} Text, Text (multi-line), Choose from list
- \textbf{Created at:} Timestamp
- \textbf{Last modified:} Timestamp
- \textbf{Last accessed:} Timestamp
- \textbf{Read-only:} Boolean (yes/no)
- \textbf{Hidden:} Boolean (yes/no)
- \textbf{Archive:} Boolean (yes/no)

11. If the selected property is of the \textbf{Choose from list} data type, and you chose \textit{Read from an XML file produced by HP DSS}, \textit{Read from an XML file} or \textit{Use an OCR value source} in the previous step, in the \textit{Conversion to value list item} section, select either:

a. \textbf{Use the value read as the ID of the item:} Select this option if you want to use the captured value as an identifier of the value list item with a separately defined name.
b. **Use the value read as the name of the item**: Select this option if you want to use the captured value as the name of the value list item. You can check the **Add a new item to the list if a matching item is not found** check box if you want to add a new value list item whenever a new value is captured.

12. Click **OK** to close the **Define Property** dialog.

13. Use the **Permissions** drop-down menu to set the permissions for new objects created via the external source.

   You can click the **...** button to refine the permission settings.

14. Optional: Check the **Read values from an XML file** check box if you want property values to be read from an XML file. Check also the **Delete the XML file after use** check box if you want the XML file to be deleted after the metadata has been read.

   The name of the XML file must match the name of the file to be imported. For instance, when the name of the file is `filename.txt`, the XML file must be named `filename.xml`. The supported XML formats are:

   - Regular XML data
   - XML data output by HP Digital Sending Software (DSS)

15. Click **OK** to finish defining the metadata.

The metadata that you have just specified is assigned to any new object created via this external source.

**In this chapter**

- Defining an OCR Value Source

**Defining an OCR Value Source**

You can extract text or barcodes from a scanned document using optical character recognition (OCR) and use them as automatic property values for files imported from an external source, a scanner in this case. The OCR value source is a zone defined on a scanned page. For more information on defining different properties for objects imported from external file sources, see [Defining Metadata for an External File Source](#).

Optical character recognition can be performed on the following file formats:

- TIF
- TIFF
- JPG
- JPEG
- BMP
- PNG
- PDF

TIFF files using an alpha channel or JPEG compression are not supported.

The use of an OCR value source is only possible when using an external source. The OCR value source cannot be defined in M-Files Desktop.
Note: The M-Files OCR module is an M-Files add-on product available for extra fee. It can be activated with a license code. For more information, see Enabling the M-Files OCR Module and Managing Server Licenses. M-Files uses an OCR engine offered by IRIS. For the M-Files OCR module purchase inquiries, please contact our sales team at sales@m-files.com.

Note: You can use the OCR value source without enabling the Use OCR to enable full-text search of scanned documents option in the Searchable PDF tab.

Do the following steps to define an OCR value source:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Connections to External Sources and then select File Sources.
5. On the File Sources list, double-click the file source that you want to edit.

The Connection Properties dialog is opened.
6. Click the Metadata tab.

✓ The Metadata tab is opened.
7. Click **Add...** to define a new property and value to be added automatically for objects created from external files, or select one of the existing properties and click **Edit...** to edit the existing property.

The **Define Property** dialog is opened.
8. Select the option **Use an OCR value source** and click the **Define...** button.

The **OCR Value Source Definition** dialog is opened.
9. In the **Zone type** section, select either:

a. **Text**: Select this option if the OCR zone contains text.

or

b. **Barcode**: Select this option if the OCR zone contains a barcode.

**Note**: For the supported barcode types, see [Supported Barcode Types](#).
10. In the **Zone position** section, define a zone from which to extract a value for the selected property. The characters may include any letters, numbers or punctuation marks. For example, an invoice number shown on a page can be added as the *Invoice number* property value for the scanned document.

An example of a zone definition:

If you are capturing a barcode and there is only one barcode to recognize on the page, you can specify the whole page as the zone. If there are several barcodes, restrict the zone in such a way that it contains the desired barcode only. With QR codes, you should specify a zone larger than the actual barcode. If the specified zone has several barcodes, all of them are considered to be a property value.

a) In the *Page* field, enter the page number of the scanned document that you want to use as the OCR value source.

b) Using the *Unit* options, select the appropriate unit for defining the zone position.

c) In the *Left* field, enter the left corner position of the OCR zone. The left corner of the scanned document is considered "0".

d) In the *Right* field, enter the right corner position of the OCR zone.

e) In the *Top* field, enter the top corner position of the OCR zone. The top corner of the scanned document is considered "0".

f) In the *Bottom* field, enter the bottom corner position of the OCR zone.

11. Using the **Primary language** and **Secondary language** drop-down menus, select the primary and secondary language of the documents scanned via this external connection to improve the quality of the recognition results. The list of secondary languages only contains languages that are allowed to be used with the selected primary language.

Although the OCR automatically recognizes all Western languages and Cyrillic character sets, specifying a language selection often improves the quality of the text recognition results. In ambiguous cases, a problematic recognition result may be resolved by a language-specific
factor, such as recognition of the letter ‘Ä’ in Finnish. The list of secondary languages only includes languages that are allowed to be used together with the selected primary language.

12. Click OK to close the OCR Value Source Definition dialog.

13. Back in the Define Property dialog, select either:

   a. **Use the value read as the ID of the item**: Select this option if you want to use the captured value as an identifier of the value list item with a separately defined name.

   or

   b. **Use the value read as the name of the item**: Select this option if you want to use the captured value as the name of the value list item. You can check the **Add a new item to the list if a matching item is not found** check box if you want to add a new value list item whenever a new value is captured.

14. Click OK to close the Define Property dialog.

The zone you have just defined is used to automatically extract a value for the selected property using OCR whenever a new object is created via the selected external file source.

To ensure that the defined zone is correctly positioned, in most cases the document to be scanned should be placed onto the scanner glass by hand rather than fed via an automatic sheet feeder.

In some cases, the OCR may give an incorrect recognition result of the text: for example, depending on the font type or size, the number 1 may be interpreted as the letter l. To ensure that the characters are added correctly to the document metadata, you can check the property values with event handlers and VBScript. You can then use VBScript to check, for example, that all added characters are numbers. For more information, see Event Handlers.

Supported Barcode Types

The M-Files OCR module supports the following barcode types:

- QR Code
- EAN-13
- EAN-8
- EAN-5
- EAN-2
- MSI Plessley
- MSI Pharma
- UPC-A
- UPC-E
- Codabar
- Interleaved 2 of 5
- Discrete 2 of 5
- Code 39
- Code 39 Extended
- Code 39 HIBC
- Code 93
- Code 128
- PDF 417
- Postnet
- Postnet 32
M-Files can convert images imported from external file sources into searchable PDFs using optical character recognition (OCR). This makes full-text search of scanned documents possible. After conversion, you can find the PDF document by searching the actual document content.

Optical character recognition can be performed on the following file formats:

- TIF
- TIFF
- JPG
- JPEG
- BMP
- PNG
- PDF

TIFF files using an alpha channel or JPEG compression are not supported.

Note: Converting the file to a searchable PDF does not affect the outward appearance of the document when viewing it. The users still see the original scanned image. M-Files stores the automatic text recognition results in the PDF as invisible text, which is used when searching the file. Possible text recognition inaccuracies will not affect the appearance of the scanned document in any way when viewed on screen or printed.

Note: The M-Files OCR module is an M-Files add-on product available for extra fee. It can be activated with a license code. For more information, see Enabling the M-Files OCR Module and Managing Server Licenses. M-Files uses an OCR engine offered by IRIS. For the M-Files OCR module purchase inquiries, please contact our sales team at sales@m-files.com.

Do the following steps to convert images from an external file source into searchable PDFs:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Connections to External Sources and then select File Sources.
5. On the **File Sources** list, double-click the file source that you want to edit.

   The **Connection Properties** dialog is opened.

   ![Connection Properties dialog]

6. Click the **Searchable PDF** tab.

   The **Searchable PDF** tab is opened.
7. Check the **Use OCR to enable full-text search of scanned documents** check box.

8. Using the **Primary language** and **Secondary language** drop-down menus, select the primary and secondary language of the documents scanned via this external connection to improve the quality of
the recognition results. The list of secondary languages only contains languages that are allowed to be used with the selected primary language.

Although the OCR automatically recognizes all Western languages and Cyrillic character sets, specifying a language selection often improves the quality of the text recognition results. In ambiguous cases, a problematic recognition result may be resolved by a language-specific factor, such as recognition of the letter ‘Ä’ in Finnish. The list of secondary languages only includes languages that are allowed to be used together with the selected primary language.

9. Optional: Check the **Use hyper-compression to reduce PDF file size** check box if you want to reduce the file size of the searchable PDFs created via this connection.

10. Optional: Check the **Convert to PDF/A-1b format** check box if you want the converted PDF documents to comply with the ISO standard 19005-1:2005 for long-term preservation of electronic documents.

   PDF/A-1b is a more restricted format than the format of standard PDF files, so the file size of documents converted to PDF/A is often larger than that of files converted to standard PDF. In addition, by exporting to PDF/A, certain advanced appearance settings may be omitted. You should use conversion to PDF/A form only if it is particularly necessary due to, for example, the requirements for long-term preservation.

11. Click **OK** to close the **Connection Properties** dialog.

The documents scanned via this connection are converted into searchable PDFs provided that they are in the applicable file format. After they have been imported or linked to M-Files, you can find them by searching for their content.

**Note:** Text recognition can also be performed via M-Files Desktop. For more information, refer to **Scanning and Text Recognition (OCR)**. If you wish to use text recognition using external sources through the M-Files Admin only, this limitation can be set by changing the registry settings. The registry settings can be used to set other limitations as well. For more information on registry settings, contact M-Files customer support at support@m-files.com.

**Deleting a Connection to an External Source**

Complete the following steps to delete a connection to an external source:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand **Connections to External Sources** and then select **File Sources**.

5. Right-click the connection that you want to delete and select **Delete** from the context menu.

6. Click **Yes** at the prompt to confirm the deletion.
7. Optional: If the type of the connection you are about to delete is **Link**, you must choose between the following options:

![Image](image.png)

- **Import Linked Files**: The documents obtained via the connection are imported to M-Files, but the link between the documents in M-Files and the files on the file system will be disabled. When you select this option, the connection imports the files from the file source and after the import is complete, you may delete the connection. The files on the file system and the documents in M-Files will continue to live their own lives independently of each other.

  or

- **Destroy Documents**: The documents obtained via the connection are destroyed in M-Files, but the previously linked files remain on the file system. The external folder will no longer be linked to M-Files and the files previously obtained via this connection are available in the external location only.

  or

- **Cancel**: This option cancels the operation.

The selected connection is deleted and files are no longer imported or linked from the selected file system location to M-Files.

**Scanner Sources**

Via the scanner connection, it is easy to save paper documents into the document vault. This way, the M-Files search capabilities can be applied also to scanned paper documents.

When using external sources, M-Files does not communicate directly with the scanners but uses an external connection to read the file produced by the scanner from, for instance, the scanner's network drive. The connection is configured in M-Files Admin under **External File Sources**.

These connections can be made, for example, with Hewlett-Packard MFP series devices by using HP Digital Sending Software (DSS). In this case, the device is connected directly to the local area network and the user scans the paper document with the device.

It is also possible to enter metadata via the device's touchscreen. The scanned file and the metadata are sent to the DSS software performing optical character recognition (OCR) for the file. The scanned image and recognized text are combined into a PDF file. The PDF file and an XML metadata file are saved in a folder controlled by M-Files via external location configuration. On detecting new files, M-Files transfers the files to the document vault as documents with metadata.

For instructions on how to use a scanner as an external source for M-Files, see [Creating a New Connection to an External Source](#).

**Note:** Text recognition can also be performed with the M-Files OCR module. For more information, refer to [this note](#). You can also scan using a local scanner that is directly connected to your computer. For more information, refer to [Scanning and Text Recognition (OCR)](#).
Mail Sources

M-Files provides the ability to save, manage, and share important e-mail in a controlled manner. The messages can be transferred directly and automatically from the mail server to the vault.

For example, messages and their attachments sent to the organization's common e-mail box can be transferred directly to the document vault. In the document vault, imported messages can be handled in a controlled manner via, for example, workflow features. Example use cases include a centralized and controlled way for handling orders, and a systematic method for archiving sent offers. Important information can thus be managed in M-Files so that it does not get lost and forgotten in e-mail boxes.

The organization may also want to save important sent e-mail to M-Files. Such important messages could include, for instance, proposals and order confirmations. Your organization can use a designated archive e-mail account to which M-Files is connected. From this box, M-Files imports all e-mail to the document vault and then deletes the messages from the mail server. Important sent messages can be archived in M-Files by sending the message to the archive box via the Cc or Bcc fields. To avoid junk mail, it is possible to set the e-mail account to accept mail from internal users only.

Creating a New Connection to a Mail Source

Do the following steps to create a new connection to a mail source:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Connections to External Sources and then select Mail Sources.
5. Click New Mail Source... on the task area.

The Connection Properties dialog is opened.
6. In the **Description** field, enter a description for the new connection.
7. Select either:
   a. **POP3**: Use this option if the protocol for connecting to the mail server is POP3.
   
       or
   
   b. **IMAP**: Use this option if the protocol for connecting to the mail server is IMAP.

8. In the **Mail server** field, enter the network address of the mail server (the IP address or the domain name, such as *mail01.company.com*).

9. Optional: Check the **Use encrypted connection (SSL/TLS)** check box to use an encrypted connection to the mail server.

10. In the **Port number** field, enter the port number of the mail server.

11. If you selected **IMAP** as the protocol, enter the folder on the server from which mail is read and imported in the **Folder** field.

12. In the **Username** field, enter the username for connecting to the mail server in the format *user@domain* (for example, *sam@company.com*).

13. In the **Password** field, enter the password for connecting to the mail server.

14. Optional: In the **Action** section, select the appropriate options:

<table>
<thead>
<tr>
<th>Select the option...</th>
<th>If you want to...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Include attachments</strong></td>
<td>Import attachments along with e-mail messages.</td>
</tr>
<tr>
<td><strong>Import only messages that have attachments</strong></td>
<td>Import to the vault only the e-mail messages that have attachments. Messages without attachments will not be imported.</td>
</tr>
<tr>
<td><strong>Delete messages from server after importing</strong></td>
<td>Remove the messages from the mail server automatically once they have been imported to M-Files.</td>
</tr>
<tr>
<td><strong>Remove attachments from server after importing</strong></td>
<td>Remove attachments from the mail server once e-mail messages have been imported to M-Files. This option can be enabled only if the selected protocol is <strong>IMAP</strong> and the option <strong>Include attachments</strong> is enabled.</td>
</tr>
<tr>
<td><strong>Save in Outlook message format (*.msg)</strong></td>
<td>Save the e-mail messages to M-Files in the Outlook message format (<em>MSG</em>). Attachments are stored inside the <em>MSG</em> file and the messages appear in M-Files as single-file documents (see Single-File and Multi-File Documents).</td>
</tr>
</tbody>
</table>

   **Note**: This functionality requires Microsoft Exchange Server or a 32-bit MAPI client to be installed on the M-Files server.

   **Note**: If you wish to save the e-mail messages as RFC 822 compliant *EML* files, configure the following registry setting on the M-Files server computer:
Select the option... | If you want to...

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server\MFServer\Vaults&lt;version&gt;\MailSources&lt;external mail source name&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>StoreEmailInRawEmlFormat</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>Description</td>
<td>When enabled, stores new e-mail messages as EML files.</td>
</tr>
<tr>
<td>Default value</td>
<td>0 Disabled</td>
</tr>
<tr>
<td>Valid values</td>
<td>1 Enabled 0 Disabled</td>
</tr>
</tbody>
</table>

This registry setting overrides the selected storage format option.

**Separate attachments from the message**

Save attachments separately from the body of the message. This option can be enabled only if the option **Save in Outlook message format (.msg)** is enabled. The message without its attachments is saved into an MSG file, and any attachments are stored beside the MSG file in their original file formats. If the message contains attachments, the message and its attachments appear in M-Files as a multi-file document.

15. Optional: Check the **Check for new and deleted files periodically** option check box to enable M-Files to synchronize with the mail server at predefined intervals.

   a) In the **Delay between checks** field, enter the time interval in seconds between synchronizations.

16. Optional: Click **Refresh Now** to synchronize the vault with the mail server right away.

   ![Information icon] You can click **Refreshing Status...** to see the current status of the refreshing process.

17. Optional: On the **Metadata** tab you can define properties for new objects created via this connection.

   ![Information icon] For more information, see Defining Automatic Metadata for a Mail Source.

18. On the **Advanced** tab, you can set an alias for this connection.

   ![Information icon] For more information, see Associating the Metadata Definitions.

   When you have automatic aliases in use and you write a name on the **General** tab, the **Aliases** field on the **Advanced** tab is automatically filled in. The alias has the format `<predefined prefix>.<name>`. Define automatic aliases for your vault in the configurations editor.

19. Click **OK**.

Email messages are imported to M-Files from the defined mail source according to the settings specified.
Defining Automatic Metadata for a Mail Source

You can define automatic metadata for new objects created from an external mail source. You can use fixed property values or extract property values from the imported e-mail messages.

Do the following steps to define automatic metadata for objects created from an external mail source:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Connections to External Sources and then select Mail Sources.
5. On the Mail Sources list, double-click the source that you want to edit.

The Connection Properties dialog is opened.
Connection Properties - New Connection to External Source

**General**

- **Description:**
- **Source**
  - Server type: □ POP3 □ IMAP
  - Mail server: 
  - Use encrypted connection (SSL/TLS)
  - Port number: 143
  - Folder: Inbox
- **Login information**
  - Username: 
  - Password:

**Action**

- M-Files creates a document from each imported message.
- Include attachments
- Import only messages that have attachments
- Delete message from server after importing
- Remove attachments from server after importing
- Save in Outlook message format (*.msg)
- Separate attachments from the message

- Check for new and deleted files periodically
  - Delay between checks: 900 seconds
  - Refresh Now
  - Refreshing Status...
- Disabled
6. Click the **Metadata** tab.

The **Metadata** tab is opened.
7. Use the **Object type** drop-down menu to select the object type for new objects created via this connection.

8. Use the **Permissions** drop-down menu to select the permissions for new objects created via this connection.

   ![Info](image)
   You can click the **...** button to refine the permission settings.

9. In the **Properties** section, click **Add...** to add a new automatic property for objects created via this connection or select one of the existing properties and click **Edit...** to edit it.

   ![Check](image)
   The **Define Property** dialog is opened.

10. Select either:

    a. **Use a fixed value**: Use this option to add a fixed value for the selected property.

    or

    b. **Read from the e-mail message**: Use this option to extract a value from the e-mail message for the selected property.

   ![Note](image)
   **Note**: If you select the **Date** field as the source of the property value, the data type of the property must be **Time**. It is not recommended to select a property of the **Timestamp** data type for the **Date** field because **Timestamp** values are adjusted by the time zone settings on client computers.
11. If the selected property is of the Choose from list data type, in the Conversion to value list item section, select either:

   a. **Use the value read as the ID of the item**: Select this option if you want to use the extracted value as an identifier of the value list item with a separately defined name.

   or

   b. **Use the value read as the name of the item**: Select this option if you want to use the extracted value as the name of the value list item. You can check the Add a new item to the list if a matching item is not found check box if you want to add a new value list item whenever a new value is extracted.

12. Click **OK** to close the Define Property dialog.

The email messages imported to M-Files via this connection are assigned automatic properties according to the settings that you have defined.

**E-Mail Client Integration Settings**

Via E-Mail Client Integration Settings, you can specify messages to be automatically associated with contact persons and customers saved in M-Files on the basis of the sender and recipient information when they are saved to your vault in Microsoft Outlook. For an introduction to this feature, see Associating Messages with Contacts.

To open the E-Mail Client Integration Settings dialog:

1. Open M-Files Admin.
2. Select a vault in the left-side tree view.
3. Select **Action > E-Mail Client Integration Settings**.

**Contact persons**

M-Files looks for a full match with a contact person’s e-mail address. M-Files associates the message with the contact person Matt Bay if Matt Bay’s properties have exactly the same e-mail address as the message does (matt.bay@estt.com).

**Customers**

If customer information has been specified in the e-mail integration settings:

1. M-Files looks for customer matches via the contact person (the Customer object type must be the owner of the Contact person object type): M-Files associates the message with the customer ESTT if Matt Bay is the contact person for ESTT.
2. M-Files looks for similarity between the domain name in the e-mail address and the customer’s properties: M-Files associates the message with the customer ESTT on the basis of the e-mail address domain, matt.bay@estt.com or patsy.bay@estt.com if the domain estt.com can be found in the customer’s properties. The message will not be associated with any contact person in this case, unless a full match is found with the contact person information.

**Advanced Settings**

The **Advanced** tab of the E-Mail Client Integration Settings dialog allows you to further specify associations between e-mail information and M-Files metadata. M-Files automatically populates the metadata card according to the mappings defined in these settings.
Note: These settings apply only when dragging and dropping the e-mail from Microsoft Outlook to M-Files.

First, you can select a default class for all the e-mail messages that are saved to M-Files via Microsoft Outlook. Secondly, the options allow you to define an appropriate metadata property for each e-mail header field value.

For instance, if you want the information contained in the *From* field to be automatically inserted to a certain property on the metadata card of the e-mail object, select the appropriate property from the drop-down menu.

### Accepted data types

There are some limitations regarding the data types of the properties that are assigned to object metadata via the advanced e-mail client integration settings. The accepted data types are listed in the table further below. The properties must also be allowed to be used with the *Document* object type (or with all object types).

<table>
<thead>
<tr>
<th>E-mail header field</th>
<th>Accepted data types</th>
</tr>
</thead>
<tbody>
<tr>
<td>To</td>
<td>• Text (multi-line)</td>
</tr>
<tr>
<td>From</td>
<td>• Text</td>
</tr>
<tr>
<td></td>
<td>• Text (multi-line)</td>
</tr>
<tr>
<td>Cc</td>
<td>• Text (multi-line)</td>
</tr>
<tr>
<td>Subject</td>
<td>• Text</td>
</tr>
<tr>
<td></td>
<td>• Text (multi-line)</td>
</tr>
<tr>
<td>Received</td>
<td>• Timestamp</td>
</tr>
<tr>
<td>Sent</td>
<td>• Timestamp</td>
</tr>
<tr>
<td>Importance</td>
<td>• Text</td>
</tr>
<tr>
<td></td>
<td>• Text (multi-line)</td>
</tr>
<tr>
<td>Sensitivity</td>
<td>• Text</td>
</tr>
<tr>
<td></td>
<td>• Text (multi-line)</td>
</tr>
</tbody>
</table>

### Monitoring Background Tasks

M-Files Server performs various tasks for your document vault in the background. You may monitor the progress of these operations in M-Files Admin.
Background tasks are complex and time-consuming processes that are processed in the background so that they can be executed in parallel with other M-Files Server tasks without interfering or stalling other ongoing processes.

Complete the following steps to monitor background tasks in your document vault:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. In the left-side tree view, select Background Tasks.

The Background Tasks view is opened.

Tip: If the list contains a large number of items, you might want to filter it. To filter the view, open the View menu and click Filter. Enter a desired text to filter the column contents.

Background tasks currently in progress are listed in the Background Tasks view. You may click Refresh on the task area to refresh the view.

Measuring Vault Performance

You can use M-Files Admin to measure the performance of a specific vault to detect problems or bottlenecks in the performance of the vault. The performance tests measure the network round-trip time to the database server of the vault as well as the time it takes to insert 100,000 rows into the vault database.

Do the following steps to measure vault performance:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Performance.

The Performance view is opened in the right-side pane.
5. Click **Begin Testing** on the task area.

   You can stop the test at any time by clicking **Stop Testing** on the task area.

   The network round-trip time to the database server as well as the database insert speed are measured.

The results of the tests are displayed in the **Duration** column. If there are no remarks displayed in the **Remarks** column, your vault should be performing optimally.

If one or more of the tests took longer than their expected duration, a remark is displayed in the **Remarks** column. If the network round-trip time to the database server took longer than expected, it may be indicative of a slow network connection or heavy traffic on the network. If the database insert speed test took longer than expected, your server hardware may be insufficient or there may be heavy load on the server.

**Note:** The vault performance tests have predefined threshold times. The default threshold time for the network round-trip test is 1,500 microseconds, and for the database insert speed test, it is 6,000 milliseconds. For instructions on modifying the default threshold values, see **Settings for Vault Performance Measurement**.

**Content Replication and Archiving**

Content replication and archiving enables synchronization of objects between vaults. This helps in ensuring that data is up to date between various specified vaults. Replication and archiving can be carried out by using the **export** and **import** operations available in M-Files Admin.

![Figure 96: The replication features in M-Files Admin.](image)
Ways to utilize replication and archiving

With content replication and archiving, you can, for instance:

- Archive data from an actively used vault to an archive vault.
- Archive data for long-term preservation in XML or PDF/A form in compliance with standards.
- Collect data from several M-Files vaults within a single, centralized vault.
- Use specific vaults for each of the various operations of the company.
- Publish certain documents for interest groups, such as partners, customers, or subcontractors.
- Perform backups.
- Restore the system after an error reliably (as in disaster recovery).

Figure 97: You can, for example, replicate documents from a production vault to a publication vault according to given property values of documents. For instance, a document may be replicated to a publication vault when the property Published is set to Yes.

For a more extensive presentation on replication and archiving, see M-Files Replication and Archiving User's Guide.

Important remarks

- For association and synchronization of objects and their metadata between separate vaults, the metadata definitions must also be associable between vaults. For more information, see Associating the Metadata Definitions.
- It is advisable to check the permissions of confidential imported objects in the target vault after an import operation is complete, especially if the source and the target vaults have differing users or user groups.
- If M-Files is installed on several servers, each server must have a unique server license installed.
- Two-directional replication of metadata structure is highly discouraged as the structure of the target vault is always overwritten with the structure in the content package, even if the metadata structure of the vault is more recent than the one in the content package. Thus, if two-directional replication of metadata structure is enabled, it may overwrite changes made to the metadata structure of any vault in the replication scheme.

An exception to the above recommendation are value list items, as they are provided with timestamp information to indicate when they have been created or modified. Therefore replicating value list items does not have the same shortcomings as replicating other metadata structure items, as value list timestamps assure that the most recent value list items are always preserved during replication.

- Replication from a vault to another vault is not supported if the vaults have the same GUID. Two vaults must never share the same GUID. It is possible to generate such a situation, for example if a copy or a backup of a vault is attached to another server using the original GUID.
• If you have archived documents in earlier versions of M-Files than 9.0, please note that you cannot restore archive files in the .mfa file format to a vault using version 9.0 or later. If you want to restore an archive file in the .mfa file format, you must use a vault that has version 8.0 or older installed. After this, you can upgrade the vault and perform archiving that is compatible with version 9.0 and newer.
• It is highly discouraged to compress M-Files content packages using the ZIP archive format. ZIP archives do not specify the character encoding that is used for the file names stored in the archive, and therefore it may not be possible to import content packages that have been compressed using ZIP to systems that use different system language and code page settings than the system from which the content package was exported. If you wish to compress the content package, it is recommended to use a format that retains the character encoding information of file names, such as 7Z.

In this chapter

• Exporting Content
• Importing Content
• Scheduled Export and Import
• Archiving Old Versions

Exporting Content

You can use content exporting for long-term archiving of content, synchronization of data among several vaults, or freeing up disk space on the server.

Do the following steps to export content:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Content Replication and Archiving.
   - The content replication and archiving features are displayed in the right-side pane.
5. Click the One-time Export... button.
   - For information about creating a recurring export operation, see Defining a Scheduled Export.
   - The Export Content dialog is opened.
6. On the **Package Location** tab, define the location for the content package.
   a) Click the ... button to define a temporary local folder for the content package.
   b) Optional: Click **Set Account...** to define the user account to be used for saving the content package to the selected local folder.

   You need to use a user account that has write permissions to the selected local folder.
7. Optional: Still on the Package Location tab, enable the Use replication via cloud storage option to export to a cloud storage location.
   a) In the Connection string field, enter the provided connection string for connecting to the cloud storage.

   If you do not yet have the connection string, click Get... to obtain one. This opens up a preformatted e-mail message to be mailed to M-Files customer support.
   b) In the User-specified folder name field, enter a folder location in the cloud storage that will be used for exporting from one vault and importing to another.
   c) In the User-specified password for encryption field, enter a password of your choice that will be used for encrypting content packages. The same password must be used for exporting and importing the same packages.

8. Optional: In the Configuration ID field, you can enter any string of characters for identifying this replication job.

   M-Files automatically creates a numeric ID for each scheduled replication job, but you can optionally enter an additional ID for the job to the Configuration ID field. The ID can be any string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files simply uses the numerical replication job ID.

9. Click the Objects and Files tab.

   The Objects and Files tab is opened.
You can export objects and files from the document vault.

- Export objects and files
  - Export existing objects
    - Use a search filter
    - If a previously exported object is no longer part of the export set, mark it to be destroyed in the target vault
  - Include latest versions only
  - Save files also in PDF/A-1b format
  - Clear archiving marker
  - Destroy exported objects after export
  - Export information on destroyed objects and object versions
  - Export only changes since latest run:
    - 1/1/1601
    - 12:00:00 AM

Preview

OK  Cancel  Help
10. Enable the **Export objects and files** option by checking the check box and select the **Export existing objects** option.

For more information about the options on this tab, see *Export Objects and Files*.

**Note:**

If the **Export only changes since latest run** option is enabled, only the files and objects that are new or have changed since the given date and time are exported. If you are exporting metadata structure elements while this option is enabled, the elements are not exported unless there have been changes made to files or objects.

Thus if you want to export metadata structure elements regardless of whether objects or files have been changed, it is recommended to do either of the following operations:

- Export the metadata structure separately.
- Disable the **Export only changes since latest run** option if metadata structure elements are to be exported alongside objects and files. Note that if you do not limit the scope of the export in any way, it may take a considerable amount of time to complete the export job.

11. Optional: To define the conditions that objects must meet to be exported, enable the **Use a search filter** option by checking the check box and click the **Define...** button.

a) In the *Define Filter* dialog, define the conditions that objects must meet to be exported and click **OK** once you have defined all the necessary conditions.

12. Click the **Structure** tab.

- The **Structure** tab is opened.
13. Enable the **Export structure** option and either:

   a. Check the **All Elements** option to export all metadata structure elements.

      or

   b. Check individual metadata structure elements on the list to define individually the elements to be exported.

   For more information about the options on this tab, see Export Structure.

14. Click **OK** to close the **Export Content** dialog and to start the export.

Once the export operation has been completed, you can use the export package to import the exported content to another vault. See Importing Content.
In this chapter

- Export Package Location
- Export Objects and Files
- Export Structure

Export Package Location

On the Package Location tab of the Export Content dialog, you can change the location of the content package. M-Files names the files automatically according to the vault ID and timestamp, so that you can find the content package easily at a later time.

You can also modify the user account to be used. The user needs to have the rights to the specified saving location in order for the export to be successfully completed. The default selection is Local System account.

M-Files automatically creates a numeric ID for each scheduled replication job, but you can optionally enter an additional ID for the job to the Configuration ID field. The ID can be any string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files simply uses the numerical replication job ID.

Use replication via cloud storage

You can also use replication via a cloud storage location. When exported, the replication packages are locally encrypted with the AES-256 algorithm and then uploaded to the cloud storage location. When imported, the replication packages are downloaded from the cloud storage location and then decrypted locally. This functionality can be helpful when you are replicating data between different locations and want to be completely certain that only the appropriate persons can access the data.

Connection string

Use the Get button to obtain the connection string for the cloud storage location. Please make sure to use the same string for both export and import.

User-specified folder name

The folder name is unique for one export-import pair. For instance, replication from the master vault to a secondary vault could be named "MasterOut" and replication from the secondary vault to the master vault "MasterIn".

User-specified password for encryption

The replication password is used for encrypting the replication packages. The password can be whatever you decide. Just remember to use the same password for both export and import.

Export Objects and Files

The Objects and Files tab enables you to change settings for exporting object and file content.
Figure 98: The "Objects and Files" tab of the "Export Content" dialog.
Export existing objects

Use a search filter

By using a filter, you can specify which existing objects you want to export. For example, you can export certain objects by object type or property. In particular, when publishing certain documents, such as brochures or press releases, for interest groups only, you can use the search filter for the publication when, for example, the requirement of a certain class or property is met.

If a previously exported object is no longer part of the export set, mark it to be destroyed in the target vault

By enabling this setting, any of the objects that were included in an earlier export set but are not in the current one will be deleted in the target vault upon import. If you wish to delete for example certain price lists from a vault designed for partner use, you need to make sure that this setting has been enabled and that the price lists do not fit the criteria of the export set.

Note: The setting is job-based and applies only for scheduled export and import jobs.

Note: The setting Do not import object destructions in the properties of the import job overrides this setting.

Include latest versions only

You can choose to export only the latest versions of the selected objects for archiving. Older versions of the selected objects will not be archived.

Save files also in PDF/A-1b format

You can indicate whether you also want to save the files in PDF/A-1b format when archiving them. PDF/A-1b format complies with the standard ISO 19005-1:2005, on the long-term preservation of electronic documents.

Saving in PDF/A-1b format is possible with Office files and standard PDF files. Files in PDF/A-1b format are not imported during import. Saving in PDF/A-1b format slows down the export to some extent.

Clear Archiving Marker

If you have chosen to export objects with the Marked for archiving property defined, you can indicate that the property should be cleared after the content export. With this setting is enabled, the exported objects are no longer marked for archiving.

Destroy exported objects after exporting

You can specify whether you want to destroy the exported objects after the export. If you have selected to export the latest versions only, you cannot choose this setting.

Export information on destroyed objects and object versions

Instead of the existing objects, you can choose to export data from the destroyed objects and object versions only. This function is intended mainly for clearing the destroyed objects from the vault.
Export only changes since latest run

You can choose to export only the changes made since the latest run. By default, M-Files offers the date of the latest export (or of the last import of exported objects to the source vault with a timestamp older than the previous export).

Note:

If the Export only changes since latest run option is enabled, only the files and objects that are new or have changed since the given date and time are exported. If you are exporting metadata structure elements while this option is enabled, the elements are not exported unless there have been changes made to files or objects.

Thus if you want to export metadata structure elements regardless of whether objects or files have been changed, it is recommended to do either of the following operations:

- Export the metadata structure separately.
- Disable the Export only changes since latest run option if metadata structure elements are to be exported alongside objects and files. Note that if you do not limit the scope of the export in any way, it may take a considerable amount of time to complete the export job.

Preview

Click the Preview button to see the number of objects to be affected by the export process.

Export Structure

The Structure tab enables you to select which parts of the metadata structure you want to export.
Figure 99: The Structure tab of the Export Content dialog.

Export structure

You can choose the metadata structure elements of the selected vault to be exported or select all elements by activating All Elements.

Note: Built-in elements are always created in M-Files by default and include, for example, the property definitions Name or title, Created by, Last modified by, and Keywords. In addition to these, administrators can create new, user-defined elements.

Note: It is recommended to use aliases or GUIDs in event handlers and metadata card configurations because they are exported as-is and because the metadata element IDs may differ between the source and the target vaults.
Note: For the imported metadata card configurations to be visible in the target vault, you need to either restart M-Files Admin or to perform a forced refresh (Ctrl + F5) in the configurations editor.

Export contents of the selected value lists

By selecting the Export contents of the selected value lists checkbox you can choose to export all value list content.

Note: All the removed values are replicated as well. This means that values in the target vault may be deleted through a metadata structure import. The values are not deleted completely, however, but instead only marked as deleted. This enables the ability to search and re-enable any deleted values in the source or target vault via M-Files Admin.

Selecting OK creates an export package of the selected metadata to the location specified on the Package Location tab.

Export users' custom display settings of the selected views

By enabling the Export users' custom display settings of the selected views checkbox you can choose to include users' custom display settings to the export package.

Note: Exporting a view always includes the common display settings of the view.

Importing Content

After creating an export package, you can import its content to a vault of your choosing. You can use the Import Content function when you need to import data to another vault for example for replication, publication, archiving, or backup purposes. The objects and their metadata are imported and synchronized with those in the target vault. M-Files always imports versions that are new or changed compared to the current versions in the target vault.

Complete the following steps to import a content package:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Content Replication and Archiving.
   - The content replication and archiving features are displayed in the right-side pane.
5. Click the One-time Import... button.
   - For information about creating a recurring import operation, see Defining a Scheduled Import.
   - The Import Content dialog is opened.
6. On the **Package Location** tab, define the location for the content package.
   a) Optional: Enable the **Import multiple content packages** if you want to import multiple packages from the selected location.
   b) Click the ... button to define the location of the content packages to be imported.
   c) Optional: Click **Set Account...** to define the user account to be used for retrieving the content package from the selected folder.

   ⚠ You need to use a user account that has read permissions to the selected folder.
7. Optional: Still on the **Package Location** tab, enable the **Use replication via cloud storage** option to import from a cloud storage location.
   a) In the **Connection string** field, enter the provided connection string for connecting to the cloud storage.

   If you do not yet have the connection string, click **Get...** to obtain one. This opens up a preformatted e-mail message to be mailed to M-Files customer support.

   b) In the **User-specified folder name** field, enter a folder location in the cloud storage that will be used for importing to one vault and exporting from another.

   c) In the **User-specified password for encryption** field, enter a password of your choice that will be used for encrypting content packages. The same password must be used for exporting and importing the same packages.

8. Check the **Delete content package after importing** check box if you want the content package to be removed after the operation has been completed.

9. Optional: In the **Configuration ID** field, you can enter any string of characters for identifying this replication job.

   M-Files automatically creates a numeric ID for each scheduled replication job, but you can optionally enter an additional ID for the job to the **Configuration ID** field. The ID can be any string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files simply uses the numerical replication job ID.

10. On the **Objects and Files** tab, you can specify how objects and files are imported.

    For more information, see Import Objects and Files.

11. On the **Structure** tab, you can specify how metadata structure is imported.

    For more information, see Import Structure.

12. On the **Permissions** tab, you can specify the permission settings for the imported objects.

    For more information, see Permissions (Importing Content).

13. Click **OK** to start the import operation.

    A summary of the package content to be imported is opened.

    **Important:** It is essential to take into consideration that exporting and importing objects with relationships to other objects may, in some cases, produce a conflict. If the conflict cannot be resolved automatically, some of the selected objects might not be replicated. The **import summary report** should be reviewed carefully before proceeding with the import operation.

**In this chapter**

- Import Package Location
- Import Objects and Files
- Import Structure
- Permissions (Importing Content)
- Import Summary Report
**Import Package Location**

The **Package Location** tab displays options related to the package containing the objects, files, and metadata structure to be imported. See the corresponding settings in Exporting Content when you are importing the content package to the selected vault.

The location must be the same as that of the content package exported from the source vault. That is, M-Files must find the exported data to perform the import. The location may be different, but in that case a separate data transfer between locations must be implemented.

**Note:** The exported package can contain different marker files. M-Files only imports content packages that have the *Ready* marker file but not the *Imported* marker file for the target vault.

![Image](image_url)
You can also import several packages at a time by checking the **Import multiple content packages** check box. This enables you to select a folder instead of a single file.

The content package will be automatically deleted after importing if the **Delete content package after importing** option is enabled.

M-Files automatically creates a numeric ID for each scheduled replication job, but you can optionally enter an additional ID for the job to the **Configuration ID** field. The ID can be any string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files simply uses the numerical replication job ID.

**Use replication via cloud storage**

You can also use replication via a cloud storage location. When exported, the replication packages are locally encrypted with the AES-256 algorithm and then uploaded to the cloud storage location. When imported, the replication packages are downloaded from the cloud storage location and then decrypted locally. This functionality can be helpful when you are replicating data between different locations and want to be completely certain that only the appropriate persons can access the data.

**Connection string**

The connection string contains the storage location information. Please make sure to use the same string for both export and import (see **Export Package Location**).

**Folder name**

The folder name is unique for one export-import pair. For instance, replication from the master vault to a secondary vault could be named **MasterOut** and replication from the secondary vault to the master vault **MasterIn**.

**Password for encryption**

The replication password is used for encrypting the replication packages. The password can be whatever you decide. Just remember to use the same password for both export and import.

**Import Objects and Files**

The **Objects and Files** tab enables you to change settings related to importing object and file content.
Figure 101: The **Objects and Files** tab of the **Import Content** dialog.
**Import checkout states of objects**

If the objects are checked out in the vault from which you are exporting, you can import the check-out states to the target vault as well. Then the object is also checked out in the target vault, which prevents other users from editing it. This reduces the possibility of conflicts, which could be caused by simultaneous editing in multiple vaults.

**Use the name of an imported element as its alias if no other alias is available**

Since only built-in, GUID and "ID+name" matching metadata definitions are automatically connected, other metadata definitions must be associated by using aliases. However, the necessary alias definitions may not have been made in the source vault. In the latter case, the data export can be facilitated by means of this setting. When this option has been selected, the alias need only be defined in the target vault as long as it is in line with the element's source vault name.

For example, you may want to import objects of the *Project* type but have not defined an alias for the *Project* object type in the source vault. By selecting this option and adding, in the target vault, an alias corresponding to the source vault's name for the project object type (in this case, the alias is "Project"), you will get the necessary definitions for the import.

![Note: You must use the default language names from the source vault as the aliases for the metadata definitions in the target vault to be able to perform connection of the metadata definitions.]

![Note: This setting is valid only when the metadata definition in question (object type, property definition, value list, or similar) has no alias defined in the source vault.]

**Do not import object destructions**

Select this option if:

- You do not want to destroy objects that you have destroyed in the source vault also in the target vault. For example, if you use the target vault for archiving destroyed objects, select this setting.
- You do not want to destroy objects that are no longer part of the export set. Please note that this setting nullifies the export setting *If a previously exported object is no longer part of the export set, mark it to be destroyed in the target vault.*

**Import Structure**

On the *Structure* tab, you can disable any external database connections to object types, value lists and to user groups, as well as disable any active event handlers to be replicated.

Clicking *OK* generates a report that displays all modifications to the target vault structure.

**Permissions (Importing Content)**

The *Permissions* tab of the importing dialog allows you to change the permission settings of the content to be imported.

Complete the following steps to modify the permissions:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand *Document Vaults*, and then expand the document vault of your choice.
4. Still in the left-side tree view, select **Content Replication and Archiving**.
   
   ✔️ The content replication and archiving features are displayed in the right-side pane.

5. Either:

   a. Click **One-time Import...** if you want to modify the permissions of a single import package.
       
       or

   b. Click the task area item **New Scheduled Import...** if you want to modify the permissions of a recurring import job.

   ✔️ Depending on your choice, either the **Import Content** or the **Scheduled Job Properties** dialog is opened.

6. Select the **Permissions** tab.

   ✔️ The **Permissions** tab of either the **Import Content** or the **Scheduled Job Properties** dialog is opened.
You can specify the permission settings for the imported objects.

Permissions of the imported objects:
- [Use the permissions from the content package]
- [Use the default permissions of object types]
- [Specify permissions for imported versions:
  - Full control for all internal users]

Automatic permissions:
- [Activate new or changed definitions of automatic permissions]
- [Ignore the definitions of automatic permissions of the imported objects]
7. In the **Permissions of the imported objects** section, select one of the following options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use the permissions from the content package</strong></td>
<td>Select this option if you want the imported objects to have the same permissions as the objects in the source vault.</td>
</tr>
<tr>
<td><strong>Use the default permissions of the object types</strong></td>
<td>Select this option if you want the imported objects to use the default permissions defined via the properties dialog of each object type.</td>
</tr>
<tr>
<td><strong>Specify permissions for imported versions</strong></td>
<td>Select this option if you want to manually define permission settings that are to be applied to all the imported objects.</td>
</tr>
</tbody>
</table>

8. Optional: Check or uncheck the **Activate new or changed definitions of automatic permissions** option checkbox.

   - If the content package contains any new or changed definitions of automatic permissions, importing the content package with this option enabled activates all the automatic permissions triggered by the imported definitions in the target vault. Importing the content package with this option unchecked still imports the automatic permission definitions to the target vault, but does not cause any new automatic permissions to be activated.

9. Optional: Check or uncheck the **Ignore the definitions of automatic permissions of the imported objects** option checkbox.

   - When selected, this option makes the importing process bypass the definitions of automatic permissions of all the imported objects in the content package. This way you can choose to preserve the automatic permissions of all the objects in the target vault by leaving out any potential changes to the definitions of automatic permissions from the objects in the imported content package.

10. Click **OK** to close the dialog.

    **Import Summary Report**

    Before accepting any changes to the target vault, M-Files presents a detailed summary of the content package to be imported. It is highly recommended to carefully review the summary report explaining the results of the content import.
It is very important to make sure that no unintended duplicate structure elements will be generated, and that all changes to the target vault’s metadata structure will be as expected. In the event there are incorrect mappings, the process should be canceled and the names or aliases of the elements in the source and/or target vault modified accordingly.

**Scheduled Export and Import**

For keeping vaults up to date between each other and in interaction, scheduled export and import must be defined for the vaults. With scheduled export and import, you can synchronize the objects and their metadata between vaults.

- **Note:** The schedule option *When idle* is not supported in M-Files.

- **Note:** It is recommended that you study the section *Interaction Among Several Vaults* before defining any export or import jobs.

**Scheduled export**

Define the scheduled export in the source vault where you can save the content to be exported on a scheduled basis. The same settings are available as when defining an individual export. For further information, refer to *Export Content*. Exported data can be imported to another vault for publication, replication, archiving or backup.

**Scheduled import**

When you want to import the content to another vault for synchronization or other use, you should define the scheduled import to the target vault. The same settings are available as when defining an individual import. For further information, refer to *Import Content*. 
Scheduling an export or an import job works the same way as scheduling tasks in the Windows Control Panel.

**Note:** In addition to the content export and import, you should be able to associate the metadata definitions for the interaction between separate vaults, so that synchronization is possible through archiving. For further information, refer to Interaction Among Several Vaults.

**In this chapter**

- Defining a Scheduled Export
- Defining a Scheduled Import

**Defining a Scheduled Export**

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, select **Content Replication and Archiving**.

   The content replication and archiving features are displayed in the right-side pane.

5. Click **New Scheduled Export...** on the task area.

   The **Scheduled Job Properties** dialog is opened.

6. In the **Description** field, type in a name for the scheduled export job.

7. To define a schedule for this task, complete the following steps:
   a) Click the **Schedule...** button.

   The **Define Schedule** dialog is opened.
b) Define the appropriate schedule using the available options.

The schedule option **When idle** is not supported in M-Files.

c) Click **OK** to close the **Define Schedule** dialog.

8. On the **Package Location** tab, define the location for the content package.
   a) Click the **...** button to define a temporary local folder for the content package.
   b) Optional: Click **Set Account...** to define the user account to be used for saving the content package to the selected local folder.

   You need to use a user account that has write permissions to the selected local folder.

9. Optional: Still on the **Package Location** tab, enable the **Use replication via cloud storage** option to export to a cloud storage location.
   a) In the **Connection string** field, enter the provided connection string for connecting to the cloud storage.

   If you do not yet have the connection string, click **Get...** to obtain one. This opens up a preformatted e-mail message to be mailed to M-Files customer support.

   b) In the **User-specified folder name** field, enter a folder location in the cloud storage that will be used for exporting from one vault and importing to another.

   c) In the **User-specified password for encryption** field, enter a password of your choice that will be used for encrypting content packages. The same password must be used for exporting and importing the same packages.
10. Optional: In the Configuration ID field, you can enter any string of characters for identifying this replication job.

M-Files automatically creates a numeric ID for each scheduled replication job, but you can optionally enter an additional ID for the job to the Configuration ID field. The ID can be any string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files simply uses the numerical replication job ID.

11. On the Objects and Files tab, enable the Export objects and files option by checking the check box and select the Export existing objects option.

For more information about the options on this tab, see Export Objects and Files.

Note:

If the Export only changes since latest run option is enabled, only the files and objects that are new or have changed since the given date and time are exported. If you are exporting metadata structure elements while this option is enabled, the elements are not exported unless there have been changes made to files or objects.

Thus if you want to export metadata structure elements regardless of whether objects or files have been changed, it is recommended to do either of the following operations:

- Export the metadata structure separately.
- Disable the Export only changes since latest run option if metadata structure elements are to be exported alongside objects and files. Note that if you do not limit the scope of the export in any way, it may take a considerable amount of time to complete the export job.

12. Optional: To define the conditions that objects must meet to be exported, enable the Use a search filter option by checking the check box and click the Define... button.

a) In the Define Filter dialog, define the conditions that objects must meet to be exported and click OK once you have defined all the necessary conditions.

13. On the Structure tab, enable the Export structure option and either:

a. Check the All Elements option to export all metadata structure elements.

or

b. Check individual metadata structure elements on the list to define individually the elements to be exported.

14. Click OK to save the scheduled export job and close the Scheduled Job Properties dialog.

The scheduled export job that you have just defined is added to the Scheduled Export and Import list and will be run according to the defined schedule.

Defining a Scheduled Import

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select **Content Replication and Archiving**.

   - The content replication and archiving features are displayed in the right-side pane.

5. Click **New Scheduled Import...** on the task area.

   - The **Scheduled Job Properties** dialog is opened.

6. In the **Description** field, type in a name for the scheduled import job.

7. To define a schedule for this task, complete the following steps:
   a) Click the **Schedule...** button.

   - The **Define Schedule** dialog is opened.

   ![Define Schedule dialog]

   b) Define the appropriate schedule using the available options.

   - The schedule option **When idle** is not supported in M-Files.

   c) Click **OK** to close the **Define Schedule** dialog.
8. On the **Package Location** tab, define the location for the content package.
   a) Optional: Enable the **Import multiple content packages** if you want to import multiple packages from the selected location.
   b) Click the ... button to define the location of the content packages to be imported.
   c) Optional: Click **Set Account...** to define the user account to be used for retrieving the content package from the selected folder.

   ![Note]
   You need to use a user account that has read permissions to the selected folder.

9. Optional: Still on the **Package Location** tab, enable the **Use replication via cloud storage** option to import from a cloud storage location.
   a) In the **Connection string** field, enter the provided connection string for connecting to the cloud storage.
   ![Note]
   If you do not yet have the connection string, click **Get...** to obtain one. This opens up a preformatted e-mail message to be mailed to M-Files customer support.
   b) In the **User-specified folder name** field, enter a folder location in the cloud storage that will be used for importing to one vault and exporting from another.
   c) In the **User-specified password for encryption** field, enter a password of your choice that will be used for encrypting content packages. The same password must be used for exporting and importing the same packages.

10. Optional: Check the **Delete content package after importing** check box if you want the content package to be removed after the operation has been completed.

11. Optional: In the **Configuration ID** field, you can enter any string of characters for identifying this replication job.

    ![Note]
    M-Files automatically creates a numeric ID for each scheduled replication job, but you can optionally enter an additional ID for the job to the **Configuration ID** field. The ID can be any string of characters. If a configuration ID cannot be found when the jobs are processed, M-Files simply uses the numerical replication job ID.

12. On the **Objects and Files** tab, you can specify how objects and files are imported.

    ![Note]
    For more information, see **Import Objects and Files**.

13. On the **Structure** tab, you can specify how metadata structure is imported.

    ![Note]
    For more information, see **Import Structure**.

14. On the **Permissions** tab, you can specify the permission settings for the imported objects.

    ![Note]
    For more information, see **Permissions (Importing Content)**.

15. Click **OK** to save the scheduled import job and close the **Scheduled Job Properties** dialog.

The scheduled import job that you have just defined is added to the **Scheduled Export and Import** list and will be run according to the defined schedule.

**Archiving Old Versions**

You can archive old versions of documents that you no longer need. When you archive old versions of documents, the selected document versions are transferred from the document vault to the archive file.

Do the following steps to archive old versions of documents:
1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Content Replication and Archiving.
5. Select Action > Archive Old Versions... from the menu bar.

   You can also right-click on an empty area in the Scheduled Export and Import list and select Archive Old Versions... from the context menu.

   The Archive Old Versions dialog is opened.
6. Select either:

   a. **All documents**: Select this option if you want to archive old versions of all documents.
or

b. **Documents marked for archiving**: Select this option if you want to archive old versions of the documents that you have marked for archiving.

   ![](image.png)

   **Note**: You can mark a document for archiving in M-Files Desktop by right-clicking a document and selecting Archiving > Mark for Archiving from the context menu. For more information, see Archiving.

7. Select the conditions (you can select all that apply) for limiting the number of old versions to be archived:

   You can click **Preview** to view the number of old versions to be archived with the selected settings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Checked in before</strong></td>
<td>Select this option to archive old versions that have been checked in before the given date.</td>
</tr>
<tr>
<td><strong>At least &lt;number&gt; versions older than the current version</strong></td>
<td>Select this option to archive old versions that are a given number of versions older than the current version.</td>
</tr>
<tr>
<td><strong>At least &lt;number&gt; days older than the current version</strong></td>
<td>Select this option to archive versions that are a given number of days older than the current version.</td>
</tr>
<tr>
<td><strong>No version tag</strong></td>
<td>Select this option to exclude versions that have a version label from the archive.</td>
</tr>
</tbody>
</table>

8. In the **Content package location** section, click the ... button to select the location to save the archive.

9. Optional: To specify an account other than the Local System account for running this task, complete the following steps:
   a) Click the **Set Account**... button.

   ![](image.png)

   b) Select the **This account** option.
   c) In the **This account** field, enter the name of the user account.
   d) In the **Password** and **Confirm password** fields, enter the password of the user account.
   e) Click **OK** to close the **Set Account** dialog.

   ![](image.png)

   Setting the account may be necessary especially if the location you have selected is on a network drive that the Local System account cannot access.
10. Click **OK** to save your changes and to close the **Archive Old Versions** dialog.

The selected old versions of documents are archived to the location you have defined.

The archived documents can later be restored to the document vault via **Content Replication and Archiving**.

**Note:** If you have archived documents in earlier versions of M-Files than 9.0, please note that you cannot restore archive files in the `.MFA` file format to a vault using version 9.0 or later. If you want to restore an archive file in the `.MFA` file format, you must use a vault that has version 8.0 or older installed. After this, you can upgrade the vault and perform archiving that is compatible with version 9.0 and newer.

**Vault Event Log**

The vault event log records document vault events, such as new object creations and user logins. Events can be viewed and organized in any desired order, filtered and exported. You can add new types of events to be recorded by purchasing the **Electronic Signatures and Advanced Logging** module.

**Tip:** If the list contains a large number of items, you might want to filter it. To filter the view, open the **View** menu and click **Filter**. Enter a desired text to filter the column contents.

**Note:** Event logging must be enabled to send notifications. For more information about notifications, refer to **Editing Notification Settings in M-Files Admin**.

To enable the vault event log, in M-Files Admin, select the document vault of your choice, then select **Event Log**, and finally click **Enable** via the task area.

**Showing events X–XXXX**

You can browse the events page by page by using the arrow icons. A single page can display 10,000 events at maximum.

**Define Filter**

You can specify the events to be displayed in the list by either object type or object ID.

**Export**

You can export and archive all or selected events in XML file format.

**Delete events X–XXXX**

In addition to being able to delete all events, you can select events for listing on the page and delete them (this does not apply to filtered lists).

**Detailed information on an individual event**

The **Event Details** dialog provides detailed information on the saved changes.

**Note:** To view more detailed information on an individual event, you must have the **Electronic Signatures and Advanced Logging** module activated.
Figure 103: The "Event Details" window.

**Number of events, and event types**

If the Electronic Signatures and Advanced Logging module is in use and the Advanced Event Log features have been enabled, the event log records all events without any restrictions. Otherwise, the M-Files server removes the oldest events automatically if the number of events exceeds 10,000. The maximum number of events can be changed via a registry setting (for more information, contact M-Files customer support at support@m-files.com).

While M-Files offers a versatile event log, several additional event types that can be covered by logging are enabled with the Electronic Signatures and Advanced Logging module.

**Tip:** If you want to give system administrators more visibility into actions that vault users perform in a vault, see User Action Log.

The following event types are recorded in the M-Files Admin event log:

- Assign request
- Event log cleared
- Object deleted
- Signature settings deleted
<table>
<thead>
<tr>
<th>Event Type</th>
<th>Description</th>
<th>Event Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup completed</td>
<td>Event log exported</td>
<td>Object destroyed</td>
<td>Signature settings modified</td>
</tr>
<tr>
<td>Backup started</td>
<td>Event logging disabled</td>
<td>Object undeleted</td>
<td>State changed</td>
</tr>
<tr>
<td>Check-in</td>
<td>Event logging enabled</td>
<td>Object version destroyed</td>
<td>The state of a document or other object changed</td>
</tr>
<tr>
<td>Check-in request</td>
<td>File downloaded</td>
<td>One version of a document or other object destroyed</td>
<td>User created</td>
</tr>
<tr>
<td>Checkout</td>
<td>File downloaded via public link</td>
<td>Property definition deleted</td>
<td>User deleted</td>
</tr>
<tr>
<td>Undo checkout</td>
<td>Free-form request</td>
<td>Public link accessed</td>
<td>User modified</td>
</tr>
<tr>
<td>Document or other object changed</td>
<td>Login</td>
<td>Public link created</td>
<td>User group created</td>
</tr>
<tr>
<td>Document or other object deleted</td>
<td>Logout</td>
<td>Public link deleted</td>
<td>User group deleted</td>
</tr>
<tr>
<td>Document or other object destroyed</td>
<td>New document or other object</td>
<td>Restoration from backup completed</td>
<td>User group modified</td>
</tr>
<tr>
<td>Document vault created</td>
<td>New object</td>
<td>Rollback</td>
<td>Vault variable modified</td>
</tr>
<tr>
<td>Document vault created as a copy of another vault</td>
<td>Object changed</td>
<td>Signature settings added</td>
<td></td>
</tr>
</tbody>
</table>

The Electronic Signatures and Advanced Logging module adds the following event types to the M-Files Admin event log:

**Metadata structure changes:**

- **Class changed**
- **Class created**
- **Class deleted**
- **Common view changed**
- **Common view created**
- **Common view deleted**
- **Named ACL changed**
- **Named ACL created**

**Vault property changes:**

- Event handler changed
- Event handler created
- Event handler deleted
- Event handler index changed
Other:

Application installed
Application uninstalled
Content package exported
Content package import completed

Electronic Signatures and Advanced Logging module

The Electronic Signatures and Advanced Logging module enables you to use electronic signatures and to record additional event types in the vault event log. The module is available for a separate fee.

For you to activate the Electronic Signatures and Advanced Logging module, the license code must be activated on your system. The license is provided on a subscription basis. Activate or update the license code in M-Files Admin (for more information, refer to Managing Server Licenses). In addition to this, properties of the audit trail must be activated vault-specifically. For more information, see Document Vault Advanced Properties.

For more information on User Action Log, that also comes with the module, see User Action Log.

In this chapter

• User Action Log

User Action Log

You can enable the User Action Log feature to have more visibility into the actions performed by individual M-Files Desktop users in a given vault. The feature allows the additional events described in the table below to be included in the vault event log. To enable the feature, see Enabling User Action Log.

Important remarks

Please take the following information into consideration when using the feature:

• Actions performed via M-Files Web, M-Files Mobile or any M-Files API based custom clients are not logged.
• Actions performed in offline mode are not logged.
• Using this feature considerably increases the size of the vault log.

Logged events

When the feature is in use, the following additional events are recorded to the vault event log:
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
</table>
| Metadata card opened   | An event of this type is recorded when the metadata card is displayed in the right pane, bottom pane, or popped out for any object. The entry contains the following details:  
  - the user who opened the metadata card  
  - the timestamp of the event  
  - the property IDs, name, and ID of the object  
  The property IDs are shown only if you have enabled this behavior via settings of the feature. |
| Preview tab opened     | An event of this type is recorded when the preview tab is displayed for a document or a non-document object containing one or more files. The entry contains the following details:  
  - the user who opened the preview pane  
  - the timestamp of the event  
  - the name and ID of the document (or, alternatively, the name of the file and the name and ID of the object containing the file) |
| File opened            | An event of this type is recorded when a file is opened via M-Files Desktop. The entry contains the following details:  
  - the user who opened the file  
  - the timestamp of the event  
  - the name and ID of the object |
| Object history opened  | An event of this type is recorded when the History dialog is opened via M-Files Desktop. The entry contains the following details:  
  - the user who opened the dialog  
  - the timestamp of the event  
  - the name and ID of the object |
| Object relationships opened | An event of this type is recorded when the relationships of an object are browsed in the M-Files Desktop listing area. The entry contains the following details:  
  - the user who browsed the relationships  
  - the timestamp of the event  
  - the name and ID of the object |
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
</table>
| Relationships dialog opened               | An event of this type is recorded when the **Relationship** dialog is opened in M-Files Desktop. The entry contains the following details:  
  - the user who opened the dialog  
  - the timestamp of the event  
  - the name and ID of the object |
| Collection Members dialog opened          | An event of this type is recorded when the **Collection Members** dialog is opened in M-Files Desktop. The entry contains the following details:  
  - the user who opened the dialog  
  - the timestamp of the event  
  - the name and ID of the object |
| Search initiated                          | An event of this type is recorded when a search is performed in M-Files Desktop. The entry contains the following details:  
  - the user who performed the search  
  - the search terms  
  - the timestamp of the event  
  - the columns shown in the listing area |
| View or folder opened                     | An event of this type is recorded when a view or grouping level is opened in M-Files Desktop. The entry contains the following details:  
  - the user who opened the view or grouping level  
  - the timestamp of the event  
  - the name and ID of the object  
  - the columns shown in the listing area |
| Object listing invoked                    | An event of this type is recorded when a search is performed in M-Files Desktop. The entry contains the following details:  
  - the user who invoked the listing  
  - the timestamp of the event  
  - the search terms and search criteria |
<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object listing requested from server</td>
<td>An event of this type is recorded when a search is performed in M-Files Desktop. The entry contains the following details:</td>
</tr>
<tr>
<td></td>
<td>• the user who requested the listing</td>
</tr>
<tr>
<td></td>
<td>• the timestamp of the event</td>
</tr>
<tr>
<td></td>
<td>• the search terms and search criteria</td>
</tr>
<tr>
<td></td>
<td>For M-Files to start recording events of this type, you must restart the vault after enabling the feature.</td>
</tr>
<tr>
<td>Column inserted</td>
<td>An event of this type is recorded when a column is added to a listing in M-Files Desktop. The entry contains the following details:</td>
</tr>
<tr>
<td></td>
<td>• the user who performed the modification</td>
</tr>
<tr>
<td></td>
<td>• the timestamp of the event</td>
</tr>
<tr>
<td></td>
<td>• the column that was added</td>
</tr>
<tr>
<td>Column removed</td>
<td>An event of this type is recorded when a column is removed from a listing in M-Files Desktop. The entry contains the following details:</td>
</tr>
<tr>
<td></td>
<td>• the user who performed the modification</td>
</tr>
<tr>
<td></td>
<td>• the timestamp of the event</td>
</tr>
<tr>
<td></td>
<td>• the column that was removed</td>
</tr>
<tr>
<td>Column settings modified</td>
<td>An event of this type is recorded when columns are added or removed via the <strong>Choose Columns</strong> dialog in the M-Files Desktop. The entry contains the following details:</td>
</tr>
<tr>
<td></td>
<td>• the user who performed the modification</td>
</tr>
<tr>
<td></td>
<td>• the timestamp of the event</td>
</tr>
<tr>
<td></td>
<td>• columns that are visible to the user after the modification</td>
</tr>
<tr>
<td>Object dragged from M-Files</td>
<td>An event of this type is recorded when an object is dragged and dropped from M-Files Desktop. The entry contains the following details:</td>
</tr>
<tr>
<td></td>
<td>• the user who exported the object</td>
</tr>
<tr>
<td></td>
<td>• the timestamp of the event</td>
</tr>
<tr>
<td></td>
<td>• the name and ID of the object</td>
</tr>
<tr>
<td></td>
<td>If multiple objects are exported, all items are logged.</td>
</tr>
</tbody>
</table>
### Event

<table>
<thead>
<tr>
<th>Event</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object copied to clipboard</td>
<td>An event of this type is recorded when an object is copied to the Windows clipboard in M-Files Desktop. The entry contains the following details: • the user who copied the object • the timestamp of the event • the name and ID of the object If multiple objects are copied, all items are separately logged.</td>
</tr>
</tbody>
</table>

#### In this chapter

- **Enabling User Action Log**

*Enabling User Action Log*

To use the feature, your server license must contain the Electronic Signatures and Advanced Logging module.

To enable the User Action Log feature for a single vault, do the following steps:

1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select **Configurations**, and then in the gray navigation area, select **Advanced Vault Settings**.

2. Expand the **Event Log** node.

3. Select **User Action Log**.

4. Change the value of the **Enabled** setting to **Yes**.

5. Optional: Change the settings as required under the **Event Settings** node.

See the descriptions of the settings by clicking the information icon next to each individual setting.
6. Click **Save** to save your changes.

**Note:** M-Files starts recording the events for all vault users that have logged out and logged back in after the settings were applied in M-Files Admin. You can log out all vault users by restarting the vault, but taking a vault offline should always be done in a controlled manner and the vault users should be notified beforehand.

The feature is now in use in the vault. Repeat the steps for any additional vaults that you want to be using this feature.

### Interaction Among Several Vaults

M-Files enables a multi-level interaction between several document vaults. The interaction enables you, for instance, to:

- Archive data from an actively used vault to an archive vault.
- Back up data from the vault on your server to the vault in the cloud service so that the users can immediately connect to the cloud service if they face problems with the vault installed on your server.
- Centralize data from several M-Files vaults to a single vault.
- Use several vaults, separating the various functions of the company so that content, metadata structures, and the permissions for the vaults can be customized to match the needs of various operations and business units.
- Publish certain documents via a separate vault for interest groups.
- Create relationships between objects in different vaults so that objects in other vaults can be found as the company’s operations require.

With interaction, you can share documents and other objects efficiently between separate vaults. You can, for example, specify certain documents for sharing from the company’s vault with a publishing vault. This enables you to easily provide your customers and other cooperation partners with up-to-date price lists, product descriptions, brochures, and other material from this publishing vault at all times without any manual copying or outdated information.

**Note:** If M-Files is installed on several servers, each server must have a unique server license installed. For example, if you want to replicate information between vaults on separate servers, unique server licenses must be installed for all the servers.

### Settings required for the interaction

**Associations for the metadata definitions**

In order for you to associate and synchronize metadata between vaults, the metadata definitions must also be associatable between vaults. For more information, refer to **Associating the Metadata Definitions**.

**Synchronization of objects and values between vaults**

In addition to associations for the metadata, the objects and values need to be updated or synchronized regularly so that the data content is up to date across vaults. Synchronization of data between vaults is performed with **replication** of contents, with data then exported from the source vault and imported to another vault.

The synchronization of this content can be performed with scheduled export and import operations. The content can be synchronized, for example, every 15 minutes. With this approach, the data in the target vault will always be up to date. For more information, refer to **Content Replication and Archiving**.
Two-way synchronization is possible between vaults, but synchronization can also be performed among many individual vaults. When defining the export, you can use a filter if you want to export and publish only certain documents or another objects for the target vault.

In this chapter

- Associating the Metadata Definitions
- Synchronization of Objects and Their Values Between Vaults

Associating the Metadata Definitions

To associate and synchronize objects and their metadata between different vaults, the metadata definitions must also be associatable between different vaults.

Associations between metadata definitions can be made in several ways depending on how the vaults are used. Certain metadata definitions are always associated automatically. Some of them are associated automatically according to the vault structure, but for some of them, it must be done manually using aliases.

Purpose of the Vault vs. Metadata Associations

Associations between metadata can be created in several ways, depending on the purpose of use of the vaults. The target vault can be used in archiving, replication, backups, and publication. For this reason, you should consider – before creating a vault that might be used as a target vault – which implementation is the easiest and best for creation of the desired vault.

If the association and synchronization is performed between two or more existing vaults, check the association of the metadata definitions and define the scheduled export and import between vaults.

Perfect copy (for example replication, archiving, and backup)

If you want the vaults to be perfect – full and complete – copies of each other in terms of both metadata and contents, you should first create a target vault through backup or copy of the relevant vault and then define the export and import. This way, especially the metadata definitions are automatically matched with the names and IDs and any separate definition of aliases need not be performed one metadata definition at a time.

Note: Metadata definitions created after creation of the vault must be manually associated between vaults by using aliases.

Partially the same metadata structure and partially the same contents (for example vaults intended for different purposes in the company)

If you want the metadata largely matching each other between vaults, you should consider first creating the metadata structure of the target vault through metadata structure export (see Export Structure) and then define the export and import. After this, you should verify in the target vault that the metadata structure corresponds to the use of the target vault.

Note: Metadata created after creation of the vault must be manually associated between vaults by using aliases.
Different metadata structure but partially the same content (for example, publication of certain objects from one vault to another)

If you want to publish only certain objects and metadata in the so-called publishing vault, you should create the metadata structure of the publishing vault separately from that of the source vault.

In this case, aliases must be defined for all other metadata structures than built-in ones, so that metadata can be associated when the synchronization is performed.

Associating Metadata

By default, M-Files associates metadata by the following methods (in order of relevance):

1. The built-in metadata definitions are always automatically associated, regardless of the manner of creation of the vault metadata structures or methods of performing the association. These metadata definitions might be Name or title, Created by, Last modified by, Keywords, and so on. In publishing operations, you may want to hide some of these. For example, you may not want to show the document creator in the publishing vault. You can edit the built-in metadata to suit the publishing operation via the registry settings and permissions.

2. All the items have a GUID (globally unique identifier). If there is a GUID match across vaults, the metadata definitions are always mapped automatically.

3. If the aliases match between the vaults, the association of the metadata definitions is always performed. The alias must be manually defined in each vault for the metadata definition in question. For more information, refer to Aliases for Associating Metadata Between Vaults.

4. If both metadata definition's ID and the name match, the association of the metadata is performed automatically. This default setting can be changed from the registry settings. Note that when the association is performed with name, the names in line with the default languages for vaults are used. Also note that if the metadata structures have been separately created in different vaults, the IDs are not the same and the association must be performed via aliases.

5. You can also use the name of imported metadata definition as its alias if there are no other aliases available. In this case, you need to define the alias only in the target vault using the name of the metadata definition from the source vault. For more information, refer Use the name of an imported element as its alias under Importing Content.

6. If, in addition to those mentioned above, you want to have associations using the name only, you can include this definition in the registry settings. Then the name of the metadata definition, such as Telephone number, must be the same across vaults. When default settings are used, the name alone is not sufficient for association of the metadata. Note that when the association is performed by means of name, the names in line with the default languages for the vaults are used.

Aliases for Associating Metadata Between Vaults

Because only the built-in metadata definitions and those matching the GUID or ID and name are associated automatically, for other metadata definitions the association must be performed by using aliases.

Aliases can be used for identifying semantically equivalent metadata. For example, when importing objects from another vault, their Date and Description properties can be mapped to the target vault's equivalent properties on the basis of aliases even if the properties' internal IDs and/or names are different. That is, the aliases refer to semantically equivalent metadata in different vaults. In other words, alias is a common identifier for the same metadata definition between several vaults.

The alias is defined as a common ID with the same name in both source and target vault.

When defining the alias, you can use various external data type and archive standards, such as SÄHKE2, MoReq2, and Dublin Core.
Check that there are sufficient definitions for all desired metadata definitions so that the association can be performed. Check the following: object types, value lists, property definitions, classes and class groups, workflows and workflow states, user groups, and named access control lists. In the properties of these metadata definitions, you can find the **Advanced** tab, where you can define the alias(es) for the metadata definitions.

For example, the source vault has the property definition **Telephone number**, whose vault-specific ID is 1001. The semantically equivalent property definition is also in the target vault, but the vault-specific ID is 1005 – the name can be the same (**Telephone number**) or different (**Phone number**) in the default language. If you want to associate these, you must define a common alias for this property definition in both vaults. The alias can be anything you want, such as **Telephone number** or **dc.PhoneNumber**, with the exception that it cannot contain both dots and spaces.

The alias is not shown to the users in M-Files Desktop; that is, the users see the name of the vault-specific property definition, just as before.

**Note:** If there are several metadata definitions with the same alias in the target vault, the association is bypassed for these and the data will not be imported to the target vault.

Assigning Aliases for Metadata Definitions

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand **Metadata Structure (Flat View)** and select the type of metadata definition, for example **Property Definitions**, for which you want to assign an alias or aliases.

   The list of metadata definitions is opened in the right-side panel.

5. From the list, right-click the instance for which you want to assign an alias and select **Properties** from the context menu.

   The **Properties** dialog for the selected metadata definition is opened.

6. Go to the **Advanced** tab.

7. In the **Aliases** field, type in the name of the alias for the selected metadata definition.

   Use the same aliases for semantically equivalent metadata in both the source and the target vault.

8. Click **OK** to close the **Properties** dialog.

   The alias is displayed in the **Aliases** column of the metadata definition listing.

**Login Accounts**

Depending on the purpose of use of the target vault, the users of the target vault may be the same as, or entirely different from, those of the source vault. If you want to grant certain users permissions for both vaults, synchronize the metadata for the **Users** value list, or do both, you should create user accounts with the same name for these users for both vaults. User accounts are not automatically synchronized between vaults.
Related Objects in Separate Vaults

The interaction between several vaults enables creation of relationships between objects across vaults. The objects are not exported from one vault to another; instead, the relationship is created by reference to an object in another vault; that is, a link is created to the original object. The object types of the objects must be associatable, but synchronization of the objects (replication of content) is not required, because the objects are not transferred from one vault to another. For more information, see Relationships Between Objects in Separate Vaults.

Synchronization of Objects and Their Values Between Vaults

This section provides further information on synchronization of objects and their values. We recommend studying this section before defining any synchronization jobs. Synchronization is implemented via Content Replication and Archiving.

Synchronizing Objects

When the metadata structures of vaults have been defined according to your needs and the required metadata definitions can be associated with them, the actual synchronization of objects and values can be performed between vaults. Synchronization of data between vaults is performed with replication of content. For more information, refer to Content Replication and Archiving and Replication and Archiving User’s Guide.

Note: Only the values for which there is a built-in object type are synchronized automatically. For other object types, either the alias or the combination of ID and name must match, so that objects of this object type are imported to the target vault during import. You should check that these definitions are in proper order. For more information, see Associating the Metadata Definitions.

Conflicts and their resolution

If objects are edited at the same time in multiple vaults, conflicts may result during synchronization of data, for example, from source vault A to target vault B. When detecting a conflict, M-Files creates a so-called conflict object, from which the conflict can be resolved in favor of either the source or the target vault.

You can find these conflict objects through relations: if the object has conflicts, you can find them under the Conflicts grouping title. You can also find all conflict objects by means of the Conflicts view (hidden by default).

Resolve conflicts by keeping the changes in the target vault (Keep These Changes) or discarding them (Discard These Changes), as appropriate. The latter chooses the version in the source vault. When resolving the conflict, you must have editing rights to the actual object and the conflict object in the same vault.

If two-way synchronization (replication of contents) is performed, you must resolve the conflict in both vaults to rectify the conflict situation.

Publishing selected objects of one vault in another vault

If you want to publish only certain objects from a vault by using another vault, you can do this by using a search filter when defining the content export. You should also check that the object types of the published objects can be associated either automatically or based on aliases.
Synchronizing Metadata Values

Value list values

When the metadata structures of vaults have been defined according to your needs and the required metadata definitions can be associated, the actual synchronization of objects and their values can be performed between vaults. Data synchronization between different vaults is performed with replication of contents.

However, you should note that if the value does not exist in the target vault or you cannot create it as a normal value-list value during import (for example, in the case of built-in values, such as classes, workflows, and users), the value name is displayed in metadata in the form "Value name XYZ (deleted)". In other words, if the value does not exist in the metadata structure of the target vault after import, it is shown as a "Value name XYZ (deleted)" value.

Note: The default permissions for the imported values are the target vault's default permissions for new values set from value lists. This means that the name of the value may be shown regardless of its permissions in the source vault. For example, the name of the document creator is shown in the metadata of the published document via the "Created by: User XYZ (deleted)" value. If necessary, check the permissions and association of the metadata definitions if you do not want to display this information in the other vault.

Related objects

The object metadata contains information on other, related objects. For example, a document might be related to a project or a customer.

When objects are exported to another vault, you may not want to export their related objects to the target vault. For example, you export documents to the target vault but not projects or customers (for instance, in publishing operations, you publish price lists and brochures but not customer information). Then the related object is shown as a shortcut in the object's metadata (or, less frequently, with the "Value name XYZ (deleted)" value). The object refers to the source vault and has not been imported as a genuine object to the target vault. For further information, refer to Relationships between objects in separate vaults under Object Relationships.

Note: The default permissions for the related object are the target vault's default permissions for new objects set in the import by object type. This means that the name of the related object is shown in the metadata of the imported/published object regardless of its permissions in the source vault. For example, the name of the customer or project may be shown in metadata of the published document as a shortcut or as a "Value name XYZ (deleted)" value. If necessary, check the permissions and association of the metadata definitions if you do not want to display this information in the other vault.

3.2. Configuring M-Files

This section offers guidance on personalizing the system to function and behave according to the requirements of your organization. In addition to instructions on modifying the metadata structure of your vault, the topics under this section deal with themes such as adding and editing workflows, installing and using vault applications, editing notification settings, and making use of event handlers and scripts.

In this chapter

- Editing the Vault Metadata Structure
- Managing Users and User Groups
3.2.1. Editing the Vault Metadata Structure

M-Files Admin enables you to modify the metadata elements of the vault, such as object types, value lists, property definitions and classes. Classes can also further be categorized into class groups. The document and object metadata is utilized almost everywhere in M-Files, such as in views and search functions, and therefore the metadata structure of the vault should be carefully planned.
You can browse and edit the vault metadata structure either as a hierarchical view or as a flat view.

Complete the following steps to browse and edit your vault metadata structure:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand either Metadata Structure (Hierarchical View) or Metadata Structure (Flat View).

In the Metadata Structure (Hierarchical View) and Metadata Structure (Flat View) sections, you can create new metadata elements, such as object types, to the vault metadata structure or modify existing
In this chapter

- Object Types
- Value Lists
- Property Definitions
- Classes
- Class Groups

Object Types

M-Files uses object types to define the objects to be stored. Built-in object types include documents and document collections, but depending on the needs of the organization, you can also define object types like customer, contact, or project in the vault. They can then be managed via M-Files, storing the change history of these objects as well.

Besides versioning, M-Files enables sorting in dynamic views, protection against concurrent editing, easy-to-use permissions functionality, and extremely versatile search capabilities for all objects.

The metadata card is provided both for documents as well as for other object types. Other object types differ from documents in that they need not contain any files whereas documents are always based on at least one file (such as a Word document).

Creating a New Object Type

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Metadata Structure (Flat View) and then select Object Types.
   - The Object Types list is opened in the right pane.
5. Click New Object Type... on the task area.
   - The Object Type Properties dialog is opened.
6. In the **Name (singular)** field, type in an appropriate name for the object type in the singular form.

7. In the **Name (plural)** field, type in the same name in the plural form.
8. Optional: Click **Change Icon**... to change the icon of the object type.
   a) Select an icon from the list or click **Browse**... to browse for a different icon file.
   b) Click **OK** to change the icon.

   If you wish to restore the default icon, click **Use Default**.

9. Optional: If you want users to be able to create objects of this type in M-Files, check the **Users can create objects of this type** check box.
   a) If you want the object type to appear under the **Create** menu in the top pane and the task area, check the **Show the creation command in the task area** check box.

10. Optional: If you want users to be able to incorporate files into objects of this type, check the **Objects of this type can have files** check box.

11. Optional: Check the object types in the **The types of objects that users can browse for objects of this type** list that you want users to be able to browse when they right-click an object of this type and select **Relationships**.

    This setting does not affect the related objects displayed in the listing view (search results or a view) below the main object.

12. Using the **Default permissions for new objects** drop-down menu, select the default permissions for new objects of this type.

    You can click the ... button to adjust any existing permission settings.

13. Optional: Select the **Allow this object type to be used as a grouping level in views** check box to allow this object type to used for defining a grouping level within a view.

14. Optional: If you need to define an object type hierarchy, automatic permissions, a separate metadata search index, or aliases for the object type, open the **Advanced** tab.

    For further instructions on the options available in the **Advanced** tab, see **Advanced Object Type Properties**.

15. Optional: If you need to further refine the permissions for the new object type, define the permissions on the **Permissions** tab.

    For further instructions on defining object type permissions, see **Object Type Permissions**.

16. Optional: If you want to use an external database as the source of the objects for the new object type, define the external database connection on the **Connection to External Database** tab.

    For further instructions on defining the external database connection for the object type, see **Connections to External Databases for Object Types**.

17. Click **OK** to create the new object type.

The object type that you have just created is added to the **Object Types** list. You can now create objects of this type in M-Files.

**Advanced Object Type Properties**

On the **Advanced** tab of the **Object Type Properties** dialog, you can perform the following tasks for the selected object type:

- define an object type hierarchy
• define automatic permissions
• enable a separate metadata search index
• define aliases

Figure 105: The Advanced tab of the Object Type Properties dialog.

**Defining an Object Type Hierarchy**

Object types can have hierarchical relationships. For example, the relationship between a customer company and its contact person can be defined so that the Contact Person object type is a subtype of the Customer object type. Viewing the value list for the Customer object type also displays the contact persons filtered by customer.

**Note:** You cannot define an internal hierarchy for an object type.

Complete the following steps to define an object type hierarchy:
1. In M-Files Admin, access the **Advanced** tab of the **Object Type Properties** dialog for the object type that you want to modify.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, expand **Metadata Structure (Flat View)** and then select **Object Types**.

   ![The **Object Types** list is opened in the right pane.](image)

   e) Double-click the object type that you want to modify.

   ![The **Object Type Properties** dialog is opened.](image)

   f) Click the **Advanced** tab.

   ![The **Advanced** tab is opened.](image)
2. On the **Advanced** tab, do one or both of the following:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do the following task</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Define subtypes for this object type</strong></td>
<td>Click the <strong>Add...</strong> button, then select the object types to be added as subtypes of this object type, and click <strong>Add</strong>.</td>
</tr>
</tbody>
</table>

**Note:** You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the Shift key to select adjacent items on the list.

**Note:** You can remove a subtype by clicking **Remove**.
### If you want to

<table>
<thead>
<tr>
<th>Define this object type as a subtype of another object type</th>
<th>Do the following task</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Check the <strong>This object type is a subtype of the following object type</strong> check box and select the object type using the drop-down menu.</td>
</tr>
</tbody>
</table>

3. Click **OK** to save your changes and close the **Object Type Properties** dialog.

An object type hierarchy is created between the selected object types. In M-Files, when you create a new object that you have defined as a subtype of another object type, you will need to select an owner object for it. Thus a relationship is created between the owner and the subobject when the new object is created. *Defining Automatic Permissions for an Object Type*

An object receives automatic permissions when a value with automatic permissions is added to the object metadata. You can define automatic permissions for an object type so that when an object of the selected type is referred to in the metadata of another object, the object inherits the permissions of the object that it references.

**Note:** The automatic permission settings specific to a value list item always have priority over the settings made at value list and object type level. For more information on automatic permissions for value list items, see *Automatic Permissions for Value List Items*.

Complete the following steps to define automatic permissions for an object type:

1. In M-Files Admin, access the **Advanced** tab of the **Object Type Properties** dialog for the object type that you want to modify.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, expand **Metadata Structure (Flat View)** and then select **Object Types**.

   ![The Object Types list is opened in the right pane.]

   e) Double-click the object type that you want to modify.

   ![The Object Type Properties dialog is opened.]

2. In the **Object Type Properties** dialog, check the **This object type is a subtype of the following object type** check box and select the object type using the drop-down menu.

3. Click **OK** to save your changes and close the dialog.

4. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

5. In the left-side tree view, expand **Metadata Structure (Flat View)** and then select **Object Types**.

6. Double-click the object type that you want to modify.

7. In the **Object Type Properties** dialog, check the **This object type is a subtype of the following object type** check box and select the object type using the drop-down menu.

8. Click **OK** to save your changes and close the dialog.

9. Repeat steps 2-8 for each object type that you want to modify.
f) Click the **Advanced** tab.

- The **Advanced** tab is opened.
2. On the **Advanced** tab, click the **Define...** button.

   ✓ The **Automatic Permissions** dialog is opened.
3. Check the check box **Restrict the permissions of objects that refer to this value** to enable automatic permissions for the selected object type.

4. Complete one of the following tasks:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do the following task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the object permissions defined on the metadata card as automatic permissions</td>
<td>Check the <strong>Use the object’s own permissions</strong> check box.</td>
</tr>
<tr>
<td>Use a predefined named access control list as automatic permissions</td>
<td>Check the <strong>Use named access control list</strong> check box and then use the drop-down menu to select a predefined named access control list.</td>
</tr>
<tr>
<td>Use custom permission settings as automatic permissions</td>
<td>Click the <strong>Add...</strong> button, then select the users or user groups to be added to the custom permission settings, and click <strong>Add</strong>.</td>
</tr>
<tr>
<td>If you want to</td>
<td>Do the following task</td>
</tr>
<tr>
<td>---------------</td>
<td>----------------------</td>
</tr>
<tr>
<td>Note: You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the ⇧ Shift key to select adjacent items on the list.</td>
<td></td>
</tr>
<tr>
<td>Note: You can remove a user or group from the settings by clicking <strong>Remove</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

Select a user or group in the **Users and user groups** list and grant permissions in the **Permissions** listing by checking either the **Allow** or **Deny** check box for a permission.

5. Optional: Check the **Allow users to deactivate these restrictions** check box if you want vault users to be able to disable the automatic permissions granted by these settings.

6. Click **OK** to close the **Automatic Permissions** dialog.

7. Back in the **Object Type Properties** dialog, either:

   a. Click **Apply** to save your automatic permission settings.

   or

   b. Click **OK** to save your automatic permission settings and to close the **Object Type Properties** dialog.

The selected object type now has automatic permissions. Now when an object of this object type is referred to in the metadata of another object, the referring object inherits the permissions of the object that has automatic permissions set.

*Using a Separate Metadata Search Index for an Object Type*

You might want to enable the **Use a separate metadata search index for this object type** option for essential object types that are frequently used and that are found in large number in the vault.

Since these essential object types vary from organization to organization, the option is disabled by default. In document management, for instance, the **Document** object type is naturally the most important object type. In CRM vaults, however, the most important object types are usually something different, such as **Customer**, **Project**, **Contact person**, and so on.

Enabling this option makes M-Files use a separate search structure for the objects of the selected object type. This improves search speed for both the objects of the selected object type and for other objects – especially if the vault contains a high number of objects representing this key object type.

**Note:** Enabling this option might take a long time to complete, from a couple of minutes up to a few hours. The vault is also taken offline for the duration of this operation, preventing any users from accessing the vault.

Complete the following steps to enable a separate metadata search index for an object type:
1. In M-Files Admin, access the **Advanced** tab of the **Object Type Properties** dialog for the object type that you want to modify.

   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, expand **Metadata Structure (Flat View)** and then select **Object Types**.

   ![Image](image.png) 
   The **Object Types** list is opened in the right pane.

   e) Double-click the object type that you want to modify.

   ![Image](image.png) 
   The **Object Type Properties** dialog is opened.

   ![Image](image.png) 
   f) Click the **Advanced** tab.

   ![Image](image.png) 
   The **Advanced** tab is opened.
2. Check the check box **Use a separate metadata search index for this object type**.

3. Click **OK** to close the **Object Type Properties** dialog.

M-Files now uses a separate search index for the objects of the selected object type.

**Defining Aliases for an Object Type**

Aliases can be used for identifying semantically equivalent metadata. For example, when importing objects from another vault, their *Date* and *Description* properties can be mapped to the target vault's equivalent properties on the basis of aliases even if the properties' internal IDs, names, or both are different. That is, the aliases refer to semantically equivalent metadata in different vaults, or in other words, alias is a common ID for the same metadata definition between several vaults.

The alias is defined as a common ID with the same name in both source and target vault.

When defining the alias, you can use various external data type and archive standards, such as SÄHKE2, MoReq2, and Dublin Core.

For more information, see **Associating the Metadata Definitions**.
Complete the following steps to define aliases for an object type:

1. In M-Files Admin, access the **Advanced** tab of the **Object Type Properties** dialog for the object type that you want to modify.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, expand **Metadata Structure (Flat View)** and then select **Object Types**.

   The **Object Types** list is opened in the right pane.

   e) Double-click the object type that you want to modify.

   The **Object Type Properties** dialog is opened.

   ![Object Type Properties dialog](image)

   f) Click the **Advanced** tab.

   The **Advanced** tab is opened.
2. In the **Aliases** field, enter the aliases for the selected object type.

   If you need to define more than one alias, separate the aliases using semicolons (;).

   ```text
   ObjectType.Customers; OT.Customers
   ```

   When you have automatic aliases in use and you write a name on the **General** tab, the **Aliases** field on the **Advanced** tab is automatically filled in. The alias has the format `<predefined prefix>.<name>`. Define automatic aliases for your vault in the **configurations editor**.

3. Click **OK**.

**Object Type Permissions**

Access for viewing this object type and creating objects of this type can be defined on the **Permissions** tab.
If the user does not have the permission to view the name of the object type, it is not available for selection in M-Files Desktop (for example when you are creating a new object or search). Even if the object type name is hidden, the user can see the objects themselves in views or search results, for example.

If you cannot see the object type name, you do not have the permission to create objects of this type either. However, the user may have the permission to see the name without having permission to create new objects.

**Adjusting Permissions**

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, click the appropriate node or subnode of the vault and select the desired item from the list on the right or from the left-side tree view.

5. Right-click the item and select **Properties** from the context menu.

6. Go to the **Permissions** tab.

7. From the **Users and user groups** list, select the user or user group whose permissions you want to adjust.

   ![Users and user groups](image)

   - If the user or user group is not on the list, click **Add...** to add the user or user group to the list.

8. Either:

   a. Check the **Allow** check box to allow the selected user to see this item.

   or

   b. Check the **Deny** check box to deny the selected user from seeing this item.

9. Optional: If you want to adjust additional permissions, repeat the steps 7 and 8.

10. Click **OK** once you are done.

You have adjusted the view permissions of the selected item for the selected users.

**Connections to External Databases for Object Types**

You can set M-Files to update any object type to and from an external database.
The example below describes how to define any object type to use an external database connection to Microsoft SQL Server.

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand Metadata Structure (Flat View), and then select Object Types.
   - The object type listing is opened in the right pane.

5. In the right-pane listing, right-click the object type of your choice and select Properties from the context menu.

6. Select the Connection to External Database tab.
   - The Connection to External Database tab is opened.
Use a connection to an external database to import and modify objects that reside in the external database.

**OLE DB connection string (from server):**

**SELECT statement:**

**Columns:**

<table>
<thead>
<tr>
<th>Source Column</th>
<th>Target Property</th>
<th>Update</th>
<th>Insert</th>
</tr>
</thead>
</table>

If you want to allow users to modify the data in the external database from within M-Files, specify the SQL statements that M-Files Server can use to create, modify, or delete records in the external database:

**UPDATE statement for modifying an existing record:**

**INSERT INTO statement for creating a new record:**

**SELECT statement for getting the ID of the new record after insertion:**

**DELETE statement for deleting a record:**

**Disabled**
7. Enable the option **Use a connection to an external database to import and modify objects that reside in the external database.**

8. Click the **Define...** button next to the **OLE DB connection string (from server)** field.

   The syntax of the connection string depends on the OLE DB (Object Linking and Embedding Database) supplier used for establishing the connection to the external database. If Open Database Connectivity (ODBC) is required to establish a connection, the data store has to be accessed over OLE DB and ODBC. For a list of recommended providers, see **Provider Recommendations for External Database Connections**.

   **Note:** M-Files Admin only displays OLE DB providers that are available on the computer running M-Files Admin. If your M-Files Server resides on a different host, ensure that the selected OLE DB connection string works from the computer running M-Files Server as well.

   The **Data Link Properties** dialog is opened.

9. On the **Provider** tab, select **Microsoft OLE DB Driver for SQL Server** from the list and click **Next >>**.

   The other providers may have slightly different options on the **Connection** and **Advanced** tabs. The **All** tab contains all the available connection properties as a name–value table.

   **Note:** We do not recommend the use of Microsoft Access Database Engine Redistributables to import value lists or object types from an Excel file. For more information, see the support article **Access ODBC driver not supported - Solution available**.

   The **Connection** tab of the **Data Link Properties** dialog is opened.

10. To the **Select or enter a server name** field, input the name of your Microsoft SQL Server.

11. In the **Enter information to log on to the server** section, select either:

    a. **Windows Authentication**: Select this option to use a Microsoft Windows account for logging in. In this case the connection uses the credentials that are used for running the M-Files Server service.

       or

    b. **SQL Server Authentication**: Select this option to use a Microsoft SQL Server login. Enter the credentials in the **User name** and **Password** fields, and check the **Allow saving password** check box.

12. For the **Select the database** section, either:

    a. Use the drop-down menu to select the database on the server you defined above.

       or

    b. Enter a database name to the **Attach a database file as a database name** field and use the **...** button to select a Microsoft SQL Server Database (MDF) file.

13. Optional: Click **Test Connection** to ensure that your database connection is working properly.

14. Optional: On the **Advanced** tab, define a timeout period for the database connection.
15. Click OK to close the Data Link Properties dialog.

   The dialog is closed, the Connection to External Database tab of the Object Type Properties
dialog is active, and your newly defined connection string is added to the OLE DB connection
string (from server) field.

16. Back on the Connection to External Database tab, enter the SELECT statement for retrieving
properties from the database to the SELECT statement field.

   Examples of SELECT statements:

   SELECT CustomerNumber, CustomerName FROM Customer
   SELECT ID, Name + ' ' + Department FROM Company
   SELECT ID, Name, CustomerID FROM Contacts
   SELECT * FROM Customer

17. Click the Refresh Columns button to fetch the data defined in your SELECT statement to the Columns
listing.

   The Columns listing displays correspondences between columns fetched from an external
database (Source Column) and document vault property definitions (Target Property).

18. Map the Source Column properties with properties in your M-Files vault (listed in the Target Property
column).

   Note: When you want to map multiple values to a property of the Choose from list
(multi-select) data type, the values must be recorded on their own rows in the external
database. For instance, the values should be recorded like this if you want to map
multiple values to the Industry property:

<table>
<thead>
<tr>
<th>ID</th>
<th>Customer name</th>
<th>City</th>
<th>Industry</th>
<th>Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC-123</td>
<td>ESTT Corporation</td>
<td>New York</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>ABC-123</td>
<td>ESTT Corporation</td>
<td>New York</td>
<td>101</td>
<td>1</td>
</tr>
<tr>
<td>ABC-123</td>
<td>ESTT Corporation</td>
<td>New York</td>
<td>108</td>
<td>1</td>
</tr>
</tbody>
</table>

   In this case, however, data can only be read from, not recorded to the external database.

19. Check the check boxes in the Update and Insert columns and define the four statements below the
Columns listing according to the following table:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Complete the following steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow read-only access</td>
<td>Do not check any of the check boxes and leave the statements empty.</td>
</tr>
<tr>
<td>Allow users to update but not create or delete information</td>
<td>a. Check the check boxes in the Update column for the properties of your choice.</td>
</tr>
</tbody>
</table>
If you want to... | Complete the following steps:
--- | ---
| b. Click the Default button next to the UPDATE statement field – or enter your own statements to the field. |

**Allow users to update, create, and delete information**

| a. Check the check boxes in the Update and Insert columns for the properties of your choice. |
| b. Click the Default button next to the UPDATE, INSERT INTO, SELECT, and DELETE statement fields – or enter your own statements to these four fields. |

The table below explains the use of the four statements mentioned above.

<table>
<thead>
<tr>
<th>Statement</th>
<th>Definition</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>UPDATE</strong></td>
<td>When you edit an object in M-Files, M-Files Server edits the corresponding record in the external database using an UPDATE statement. Use a question mark (?) to signal columns to be updated.</td>
<td>UPDATE Customers SET CustomerName = ? WHERE CustomerID = ? UPDATE Contact SET Name = ?, CustomerID = ? WHERE ContactID = ?</td>
</tr>
<tr>
<td><strong>INSERT INTO</strong></td>
<td>When you create a new object in M-Files, M-Files Server adds a corresponding record into the external database using an INSERT INTO statement. Use a question mark (?) to indicate the value of each column. <strong>Note:</strong> The INSERT INTO statement input to M-Files does not define a value for the ID column. The database should be set up to automatically provide an ID for new records. For example in SQL Server databases, set the type of the ID column as identity. If the external database cannot produce new ID values, the INSERT INTO statement cannot be used.</td>
<td>INSERT INTO Customers( CustomerName ) VALUES( ? ) INSERT INTO ContactPersons( Name, CustomerID ) VALUES( ?, ? )</td>
</tr>
<tr>
<td><strong>SELECT</strong></td>
<td>After a new record has been created with the INSERT INTO statement, M-Files Server gets the ID of the newly created record with this SELECT statement.</td>
<td>SELECT MAX( CustomerID ) FROM Customer</td>
</tr>
</tbody>
</table>
Statement | Definition | Examples
--- | --- | ---
DELETE | When you delete an object from M-Files, M-Files Server deletes the corresponding record in the external database using a DELETE statement. Use a question mark (?) for the ID of the record to be deleted. | DELETE FROM Customers WHERE CustomerID = ?
 |  | DELETE FROM Contacts WHERE ContactID = ?

20. Optional: Check the **Disabled** check box if you would like to temporarily disable the external database connection.

If the connection is disabled, any information between the vault and the external database is not synchronized. The synchronization can be re-enabled at any time by unchecking this check box.

21. Once you are done, click **OK** to close the dialog.

The object type is now updated to and from an external database according to your connection definition.

**In this chapter**

- Refreshing External Object Types
- Provider Recommendations for External Database Connections

**Refreshing External Object Types**

There are two types of refresh operations for external object types:

- full refresh
- quick refresh

A full refresh detects new items, compares and updates existing items, and deletes items that have disappeared from the external database.

A quick refresh, by default, only detects new items in the external database. It does not compare existing items. It does not delete items, either, because undeleting them would require a full refresh.

The quick refresh operation is notably quicker than the full refresh operation. For reference, the full refresh operation for 120,000 items takes about two minutes, while the quick refresh operation finishes in about seven seconds.

For simple value lists, refreshing data is fast even with large amounts of data and therefore a full refresh is always used. This guarantees up-to-date data.

**Refreshing external object types manually**

External object types can be refreshed in M-Files Desktop by pressing the Alt key and selecting **Settings > Refresh External Objects** and then by selecting a suitable external object type from the submenu. You can select either the **Quick Refresh** or the **Full Refresh** operation.

If M-Files Server is refreshing an external object type, the refresh operation initiated by the user is started only after the currently running job is finished.
Refreshing external object types via M-Files Admin

Administrators can initiate the full refresh operation for any external object type in M-Files Admin by right-clicking the object type under Metadata Structure (Flat View) and selecting Refresh Now from the context menu. Administrators can also stop refresh operations using M-Files Admin.

The full refresh operation is also triggered if an administrator edits the object type definitions in M-Files Admin. Subsequent object type definition updates will stop the possible previously running refresh.

Automatic refresh operations and configuration options

The quick refresh operation is started automatically if an external object type is requested by a client (for instance, the metadata card containing a property that uses an external object type is viewed) and if the latest refresh was executed more than 15 minutes ago.

A full refresh operation is initiated for all external object types at 4:30 AM server time every night. This operation is executed as one part of the nightly maintenance routine.

A full refresh operation is automatically triggered instead of a quick refresh operation if an external object type is requested by the client and if a full refresh has not been performed within the last 25 hours.

For configuration options available for refreshing external object types automatically, see the document Default Refresh Logic and Configuration Options for External Value Lists and Object Types.

Provider Recommendations for External Database Connections

The table below lists the recommended OLE DB providers to be used for an external database connection (see Connections to External Databases for Object Types).

<table>
<thead>
<tr>
<th>Database</th>
<th>Provider</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft SQL Server</td>
<td>Microsoft OLE DB Driver for SQL Server (MSOLEDBSQL)</td>
</tr>
</tbody>
</table>

Note: Using the following, deprecated providers is not recommended:

- Microsoft OLE DB Provider for SQL Server (SQLOLEDB)
- SQL Server Native Client OLE DB Provider (SQLNCLI)

MySQL | Microsoft OLE DB Provider for ODBC Drivers (MySQL Connector/ODBC).

- Use the Data sources (ODBC) administrative tool to configure a new system data source.
- Select MySQL Connector/ODBC as the ODBC driver.
- Define the data source.
- Under driver properties, select the Disable Transactions check box.

In connection settings, select Microsoft OLE DB Provider for ODBC Drivers as the provider and the system data source you defined as the data source. The default collection in the connection settings remains empty. Thus you only define the database in the driver settings.

You can also use MySql.OLEDB Provider with MySQL.
Value Lists

A value list contains various values, such as city names. The same value list can be utilized in several different properties.

A value list is one of the M-Files data types. Creating and using value lists makes it significantly faster to specify metadata for a document. In many cases, selecting a value from the list is more sensible than typing it in each time. On the other hand, not all values can reasonably be selected from a list, such as the title of the object.

Figure 106: Value lists can be used for storing and selecting preset values for metadata properties. Several different properties can be based on the same value list.

Complete the steps below to view the value lists in your vault:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand Metadata Structure (Flat View) and then select Value Lists.

You should now be able to see the available value lists in the right-side listing view. To also display the built-in value lists, click Show All Value Lists on the task area.

In this chapter

- New Value List
- Value List Contents (Individual Values)
- Advanced Value List Properties
New Value List

A value list can either be internal or external.

The contents of an internal value list are saved in the document vault database, meaning that the list is used only inside the document vault. An external value list, on the other hand, can be updated from an external database. In this case, you need to define how the server is to retrieve the value list contents from the other database. For example, an employee database running on an external database server can be connected to the M-Files value lists by defining the database connection. See Connections to External Databases for Value Lists.

Creating a New Value List

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Metadata Structure (Flat View), and then select Value Lists.
5. Click New Value List... on the task area.

The Value List Properties dialog is opened.
6. In the **Name (singular)** and **Name (plural)** fields, enter the name of the new value list respectively in singular (for example, *Client*) and plural (for example, *Clients*) forms.

7. Optional: Check the **Allow users to add new values to this list** if you want to allow users to add new values to the value list.

8. From the **Default permissions for new values** drop-down menu, select the default permissions for new values in this value list.
9. Optional: Check the **Allow this value list to be used as a grouping level in views** check box to allow this value list to be used for defining a grouping level within a view.

10. Optional: On the **Advanced** tab, set hierarchical relationships for the value list.

   See [Advanced Value List Properties](#) for more information.

11. Optional: On the **Permissions** tab, you can specify the users who may see this value list or add new values to it.

   See [Value List Permissions](#) for more information.

12. Optional: On the **Connection to External Database**, set the connection to an external database for importing value list contents from an external database source.

   For further instructions, see [Connections to External Databases for Value Lists](#).

13. Click **OK** to finish creating the value list.

The new value list is added to the **Value Lists** list.

### Converting a Value List to an Object Type

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand **Metadata Structure (Flat View)** and then select **Value Lists**.

5. From the **Value Lists** list, select the value list that you want to convert to an object type.

6. Click **Convert to Object Type** on the task area.

   The **Convert to Object Type** dialog appears.

7. You are prompted to confirm that you want to convert the selected value list to an object type. Click **Yes**.

   Once you have clicked **Yes**, you cannot undo the conversion.

The selected value list is converted to an object type and removed from the **Value Lists** list and added to the **Object Types** list.

### Value List Contents (Individual Values)

You can create new items for the value list as well as new subitems for internally hierarchical values. You can also define hierarchical relationships between value list items (see [Defining a Hierarchical Relationship Between Value Lists](#)). Additionally, you can set value-specific permissions as well as default permissions for objects that use the item.
Figure 107: The "Contact persons" value list used as a sublist for the "Customers" value list.

**Permissions**

By selecting a value list item and clicking the **Permissions...** button, you can specify the users who may see this value list item. This way, you can make a value list value to be visible to a specific target group only.
Automatic permissions

An object receives automatic permissions when a value with automatic permissions is added to the object metadata.

You can activate the automatic permissions by value, value list, object type, or class by clicking Permissions... in the Value List Contents dialog and then selecting the Automatic Permissions tab. For more information, see Automatic Permissions for Value List Items.

In this chapter

- Adding Values to a Value List
- Automatic Permissions for Value List Items

Adding Values to a Value List

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Metadata Structure (Flat View) and then select Value Lists.

   The Value Lists list is opened in the right pane.

5. Right-click a value list to which you want to add individual values and select Contents... from the context menu.

   The Value List Contents dialog is opened.

6. Click the New Item button.

   A new value titled New Item is added to the selected value list.

7. Type in an appropriate name for the new value.

   You can rename existing values by selecting a value from the list and clicking the Rename button.

8. Optional: Click Permissions... to specify the users who may see this value list item.

   For detailed instructions, see Value List Permissions and Automatic Permissions for Value List Items.

9. Optional: Click Change Icon... to change the icon of the value list item.

   In addition to being able to add icons for object types, you can add, change, and remove icons for value list items. This allows you to further increase the clarity of the M-Files user interface. Specific icons can be assigned to, for instance, workflow states and meeting types. Since workflow states can be changed directly with the shortcuts in the task area or from the metadata card, icons can be used to make the states visually more distinguishable. For detailed instructions, see Changing the Icon of a Value in a Value List.

10. Optional: Repeat steps from 6 to 9 to add another value.
11. Click **Close** when you are done.

The new values are added to the selected value list.

**Changing the Icon of a Value in a Value List**

In addition to being able to add icons for object types, you can add, change, and remove icons for value list items. This allows you to further increase the clarity of the M-Files user interface.

Specific icons can be assigned to, for instance, workflow states and meeting types. Since workflow states can be changed directly with the shortcuts in the task area or from the metadata card, icons can be used to make the states visually more distinguishable.

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand **Metadata Structure (Flat View)** and then select **Value Lists**.
   - The **Value Lists** list is opened in the right pane.
5. Right-click a value list that you want to edit and select **Contents...** from the context menu.
   - The **Value List Contents** dialog is opened.
6. Select a value from the list and click the **Change Icon...** button.
   - The **Change Icon** dialog is opened.
7. Either:
   a. Select an icon from the list of icons.
      - or
   b. Click **Browse...** to browse for a different icon file and then select an icon from the list of icons.
8. Click **OK** to change the icon and close the **Change Icon** dialog.
9. Repeat the steps from 6 to 8 to change the icon for another value.
10. Click **Close** when you are done to close the **Value List Contents** dialog.

**Automatic Permissions for Value List Items**

You can use automatic permission settings to pass permissions for an object when the object has a property value, object type or class that uses automatic permissions. The object receives automatic permissions when a value with automatic permissions specified is added to the object metadata.
Figure 108: The "Automatic Permissions" dialog for a value list item.

In the above example, automatic permissions have been activated. Read-only access has been granted to all users and a separate access to project managers.
Restrict the permissions of objects that refer to this value

Activate the function *Restrict the permissions of objects that refer to this value* when you want to activate the automatic permissions.

Use the value's own permissions

You can use the permissions of a value or object, such as a project, as automatic permissions.

In this type of case, for example, a project plan inherits the permissions of the project that is added as a value to the metadata of the project plan. For example, the user has defined permissions for the project *House project Haven* that allow access for the project manager and project group only. When this project is added to the metadata of a project plan, the same permissions are granted to the plan.

Note: Automatic permissions are not inherited indirectly. Let’s say we have the object “Hugh Brent” that inherits automatic permissions via the “Look Up Company” property. These permissions are no longer inherited by the “CRM Application Development” object that has “Hugh Brent” as one of its property values.

Name

Give as descriptive a name as possible to the automatic permissions set, because this information will be displayed in the client software.

Specify permissions

You can then specify the automatic permissions that are always activated automatically for the object when a value, object, or class using automatic permissions is added to the object’s metadata.

For more information on permissions, see *Object Permissions*. Also refer to the specification of pseudo-users in *Pseudo-users*.

Note: If you do not explicitly allow any permissions, using this kind of value or object restricts all permissions for the final object.

Allow users to deactivate these restrictions

You can also specify whether the users are allowed to deactivate the automatic permission restrictions created via this value, so that the users can delete the preset automatic permissions if they so desire.

Remarks about using automatic permissions

The specified value providing automatic permissions must be selected on the metadata card for the explicit property definition for which you have enabled automatic permissions. See *Verifying Which Properties Have Automatic Permissions Enabled*.

Note: The value-specific settings always have priority over the settings made at value list and object type level.

Enabling Automatic Permissions for a Value List Item

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand **Metadata Structure (Flat View)** and then select **Value Lists**.
   
   The **Value Lists** list is opened in the right pane.

5. Right-click a value list that you want to edit and select **Contents...** from the context menu.
   
   The **Value List Contents** dialog is opened.

6. Select a value list item that you want to edit and click the **Permissions...** button.
   
   The **Permissions** dialog is opened.

7. On the **Automatic Permissions** tab, check the **Restrict the permissions of objects that refer to this value** check box.

8. Do one of the following:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use the existing permissions of the value as automatic permissions</td>
<td>Check the <strong>Use the value's own permissions</strong> check box.</td>
</tr>
<tr>
<td>Use an existing named access control list as automatic permissions</td>
<td>Check the <strong>Use named access control list</strong> check box and, using the drop-down menu, select a named access control list.</td>
</tr>
<tr>
<td>Define new permissions to be used as automatic permissions</td>
<td>In the <strong>Name</strong> field, type in a name for the permissions, click <strong>Add...</strong> to add users or user groups affected by these permissions, and select the appropriate <strong>Allow</strong> or <strong>Deny</strong> check boxes on the <strong>Permissions</strong> list.</td>
</tr>
</tbody>
</table>

9. Optional: Select the **Allow users to deactivate these restrictions** check box if you want to give users the option to disable the automatically set permissions and employ user-defined permissions instead.

10. Click **OK** to close the **Permissions** dialog.

11. Click **Close** to close the **Value List Contents** dialog.

   The selected value now has automatic permissions defined. When this value is added to the metadata of an object, the object receives the automatic permissions defined for the value.

Verifying Which Properties Have Automatic Permissions Enabled

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the tree view, expand **Metadata Structure (Flat View)**.

5. Select the **Property Definitions** node.
You can see which properties have automatic permissions enabled in the *Automatic Permissions* column of the listing area.

**Advanced Value List Properties**

*Value list hierarchy*

Value lists can have two types of hierarchical relationships:

- Internal hierarchies within individual value lists
- Hierarchies between separate value lists
Defining an Internal Hierarchy for a Value List

A value list can be *hierarchical in itself*, meaning that it can contain items and subitems. A parent item collects related subitems. This way, you can create, for example, a value list containing all drawing types hierarchically. The parent object can be for instance a floor plan, with floor plans in different scales as its
subobjects. Regardless of their internal hierarchy, all items in the hierarchical value list represent the same concept (for example, the parent item Floor plan and its subitems Floor plan 1:100 and Floor plan 1:50).

Do the following steps to define an internal hierarchy for a value list:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Metadata Structure (Flat View) and then select Value Lists.

   - The Value Lists list is opened in the right pane.
5. Double-click the value list that you want to edit.

   - The Value List Properties dialog is opened.
6. Open the Advanced tab, and check This value list is a sublist of the following value list check box.
7. Using the drop-down menu, select the Same list (defines a value list with internal hierarchy) option.
8. Click the Contents... button.

   - The Value List Contents dialog is opened.
9. Select an item on the list for which you want to create a subitem and click New Subitem.
10. Type in an appropriate name for the new item.
    - You can also rename the item later by selecting the item in the list and clicking Rename.
11. Optional: If you want to create additional subitems, repeat the steps 9 and 10.
12. Click Close when you are ready.

   The value list items that you have just created are added to the value list as subitems of the selected owner value list items. When you assign a value to a property from the aforementioned value list, you can select a subitem by clicking the down arrow next to a value list item to expand its subitems.

Defining a Hierarchical Relationship Between Value Lists

If a parent item and subitems represent different concepts, such as countries and their cities, separate value lists must be created for the items and the value lists must be defined as two hierarchically related value lists. In such a case, the item in the Countries value list (country name) is the owner value for the items in the Cities value list. The Countries value list is then the higher-level list and the Cities list is its sublist.

Do the following steps to define a hierarchical relationship between two value lists:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand **Metadata Structure (Flat View)** and then select **Value Lists**.

   - The **Value Lists** list is opened in the right pane.

5. Double-click the value list that you want to define as a sublist of a higher-level list.

   - Make sure that the property definition using this value list uses automatic filtering. For more information, see **Property Definitions**.
   - The **Value List Properties** dialog is opened.

6. Open the **Advanced** tab, and check **This value list is a sublist of the following value list** check box.

7. Using the drop-down menu, select the value list that you want to set as the owner of this value list.

8. Click **OK** to save your changes and close the **Value List Properties** dialog.

9. In the **Value Lists** list, find the value list that you have just set as the owner of the previous value list, right-click it, and select **Contents...** from the context menu.

   - The **Value List Contents** dialog is opened.

10. In the upper list, select the owner item for which you want to add a subitem.

11. Next to the lower list, click **New Item**.

   - A new value list item is added to the lower list.

12. Type in an appropriate name for the new subitem.

   - You can also rename the item later by selecting the item in the list and clicking **Rename**.

13. Optional: If you want to create additional subitems, repeat the steps from 10 to 12.

14. Click **Close** when you are ready to save your changes and close the **Value List Contents** dialog.

   The selected value list is defined as a sublist of the selected owner value list. When you assign a value to a property from the owner value list in M-Files, you can then also assign any associated subvalues from the sublist.

   **Default for automatic permissions**

   You can activate the automatic permissions by value, value list, object type, or class. You can specify the automatic permissions for each value list in the same way as for each value. The automatic permissions are attached to an object when a value with automatic permissions is added for the object.

   - **Note:** The value-specific settings always have priority over the settings made at value list and object type level.

   **The contents of this value list can be translated**

   Enable this option to allow the contents of the selected value list to be translated to different languages. For more information, see **Languages and Translations**.
**Value list aliases**

Using the **Aliases** field, you can define an alias for the value list. For more information, see [Associating the Metadata Definitions](#).

When you have automatic aliases in use and you write a name on the **General** tab, the **Aliases** field on the **Advanced** tab is automatically filled in. The alias has the format `<predefined prefix>.<name>`. Define automatic aliases for your vault in the [configurations editor](#).

**Value List Permissions**

Access for viewing this value list and creating items to the list can be defined on the **Permissions** tab.

If the user does not have the permission to view the name of the value list, it is not available for selection in M-Files (for example, when you are creating a new search).

If the user cannot see the value list, the user does not have the permission to create items to it either. However, the user may have the permission to see the list without having the permission to create new items.

**Adjusting Permissions**

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, click the appropriate node or subnode of the vault and select the desired item from the list on the right or from the left-side tree view.
5. Right-click the item and select **Properties** from the context menu.
6. Go to the **Permissions** tab.
7. From the **Users and user groups** list, select the user or user group whose permissions you want to adjust.

   ![Users and user groups](Image)

   If the user or user group is not on the list, click **Add...** to add the user or user group to the list.

8. Either:
   
   a. Check the **Allow** check box to allow the selected user to see this item.
or

b. Check the **Deny** check box to deny the selected user from seeing this item.

9. Optional: If you want to adjust additional permissions, repeat the steps 7 and 8.

10. Click **OK** once you are done.

You have adjusted the view permissions of the selected item for the selected users.

**Connections to External Databases for Value Lists**

You can set M-Files to update any value list to and from an external database.

The example below describes how to define any value list to use an external database connection to Microsoft SQL Server.

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand **Metadata Structure (Flat View)**, and then select **Value Lists**.

  ✅ The value list listing is opened in the right pane.

5. In the right-pane listing, right-click the value list of your choice and select **Properties** from the context menu.

6. Select the **Connection to External Database** tab.

  ✅ The **Connection to External Database** tab is opened.
7. Enable the option **Use a connection to an external database to import and modify objects that reside in the external database**.

8. Click the **Define...** button next to the **OLE DB connection string (from server)** field.

   The syntax of the connection string depends on the **OLE DB** (Object Linking and Embedding Database) supplier used for establishing the connection to the external database. If Open Database Connectivity (ODBC) is required to establish a connection, the data store has to be accessed over OLE DB and ODBC. For a list of recommended providers, see **Provider Recommendations for External Database Connections**.
Note: M-Files Admin only displays OLE DB providers that are available on the computer running M-Files Admin. If your M-Files Server resides on a different host, ensure that the selected OLE DB connection string works from the computer running M-Files Server as well.

The Data Link Properties dialog is opened.

9. On the Provider tab, select Microsoft OLE DB Driver for SQL Server from the list and click Next >.

The other providers may have slightly different options on the Connection and Advanced tabs. The All tab contains all the available connection properties as a name–value table.

Note: We do not recommend the use of Microsoft Access Database Engine Redistributables to import value lists or object types from an Excel file. For more information, see the support article Access ODBC driver not supported - Solution available.

The Connection tab of the Data Link Properties dialog is opened.

10. To the Select or enter a server name field, input the name of your Microsoft SQL Server.

11. In the Enter information to log on to the server section, select either:

   a. Windows Authentication: Select this option to use a Microsoft Windows account for logging in. In this case the connection uses the credentials that are used for running the M-Files Server service.

   or

   b. SQL Server Authentication: Select this option to use a Microsoft SQL Server login. Enter the credentials in the User name and Password fields, and check the Allow saving password check box.

12. For the Select the database section, either:

   a. Use the drop-down menu to select the database on the server you defined above.

   or

   b. Enter a database name to the Attach a database file as a database name field and use the ... button to select a Microsoft SQL Server Database (MDF) file.

13. Optional: Click Test Connection to ensure that your database connection is working properly.


15. Click OK to close the Data Link Properties dialog.

The dialog is closed, the Connection to External Database tab of the Value List Properties dialog is active, and your newly defined connection string is added to the OLE DB connection string (from server) field.

16. Back on the Connection to External Database tab, enter the SELECT statement for retrieving properties from the database to the SELECT statement field.

Examples of SELECT statements:

SELECT CustomerNumber, CustomerName FROM Customer
SELECT ID, Name + ' ' + Department FROM Company

SELECT ID, Name, CustomerID FROM Contacts

SELECT * FROM Customer

17. Click the **Refresh Columns** button to fetch the data defined in your SELECT statement to the **Columns** listing.

The **Columns** listing displays correspondences between columns fetched from an external database (**Source Column**) and document vault property definitions (**Target Property**).

18. Map the **Source Column** properties with properties in your M-Files vault (listed in the **Target Property** column).

**Note:** When you want to map multiple values to a property of the **Choose from list (multi-select)** data type, the values must be recorded on their own rows in the external database. For instance, the values should be recorded like this if you want to map multiple values to the **Industry** property:

```
<table>
<thead>
<tr>
<th>ID</th>
<th>Customer name</th>
<th>City</th>
<th>Industry</th>
<th>Active</th>
</tr>
</thead>
<tbody>
<tr>
<td>ABC-123</td>
<td>ESTT Corporation</td>
<td>New York</td>
<td>100</td>
<td>1</td>
</tr>
<tr>
<td>ABC-123</td>
<td>ESTT Corporation</td>
<td>New York</td>
<td>101</td>
<td>1</td>
</tr>
<tr>
<td>ABC-123</td>
<td>ESTT Corporation</td>
<td>New York</td>
<td>108</td>
<td>1</td>
</tr>
</tbody>
</table>
```

In this case, however, data can only be read from, not recorded to the external database.

19. Check the check boxes in the **Insert** column and define the two statements below the **Columns** listing according to the following table:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Complete the following steps:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow read-only access</td>
<td>Do not check any of the check boxes and leave the statements empty.</td>
</tr>
</tbody>
</table>
| Allow users to create but not update or delete information | a. Check the check boxes in the **Insert** column for the properties of your choice.  
  b. Click the **Default** button next to the INSERT INTO and SELECT statement fields – or enter your own statements to the fields. |

**Note:** The table below explains the use of the two statements mentioned above.
<table>
<thead>
<tr>
<th>Statement</th>
<th>Definition</th>
<th>Examples</th>
</tr>
</thead>
</table>
| INSERT INTO  | When you create a new value list item in M-Files, M-Files Server adds a corresponding record into the external database using an INSERT INTO statement. Use a question mark (?) to indicate the value of each column. | INSERT INTO Customers( CustomerName ) VALUES( ? )  
INSERT INTO ContactPersons( Name, CustomerID ) VALUES( ?, ? ) |

**Note:** The INSERT INTO statement input to M-Files does not define a value for the ID column. The database should be set up to automatically provide an ID for new records. For example in Microsoft SQL Server databases, set the type of the ID column as identity. If the external database cannot produce new ID values, the INSERT INTO statement cannot be used.

| SELECT       | After a new record has been created with the INSERT INTO statement, M-Files Server gets the ID of the newly created record with this SELECT statement.                                                       | SELECT MAX( CustomerID ) FROM Customer                                                                                                                        |

20. Optional: Check the **Disabled** check box if you would like to temporarily disable the external database connection.

If the connection is disabled, any information between the vault and the external database is not synchronized. The synchronization can be re-enabled at any time by unchecking this check box.

21. Once you are done, click **OK** to close the dialog.

The value list is now updated to and from an external database according to your connection definition.

**In this chapter**

- Refreshing External Value Lists
- Provider Recommendations for External Database Connections

**Refreshing External Value Lists**

There are two types of refresh operations for external value lists:

- full refresh
- quick refresh

A full refresh detects new items, compares and updates existing items, and deletes items that have disappeared from the external database.
A quick refresh, by default, only detects new items in the external database. It does not compare existing items. It does not delete items, either, because undeleting them would require a full refresh.

The quick refresh operation is notably quicker than the full refresh operation. For reference, the full refresh operation for 120,000 items takes about two minutes, while the quick refresh operation finishes in about seven seconds.

For simple value lists, refreshing data is fast even with large amounts of data and therefore a full refresh is always used. This guarantees up-to-date data.

**Refreshing external value lists manually**

External value lists can be manually refreshed via the metadata card by selecting a property that uses an external value list and clicking the **Refresh** icon in M-Files Desktop and in M-Files Web.

If M-Files Server is refreshing an external value list, the refresh operation initiated by the user is started only after the currently running job is finished.

**Refreshing external value lists via M-Files Admin**

Administrators can initiate the full refresh operation for any external value list in M-Files Admin by right-clicking the value list under **Metadata Structure (Flat View)** and selecting **Refresh Now** from the context menu. Administrators can also stop refresh operations using M-Files Admin.

The full refresh operation is also triggered if an administrator edits the value list definitions in M-Files Admin. Subsequent value list definition updates will stop the possible previously running refresh.

**Automatic refresh operations and configuration options**

The quick refresh operation is started automatically if an external value list is requested by a client (for instance, the metadata card containing a property that uses an external value list is viewed) and if the latest refresh was executed more than 15 minutes ago.

A full refresh operation is automatically triggered instead of a quick refresh operation if an external value list is requested by the client and if a full refresh has not been performed within the last 25 hours.

For configuration options available for refreshing external value lists automatically, see the document **Default Refresh Logic and Configuration Options for External Value Lists and Object Types**.

**Provider Recommendations for External Database Connections**

The table below lists the recommended OLE DB providers to be used for an external database connection (see **Connections to External Databases for Value Lists**).
**Database** | **Provider**
---|---
Microsoft SQL Server | Microsoft OLE DB Driver for SQL Server (MSOLEDBSQL)

     **Note:** Using the following, deprecated providers is not recommended:

     • Microsoft OLE DB Provider for SQL Server (SQLOLEDB)
     • SQL Server Native Client OLE DB Provider (SQLNCLI)

MySQL | Microsoft OLE DB Provider for ODBC Drivers (MySQL Connector/ODBC).

     • Use the Data sources (ODBC) administrative tool to configure a new system data source.
     • Select MySQL Connector/ODBC as the ODBC driver.
     • Define the data source.
     • Under driver properties, select the Disable Transactions check box.

In connection settings, select Microsoft OLE DB Provider for ODBC Drivers as the provider and the system data source you defined as the data source. The default collection in the connection settings remains empty. Thus you only define the database in the driver settings.

You can also use MySql.OLEDB Provider with MySQL.

**Property Definitions**

Property definitions are used for determining properties associated with classes. A property definition specifies the property name (which should naturally be as descriptive as possible) and the data type, which determines the type of the data entered (in relation to the property).

Various properties can be combined to create classes (refer to **Classes**). For example, **Contract of Employment** is a document class with the associated properties **Title**, **Document Date**, **Employee**, **Keywords** and **Description**.

The property definitions are used for determining the metadata on the metadata card. The properties that are associated with the document class are displayed on the metadata card after class selection.

**In this chapter**

- New Property Definition
- Property Definition Automatic Values
- Automatically Validating Property Values
- Built-in Property Definitions
- Property Definition Permissions
- Hierarchical Property Values

**New Property Definition**

In a new property definition, you need to specify the data type after assigning a name to the property. For example, if you are creating a property with the name **Document Date**, the logical data type choice is **Date**.
Property Definition data types

<p>| Text                  | Any typed text, for instance, a heading. This type of property accepts a maximum of 100 characters entered via the user interface. More characters can be entered via the M-Files API but values of over 100 characters will be cut and the full value is lost. |</p>
<table>
<thead>
<tr>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text (multi-line)</td>
<td>Any typed text. The text can have multiple lines.</td>
</tr>
<tr>
<td></td>
<td>This type of property accepts a maximum of 10,000 characters entered via the</td>
</tr>
<tr>
<td></td>
<td>user interface. More characters can be entered via the M-Files API, but this</td>
</tr>
<tr>
<td></td>
<td>may cause the value to not be shown in its entirety, as well as other</td>
</tr>
<tr>
<td></td>
<td>unwanted behavior in the user interface. For instance, attempting to insert</td>
</tr>
<tr>
<td></td>
<td>property values containing more than 10,000 characters into a Microsoft</td>
</tr>
<tr>
<td></td>
<td>Office document causes an error.</td>
</tr>
<tr>
<td>Choose from list</td>
<td>You can select one value from the options on the value list.</td>
</tr>
<tr>
<td>Choose from list (multi-select)</td>
<td>You can select several values from the options on the value list.</td>
</tr>
<tr>
<td>Date</td>
<td>You can select a date. As a default, M-Files suggests the current date.</td>
</tr>
<tr>
<td>Time</td>
<td>You can select a time.</td>
</tr>
<tr>
<td>Timestamp</td>
<td>This data type can be used for generating a timestamp with a script.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The timestamp needs to be defined as a calculated value. Go to</td>
</tr>
<tr>
<td></td>
<td>the Automatic Values tab of the Property Definition Properties dialog and</td>
</tr>
<tr>
<td></td>
<td>select the Calculated value (VBScript) option and click Edit Code... to</td>
</tr>
<tr>
<td></td>
<td>add the VBScript code for generating the timestamp.</td>
</tr>
<tr>
<td>Number (integer)</td>
<td>You can enter the desired integer.</td>
</tr>
<tr>
<td></td>
<td>The value can be anything between -2,147,483,648 and 2,147,483,647.</td>
</tr>
<tr>
<td>Number (real)</td>
<td>You can enter the desired real number.</td>
</tr>
<tr>
<td></td>
<td>The value can be anything between -1.79 x 10^{308} and 1.79 x 10^{308}.</td>
</tr>
<tr>
<td></td>
<td>You can enter the value in the format X\cdot 10^Y, where X is the number</td>
</tr>
<tr>
<td></td>
<td>to be multiplied, E represents the base number 10 and Y is the exponent.</td>
</tr>
<tr>
<td></td>
<td>For instance, entering -12E3 would result in the value -12,000.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This data type can present a wider range of numbers than Number</td>
</tr>
<tr>
<td></td>
<td>(integer) but at the cost of precision. Consequently, Number (real) should</td>
</tr>
<tr>
<td></td>
<td>not be used when the number value has to be absolutely accurate, such as</td>
</tr>
<tr>
<td></td>
<td>with values representing money. In those cases, it is recommended to use</td>
</tr>
<tr>
<td></td>
<td>Number (integer) as the data type.</td>
</tr>
</tbody>
</table>
Boolean (yes/no)  You can specify the Boolean value yes or no for the desired variable.

The data type indicates the type of the property. For example, if you create a new property named Confidential and specify Boolean (yes/no) as its data type, you need to select yes or no when filling in the Confidential field on the metadata card. This happens only if the property Confidential has been associated with the document class (Report, Memo, Agenda, etc.) to which the document you are creating belongs.

After creating this property, you can create a new view that lists the documents on the basis of whether they are confidential or not. You can group the documents into the Yes and No property folders by using the view hierarchy.

Value lists can be efficiently utilized in property definitions. For example, the Customers value list is utilized in several property definitions in the M-Files sample vault.

When specifying, for example, the Author Organization, the options are retrieved from the Customers value list, to which you can easily add new values (customers). This way, the same company names need not be entered again, but the existing list can be utilized instead. The lists decrease the number of input errors and make work more efficient.

Pre-filtering of properties

You can specify pre-filtering for property definitions to show a subset of the objects. This way, the list of objects to be displayed can be limited by certain criteria, and the user can more quickly find the desired object when, for example, adding a customer to the metadata card.

For example, pre-filtering can be used to divide:

- Customers into prospective and actual customers.
- Customers into buyers and suppliers.
- Customers into persons and companies.
- Projects into internal and external projects.
- Projects into current and past projects.

The customer class may also be used as a pre-filter for customer listing. Likewise, the project class, for example, may be used as a pre-filter for a project listing.

Filter the list by using the value of the following property

A property definition using a value list that is filtered by some other value list can be defined to be filtered by some other property definition that uses the main value list of the filtered one. This is a case of dynamic filtering, which depends on what the user selects in the metadata card.

Example: The properties Customer (Buyer) and Customer's Contact Person are filled in the metadata card. Selecting the correct Customer (Buyer) also filters values available in the Customer's Contact Person value list to show only contact persons of this selected customer. The Customer (Buyer) property may use the Customers value list and Customer's Contact Person may use the Contact Persons value list. The Contact Persons value list is filtered by customer.

In addition, the Customer (Buyer) property is defined to be filtered by the Buyer property. For more information about hierarchical relationships between value lists and object types, refer to Value Lists and Object Types.
Also, you can select an automatic filter allowing M-Files to search for the best metadata card filter selection to filter the property in question. In this case, for example, the two-way filtering of value lists between ZIP codes and cities functions in a user-friendly manner: In the metadata card, you can choose a ZIP code first, and M-Files then chooses an appropriate city from the list automatically. If you choose the city first, M-Files filters the available ZIP codes automatically according to the city.

**Sort values in the list in the following order**

You can define whether you want the value list used for the property definition to be ascending or descending.

**Allow using this property with the following object type**

You can also limit the use of this functionality to just one object type.

**Enable automatic permissions via this property**

For you to be able to use the automatic permissions via a specific property, you should allow this in the property definition's properties. For the Class property definition, the automatic permissions are active by default, so activation is not needed in this case.

When you have added automatic permissions to a value, value list or object type, M-Files will display the property definitions in which the automatic permissions are enabled and those in which they are disabled. Make sure that the automatic permissions are enabled for the desired property definition.

Note that the specified value must be selected for the explicit property definition for which you have enabled automatic permissions.

**Allow this property to be used as a grouping level in views**

Enable this option to allow the property to be used for defining a grouping level within a view. It is advisable to disable this option for properties that may contain classified information.

**Allow searching for objects by this property**

If you choose to disable this option, searches based on the values of the selected property do not generate any results. Note, however, that the property may still be shown in the list of additional property conditions. Alternatively, you can enable the option and use the Do not search for old object versions suboption to define that users can only search for the latest versions of objects on the basis of the values of this property.

If you think the property is a relevant search criterion, this option should be enabled. Otherwise, it is best to leave it disabled to allow the search to perform optimally.

**Aliases (Advanced tab)**

Via the Advanced tab, you can define an alias for the property definition. For more information, see Associating the Metadata Definitions.

When you have automatic aliases in use and you write a name on the General tab, the Aliases field on the Advanced tab is automatically filled in. The alias has the format <predefined prefix>.<name>. Define automatic aliases for your vault in the configurations editor.
Creating a New Property Definition

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand Metadata Structure (Flat View) and then select Property Definitions.

   The Property Definitions list is opened in the right pane.

5. Click New Property Definition... on the task pane.

   The Property Definition Properties dialog is opened.

6. In the Name field, enter a name for the new property definition.

   The name will be displayed on the metadata card when you add this property to the metadata card.

7. Use the Data type drop-down menu to select the data type for the new property definition.

   For more information on data types, see Property definition data types.

8. Optional: If you chose Text or Text (multi-line) as the data type, select a content type for the text data type using the Content drop-down menu.

9. Optional: If you chose Choose from list or Choose from list (multi-select) as the data type, carry out the steps from 9.a to 9.d:
   a) Use the Show values from the following list drop-down menu to select the value list from which a value is to be chosen for the property.

      You can also filter the values in the value list by clicking Filter... and specifying the conditions that must be met in order for a value list item to be a selectable value for the property.

   b) Use the Filter the list by using the value of the following property drop-down menu to select the property by which available values are filtered. If you do not want to filter the values, select (no filtering).

      For more information, see Filter the list by using the value of the following property.

   c) Use the Sort values in the list in the following order drop-down menu to select the sorting order for the values.

   d) Check the Enable automatic permissions via this property check box if you want to allow automatic permissions for this property.

      For more information, see Automatic Permissions for Value List Items.

10. Use the Allow using this property with the following object type drop-down menu to select the object type that this property is used with, or select the All object types option if you do not want to restrict the use of this property to a specific object type.
11. Optional: Check the **Allow this property to be used as a grouping level in views** check box to allow this property to be used for defining a grouping level within a view.

   It is advisable to disable this option for properties that may contain classified information.

12. Optional: Check the **Allow searching for objects by this property** check box to allow the values of this property to be used as criteria for searching for objects and object versions.
   a) Optional: Select the **Do not search for old object versions** check box to allow the values of this property to be used as criteria for searching for the latest versions of objects only.

The new property definition that you have just defined is added to the **Property Definitions** list and the property can be added to the metadata of objects in M-Files.

**Property Definition Automatic Values**

An automatic value can be set for a property. This means that, for example, invoices can be consecutively numbered. An automatic value can also contain text, in which case it is a combination of other properties. For example, to create proposal headings in a set format such as *Class/Product/Customer*, these properties (*Proposal/Mach20A/ESTT Corporation*) can be used to automatically create the headings.

Automatic values offer increased utilization of document and object metadata in storing and searching for information. In addition, using automatic values makes the naming of documents and objects more consistent and reduces the need for repeated data entries.

Automatic values are especially useful for naming objects (for more information, see New Class) and in automatically including metadata in document content (for more information, see Insert M-Files Property).

**Automatic numbers and values**

A property can have an automatic number or an automatic value.

**An automatic number** is calculated once and it does not change. Such automatic numbering is useful, for instance, in various company internal processes and record-keeping.

**An automatic value** can contain other properties, usually by concatenating two or more properties. For example, a document name (automatic value) can be defined as *Class (Customer)*, which would return, for instance, *Proposal (ESTT)*. The automatic value changes when the object is edited. If the automatic value is created using the class and customer name (*Proposal (Customer A)*), the automatic value changes when another customer is selected (*Proposal (Customer B)*).
The example above illustrates a property with consecutive numbering in single whole number increments (increment: 1). The last value used is set as 1000. Thus, the next object to use this property will be numbered as 1001. The calculation order value is 100 (see Calculation order below).

**Simple automatic numbering**

Generates an incrementing numerical value. The increment can also be specified in the Increment field. The default value is one (1).
Customized automatic numbering (VBScript)

Generates an automatic number that can contain letters, numbers, or both. Creating a customized automatic number is specified in more detail by using the M-Files API and generic features of VBScript.

The following M-Files variables can be used with this script: PropertyDef, Output, LastUsed, ObjVer, DisplayID, Vault, CurrentUserID, CurrentUserSessionInfo, PropertyValues, VaultSharedVariables, SavepointVariables, TransactionCache, MFScriptCancel, GetExtensionObject, MasterTransactionID, CurrentTransactionID, ParentTransactionID. For more information about the variables, refer to Available VBScript Variables.

The desired custom value is assigned to the Output variable, for example Output = "Automatic value". For more information on specifying customized automatic numbering, see Specifying an Automatic Property Value Using VBScript.

Simple concatenation of properties

Conjoins selected properties (for instance Proposal/Device/Customer). Any characters or text can be inserted between the selected properties. For example: Proposal: Customer (Project) or Proposal, Customer, Project.

A list of available placeholders can be opened when specifying an automatic value for a property. The Add Placeholder... button opens the list of property definitions and other placeholders available for use.

Alternatively, you can add the placeholders to the field manually. They are used by bracketing them with % characters. For instance, %PROPERTY_23% (%PROPERTY_21%) could give us "John Smith (09/25/2016 12:39 PM)", assuming that 23 is the ID for the Last modified by property and 21 the ID for the Last modified timestamp property.

Besides the ID, you can also add the placeholders using aliases. To specify an alias placeholder, use the syntax %PROPERTY_{Property.Definition.Alias}%. For more information on defining aliases, see Assigning Aliases for Metadata Definitions.

Indirect placeholders

Indirect placeholders are metadata indirectly related to an object. For example, if a contract is related to a customer object, the country of the customer is indirect metadata for the document.

To specify the customer’s country as an indirect placeholder the syntax %PROPERTY_1079.PROPERTY_1090% is used, where 1079 is the property definition ID for Customer and 1090 is the property definition ID for Country.

Alternatively, you can add indirect placeholders using aliases. In the previous example, the syntax with aliases would be %PROPERTY_{PD.Customer}.PROPERTY_{PD.Country}%, where PD.Customer is the alias for the Customer property definition and PD.Country is the alias for the Country property definition.

Calculated value (VBScript)

Creating an automatic value can be specified in more detail by using the M-Files API and generic features of VBScript.

The following M-Files variables can be used with this script: PropertyDef, Output, ObjVer, DisplayID, Vault, CurrentUserID, CurrentUserSessionInfo, PropertyValues, VaultSharedVariables, SavepointVariables, TransactionCache, MFScriptCancel,
GetExtensionObject, MasterTransactionID, CurrentTransactionID, ParentTransactionID. For more information about the variables, refer to Available VBScript Variables.

The desired custom value is assigned to the Output variable, for example Output = "Automatic value". For more information on specifying calculated values, see Specifying an Automatic Property Value Using VBScript.

Last value used

The starting value for consecutive numbering or values. The default is zero (0). The value can be changed; for example, consecutive numbering can start at 3000.

Calculation order

Calculation order determines the order in which automatic values are calculated (from smallest to greatest). This is significant when several automatic values are used and their combinations form new automatic values.

For example, calculation order is crucial if the name of an object is an automatic property value consisting of two other automatic values. These two automatic values should be calculated first and their combined value afterward.

The values themselves make no difference other than that the calculation order proceeds from smallest to greatest. The calculation order values for different properties can be, for example, 10, 12, 17 and 20. The property with the calculation order number 10 is thus calculated first, followed by the property with the calculation order number 12, and so on.

Recalculate

The Recalculate... command is available in M-Files Admin’s task area (or by right-clicking a property in the Property Definitions list and selecting Recalculate... from the context menu) when a property with an automatic value is selected. You can choose between recalculating empty values or recalculating all values.

Recalculate Empty Values

Calculates automatic values for properties that have not been calculated yet. This is the default for calculating automatic values. Changes to settings only apply to new values. For example, if you edit the Last value used field, only new objects will have the new value. Old values are preserved; that is, once defined, a value does not change.

Recalculate All Values

Recalculates the automatic values of all properties. Recalculate All Values thus also recalculates previously defined values. For example, if consecutive numbering is used and the Last value used is changed, this function renumbers all existing objects.

Naming a template without using automatic values

Document templates work differently when automatic values are used. All properties in the template metadata work without the calculation of an automatic value. Thus, in templates, automatic property values work as if they were not automatic. Their values can be defined normally and the server does not calculate an automatic value for the property.
For example, objects in the Proposal class may use automatic values in their titles (such as Proposal <number> - <customer name>). However, it makes sense to name the Proposal class templates as templates; titles using automatic properties only make sense for actual proposals, not templates. Thus, the template might be called Proposal Template, while the actual proposal documents created using the template will have names formulated with automatic values, such as Proposal 35 - ESTT.

For more information, refer to Using Document Templates and New Class.

**In this chapter**

- Specifying an Automatic Value for a Property
- Specifying an Automatic Property Value Using VBScript

*Specifying an Automatic Value for a Property*

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand Metadata Structure (Flat View) and then select Property Definitions.

   - The Property Definitions list is opened in the right pane.

5. Double-click the property definition that you want to edit.

   - The Property Definition Properties dialog is opened.
6. Go to the **Automatic Values** tab, and select one of the following:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify automatic incremental numbering for a property.</td>
<td>Select the <strong>Simple automatic numbering</strong> option, and specify the size of the increment for each new value in the <strong>Increment</strong> field.</td>
</tr>
<tr>
<td>Specify for a property customized automatic numbering using VBScript.</td>
<td>Select the <strong>Customized automatic numbering (VBScript)</strong> option, and click <strong>Edit Code...</strong> to add the code for automatic numbering.</td>
</tr>
</tbody>
</table>
If you want to | Do the following
--- | ---
If you want to specify a combination of text and property placeholders as an automatic property value. | Select the Simple concatenating of properties option, and enter the combination of text and property placeholders in the text field. You can add property placeholders by clicking the Add Placeholder... button.  
**Note:** For more information on placeholders, see Simple concatenation of properties.

Specify for a property an automatic calculated value using VBScript. | Select the Calculated value (VBScript) option, and click Edit Code... to add the code for calculating the property value.  
**Note:** For more information, see Specifying an Automatic Property Value Using VBScript.

---

7. Optional: In the **Last value used** field, enter the starting value for automatic numbering if you want to use some other value than the default zero (0).

8. In the **Calculation order** field, enter the number that determines the order in which this automatic value is calculated in relation to other automatic values. The smaller the number, the earlier the calculation order.

   **i** For more information, see Calculation order.

9. Click **OK** to save your changes and close the **Property Definition Properties** dialog.

The selected property now has an automatic value. When you add this property to the metadata card, the value is calculated and generated automatically.

**Specifying an Automatic Property Value Using VBScript**

Creating customized automatic values and calculated values can be specified in more detail by using M-Files API and generic features of VBScript ("Microsoft Visual Basic Scripting Edition"). This section provides instructions for using VBScript with automatic values.

**Note:** For the VBScript user’s guide and language reference, see the VBScript MSDN article.

The VBScript code for a calculated value is executed whenever a property value is edited. The VBScript code is used for calculating the automatic value, after which the result of the calculation must be assigned to a variable called **Output**. This value is stored as the value of the property in the object metadata.

The simplest piece of VBScript for formulating an automatic value might therefore look like this:

```vbnet
Output = "Automatic value"
```
Usually an automatic value uses other object properties, for example, by concatenating them. VBScript code can utilize the property values and basic information of the same or another object with the aid of the following VBScript variables:

- CurrentUserID
- DisplayID
- LastUsed
- MFScriptCancel
- ObjVer
- Output
- PropertyDef
- PropertyValues
- Vault
- VaultSharedVariables

For the variable descriptions, see Available VBScript Variables.

Note: Some property definitions are not shown when using the PropertyValues variable in scripts (see Property definitions not shown for scripts).

Do the following steps to use VBScript for calculating an automatic value for a property:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Metadata Structure (Flat View) and then select Property Definitions.
   - The Property Definitions list is opened in the right pane.
5. Double-click the property definition that you want to edit.
   - The Property Definition Properties dialog is opened.
6. Go to the **Automatic Values** tab.

- The **Automatic Values** tab is opened.
7. Select either:

a. **Customized automatic numbering (VBScript)**: Select this option if you want to define automatic numbering using VBScript.

   or

b. **Calculated value (VBScript)**: Select this option if you want to define any other type of automatic value using VBScript.
8. Click the **Edit Code**... button.

The **Edit VBScript Code** window is opened.

9. Specify the VBScript code for calculating the automatic value.

The following code creates an automatic value for the "Proposal Title" property by utilizing the proposal number and customer information in the object metadata. The ID of the Proposal Number property is 1156 and the ID of the Customer property is 1288. If a document has the proposal number 5577 and the customer is ESTT, the code below creates the following string as the title of the proposal: "Proposal #5577 / ESTT".

```vbnet
Option Explicit

' Get proposal number.
Dim szNumber
szNumber = PropertyValues.SearchForProperty(1156).TypedValue.DisplayValue

' Get customer.
Dim szCustomer
szCustomer = PropertyValues.SearchForProperty(1288).TypedValue.DisplayValue

' Create proposal title.
Dim szName
szName = "Proposal #" & szNumber & " / " & szCustomer

' Set result.
```
Output = szName

10. Close the Edit VBScript Code window once you are done.

11. Back in the Property Definition Properties dialog, click OK to save your changes and to close the Property Definition Properties dialog.

The selected property now has an automatic value which is calculated by the VBScript code that you have specified.

Automatically Validating Property Values

On the Validation tab of the Property Definition Properties dialog, you can define the criteria that the values of a specific property should meet. For example, with validation you can ensure that the property value contains a required number of characters. In this way, you can verify that the customer phone number or invoice number is added correctly on the metadata card. You can also validate that, for instance, the value can be accepted in relation to other properties or that the value is not empty.

Validation is specified by using variables, generic features of VBScript, and M-Files API. The following M-Files variables can be used for validating property values: PropertyDef, PropertyValue, ObjVer, DisplayID, Vault, CurrentUserID, CurrentUserSessionInfo, VaultSharedVariables, SavepointVariables, TransactionCache, MFScriotCancel, GetExtensionObject, MasterTransactionID, CurrentTransactionID, ParentTransactionID. For more information about the variables, refer to Available VBScript Variables.

By default, validation is considered successful. Invalid values are thus detected using conditional statements and should any of the conditions specified in the validation be met, then an error should be raised, prompting the user to correct the invalid value (for instance, Err.Raise MFScriotCancel, "The property must have a value of at least 10 characters.").

Complete the following steps to add value validation for a property:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, expand Metadata Structure (Flat View) and then select Property Definitions.

5. Either:

   a. In the Property Definitions list, right-click the property, the values of which you want to be automatically validated, and select Properties from the context menu.

   or

   b. Click New Property Definition... on the task area to create a new property definition with automatic value validation.

The Property Definition Properties dialog is opened.
6. Go to the Validation tab.

The Validation tab is opened.
7. Select the Validation with VBScript option and click the Edit Code... button.

The Edit VBScript Code window is opened.
8. In the **Edit VBScript Code** window, type in the VBScript code for validating the values of this property.

   If the values of this property must have at least 10 characters, you could use the following code:

   ```vbscript
   Option Explicit
   Dim propertyName, value
   propertyName = PropertyDef.Name
   value = PropertyValue.GetValueAsUnlocalizedText
   If Len(value) < 10 Then
     Err.Raise MFScriptCancel, "The property "" & propertyName & "" must have a value of at least 10 characters."
   End If
   ```

   **Note:** The M-Files API documentation is located at [www.m-files.com/api/documentation/latest](http://www.m-files.com/api/documentation/latest). For more information about using VBScript in M-Files, see the [How do I write VBScript code for M-Files purposes?](#) tutorial.

9. Close the **Edit VBScript Code** window and then click **Apply** in the **Property Definition Properties** dialog to save your changes.

   The values entered for the selected property are now automatically validated. When entering a value for the property on the metadata card, the value is validated and if it does not meet the criteria specified, the action specified in the validation script is executed (such as displaying an error message).
### Built-in Property Definitions

The following table lists the descriptions for built-in property definitions that come included in the metadata structure of every vault implementation. These property definitions are essential elements of every vault metadata structure, and therefore modifying these definitions is restricted by design.

<table>
<thead>
<tr>
<th>Built-in property definition</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessed by me</td>
<td>Timestamp</td>
<td>The last time the object was accessed by the current user.</td>
</tr>
<tr>
<td>Additional classes</td>
<td>Choose from list &quot;Classes&quot; (multi-select)</td>
<td>A list of additional classes for the object.</td>
</tr>
<tr>
<td>Assigned to</td>
<td>Choose from list &quot;Users&quot; (multi-select)</td>
<td>A list of users to whom an assignment is assigned.</td>
</tr>
<tr>
<td>Assignment</td>
<td>Choose from list &quot;Assignments&quot; (multi-select)</td>
<td>An assignment related to the selected object.</td>
</tr>
<tr>
<td>Assignment description</td>
<td>Text (multi-line)</td>
<td>The assignment description for an assignment.</td>
</tr>
<tr>
<td>Class</td>
<td>Choose from list &quot;Classes&quot;</td>
<td>The class of the object.</td>
</tr>
<tr>
<td>Class groups</td>
<td>Choose from list &quot;Class groups&quot; (multi-select)</td>
<td>The class group of the object.</td>
</tr>
<tr>
<td>Collection members (document collections)</td>
<td>Choose from list &quot;Document collections&quot; (multi-select)</td>
<td>A list of document collections belonging to the document collection.</td>
</tr>
<tr>
<td>Collection members (documents)</td>
<td>Choose from list &quot;Documents&quot; (multi-select)</td>
<td>A list of documents belonging to the document collection.</td>
</tr>
<tr>
<td>Comment</td>
<td>Text (multi-line)</td>
<td>Comment text for an object.</td>
</tr>
<tr>
<td>Completed</td>
<td>Boolean (yes/no)</td>
<td>Specifies whether the assignment has been completed.</td>
</tr>
<tr>
<td>Conflict resolved</td>
<td>Timestamp</td>
<td>The date and time a conflict was last resolved in favor of the selected object.</td>
</tr>
<tr>
<td>Created</td>
<td>Timestamp</td>
<td>The creation date and time of an object.</td>
</tr>
<tr>
<td>Created by</td>
<td>Choose from list &quot;Users&quot;</td>
<td>Identifies the user who created the object in M-Files or imported the object into M-Files.</td>
</tr>
<tr>
<td>Created from external source</td>
<td>Choose from list &quot;External sources&quot;</td>
<td>The external source from which the object was imported.</td>
</tr>
<tr>
<td>Deadline</td>
<td>Date</td>
<td>The deadline date for the current assignment.</td>
</tr>
<tr>
<td>Deleted</td>
<td>Timestamp</td>
<td>The deletion date and time of the object.</td>
</tr>
<tr>
<td>Deleted by</td>
<td>Choose from list &quot;Users&quot;</td>
<td>Identifies the user who deleted the object.</td>
</tr>
<tr>
<td>Built-in property definition</td>
<td>Data type</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Deletion status changed</td>
<td>Timestamp</td>
<td>The date and time the object was last deleted or undeleted.</td>
</tr>
<tr>
<td>Document</td>
<td>Choose from list &quot;Documents&quot; (multi-select)</td>
<td>A document related to the selected object.</td>
</tr>
<tr>
<td>Document collection</td>
<td>Choose from list &quot;Document collections&quot; (multi-select)</td>
<td>A document collection related to the selected object.</td>
</tr>
<tr>
<td>Favorite view</td>
<td>Number (integer)</td>
<td>The ID of the Favorites view where the object is shown.</td>
</tr>
<tr>
<td>Is template</td>
<td>Boolean (yes/no)</td>
<td>A Boolean property identifying whether the object is a template.</td>
</tr>
<tr>
<td>Last modified</td>
<td>Timestamp</td>
<td>The last modification date and time of an object.</td>
</tr>
<tr>
<td>Last modified by</td>
<td>Choose from list &quot;Users&quot;</td>
<td>Identifies the user who last modified the object.</td>
</tr>
<tr>
<td>Marked as complete by</td>
<td>Choose from list &quot;Users&quot; (multi-select)</td>
<td>A list of users who have completed the current assignment.</td>
</tr>
<tr>
<td>Marked as rejected by</td>
<td>Choose from list &quot;Users&quot; (multi-select)</td>
<td>A list of users who have rejected the current assignment.</td>
</tr>
<tr>
<td>Marked for archiving</td>
<td>Boolean (yes/no)</td>
<td>A Boolean property identifying whether the object is marked for archiving.</td>
</tr>
<tr>
<td>Message ID</td>
<td>Text</td>
<td>The Message-ID value of an e-mail extracted from the Internet header.</td>
</tr>
<tr>
<td>Monitored by</td>
<td>Choose from list &quot;Users&quot; (multi-select)</td>
<td>A list of users who are monitoring the current assignment.</td>
</tr>
<tr>
<td>Moved into current state</td>
<td>Timestamp</td>
<td>The date and time when the object was moved to its current state.</td>
</tr>
</tbody>
</table>
## Built-in property definition

<table>
<thead>
<tr>
<th>Property</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name or title</td>
<td>Text</td>
<td>The name of title of the current object.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Tip:</strong> When translatable object titles are enabled, objects can have multilingual names. The translated object titles can be used in searches and they are displayed instead of Name or Title property on the title area of the metadata card, listing area as well as in notifications and value lists when a specific vault language is selected.</td>
</tr>
<tr>
<td>Object changed</td>
<td>Timestamp</td>
<td>The date and time of the last change to the object.</td>
</tr>
<tr>
<td>Original path (1/3)</td>
<td>Text</td>
<td>The location from which the object was imported to M-Files.</td>
</tr>
<tr>
<td>Original path (2/3)</td>
<td>Text</td>
<td>The location from which the object was imported to M-Files (continued).</td>
</tr>
<tr>
<td>Original path (3/3)</td>
<td>Text</td>
<td>The location from which the object was imported to M-Files (continued).</td>
</tr>
<tr>
<td>Owner (Assignment)</td>
<td>Choose from list &quot;Assignments&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (Class group)</td>
<td>Choose from list &quot;Class groups&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (Class)</td>
<td>Choose from list &quot;Classes&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (Document collection)</td>
<td>Choose from list &quot;Document collections&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (Document)</td>
<td>Choose from list &quot;Documents&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (External source)</td>
<td>Choose from list &quot;External sources&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (Report)</td>
<td>Choose from list &quot;Reports&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (State transition)</td>
<td>Choose from list &quot;State transitions&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (State)</td>
<td>Choose from list &quot;States&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Built-in property definition</td>
<td>Data type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Owner (Traditional folder)</td>
<td>Choose from list &quot;Traditional folders&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (User group)</td>
<td>Choose from list &quot;User groups&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (User)</td>
<td>Choose from list &quot;Users&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (Version label)</td>
<td>Choose from list &quot;Version labels&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Owner (Workflow)</td>
<td>Choose from list &quot;Workflows&quot;</td>
<td>The owner value of the selected object.</td>
</tr>
<tr>
<td>Permissions changed</td>
<td>Timestamp</td>
<td>The date and time when the permissions of the object were last changed.</td>
</tr>
<tr>
<td>Reference</td>
<td>Choose from list &quot;Documents&quot; (multi-select)</td>
<td>A list of referenced documents.</td>
</tr>
<tr>
<td>Remote vault GUID</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Reply to</td>
<td>Choose from list &quot;Documents&quot; (multi-select)</td>
<td></td>
</tr>
<tr>
<td>Reply to (ID)</td>
<td>Text</td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>Choose from list &quot;Reports&quot; (multi-select)</td>
<td>A report related to the selected object.</td>
</tr>
<tr>
<td>Report placement</td>
<td>Number (integer)</td>
<td>Specifies the placement of the selected report.</td>
</tr>
<tr>
<td>Report URL</td>
<td>Text</td>
<td>Specifies the URL of the selected report.</td>
</tr>
<tr>
<td>Shared files</td>
<td>Text (multi-line)</td>
<td>The shared location paths of the shared files of the selected object.</td>
</tr>
<tr>
<td>Signature manifestation</td>
<td>Text (multi-line)</td>
<td>Electronic signature manifestation of the selected assignment.</td>
</tr>
<tr>
<td>Single file</td>
<td>Boolean (yes/no)</td>
<td>A Boolean property identifying whether the object is a single-file object.</td>
</tr>
<tr>
<td>Size on server (all versions)</td>
<td>Number (integer)</td>
<td>The total size of all versions of the selected object.</td>
</tr>
<tr>
<td>Size on server (this version)</td>
<td>Number (integer)</td>
<td>The size of the selected object version.</td>
</tr>
<tr>
<td>State</td>
<td>Choose from list &quot;States&quot;</td>
<td>The workflow state of the object.</td>
</tr>
<tr>
<td>State transition</td>
<td>Choose from list &quot;State transitions&quot;</td>
<td>The workflow state transition of the object.</td>
</tr>
<tr>
<td>Status changed</td>
<td>Timestamp</td>
<td>The date and time of the last status change of the object.</td>
</tr>
</tbody>
</table>
## Built-in property definition

<table>
<thead>
<tr>
<th>Property Definition</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Traditional folder</td>
<td>Choose from list “Traditional folders” (multi-select)</td>
<td>A traditional folder containing the selected object version.</td>
</tr>
<tr>
<td>Version comment changed</td>
<td>Timestamp</td>
<td>The date and time of the last change to the comment of the object version.</td>
</tr>
<tr>
<td>Version label</td>
<td>Choose from list “Version labels” (multi-select)</td>
<td>The version label for the object.</td>
</tr>
<tr>
<td>Version label changed</td>
<td>Timestamp</td>
<td>The date and time of the last change to the version label of the object version.</td>
</tr>
<tr>
<td>Workflow</td>
<td>Choose from list “Workflows”</td>
<td>The workflow of the selected object.</td>
</tr>
<tr>
<td>Workflow Assignment</td>
<td>Choose from list “Assignments” (multi-select)</td>
<td>A property that indicates the assignment related to the workflow of the object.</td>
</tr>
</tbody>
</table>

### Property Definition Permissions

Access for viewing this property and editing the property in object metadata can be defined on the Permissions tab.

If the user does not have the permission to view the property, it is not available for selection in M-Files (for example, when you are creating a new search or when More properties is selected).

If the user cannot see the property, the user also does not have the permission to edit it. However, the user may have the permission to see the property without having the permission to edit it. Editing in this case refers to the user being able to edit the property in the object metadata in all possible ways: edit its value, or add or delete the property.

### Adjusting Permissions

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, click the appropriate node or subnode of the vault and select the desired item from the list on the right or from the left-side tree view.
5. Right-click the item and select Properties from the context menu.
6. Go to the Permissions tab.
7. From the **Users and user groups** list, select the user or user group whose permissions you want to adjust.

![Users and user groups](image)

If the user or user group is not on the list, click **Add...** to add the user or user group to the list.

8. Either:
   a. Check the **Allow** check box to allow the selected user to see this item.
   
   or
   
   b. Check the **Deny** check box to deny the selected user from seeing this item.

9. Optional: If you want to adjust additional permissions, repeat the steps 7 and 8.

10. Click **OK** once you are done.

You have adjusted the view permissions of the selected item for the selected users.

**Hierarchical Property Values**

Instead of having the property value selection field show a flat list of values, you can set it to show a hierarchically ordered list, which can be built either on top of value lists or real object types. This section explains how you can set up the property value selection field to show an object type based hierarchy. If you would like to specify and use hierarchical value lists instead, see **Value list hierarchy**.

**Tip:** The values of a real **object type** based value list consist of actual objects in your vault, whereas a simple **value list** only contains items that are added to the list manually, either via **M-Files Admin** or via the M-Files clients by end users.

Before you can set a hierarchy to be used by a property, you of course must have one available to you. See the example in **Creating an Object-Based Hierarchy** to get started. After you have finished creating the hierarchy, you can put it to use as explained in **Specifying Hierarchical Properties**.

**In this chapter**

- Creating an Object-Based Hierarchy
- Specifying Hierarchical Properties

**Creating an Object-Based Hierarchy**

This example describes a scenario where a construction company wants to use a single hierarchically ordered list of values for three separate properties referring to the location of a construction site. They want the hierarchical value list to be based on actual objects in their vault.

To create the required metadata structure and objects for this kind of scenario, follow the steps provided below. The names of the structure elements are examples only, and you can freely name them as you like.
First, open M-Files Admin and create the required metadata structure elements as instructed below.

1. Create an object type with the names Area (singular) and Areas (plural).
   
   For instructions on creating object types, see Creating a New Object Type.

2. Create four property definitions that have the names listed below. All of them should be of the data type Choose from list and should show values from the value list Areas, essentially consisting of various Area objects in your vault.
   
   • Belongs to area
   • Construction site continent
   • Construction site country
   • Construction site city

   For instructions on creating property definitions, see Creating a New Property Definition.

   Tip: You can optionally set the following filters for the continent and country properties if you want the continent property to only show continents and the country property to hide cities from the list:
   
   - Construction site continent: Class = Continent
   - Construction site country: Class != City

3. Create the following three classes:
   
   • Continent
   • Country
   • City

   As the value of the Object type setting for each one, select Area.

   Under the Properties section, add the Belongs to area property for all the three classes. This way, the property is automatically added to the metadata card when you are creating these objects later on.

   For detailed instructions on creating classes, see Creating a New Class.

Next, open M-Files Desktop and create a hierarchy of continent, country, and city objects using the newly created metadata structure elements.

4. Create a set of continents:
   
   a) Click the Create button in the top pane and select Area... in the context menu.
   b) To the Class field, enter Continent.
   c) To the Name or title field, enter the name of the continent, such as Asia.
   d) Leave empty the value of the Belongs to area field as this is a top-level object.

   The top-level object must contain this property as well because it defines that it belongs to the same hierarchy as its descendant objects (in this example, countries and cities).

   e) Click Create once you are done.
   f) Repeat these steps for as many objects of this class as you require.
5. Create a set of countries:
   a) Click the Create button in the top pane and select Area... in the context menu.
   b) To the Class field, enter Country.
   c) To the Name or title field, enter the name of the country, such as India.
   d) To the Belongs to area field, enter the name of the continent in which this country is located, such as Asia.
   e) Click Create once you are done.
   f) Repeat these steps for as many objects of this class as you require.

6. Create a set of cities:
   a) Click the Create button in the top pane and select Area... in the context menu.
   b) To the Class field, enter City.
   c) To the Name or title field, enter the name of the city, such as Mumbai.
   d) To the Belongs to area field, enter the name of the country in which this city is located, such as India.
   e) Click Create once you are done.
   f) Repeat these steps for as many objects of this class as you require.

Finally, open M-Files Admin again and, by following the instructions in Specifying Hierarchical Properties, set the property definitions Construction site continent, Construction site country, and Construction site city to use the Belongs to area hierarchy. The configuration should look similar to the one presented below.

- Hierarchies
  - Construction site continent
    - Hierarchy Name = Construction site continent
    - Target Property = Construction site continent
    - Hierarchy Property = Belongs to area
  - Construction site country
    - Hierarchy Name = Construction site country
    - Target Property = Construction site country
    - Hierarchy Property = Belongs to area
  - Construction site city
    - Hierarchy Name = Construction site city
    - Target Property = Construction site city
    - Hierarchy Property = Belongs to area

7. Click Save and close M-Files Admin once you are done.

Now, when you add the properties Construction site continent, Construction site country, and Construction site city to the metadata of an object, they all show the same hierarchical list of areas that you can use to select the location of the construction site.
Specifying Hierarchical Properties

To set a property of your choice to use an object-based hierarchy, do the following steps:

1. Open M-Files Admin and access the document vault of your choice.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

2. Select Configurations and expand Advanced Vault Settings.

3. Expand the Configuration node and select Real Object Type Hierarchies.

4. Select the Hierarchies > Add Hierarchy.

5. Expand the newly created node and specify the values according to the information in the table below.

<table>
<thead>
<tr>
<th>Setting name</th>
<th>Description</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hierarchy Name</td>
<td>The name of this hierarchy definition. The name is only shown in the configurations editor.</td>
<td>Construction site continent</td>
</tr>
<tr>
<td>Target Property</td>
<td>The property that uses the value list hierarchy specified via the Hierarchy Property setting. Can be the same as Hierarchy Property. The property must be of the data type Choose from list or Choose from list (multi-select).</td>
<td>Construction site continent</td>
</tr>
</tbody>
</table>
### Setting name | Description | Example value
--- | --- | ---
Hierarchy Property | Specifies the real object type based value list hierarchy to be used. The property selected here is automatically set to be hierarchical as well. The property must be of the data type **Choose from list**. | Belongs to area

6. Click **Save**.

When the property specified via the **Target Property** setting is added to object metadata, the value selection drop-down menu shows a hierarchically ordered list of values based on the property specified via the **Hierarchy Property** setting. For an example, see [Creating an Object-Based Hierarchy](#).

⚠️ **Note:** After the changes have been saved and M-Files Server has been restarted, end users must log out from and log back in to the vault to be able to use these type of lists. You can log out all vault users by **restarting the vault**, but taking a vault offline should always be done in a controlled manner and the vault users should be notified beforehand.

### Classes

A document class is an object type that combines several properties (see [Property Definitions](#)). Classes are designed to help categorize objects, to improve consistency as well as to speed up the process of filling in the object metadata.

You can create new classes and specify properties for each class via M-Files Admin. When the class is selected in M-Files Desktop, the properties that the system administrator has specified for the class will appear on the metadata card. M-Files users provide the properties with values when creating the new object.
Figure 113: Classes shown on the metadata card for a new document.

In this chapter

- New Class
- Permissions and Automatic Permissions

New Class

You can start creating a new class by clicking the Classes heading in the left-side tree view of M-Files Admin and by clicking the New Class... link on the task area.
Figure 114: The properties dialog of a new "Purchase Invoice" class.

In the example shown above, a new class is being created. You can add new properties by clicking the Add... button. If the Required checkbox for the property is active, users need to assign a value for the property when creating a new object in that class. Otherwise, the object cannot be created. The Purchase Invoice class being created in the above image dictates that the Name or title and Document date properties would need to be filled in for users to be able to create a Purchase Invoice object.
Set As Name

Any property of the class can be defined as the name of the object; that is, the property is selected as the name property for the objects of this class. Then the name of the object does not have to be entered separately; instead, a certain property can be set up to always be the name or "title" of the object belonging to the class in question. This makes the naming of objects in a class more consistent.

This property is very useful for working with automatic values (see Property Definition Automatic Values). The automatic value of the property may at the same time be the name of the proposal document ("Proposal/ESTT").

Note: Templates are named without automatic values.

The Update names function (found on the M-Files Admin task area for a class) can be used to update the names of all existing objects in the class to conform to the new definition.

Default workflow for new objects

You can define a default workflow for new objects in this class. For example, all invoices can be set to use the invoice circulation workflow.

Force this workflow for new objects

If a specific workflow is forced for new objects in the class, the workflow cannot be deleted or changed. For example, the Purchase Invoice Approval workflow can be specified as compulsory for a new document created in the Purchase Invoice class.

Templates

You can define templates to be used when creating new objects in this class. To specify a document or other object as a template, add the property Is template and set it to Yes. Templates are class-specific. You can specify the template to be a part of several classes by specifying multiple classes for the object being used as a template, with the Additional Classes property.

Aliases (Advanced tab)

Via the Advanced tab, you can define an alias for the class. For more information, see Associating the Metadata Definitions.

Creating a New Class

Follow the steps provided below to create a new class to your M-Files vault.

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand Metadata Structure (Flat View), and then select Classes.
5. Click New Class... on the task area.

The Class Properties dialog for a new class is opened.
6. In the **Name** field, type in a descriptive name for the new class.

7. Using the **Object type** drop-down menu, select the object type that the class is to be associated with.

   - The class can be selected only for objects of this type.

8. Optional: Using the **Properties** table, define which properties are to be automatically added to the metadata card when this class is selected.

   - For more information, see **New Class**.

9. Optional: Using the **Default workflow for new objects** drop-down menu, specify the default workflow to be associated with the class.

   - Enable **Force this workflow for new objects** to require the selected workflow to be used for any new objects with this class.

10. Optional: On the **Permissions** tab, you can specify the users who may see this class or attach objects to it.

    - For more information, see **Permissions and Automatic Permissions**.

11. Optional: On the **Automatic Permissions** tab, you can specify whether or not objects of this class receive automatic permissions.

    - For more information, see **Permissions and Automatic Permissions**.

12. Optional: On the **Advanced** tab, you can define aliases for the class using the **Aliases** field.

    - For more information, see **Aliases for Associating Metadata Between Vaults**.

   When you have automatic aliases in use and you write a name on the **General** tab, the **Aliases** field on the **Advanced** tab is automatically filled in. The alias has the format `<predefined prefix>.<name>`. Define automatic aliases for your vault in the configurations editor.

13. Click **OK**.

    The new class is added to the list of classes in M-Files Admin and can be selected for objects in M-Files Desktop.

**Assignment Class**

When you are creating a new class with the object type **Assignment**, an additional tab appears to the **Class Properties** dialog, the **Assignment Details** tab. It enables you to select the assignment type and certain conditions related to the completion or approval of the assignment.

**Assignment types**

There are two types of assignments, task assignments and approval assignments. The assignees of the task assignments simply mark the assignment complete when they have successfully carried out the task, whereas the assignees of approval assignments have more say in the actual approval process: they can use the assignment for approving or rejecting the target object.

In both cases, you can set the completion of the assignment to require action from all or any assignees. You may also want to require an **electronic signature**.
Permissions and Automatic Permissions

Permissions

On the **Permissions** tab, you can specify the users who may see this class.

Automatic permissions

An object receives automatic permissions when a class with automatic permissions specified is added to the object metadata.

You can activate the automatic permissions by value, value list, object type, or class. You can specify the automatic permissions for each class in the same way as for each value. For more information, see [Enabling Automatic Permissions for a Value List Item](#).

Adjusting Permissions

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, click the appropriate node or subnode of the vault and select the desired item from the list on the right or from the left-side tree view.
5. Right-click the item and select **Properties** from the context menu.
6. Go to the **Permissions** tab.
7. From the **Users and user groups** list, select the user or user group whose permissions you want to adjust.

   ![Users and user groups](image)

   If the user or user group is not on the list, click **Add...** to add the user or user group to the list.

8. Either:
   a. Check the **Allow** check box to allow the selected user to see this item.
      or
   b. Check the **Deny** check box to deny the selected user from seeing this item.
9. Optional: If you want to adjust additional permissions, repeat the steps 7 and 8.
10. Click **OK** once you are done.
You have adjusted the view permissions of the selected item for the selected users.

**Class Groups**

You can create class groups to combine document classes into categories. This makes it easier to select a class when creating a new document. Note that you can create class groups only for the document object type.

Complete the following steps to create a class group:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, expand **Metadata Structure (Hierarchical View)**, then right-click **Document** and select **New Class Group...** from the context menu.

The **Class Group Properties** dialog is opened.
5. In the **Name** field, enter the name of the new class group.

The name can be, for instance, **Meetings** if you are creating a class group that contains classes for documents related to meetings, such as **Memo**, **Meeting Notice** or **Agenda**. Class groups are shown in the class selection drop-down menu in numerical order when you fill in the metadata card. You can easily change the order of the list by using numbers in the beginning of the class group names.

![Select Classes dialog](image)

6. Click **Add...** to add a class to the new group.

- The **Select Classes** dialog is opened.
7. Optional: If you want to create a new class and add it to the new class group, click the **New Class...** button.

   For instructions on creating a new class, see Creating a New Class.

8. Select the classes that you want to add to the new class group and then click **Add**.

   You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the Shift key to select adjacent items on the list.

9. Optional: In the **Members** list, you may select a class and click the ↑ or the ↓ button to rearrange the order of the classes in the group.

   The ordering affects the order in which the classes in the group are displayed in the class selection drop-down menu when creating a new document.

10. Optional: In the **Members** list, select a class and click **Edit...** to modify its properties.

    For more information on class properties, see New Class.

11. Optional: If you need to remove a class from the class group, in the **Members** list, select the group to be removed and click **Remove**.

    Note that this only removes the class from the class group. It does not delete the class from your vault.

12. Optional: Open the **Permissions** tab to specify the users who may see the new class group.

    For further instructions, see Adjusting Permissions.

13. Click **OK** to create the class group.

    The new class group is from now on shown in the class selection drop-down menu when creating a new document.
In this chapter

- Adjusting Permissions

Adjusting Permissions

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, click the appropriate node or subnode of the vault and select the desired item from the list on the right or from the left-side tree view.

5. Right-click the item and select **Properties** from the context menu.

6. Go to the **Permissions** tab.

7. From the **Users and user groups** list, select the user or user group whose permissions you want to adjust.

8. Either:
   a. Check the **Allow** check box to allow the selected user to see this item.
      
      or
   b. Check the **Deny** check box to deny the selected user from seeing this item.

9. Optional: If you want to adjust additional permissions, repeat the steps 7 and 8.

10. Click **OK** once you are done.

You have adjusted the view permissions of the selected item for the selected users.

### 3.2.2. Managing Users and User Groups

This section deals with managing vault users and user groups in M-Files Admin.

**In this chapter**

- **Users**
- **User Groups**
- **External Repository Users**
- **External Repository User Groups**

**Users**

Under the **Users** node of a vault in M-Files Admin, you can add users to the vault, thus assigning a name to the user and specifying the user's permissions. Each user object is based on a server login account (see **Login Accounts**).

M-Files assigns each user a unique ID, which can be found via the user's properties in M-Files Admin.
Deleting users

As a general rule, users should not be deleted from the vault because they contain a lot of information that might still be needed later on. The user objects hold, among other things, user interface preferences, information about the favorite objects of the user, and records about notifications related to the user. M-Files Admin does not allow the delete operation to be undone, so it should be carried out only if you are absolutely certain the user information will no longer be needed. You might, instead, want to consider disabling the user. For more information about disabled users, go to Creating a User and search for disabled in step 8.

In this chapter

• Creating a User
• Importing Users
• Vault User Permissions

Creating a User

Do the following steps to create a new user to a selected document vault:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, click Users.

   Tip: If the list contains a large number of items, you might want to filter it. To filter the view, open the View menu and click Filter. Enter a desired text to filter the column contents.

5. Click New User... on the task area.

   The New User dialog is opened.
6. Use the **Login account** drop-down menu to select a login account for the user or select **New login account**... from the same drop-down menu to create a new login account for the user.

- For instructions on creating a new login account, see Creating a Login Account.

- The **Full name** field is updated with the full name information of the selected login account.
7. Use the **Vault language** drop-down menu to select the default vault language for the user from the list of available vault languages.

    For instructions on adding a new vault language, see Languages and Translations.

8. Set the properties and administrative rights for the new user in the selected vault by checking or unchecking the relevant check boxes:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User account is disabled</td>
<td>When the account is disabled, the user cannot access the document vault. Logging in to the document vault has been disabled, but the user information is retained. The account can be easily enabled again by unchecking this check box when necessary. For example, you may want an employee's account to be disabled during her vacation for data security reasons.</td>
</tr>
<tr>
<td>User cannot create documents or other objects</td>
<td>The user cannot create documents or other objects in the vault but can, for example, read them if provided with the necessary permissions.</td>
</tr>
<tr>
<td>User cannot create or modify traditional folders</td>
<td>The user cannot create traditional folders in the vault or modify existing traditional folders.</td>
</tr>
<tr>
<td>External user</td>
<td>Users can be grouped into external and internal users. A user can be defined as an external user by enabling the <strong>External user</strong> option. External users cannot see or access any documents other than those specifically marked for them. By default, they do not have permissions to view any documents. For example, you can define your customers as external users and grant them access to customer-specific documents in the document vault.</td>
</tr>
<tr>
<td></td>
<td>As stated above, external users do not, by default, have permissions for accessing any documents. To share a document with an external user, access must be explicitly granted in the permissions of the document.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Object permissions are updated as an asynchronous background task. Object permissions may be updated when, for example, a named access control list, a user, a user group, or the value of a pseudo-user (such as a project manager) is modified. You may monitor the progress of the task in M-Files Admin in the <strong>Background Tasks</strong> section. For more information, see Monitoring Background Tasks.</td>
</tr>
<tr>
<td>Full control of vault</td>
<td>With this option, the user is assigned all administrative permissions in the vault.</td>
</tr>
<tr>
<td>See and read all vault content (including deleted objects)</td>
<td>Regardless of the permissions specified for a document or object, a user with this permission can see and read all objects, including deleted ones.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>See and undelete deleted objects</td>
<td>The user has the permission to restore documents and other objects marked as deleted.</td>
</tr>
<tr>
<td>Destroy objects</td>
<td>The user has the permission to permanently destroy objects.</td>
</tr>
<tr>
<td>Force undo checkout</td>
<td>A user with this permission can undo the checkout made by another user. For example, if a user has forgotten to check in a document that others should be able to edit, a user with this permission can check in the document. In this case, the changes made to the document during the checkout will not be saved on the server.</td>
</tr>
<tr>
<td>Change permissions for all objects</td>
<td>The user has the right to change the permissions for any object that they are permitted to see. You can edit the permissions for an object, for instance, remove the write permission to a document from other users.</td>
</tr>
<tr>
<td>Note:</td>
<td>The user with this permission has the power to obtain edit rights to documents that they would normally be able to only read.</td>
</tr>
<tr>
<td>Change metadata structure</td>
<td>The user has the permission to modify document vault metadata, such as add new document classes or value lists. For example, if you want to change the Invoice document class so that the Project property field must be filled in for each invoice, you can make the change if you have this permission. Even if the user does not have the permission to do this, the user can still add new metadata fields to individual objects using the metadata card.</td>
</tr>
<tr>
<td>Note:</td>
<td>With this permission, users may be allowed to view metadata structure items and other vault information that they would not otherwise be permitted to view, such as value lists, object types, and named access control lists.</td>
</tr>
<tr>
<td>Manage workflows</td>
<td>This permission enables the user to create, edit and delete workflows in M-Files Admin.</td>
</tr>
<tr>
<td>Manage user accounts</td>
<td>The user has the permission to manage login accounts in the selected document vault. With this permission, you can, for instance, add or remove users from the document vault.</td>
</tr>
<tr>
<td>Manage common views and notification rules</td>
<td>The user has the permission to manage the document vault views and notification rules. With this permission, you can create a document vault view visible to all users. You can also define common notification rules. Common views and notifications are created via M-Files Desktop.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>9. Optional: On the <strong>Permissions</strong> tab, specify the users or user groups who may see this user.</td>
<td></td>
</tr>
<tr>
<td>a) On the <strong>Users and user groups</strong> list, select the user or the user group for which you wish to set the permissions for seeing this user.</td>
<td></td>
</tr>
<tr>
<td>i) If the desired user or user group is not on the list, click <strong>Add...</strong> to add the user or user group to the <strong>Users and user groups</strong> list.</td>
<td></td>
</tr>
<tr>
<td>b) Check either the <strong>Allow</strong> or <strong>Deny</strong> check box to modify the permissions of the selected user.</td>
<td></td>
</tr>
<tr>
<td>10. Click <strong>OK</strong> once you are done.</td>
<td></td>
</tr>
<tr>
<td>A new user is created and it is listed in the <strong>Users</strong> list. The new user can now access the selected document vault with the permissions that you have defined.</td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> You can also import domain users to M-Files. For instructions, see <strong>Importing Users</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

**Importing Users**

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, select **Users** and then click **Import Individual Users...** on the task area. |

   The **Import Individual Users** dialog is opened.

5. Select either:

   a. **Choose from list** to select the user group using drop-down menus. In **Domain**, select the desired domain. In **Organizational unit**, select the desired organizational unit within that domain. Finally, in **User group**, select the user group that you want to import.

   or

   b. **Enter Name**. This option is especially useful if you have so many user groups that searching the correct one from list is hard. Enter the name of the user group in the format `<domain>\<user group>` and click **Show**. |

   The list area in the dialog is populated with the members of the selected user group.
6. Optional: Check the **Include users from nested groups** check box to be able to import login accounts from nested groups within the selected user group.

   The list area in the dialog is populated with the members of the selected user group and the members of any user group nested within the selected user group.

7. Select the user to be imported by clicking its username on the list.

   You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the ⇧ Shift key to select adjacent items on the list.

8. Using the **License type for new login accounts** drop-down menu, select the license type for the login accounts that are created for the imported users.

   For more information about license types, see [License type](#).

9. Click **OK** to import the selected users.

   The users are imported to the selected vault and added to the **Users** list.

**Vault User Permissions**

The **Permissions** tab enables you to specify who may see this user.

**Note:** The system administrator and all users with full control of the document vault in question always see all users.

**Adjusting Permissions**

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, click the appropriate node or subnode of the vault and select the desired item from the list on the right or from the left-side tree view.

5. Right-click the item and select **Properties** from the context menu.

6. Go to the **Permissions** tab.

7. From the **Users and user groups** list, select the user or user group whose permissions you want to adjust.

   ![Users and user groups](image)

   If the user or user group is not on the list, click **Add...** to add the user or user group to the list.
8. Either:
   a. Check the **Allow** check box to allow the selected user to see this item.
   
or
   b. Check the **Deny** check box to deny the selected user from seeing this item.

9. Optional: If you want to adjust additional permissions, repeat the steps 7 and 8.

10. Click **OK** once you are done.

You have adjusted the view permissions of the selected item for the selected users.

**User Groups**

You can create, edit, remove and import user groups to your vault. Creating user groups makes it easier to specify permissions for documents. You can combine into user groups individual users with a certain common feature, such as their position in the organization (management, research and development, and so forth).

![User groups diagram](image)

**Figure 115: User groups simplify the management of access rights.**

You can manage the user groups in your vault by completing the following steps:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, select User Groups.

In this chapter

- Creating a User Group
- Importing User Groups
- User Group Permissions

Creating a User Group

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, click User Groups.

   Tip: If the list contains a large number of items, you might want to filter it. To filter the view, open the View menu and click Filter. Enter a desired text to filter the column contents.

5. On the task pane, click New User Group....

   The User Group Properties dialog is opened.

6. In the Name field, enter a name for the new user group.

7. Click Add... to add users to this group.

   The Select Users or User Groups dialog is opened.

8. Select the users to be added to the user group and click Add.

   You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the ⇧ Shift key to select adjacent items on the list.

9. Optional: Enable the Group members are synchronized from the domain and click Define... if you want to retrieve the users from a domain.

   For more information, see Importing User Groups.

10. Optional: On the Advanced tab, define an alias for the user group.

   For more information, see Associating the Metadata Definitions.

   When you have automatic aliases in use and you write a name on the General tab, the Aliases field on the Advanced tab is automatically filled in. The alias has the format <predefined prefix>.<name>. Define automatic aliases for your vault in the configurations editor.

11. Click OK to finish creating the user group.
The user group that you have just created is added to the **User Groups** list.

**Note:** Object permissions are updated as an asynchronous background task. Object permissions may be updated when, for example, a named access control list, a user, a user group, or the value of a pseudo-user (such as a project manager) is modified. You may monitor the progress of the task in M-Files Admin in the **Background Tasks** section. For more information, see [Monitoring Background Tasks](#).

### Importing User Groups

User groups can be imported by domain and by organizational unit. This makes importing user groups into M-Files quicker and easier. M-Files can check for new and deleted user group members periodically.

#### Domain

<table>
<thead>
<tr>
<th>User groups</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
</tr>
<tr>
<td>Tina Smith</td>
</tr>
<tr>
<td>Mike Taylor</td>
</tr>
<tr>
<td>Samuel Lewis</td>
</tr>
<tr>
<td>Marketing</td>
</tr>
<tr>
<td>Alex Kramer</td>
</tr>
<tr>
<td>Production</td>
</tr>
<tr>
<td>John Stewart</td>
</tr>
<tr>
<td>Tommy Hart</td>
</tr>
</tbody>
</table>

#### Vault

<table>
<thead>
<tr>
<th>User groups and users</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sales</td>
</tr>
<tr>
<td>Tina Smith</td>
</tr>
<tr>
<td>Mike Taylor</td>
</tr>
<tr>
<td>Samuel Lewis</td>
</tr>
<tr>
<td>Marketing</td>
</tr>
<tr>
<td>Alex Kramer</td>
</tr>
<tr>
<td>Production</td>
</tr>
<tr>
<td>John Stewart</td>
</tr>
<tr>
<td>Tommy Hart</td>
</tr>
</tbody>
</table>

#### M-Files Server

<table>
<thead>
<tr>
<th>Login accounts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tina Smith</td>
</tr>
<tr>
<td>Mike Taylor</td>
</tr>
<tr>
<td>Alex Kramer</td>
</tr>
<tr>
<td>Samuel Lewis</td>
</tr>
<tr>
<td>John Stewart</td>
</tr>
<tr>
<td>Tommy Hart</td>
</tr>
</tbody>
</table>

![Figure 116: User groups can be imported from the domain to the vault, allowing existing user groups in the domain to be used for specifying permissions to vault content.](image)

Complete the following steps to import user groups:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, click **User Groups** and then click **Import User Group...** on the task area.

   The **Import User Group** dialog is opened.
5. Select either:

   a. Choose from list to select the user group using drop-down menus. In Domain, select the desired domain. In Organizational unit, select the desired organizational unit within that domain. Finally, in User group, select the user group that you want to import.

   or

   b. Enter Name. This option is especially useful if you have so many user groups that searching the correct one from list is hard. Enter the name of the user group in the format `<domain>\<user group>` and click Show.

   The list area in the dialog is populated with the members of the selected user group.

6. Optional: Check the Include users from nested groups check box to be able to import login accounts from nested groups within the selected user group.

   The list area in the dialog is populated with the members of the selected user group and the members of any user group nested within the selected user group.

7. Using the License type for new login accounts drop-down menu, select the license type for the login accounts of the users to be imported.

   For more information about license types, see License type.

8. Optional: Select the Check for new and deleted members every 15 minutes check box if you want to keep the user group up to date and import new users automatically when they are added to the group.

9. Click OK to import the selected user group.

The selected user group is imported to the selected vault and it is added to the User Groups list. In addition, new login accounts are created for new users.

Defining, Editing or Disabling Import Settings of Existing User Groups

You can also import users to existing user groups in M-Files.

Or you can edit the synchronization settings of previously imported user groups. If the user group on the domain is changed (it is for instance renamed or the grouping is changed), the earlier imported M-Files user group can be merged with the new user group on the domain. This preserves the identity of the M-Files user group regardless of changes in the domain user group, and the permissions related to it can remain the same.

if you no longer wish to import users to a specific user group, you can also disable user group synchronization altogether.

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, click User Groups and then, on the User Groups list, double-click a user group that you want to edit.

   The User Group Properties dialog is opened.
5. Either:

<table>
<thead>
<tr>
<th>If you want to</th>
<th>Do the following</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Import to users an existing user group</strong></td>
<td>Check the <strong>Group members are synchronized from the domain</strong> check box, click the <strong>Define</strong> button and then define the import settings in the dialog that is opened. See <strong>Importing User Groups</strong> for specific instructions on import settings. After you are done, click <strong>OK</strong>.</td>
</tr>
<tr>
<td><strong>Edit the import settings of a previously imported user group</strong></td>
<td>Click <strong>Define</strong>... and modify the settings in the dialog that is opened. See <strong>Importing User Groups</strong> for specific instructions on import settings. After you are done, click <strong>OK</strong>.</td>
</tr>
<tr>
<td><strong>Disable user group synchronization for a user group</strong></td>
<td>Uncheck the <strong>Group members are synchronized from the domain</strong> check box.</td>
</tr>
</tbody>
</table>

6. Click **OK** to save your changes and close the **User Group Properties** dialog.

**Users in Synchronized Active Directory Groups**

When new users are added to Active Directory (AD) groups that are synchronized to M-Files:

- The users are added as vault users to the vault in which the user group is located.
- If the added users do not yet have M-Files login accounts, new login accounts are automatically created for the users and the license specified in the synchronization settings is applied to the new login accounts.
- No changes are made to existing M-Files login accounts. If users have been assigned concurrent licenses, and they are added to a group for which named licenses are specified, the users retain their concurrent licenses.

When users are removed from all the AD groups that are synchronized to M-Files:

- The users are removed from the user group in M-Files, losing all permissions that were granted to them through the group membership.
- The user accounts remain in M-Files but are disabled.
- The login accounts remain active, keeping the licenses assigned to them.

**Note:** Users will not be automatically disabled as long as they are members of at least one synchronized AD group.

**User Group Permissions**

The **Permissions** tab enables you to specify who may see this user group.

**Note:** The system administrator and all users with full control of the document vault in question always see all user groups.

**Adjusting Permissions**

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, click the appropriate node or subnode of the vault and select the desired item from the list on the right or from the left-side tree view.

5. Right-click the item and select **Properties** from the context menu.

6. Go to the **Permissions** tab.

7. From the **Users and user groups** list, select the user or user group whose permissions you want to adjust.

   ![Users and user groups list](image)

   If the user or user group is not on the list, click **Add...** to add the user or user group to the list.

8. Either:

   a. Check the **Allow** check box to allow the selected user to see this item.

   or

   b. Check the **Deny** check box to deny the selected user from seeing this item.

9. Optional: If you want to adjust additional permissions, repeat the steps 7 and 8.

10. Click **OK** once you are done.

You have adjusted the view permissions of the selected item for the selected users.

**External Repository Users**

When you connect a document vault to an external repository using the Intelligent Metadata Layer technology, users in the external repository are imported to M-Files Server.

The **External Repository Users** view in M-Files Admin allows you to manage and refine associations between M-Files users and external repository users. When you associate an M-Files user with an external repository user, the M-Files user inherits the access rights of the external repository user. This way you can refine the access rights of an M-Files user to external repository content.
Figure 117: You can refine the access rights to external repository content, such as files and folders obtained via a network folder connection, by associating external repository users with M-Files users in M-Files Admin.

Depending on your connector configuration, automatic associations between M-Files users and external repository users may be established in external repository connections. See Automatic Association for more information.

For more information on Intelligent Metadata Layer, see Intelligent Metadata Layer.

**Note:** External Repository Users is visible only if the selected vault has one or more active external repository connections.

Complete the following steps to associate an M-Files user with an external repository user:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select External Repository Users.
   - **Tip:** If the list contains a large number of items, you might want to filter it. To filter the view, open the View menu and click Filter. Enter a desired text to filter the column contents.
5. Double-click the external repository user of your choice, or select the external repository user and then click Properties on the task area.
   - The User Properties dialog is opened.
6. To associate an M-Files user with the selected external repository user, click the **Add...** button.

- The **Select Users** dialog is opened.
7. Select the M-Files user or users that you want to associate with the selected external repository user and then click **Add**.

   You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the ⇧ Shift key to select adjacent items on the list.

8. Click **OK** to close the **User Properties** dialog.

The selected M-Files user is now associated with the selected external repository user, and the M-Files user has the same access rights to the external repository content as the external repository user when the M-Files user accesses the external repository via M-Files.

**External Repository User Groups**

When you connect a document vault to an external repository using the Intelligent Metadata Layer technology, all or some of the user groups in the external repository are imported to M-Files Server, depending on your connector configuration.

The **External Repository User Groups** view in M-Files Admin allows you to manage and refine associations between M-Files users or M-Files user groups and external repository users or external repository user groups. When you associate an M-Files user or user group with an external repository user group, the M-Files user or user group inherits the access rights of the external repository user group. This way you can refine the access rights of an M-Files user to external repository content.
Figure 118: You can refine the access rights to external repository content, such as files and folders obtained via a network folder connection, by associating external repository user groups with M-Files users and user groups in M-Files Admin.

Depending on your connector configuration, automatic associations between M-Files users or M-Files user groups and external repository users or external repository user groups may be established in external repository connections. See Automatic Association for more information.

For more information on Intelligent Metadata Layer, see Intelligent Metadata Layer.

Note: External Repository User Groups is visible only if the selected vault has one or more active external repository connections.

Complete the following steps to associate an M-Files user or user group with an external repository user group:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   
   Tip: If the list contains a large number of items, you might want to filter it. To filter the view, open the View menu and click Filter. Enter a desired text to filter the column contents.

5. Double-click the external repository user group of your choice, or select the external repository user group and then click Properties on the task area.

The User Group Properties dialog is opened.
6. To associate an M-Files user or user group with the selected external repository user group, click the **Add...** button.

   - The **Select Users or User Groups** dialog is opened.
7. Select the M-Files user or user group that you want to associate with the selected external repository user group and then click Add.

You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the Shift key to select adjacent items on the list.

8. Click OK to close the User Group Properties dialog.

The selected M-Files user or user group is now associated with the selected external repository user group, and the M-Files user or user group has the same access rights to the external repository content as the external repository user group when the associated M-Files user accesses the external repository via M-Files.

3.2.3. Configuring Workflows

M-Files integrates with the organization's administrative and executive processes. Defining and monitoring tasks is easiest where the task documents are located. With workflows, the routines of the organization can be widely automated and tasks can be assigned to the right people at the right time. Users receive e-mail notifications about task-related issues, and managers can monitor task progress and approve completed tasks.

Workflows can be used, among many other processes, for purchase invoice circulation. Workflow states could in that case include:

- Awaiting approval
- Approved
- Rejected
- Paid in full

You can define who is allowed to transfer the object from one state to the next and who is responsible for the next workflow task. For example, invoices could only be approved for payment by a member of the management group.
When the invoice is in the *Approved* state, the department responsible for money transactions would automatically be informed that a new invoice is awaiting payment. When the invoice has been paid, it is transferred to the *Paid in full* state.

![Workflow diagram](image)

**Figure 119:** Workflows facilitate routine tasks of the organization, such as processing purchase invoices.

**Graphical Workflow Designer**

M-Files comes with a graphical user interface for managing workflows. See [Graphical Workflow Designer](#) for more details.

**In this chapter**

- Graphical Workflow Designer
- Creating and Editing Workflows

**Graphical Workflow Designer**

You can use the graphical workflow designer in M-Files Admin for creating and modifying workflows. Access the designer in M-Files Admin by first selecting the vault connection and then the vault in the left-side tree view, and then by navigating to **Workflows**.

**Note:** The designer requires Internet Explorer 9 or later to be installed on the computer.

**Workspace**

The **Workflows** window has two sections:

- The top section lists the available workflows and the task area commands **New Workflow**, **Make Copy**, **Delete** and **Properties**.
- The bottom section displays the graphical workflow designer. The designer-related task area commands are explained in **Using the designer** and **Task pane commands**.
The **Save** and **Discard** commands are located in the top-right corner of the workspace, on the title bar of the selected workflow. The **Save** command stores all the modifications to the workflow, including the layout of your graphical representation.

You can modify the workspace proportions by dragging the workflow title bar up or down.

**Using the designer**

The designer has been designed to work very intuitively. You can use the task area and/or interact with the graphical designer and context menus.

**Creating new states**

You can create new states either via the task area or by double-clicking an empty space on the canvas. This opens up the dialog for a new workflow state.

**Note:** If a class has a default workflow and a new object is created in the class, the first state is chosen automatically only if the first state is the first on the **States** list of the **Workflow Properties** dialog. The order of states on the list overrides the order of states in the graphical workflow designer.

**Editing states**

You can open the properties dialog for an existing state simply by double-clicking the state, by selecting it and then clicking **Edit State** via the task area, or via the context menu for the state.

**Deleting states**

States can be deleted via the task area command **Delete**, via the context menu of the state, or by selecting the state and pressing the Delete key on your keyboard.

**Modifying the layout**

The workflow states can be freely moved around on the canvas by dragging and dropping.

**Connectors (state transitions)**
You can add arrow connectors between the states by moving your cursor on the edge of a state rectangle and by using drag and drop. The state rectangle has green edges and the cursor changes into a cross (+) when a connector can be drawn. The connectors represent workflow state transitions.

![Figure 121: A state transition being drawn from "Testing" to "Released".](image)

Sometimes the connectors may overlap with each other or with the state rectangles. The connectors can also be modified to make the layout more readable. Just select a connector and use the two handles for reshaping the connector.

The context menu for a connector allows you to **Edit** or **Delete** the state transition in question, as well as to **Straighten** the connector. Double-clicking the connector opens the properties dialog for the state transition.

**Zooming and dragging the canvas**

You can zoom in and out by scrolling, as well as drag the canvas around. The context menu for an empty space on the canvas allows you to reset the zoom level.

**Task pane commands**

In addition to context-specific task area commands, such as **Edit State** or **Straighten**, there are also a few actions that affect the designer or your workflow as a whole.

**Re-layout**

With the **Re-layout** command you can "clean up" the canvas. This basically makes M-Files suggest a default positioning for the workflow components.

**Show Grid and Hide Grid**

The **Show Grid** and **Hide Grid** commands toggle the grid shown on the background.

**Print**

You can create a paper copy of the workflow by using the **Print** command on the task area.

> **Note:** The print function uses the **Page setup** settings of Internet Explorer for the page header and footer. You can set the settings for the header and footer to **empty** if you want to remove them from the printout. For instance with Internet Explorer 10, you can open the **Page setup** dialog by clicking the tools button in the top-right corner of the browser and by selecting **Print > Page setup**.

**Export as Image**

In addition to creating a print-out, you can export the workflow as a PNG file. Clicking the **Export as Image** command opens the common Windows save dialog for the image file.

**Tooltips**

The state rectangles and connectors may display a tooltip while the cursor is hovered above them.
In addition to the title of the element, the tooltips may contain a description as well as information on the state transition conditions and special actions related to the transition or workflow state.

**Creating and Editing Workflows**

The Workflow feature enables automating company processes. You can start creating a new workflow by clicking **Workflows** in the left-side tree view of M-Files Admin and selecting **New Workflow...** on the task area.

![Workflow Properties - Reviewing drawings](image)

Figure 122: The properties dialog for a workflow.
Name
Give a descriptive name for the workflow.

Description
A free-form description of the workflow.

States
Use the arrow keys along the right side of the dialog to change the order of the states. Use the Add..., Edit... and Remove buttons to manage the workflow states.

Note: If you are creating a workflow that is going to be forced for new objects of a specific class (see New Class for more information), make sure that the first state after (no state) in the graphical workflow designer is the topmost state in the States list.

Allow using this workflow with the following class
You can allow a given workflow to be used with all classes or with one class only. For example, you can define that the Purchase Invoice Approval workflow can be selected for documents in the Purchase Invoice class only. The workflow will in that case not be selectable for documents in any other class.

The Permissions tab
Access for viewing this workflow can be set on the Permissions tab. If the user does not have access for viewing the workflow, also the workflow states are hidden.

The Advanced tab
From the Advanced tab, you can define an alias for the workflow. For more information, see Associating the Metadata Definitions.

In this chapter
- Creating a New Workflow
- Workflow States
- Workflow State Transitions

Creating a New Workflow
1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Workflows.
5. Click New Workflow... on the task area to start creating a new workflow.

The Workflow Properties dialog is opened.
6. In the **Name** field, enter a name for the workflow and, in the **Description** field, enter an optional description for the workflow.

7. Optional: Click **Add...** to add states to the workflow.

   - States can also be added later in the graphical workflow designer by selecting a workflow and clicking **New State** on the **Tools** pane.

   - **Note:** If a class has a default workflow and a new object is created in the class, the first state is chosen automatically only if the first state is the first on the **States** list of the **Workflow Properties** dialog. The order of states on the list overrides the order of states in the graphical workflow designer.

8. Optional: On the **Advanced** tab, define an alias for the workflow.

   - When you have automatic aliases in use and you write a name on the **General** tab, the **Aliases** field on the **Advanced** tab is automatically filled in. The alias has the format `<predefined prefix>.<name>`. Define automatic aliases for your vault in the configurations editor.

9. Click **OK**.

The workflow you have just created is added to the **Workflows** list. You can add workflow states and state transitions to it by selecting the workflow from the list and using the tools on the **Tools** pane.

- For instructions on adding workflow states to a workflow, see **Adding States to a Workflow**.
- For instructions on adding state transitions between states in a workflow, see **Adding State Transitions to a Workflow**.

**Workflow States**

Workflow states are used for dividing workflows into smaller stages. You can create a new workflow state by double clicking the canvas in the **Graphical Workflow Designer** or by clicking the **Add...** button on the **General** tab of the **Workflow Properties** dialog (see **Creating and Editing Workflows**).

Individual states allow a variety of settings. The **General** tab contains the name and the description of the state. The properties dialog for a workflow state also includes the tabs **Conditions**, **Actions**, and **Advanced**. The **Advanced** tab allows you to assign an alias for the state. When you have automatic aliases in use and you write a name on the **General** tab, the **Aliases** field on the **Advanced** tab is automatically filled in. The alias has the format `<predefined prefix>.<name>`. Define automatic aliases for your vault in the configurations editor. For more information on aliases, see **Associating the Metadata Definitions**.

   - **Note:** In versions 2015 and earlier, the **State Properties** dialog contains the **State Transition** tab. This can be enabled in M-Files 2015.1 and later by using a Windows registry setting. Ask your M-Files consultant for more information, or contact our customer support at support@m-files.com.

**In this chapter**

- **Adding States to a Workflow**
- **Workflow State Conditions**
- **Workflow State Actions**

**Adding States to a Workflow**

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, select **Workflows**.

5. Select a workflow from the **Workflows** list and click **New State** on the **Tools** pane.

   - The **State Properties** dialog is opened.

6. In the **Name** field, enter a name for the workflow state and, in the **Description** field, enter an optional description for the state.

7. Optional: In the **Conditions** tab, specify the preconditions and postconditions that must be met before an object can be moved in or out of this state.

   - For more information on workflow state conditions, refer to **Workflow State Conditions**.

8. Optional: In the **Actions** tab, specify the actions that are performed when an object is moved to this state.

   - For more information on workflow state actions, refer to **Workflow State Actions**.

9. Click **OK** to close the **State Properties** dialog.

10. Click **Save** to save your changes.

    The new state you have just defined is added to the workflow. The state can be seen in the graphical workflow designer.

    - For instructions on adding state transitions between states in a workflow, see **Adding State Transitions to a Workflow**.
    - For instructions on creating a new workflow, see **Creating a New Workflow**.

**Workflow State Conditions**

On the **Conditions** tab you can specify different pre- and post-conditions for the state transitions. For example, you can define specific properties or their values that a document should meet before it can moved to this state. The conditions can also specify that, for instance, the basic documents related to the project (specification document, implementation and project timetable instructions, etc.) must be on a certain level before moving to the next level is possible.

The conditions can be specified in broader scope and detail using variables, generic features of VBScript, and M-Files API. The following variables can be used in advanced conditions: **VaultSharedVariables**, **MFScriptCancel**, **CurrentUserID**, **Vault**, **DisplayID**, **ObjVer**, **PropertyValues**, **StateID**, **PropertyDef**, **SavepointVariables**, **TransactionCache**, and **GetExtensionObject**. For more information about variables, refer to **Available VBScript Variables**.

- **Note:** The M-Files API documentation is located at [www.m-files.com/api/documentation/latest](http://www.m-files.com/api/documentation/latest). For more information about using VBScript in M-Files, see the **How do I write VBScript code for M-Files purposes?** tutorial.
The conditions specified below control when an object can be moved into or out of this state.

Preconditions
- [ ] Property conditions
  - Define...
- [ ] Advanced conditions (VBScript)
  - Edit Code...

Postconditions
- [ ] Property conditions
  - Define...
- [ ] Advanced conditions (VBScript)
  - Edit Code...

Figure 123: The **Conditions** tab of the workflow state properties.
Preconditions

The state preconditions specify the object properties that are required in order for the object to be moved to this state.

For example, you can specify that the Approved by information must be entered before the document can be moved to the Approved state.

Postconditions

The state postconditions specify the object properties that are required in order for the object to be moved out of this state.

For example, you can specify that the Cost center information in a purchase invoice must be entered before the document can be moved from the Awaiting definition of cost center state.

Workflow State Actions

The Actions tab is used for setting the actions to be performed when the object enters to a certain state.
State Properties

The actions specified below are carried out when an object moves into this state.

- **Set permissions**
  - Full control for all internal users
  - Do not use automatic permissions
  - Ignore the permissions of the latest checked-in version for this version

- Delete
- Mark for archiving
- Send notification
- Set properties
- Convert to PDF format
- Run script
- Assign to user
- Create separate assignments

<table>
<thead>
<tr>
<th>Class</th>
<th>Title</th>
</tr>
</thead>
</table>

- Add...
- Edit...
- Remove

[OK] [Cancel] [Help]
1. Set permissions, Delete, and Mark for archiving
2. Send notification and Set properties
3. Convert to PDF format
4. Run script
5. Assign to user
6. Create separate assignments

The actions are executed in the following order:

1. Mark for archiving
2. Assign to user
3. Create separate assignments
4. Send notification
5. Set properties
6. Convert to PDF format
7. Set permissions
8. Run script
9. Delete

In this chapter

• Set permissions, Delete, and Mark for archiving
• Send notification and Set properties
• Convert to PDF format
• Run script
• Assign to user
• Create separate assignments

Set permissions, Delete, and Mark for archiving

You can define new permissions to be set, the object to be deleted, and/or archiving to be performed as a result of a state transition. Several options of the Actions tab can be selected at the same time.

Do not use automatic permissions

As a result of this state transition, the object bypasses the automatic permissions that would normally be applied to the object, and the effective permissions for the object version are configured with the Set permissions feature.

Ignore the permissions of the latest checked-in version for this version

The permissions of the objects are version-specific in M-Files. In order for you to access the latest object version, you must have at least read access to it. To access any of the previous versions, you must have at least read access to that specific version and to the currently latest version. Enabling this check box ignores the permissions of the latest checked-in version and grants users access to prior versions of the object to which they have at least read access rights – regardless of the permission settings of the latest version.

This feature merits an example: Let's suppose that we have an SOP and an SOP workflow with the states Draft, Waiting for Approval and Approved. All three states have different permissions, as a draft is shown only to the user who created the document, and an approved document is shown to all users.
The document is now at version 3 and in the Approved state (and thus visible and accessible to all users). As modifications need to be introduced, it is moved back to the Draft state and the permissions are changed so that only the creator of the document can see it. If the check box **Ignore the permissions of the latest checked-in version for this version** was active when the new version was created, all users would still be able to access the document version 3, but not the newest one. If the check box was not active, however, only the creator of the document would be able to see the document version 3.

**Note:** Even if the **Ignore the permissions of the latest checked-in version for this version** option was enabled, the document would still not be visible in searches and views if they do not have the **Look in the metadata of all versions** option enabled.

Send notification and Set properties

**Send notification**

To send a notification, first define the recipient users and user groups. Then enter the notification subject and the message. You can also specify the user from metadata or state transitions.

The **Add Placeholder...** buttons can be used to insert values from the object metadata to the subject line or message content (see also the placeholder descriptions under **Personalizing Notification Messages**).

**Set properties**

You can define different object properties and values to be applied when an object's state is changed. For example, you can make the Published version label to be assigned to a drawing when the drawing moves to the Approved state.

Convert to PDF format

Files of the object can be automatically converted into PDF form on the server when the object changes state. Conversion to PDF on the server can be done for files in such source formats as Microsoft Word, Microsoft Excel, Microsoft PowerPoint, Microsoft Outlook, and Visio, as well as RTF and OpenOffice files.

When converting to PDF, M-Files updates the M-Files property fields, if any, in Microsoft Word and Microsoft Excel documents by using the current metadata of the object.

**Conversion settings**

When you activate the **Convert to PDF** function from the **Actions** tab, M-Files converts the files in a single-file or multi-file document to PDF form automatically when the object's state changes. You can define advanced settings for the conversion.

**Store each PDF file as a separate file next to the original file:** If you also want to keep the file in its original format, select to store the PDF file next to the original file. Then the PDF file does not replace the original. The PDF file is created with the same name as the original file. If this function is applied to a single-file document, M-Files changes it into a multi-file document when creating the PDF file.

**Overwrite existing PDF files:** If there are already PDF files with this name in the multi-file document, select this option if you want to overwrite the identically named existing PDF files with the versions created via this function. If this option is not selected and the multi-file document already has a PDF file with the same name, M-Files will notify of the error and the PDF file will not be created.

**Convert to PDF/A-1b:** Select storage in PDF/A-1b form when you want to comply with ISO standard 19005-1:2005 for long-term preservation of electronic documents. PDF/A-1b is a more restricted format than that of standard PDF files, so files converted to PDF/A are often bigger than files converted to
standard PDF. In addition, in export to PDF/A, certain advanced appearance settings may be omitted. You should use conversion to PDF/A form only if it is particularly necessary on account of, for example, requirements for long-term preservation.

**Prevent state transition if the object contains files in an unsupported format:** Select this if you want to prevent the state transition in cases wherein the PDF conversion function encounters files with formats that cannot be exported as PDF files (for instance, ZIP files). An error message is displayed and the state transition is prevented.

**Run script**

Operations can be specified in more detail using variables, generic features of VBScript, and M-Files API. For example, you can set consecutive numbers for different publication versions or add the send date for a document when it moves to the *Sent* state.

The following variables can be used in this script: `VaultSharedVariables`, `MFScriptCancel`, `CurrentUserID`, `Vault`, `DisplayID`, `ObjVer`, `PropertyValues`, `StateID`, `SavepointVariables`, `TransactionCache`, `PropertyDef`, and `GetExtensionObject`. For more information about variables, refer to [Available VBScript Variables](#).

**Note:** The M-Files API documentation is located at [www.m-files.com/api/documentation/latest](http://www.m-files.com/api/documentation/latest). For more information about using VBScript in M-Files, see the [How do I write VBScript code for M-Files purposes?](#) tutorial.

**Assign to user**

Assignments are an important part of workflows. They transfer information and responsibility for task execution to the correct person automatically during a state transition. M-Files offers two types of assignments for use in connection with workflows.

By selecting **Assign to User**, you can create an assignment that does not result in a separate object. An assignment created with this option is switched to the "complete" state when one of the persons to whom the task was assigned changes the document state in the workflow (usually by moving the object to the next state).
In the object's properties, you can see whom it has been *assigned to*, provided that the object is in a state to which an assignment is related. The person to whom the task was assigned can change the state by using the functions in the task area, metadata card or context menu.

Create separate assignments

You can also have separate assignments created once the object workflow is moved to a certain state. To create such assignments, enable **Create separate assignments** and click **Add...** on the **Actions** tab of the **State Properties** dialog.
If you want the workflow state to be automatically changed after the completion of the separate assignment(s), you need to define that in the Trigger options of the state transition.

**Adding and Removing users**

You can manage the persons responsible for completing the task by using the **Add**... and **Remove** buttons in both the **Assign to User** dialog and the **Create separate assignment** dialog. In addition to adding users via the **Users or user groups** list, you can add users based on metadata or a state transition. For example, a person who has been specified in the property **Approved by** in the object's metadata can automatically be specified as the person to whom the task is assigned. For more information, see **Permissions** under **Workflow State Transition Permissions** and **Pseudo-users**.

![Select Users or User Groups](image)

Figure 125: Selecting a user based on an earlier state transition.

**Monitoring**

In the **Monitoring** section (**Actions > Create separate assignments > Monitoring**), you can define the users that you want to notify each time a task has been completed. The assignment submitter is automatically defined as a task monitor.

There are separate icons for uncompleted and completed assignment objects, making it easy to distinguish between uncompleted and completed assignments.
Assignment class

The assignment class determines the assignment type and assignment completion conditions. See Assignment Class for more information.

Assignment description

Add a free-form description of the task. The assignment notice by email displays the description to the person to whom the task was assigned. Notification templates supported by M-Files can also be included in the description. For more information on notification templates and placeholders, refer to Editing Notification Settings in M-Files Admin.

Deadline

If desired, you can specify a deadline for the assignment. An automatic reminder is sent if the assignment has not been marked complete when the deadline is approaching. The reminder will be sent using a common notification rule which can be deleted by the administrator.

Tip: The deadline can also be useful for creating views. You can create a view to display any assignments with an approaching deadline. For more information about views, refer to Creating a View.

Creating a Workflow State with a Separate Assignment

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Workflows.
5. Select a workflow that you want to edit from the Workflows list.
6. In the graphical workflow designer, right-click a workflow state to which you want to add a separate assignment and select Edit.
7. In the Actions tab, check the Create separate assignments check box and click the Add... button.
8. Click Add... to add the user or users the separate assignment is assigned to.
9. Optional: Click Monitoring... to add a user or users who will receive a notification once this assignment is marked complete, approved, or rejected.
10. From the Select assignment class drop-down menu, select the assignment class for the separate assignment.
11. In the **Title** field, enter a title for the assignment and, in the **Assignment description** field, enter an optional description for the assignment.

   **Info** By clicking the **Add Placeholder...** button, you can add placeholders for metadata properties in the **Title** and **Assignment description** fields.

12. Optional: Check the **Deadline** check box and select the number of days to define a deadline for the separate assignment.

13. Click **OK** to close the **Create Separate Assignment** dialog.

14. Click **OK** to close the **State Properties** dialog.

15. Click **Save** to save your changes.

The separate assignment is added to the workflow state. When an assignment with the aforementioned workflow is moved to the aforementioned state, the separate assignment is created and added as a linked assignment under the primary assignment.

**Workflow State Transitions**

Workflow state transitions are used for moving from one workflow state to another. The transitions can be initiated manually by users or triggered automatically by M-Files Server. They may also be set to require an Electronic Signatures.

**The General tab**

The **General** tab contains the name of the state transition as well as an optional description for the state transition.

**The Electronic Signature tab**

The **Electronic Signature** tab allows you to enable eSigning for a state transition. If enabled, an electronic signature must be signed by the user before the state transition is performed. See Electronic Signatures for more information.

**The Trigger tab**

On the **Trigger** tab, you can define conditions for automatic state transitions. See Trigger for more information.

**The Advanced tab**

On the **Advanced** tab, you can set an alias for the state transition. For more information about using aliases, see Associating the Metadata Definitions.

**In this chapter**

- Adding State Transitions to a Workflow
- Parallel State Transitions
- Workflow State Transition Permissions
- Electronic Signatures
- Trigger
Adding State Transitions to a Workflow

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, select **Workflows**.
5. Select a workflow that you want to edit from the **Workflows** list.
   - The workflow is opened in the graphical workflow designer.
6. In the graphical workflow designer, place your cursor on the border of the state from which you want to create a state transition so that your cursor changes to a crosshair.
7. Holding down the left mouse button, draw a state transition by dragging the mouse cursor from the selected state to another.
8. Right-click the state transition arrow that you just created and select **Edit** from the context menu.
   - The **State Transition** dialog is opened.
9. In the **Name** field, enter a name for the state transition and, in the **Description** field, enter an optional description for the transition.
10. Optional: In the **Electronic Signature** tab, you can specify an electronic signature that must be provided before completing this state transition.
    - For more information on electronic signatures, refer to **Electronic Signatures**.
11. Optional: In the **Trigger** tab, you can define a condition that triggers this state transition once the condition is fulfilled.
    - For more information on triggers, refer to **Trigger**.
12. Click **OK** to close the **State Transition** dialog.
13. Click **Save** to save your changes.

The state transition is added to the workflow between the selected workflow states. This is manifested by the arrow between the states in the graphical workflow designer.

- For instructions on adding states to a workflow, see **Adding States to a Workflow**.
- For instructions on creating a new workflow, see **Creating a New Workflow**.

**Parallel State Transitions**

You can define multiple workflow state transitions between two states. This is useful, for instance, if you need to define multiple automatic transitions based on different criteria. For more information about creating state transitions, see **Adding State Transitions to a Workflow**.

Example: Creating a Workflow with a Parallel State Transition

---

---
The target in this example is to modify an existing sample vault workflow, such as *Reviewing drawings*, to be automatically moved to the **Rejected** state if no one moves it to the **Approved** (or **Rejected**) state within 10 days after the transition to the **Listed for approval** state.

![Diagram](image)

Figure 126: The workflow moves to the **Rejected** state automatically if nobody moves it to the **Approved** state.

To modify the workflow, do the following steps:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, select **Workflows**.
5. In the **Workflows** list, select one of the existing workflows, such as *Reviewing drawings*.
   - The workflow is shown as a flowchart in the graphical workflow designer below the **Workflows** list.
6. Click **New State** in the **Tools** pane to create a new state for the workflow.
   - If you already have a state called **Rejected** in your workflow, you can skip this and the next step, and proceed to step 8.
   - The **State Properties** window is opened.
7. Enter the name **Rejected** in the **Name** field and click **OK** to close the **State Properties** window.
8. In the graphical workflow designer, place your cursor on the border of the **Listed for approval** state (or any other intermediary state, if your workflow does not have the **Listed for approval** state) so that your cursor changes to a crosshair.
9. Hold down the left mouse button and drag the crosshair to the **Rejected** state to draw a state transition between the **Listed for approval** and **Rejected** states.
10. Repeat step 8 to draw another state transition between the **Listed for approval** and **Rejected** states.
11. Right-click one of the state transition connector arrows and select **Edit**.
   - If you are seeing only one connector arrow between the states, the connectors are most likely on top of each other. Click the topmost connector to select it and click and drag the handles to reshape the connector.
12. Go to the **Trigger** tab, select the **Trigger the state transition after** option, and enter **10** in the **days** field.
13. Click **OK** to close the **State Properties** window.
14. Click **Save** in the upper-right corner of the graphical workflow designer to save the changes you have made to your workflow.

You should now have a workflow with two parallel state transitions from the *Listed for approval* state to the *Rejected* state: one that is initiated by users and another that is triggered automatically after 10 days if it is not initiated by users in 10 days.

*Workflow State Transition Permissions*

You can access the state transition permissions by adding and selecting a state transition, clicking the **Edit Transition...** button and selecting the **Permissions** tab.

**Permissions**

On the **Permissions** tab, you can specify which users are allowed to perform an explicit state transition.
Figure 127: Define permissions for changing state by means of state transitions.

The **Select Users or User Groups** dialog under the **Add...** button also contains the options **User from metadata** and **User from state transition**.

**User from metadata**

You can also utilize pseudo-users in state transitions. For example, you can specify that invoices are to be accepted only by the project manager of the project linked to the invoice. In other words, you can define users via the object's metadata. Then the right to perform state transitions is not bound to a certain named person; it is instead determined dynamically on the basis of an object's metadata.
**User from state transition**

You can also select users on the basis of previous state transitions. You can specify that the document can be moved from the *Approved* state to *Approval undone* only by the user who originally moved the document into the *Approved* state.

**Electronic Signatures**

The electronic signature features offered by the Electronic Signatures and Advanced Logging module expands the versatile workflows of M-Files: the state transition can be certified with a username. This function can easily be used to certify, for example, approval of documents.

If an electronic signature has been defined for the state transition, the signature is always required for the user before the change in state. In order for the state to change, the object must be checked in, and change of state with a signature can only be done one object at a time. Only users using Windows authentication can perform state changes that require an electronic signature. The user adds an electronic signature to the state transition by entering his or her identification data and logging in. The electronic signature does not refer to an electronic "fingerprint"; it always requires entering the user identification and logging in.

![Figure 128: You can require users to provide their electronic signature before they can make a specific state transition in a workflow.](image)

The Electronic Signatures and Advanced Logging module is available for a separate fee. This module includes event logging extensions and electronic signature functionality. For more information, see Electronic Signing and Compliance.

**Electronic signature for workflow state transitions**

To incorporate an electronic signature with a workflow state transition:

1. Select a transition in the Graphical Workflow Designer.
2. Click *Edit Transition* in the left-side task pane.
3. Move to the *Electronic Signature* tab.
Enable the option **Require electronic signature for this action** to be able to modify the options.

**Signature meaning**

The **Signature meaning** options enable you to select either a predefined signature reason-meaning pair or to define multiple meanings for the signer to choose from. The signature reason is a brief heading-level description for the signature, such as *Approval of instruction document* or *Approval of invoice*. The signature meaning is a description that should enable the signer to understand what is being approved.
The maximum number of characters is 500, and you can use placeholders. The available placeholders are listed under Placeholders for Signature meaning and Additional information fields.

**Examples**

If you have entered "Signed by %SIGNED_BY%" in the **Signature meaning**, the the actual signature description to be shown to the user would be *Signed By Alex Kramer*.

If you want the substitute user's name to be shown, use the %SIGNED_BY_WITH_PROXY% placeholder. If you have entered "Signed by %SIGNED_BY_WITH_PROXY%" in the **Signature meaning** and Alex Kramer signs, the signature description will be *Signed by Alex Kramer*. If the signer is a substitute user of Alex, the signature description will be *Signed by Andy Nash, on behalf of Alex Kramer*.

In the following image, the user has defined the following signature meaning: "By moving this drawing from state %SIGNED_FROM_STATE% to %SIGNED_TO_STATE%, I confirm the drawing to be ready for the delivery to the client."

![Electronic Signature](image)

**Signature metadata**

You can set the electronic signature to require the signer to add a value for a selected metadata property, such as *Comment*. The text is saved either to a separate signature object (see Create a separate signature object) or to the object using the workflow. You can also include additional information to the **Additional information** text box. In **Additional information**, you can use placeholders (listed under Placeholders for Signature meaning and Additional information fields).

**Create a separate signature object**

Select this option if you want to create a new object for the signature. Then the signature object is automatically in relationship with the object to which the state transition applies.
 biodiversity and ecosystem. To foster biodiversity, strategies must be implemented that conserve and restore habitats, and mitigate the impacts of human activities. This includes the protection of biodiversity hotspots, the implementation of sustainable land use practices, and the enforcement of environmental laws. Conservation efforts need to be multifaceted, encompassing actions at local, national, and international levels. The role of policies, such as the Ramsar Convention and the Convention on Biological Diversity, is crucial in ensuring the conservation of biodiversity. These policies are essential for guiding and coordinating global efforts towards biodiversity conservation.
Save signature manifestation as text to a property

Select the property that the signature is to be associated with. Then the content of the signature that has been defined is displayed as the property value in the metadata of the object. The default property is *Signature manifestation*. The text content of the signature property consists of the *reason*, *meaning* and *additional information* for the signature.

**Note:** If you use the same property for signatures of all state transitions in the workflow, such as the default property *Signature manifestation*, you can see only the latest signature manifestation in the metadata of the object's latest version. Other signatures with their contents (manifestations) can be found via the version history of the relevant object.

You can also create a separate property definition of your own for each signature of the relevant state transition in the workflow. Then you can see all of the properties created and their signature content (manifestations) in the metadata of the object's latest version.

**Note:** If you first create a property in the *Property definitions* area, specify its permissions in such a way that the users can see the property used in the signatures but cannot edit it.

### Placeholders for Signature meaning and Additional information fields

The available placeholders to be used with the *Signature meaning* and *Additional information* fields are listed in the following table.

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>%SIGNED_ATUTC%</td>
<td>The UTC time at the time of signing.</td>
</tr>
<tr>
<td>%SIGNED_ATLOCAL%</td>
<td>The time on the client computer at the time of signing.</td>
</tr>
<tr>
<td>%SIGNED_AT%</td>
<td>The time on the server computer at the time of signing.</td>
</tr>
<tr>
<td>%SIGNED_BY%</td>
<td>The signer name.</td>
</tr>
<tr>
<td>%SIGNED_FROM_STATE%</td>
<td>The source state.</td>
</tr>
<tr>
<td>%SIGNED_TO_STATE%</td>
<td>The target state.</td>
</tr>
<tr>
<td>%SIGNED_FOR_STATETRANSITION%</td>
<td>The title of the state transition for which the electronic signature is required.</td>
</tr>
<tr>
<td>%SIGNED_BY_WITH_PROXY%</td>
<td>Displays the name of the signer and the user on behalf of whom an assignment has been electronically signed. For instance: &quot;Preston Present, on behalf of Abraham Absent&quot;. See the usage examples.</td>
</tr>
</tbody>
</table>

### In this chapter

- Metadata Definitions for an Electronic Signature Object
- Inserting the Signature Property to Microsoft Office Documents

**Metadata Definitions for an Electronic Signature Object**

In order for automatic signature objects to be created in M-Files, aliases must be created for the new object type as well as for the required property definitions. The aliases are used for creating objects at the time of signing. If you are using M-Files Compliance Kit, these definitions should already be available. Otherwise, you should create the metadata definitions below to activate the separate signature objects.
Object type

Create a new object type and name it, for example, the Signature object type. In the advanced settings, specify the object type alias:

M-Files.QMS.Signature.ObjectType

Required property definitions for the signature object

When you have created the new object type, M-Files automatically creates an equivalent property definition. Select this property definition in the property definitions and add the following alias:

M-Files.QMS.Signatures

In addition to this, add the property definitions listed below:

<table>
<thead>
<tr>
<th>Suggested property name</th>
<th>Alias</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identifier</td>
<td>M-Files.QMS.Signature.Identifier</td>
<td>Text</td>
<td>The identifier property is added to the electronic signature when the electronic signature object is created. The identifier property value is specified in the electronic signature settings in M-Files Admin.</td>
</tr>
<tr>
<td>Reason for signature</td>
<td>M-Files.QMS.Signature.Reason</td>
<td>Text</td>
<td>A brief heading-level description for the signature.</td>
</tr>
<tr>
<td>Signature meaning</td>
<td>M-Files.QMS.Signature.Meaning</td>
<td>Text (multi-line)</td>
<td>A description enabling the signer to understand what is being approved.</td>
</tr>
<tr>
<td>Signer</td>
<td>M-Files.QMS.Signature.Signer</td>
<td>Choose from list &quot;Users&quot;</td>
<td>The vault user electronically signing the state transition.</td>
</tr>
<tr>
<td>User</td>
<td>M-Files.QMS.Signature.User</td>
<td>Choose from list &quot;Users&quot;</td>
<td>The vault user to whose identity the signature is bound when the signature is used for moving an assignment to a terminal state, such as Completed, Accepted, or Rejected.</td>
</tr>
</tbody>
</table>

You can freely name the required property definitions mentioned above, but you should use the most descriptive names possible, since this information is shown in the metadata of the signature object.

Optional property definitions for the signature object

You can also create various optional property definitions for the signature object. For example, you may want to create a new property definition for additional signature information with the data type Text (multi-line) and add the following alias:

M-Files.QMS.Signature.AdditionalInfo

The rest of the optional properties are listed below:
<table>
<thead>
<tr>
<th>Alias</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-Files.QMS.Signature.Signer.Name</td>
<td>Text</td>
<td>Contains the full name of the signer.</td>
</tr>
<tr>
<td>M-Files.QMS.Signature.Signer.Account</td>
<td>Text</td>
<td>Contains the M-Files account name of the signer.</td>
</tr>
<tr>
<td>M-Files.QMS.Signature.LocalTimestampText</td>
<td>Text</td>
<td>The local time of the signature as text, including the timezone information.</td>
</tr>
<tr>
<td>M-Files.QMS.Signature.UTCTimestampText</td>
<td>Text</td>
<td>The UTC time of the signature as text, including the timezone information.</td>
</tr>
<tr>
<td>M-Files.QMS.Signature.UTCTimestamp</td>
<td>Timestamp</td>
<td>The UTC timestamp of the signature.</td>
</tr>
<tr>
<td>M-Files.QMS.Signature.Date</td>
<td>Date</td>
<td>The signature date in local (server) time.</td>
</tr>
<tr>
<td>M-Files.QMS.Signature.FromState</td>
<td>Choose from list “States”</td>
<td>The workflow state prior to the state transition. Available only when signing state transitions.</td>
</tr>
<tr>
<td>M-Files.QMS.Signature.ToState</td>
<td>Choose from list “States”</td>
<td>The workflow state after the state transition. Available only when signing state transitions.</td>
</tr>
<tr>
<td>M-Files.QMS.Signature.StateTransition</td>
<td>Choose from list “State Transitions”</td>
<td>The workflow state transition that has been executed. Available only when signing state transitions.</td>
</tr>
</tbody>
</table>

**Executed, empty, and invalidated signature objects and how to utilize them**

You can also create so-called empty signature objects and use them to monitor which signatures have not yet been signed and which signatures have already been executed. You can utilize these empty, executed, and invalidated signature objects creating different classes for the signature object type.

Here are the aliases which, if specified for classes of the Signature object type, are utilized by M-Files in various phases of electronic signing:

- M-Files.QMS.Signature.Class.Empty
- M-Files.QMS.Signature.Class.Executed
- M-Files.QMS.Signature.Class.Invalidated

**Permissions**

Metadata definitions (object type and property definitions) created for the automatic signature object should be secure; it should not be possible to create signature objects manually or change their metadata. Also the property definition that binds the signed object to the signature must be secure. If you are using M-Files Compliance Kit, these definitions are already available.

**Separate signature object**

When you have created the necessary definitions and chosen creation of a separate object for the signature, the object will be automatically created after signing.
The name of the signature object is created automatically from the signature reason, signer and timestamp.

Other metadata for the signature object are created automatically on the basis of the signature definitions.

Inserting the Signature Property to Microsoft Office Documents

The text content of the signature property can be added to a Microsoft Word, Microsoft Excel, or Microsoft PowerPoint document in the same way as other M-Files properties.

When the user selects the added property from the list, the property name, such as the name of the built-in property Signature manifestation, is displayed. This is why it is recommended to make the name of the property as unambiguous as possible.

When the property is selected, M-Files automatically adds the text content to the document. You should bear this in mind when you define the reason and meaning for the signature.

![Image of a Microsoft Word document showing a signature properties tab and a note:]

This document is electronically signed:

25/7/2017 12:44:16 AM Andy Nash (AndyN): 'Interview held' -> 'Applicant proposed for hiring'

Note: If the signature is inserted in the Microsoft Office document and you want to cancel the state transition, you should cancel it manually by removing the property value (signature manifestation) or the property itself, in order for the cancellation to apply for the document. In most cases, rolling back this kind of state transition to the previous state requires system administrator rights.

Trigger

You can define a trigger to automatically initiate a state transition when certain conditions are fulfilled. For example, you can set a state transition to take place when all the assignments of the current workflow state are completed or approved.
Figure 133: An automatic state transition can be triggered for an object on the basis of, for example, the property values of the object.

Automatic state transitions are executed by the server, ignoring user permissions. This means that permissions can be used to prevent users from manually initiating a state transition, ultimately executed by M-Files Server when all the assignees have completed the task.
Figure 134: Triggers can be used for automating workflow phases.

**Using various criteria for the automatic transition**

An automatic state transition can be configured to take place when an object fulfills certain conditions. You can configure, for example, the object to be moved to the next state when it is given a certain property or certain property value. For example, in the message process workflow, you can define that when a date is added to the *Sent* field for the document, the document will automatically be changed to the *Sent* state.

You can also set the state to be changed after all separate assignments are completed, approved, or rejected. Alternatively, you can specify custom criteria for the state change. For more information
Using a user-defined script for the automatic transition

The state transition can also be triggered via a user-defined script. This allows you to specify the transition conditions in more detail by using variables, generic features of VBScript and M-Files API. For example, you can define several state transitions related to the properties and property values at the same time.

The following M-Files variables can be used in this script: StateID, StateTransitionID, AllowStateTransition, NextStateID, ObjVer, DisplayID, Vault, CurrentUserID, CurrentUserSessionInfo, PropertyValues, VaultSharedVariables, SavepointVariables, TransactionCache, MFScriptCancel, GetExtensionObject, MasterTransactionID, CurrentTransactionID, ParentTransactionID. For more information about variables, refer to Available VBScript Variables.

Note: The M-Files API documentation is located at www.m-files.com/api/documentation/latest. For more information about using VBScript in M-Files, see the How do I write VBScript code for M-Files purposes? tutorial.

Evaluation priority

The evaluation priority enables you to define the priority in which parallel state transitions are evaluated on M-Files Server. The priority is sorted from the lowest to the highest number, zero (0) representing the highest priority.

3.2.4. Named Access Control Lists

A named access control list is a list of permissions that can be attached to an object. It is a list consisting of one or more subjects (users, user groups, or pseudo-users) and operations (delete, edit, read, or change permissions) that are either allowed or denied to those particular subjects. Named access control lists make managing permissions in M-Files very quick and effortless.

Tip:

The best practice to define access rights in named access control lists is via user groups instead of individual users.

Making changes to named access control lists in large vaults can be very slow and may therefore sometimes cause lock conflicts. Therefore, it is recommended that changes to named access control lists and, in turn, to object permissions are made during off-peak hours when user access to the vault is limited.

In this chapter

- Creating a New Named Access Control List
- Modifying Named Access Control Lists
- Named Access Control List Permissions

Creating a New Named Access Control List

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, select the **Named Access Control Lists** node.

5. Click **New Named Access Control List...** on the task area.

   ![Named Access Control List Properties dialog](image)

   The **Named Access Control List Properties** dialog is opened.

6. In the **Name** field, enter a descriptive name for the named access control list.

   ![Permission options](image)

   It is recommended to name the named access control list according to the members of the list and the permissions given to them, such as *Visible to company management only* or *Full control for all internal users*.
7. Click **Add...** to add users or user groups to this named access control list.

![Select Users or User Groups dialog](image)

The **Select Users or User Groups** dialog is opened.

8. Select either:

   a. The **Users or user groups** option and select the users or user groups that you wish to add to this named access control list.

      **Tip:**

      The best practice to define access rights in named access control lists is via user groups instead of individual users.

      Making changes to named access control lists in large vaults can be very slow and may therefore sometimes cause lock conflicts. Therefore, it is recommended that changes to named access control lists and, in turn, to object permissions are made during off-peak hours when user access to the vault is limited.

      **Tip:** You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the ⇧ Shift key to select adjacent items on the list.

   or

   b. The **User from metadata** option and use the drop-down menu to select the property containing users or user groups on the basis of which permissions are granted. For more information, see **Pseudo-users**.
9. Click **Add** to add the selected users or user groups to the named access control list and to close the **Select Users or User Groups** dialog.

10. Back in the **Named Access Control List Properties** dialog, select the user or user group whose permissions you want to adjust from the **Users and user groups** list.

11. Select the permission that you want to adjust and check either:

   a. The **Allow** check box if you want to allow the selected permission for the user or user group.

   or

   b. The **Deny** check box if you want to deny the selected permission for the user or user group.

   **Tip:** For optimal performance in large vaults, named access control lists should only be used to allow access rights instead of explicitly denying them.

12. If you want to adjust additional permissions, repeat the steps 10 and 11.

13. Optional: On the **Permissions** tab, you can specify the users who can see this named access control list.

14. Optional: On the **Advanced** tab, you can specify an alias for the named access control list.

   ![Permissions Table]

   For more information, see **Associating the Metadata Definitions**.

   When you have automatic aliases in use and you write a name on the **General** tab, the **Aliases** field on the **Advanced** tab is automatically filled in. The alias has the format `<predefined prefix>.<name>`. Define automatic aliases for your vault in the **configurations editor**.

15. Click **OK**.

The new named access control list containing a set of permissions can now be attached to an object using the permission control on the metadata card.
Modifying Named Access Control Lists

When you modify a named access control list, the modified permissions are applied to either new and existing objects to which the named access control list is already attached or to new objects only, depending on your choice.

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, click Named Access Control Lists.
   - The list of named access control lists in the selected vault is opened in the right-side pane.
5. In the Named Access Control Lists list, right-click the item that you want to edit and select Properties from the context menu.
   - The Named Access Control List Properties dialog is opened.
6. Optional: On the General tab, click Add... if you wish to add a new user or user group to this named access control list.
   a) Select the user or user group that you want to add to the named access control list.
      - Tip: The best practice to define access rights in named access control lists is via user groups instead of individual users.
      - Making changes to named access control lists in large vaults can be very slow and may therefore sometimes cause lock conflicts. Therefore, it is recommended that changes to named access control lists and, in turn, to object permissions are made during off-peak hours when user access to the vault is limited.
      - Tip: You can select more than one item at once by holding down the Ctrl key to select multiple individual items or by holding down the ⌘ Shift key to select adjacent items on the list.
      a) Optional: Select the User from metadata option if you want to add users based on metadata properties to the named access control list. Use the drop-down menu to select the desired property. For more information, see Pseudo-users.
      b) Click Add to add the users or user groups to the named access control list.
7. Select the user or user group whose permissions you wish to adjust from the Users and user groups list.
8. Depending on your choice, select either the Allow or Deny option for the desired operations.
9. Click OK once you are done to close the Named Access Control List Properties dialog.
Optional: If the selected named access control is already used in the permissions of one or more objects, the **Confirm Update** dialog is opened.

a. Click **Change Objects’ Permissions** if you wish to apply your changes to the permissions of existing objects that use the selected named access control list in their permissions.

   Note: Object permissions are updated as an asynchronous background task. Object permissions may be updated when, for example, a named access control list, a user, a user group, or the value of a pseudo-user (such as a project manager) is modified. You may monitor the progress of the task in M-Files Admin in the **Background Tasks** section. For more information, see Monitoring Background Tasks.

or

b. Click **Preserve Objects’ Permissions** if you do not wish to apply your changes to the permissions of existing objects that use the selected named access control list in their permissions.

The changes you have made are to the named access control list are saved and applied, depending on your choice, to new and existing objects that employ the selected named access control list or to new objects only.

**Named Access Control List Permissions**

Access for viewing the selected access control list can be defined on the **Permissions** tab. The selected list can be made invisible to certain users.

Note: The system administrator and all users with full administrative access to the document vault in question always see all the named access control lists.

**Adjusting Permissions**

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, click the appropriate node or subnode of the vault and select the desired item from the list on the right or from the left-side tree view.

5. Right-click the item and select **Properties** from the context menu.

6. Go to the **Permissions** tab.
7. From the **Users and user groups** list, select the user or user group whose permissions you want to adjust.

   ![Users and user groups list](image)

   If the user or user group is not on the list, click **Add...** to add the user or user group to the list.

8. Either:
   a. Check the **Allow** check box to allow the selected user to see this item.
   
   or
   
   b. Check the **Deny** check box to deny the selected user from seeing this item.

9. Optional: If you want to adjust additional permissions, repeat the steps 7 and 8.

10. Click **OK** once you are done.

You have adjusted the view permissions of the selected item for the selected users.

### 3.2.5. Installing and Managing Vault Applications

You can manage vault-specific client and server applications via M-Files Admin. These applications allow you to modify and extend the behavior of your M-Files Desktop and M-Files Server. This way you can choose to give priority to the functions that are the most important for the efficiency of your organization.

The application can be either a **client application** or a **server application**:

- Client applications run on M-Files client computers and affect the behavior of M-Files Desktop.
- Server applications run on the M-Files server computer and affect M-Files server behavior.

   **Note:** Creating applications requires advanced programming skills. Instructions for the programming are available from the M-Files technical staff for a separate fee. For more documentation and sample applications, see the guide to **M-Files UI Extensibility Framework**.

Do the following steps to manage the applications of the selected document vault:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. Still in the left-side tree view, either:
   a. expand **Document Vaults**, and then right-click the desired document vault.
or

b. expand **Ground Link Proxies**, and then right-click the desired Ground Link proxy to **configure the connector over Ground Link**.

4. Select **Applications** from the context menu.

   The **Applications** dialog is opened.

   ![Applications dialog](image)

5. Perform one or more of the following operations, as necessary:

<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do the following steps:</th>
</tr>
</thead>
</table>
   | Install a new application | a. Click the **Install...** button.  
                                b. Browse for the application package and click **Open**.  
                                c. Click **Yes** to restart the document vault. |
   | Uninstall an application    | a. Select the application that you want to uninstall in the applications listing.  
                                          b. Click **Uninstall**.  
                                          c. Click **Yes** to confirm uninstalling the application.  
                                          d. Click **Yes** to restart the document vault. |
   | Export an application       | a. Select the application that you want to export in the applications listing.  
                                          b. Click the **Export...** button.  
                                          c. Select the location and the file name for the export package and click **Save**. |
<table>
<thead>
<tr>
<th>If you want to...</th>
<th>Do the following steps:</th>
</tr>
</thead>
</table>
| Disable an application and uninstall it from all users | a. Select the application that you want to disable in the applications listing.  
b. Click **Disable**.  
c. Click **Yes** to confirm uninstalling the application.  
d. Click **Yes** to restart the document vault.                                                                                                      |
| Enable a disabled application                         | a. Select the disabled application in the application listing.  
b. Click **Enable**.  
c. Click **Yes** to restart the document vault.                                                                                                    |
| See the license status, or install or change the license of an application | a. Select the desired application in the applications listing.  
b. Click the **License** button to open the **Application License Management** dialog and to view the license status and information of the selected application.  
c. If necessary, click the **Install License...** button, browse for the license file, and then click **Open**.                |

6. Click **Close** once you are done.

The changes you have made to the selected document vault should now be effective.

For information on enabling the applications in M-Files Desktop, see Managing Vault Applications in M-Files Desktop.

### 3.2.6. Using the Configurations Editor

The configurations editor in M-Files Admin allows you to define configurations for the following features of the vault:

- advanced vault settings
- custom vault data
- metadata card
- federated authentication
- intelligence services
- external connectors
- vault applications

**Note:** The configurations editor is available in English only. The editor requires Internet Explorer 9 or later to be installed.

**Note:** You must have the **Full control of vault** administrative right to use the configurations editor. For more information, see **Users**.
The configurations in the editor are hierarchical. You can select subsections of a configuration in the gray navigation area, and the scope of the configuration shown in the Configuration or the Advanced tab changes accordingly.

The configurations are defined in the Configuration tab. They may consist of configuration groups and subgroups, and configurations keys and subkeys. Subitems in a group or a key can be expanded or collapsed by clicking the arrow icon (↑ or ↓) next to the configuration key.

The Info tab provides you information about the use and purpose of the currently selected configuration key:
You may also hover your mouse cursor over the information icon ( cabeça ) next to the configuration key to see the same information.

You may comment a setting by selecting a setting and writing your comment in the Comment tab at the bottom of the Configurations pane:

```
This description text is shown on the metadata card for all objects of the "Document" object type.
```

Commenting a setting may be useful if you, for example, want to inform other administrators as to why a certain setting is used.

If there are errors in your configuration, they are shown in the Local or Server tab at the bottom of the Configurations pane.

The Dashboard tab provides you information on the selected configuration category. It may also contain an overview and status of your current configurations in the selected category.

The configurations are stored in JSON format. You may inspect, edit, as well as copy and paste the configurations in plain JSON format in the Advanced tab.

**In this chapter**

- Adding or Modifying Configurations
- Adding Translations for Configuration Values
- Exporting Configurations
- Importing Configurations
- Configuring Advanced Vault Settings
- Configuring Custom Vault Data
- Metadata Card Configuration

**Adding or Modifying Configurations**

Do the following steps to add or modify configurations in the vault of your choice:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Configurations.
5. In the gray navigation area, expand the desired configuration category:

6. In the gray navigation area, locate and select the configuration key that you want to modify by expanding and navigating the configuration tree:

7. In the right pane, either:
   a. Modify the existing value.
      or
   b. Click the relevant **Add** button to add a new configuration value or subvalue.
or

c. Open the **Dashboard** tab and click the relevant **Add** button to add a new configuration.

> Configuration fields highlighted in red are required fields that must have a value.

> If a configuration value requires a reference to a vault metadata structure item, you may enter the first few letters of the name of the item in the configuration field and the editor then suggests appropriate values. As you select an item from the available suggestions, the editor automatically resolves the reference by the alias or ID of the item. You may change the type of reference by clicking the value to the right of the equals sign and pressing the down arrow key:

<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test</td>
<td>[not set]</td>
</tr>
<tr>
<td>Description</td>
<td>[not set]</td>
</tr>
<tr>
<td>Label</td>
<td>[not set]</td>
</tr>
</tbody>
</table>

8. When ready, click the **Save** button.

Your configurations are saved and are now effective.

**Adding Translations for Configuration Values**

You can add translations for certain configuration values.

If you are for example configuring a metadata card description for a certain object type, you may add translations for the text used in the description, so that a vault user with the appropriate language settings can see the description on the metadata card in the correct language.

Do the following steps to add translations for a configuration value:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, select **Configurations**.

5. In the gray navigation area, expand the configuration category that you want to edit and then locate the configuration key for which you want to add translations.

> The keys for which you can add translations can be identified by the cogwheel icon (⚙️) shown in the value field.

6. Click the cogwheel icon (⚙️) on the right side of the configuration value field.

> The **Translate Content** dialog is opened.
7. Use the **Default language** drop-down menu to select the default language.

   - The translation for the default language is used if the requested translation is not available.

8. Use the **Language** drop-down menu to select the language of the value.

9. Enter the value in the text field in the selected value.

10. Click **Add Translation** to add a translation.

11. Repeat the steps 8 and 9.

12. Click **OK** when you are ready.

13. Click **Save** in the configurations editor to save your changes.

**Exporting Configurations**

You can export vault-specific configurations to a file and use the export file to import configurations, for example, to another server computer.
Do the following steps to export configurations:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, select **Configurations**.
5. In the gray navigation area, expand the configurations that you want to export.
6. In the gray navigation area, right-click a setting node and select **Export to File...** from the context menu.

   - The **Save As** dialog is opened.
7. Specify a location and file name, and then click **Save**.

   - A confirmation dialog appears after the export is complete.
8. Click **OK**.

The configurations are exported to the specified location.

### Importing Configurations

You can import vault-specific configurations from a configuration export file. This way you can, for example, import configurations from one M-Files server computer to another.

Do the following steps to import configurations from a configuration export file:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, select **Configurations**.
5. In the gray navigation area, right-click a configuration category and select **Import from File...** from the context menu.

   - The **Open** dialog is opened.
6. Locate and select the configuration export file, and then click **Open**.

   - A confirmation dialog appears after the import is complete.
7. Click **OK**.
8. Right-click the category and select **Save All** from the context menu to save the imported configurations.

The selected configurations are imported to the server computer.
Configuring Advanced Vault Settings

The settings in the Advanced Vault Settings section of the M-Files Admin configurations editor allow you to control how the vault functions. These settings were previously available as Microsoft Windows registry settings. Settings added via the Advanced Vault Settings section are included in vault backups.

In the Advanced Vault Settings section, the system administrator can configure all the functionalities listed in the table below. The table gives an overview of which settings also a user with the Full control of vault administrative rights can adjust.

<table>
<thead>
<tr>
<th>Configuration</th>
<th>Vault administrator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignments</td>
<td>Allowed</td>
</tr>
<tr>
<td>Automatic aliases</td>
<td>Allowed</td>
</tr>
<tr>
<td>Background tasks</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Connections to external databases</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>Connections to external sources</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>Content replication and archiving</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>Database</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>Document comparison</td>
<td>Allowed</td>
</tr>
<tr>
<td>Duplicate detection</td>
<td>Allowed</td>
</tr>
<tr>
<td>Event log</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>External repositories</td>
<td>Not allowed</td>
</tr>
<tr>
<td>File operations</td>
<td>Allowed</td>
</tr>
<tr>
<td>File previews</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Ground Link</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>M-Files add-in settings</td>
<td>Allowed</td>
</tr>
<tr>
<td>Multi-file documents</td>
<td>Allowed</td>
</tr>
<tr>
<td>Notifications</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>PDF conversion</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>Performance</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Real object type hierarchies</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>Reporting and data export</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Scanning and OCR</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Scripting</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Search</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>Security</td>
<td>Not allowed</td>
</tr>
<tr>
<td>Thumbnails</td>
<td>Partly allowed</td>
</tr>
<tr>
<td>Translatable object titles</td>
<td>Allowed</td>
</tr>
<tr>
<td>User groups</td>
<td>Allowed</td>
</tr>
</tbody>
</table>
Complete the following steps to configure vault settings:

1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select Configurations, and then in the gray navigation area, select Advanced Vault Settings.

2. Open the Configuration tab.

   The advanced vault settings are shown.
3. Expand the section that you want to edit, and then edit settings that you want to change.

   See the Info tab for more information about the selected setting.

   Tip: Right-click a settings node to bring up a context menu with additional options, such as Move Up, Move Down, and Make Copy.

4. When you are done, click Save to save the vault settings.

5. Some of the settings require that you take the vault offline and bring it back online for the changes to take effect. For instructions, see Taking a Vault Offline and Bringing a Vault Online.

Example: Excluding Employee Objects from Metadata Searches

Complete the following steps to configure your vault search engine so that Employee objects are not included in metadata searches:
1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select **Configurations**, and then in the gray navigation area, select **Advanced Vault Settings**.

2. On the **Configuration** tab, expand **Search > Excluded Object Types > Metadata-Based Searches**.

3. Click **Add Object Type**.

4. In the **Object Type** field, press the down arrow key ↓ and then select **Employee**.

5. Click **Save** to save your settings.

After saving the setting, **Employee** objects are no longer included in metadata searches in the selected vault.

**Configuring Custom Vault Data**

The **Custom Vault Data** section in the M-Files Admin configurations editor allows you to add and modify custom vault data to affect the vault functionality. The most common type of custom vault data are custom settings of the vault that allow you to add custom functionality to the vault. Sets of custom vault data are registered within specific namespaces.

**Note:** This section of the configurations editor is intended for advanced configuration and customization only, and therefore we recommend that you do not add custom vault data unless you know what you are doing.

**Registering a Namespace**

To begin modifying custom vault data, you must first register a namespace for a new set of custom vault data. Complete the following steps to register a namespace:
1. In M-Files Admin, access the custom vault data section.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select Configurations, and then in the gray navigation area, expand Custom Vault Data.

2. Select Namespace Registry > Configuration.

3. Expand the Namespaces node, click Add Namespace, and expand the newly added namespace node.

4. In the Group field, enter an internal name of your choice for the group that uses the namespace that you are about to register.

5. Use the Storage Type drop-down menu to select the storage type that the namespace uses.

6. In the Namespace field, enter the namespace that you are about to register, and in the Namespace Label field, enter a custom label for the namespace shown in the Custom Vault Data configuration.

7. In the Namespace Description field, enter a description about the purpose of the namespace.

8. Click Save to save your configuration.

Adding Named Values

After you have registered a namespace, you can add named values within that namespace. Complete the following steps to add named values:
1. In M-Files Admin, access the custom vault data section.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select Configurations, and then in the gray navigation area, expand Custom Vault Data.

2. In the gray navigation area, expand Custom Vault Data > Named Values, then expand a group that you have registered in Registering a Namespace, and finally select the namespace of the group.

3. Open the Configuration tab.

4. Click Add Named Value, and expand the newly created named value node.

5. In the Name field, enter the name part of the named value.
   - The name can only contain letters, numbers, underscores, hyphens, and periods.

6. In the Value field, enter the value part of the named value.

7. Repeat the steps from 4 to 6 to add more named value pairs within the given namespace.

8. Click Save to save your configuration.

**Example: Disabling the Sorting of Search Results by Their Relevance**

By default, M-Files sorts search results by their relevance. For more information on how document relevance in relation to the search term is determined, see Search result sorting.

This behavior can be prevented so that search results are sorted by user preference instead. Make the following changes on the M-Files Server computer to prevent search results to be automatically sorted by their relevance:
1. In M-Files Admin, access the custom vault data section.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select Configurations, and then in the gray navigation area, expand Custom Vault Data.

2. Select Namespace Registry > Configuration.

3. Expand the Namespaces node, click Add Namespace, and expand the newly added namespace node.

4. In the Group field, type Search results.

5. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.

6. In the Namespace field, enter the following value: M-Files.Core.Listing.SearchResults

7. In the Namespace Label field, type Search results.

8. In the Namespace Description field, enter for example Settings related to search results.

9. Click Save to save the namespace settings.

10. In the gray navigation area, select Named Values > Search results > Search results > Configuration.

11. Click Add Named Value, and expand the newly created named value node.

12. In the Name field, enter the following value: RememberSearchResultsSortingCriteria

13. In the Value field, enter the following value: true

14. Click Save to save the configuration.

M-Files no longer forces search results to be sorted by their relevance, and therefore users can change the column by which search results are sorted and the user preference is retained in subsequent searches.

Metadata Card Configuration

You can use the configurations editor in M-Files Admin to modify the behavior and appearance of the metadata card. For instructions on how to use the configurations editor, see Using the Configurations Editor.
Metadata card configurations allow you, for instance, to:

- add an additional header, including text and an image, for a certain object type or a class.
- add tooltips and description fields for individual properties.
- create collapsible property groups.
- control the order in which properties and groups are displayed on the metadata card.
- assign default values for properties.
- manage automatically added (mandatory and optional) properties based on, for instance, object type and class.
- hide properties from the metadata card.

Metadata card configurations do not, however, allow you to impose any real restrictions on metadata modifications as the configurations are effective at the user interface level only. You can, for instance, change the workflow state of an object via the Change State command without filling in a required property value imposed by a metadata card configuration rule. In such a case, you should use the workflow state preconditions or postconditions to ensure that certain property values are filled before state transitions are carried out.

Figure 135: Metadata card configurations in the Configurations editor.

Metadata card configurations can be found in the Metadata Card section in the configurations editor.
You can add and remove rules by clicking the Add New button in the Rules section. The rules are hierarchical, meaning that you can add subordinate rules in the Sub-Rules section for further specifying main rules (or any superordinate rules).

The Name field should contain a descriptive name for the rule. The name is only visible in the rule editor.

The Filter section defines the scope of the rule. You may want to, for example, apply a metadata card configuration of objects of a certain class only.

The Behavior section is for specifying what happens when the above-defined condition is met. For instance, when the object class is Customer, you might want to add the property groups Contact information, Subscription and Responsible employee to the metadata card.

The hierarchical rule list is evaluated from top to bottom. The higher a rule is in the list, the earlier it is evaluated. You can change the evaluation order by right-clicking a rule and selecting one of the following options:

- Move Up to move the rule up in the list
- Move to Top to move the rule to the top of the list
- Move Down to move the rule down in the list
- Move to Bottom to move the rule to the bottom of the list

Note: When a rule becomes effective, it always overwrites any overlapping behaviors of rules that have previously come into effect. In other words, a rule always overwrites any overlapping behaviors of other rules higher up in the hierarchical rule list.

For more information on defining the rule condition and behavior, see the article Configuring the Metadata Card (M-Files 2018).

### 3.2.7. Editing Notification Settings in M-Files Admin

M-Files can be requested to send email notifications to end users about object-related actions. Users can create new notification rules via M-Files Desktop (see Editing Notification Settings in M-Files Desktop and "Follow this object" functionality).

Note: In addition to enabling notifications via M-Files Admin, for the end users to receive email notifications, event logging and M-Files Desktop notifications must be enabled.

Do the following steps to enable email notifications on the M-Files Server computer:

1. Open M-Files Admin.

2. In the left-side tree view, right-click the desired connection to M-Files Server and select Notification Settings from the context menu.

The Notification Settings dialog is opened.
3. Check the **Enable notifications** check box.

4. In the **SMTP server** field, enter the address of the SMTP server to be used for sending notification email messages.

   mail.company.com. Ask your network administrator for the email server name used by your company.

5. Optional: Check the **Use encrypted connection (SSL/TLS)** check box if the connection to the SMTP server is encrypted.

   **Note:** If you select this check box, the **SMTP server port** is set to 587 and you cannot change it.
6. In the **SMTP server port** field, enter the port number that the SMTP server is using.

   The default ports are 25 (without SSL), and 587 (with SSL). The most commonly used ports are 25, 465, and 587.

7. Optional: Check the **SMTP server requires authentication** check box if the SMTP server requires the sender to be authenticated.
   a) In the **Account name** field, enter the username of the sender’s email account.
   b) In the **Password** field, enter the password of the sender’s email account.

8. In the **Sender's e-mail address** field, enter the email address for the notification sender.

   /notifications@company.com.

9. In the **Sender’s display name** field, enter the name for the notification sender to be displayed in the **From** field of notification messages.

   /Notifications.

10. In the **Digest message** field, specify the time when the daily digest messages are sent.

   M-Files users can choose to receive their notifications as individual messages or as a daily digest message. For more information, see Editing Notification Settings in M-Files Desktop.

11. Click **OK** to save your changes and to close the **Notification Settings** dialog.

Notifications are now enabled on the M-Files server.

- Users must enable notifications in M-Files Desktop to be able to receive notifications. For instructions, see Editing Notification Settings in M-Files Desktop.
- The administrator and users can also create notification rules on the basis of which notification messages are sent. See Editing Notification Settings in M-Files Desktop for more information.
- You can customize your notification messages. For instructions, see Personalizing Notification Messages.

**In this chapter**

- Personalizing Notification Messages
- Setting Up Push Notifications for the M-Files Mobile Apps

**Personalizing Notification Messages**

M-Files uses customizable templates for email notifications, which you can modify to match the requirements of your organization. You can, for instance, change the information provided along with notifications about new or modified objects, assignments, and so on.

Follow the instructions in this section to access and edit the notification templates in M-Files Admin.

**Accessing the Notification Template Settings**

Do the following steps to access the notification template settings:
1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select **Configurations**, and then in the gray navigation area, select **Advanced Vault Settings**.

2. Open the **Configuration** tab.

   - The advanced vault settings are shown.
3. Expand **Notifications** > **Notification Templates**.

The list of available notification templates in this vault is displayed in the configurations editor. The templates are divided under two sections, **Email Templates** and **Push Notification Templates**. The latter are used for the M-Files mobile applications.

If the listing does not include at least a template called **Default**, try to restart the vault and M-Files Admin. Taking a vault offline should always be done in a controlled manner and the vault users should be notified beforehand.

**Editing or Adding a Notification Template**

To edit an existing notification template or to add a new one:

1. Under **Advanced Vault Settings** > **Notifications** > **Notification Templates**, in the configurations editor listing area, either:
   a. Expand an existing template rule that you would like to edit.
2. In **Rule**, select the notification rule to which you want this template to apply.

3. Expand the **Template Sections** node.

4. Either:

   a. Expand an existing section node to edit a previously added section.
   
   or

   b. Click **Add Section** to add a new section, and expand the newly created node.

   For any sections that your template does not include, the M-Files server uses the corresponding sections of the special **Default** template. If the **Default** template cannot be found, M-Files server uses the corresponding sections of a fallback template located in the installation directory.

5. In **Template Section**, select the section that you would like to modify.

   > Tip: Hovering the mouse cursor on top of the section names in the drop-down menu displays a short description for each section.

6. Click the cogwheel icon (⚙️) in the value field of the **Template Entry** setting.

The **Placeholder Editor** dialog is opened.
7. To the text box, enter the content of the section.

Use the **Insert Placeholder** button to add a dynamically updated reference in your content. Clicking the button adds a set of curly brackets in the text box. You can either start typing the name of the placeholder or press the down arrow key to bring up a list of available placeholders, such as the title or class of the object that triggered the notification. Some placeholders, however, only work with specific sections.

8. Once you are done editing the template content, click **OK** to close the **Placeholder Editor** dialog.

9. Optional: Repeat the steps from 4 to 8 to edit or add as many sections as needed.

10. Once you are done with your changes, click **Save**.

**Placeholders for Notification Templates**

In addition to the object properties, such as the title or the class of the object, you can use a set of special placeholders in your notifications. These placeholders are described in the table below.

<table>
<thead>
<tr>
<th>Placeholder</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>All referred objects()</td>
<td>All the referred objects in the properties of the object.</td>
</tr>
<tr>
<td>Caused by()</td>
<td>The name of the user who caused the event.</td>
</tr>
<tr>
<td>Caused by account()</td>
<td>The account name for the user who caused the event.</td>
</tr>
<tr>
<td>FileName()</td>
<td>The name of the file.</td>
</tr>
<tr>
<td>ID()</td>
<td>The (external) ID of the object.</td>
</tr>
<tr>
<td>InternalID()</td>
<td>The (internal) ID of the object. The internal ID is always unique for each</td>
</tr>
<tr>
<td></td>
<td>object of a single object type and within a single vault.</td>
</tr>
<tr>
<td>NameAndLinks()</td>
<td>A plain text formatted text fragment containing URLs to the object for M-</td>
</tr>
<tr>
<td></td>
<td>Files Desktop, M-Files Web, and M-Files Mobile.</td>
</tr>
<tr>
<td>NameAndLinksHtml()</td>
<td>An HTML-formatted hyperlink containing URLs to the object for M-Files</td>
</tr>
<tr>
<td></td>
<td>Desktop, M-Files Web, and M-Files Mobile.</td>
</tr>
<tr>
<td>Notification rule name()</td>
<td>The name of the notification rule that caused the event.</td>
</tr>
<tr>
<td>ObjTitle()</td>
<td>The name or title of the object.</td>
</tr>
<tr>
<td>ObjType()</td>
<td>The type of the object.</td>
</tr>
<tr>
<td>OldProperty( Undefined )</td>
<td>The old value of the specified property of the object. <em>Undefined</em> is</td>
</tr>
<tr>
<td></td>
<td>replaced with the property the old value of which you want this</td>
</tr>
<tr>
<td></td>
<td>placeholder to display in the notification.</td>
</tr>
<tr>
<td></td>
<td>After selecting this placeholder, open the <strong>References</strong> tab and select</td>
</tr>
<tr>
<td></td>
<td>the desired value via drop-down menu in the <strong>Item</strong> tab.</td>
</tr>
<tr>
<td>Rolled back to version()</td>
<td>The version that the object was rolled back to.</td>
</tr>
<tr>
<td>Timestamp()</td>
<td>The time when the event occurred.</td>
</tr>
<tr>
<td>URL()</td>
<td>An M-Files URL that shows the latest version of the object in question.</td>
</tr>
<tr>
<td>UrlToLatestMobile()</td>
<td>An M-Files Mobile URL that shows the latest version of the object in</td>
</tr>
<tr>
<td></td>
<td>question.</td>
</tr>
<tr>
<td>Placeholder</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>UrlToLatestWeb()</td>
<td>An M-Files Web URL that shows the specific version of the object in question.</td>
</tr>
<tr>
<td>UrlToVersion()</td>
<td>An M-Files URL that shows the specific version of the object in question.</td>
</tr>
<tr>
<td>UrlToVersionMobile()</td>
<td>An M-Files Mobile URL that shows the specific version of the object in question.</td>
</tr>
<tr>
<td>UrlToVersionWeb()</td>
<td>An M-Files Web URL that shows the latest version of the object in question.</td>
</tr>
<tr>
<td>UserCausedState( Undefined )</td>
<td>The user who moved the object into a specific state. <em>Undefined</em> is replaced with the target state. After selecting this placeholder, open the <strong>References</strong> tab and select the desired value via drop-down menu in the <strong>Item</strong> column.</td>
</tr>
<tr>
<td>VaultGuid()</td>
<td>The unique identifier (GUID) of the vault.</td>
</tr>
<tr>
<td>VaultName()</td>
<td>The name of the document vault.</td>
</tr>
<tr>
<td>Version()</td>
<td>The version of the object.</td>
</tr>
</tbody>
</table>

### Setting Up Push Notifications for the M-Files Mobile Apps

Push notifications allow sending notifications from M-Files Server to iOS and Android devices that have the M-Files mobile app installed. Push notifications are sent for the same events as email notifications except for digest messages. Once they are enabled, you will receive a push notification, for instance, when a new assignment is created for you. You can also create personalized notification rules with M-Files Desktop (see **Editing Notification Settings in M-Files Desktop**).

To enable push notifications:

- in an on-premises environment or in your own cloud environment, follow the instructions provided in the sections Creating a notification hub in Azure, Setting up an Azure notification hub for push notifications, and finally Enabling push notifications in M-Files vaults.
- in an M-Files Cloud Vault, simply follow the steps from 9 to 15 under Enabling push notifications in M-Files vaults. No other changes are needed.
- Vault users should enable push notifications on their iOS or Android devices. They will receive push notifications when they are logged in to a vault that has push notifications enabled. Note that vault users do not have to keep the M-Files application running to receive push notifications from a vault, as long as they are logged in to the vault ensures that they can receive push notifications.

Before you begin, note that notifications need to be enabled on the M-Files server (see **Editing Notification Settings in M-Files Admin**).

### Creating a notification hub in Azure

M-Files push notifications use Azure notification hubs for delivering the notifications (see Microsoft Azure Notification Hubs). You therefore need to have a valid Microsoft Azure subscription before moving forward. Visit [https://azure.microsoft.com](https://azure.microsoft.com) to create a subscription if you do not yet have one.

Do the following steps to create a new notification hub in Azure:

1. Sign in to Azure Portal.
2. Select **Create a resource > Mobile > Notification Hub**.

3. In the **Notification Hub** field, enter a unique name.

4. In the **Create a new namespace** field, enter a namespace name.
   
   - If you do not yet have a service bus namespace, you can use the default one. It is automatically created based on the hub name, provided that the namespace name is available.
   
   - If you already have a namespace that you want to create the hub in, click the **Select existing** link and then select **Create**.

5. Select your **Location**, **Resource Group** (if you have one already), and **Subscription**.

6. Select a suitable price tier (for details, see **Notification Hubs pricing**).

**Setting up an Azure notification hub for push notifications**

After you have created an Azure notification hub, it needs to be configured for different mobile platforms. You can find the settings for the available notification services by doing these steps:

1. Sign in to **Azure Portal**.

2. Select **All services**.

3. Under **Mobile**, select **Notification Hubs**.

4. From the list of notification hubs, select the hub that was created according to the instructions in Creating a notification hub in Azure.

5. Under **Notifications Settings**, do one of the following, or both:
   
   a. Enter the iOS configuration under **Apple (APNS)**. You can request the configuration settings from our customer support at support@m-files.com.
or

b. Enter the Android configuration under **Google (GCM)**. You can request the configuration settings from our customer support at support@m-files.com.

**Enabling push notifications in M-Files vaults**

After you have created a notification hub and set it up for push notifications, you need to enable push notifications for the M-Files vaults in which you want them to be used, as well as to set up the connection between M-Files and the Azure notification hub. You can store the connection settings to the Windows registry of the M-Files server computer or set them separately for each vault via M-Files Admin, or both. The server-level settings simply do not apply to any vaults for which the connection settings have been defined via M-Files Admin.

First, you need to locate the connection details in your notification hub settings:

1. Sign in to **Azure Portal**.
2. Select **All services**.
3. Under **Mobile**, select **Notification Hubs**.
4. From the list of notification hubs, select the hub that was created according to the instructions in **Creating a notification hub in Azure**.

If you want to store the connection details to the Windows registry of the server computer, do the following steps:

5. Optional: Under the notification hub settings, select **Properties**.
6. Optional: Copy the value of the **Name** field and enter it as the value of the following Windows registry key on the M-Files server computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server\MFServer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>AzureNotificationHubName</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_SZ</td>
</tr>
<tr>
<td>Description</td>
<td>The name of the Azure notification hub to use for delivering the notifications.</td>
</tr>
<tr>
<td>Value</td>
<td>&lt;the notification hub name&gt;</td>
</tr>
</tbody>
</table>

7. Optional: Under the notification hub settings, select **Access Policies**.
8. Optional: Copy the value of the **DefaultFullSharedAccessSignature** field and enter it as the value of the following Windows registry key on the M-Files server computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server\MFServer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>AzureNotificationHubConnectionString</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_SZ</td>
</tr>
<tr>
<td>Description</td>
<td>The connection string for the Azure notification hub.</td>
</tr>
</tbody>
</table>
To enable push notifications in a vault:

9. Open M-Files Admin.

10. In the left-side tree view, expand the desired connection to M-Files Server.

11. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

12. Select Configurations.

13. In the task area, select the Advanced Vault Settings node.


15. Set the value of the Enabled setting to Yes.

If the connection details have not been stored to the Windows registry of the server computer, or if you want to vault-specifically override the server-level settings, do the following:

16. Enter the notification hub name and the connection string as the values of the Notification Hub Name and Connection String settings, respectively.

   To get the value for Notification Hub Name, open your notification hub settings (see steps from 1 to 4), select Properties and enter the Name value to your configuration.

   To get the value for Connection String, open your notification hub settings (see steps from 1 to 4), select Access Policies and enter the DefaultFullSharedAccessSignature value to your configuration.

17. Click Save to save your changes once you are done.

Finalize the process by doing either step 18 or steps 19 and 20, depending on where the connection settings are stored. Note that restarting the vault or the server should always be done in a controlled manner and users should be notified beforehand so that no work is lost.

18. If you saved the connection details to the vault (see step 16), restart the vault.

   In this case, you can skip steps 19 and 20.

19. If the connection settings are stored on the server computer (see steps from 5 to 8), restart the MFServer service as instructed in step 20.

20. Use Windows Task Manager to restart the MFServer service:
   a) Right-click the taskbar and select Task Manager from the context menu.

      The Task Manager window is opened.

   b) Open the Services tab.
   c) Right-click the MFServer service and select Restart from the context menu.

Your vault is now set up to send push notifications to vault users. Repeat the process for as many vaults as needed.
3.2.8. Setting Up Web and Mobile Access to M-Files

M-Files Web provides a way of accessing your document vaults via a web browser or a mobile device.

**M-Files Web**

M-Files Web has been implemented with standard languages, such as HTML, DHTML, JavaScript, and CSS. This makes it possible to use M-Files with various browsers, among them Chrome, Internet Explorer, Mozilla Firefox, Opera, and Safari. See the System Requirements and Technical Details for details.

The M-Files Web interface is managed with the M-Files server computer. In a normal implementation, M-Files Web is set to listen on TCP port 80 for the HTTP protocol, but there are other possibilities as well. For more information, contact M-Files customer support.

**M-Files Mobile**

In order for users to be able to access your organization's on-premises vaults via a mobile device, M-Files Web must be enabled and configured, as M-Files Web acts as the connection point for the mobile apps by providing the M-Files Web Service REST API services. In cloud-based deployments, you can always use mobile apps without any special configuration.

**Tip:** Administrators can create links for facilitating the end users' vault connection process for mobile devices. The end user only has to open the link with their mobile device and input their username and password. After a successful connection, the vault connection information is saved to the device. For more details and examples, see the document M-Files URL Properties.

**Enabling push notifications for the M-Files mobile apps**

You can enable push notifications for M-Files Mobile by following the instructions in Setting Up Push Notifications for the M-Files Mobile Apps.

**Federated authentication and pre-shared keys**

For additional security, M-Files can be configured to require a pre-shared key in addition to the user's username and password. This provides an additional level of security without requiring users to open a VPN connection for accessing M-Files. For more information, see Accessing M-Files Vaults without VPN. If your organization is using federated identity management, see Using Federated Authentication with M-Files.

**In this chapter**

- Enabling the Necessary Internet Information Services (IIS) Components
- Enabling Web and Mobile Access
- M-Files Web Publication Settings
- Document-Specific Publishing via a Web Link

**Enabling the Necessary Internet Information Services (IIS) Components**

The following Internet Information Services (IIS) components need to be enabled on the M-Files Server computer before web and mobile access can be enabled:

- Common HTTP Features
- ASP.NET features
- Dynamic Content Compression
1. In Microsoft Windows open Control Panel and then open Programs and Features.

   The Programs and Features dialog is opened.

2. On the task pane on the left, click Turn Windows features on or off.

   The Windows Features dialog is opened.


4. Navigate to Internet Information Services > World Wide Web Services > Application Development Features and enable the ASP.NET features.

5. Navigate to Internet Information Services > World Wide Web Services > Performance Features and enable the Dynamic Content Compression feature.


7. Navigate to Internet Information Services > Web Management Tools > IIS 6 Management Compatibility and enable the features IIS Metabase and IIS 6 configuration compatibility and IIS 6 Management Console.

8. Navigate to Internet Information Services > World Wide Web Services > Common HTTP Features and enable the Static Content feature.

9. Under Internet Information Services, enable the Internet Information Services Hostable Web Core feature.

10. Click OK to close the Windows Features dialog.

You should now have the necessary components installed and you are ready to enable web and mobile access on the selected server computer.

**Enabling Web and Mobile Access**

M-Files Web uses Microsoft Internet Information Services and .NET framework version 4.0 (or higher). These applications must be installed on the computer running M-Files Server before M-Files Web can be enabled. For instructions on enabling Microsoft Internet Information Services, see Enabling the Necessary Internet Information Services (IIS) Components.

**Note:** If you want to enable web and mobile access without having to use a virtual private network (VPN) for connections outside the private network of your organization, see Accessing M-Files Vaults without VPN for further instructions.

Complete the following steps to enable web and mobile access:

1. Open M-Files Admin on the server computer on which you intend to host web and mobile access.

2. In the left-side tree view, expand the desired connection to M-Files Server.
3. Still in the left-side tree view, right-click the connection and select **Configure Web and Mobile Access...** from the context menu.

4. Select one of the following options:

<table>
<thead>
<tr>
<th>Select the option...</th>
<th>If you want to...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Modify an existing web site</strong></td>
<td>Modify an existing M-Files Web site. Select the existing site using the <strong>Web site</strong> drop-down menu.</td>
</tr>
<tr>
<td><strong>Create a new web site</strong></td>
<td>Create a new M-Files Web site within IIS. Enter the name of the site in the <strong>Name</strong> field and the TCP for connecting to the site in the <strong>TCP port</strong> field. The TCP port is 80 by default as it is the most common TCP port for web servers. If you use any other port, you need to indicate the port in the URL (http://&lt;domain name&gt;:&lt;port&gt;) to access the site.</td>
</tr>
<tr>
<td><strong>Create a new virtual directory</strong></td>
<td>Create a new M-Files Web site under a virtual directory within an existing web site. Use the <strong>Web site</strong> drop-down menu to select the preferred existing web site and, in the <strong>Name</strong> field, enter the name of the virtual folder. The URL for accessing the site is thus http://&lt;domain name&gt;/&lt;virtual folder name&gt;.</td>
</tr>
</tbody>
</table>

5. Click **OK** to close the **Configure Web and Mobile Access** dialog.
You should now have web and mobile access to the vaults under the selected connection. You can test to see if your site is online by typing the URL of your site into your web browser.

**M-Files Web Publication Settings**

When documents are published online for customers or other interest groups, it is usually a good idea to hide some of the object properties. For example, if the user has read-only access, the functions for editing need not be displayed at all. With the publication settings, the users can be granted suitable and sufficient functions that facilitate and simplify accessing and processing the published information.

**Note:** You can use the *Get Hyperlink* function in the task area when you want to send a link to the document from the M-Files Web interface.

**Site for definition of the publication settings (site and vault specific)**

You can specify different publication settings specific to the site and vault by using a separate configuration site.

Log in to the configuration page by using your company’s M-Files Web URL (for instance “http://www.publications.company.com”) and by adding `/configuration.aspx` at the end of the address. For example, “http://www.publications.company.com/configuration.aspx”. If you have already logged in to M-Files Web in the browser, M-Files does not ask you to log in again.

**Note:** You must have system administrator's rights to be able to edit the publication settings

**Site-specific settings**

From the site-specific settings, you can make selections that apply to the configuration site and all vaults of the site.

![Figure 136: The publication settings configuration site.](image)

**Restrict access to configuration pages**
You can specify the configuration site to be accessible for a certain IP address range only. Access to the configuration site is usually allowed only for connections from inside the company.

**Display options**

*Page title:* You can freely name the page of the web site you are offering. The default title is *M-Files Web.*

*Language:* By default, M-Files uses *Automatic* as the language selection. This means that the M-Files Web language is determined by the language of the user's browser settings. If the language in the browser settings is not supported by M-Files, the language installed on the M-Files server will be used.

Alternatively, you can set a *Specific language* to be the M-Files Web language. For example, if your company's instructions refer to functions that are in English or the users work in different languages, you can specify English as the M-Files Web language. You can choose from all languages supported by M-Files.

**Note:**

This applies to the user interface language only. For the full M-Files Web experience to be in the language defined by a specific user, four prerequisites need to be met:

- The vault has been localized to the target language.
- The vault language has been set for the vault user.
- The language setting has been set to *Automatic* as described further above.
- The language preference settings of the user's browser have been set to the desired language. For more information, see this W3C article.

**Windows SSO**

With Windows authentication enabled, M-Files Web can automatically use the user's Windows credentials for login. The administrator can configure the single sign-on (SSO) setting so that the login credentials are no longer required when users navigate to M-Files Web.

The automatic authentication is disabled by default, but can be enabled by setting the single sign-on value to *Use automatically.* Alternatively, the choice of using single sign-on can be displayed on the login page by selecting *Show on login page.*

**Force M-Files User Login**

Select this setting if you do not want to display the Windows login option to users. Then the user does not have to consider which login option is appropriate and M-Files suggests logging in as an M-Files user. For data security reasons, it may be advisable to disable Windows login in some cases.

**Note:** This does not prevent logging in to the configuration site with your Windows user account.

**Automatic Login**

Select *Automatic Login* and enter the authentication information if you do not wish to require the users to enter their user ID for M-Files Web. This means that any user can access the site's vaults if authorized by the user ID.

*Authentication (username, password and domain):* If automatic login is enabled, this is the authentication information that M-Files uses for the automatic login. If you want M-Files to offer a specific ID for the user by default, save the default ID in the authentication information and disable automatic login. The user is still able to use other IDs, possibly granting more extensive web-based access.
**Vault**: You can also specify the vault to which the user is to be connected to. If the vault is not specified, the users can see all the vaults accessible with the credentials.

**Vault-specific settings**

In the vault-specific settings you can specify, for example:

- whether the vault is to be available for use via M-Files Web.
- the vault-specific default view.
- the configuration of the vault user interface.

**Allow access to this vault**

Select this if you want the vault to be accessible via M-Files Web.

**Note**: In order to use a vault, the user must always have permissions for that vault.

**Default view**

You can specify which view is to be opened by default. The home view is opened by default.

**Layout**

You can choose the layout elements to be displayed – or hidden – in the vault. You can, for instance, hide the task area or choose to display the listing area only.

**Java applet**

If you need to frequently edit documents in M-Files Web with Internet Explorer 11 and the Integration with Office for the web is not an option for you, enable the M-Files Web Java applet in your vaults. For instructions, see Enabling the Java Applet for M-Files Web.

**Microsoft Office for the web editor** (cloud vaults only)

If you are using M-Files Cloud Vault, enable this option to edit documents in M-Files Web using Microsoft Office for the web.

**Note**: To set up the Microsoft Office for the web editor, you first need to request our customer support (support@m-files.com) to enable the Microsoft Office for the web tools for your vault or vaults.

**Prevent navigation outside default view**

You can prevent navigation beyond the default view by choosing Prevent navigation outside default view. In this case, navigation is not possible, even if the breadcrumb is used.

**Default search criteria and settings**

You can select whether the latest search criteria and settings selected by users are to be kept or if you would prefer to use a specific criterion and setting. The same options as in M-Files Desktop are available.

**Navigation within the vault**

You can display or hide the top menu (New, Operations, and Settings) and/or breadcrumb.
**Note:** When M-Files Web is displayed in the “Listing pane only” mode, object metadata and search functions are hidden from the users. This allows the users to only read and edit objects displayed in the listing pane, according to their permissions.

**Vault controls**

These settings allow you to control which functions are available for the users of the vault.

- **Save view settings.** If several users have the same user ID (for example, during automatic login), it is recommended to prevent saving of the column settings.

- **Workflow shortcut in properties pane.**

- **Checkout prompt.** If the M-Files Web users are granted read-only access and no edit permission, displaying the Check Out dialog is not necessary.

- **Hidden properties.** Some properties may be hidden from external users. In these cases, the information (hidden) is displayed in the properties pane or on the metadata card. It is recommended to hide this (hidden) information.

- **State transition prompt.**

- **Save search terms.**

- **Context menu.**

- **Advanced Search.**

- **Search in right pane.** With this option enabled, the search functions can be placed into the right pane.

**Task area operations**

The options in the task area settings allow you to decide which links are to be displayed in the task pane.

**Note:** If you hide the New commands, users cannot create new objects. Additionally, if the View and Modify commands are hidden, they are not accessible via the context menu either.

**Example: Modifying the Appearance of M-Files Web**

1. Open the M-Files Web configuration page by entering the URL `http://<Your M-Files Web domain>/configuration.aspx` into your web browser and then enter your credentials if you are not already logged in.

   - If you are already logged in, you will be redirected directly to the configuration page. Otherwise the configuration page will be opened after the login screen.

2. From the left-side tree view, under **Vault-specific settings**, expand the additional settings of the vault that you want to modify by clicking the arrow before the vault icon.

3. By clicking the folder beneath the selected vault in the left-side tree view, select the category that you want to modify:

   a. Select the **Controls** folder, if you want to show or hide various M-Files Web user interface controls.

   or

   b. Select the **Task area** folder, if you want to show or hide various elements on the M-Files Web task area.
4. Select the **Show** or **Allow** radio button for the elements that you want to enable.

   If you want to show the **Log Out** button on the task area, go to the **Task area** settings, and select **Show** for the **Log Out** option.

5. Select the **Hide** or **Disallow** radio button for the elements that you want to disable.

**Document-Specific Publishing via a Web Link**

You can use M-Files for sharing documents with interested parties through direct web links. This feature makes it possible to, for example, provide a company web site with a direct link to a price list in M-Files. The link can be made to always refer to the latest version of the document, to be able to provide up-to-date information at all times. The link works in the same way as any ordinary web URL.

Normally, M-Files Web always requires a login name and a password to be entered. However, if the system is used for publishing, it may often be necessary to allow users to view documents without entering any credentials. To enable this, M-Files can be set to use a predetermined login account with, for example, read permissions for certain documents.

**Enabling document-specific publishing via a web link**

Do the following steps to enable document-specific publishing via a web link:

1. Create a login account, such as **Publishing**, on the server. Select **M-Files authentication** as the authentication method, and enter a password and other necessary data.
   
   For instructions, see **Creating a Login Account for Publishing**.

2. Assign the user to the desired document vault and define the user as an external user.

   For instructions, see **Assigning the Login Account to the Desired Vault**.

3. Provide the user with read permissions for published documents.

   For instructions, see **Providing the User with Read Permissions to Published Documents**.

4. Enable the login account to log in automatically.

   For instructions, see **Enabling the Login Account to Log In Automatically**.

5. After this you can create direct web links to the vault.

   For instructions, see **Creating Direct Web Links**.

**Creating a Login Account for Publishing**

To allow users to view documents without entering credentials, you must first create a login account that will be used to automatically log in to a specific vault.

1. Open M-Files Admin on the M-Files Server computer used for publishing content.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, select **Login Accounts**, and then click **New Login Account**... on the task area.

   The **Login Account Properties** dialog is opened.

4. In the **Username** field, enter a suitable username for the login account, such as **Publishing**.
5. Select **M-Files authentication** as the authentication method, and enter a password of your choice in the **Password** and **Confirm password** fields.

6. Optional: Enter personal information of the login account in the **Full name** and **E-mail** fields.

7. Using the **License type** drop-down menu, select a license type for the login account.

8. Click **OK** to finish creating the login account.

The newly created login account is added to the **Login Accounts** list.

**Assigning the Login Account to the Desired Vault**

Next, the login account needs to be assigned to the vault that contains the published documents.

1. Open M-Files Admin on the M-Files Server computer used for publishing content.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, then expand the desired vault and finally select **Users**.

4. Click **New User...** on the task area.

   ✓ The **User Properties** dialog is opened.

5. Using the **Login account** drop-down menu, select the login account that you previously created.

6. Check the **External user** check box.

7. Optional: Check the **User cannot create documents or other objects** check box, if you wish to prevent users from creating documents or other objects with this user account.

8. Optional: Check the **User cannot create or modify** check box, if you wish to prevent users from creating or modifying traditional folders with this user account.

9. Click **OK** to finish creating the user.

The user is added to the **Users** list.

**Providing the User with Read Permissions to Published Documents**

The user needs to be provided with appropriate permissions to access published documents.

1. Open M-Files Admin on the M-Files Server computer used for publishing content.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. In the left-side tree view, select **Named Access Control Lists** under the selected vault.

5. Either:

   a. Click **New Named Access Control List...** to define a new named access control list containing read permissions for the newly created user account.
or

b. Double-click an existing named access control list on the Named Access Control Lists list to define read permissions for the newly created user account. The Named Access Control List Properties dialog is opened.

6. If you are creating a new named access control list, enter a suitable name for it in the Name field.

7. Click Add... to add the newly created user to the Users and user groups list. The Select Users or User Groups dialog is opened.

8. Select the newly created user from the Users or user groups list and click Add to add the user to the named access control list and to close the Select Users or User Groups dialog.

9. Back in the Named Access Control List Properties dialog, select the newly added user and provide the user the following permissions using the check boxes below in the dialog:

<table>
<thead>
<tr>
<th>Permission</th>
<th>Allow / Deny</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Permissions</td>
<td>Deny</td>
</tr>
<tr>
<td>Delete</td>
<td>Deny</td>
</tr>
<tr>
<td>Edit</td>
<td>Deny</td>
</tr>
<tr>
<td>Read</td>
<td>Allow</td>
</tr>
</tbody>
</table>

10. Optional: If your named access control list already has all permissions set to Allow for the All internal users user group, you can skip these steps. Do the following steps to allow all permissions for All internal users:
   a) Click Add... to add the All internal users user group to the Users and user groups list. The Select Users or User Groups dialog is opened.
   b) Select All internal users from the Users or user groups list and click Add.
   c) Highlight All internal users on the Users and user groups and check the Allow check box next to the All option on the Permissions list.

11. Click OK to close the Named Access Control List Properties dialog.

12. Assign the named access control list you just created or modified to all the public documents intended to be accessed without credentials.

If you have created a new named access control list, it is added to the Named Access Control Lists list. Otherwise your changes are saved to the existing named access control list that you have modified.

Enabling the Login Account to Log In Automatically

To make it possible to view published documents without logging in, M-Files must be set to log in automatically through M-Files Web. This way, published documents can be viewed without entering a username and password.

Before you begin, make sure M-Files Web is configured properly. For more information, refer to Setting Up Web and Mobile Access to M-Files. To ensure sufficient permissions, an external connector license is required.
1. On the M-Files Server computer, use Registry Editor to create the following registry key, where
\<version\> is the M-Files version number (for example 11.1.4310.92) and \<web site ID\> is a
unique ID assigned to the M-Files Web site by Internet Information Services (IIS):

HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server\MFWA\Sites \<web site ID>\

- If there is only one web site, the site ID is usually 1.
- If the M-Files Web site is running in the virtual directory of the web site, add a colon
and the name of the virtual directory after the site ID. For example, if the application is
accommodated in the M-Files Web virtual directory of this single web site, the web site ID is
1:MFWA.
- The IIS server software in Windows 2003 displays the ID as one column.

2. Specify the registry key values to be used for automatic login. The table below lists the values available
for specification.

<table>
<thead>
<tr>
<th>Value</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Domain</td>
<td>REG_SZ</td>
<td>If the authentication method in use is Windows authentication, specify the domain in this value.</td>
</tr>
<tr>
<td>Password</td>
<td>REG_SZ</td>
<td>The login password.</td>
</tr>
<tr>
<td>UserName</td>
<td>REG_SZ</td>
<td>The login account name, for example &quot;publishing&quot;.</td>
</tr>
<tr>
<td>Vault</td>
<td>REG_SZ</td>
<td>The document vault ID. The value can be for instance {A8DCB561-913F-4318-A276-E7E171EAFBE6}. The value can be found in the Document Vault Properties window of M-Files Admin.</td>
</tr>
<tr>
<td>WindowsUser</td>
<td>REG_DWORD</td>
<td>Specifies the authentication method. False means M-Files authentication, True means Windows authentication.</td>
</tr>
</tbody>
</table>

3. Close Registry Editor.

The selected login account can now be used to automatically log in to M-Files Web and the account can be
used for accessing published documents without entering a username and password.

Creating Direct Web Links

Once automatic login is enabled, you can create direct web links between, for example, the company web
site and document files. The opening page, openfile.aspx, can be assigned the following parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>objtype</td>
<td>Object type ID of the object to which the file to be opened belongs. This parameter is required. You can see the list of object type IDs by completing the first four steps of the Creating a New Object Type task.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>docid</td>
<td>ID of the document containing the file to be opened. This parameter is required.</td>
</tr>
<tr>
<td>docver</td>
<td>Version of the document containing the file to be opened. This parameter is not required. If this parameter is not used, the link always refers to the latest version of the document.</td>
</tr>
<tr>
<td>fileid</td>
<td>ID of the file to be opened. This parameter is not required unless the document containing the file is a multi-file document.</td>
</tr>
<tr>
<td>filever</td>
<td>File version.</td>
</tr>
<tr>
<td>showopendialog</td>
<td>This parameter specifies whether or not the web browser displays an opening dialog. If the value assigned to this parameter is 0, the dialog is not displayed.</td>
</tr>
</tbody>
</table>

As described above, you can provide your web site with a link that refers directly to a document. Below are examples of such web links. Replace `<server>` with the web address of your own server.

http://<server>/openfile.aspx?objtype=0&docid=71


http://<server>/openfile.aspx?objtype=0&docid=71&docver=7&fileid=71

http://<server>/openfile.aspx?objtype=0&docid=71&showopendialog=0

### 3.2.9. Reporting and Data Export

Saving and protecting data is important, but the saved data must also be available for analysis. In addition to being able to save many types of data in M-Files, you can use it to create various reports.

The reports can be used to gather information on, for example, sales processes, completed projects, the size of the proposal base, volumes of orders, participation in training, and sales by each salesperson itemized by customer. Graphical reports make the data analysis quick and easy. In real-world operation, reports can be generated from any metadata.
Updating the license code for reporting

The reporting module is an M-Files add-on product available for a separate fee. It can be activated with an accompanying license code. The reporting module enables data export from M-Files to create reports and display them in the M-Files user interface.

For you to activate the reporting module, the license code must be activated on your system. The license is provided on a subscription basis. Activate or update the license code in M-Files Admin (for more information, refer to Managing Server Licenses).

To find out how M-Files can support your business with M-Files reports, please contact us at sales@m-files.com.

Report object type and class

To display the reports, M-Files has a built-in object type and class for reports. By default, the Report object type is hidden from the users. Provide the required access rights for the Report object type so that actual reports can be created in the client software.

In this chapter

- Creating a New Data Set
- Specifying the Report Access Identity
- Creation of Reports and the Required Software
• Creating a Report Object for a Report
• Exporting a Report

Creating a New Data Set

*M-Files Reporting Data Services* enable data exporting from M-Files to external databases (SQL Server). The administrator can specify manually which data will be exported, or export data on a scheduled basis from M-Files for reporting or other purposes. The *M-Files Reporting Data Services* functionality is installed in conjunction with M-Files Server. Once you have exported a data set, you can use it to generate a report.

Start by specifying a data set that you want to export for reporting. Do the following steps to create a new data set:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, select **Reporting and Data Export** and then click **New Data Set...** on the task area.

- The **Data Set Properties** dialog is opened.
5. In the **Name** field, enter a name for the new data set.

6. In the **Data to export** section, click **Add Objects...** to select the objects to be exported.

   ![Add Objects to Data Set dialog]

   The **Add Objects to Data Set** dialog is opened.

7. Use the **Objects to export** drop-down menu to select the objects to be exported on the basis of the object type.

   ![Target database dialog]

   You can click **Filter Objects...** to refine the selected objects by specifying property conditions that the objects must meet to be exported. For more information on filtering objects by properties, see **Property-Based Conditions**.
8. Optional: Select the object that you just added to the **Data to export** section and click **Add Property**... to add for the selected object type a property that you want to be exported.
   a) Use the **Property to export** drop-down menu to select the property to be exported.
   b) Go to the **History and Old Values** tab.

   - On the **History and Old Values** tab you can define whether you want to export the change history and previous values of the selected property.
   - The **History and Old Values** tab is opened.

   ![Property to Export - Customer](image)

   c) Check the **Export the change history of this property** check box if you want to export the change history of the selected property.

   - The change history adds an entry of each change in the property value to the data set. This makes it possible to answer questions such as "What was the total value of deals closed in August?" by exporting the change history of the property value **Closed** and pinpointing the objects for which the value of said property changed from **No** to **Yes** during August.
   
   d) Check the **Export the old values of this property, using sampling** check box if you want to export previous values of the selected property and use the **Sample at** drop-down menu to define the frequency of the sampling (daily, weekly, monthly, or yearly).
   
   e) Select either **Full history**, **Fixed-length period**, or **Starting from date** option to define the history length for the change history and old values of the selected property.

   - If the frequency of sampling is high (for instance daily), it is recommended to restrict the length of the history period to avoid expanding the database unnecessarily and to increase the speed of the export function.
   
   f) Click **OK** to close the **Property to Export** dialog.
9. In the **OLE DB connection string** field, enter the connection string for connecting to the target database or click **Define...** to define the connection string.

   If you are using Microsoft SQL Server as the target database, it is advised to use Microsoft OLE DB Driver for SQL Server (**MSOLEDBSQL**) as the data provider, and to use either **Simple** or **Bulk-logged** as the **Recovery model** setting in the target database. This will significantly improve the speed and performance of exporting data sets.

   For more information on database connection strings, see **Connections to External Databases for Object Types**.

10. Go to the **Advanced** tab.

   The **Advanced** tab is opened.

   ![Advanced tab image](image-url)
11. In the **Use the identity of the following user when reading data** drop-down menu, select the user whose identity you want to use for transferring data from M-Files to the reporting services.

   - The most suitable user is a “regular” user without any extended rights. If you use, for example, your own user identity that has a system administrator role, data that you do not want to expose to all users could end up in the reports displayed by the client software.

   - If the metadata structure of the vault is translated into multiple languages, the metadata language of the exported data set depends on the vault language settings of the user whose identity is used for reading data.

   - If you have the Electronic Signatures and Advanced Logging module in use, you must select (M-Files Server) as the user.

12. Optional: Check the **Export data on a scheduled basis** option check box and click **Schedule...** if you want to export this data set on a scheduled basis.

   - It is recommended to schedule the data export to be performed once a day/week/month. The reports are updated at the same time. If you do not select scheduling, the data will not be updated after export. You can also create a separate update link in the reporting services so that the user can update the report in the client software whenever desired. For more information, please contact M-Files Customer Support at support@m-files.com.

13. Optional: On the **Advanced** tab, define an alias for the data set.

   - When you have automatic aliases in use and you write a name on the **General** tab, the **Aliases** field on the **Advanced** tab is automatically filled in. The alias has the format <predefined prefix>.<name>. Define automatic aliases for your vault in the configurations editor.

14. Optional: Click **Export Now** to export the data set right away.

   - You can click **Status of Exporting...** to view the status of the exporting process when the exporting is in progress.

15. Click **OK** to finish creating the new data set.

   The data set that you have just defined is added to the **Reporting and Data Export** list. The data set is exported either automatically on a scheduled basis or manually, depending on the settings that you have provided.

   Now that you have created a data set, you can use it to create a report (see **Creation of Reports and the Required Software**) and then create a report object in M-Files to read the report (see **Creating a Report Object for a Report**).

### Specifying the Report Access Identity

The report access identity is the identity that is used for transferring reports from the reporting services to M-Files Desktop and for reading them.

Follow these steps to specify the report access identity:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Reporting and Data Export and then click Specify Report Access Identity on the task area.

The Specify Report Access Identity dialog is opened.

5. Select either:

   a. **Windows user identity**: Select this option to access reports via the Windows user account. This is the recommended choice in a Windows domain environment.

   or

   b. **Specific identity**: To define a specific identity for accessing reports, select this option and enter the username and password of the identity in the Username and Password fields. The identity can be a local Windows account, a domain account, or some other account recognized by the reporting service. The reporting account to be specified should have only limited access permissions to the reporting services. Check the The account specified is an external account (e.g., Microsoft Azure SQL Reporting) check box if the specified account is an external account.

6. Click OK to close the Specify Report Access Identity dialog.
The report access identity that you have specified is now used for transferring reports from the reporting services to M-Files Desktop and for reading them.

**Creation of Reports and the Required Software**

The reports from M-Files to an external database are created by using the *Microsoft SQL Server Reporting Services* infrastructure, which must be implemented and configured correctly.

When reports have been created and they are to be used in M-Files, the *SQL Server Reporting Services* system contacts the database to which the data export was done from M-Files, creating a report when M-Files Desktop so requires.

Microsoft's SQL Server Reporting Services infrastructure can be installed with the SQL Server installation package (*Microsoft SQL Server 2012* or later).

The free SQL Server Express versions can also be used in reporting. If you are going to use SQL Server Express, you need the SQL Server Express with Advanced Services edition, which includes the necessary reporting services module. You can download it via Microsoft's web site at https://www.microsoft.com/en-us/sql-server/sql-server-editions-express.


In planning the reports, you also need *Business Intelligence Development Studio* or, a simpler tool, *Report Builder*. The person planning the reports must be experienced in this and have the skills required for creating reports. Please contact our consulting services personnel, and we will be happy to help you with planning of the reports (sales@m-files.com).

For more information on installing Microsoft’s reporting services, please consult Microsoft's web pages and the M-Files customer support staff at support@m-files.com.

**Note:** Instructions for planning and creating reports and for using third-party software are available via the M-Files consulting services for a separate fee.

**Creating a Report Object for a Report**

When a report has been created (for more information, see *Creation of Reports and the Required Software*), it can be retrieved for use in M-Files Desktop.

For displaying reports, .NET Framework 4.5 or later (or the most recent available *Client Profile* version) is required. If the client computer does not have an appropriate .NET Framework installed, the report is not shown and the user is prompted to install the framework. You can download the most recent .NET Framework version via Microsoft Download Center.

Follow these steps to create a report object:

1. In M-Files, right-click on the listing area and select **Create > Report**... from the context menu.

   The **New Report** dialog is opened.

2. In the **Name or title** field, enter a name describing the report.

   If the report is used for calculating yearly revenue, the title of the report object could be **Revenue by Year**.
3. In the **Report URL** field, enter the URL to be used for retrieving the report from the reporting services to M-Files. The URL must be in the form `http://servername/instance/?report_path`.

   The same URL can be used to retrieve the report in the browser. Note, however, that this address will not be displayed in the browser address field after opening the report. For more information, please contact M-Files customer support at support@m-files.com.

4. Optional: To define the placement of the report in the M-Files user interface, click **Add property** and select **Report placement** from the drop-down menu, and then select an appropriate value for **Report placement** using the drop-down menu.

5. Click **Create** to create the report object.

The report object you have created is added to the vault. You can view the report by selecting the object in M-Files.

You can attach a report object to a specific view. For instructions, see **Attaching a Report Object to a View**.

**Attaching a Report Object to a View**

You can attach a report object to a specific view, such as *Sales by customer* or *Proposals by salesperson*. Do the following steps to attach a report object to a view:

1. In M-Files, navigate to the view to which you want to attach a report object.

2. Optional: If you want your settings to be applied for all users, right-click on an empty area in the view and select **Properties** from the context menu.
   a) In the **Properties** dialog, check the **Common to all users** check box, if it is not already checked.
   b) Click **OK** to close the **Properties** dialog.

3. Press Alt and select one of the following options from the context menu:

   a. **View > Reports > Attach Report to This View (full view)...**: Select this option if you want the report to be displayed in the full view mode, covering the listing area and the right pane.

   or

   b. **View > Reports > Attach Report to This View (right)...**: Select this option if you want the report to be displayed in the right pane.

   or

   c. **View > Reports > Attach Report to This View (bottom)...**: Select this option if you want the report to be displayed at the bottom of the listing area.

   The **Select Report** dialog is opened.

4. Select the report object that you want to attach to the selected view and click **Open**.

The selected report is attached to the selected view. When you navigate to the view, the report is displayed automatically.

**Associating the Report Object with Other Objects**

You can associate the *Report* object with other objects, such as *Customers*. You can display the report data by customer by selecting a customer from the list if you so specify in the reporting services settings (see **Creation of Reports and the Required Software**). Then M-Files will show the data (for instance sales by month) for only this specific customer in the report. When you select another customer, the report will be updated with data related to the second customer.
Bringing the Report Up to Date

The data in the report is based on the latest data from M-Files to the reporting service. The data can be exported either manually or on a scheduled basis. If a separate update link is created for a report in the reporting services, the report can be updated whenever desired via M-Files Desktop. For more information, please contact M-Files customer support at support@m-files.com.

Exporting a Report

Once a report is readable in M-Files, it can also be exported in various file formats. The supported file formats are:

- XML file with report data
- CSV (comma delimited)
- PDF
- MHTML (web archive)
- Excel spreadsheet.
- TIFF file
- Word document

Note: The exported report is static and cannot be edited in other applications.

Do the following steps to export a report:

1. In M-Files, locate the report that you want to export by using either the search or the views.
2. Right-click on the displayed report and select Export and then select a suitable file format from the context menu.

   The Save As dialog is opened.

3. Select a suitable directory and enter a suitable file name in the File name field and then click Save.

   The report is exported in the selected file format.

3.2.10. Event Handlers and Scripts

This section describes how to create new event handlers and how to use scripts in M-Files. You might also want to see the FAQ article How do I write VBScript code for M-Files purposes?.

In this chapter

- Event Handlers
- Available VBScript Variables
- Execution Order of Scripts

Event Handlers

With event handlers, you can define different operations that are executed when certain events occur, such as after an object is modified or before a new value list item is created. The operations are specified using variables, generic features of VBScript, and M-Files API.

Examples of event handler use:
• Object permissions can be set to change automatically when the object properties are changed.
• Certain basic documents can be added to every new project via a pre-defined project model.
• Specified Word documents can always be saved as PDFs, so that when a Word file is checked in, it is saved to the server in PDF format as well.
• Data related to photos, such as date and image size, can be automatically added to the metadata of the photo document.
• If the user adds a new value to the value list, the event handler can be used to check that the added value is entered correctly.
• Logging in to M-Files can be prevented outside working hours, for instance during night time and weekends.
• Downloading certain files can be monitored, downloading large numbers of files can be prevented, or an alarm of suspicious downloads can be sent to the administrator.

Note: The M-Files API documentation is located at www.m-files.com/api/documentation/latest. For more information about using VBScript in M-Files, see the How do I write VBScript code for M-Files purposes? tutorial.

Do the following steps to create a new event handler:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, right-click the desired document vault and select Event Handlers from the context menu.

The Event Handlers dialog is opened.
4. Click the **Add Event Handler...** button.

   The **Add Event Handler** dialog is opened.

   ![Add Event Handler dialog](image)

5. Use the **Select event** drop-down menu to select the event for which you want to create an event handler.

   ![Select event dropdown](image)

   - If you want to create an event handler that is invoked whenever a new object is about to be created, select the **BeforeCreateNewObjectFinalize** event.

   - For the list of available events and their descriptions, see Available Event Handlers

6. In the **Name** field, enter a descriptive name for the new event handler and click **OK** to close the **Add Event Handler** dialog.

   Check for duplicate titles.

   ![Check for duplicate titles](image)

   - If you have more than one event handler of the same type, you may change their execution order by selecting the event handler in the **Event Handlers** dialog and clicking either the up or down arrow button along the right corner of the dialog.

7. Back in the **Event Handler** dialog, click **Edit Code**.

   The **Edit VBScript Code** window is opened.
8. Enter the code to be executed when the event handler is invoked, and then close the **Edit VBScript** window.

The following code in the `BeforeCreateNewObjectFinalize` event could be used to display an error message to the user when they are about to create a new object (that is, the metadata card is filled with the necessary information and the user clicks the **Create** button) and the document vault already contains an object with the same title:

```vbscript
' The ID of the title property.
Dim titleProperty
titleProperty = MFBuiltInPropertyDefNameOrTitle

' Find the title property of the current object.
Dim currentTitleProp
currentTitleProp = PropertyValues.SearchForProperty(titleProperty)

' Get the title of the object.
Dim currentTitle
currentTitle = currentTitleProp.Value

' Search for objects on the basis of title.
Dim titleSearch
Set titleSearch = CreateObject("MFilesAPI.SearchCondition")
Dim titleExpression
Set titleExpression = CreateObject("MFilesAPI.Expression")
titleExpression.SetPropertyValueExpression titleProperty, MFParentChildBehaviorNone, Nothing
Dim titleTypedValue
```
Set titleTypedValue = CreateObject("MFilesAPI.TypedValue")
titleTypedValue.SetValue MFDatatypeText, currentTitle
titleSearch.Set titleExpression, MFConditionTypeEqual,
titleTypedValue
Dim SearchResults
Set SearchResults = Vault.ObjectSearchOperations.SearchForObjectsByCondition(titleSearch, false)

' If an existing object with the same title was found, raise an error.
If SearchResults.Count > 1 Then
    Err.Raise MFScriptCancel, 
        "The document vault already contains an object with the same title. Please choose another title."
End if


The new event handler is added to the selected document vault and the code that you have defined is executed whenever the event handler is invoked.

In this chapter

- Available Event Handlers

Available Event Handlers

Below you can find the available event handlers, with their variables and explanations. For more information about variables, see Available VBScript Variables.

Vault-level event handlers

The event handlers listed in this section are triggered by operations on the vault level.

Note: An exception in an event handler prevents the triggering operation from being executed.
<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
</table>
| BeforeSetProperties | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• PropertyValues  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when the property values of the object stored in the document vault are re-set. Properties can be inspected during BeforeSetProperties before they are set. It is not, however, recommended to modify properties during BeforeSetProperties as they may be overwritten after the event handler has been executed. Properties, on the other hand, can be modified during the AfterSetProperties event. |
| AfterSetProperties | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• PropertyValues  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when a new object is created in the document vault, regardless of whether the new object has been checked in or not. When executing the AfterCreateNewObjectFinalize event handler, the object may have already been checked in. For this reason, the metadata or files can no longer be modified during operation of the event handler, and thus the event handler is only suitable for validating changes. |
| BeforeCreateNewObjectFinalize | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• PropertyValues  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when an object which has never been checked in is removed from the document vault. The execution takes place, for instance, when the user performs the "Undo Checkout" function on the object or removes the object from the document vault. |
| AfterCreateNewObjectFinalize | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• PropertyValues  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when a new object is created in the document vault, regardless of whether the new object has been checked in or not. When executing the AfterCreateNewObjectFinalize event handler, the object may have already been checked in. For this reason, the metadata or files can no longer be modified during operation of the event handler, and thus the event handler is only suitable for validating changes. |
| BeforeCancelCreateObject | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when an object which has never been checked in is removed from the document vault. The execution takes place, for instance, when the user performs the "Undo Checkout" function on the object or removes the object from the document vault. |
<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BeforeCheckInChanges</td>
<td>• ObjVer</td>
<td>The event handlers are executed when the user checks the object in. The event handlers are not executed if the object was not modified, in which case the BeforeCancelCheckOut and AfterCancelCheckOut event handlers are executed. It is still possible to modify the object during BeforeCheckInChanges. These event handlers are also executed when the user creates a new object with the <strong>Check in immediately</strong> option unchecked, and checks in the object without making any changes to the file. These event handlers are not executed when a new object is created with the <strong>Check in immediately</strong> option enabled. During the execution of the AfterCheckInChanges event handler, the object can no longer be modified as the object has already been checked in, and thus the event handler is only suitable for validating changes.</td>
</tr>
<tr>
<td></td>
<td>• DisplayID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vault</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td>AfterCheckInChanges</td>
<td>• ObjVer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• DisplayID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vault</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td>BeforeCancelCheckOut</td>
<td>• ObjVer</td>
<td>The event handlers are executed when modifications of a checked out object are undone using, for example, the <strong>Undo Checkout</strong> function. The event handlers are also executed if the object is checked in without any modifications. During execution of the AfterCancelCheckOut event handler, the object cannot be modified as the object is no longer checked out.</td>
</tr>
<tr>
<td></td>
<td>• DisplayID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vault</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td>Event handler</td>
<td>Variables</td>
<td>Execution</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| AfterCancelCheckoutFinalize | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | An event triggered after the undo checkout operation is complete, meaning that the object is no longer checked out. A script can be used for performing the checkout operation and for performing further object operations with the checked out object version. |
| BeforeCheckOut         | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when a document vault object is checked out. During execution of the BeforeCheckOut event handler, the object has not been checked out, so the object cannot be modified. |
| AfterCheckOut          | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID |                                                                                                                                 |
| BeforeDeleteObject     | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when an object is marked as deleted. |
| AfterDeleteObject       | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID |                                                                                                                                 |
<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
</table>
| BeforeDestroyObject          | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when an object is destroyed from the document vault. |
| AfterDestroyObject           | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when an object is destroyed from the document vault. |
| BeforeDestroyObjectVersion   | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when an individual version of the object is destroyed from the document vault. |
| AfterDestroyObjectVersion    | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handlers are executed when an individual version of the object is destroyed from the document vault. |
| BeforeSetObjectPermissions    | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID  
• ObjectAccessControlList | The event handlers are executed when the object permissions are changed. |
<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BeforeFileUpload</td>
<td>• Vault&lt;br&gt;• CurrentUserID&lt;br&gt;• CurrentUserSessionInfo&lt;br&gt;• VaultSharedVariables&lt;br&gt;• SavepointVariables&lt;br&gt;• TransactionCache&lt;br&gt;• MFScriptCancel&lt;br&gt;• GetExtensionObject&lt;br&gt;• MasterTransactionID&lt;br&gt;• CurrentTransactionID&lt;br&gt;• ParentTransactionID&lt;br&gt;• FileTransferSessionID</td>
<td>The event handler is executed when the user starts a file transfer to M-Files Server.</td>
</tr>
<tr>
<td>AfterFileUpload</td>
<td>• ObjVer&lt;br&gt;• DisplayID&lt;br&gt;• Vault&lt;br&gt;• CurrentUserID&lt;br&gt;• CurrentUserSessionInfo&lt;br&gt;• VaultSharedVariables&lt;br&gt;• SavepointVariables&lt;br&gt;• TransactionCache&lt;br&gt;• MFScriptCancel&lt;br&gt;• GetExtensionObject&lt;br&gt;• MasterTransactionID&lt;br&gt;• CurrentTransactionID&lt;br&gt;• ParentTransactionID&lt;br&gt;• FileTransferSessionID&lt;br&gt;• FileVer</td>
<td>The event handler is executed when the file transfer to the server is completed.</td>
</tr>
<tr>
<td>BeforeFileDownload</td>
<td>• Vault&lt;br&gt;• CurrentUserID&lt;br&gt;• CurrentUserSessionInfo&lt;br&gt;• VaultSharedVariables&lt;br&gt;• SavepointVariables&lt;br&gt;• TransactionCache&lt;br&gt;• MFScriptCancel&lt;br&gt;• GetExtensionObject&lt;br&gt;• MasterTransactionID&lt;br&gt;• CurrentTransactionID&lt;br&gt;• ParentTransactionID&lt;br&gt;• FileTransferSessionID&lt;br&gt;• ObjID&lt;br&gt;• FileVer</td>
<td>The event handlers are executed when the user loads the file from M-Files Server to the client machine's local cache. If necessary, these event handlers can be used to prevent transfer of certain files to the users' machines.</td>
</tr>
<tr>
<td>Event handler</td>
<td>Variables</td>
<td>Execution</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BeforeCreateNewValueListItem</td>
<td>• Vault</td>
<td>The event handlers are executed when new values are added to a certain value list of the document vault. These event handlers can be used to, for example, ensure that all values entered in the value list are in a specified form as desired.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ValueListItem</td>
<td></td>
</tr>
<tr>
<td>AfterCreateNewValueListItem</td>
<td>• Vault</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ValueListItem</td>
<td></td>
</tr>
<tr>
<td>BeforeLoginToVault</td>
<td>• Vault</td>
<td>The event handler is executed immediately prior to logging in of the user to the document vault. At this stage, the user has already been identified against M-Files Server, so the event handler is not executed, for instance, if a user who attempts to log in does not have a login account on the server.</td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• LoginAccount</td>
<td></td>
</tr>
<tr>
<td>AfterLoginToVault</td>
<td>• Vault</td>
<td>The event handler is executed when the user has successfully logged in to the document vault.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• LoginAccount</td>
<td></td>
</tr>
<tr>
<td>Event handler</td>
<td>Variables</td>
<td>Execution</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
</tbody>
</table>
| **BeforeLogoutFromVault** | • Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event handler is executed immediately before the user is logged out of the document vault. The logout cannot be interrupted during this event handler. The client software does not react to any error messages received from this event handler. |
| **AfterLogoutFromVault** | • Vault  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID  
• LoggedOutUserID | The event handler is executed when the user has been logged out of the document vault. The logout cannot be interrupted during this event handler. The client software does not react to any error messages received from this event handler. |
| **Replication: AfterCheckInChanges** | • Vault  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID  
• RestoredVersions  
• ObjVer | The event handlers are invoked when new versions are imported to the existing object from the content package or when a conflict between two objects is resolved in favor of the source-vault version. When the AfterCheckInChanges event handler is invoked, the object has already been checked in. For this reason, the metadata or files can no longer be modified during operation of the event handler. |
### Event handler | Variables | Execution
--- | --- | ---
**Replication:**  
*AfterCreateNewObjectFinalize* | - Vault  
- VaultSharedVariables  
- SavepointVariables  
- TransactionCache  
- MFScriptCancel  
- GetExtensionObject  
- MasterTransactionID  
- CurrentTransactionID  
- ParentTransactionID  
- RestoredVersions  
- ObjVer | The event handler is invoked when a new object is imported to the document vault from the content package. On invoking of the *AfterCreateNewObjectFinalize* event handler, the object has already been checked in. For this reason, the metadata or files can no longer be modified during operation of the event handler.

**VaultExtensionMethod** | - Vault  
- CurrentUserID  
-CurrentUserSessionInfo  
- VaultSharedVariables  
- SavepointVariables  
- TransactionCache  
- MFScriptCancel  
- GetExtensionObject  
- MasterTransactionID  
- CurrentTransactionID  
- ParentTransactionID  
- Input  
- Output | The event handler is invoked explicitly by the client (the so-called vault extension method).

**BeforeCreateLoginAccount**  
**AfterCreateLoginAccount** | - Vault  
- CurrentUserID  
- CurrentUserSessionInfo  
- VaultSharedVariables  
- SavepointVariables  
- TransactionCache  
- MFScriptCancel  
- GetExtensionObject  
- MasterTransactionID  
- CurrentTransactionID  
- ParentTransactionID  
- LoginAccount | BeforeCreateLoginAccount: The event is triggered before a vault-level login account is created in the vault database.

AfterCreateLoginAccount: The event is triggered after a vault-level login account is created in the vault database.
<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
</table>
| BeforeModifyLoginAccount      | • Vault
• CurrentUserID
• CurrentUserSessionInfo
• VaultSharedVariables
• SavepointVariables
• TransactionCache
• MFScriptCancel
• GetExtensionObject
• MasterTransactionID
• CurrentTransactionID
• ParentTransactionID
• LoginAccount                 | BeforeModifyLoginAccount: The event is triggered before a vault-level login account is modified in the vault database. |
| AfterModifyLoginAccount       |                                                                           | AfterModifyLoginAccount: The event is triggered after a vault-level login account is modified in the vault database. |
| BeforeRemoveLoginAccount      | • Vault
• CurrentUserID
• CurrentUserSessionInfo
• VaultSharedVariables
• SavepointVariables
• TransactionCache
• MFScriptCancel
• GetExtensionObject
• MasterTransactionID
• CurrentTransactionID
• ParentTransactionID
• LoginAccount                 | BeforeRemoveLoginAccount: The event is triggered before a vault-level login account is removed from the vault database. |
| AfterRemoveLoginAccount       |                                                                           | AfterRemoveLoginAccount: The event is triggered after a vault-level login account is removed from the vault database. |
| BeforeCreateUserAccount       | • Vault
• CurrentUserID
• CurrentUserSessionInfo
• VaultSharedVariables
• SavepointVariables
• TransactionCache
• MFScriptCancel
• GetExtensionObject
• MasterTransactionID
• CurrentTransactionID
• ParentTransactionID
• UserAccount                  | BeforeCreateUserAccount: The event is triggered before a user account is created in the vault database. |
<p>| AfterCreateUserAccount        |                                                                           | AfterCreateUserAccount: The event is triggered after a user account is created in the vault database. |</p>
<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BeforeModifyUserAccount</td>
<td>• Vault</td>
<td>BeforeModifyUserAccount: The event is triggered before a user account is modified in the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UserAccount</td>
<td></td>
</tr>
<tr>
<td>AfterModifyUserAccount</td>
<td>• Vault</td>
<td>AfterModifyUserAccount: The event is triggered after a user account is modified in the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UserAccount</td>
<td></td>
</tr>
<tr>
<td>BeforeRemoveUserAccount</td>
<td>• Vault</td>
<td>BeforeRemoveUserAccount: The event is triggered before a user account is removed from the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UserAccount</td>
<td></td>
</tr>
<tr>
<td>AfterRemoveUserAccount</td>
<td>• Vault</td>
<td>AfterRemoveUserAccount: The event is triggered after a user account is removed from the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UserAccount</td>
<td></td>
</tr>
<tr>
<td>BeforeCreateUserGroup</td>
<td>• Vault</td>
<td>BeforeCreateUserGroup: The event is triggered before a user group is created in the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UserGroupAdmin</td>
<td></td>
</tr>
<tr>
<td>AfterCreateUserGroup</td>
<td>• Vault</td>
<td>AfterCreateUserGroup: The event is triggered after a user group is created in the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UserGroupAdmin</td>
<td></td>
</tr>
<tr>
<td>Event handler</td>
<td>Variables</td>
<td>Execution</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>BeforeModifyUserGroup</strong></td>
<td>• Vault</td>
<td><strong>BeforeModifyUserGroup</strong>: The event is triggered before a user group is modified in the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td><strong>AfterModifyUserGroup</strong>: The event is triggered after a user group is modified in the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td><strong>Note</strong>: The <strong>AfterModifyUserGroup</strong> event handler is not executed when the <em>All internal users</em> group is modified.</td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UserGroupAdmin</td>
<td></td>
</tr>
<tr>
<td><strong>AfterRemoveUserGroup</strong></td>
<td>• Vault</td>
<td><strong>BeforeRemoveUserGroup</strong>: The event is triggered before a user group is removed from the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td><strong>AfterRemoveUserGroup</strong>: The event is triggered after a user group is removed from the vault database.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td><strong>AfterRemoveUserGroup</strong>: The event is triggered after a user group is removed from the vault database.</td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• UserGroupAdmin</td>
<td></td>
</tr>
<tr>
<td><strong>AfterBringOnline</strong></td>
<td>• Vault</td>
<td><strong>AfterBringOnline</strong>: The event is triggered after the vault is brought online.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td><strong>BeforeTakeOffline</strong>: The event is executed before the vault is taken offline. An exception in any of the two event handlers does not prevent the online/offline transition.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td>Event handler</td>
<td>Variables</td>
<td>Execution</td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| AfterCheckInChangesFinalize | • ObjVer  
• DisplayID  
• Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID | The event is triggered when an object has been completely checked in (or when an object is immediately checked in after it has been created) after all the operations occurring after the check-in, such as any automatic state transitions, have been completed. |
| BeforeCreateView     | • Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID  
• View | BeforeCreateView: The event is triggered before a new view is created in a vault. |
| AfterCreateView      | • Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID  
• View | AfterCreateView: The event is triggered after a new view has been created in a vault. |
| BeforeModifyView     | • Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID  
• View | BeforeModifyView: The event is triggered before changes made to a view become effective. |
| AfterModifyView       | • Vault  
• CurrentUserID  
• CurrentUserSessionInfo  
• VaultSharedVariables  
• SavepointVariables  
• TransactionCache  
• MFScriptCancel  
• GetExtensionObject  
• MasterTransactionID  
• CurrentTransactionID  
• ParentTransactionID  
• View | AfterModifyView: The event is triggered after changes made to a view have become effective. |
<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BeforeDeleteView</td>
<td>• Vault</td>
<td>BeforeDeleteView: The event is triggered before a view that is set to be deleted.</td>
</tr>
<tr>
<td>AfterDeleteView</td>
<td>• CurrentUserID</td>
<td>AfterDeleteView: The event is triggered after a view has been deleted.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View</td>
<td></td>
</tr>
<tr>
<td>BeforeReturnView</td>
<td>• Vault</td>
<td>This event handler is triggered after a view has been retrieved from the vault but before it is returned to the client. It enables you to modify a view, for instance, by filtering it with dynamic search conditions, such as ones based on the current user.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• View</td>
<td></td>
</tr>
<tr>
<td>BeforeUndeleteObject</td>
<td>• ObjVer</td>
<td>BeforeUndeleteObject: The event handler is triggered before an object is undeleted.</td>
</tr>
<tr>
<td>AfterUndeleteObject</td>
<td>• DisplayID</td>
<td>AfterUndeleteObject: The event handler is triggered after an object is undeleted. A script can be used for performing the checkout operation and for performing further object operations with the checked out object version.</td>
</tr>
<tr>
<td></td>
<td>• Vault</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td>Event handler</td>
<td>Variables</td>
<td>Execution</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AfterUndeleteObjectFinalize</td>
<td>• ObjVer</td>
<td>This event is triggered after the object undelete operation is complete and you are able to work with the undeleted object.</td>
</tr>
<tr>
<td></td>
<td>• DisplayID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vault</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ActivityID</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BeforeModifyMFilesCredentials</td>
<td>• Vault</td>
<td>BeforeModifyMFilesCredentials: The event handler is triggered before the password of the M-Files login account is changed.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td>AfterModifyMFilesCredentials</td>
<td>• CurrentUserSessionInfo</td>
<td>AfterModifyMFilesCredentials: The event handler is triggered after the password of the M-Files login account is changed.</td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ActivityID</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BeforeCheckinChangesFinalize</td>
<td>• ObjVer</td>
<td>The BeforeCheckinChangesFinalize event handler is triggered before an object is checked in, but after the state transitions and signatures have been finalized. Workflow changes are not allowed.</td>
</tr>
<tr>
<td></td>
<td>• DisplayID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Vault</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
</tbody>
</table>

**Server-level event handlers**

This section lists event handlers that are triggered by server-level operations. These operations also cause a corresponding event to be executed in all online vaults of the server.
**Note:** An exception in a server-level event handler prevents the triggering operation from being executed, but any vault-level event handler exceptions do not affect server-level operations.

<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
</table>
| BeforeRunScheduledJob | • CurrentUserID  
                      | • CurrentUserSessionInfo  
                      | • GetExtensionObject  
                      | • MFScriptCancel  
                      | • ScheduledJob  
                      | • ScheduledJobOutputInfo  | The event handler is executed when one of the timed jobs of the server is performed. These event handlers can be used to automatically monitor the execution of the automatically timed jobs. In case of error, the event handler can automatically send an e-mail notification to the administrator to facilitate resolution of the problem. |
| AfterRunScheduledJob   | • LoginAccount  
                      | • CurrentUserID  
                      | • CurrentUserSessionInfo  
                      | • VaultSharedVariables  
                      | • SavepointVariables  
                      | • TransactionCache  
                      | • MFScriptCancel  
                      | • GetExtensionObject  
                      | • MasterTransactionID  
                      | • CurrentTransactionID  
                      | • ParentTransactionID  | BeforeCreateLoginAccount: The event is triggered for all online vaults before a login account is created on the server. 

AfterCreateLoginAccount: The event is triggered for all online vaults after a login account is created on the server. |
| BeforeCreateLoginAccount | • LoginAccount  
                      | • CurrentUserID  
                      | • CurrentUserSessionInfo  
                      | • VaultSharedVariables  
                      | • SavepointVariables  
                      | • TransactionCache  
                      | • MFScriptCancel  
                      | • GetExtensionObject  
                      | • MasterTransactionID  
                      | • CurrentTransactionID  
                      | • ParentTransactionID  | BeforeModifyLoginAccount: The event is triggered for all online vaults before a login account is modified on the server. |
| AfterModifyLoginAccount | • LoginAccount  
                      | • CurrentUserID  
                      | • CurrentUserSessionInfo  
                      | • VaultSharedVariables  
                      | • SavepointVariables  
                      | • TransactionCache  
                      | • MFScriptCancel  
                      | • GetExtensionObject  
                      | • MasterTransactionID  
                      | • CurrentTransactionID  
                      | • ParentTransactionID  | AfterModifyLoginAccount: The event is triggered for all online vaults after a login account is modified on the server. |
### Event handler
<table>
<thead>
<tr>
<th>Event handler</th>
<th>Variables</th>
<th>Execution</th>
</tr>
</thead>
<tbody>
<tr>
<td>BeforeRemoveLoginAccount</td>
<td>• LoginAccount</td>
<td>BeforeRemoveLoginAccount: The event is triggered for all online vaults before a login account is removed from the server.</td>
</tr>
<tr>
<td>AfterRemoveLoginAccount</td>
<td>• CurrentUserID</td>
<td>AfterRemoveLoginAccount: The event is triggered for all online vaults after a login account is removed from the server.</td>
</tr>
<tr>
<td></td>
<td>• CurrentUserSessionInfo</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• VaultSharedVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• SavepointVariables</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• TransactionCache</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MFScriptCancel</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• MasterTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• CurrentTransactionID</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• ParentTransactionID</td>
<td></td>
</tr>
<tr>
<td>BeforeModifyMFilesCredentials</td>
<td>• CurrentUserID</td>
<td>BeforeModifyMFilesCredentials: The event handler is triggered for all online vaults before the password of an M-Files login account is changed.</td>
</tr>
<tr>
<td>AfterModifyMFilesCredentials</td>
<td>• CurrentUserSessionInfo</td>
<td>AfterModifyMFilesCredentials: The event handler is triggered for all online vaults after the password of an M-Files login account is changed.</td>
</tr>
<tr>
<td></td>
<td>• GetExtensionObject</td>
<td></td>
</tr>
</tbody>
</table>

### Available VBScript Variables

VBScript code is edited in the **Edit VBScript code** window available in the following dialogs:

- Property Definition Automatic Values
- Automatically Validating Property Values
- Trigger
- Workflow State Actions
- Workflow State Conditions
- Event Handlers

The available variables are described in the table below.

**Note**: The M-Files API documentation is located at [www.m-files.com/api/documentation/latest](http://www.m-files.com/api/documentation/latest). For more information about using VBScript in M-Files, see the [How do I write VBScript code for M-Files purposes?](http://www.m-files.com) tutorial.

<table>
<thead>
<tr>
<th>Variable</th>
<th>Data type</th>
<th>Mode</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>ActivityID</td>
<td>MFilesAPI.TypedValue</td>
<td>In</td>
<td>The unique ID of the operation that is being processed. Can be used for identifying which events are caused by a certain server operation.</td>
</tr>
<tr>
<td>Variable</td>
<td>Data type</td>
<td>Mode</td>
<td>Use</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------</td>
<td>------</td>
<td>---------------------------------------------------------------------</td>
</tr>
<tr>
<td>AllowStateTransition</td>
<td>Boolean</td>
<td>Out</td>
<td>Can be used to allow or deny automatic state transition when running the automatic state transition script.</td>
</tr>
<tr>
<td>CurrentTransactionID</td>
<td>MFilesAPI.TypedValue</td>
<td>In</td>
<td>The ID of the transaction. If event handlers are executed recursively (so that executing one causes another to be executed), the ID changes on every recursion level.</td>
</tr>
<tr>
<td>CurrentUserID</td>
<td>MFilesAPI.Number</td>
<td>In</td>
<td>Contains the ID of the user who performed the action that triggered the script.</td>
</tr>
<tr>
<td>CurrentUserSessionInfo</td>
<td>MFilesAPI.SessionInfo</td>
<td>In</td>
<td>Contains information about the login session of the user who caused the operation.</td>
</tr>
<tr>
<td>DisplayID</td>
<td>MFilesAPI.TypedValue</td>
<td>In</td>
<td>Contains the object's unique ID. This ID is displayed to users in the property area of M-Files Desktop when the object is selected in the list. DisplayID can contain both numbers and letters. Often, DisplayID is the same as the object's internal ID whose value can be retrieved with the ObjVer variable. The internal ID can only contain numbers. DisplayID and the internal ID are usually different when the object has been imported from an external database.</td>
</tr>
<tr>
<td>FileTransferSessionID</td>
<td>MFilesAPI.Number</td>
<td>In</td>
<td>Contains the user-specific data transfer identifier. The data transfer identifier is created when the data transfer is being started on the server and, at the same time, the same identifier is given to the BeforeFileUpload and BeforeFileDownload event handlers. After completion of the data transfer, the same data transfer identifier will be given to the AfterFileUpload and AfterFileDownload event handlers. This way it is possible to attach the event handlers of type &quot;Before&quot; to the event handlers of type &quot;After&quot;.</td>
</tr>
<tr>
<td>FileVer</td>
<td>MFilesAPI.FileVer</td>
<td>In</td>
<td>Contains the complete unique ID of the target file, consisting of the file ID and file version.</td>
</tr>
<tr>
<td>Variable</td>
<td>Data type</td>
<td>Mode</td>
<td>Use</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------</td>
<td>------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>GetExtensionObject</td>
<td>(method)</td>
<td>N/A</td>
<td>A method for retrieving the extension object defined by the vault application.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Use</strong>: <code>GetExtensionObject(&lt;object name&gt;[, application GUID])</code>, where the part <code>[, application GUID]</code> is optional.</td>
</tr>
</tbody>
</table>
|                     |                    |      | **For example**: Set CK = GetExtensionObject("M-Files.ComplianceKit", 
<p>|                     |                    |      | &quot;{0CAC5452-631F-4646-AC95-4A06BFB8147E}&quot;) |
|                     |                    |      | If the application GUID has not been specified, the extension object is searched from all the applications of the vault. |
| Input               | MFilesAPI.TypedValue | In   | A client-defined parameter for the <code>VaultExtensionMethod</code> event handler. |
| IsCancellable       | MFilesAPI[BooleanValue] | In   | Normally, scripts can cancel a server operation and revert the associated transaction by raising an error in the script. The <code>IsCancellable</code> variable specifies whether the script is allowed do this. |
|                     |                    |      | If the value of the variable is <code>false</code>, M-Files Server will ignore any errors raised in the script. If the script raises an error while the value of the variable is <code>false</code>, however, an error is written to the Windows event log and all the changes made via the script are reverted. The server operation then proceeds to completion. |
| LastUsed            | MFilesAPI.TypedValue | In   | Available only if a <em>customized automatic number</em> is being calculated for a property. The value of an automatic number usually depends on the previous calculation. For example, in ordinary consecutive numbering, the automatic value is incremented by one each time. When you are setting up customized automatic numbering, the result of the previous calculation can be retrieved by using the <code>LastUsed</code> variable. |
|                     |                    |      | <strong>For example</strong>, simple automatic numbering that increments by one could be implemented with the following simple VBScript code: <code>Output = LastUsed + 1</code> |</p>
<table>
<thead>
<tr>
<th>Variable</th>
<th>Data type</th>
<th>Mode</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoggedOutUserID</td>
<td>MFilesAPI.Number</td>
<td>In</td>
<td>Contains the logged out user ID after logout.</td>
</tr>
<tr>
<td>LoginAccount</td>
<td>MFilesAPI.LoginAccount</td>
<td>In</td>
<td>Contains the user account data in the login.</td>
</tr>
<tr>
<td>MasterTransactionID</td>
<td>MFilesAPI.TypedValue</td>
<td>In</td>
<td>The ID of the transaction. If event handlers are executed recursively (so that executing one causes another to be executed), this transaction ID is the ID of the first transaction.</td>
</tr>
</tbody>
</table>
| MFScriptCancel          | MFilesAPI.Number      | In   | Contains the error code which is used by the scripts for displaying error messages to users. M-Files often adds detailed data to error messages; this can be prevented with the error code of the MFScriptCancel variable.  
**Example:** Err.Raise MFScriptCancel, "This is the error message shown to the user." |
<p>| NextStateID             | MFilesAPI.Number      | Out  | During the automatic state transition, the NextStateID variable contains the ID of the state for which the automatic state transition will be performed. By changing the value of this variable, you can define the next state in the automatic state transition script. By default, the target state is the same as set in the Next State option in the user interface. |
| ObjectAccessControlList | MFilesAPI.ObjectAccessControlList | In   | Contains the current permissions of the viewed object. |
| ObjID                   | MFilesAPI.ObjID       | In   | The ID of the object being processed.                                |
| ObjVer                  | MFilesAPI.ObjVer      | In   | Contains the complete unique ID of the target version, consisting of the object type ID, object internal ID, and object version. |</p>
<table>
<thead>
<tr>
<th>Variable</th>
<th>Data type</th>
<th>Mode</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>MFilesAPI.TypedValue</td>
<td>Out</td>
<td>Available only if a customized automatic number is being calculated for a property. When VBScript code starts to run, the Output variable contains the current value of the property being calculated (but not for automatic numbering). The main purpose of VBScript code is usually to create a new value and assign it to the Output variable, which is then stored in the object's metadata. If the VBScript code does not set the value of the Output variable, the property value in the metadata remains the same. The value of the Output variable can, in simple cases, be set with a simple statement, for example: <code>Output = 123</code> If the data type of the value being calculated is, say, Choose from list, the SetValue method is recommended for setting the value of the Output variable (see M-Files API), for example, as follows: <code>Output.SetValue MFDatatypeLookup, 101</code></td>
</tr>
<tr>
<td>ParentTransactionID</td>
<td>MFilesAPI.TypedValue</td>
<td>In</td>
<td>The ID of the transaction. If event handlers are executed recursively (so that executing one causes another to be executed), this transaction ID is the ID of the previous (calling) transaction.</td>
</tr>
<tr>
<td>PropertyDef</td>
<td>MFilesAPI.PropertyDef</td>
<td>In</td>
<td>Contains the information about the property value being calculated, such as the property value definition ID, name, and data type.</td>
</tr>
<tr>
<td>PropertyValue</td>
<td>MFilesAPI.PropertyValue</td>
<td>In</td>
<td>Contains a property value. Each property value is stored in the PropertyValue variable as a variable of the type PropertyValue. A certain property value can be retrieved with the SearchForProperty method.</td>
</tr>
<tr>
<td>Variable</td>
<td>Data type</td>
<td>Mode</td>
<td>Use</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------</td>
<td>------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>PropertyValues</td>
<td>MFilesAPI.PropertyValues</td>
<td>In</td>
<td>Contains all the property values of the target version that were affected by the current action. Each property value is stored in the variable <code>PropertyValues</code> as a variable of the type <code>PropertyValue</code>. A certain property value can be retrieved with the <code>SearchForProperty</code> method.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Note: Some property definitions are not shown when using the <code>PropertyValues</code> variable in scripts (see Property definitions not shown for scripts).</td>
</tr>
<tr>
<td>RestoredVersions</td>
<td>MFilesAPI.IDs</td>
<td>In</td>
<td>Contains object versions of the exported object that were imported from the content package.</td>
</tr>
<tr>
<td>SavepointVariables</td>
<td>MFilesAPI.NamedValues</td>
<td>In/Out</td>
<td>A container for optional name-value pairs stored for the duration of a single transaction. The container automatically reverts the modifications caused by failed operations in the container.</td>
</tr>
<tr>
<td>ScheduledJob</td>
<td>MFilesAPI.ScheduledJob</td>
<td>In</td>
<td>Contains a description of the scheduled job which is being performed.</td>
</tr>
<tr>
<td>ScheduledJobOutputInfo</td>
<td>MFilesAPI.ScheduledJobOutputInfo</td>
<td>In</td>
<td>Contains information of the scheduled job result after the job has been performed.</td>
</tr>
<tr>
<td>StateID</td>
<td>MFilesAPI.Number</td>
<td>In</td>
<td>Contains the workflow state identifier which can be used to recognize the process state in scripts related to the workflows.</td>
</tr>
<tr>
<td>StateTransitionID</td>
<td>MFilesAPI.Number</td>
<td>In</td>
<td>The ID of the state transition.</td>
</tr>
<tr>
<td>TransactionCache</td>
<td>MFilesAPI.NamedValues</td>
<td>In/Out</td>
<td>A container for optional name-value pairs stored for the duration of a single transaction. The container retains all the modifications, even if they were caused by an operation that was later canceled due to an error.</td>
</tr>
<tr>
<td>UserAccount</td>
<td>MFilesAPI.UserAccount</td>
<td>In</td>
<td>Vault user information.</td>
</tr>
<tr>
<td>UserGroupAdmin</td>
<td>MFilesAPI.UserGroupAdmin</td>
<td>In</td>
<td>Vault user group information.</td>
</tr>
<tr>
<td>ValueListItem</td>
<td>MFilesAPI.ValueListItem</td>
<td>In</td>
<td>Contains the value list value which is being processed in the event handler.</td>
</tr>
<tr>
<td>Variable</td>
<td>Data type</td>
<td>Mode</td>
<td>Use</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------</td>
<td>------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Vault</td>
<td>MFilesAPI.Vault</td>
<td>In</td>
<td>Represents the document vault used in running the script. With the identifier, the script is able to handle the document vault contents in the same way as is possible with the M-Files API interface. In an error situation, all changes made to the document vault through the Vault entity will be cancelled. The use of the Vault entity with scripts entails certain limitations. The scripts cannot, through the Vault entity, change the state of the object which the script is run to. The state change refers to checking out the object, checking in the object, undoing the check-out, and deleting and destroying the object. Also, all other objects that are checked out in the script must be checked in during running of the same script.</td>
</tr>
<tr>
<td>VaultSharedVariables</td>
<td>MFilesAPI.NamedValues</td>
<td>In/Out</td>
<td>A collection of named values stored in the document vault database. With the variable, the scripts can store their own values in the database so that they are also available to other scripts. The allowed data types for the named values are integer variables, Booleans, and strings. In the following example, the value 123 is stored as a named value and the number-based calculated value is then set as the value.</td>
</tr>
<tr>
<td>View</td>
<td>MFilesAPI.View</td>
<td>In</td>
<td>Contains the view which is being processed in the event handler.</td>
</tr>
</tbody>
</table>

### Property definitions not shown for scripts

The property definitions listed in the following table are not shown by using the PropertyValues variable in scripts:

<table>
<thead>
<tr>
<th>Name</th>
<th>ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status changed</td>
<td>24</td>
</tr>
<tr>
<td>Single file</td>
<td>22</td>
</tr>
<tr>
<td>Name</td>
<td>ID</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----</td>
</tr>
<tr>
<td>Deleted</td>
<td>27</td>
</tr>
<tr>
<td>Deleted by</td>
<td>28</td>
</tr>
<tr>
<td>Comment</td>
<td>33</td>
</tr>
<tr>
<td>Version label</td>
<td>29</td>
</tr>
<tr>
<td>Size on server (this version)</td>
<td>30</td>
</tr>
<tr>
<td>Size on server (all versions)</td>
<td>31</td>
</tr>
<tr>
<td>Marked for archiving</td>
<td>32</td>
</tr>
<tr>
<td>Collection members (documents)</td>
<td>46</td>
</tr>
<tr>
<td>Collection members (document collections)</td>
<td>47</td>
</tr>
<tr>
<td>Class groups</td>
<td>101</td>
</tr>
<tr>
<td>Assignment description</td>
<td>41</td>
</tr>
<tr>
<td>Deadline</td>
<td>42</td>
</tr>
<tr>
<td>Monitored by</td>
<td>43</td>
</tr>
<tr>
<td>Assigned to</td>
<td>44</td>
</tr>
<tr>
<td>Marked as complete by</td>
<td>45</td>
</tr>
<tr>
<td>Marked as rejected by</td>
<td>97</td>
</tr>
<tr>
<td>Workflow Assignment</td>
<td>79</td>
</tr>
<tr>
<td>Accessed by me</td>
<td>81</td>
</tr>
<tr>
<td>Favorite view</td>
<td>82</td>
</tr>
<tr>
<td>Object changed</td>
<td>89</td>
</tr>
<tr>
<td>Permissions changed</td>
<td>90</td>
</tr>
<tr>
<td>Version label changed</td>
<td>91</td>
</tr>
<tr>
<td>Version comment changed</td>
<td>92</td>
</tr>
<tr>
<td>Deletion status changed</td>
<td>93</td>
</tr>
<tr>
<td>Conflict resolved</td>
<td>96</td>
</tr>
<tr>
<td>Object changed for export</td>
<td>105</td>
</tr>
<tr>
<td>Object version changed for export</td>
<td>106</td>
</tr>
</tbody>
</table>

For example, the following piece of script results in a "not found" error:

```vbnet
Dim DeadlineValue
DeadlineValue = PropertyValues.SearchForProperty(42).TypedValue.DisplayValue
```

**Tip:** You can use the `GetProperties` method to get all the properties of a specific object.

**Execution Order of Scripts**

User-specified scripts in M-Files are executed in a specific order and the point in which they are executed depends on the event for which the script is written. See the lists below for the order in which events are by
default executed when a user performs a certain action in a vault. Note that the exact order and number of events that are triggered after a specific user action depend on the vault structure and the types of scripts used in the vault.

The user creates an object and immediately checks it in:

1. Property value validation
2. Calculating automatic property values
3. The BeforeCreateNewObjectFinalize event
4. Workflow state preconditions
5. Workflow state actions
6. The AfterCreateNewObjectFinalize event
7. The AfterCheckInChangesFinalize event

The user creates an object, then modifies its property values, and after that checks the object in:

1. Property value validation
2. Calculating automatic property values
3. The BeforeCreateNewObjectFinalize event
4. The AfterCreateNewObjectFinalize event
5. The BeforeSetProperties event
6. Property value validation
7. Calculating automatic property values
8. The AfterSetProperties event
9. The BeforeFileUpload event
10. The AfterFileUpload event
11. The BeforeSetProperties event
12. Calculating automatic property values
13. The AfterSetProperties event
14. The BeforeCheckInChanges event
15. Workflow state preconditions
16. Workflow state actions
17. The BeforeCheckInChangesFinalize event
18. The AfterCheckInChanges event
19. The AfterCheckInChangesFinalize event

The user modifies the property values and changes the workflow state of an object:

1. The BeforeCheckOut event
2. The AfterCheckOut event
3. The BeforeSetProperties event
4. Property value validation
5. Calculating automatic property values
6. The AfterSetProperties event
7. The BeforeCheckInChanges event
8. Previous workflow state postconditions
9. New workflow state preconditions
10. Workflow state actions
11. The BeforeCheckInChangesFinalize event
12. The AfterCheckInChanges event
13. The AfterCheckInChangesFinalize event
14. The BeforeReturnView event

If you have more than one event handler of the same type, you may change their execution order by selecting the event handler in the Event Handlers dialog and clicking either the up or down arrow button along the right side of the dialog:

![Event Handlers dialog](image)

3.2.11. Intelligent Metadata Layer

Intelligent Metadata Layer, abbreviated as IML, is a repository-neutral approach to intelligent information management that unifies information across different sources based on context, not on the system or folder in which the information is stored.

IML allows an M-Files user to connect to multiple different external repositories in addition to the traditional M-Files document vaults. By means of special vault applications known as connectors, the user can browse and edit content residing in external sources within the M-Files user interface.

IML provides automatic classification and metadata to your documents with the aid of so-called intelligence services that add a layer of artificial intelligence to M-Files. Intelligence services are vault applications that classify documents for you by determining the class of the document and suggesting metadata values by analyzing file content semantically and visually.

For a more thorough overview of IML, see the document Intelligent Metadata Layer.

Note: To use IML features, you need an appropriate Intelligent Metadata Layer license and Microsoft .NET Framework 4.5 or later installed on the M-Files server computer.
Note: Some M-Files applications that were released before M-Files 2018 may not be compatible with external repository content. Before taking IML into use, ensure that all your business-critical M-Files applications are compatible with content stored in external repositories.

Architecture of IML

The architecture of IML can be divided into three separate layers: the unified user experience layer on the top, the intelligent metadata layer in the middle, and the multi-repository backend at the bottom.

- **Unified User Experience Layer**
  - Easy and Engaging
  - Optimized for Your Device
  - Mobile and Offline Enabled

- **Intelligent Metadata Layer**
  - Core ECM Capabilities
  - Search Across Repositories
  - Automatic Metadata and Classification

- **Multi-Repository Backend**

The top layer, the **unified user experience layer**, serves to offer a unified user experience regardless of the repository in use. It allows information to be viewed and edited with the familiar M-Files Desktop, M-Files Web and M-Files Mobile user interfaces, no matter where the information resides.

The middle layer, also known as **Intelligent Metadata Layer**, is the central component in the IML architecture. It consists of all the essential enterprise content management capabilities, such as a versatile search interface, workflows, version history, checking out documents for editing, and a multi-repository search. The M-Files approach of classifying documents with metadata and categorizing content into metadata-based views allows documents to be found on the basis of what they are about instead of where they reside. The multi-repository search is the M-Files version of an enterprise search, allowing documents to be searched for across repositories.

The middle layer also adds artificial intelligence into the M-Files system. The so-called intelligence services offer means for automatic metadata suggestions and document classification by performing text and image analytics on content that is added to M-Files, and by applying machine learning on vault user behavior patterns. Intelligence services are vault applications that, when installed, can shoulder the burden of specifying metadata and classifying documents. Additionally, the IML application programming interface allows intelligence services to be developed by third parties so that they can be tailor-made to suit specific needs and environments of diverse organizations and businesses.

For more information on intelligence services, see **Intelligence Services**.
The bottom layer, the **multi-repository backend**, acts as an interface between M-Files and external repositories. By means of vault applications known as connectors, M-Files users are able to view and modify content in external repositories by using the M-Files user interface. Connectors establish connections between M-Files and external repositories and allow the user to view and edit content from various different external sources as though the user was operating within a single document vault.

For more information on connectors, see [Connectors](#).

**In this chapter**

- **Intelligence Services**
- **Connectors**
- **Connection to On-Premises Data from M-Files Cloud Vault**

**Intelligence Services**

Intelligence services are vault applications that are designed to analyze and classify documents and offer metadata suggestions based on file contents, existing metadata, and even user behavior. Intelligence services make use of technologies such as text analytics and machine learning to define and maintain document metadata for the user.

Intelligence services can operate in many ways and come into play in different situations. They can be tailor-made for M-Files, they can take advantage of a third-party component or an API, or connect to a third-party service to perform content analysis for M-Files.

Intelligence services are at work in the background, for example, when the user drags and drops a new document to M-Files or modifies a specific property value on the metadata card. In such instances, intelligence services analyze the contents of new documents and metadata modifications and offer metadata suggestions based on the analyses that they conduct.

If you for instance add a contract to M-Files, the intelligence service may automatically suggest contract to be used as the document class and propose values for customer and contact details, among other metadata fields, by deducing the information from the file contents. Users may then add suggested values as they see fit. This type of automation can significantly speed up the process of adding metadata for M-Files objects.

![Figure 137: Intelligence services aid you in tagging documents with metadata.](image)

As another example, when an image is added to M-Files, an intelligence service can conduct a visual analysis on the new image before the user fills in the metadata. The analysis identifies individual objects,
concepts and human faces as well as facial features in the image and generates a textual description
and subject labels of the image contents. The description and labels are in turn offered as metadata
suggestions for the description and keywords fields on the metadata card. The user can then add any
suggestions that she deems appropriate as metadata values and optionally edit the added values to further
specify the metadata.

Note: Metadata suggestions are not shown for users with a read-only license.

In this chapter

- Adding an Intelligence Service
- Configuring an Intelligence Service

Adding an Intelligence Service

Complete the following steps to add an intelligence service to a vault on the M-Files Server computer:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults.
4. Still in the left-side tree view, right-click the document vault of your choice and select Applications from
   the context menu.

   The Applications window is opened.

5. Click the Install... button.
6. Locate the application package stored on your computer and click Open.

   You are prompted to restart the document vault.

7. Click Yes at the prompt.
8. If you have any open sessions in the selected vault, you are prompted to close any open sessions. Click Yes.

The selected intelligence service is installed and should be listed in the Applications window. After the intelligence service has been successfully installed, it should be configured. For instructions on configuring an intelligence service, see Configuring an Intelligence Service.

**Configuring an Intelligence Service**

Intelligence services are configured in the M-Files Admin configurations editor. For instructions on using the editor, see Using the Configurations Editor.

Complete the following steps to configure an intelligence service:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, select Configurations.

5. In the gray navigation area, expand Intelligence Services and then select the intelligence service that you want to configure.

6. Open the Configuration tab, and then expand the General Settings section and edit the configuration as applicable:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Specifies whether the intelligence service is enabled or not.</td>
</tr>
<tr>
<td>Suggestions</td>
<td>These settings are used for mapping metadata suggestions with M-Files properties.</td>
</tr>
<tr>
<td>Maximum Processing Time in Seconds</td>
<td>The maximum amount of time in seconds that the intelligence service waits for the suggestions to be processed and generated before canceling the operation.</td>
</tr>
</tbody>
</table>

7. Expand the Service-Specific Settings section and edit the configuration as applicable.

*The settings under Service-Specific Settings vary across intelligence services. See service-specific instructions for more information.*
8. Click **Save** to save your configuration.

9. Take the vault offline and bring it back online:
   a) In the left-side tree view, right click the vault and select **Operations > Take Offline** from the context menu.
      
      If there are active user connections in the vault, click **Yes** at the prompt.
   b) In the left-side tree view, right click the vault and select **Operations > Bring Online** from the context menu.

Your configurations should now be effective and the intelligence service should be ready for use.

**Connectors**

Connectors establish a connection between M-Files and external repositories. They bring external data into the M-Files user interface and allow it to be viewed and modified in the same fashion as information is commonly processed in M-Files.

In other words, files in an external repository, such as a network folder, are displayed in M-Files like any other M-Files objects and they can be edited and enriched with metadata in the same manner as any other information residing in an M-Files document vault.

Objects in external repositories are by default **unmanaged**, meaning that they are not associated with M-Files metadata, but they can be easily **promoted** into **managed** objects by adding metadata. For more information, see Promoting Unmanaged Objects.

**In this chapter**

- Adding a Connector
- Configuring a Connector
- Increasing the Number of Allowed External Repository Connections
- Promoting Unmanaged Objects

**Adding a Connector**

Complete the following steps to add a connector to a vault on the M-Files Server computer:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**.
4. Still in the left-side tree view, right-click the document vault of your choice and select **Applications** from the context menu.

   The **Applications** window is opened.

   ![Applications Window](image)

5. Click the **Install...** button.

6. Locate the application package stored on your computer and click **Open**.

   You are prompted to restart the document vault.

7. Click **Yes** at the prompt.

8. If you have any open sessions in the selected vault, you are prompted to close any open sessions. Click **Yes**.

   The selected connector is installed and should be listed in the **Applications** window. After the connector has been successfully installed, it should be configured. For instructions on configuring a connector, see **Configuring a Connector**.

**Configuring a Connector**

Connectors are configured in the M-Files Admin configurations editor. For instructions on using the editor, see **Using the Configurations Editor**.

Complete the following steps to configure a connector:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

4. Still in the left-side tree view, select **Configurations**.
5. In the gray navigation area, expand **External Repositories** and then select the connector that you want to configure.

6. In the **Dashboard** tab, either:
   a. Click **Add Connection** to add a new connection.

      Note: You cannot add more connections than specified in the external repositories configuration. To increase the limit, see **Increasing the Number of Allowed External Repository Connections**.

   or

   b. Select an existing connection and click **Configure**.

7. Expand **General Settings** and edit the configuration as applicable:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Specifies whether the connection is enabled or not.</td>
</tr>
<tr>
<td>Display Name</td>
<td>The display name for the connection, shown in the listing area under External Views.</td>
</tr>
</tbody>
</table>
   | Authentication| Specifies the authentication type used for connecting to the external repository. The available options are:  
   |               | • Personal  
   |               | • Common  
   |               | • Anonymous  
   |               | See **External Repository Authentication** for further information.       |
   | Permissions   | These options allow you to use a default M-Files NACL for the objects in the external repository. |
### Setting Description

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Automatic Association</strong></td>
<td>These options allow you to automatically associate M-Files users with external users and user groups. This section consists of the following options:</td>
</tr>
<tr>
<td><strong>Association Methods</strong>: Allows you to specify association methods if common authentication is used. Supported values:</td>
<td></td>
</tr>
<tr>
<td><strong>username</strong>: Forms an association if an external username matches an M-Files username.</td>
<td></td>
</tr>
<tr>
<td><strong>User Association during Login</strong>: Allows the M-Files user to be associated with the external repository user when the user logs in to the repository via M-Files. This setting can be used if personal authentication is enabled.</td>
<td></td>
</tr>
<tr>
<td><strong>User Association with User Groups during Login</strong>: Allows external repository group memberships to be synchronized in M-Files when the user logs in to the repository using personal authentication.</td>
<td></td>
</tr>
<tr>
<td><strong>Replicate All User Groups</strong>: If enabled, all available user groups and the group hierarchy of the external repository is replicated to M-Files.</td>
<td></td>
</tr>
<tr>
<td><strong>Mapping</strong></td>
<td>These options are used for mapping objects in the external repository with M-Files objects, and external metadata with M-Files properties.</td>
</tr>
<tr>
<td>You can enter the value * in the <strong>External Type</strong> field of an object type mapping to use the same object type for all the external objects available via this connection.</td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong>: External files should be mapped to an M-Files object type that has the option <strong>Objects of this type can have files enabled</strong>. For more information on object type properties, see Creating a New Object Type.</td>
<td></td>
</tr>
<tr>
<td><strong>Search Indexing</strong></td>
<td>These options affect the way content in the external repository is indexed for searching.</td>
</tr>
</tbody>
</table>

8. Expand the **Connector-Specific Settings** section and edit the configuration as applicable.

- The settings under **Connector-Specific Settings** vary across connectors. See connector-specific instructions for details.

9. Optional: In the gray navigation area, right-click the connection and select **Authenticate Common User** from the context menu to add the common user credentials for accessing the repository.

10. Optional: In the gray navigation area, right-click the connection and select **Authenticate Indexer User** from the context menu to add the credentials that are used for indexing the contents of the repository.
11. In the gray navigation area, right-click the connection and select **Authenticate Permissions Retriever** from the context menu to add the credentials for fetching the external repository object permissions.

   ![](image)

   The option is displayed in the connector context menu only if the connector requires a permissions retriever to be assigned. Otherwise, only the options for authenticating a common user and an indexer user are shown.

12. Click **Save** to save your configuration.

13. Take the vault offline and bring it back online:
   a) In the left-side tree view, right click the vault and select **Operations > Take Offline** from the context menu.

   ![](image)

   If there are active user connections in the vault, click **Yes** at the prompt.

   b) In the left-side tree view, right click the vault and select **Operations > Bring Online** from the context menu.

Your configuration should now be effective. You can inspect the **Dashboard** tab to see the status of the external repository connection.

**In this chapter**

- **External Repository Authentication**

*External Repository Authentication*

Administrators must specify the type of authentication to be used for each external repository connection via M-Files Admin. The **Authentication** setting specifies the credentials that are used for accessing the external repository. Administrators can specify that **anonymous**, **common**, or **personal** authentication is used.

See also **External Repository Users** and **External Repository User Groups** for instructions on associating external repository users and user groups with M-Files users and user groups.

**Anonymous Authentication**

You must set the **Authentication** setting to **Anonymous** for repositories that do not need to authenticate users at all.

**Common Authentication**

The administrator specifies credentials that are stored in the M-Files vault database in encrypted format. These credentials are used for every M-Files user when they access the external repository via M-Files.

**Common** is the recommended authentication type in two scenarios:

- The external repository contains data that can be accessed by every M-Files vault user or a certain subset of vault users. Using this authentication type saves users from having to log in to the repository manually.
- The external repository must be made accessible for users that do not have credentials to the external repository. This might be the case, for example, when an organization wants to grant external subcontractors access to a network folder via M-Files that they would otherwise not have access to.

   - Using common authentication for this purpose may also require that the external users are granted access to the content via **named access control list**, as the common authentication only allows the
users to access the repository, not the actual content. Alternatively, the vault users that should be able to access the external content can be associated with the common external user.

**Personal Authentication**

When the type of authentication is set to **Personal**, the user is prompted to provide their credentials in the M-Files client when they access the external repository:

![Login dialog](image)

**Logging out from or Logging in to an External Repository**

To log out from or to log back in to an external repository that uses user-specific authentication, perform the following steps:

1. In M-Files Desktop, click the username in the top-right corner of the user interface.
2. Select **External Repositories** from the context menu.

   The **External Repositories** dialog is opened.

3. Select the external repository connection and either:
   a. Click **Log In** to log in to the repository to which you are no longer connected.
   or
   b. Click **Log Out** to log out of the repository to which you are currently connected.
4. Click **Close** to close the **External Repositories** dialog.
Increasing the Number of Allowed External Repository Connections

If you are using M-Files Cloud Vault, request our customer support (support@m-files.com) to increase the maximum number of connections if necessary.

To change the Maximum Number of Connections setting, you need to have the system administrator permissions.

1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select Configurations, and then in the gray navigation area, select Advanced Vault Settings.

2. Open the Configuration tab.

   The advanced vault settings are shown.
3. Expand **External Repositories**.

4. In **Maximum Number of Connections**, specify the number of allowed external repository connections.

5. Click **Save**.

**Promoting Unmanaged Objects**

External files that are not enriched with M-Files metadata are considered *unmanaged* files in M-Files. They can be viewed and modified in M-Files, but the changes are saved to the external repository only and M-Files Server will not maintain version history for such files.

When the user enriches an external file with M-Files metadata, the file is *promoted* to a managed external object in M-Files. Managed object files can be edited via the external system or via M-Files, but M-Files maintains version history of only the changes made via the M-Files system. Since the external repository may not support version history, M-Files Server stores old file versions within the M-Files system and only the latest version of the file is maintained in the external system.

**Note**: Unmanaged objects that are checked out for editing cannot be promoted. Before promoting an unmanaged object, make sure that the object is not checked out to you or someone else. See these instructions for more information.
Converting an unmanaged object into a managed object is as easy as changing the class of the object using the metadata card:

1. In M-Files Desktop, locate and select an unmanaged object either by using the search or External Views.

   The metadata card of an unmanaged object looks something like the following:

   ![Metadata Card Example](image)

   1. Make sure the object is not checked out for editing.

      a. If the object is checked out to you, you can right-click the object and select **Check In** or **Undo Checkout** from the context menu.

      or

      b. If the object is checked out to someone else, see the metadata card of the object to identify the user who has checked out the object, and then ask them to check it in.
3. Use the **Class** drop-down menu to change the class of the object.

4. Once you have changed the class, you may enrich the object with metadata as you see fit. The class that you select determines the default metadata properties of the object.

5. Click **Save** to save your changes.

The selected object in the external repository has now been promoted into a managed object.
Connection to On-Premises Data from M-Files Cloud Vault

If you are using M-Files Cloud Vault and need to access on-premises data or business applications, M-Files Ground Link provides an easy and safe method to establish the connection without a direct network path or a need for content migration.

With the Ground Link feature, you can access on-premises repositories in a cloud vault in the same manner as in on-premises environment. This is achieved by connecting a Ground Link proxy running on M-Files Server to the cloud vault.

![Diagram of Ground Link connection](image)

**Figure 139:** A Ground Link proxy allows a cloud vault to connect to private on-premises network folders (or other repositories) without a direct network path.

In short, to set up the Ground Link feature, you need to install external repository connectors to a Ground Link proxy and set up repository connections in the cloud vault. After that, you can access and edit the on-premises data through the connectors directly from the cloud vault. See the instructions below for details.

### Enabling Ground Link Connection

To set up the Ground Link feature, you first need to request M-Files customer support at support@m-files.com to enable the feature for your environment.

Complete the following steps to set up M-Files Cloud Vault to listen for connections from applications running in a Ground Link proxy.

1. Open M-Files Admin and access the document vault of your choice.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.

2. Select **Configurations** and then in the gray navigation area, expand **External Repositories**.

3. Expand **Ground Link** and finally select **Configuration**.

4. Specify the settings according to the information in the table below.

<table>
<thead>
<tr>
<th>Setting name</th>
<th>Description</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Specifies whether Ground Link is enabled or not.</td>
<td>Yes</td>
</tr>
<tr>
<td>Setting name</td>
<td>Description</td>
<td>Example value</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Shared Secrets</td>
<td>A pre-shared key that allows the Ground Link service to authenticate M-Files Cloud Vault. Make sure that the secret is complex and long enough to ensure information security. The shared secret is needed when specifying the settings of the Ground Link proxy. You can specify one or more shared secrets.</td>
<td></td>
</tr>
<tr>
<td>Timeouts &gt; Quick</td>
<td>The timeout value in seconds used for remote calls expected to return quickly.</td>
<td>15 (default value)</td>
</tr>
<tr>
<td>Timeouts &gt; Default</td>
<td>The standard timeout value in seconds used for most remote calls.</td>
<td>60 (default value)</td>
</tr>
<tr>
<td>Timeouts &gt; Extended</td>
<td>The timeout value in seconds used for remote calls expected to take a long time to return.</td>
<td>600 (default value)</td>
</tr>
<tr>
<td>Timeouts &gt; Custom</td>
<td>You can add custom timeout values for specific remote method calls if the method repeatedly times out, but is functioning correctly. We recommend that you do not add custom timeouts unless you know what you are doing.</td>
<td>Method Name: ICloudAgentV1.Ping() Timeout: 100</td>
</tr>
<tr>
<td>Keep Alive Interval</td>
<td>Specifies in seconds how frequently the cloud agent verifies the health of the remote application connections. If not changed, the default value is used.</td>
<td>60 (default value)</td>
</tr>
</tbody>
</table>

5. Click Save.

Now that the M-Files Cloud Vault has been configured for Ground Link, you can proceed to configuring the Ground Link proxy.

**Configuring Ground Link Proxy**

Complete the following steps to configure a Ground Link proxy.

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.
3. Still in the left-side tree view, select **Ground Link Proxies**. Click **New Ground Link Proxy**... on the right-side pane.

   - The **New Ground Link Proxy** dialog is opened.

4. Enter a name for the Ground Link proxy and select the database engine you want to use for storing Ground Link proxy data.

   - For more information, see [Database engine and data storage](#).

5. Click **OK** to close the **New Ground Link Proxy** dialog.

6. Install the connectors that your M-Files Cloud Vault will use to the newly created Ground Link proxy.

   - **Note:** When installing connectors that require a valid vault application license, the license will be for the cloud vault and for the cloud server even though the application is installed and the license is applied on the Ground Link proxy.

   - For more information, see [Installing and Managing Vault Applications](#).

   - If you want to access an on-premises network folder from M-Files Cloud Vault, you need to install the Network folder connector.

   - The Ground Link is set up and you can proceed to the actual configuration.

7. Select the newly created Ground Link proxy under **Ground Link Proxies** and open the **Configuration** tab.

8. Specify the settings according to the information in the table below.

<table>
<thead>
<tr>
<th>Setting name</th>
<th>Description</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Specifies whether Ground Link is enabled or not.</td>
<td>Yes</td>
</tr>
<tr>
<td>Password</td>
<td>The password required for applying a configuration for an on-premises connection from the cloud. You can choose the password freely.</td>
<td></td>
</tr>
<tr>
<td>Channel</td>
<td>Network Address</td>
<td>The location of the server to connect to.</td>
</tr>
<tr>
<td>Port number</td>
<td>The port the server is listening on. Make sure the necessary ports are open in the firewall.</td>
<td>7766</td>
</tr>
<tr>
<td>Secure</td>
<td>Indicates whether the server requires a secure (SSL encrypted) channel connection. Please note that using insecure connections in production environments is not recommended.</td>
<td>Yes</td>
</tr>
<tr>
<td>Setting name</td>
<td>Description</td>
<td>Example value</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Vault GUID</td>
<td>The GUID of the vault to open a channel with. You can view the vault GUID under the name of an existing vault in the <strong>Document Vault Properties</strong> dialog.</td>
<td>{990827D8-8AF2-4A4EB121-4C1A8A8ECD0}</td>
</tr>
<tr>
<td>Shared Secret</td>
<td>A secret value that allows the Ground Link service to authenticate applications connecting from this proxy. The channel connection is refused if it does not match one of the shared secrets configured for the Ground Link service being connected to. Copy the secret from the cloud vault configuration.</td>
<td></td>
</tr>
<tr>
<td>Reconnect Interval</td>
<td>Specifies in seconds how frequently the connection is attempted when the client is disconnected. If not changed, the default value is used.</td>
<td>60 (default value)</td>
</tr>
<tr>
<td>Keep Alive Interval</td>
<td>Specifies in seconds how frequently the Ground Link service ensures the connection is still alive. If not changed, the default value is used.</td>
<td>60 (default value)</td>
</tr>
<tr>
<td>Timeout Interval</td>
<td>The timeout values specify how long remote calls will wait for a response. We strongly recommend that you use the default values.</td>
<td></td>
</tr>
<tr>
<td>Timeouts &gt; Quick</td>
<td>The timeout value in seconds used for remote calls expected to return quickly.</td>
<td>15 (default value)</td>
</tr>
<tr>
<td>Timeouts &gt; Default</td>
<td>The standard timeout value in seconds used for most remote calls.</td>
<td>60 (default value)</td>
</tr>
<tr>
<td>Timeouts &gt; Extended</td>
<td>The timeout value in seconds used for remote calls expected to take a long time to return.</td>
<td>600 (default value)</td>
</tr>
<tr>
<td>Timeouts &gt; Custom</td>
<td>You can add custom timeout values for specific remote method calls if the method repeatedly times out, but is functioning correctly. We recommend that you do not add custom timeouts unless you know what you are doing.</td>
<td>Method Name: ICloudAgentV1.Ping()</td>
</tr>
<tr>
<td></td>
<td>Timeout: 100</td>
<td></td>
</tr>
</tbody>
</table>

9. Click **Save**.

Once you have configured both the **cloud vault** and the Ground Link proxy, the connection is established and you are able to set up the desired repository services in the cloud vault.

You can see the status of the cloud vault connection on the **Dashboard** tab.
Configuring Connectors over Ground Link

The example below tells you how to configure the Ground Link Network folder connector in the cloud vault. For information on support for other connectors, contact M-Files customer support at support@m-files.com or the connector provider.

1. Open M-Files Admin and access the cloud vault that is connected to the Ground Link proxy of your choice.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

2. Select Configurations and then in the gray navigation area, expand External Repositories and select Ground Link.
   
   On the Dashboard tab, you see the connected Ground Link proxies and the available Ground Link connectors. Make sure the proxy service you want to configure, in this case Network Folder, is online.

3. In the gray navigation area, expand first the Ground Link node and then the Ground Link proxy whose services you want to utilize in the cloud vault.

4. Still in the gray navigation area, select the remote services, in this case Network Folder, you want to configure.

5. Select Add Connection on the Dashboard tab. A confirmation dialog is opened. Select OK.

6. Click Configure on the Dashboard tab to configure the new connection. For further information, refer to Installing and Configuring M-Files Network Folder Connector.

7. Once you are done, click Save.

8. Click Apply to apply the configurations. The Enter Password dialog is opened. Give the password defined in the Ground Link proxy configuration.

9. Optional: Authenticate background users as described in the Installing and Configuring M-Files Network Folder Connector instruction. After providing the credentials, save and apply the settings again.

10. Click Save.

11. Optional: Repeat the steps from 4 to 10 to add another connection to the Ground Link proxy service.

Now you can access the on-premises network folder(s) from the cloud vault. The objects in the repository are displayed in M-Files like any other M-Files objects and they can be edited and enriched with metadata in the same manner as any other information residing in an M-Files document vault.

Disabling Ground Link Connection

If you want to disable the Ground Link feature in a cloud vault, follow the instructions below.

1. Open M-Files Admin and access the document vault of your choice.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

2. Select Configurations and expand Advanced Vault Settings.
3. Expand the **Configuration** node and select **Ground Link**.

4. On the **Configuration** tab, set the **Enabled** value to **Yes**.

5. Click **Save**.

6. Take the vault offline and bring it back online:
   a) In the left-side tree view, right click the vault and select **Operations > Take Offline** from the context menu.
      
      If there are active user connections in the vault, click **Yes** at the prompt.
   b) In the left-side tree view, right click the vault and select **Operations > Bring Online** from the context menu.

### 3.2.12. Customizing Server and Vault Behavior

This section collects Microsoft Windows registry settings, M-Files named value settings, and advanced vault settings that you can apply on the M-Files server computer to customize the behavior of M-Files Server and the vaults.

**Note:** You need M-Files Named Value Manager for distributing named value settings. For downloading the application as well as for instructions on using it, see the document *Distributing Vault-Specific Registry Settings from M-Files Server*.

#### In this chapter

- Enabling Co-Authoring
- Preventing Users from Toggling the Location of the Metadata Card
- Setting a Primary File Type for Multi-File Documents
- Enabling Metadata Field Updates for M-Files Web and M-Files Mobile
- Configuration Options for Public Links
- Configuration Options for the "Send and Save to M-Files" Button
- Disabling the Reference Direction Setting for Grouping Levels
- Enabling Phonic and Fuzzy Searches
- Setting Up Synonym Search
- Disabling the Search for Inflected Forms
- Disabling the Sorting of Search Results by Their Relevance
- Configuring Automatic Updates via Registry Settings
- Modifying PDF Conversion Limitations
- Defining File Types for Indexing
- Specifying Vault-Specific Locale Settings for Server-Side PDF Conversions
- Preventing Linked Documents from Being Removed
- Registry Setting for Extending Firebird Usability
- Settings for Vault Performance Measurement

#### Enabling Co-Authoring

To use co-authoring in your vault as instructed in *Checking Out a Document for Co-Authoring*, you first need to enable Microsoft Office for the web tools and co-authoring via Microsoft Office for the web in your vaults.

If you are using M-Files Cloud Vault, request our customer support (support@m-files.com) to enable these features.
If you want to enable co-authoring in Microsoft Office for your on-premises vaults, follow the instructions in the document Enabling Microsoft Office for the Web Services for M-Files Web for achieving the following results:

- **Office Online Server** is deployed
- **M-Files Web** is set to use Microsoft Office for the web services

**Note:** M-Files Desktop uses M-Files Web in the background for co-authoring. In other words, even though the above-mentioned document discusses M-Files Web only, the same procedures must be carried out for co-authoring to work in M-Files Desktop as well.

After you are done with the tasks described in the above-mentioned document, follow the steps provided in this section to set up your on-premises vault to use Microsoft Office based co-authoring.

1. In M-Files Admin, access the custom vault data section.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select **Configurations**, and then in the gray navigation area, expand **Custom Vault Data**.

2. Select **Namespace Registry > Configuration**.

3. Expand the **Namespaces** node, click **Add Namespace**, and expand the newly added namespace node.

4. In the **Group** field, type a suitable group name, such as **Co-authoring**.

5. Use the **Storage Type** drop-down menu to select the **MFConfigurationValue** storage.

6. In the **Namespace** field, enter the following value: **M-Files.Core.CoAuthoring.Configuration**

7. In the **Namespace Label** field, type a suitable label, such as **Co-authoring**.

8. In the **Namespace Description** field, enter for example **Settings related to co-authoring**.

9. Click **Save** to save the namespace settings.

10. In the gray navigation area, expand **Named Values**.

11. Expand the namespace group you just created, then select the namespace node, and finally the **Configuration** node.
12. Click **Add Named Value**, and expand the newly created named value node.

13. In the **Name** field, enter the value **WOPI**.

14. In the **Value** field, enter the co-authoring configuration according to the values explained in the table below and the example given below the table.

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
<th>Example value</th>
</tr>
</thead>
<tbody>
<tr>
<td>WopiRESTServer</td>
<td>The address of the server hosting M-Files Server and M-Files Web. M-Files Desktop communicates with this server via REST for starting the co-authoring process, as well as for opening the page hosting the Office Online editor.</td>
<td>myserver.mycompany.com</td>
</tr>
<tr>
<td>WopiRESTServerFolder</td>
<td>The REST server folder. This should be set to /REST/ in most cases.</td>
<td>/REST/</td>
</tr>
<tr>
<td>UrlSrc</td>
<td>The REST endpoint of M-Files Web communicating with Office Online Server. The value is entered in the following format: https://&lt;your M-Files Web server address&gt;</td>
<td><a href="https://myserver.mycompany.com/">https://myserver.mycompany.com/</a></td>
</tr>
<tr>
<td>MainAppURL</td>
<td>A confirmation page is opened based on this URL after the user closes the co-authoring page.</td>
<td><a href="https://myserver.mycompany.com/">https://myserver.mycompany.com/</a></td>
</tr>
<tr>
<td>UseHttps</td>
<td>Specifies whether HTTPS is used for communication. This should be set to true in most cases.</td>
<td>true</td>
</tr>
<tr>
<td>Note: The value must not contain quotation marks.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WopiServerPort</td>
<td>The port used for REST requests. This should be set to 443 in most cases.</td>
<td>443</td>
</tr>
<tr>
<td>OperationTimeoutInMs</td>
<td>Specifies in milliseconds the time that M-Files Desktop should wait for Microsoft Office operations to complete. If exceeded, M-Files gives up and shows a timeout error. This is an optional setting, and if it is not included in the configuration at all, the default timeout of 10 seconds is used.</td>
<td>10000</td>
</tr>
</tbody>
</table>

The configuration should be entered in the same format as the example below:

```json
{
    "WopiRESTServer": "myserver.mycompany.com",
    "WopiRESTServerFolder": "/REST/",
    "UrlSrc": "https://myserver.mycompany.com/",
    "MainAppURL": "https://myserver.mycompany.com/",
    "UseHttps": true,
    "WopiServerPort": 443,
    "OperationTimeoutInMs": 10000
}```
15. Click **Save** to save the configuration.

The integration with Microsoft Office for the web is now in use in the vault. End users can check out documents for co-authoring as instructed in **Checking Out a Document for Co-Authoring** as soon as they have logged out from and logged back in to the vault. You can log out all vault users by **restarting the vault**, but taking a vault offline should always be done in a controlled manner and the vault users should be notified beforehand.

**Troubleshooting for Enabling Co-Authoring**

**No co-authoring command in M-Files Desktop**

If the command for starting co-authoring is not visible in M-Files Desktop, make sure that

- the value for **UseHttps** does not contain quotation marks.
- you are using neutral quotation marks (" ) in your configuration.
- the values for **UrlSrc**, **MainAppURL**, and **WopiRESTServer** point to your M-Files Web server.

**Preventing Users from Toggling the Location of the Metadata Card**

You can prevent users from toggling the location of the metadata card between the right pane and the bottom pane by disabling the **Show Metadata in Bottom Pane** option in the **View > Display Mode** menu.

![Note: You can also hide the Toggle Metadata Card Location command in the metadata card option ribbon by defining a metadata card configuration rule that sets Is Hidden to Yes for the Location Button definition. For more information on metadata card configuration rules, see Metadata Card Configuration.](image)

To disable the **Show Metadata in Bottom Pane** option in the **View > Display Mode** menu, complete the following steps:

1. Open M-Files Named Value Manager.
2. Use the Server drop-down menu to select the M-Files server and then the Vault drop-down menu to select the document vault.
3. Use the Storage Type drop-down menu to select the MFConfigurationValue storage.
4. In the Namespace field, enter the following value: M-Files.Core.Client.Settings
5. Click Add... to add a new key.
6. In the left-side pane, double-click **New Named Value Key** and enter the following value: MetaDataPositionOverride
7. Select the newly added key, and in the right-side pane, enter the following value:

```json
{
  "MFSHELL": {
    "MetaDataPositionOverride": {
      "DoNotShowMetadataInBottomPane": 1
    }
  }
}
```
Your configuration in M-Files Named Value Manager should now be similar to the example shown below.

8. Click **Save** and then close M-Files Named Value Manager if you no longer need it.

The **Show Metadata in Bottom Pane** option in the **View > Display Mode** menu is now disabled and grayed out in the selected vault.

**Setting a Primary File Type for Multi-File Documents**

You can set a file type of your choice to act as the primary file type for multi-file documents in the vault. This makes

- the icon of the specified file type to be shown as the icon of the multi-file document.
- the **Preview** tab to show the preview of the primary file when the multi-file document is selected.
- double-clicking the object perform the default action of the primary file type.

**Note:** This feature is supported in M-Files Desktop only. The common Windows dialogs, such as **Open** or **Save As**, are not affected by the primary file type settings.

To specify a primary file type to be used in a vault of your choice, do the following steps on the M-Files server computer:
1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select Configurations, and then in the gray navigation area, select Advanced Vault Settings.

2. Open the Configuration tab.

   ✔️ The advanced vault settings are shown.
3. Expand **Multi-File Documents** and select **Primary Files**.

4. Click **Add Document Class**.

5. Expand the newly created node and select a class value for the **Document Class** setting.
   
   This value specifies the object class to which the setting applies.

6. Expand **File Name Filters** and click **Add Filter**.
   
   These filtering settings specify the primary file type for the selected class.
7. Expand the newly created node and specify a value for the Filter setting.

The value can include wildcard characters, for example: `order-?.txt` or `*.pdf`.

Enter only a single value for each setting node. You can, however, add as many setting nodes with the Add Filter command as you need.

The filtering values are evaluated from top to bottom. You can move a setting up or down by right-clicking it (the node level under File Name Filters) and selecting Move Up or Move Down in the context menu.

8. Click Save once you are done with your changes.

9. Restart the vault to take the settings into effect.

Note: Taking a vault offline should always be done in a controlled manner and the vault users should be notified beforehand.

Multi-file documents of the selected class stored in this vault and any connected external repositories now use the specified file type as their primary file and behave as described at the top of this section. If the document contains more than one file matching the filtering conditions, the file that has been added first is used as the primary file.

**Enabling Metadata Field Updates for M-Files Web and M-Files Mobile**

You can insert metadata properties to Microsoft Word, Microsoft Excel, and Microsoft PowerPoint documents using the M-Files for Microsoft Office plugin that is installed along with M-Files Desktop.

You can set up fields in Microsoft Word, Microsoft Excel, and Microsoft PowerPoint documents in which the selected M-Files properties are filled in automatically. For example, you can select a customer name and address from the document properties and insert them as the recipient's contact information in a proposal. This feature is often used with documents created from templates to speed up filling documents with a lot of recurring information.

For more information on this feature, see Insert M-Files Property.

You can enable this feature in M-Files Web and M-Files Mobile so that metadata fields in Microsoft Word and Microsoft Excel documents are filled and updated when new documents are created or existing documents are modified in either M-Files Web or M-Files Mobile. Note that enabling this feature in M-Files Web and M-Files Mobile may have a negative impact on performance in some environments.

To enable the feature, complete the following steps on the M-Files server computer:
1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select **Configurations**, and then in the gray navigation area, select **Advanced Vault Settings**.

2. Open the **Configuration** tab.
   - The advanced vault settings are shown.
3. Expand **File Operations** > **Extension Filter for Embedded Metadata Update on Check-In**.

4. Click **Add Extension**.

5. In the **Extension** field, enter the file extension, for instance `docx`.

   The valid values are `doc`, `docx`, `xls`, `xlsx`, and `ALL`.

   **Tip:** The value `ALL` allows the metadata update for all file types at the same time. If you set the value `ALL`, you cannot have any other file extensions set.

6. Repeat the steps 4 and 5 for each file extension.

7. Click **Save** to save your configuration.

**Configuration Options for Public Links**

The registry settings listed here can be used to enable or disable the **Share Public Link** feature as well as to enable or disable specific sharing options for public links. For more information on public links, see **Sharing Public Links**.
Complete the following steps to configure the **Share Public Link** feature:

1. Add or modify the following registry setting on the M-Files Server computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
<th>Value type</th>
<th>Description</th>
</tr>
</thead>
</table>
   | HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files \<version>\Server\MFServer | EnableSharedPublicLinks | REG_DWORD | Enables or disables the **Share Public Link** feature on the server side. When disabled, public links cannot be generated via clients or APIs. Also, previously shared public links stop working if the feature is disabled.
   |
   | Default value | 1 | | |
   | Valid values | 1 | The **Share Public Link** option is enabled. | |
   | | 0 | The **Share Public Link** option is disabled. | |

2. Use Windows Task Manager to restart the **MFServer** service:
   a) Right-click the taskbar and select **Task Manager** from the context menu.
   
      ![The Task Manager window is opened.](image)

   b) Open the **Services** tab.
   c) Right-click the **MFServer** service and select **Restart** from the context menu.

After you have configured the **Share Public Link** feature for M-Files Server, use M-Files Named Value Manager to configure public links for M-Files Desktop and M-Files Web:

3. Open M-Files Named Value Manager.

4. Use the **Server** drop-down menu to select the M-Files server and then the **Vault** drop-down menu to select the vault.

5. Use the **Storage Type** drop-down menu to select the **MFConfigurationValue** storage.

6. In the **Namespace** field, enter the following value: **M-Files.Core.Sharing.PublicLinks.Settings**

   To disable or enable the **Share Public Link** feature, complete the steps 7 to 9:

7. Click **Add...** to add a new key.

8. In the left-side pane, double-click **New Named Value Key** and enter the following value: **Enabled**
9. Complete either of the following steps:

a. If you want to disable the **Share Public Link** feature, select the newly added key and add the following value to the right-side pane:

   ```
   false
   ```

   **Note:** If you disable the **Share Public Link** feature, make sure that you also apply the corresponding registry setting for M-Files Server (see the steps 1 to 2).

   or

b. If you want to enable the **Share Public Link** feature, select the newly added key and add the following value to the right-side pane:

   ```
   true
   ```

   **Note:** The **Share Public Link** feature is enabled by default, so normally you do not have to explicitly enable the feature.

To specify whether public links are allowed to point to the latest version of shared files or only to the specific version that user has shared, complete the steps from 10 to 12:

10. Click Add... to add a new key.

11. In the left-side pane, double-click **New Named Value Key** and enter the following value:

    AllowSharingLatestVersion

12. Complete either of the following steps:

a. If you want to allow public links to point to the latest version of the shared file, select the newly added key and add the following value to the right-side pane:

   ```
   true
   ```

   or

b. If you want public links to always point to the specific file version that the user has shared, select the newly added key and add the following value to the right-side pane:

   ```
   false
   ```

   **Note:** By default, public links always point to the specific version that the user has shared, so normally you do not have to set AllowSharingLatestVersion to false.

To specify the default expiration time for public links in M-Files Web, complete the steps 13 to 16:

13. In the **Namespace** field, enter the following value: M-Files.Core.Client.Settings

14. Click Add... to add a new key.

15. In the left-side pane, double-click **New Named Value Key** and enter the following value:

    DefaultExpireInDays
16. Select the newly added key and add the expiration time in days to the right-side pane as an integer, for instance:

   10

   In the example above, the default expiration time for public links is 10 days. The user can always change the expiration date in the **Share Public Link** dialog.

After you have configured the **Share Public Link** feature, the vault has to be taken offline and brought back online for the changes to become effective.

17. Take the vault offline and bring it back online:
   a) In the left-side tree view, right click the vault and select **Operations > Take Offline** from the context menu.

   If there are active user connections in the vault, click **Yes** at the prompt.

   b) In the left-side tree view, right click the vault and select **Operations > Bring Online** from the context menu.

The **Share Public Link** feature is now configured according to the configuration options that you have specified.

**Configuration Options for the "Send and Save to M-Files" Button**

Using M-Files Named Value Manager, you may add the **Send and Save to M-Files** button to the Microsoft Outlook composer window on all client computers, or disable the **Send and Save to M-Files** button altogether. For more information on the **Send and Save to M-Files** function, see [Functions in Microsoft Outlook](#). For downloading the tool as well as for instructions on using it, see the document [Distributing Vault-Specific Registry Settings from M-Files Server](#).

Complete the following steps to configure the **Send and Save to M-Files** button for all client computers:

1. Open M-Files Named Value Manager.
2. Use the **Server** drop-down menu to select the M-Files server and then the **Vault** drop-down menu to select the document vault.
3. Use the **Storage Type** drop-down menu to select the **MFConfigurationValue** storage.
4. In the **Namespace** field, enter the following value: `M-Files.Core.Client.Settings`
5. Click **Add...** to add a new key.
6. In the left-side pane, double-click **New Named Value Key** and enter the following value:

   MSOutlookRibbon
7. Select the newly added key, and then either:
   a. If you want to display the **Send and Save to M-Files** button in the Microsoft Outlook composer window on all client computers, add the following value to the right-side pane:

   ```
   "Common": {
      ```
b. If you want to disable the **Send and Save to M-Files** button on all client computers, add the following value to the right-side pane:

```json
{
    "Common": {
        "MSOutlookRibbon": {
            "ShowSendAndSaveInMFilesTab": 0
        }
    }
}
```

8. Click **Save** and then close M-Files Named Value Manager if you no longer need it.

The **Send and Save to M-Files** button settings you have specified affect all vault users in the selected vault.

**Disabling the Reference Direction Setting for Grouping Levels**

When you are creating or editing a grouping level for a view, the **Define Grouping Level** dialog normally shows the **Reference direction** setting that allows you to select the metadata reference direction between the object type of the grouping level and the objects in the view. You can use a Windows registry setting to disable this option and therefore only allow the **To <selected object type>** reference direction to be used.

Do the following to disable the **Reference direction** setting in the **Define Grouping Level** dialog:

1. Add the following setting to the Windows registry of the server computer:

   ```ini
   [HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server\MFServer\VaultOptions\<vault GUID>]
   EnableReverseGroupingLevelsForViews REG_DWORD
   ```

2. Repeat step 1 for as many vaults as needed.
3. Use Windows Task Manager to restart the **MFServer** service:
   a) Right-click the taskbar and select **Task Manager** from the context menu.
   
   ✓ The **Task Manager** window is opened.
   
   b) Open the **Services** tab.
   c) Right-click the **MFServer** service and select **Restart** from the context menu.

**Enabling Phonic and Fuzzy Searches**

Phonic and fuzzy searches are disabled by default and can be enabled by setting a registry key on the M-Files server computer.

≡ **Note:** This feature is supported only by the dtSearch search engine.

Do the following steps to enable phonic searches, fuzzy searches, or both:

1. Either:
   a. To enable fuzzy or phonic searches at the server level, add the following registry key:
      ```
      HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server\MFServer\FullTextSearch
      ```
      
      or
   
   b. To enable fuzzy or phonic searches at the vault level, add the following registry key:
      ```
      HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server\MFServer\Vaults\<vault GUID>\FullTextSearch
      ```

2. Add one or both of the following values under the key specified in step 1:

<table>
<thead>
<tr>
<th>Value name</th>
<th>Valid values</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phonic</td>
<td>1</td>
<td>REG_DWORD</td>
<td>1 enables phonic searching. 0 disables phonic searching.</td>
</tr>
<tr>
<td></td>
<td>0 (default)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Fuzzy</td>
<td>1</td>
<td>REG_DWORD</td>
<td>1 enables fuzzy searching. 0 disables fuzzy searching.</td>
</tr>
<tr>
<td></td>
<td>0 (default)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

3. Use Windows Task Manager to restart the **MFServer** service:
   a) Right-click the taskbar and select **Task Manager** from the context menu.
   
   ✓ The **Task Manager** window is opened.
   
   b) Open the **Services** tab.
   c) Right-click the **MFServer** service and select **Restart** from the context menu.
Setting Up Synonym Search

For vault users to be able to find documents using synonyms in the search query, the synonym search feature must first be enabled on the M-Files server computer and a custom thesaurus must be constructed.

**Note:** You must use the dtSearch engine to use this feature. Enabling synonym search may have a negative impact on the performance of the search, especially if your thesaurus is large.

Complete the following steps to enable and set up synonym search:

1. Make the following registry change on the M-Files server computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server\MFServer\FullTextSearch</td>
<td></td>
</tr>
<tr>
<td>Value name</td>
<td>Thesaurus</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_SZ</td>
</tr>
<tr>
<td>Description</td>
<td>The filename of the thesaurus file.</td>
</tr>
<tr>
<td>Value</td>
<td>thesaur.xml</td>
</tr>
</tbody>
</table>

2. Use a text editor to create your own custom thesaurus file in the following fashion:

   ```xml
   <?xml version="1.0" encoding="UTF-8" ?>
   <dtSearchUserThesaurus>
   <Item>
   <Name>Synonyms for announcement</Name>
   <Synonyms>announcement notice bulletin statement publication</Synonyms>
   </Item>
   <Item>
   <Name>Synonyms for contract</Name>
   <Synonyms>contract agreement deal arrangement</Synonyms>
   </Item>
   </dtSearchUserThesaurus>
   ```

   Each Item element contains a synonym group.

   Use the Name element to enter a name for the synonym group. The name is used only for identifying the group and it has no effect on search.

   Use the Synonyms element to list the words belonging to a single synonym group. That is, list words that are synonymous of each other. Separate the words with a space.

3. Save the thesaurus file as thesaur.xml to the following location:

   C:\Program Files\M-Files\<version>\Server\<language code of the search language>\
4. Use Windows Task Manager to restart the **MFServer** service:
   a) Right-click the taskbar and select **Task Manager** from the context menu.
   
   ✔️ The Task Manager window is opened.
   
   b) Open the **Services** tab.
   
   c) Right-click the **MFServer** service and select **Restart** from the context menu.

Now when users search for **announcement**, the search results list documents containing the words **announcement**, **notice**, **bulletin**, **statement**, or **publication**. Synonyms are identified in both document contents and metadata.

**Disabling the Search for Inflected Forms**

By default, M-Files searches for inflected forms of your search term (see **Quick Search** for more information). This feature can be disabled by unchecking the option **Look for different inflected forms of the words in Quick Search** in the **Additional Conditions** dialog. If you want this feature to be disabled by default for all vault users, complete the steps below on the M-Files server computer.

**Note:** You need M-Files Named Value Manager for distributing these settings. For downloading the application as well as for instructions on using it, see the document **Distributing Vault-Specific Registry Settings from M-Files Server**.

1. Open M-Files Named Value Manager.
2. Use the **Server** drop-down menu to select the M-Files server and then the **Vault** drop-down menu to select the document vault.
3. Use the **Storage Type** drop-down menu to select the **MFConfigurationValue** storage.
4. In the **Namespace** field, enter the following value: **M-Files.Core.Client.Settings**
5. Click **Add...** to add a new key.
6. In the left-side pane, double-click **New Named Value Key** and enter the following value: **SearchBar**
7. Select the newly added key, and in the right-side pane, enter the following value:

   ```json
   { 
     "MFShell": { 
       "SearchBar": { 
         "DefaultStemmingEnabled": false 
       } 
     } 
   }
   ``

   Your configuration in M-Files Named Value Manager should now be similar to the example shown below.
8. Click **Save** and then close M-Files Named Value Manager if you no longer need it.

The search for inflected forms is now disabled by default in the selected vault for all vault users.

**Disabling the Sorting of Search Results by Their Relevance**

By default, M-Files sorts search results by their relevance. For more information on how document relevance in relation to the search term is determined, see [Search result sorting](#).

**Note:** You need M-Files Named Value Manager for distributing some of the settings. For downloading the application as well as for instructions on using it, see the document [Distributing Vault-Specific Registry Settings from M-Files Server](#).

This behavior can be prevented so that search results are sorted by user preference instead. Make the following changes on the M-Files Server computer to prevent search results to be automatically sorted by their relevance:

1. Open M-Files Named Value Manager.

2. Use the **Server** drop-down menu to select the M-Files server and then the **Vault** drop-down menu to select the document vault.

3. Use the **Storage Type** drop-down menu to select the **MFConfigurationValue** storage.

4. In the **Namespace** field, enter the following value: `M-Files.Core.Listing.SearchResults`

5. Click **Add...** to add a new key.

6. In the left-side pane, double-click **New Named Value Key** and enter the following value:

   `RememberSearchResultsSortingCriteria`
7. Select the newly added key, and in the right-side pane, enter the following value: true

Your configuration in M-Files Named Value Manager should now be similar to the example shown below.

8. Click Save and then close M-Files Named Value Manager if you no longer need it.

9. Optional: If you are using M-Files Web, make the following registry change on the M-Files server computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server \MFWA\Sites\1\Vaults&lt;vault GUID&gt;\Configurations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>DefaultSearchSortPropertyID</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_SZ</td>
</tr>
<tr>
<td>Description</td>
<td>The ID of the property by which search results are sorted.</td>
</tr>
<tr>
<td>Value</td>
<td>&lt;no value&gt; Empty the value to disable the sorting of search results by their relevance in M-Files Web.</td>
</tr>
</tbody>
</table>

10. Use Windows Task Manager to restart the MFServer service:
    a) Right-click the taskbar and select Task Manager from the context menu.

    The Task Manager window is opened.
    b) Open the Services tab.
    c) Right-click the MFServer service and select Restart from the context menu.

M-Files no longer forces search results to be sorted by their relevance, and therefore users can change the column by which search results are sorted and the user preference is retained in subsequent searches.
Configuring Automatic Updates via Registry Settings

In addition to using the Automatic Updates window, you can configure automatic updates on both the server computer and client computers via Microsoft Windows registry settings. For more information on automatic updates, see Updating M-Files.

Tip: In Microsoft Windows, you can use Group Policy Objects for distributing registry settings to multiple computers.

Disabling or enabling automatic updates

You can disable or enable the automatic updates by adding or editing the following registry setting on the target computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
<th>Value type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\Common\Updates</td>
<td>Enabled</td>
<td>REG_DWORD</td>
<td>If the value is set to 0, automatic updates disabled on the target computer, including manual update checks by using the Automatic Updates window. You can update the software by downloading and running the installation package by hand.</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>Updates are disabled on the computer.</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Updates are enabled on the computer.</td>
<td></td>
</tr>
</tbody>
</table>

Disabling or enabling automatic update downloads

You can disable or enable the automatic downloading of updates by adding or editing the following registry setting on the target computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
<th>Value type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Common\MFAUClient</td>
<td>EnableUpdates</td>
<td>REG_DWORD</td>
<td>If the value is set to 0, M-Files no longer downloads updates automatically, but you can run the update check manually via the Installation tab in the Automatic Updates window.</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>M-Files does not check for new versions automatically.</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>M-Files automatically checks for updates and downloads a new version if one is available.</td>
<td></td>
</tr>
</tbody>
</table>

Disabling or enabling automatic update installations

You can disable or enable the automatic installation of updates by adding or editing the following registry setting on the target computer:
Key  | HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Common \MFAUClient
---|---
Value name  | AllowToUseAutoInstallationFeature
Value type  | REG_DWORD
Description  | If the value is set to 0, installing automatic updates is disabled and only the Download updates automatically option is available on the Settings tab in the Automatic Updates window. You can still install updates via the Installation tab in the Automatic Updates window.
Default value  | 1 (M-Files Online)
               | 0 (M-Files 2018)
Valid values  | 1 Installing automatic updates is enabled.
               | 0 Installing automatic updates is disabled.

Disabling or enabling automatic update options in the user interface

You can disable the automatic update options in the Automatic Updates window on the Settings tab by adding or editing the following registry setting on the target computer:

| Key  | HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Common \MFAUClient
---|---
| Value name  | CanConfigureAutoInstallingViaUi
| Value type  | REG_DWORD
| Description  | If the value is set to 0, the settings shown on the Settings tab in the Automatic Updates window cannot be changed.
| Default value  | 1 (Windows Server)
               | 0 (other operating systems)
| Valid values  | 1 Settings shown on the Settings tab in the Automatic Updates window can be changed.
               | 0 Settings shown on the Settings tab in the Automatic Updates window cannot be changed.

Controlling the installation deadline

If need be, you can adjust the installation deadline and the amount of time by which users can delay the installation. Add the following registry settings on the target computer to adjust the installation deadline:

| Key  | HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Common \MFAUClient
---|---
| Value name  | PostponeDurationInHours
| Value type  | REG_DWORD
| Description  | Users can delay the installation process once before it is started. Modify this value to change the number of hours by which users can delay the installation process by selecting Update Later in the options dialog.
The default value for the additional delay is 10 hours.

Valid values

Any number of hours.

### Defining the installation schedule

You may select the preferred days and time of installing M-Files updates. It is recommended that you select a date and time that is outside working hours so that installing updates does not interrupt daily M-Files tasks in the organization.

Note that the computer must be running and not in sleep or hibernate mode when the update is scheduled to be installed. If the computer is not running when the scheduled installation time occurs, the update is attempted to be installed or scheduled the next time the computer is started.

Add the following registry settings on the target computer to define an installation schedule:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Common \MFAUClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>AutoInstallDays</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_SZ</td>
</tr>
<tr>
<td>Description</td>
<td>One or more days when automatic updates are attempted to be installed. Separate multiple values with a semicolon.</td>
</tr>
<tr>
<td>Default value</td>
<td>mon;Tue;Wed;Thu;Fri;Sat;Sun</td>
</tr>
<tr>
<td>Valid values</td>
<td>mon Monday</td>
</tr>
<tr>
<td></td>
<td>tue Tuesday</td>
</tr>
<tr>
<td></td>
<td>wed Wednesday</td>
</tr>
<tr>
<td></td>
<td>thu Thursday</td>
</tr>
<tr>
<td></td>
<td>fri Friday</td>
</tr>
<tr>
<td></td>
<td>sat Saturday</td>
</tr>
<tr>
<td></td>
<td>sun Sunday</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Common \MFAUClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>AutoInstallTimeOfDay</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_SZ</td>
</tr>
<tr>
<td>Description</td>
<td>The time of day in 24-hour format when automatic updates are attempted to be installed.</td>
</tr>
<tr>
<td>Default value</td>
<td>02:00</td>
</tr>
<tr>
<td>Valid values</td>
<td>Any valid time of day.</td>
</tr>
</tbody>
</table>
Defining the maximum random added delay before the update

You can add random delay to the beginning of the automatic updates by adding the following registry setting on the target computer:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Common \MFAUClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value name</td>
<td>AdditionalMaxRandomSleepingPeriod</td>
</tr>
<tr>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td>Description</td>
<td>The maximum value for the random delay (in other words sleeping) added to the main sleeping period (default: one hour) at the beginning of the automatic updates poll-download-install cycle. The randomness establishes a crude form of load balancing in a network. When defining the value, take into consideration that too large values may impact polling frequency and that also several other registry settings affect the sleeping period and installation. Their combined effect can result in unwanted consequences, such as preventing a user from postponing the installation during office hours or delaying the download to occur only after a weekly installation day. With the default settings, the poll-download-install cycle restarts every 1-2 hours with a mean value of 1.5 hours.</td>
</tr>
<tr>
<td>Default value</td>
<td>3600</td>
</tr>
<tr>
<td>Valid values</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>&lt;1-86400</td>
</tr>
</tbody>
</table>

Modifying PDF Conversion Limitations

By default, the maximum allowed file sizes for PDF conversions for different file formats are the following:

- E-mail messages: 10 MB
- Microsoft Excel documents: 10 MB
- Images: 10 MB
- PDF documents: 10 MB
- Microsoft PowerPoint documents: 10 MB
- Visio documents: 10 MB
- Microsoft Word documents: 10 MB

In addition to file size limits, another limitation for PDF conversions is time. By default, the maximum PDF conversion processing time is 120 seconds.

To modify these values, complete the following steps on the M-Files server computer:
1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select **Configurations**, and then in the gray navigation area, select **Advanced Vault Settings**.

2. Open the **Configuration** tab.

   ✔ The advanced vault settings are shown.
3. Expand **PDF Conversion**, and then expand the file type (either **Emails**, **Excel Files**, **Images**, **PDF Files**, **PowerPoint Files**, **Visio Files**, or **Word Files**) for which you want to specify the PDF conversion file size limit.

4. In the **Maximum Source File Size** field, enter the file size limit for the selected PDF conversion in bytes.

5. Define the other settings available for the file type you selected.

   The help texts guide you with the settings.

6. Click **Save** to save your configuration.

7. To modify the PDF conversion time limit, add or modify the following registry entry:

```
<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server\MFServer\PDFConverter\</td>
<td>ConvertedFileTimeoutInSeconds</td>
</tr>
</tbody>
</table>
```
Key: HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files\<version>\Server\MFServer\PDFConverter

<table>
<thead>
<tr>
<th>Value type</th>
<th>REG_DWORD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>The PDF conversion time limit in seconds.</td>
</tr>
<tr>
<td>Value</td>
<td>For instance, 190</td>
</tr>
</tbody>
</table>

8. Use Windows Task Manager to restart the MFServer service:
   a) Right-click the taskbar and select Task Manager from the context menu.
      
      ☑ The Task Manager window is opened.
   b) Open the Services tab.
   c) Right-click the MFServer service and select Restart from the context menu.

Defining File Types for Indexing

M-Files Server tries to index the contents of the most general file types when a new file version is checked in to M-Files Server. Indexing enables users to search documents and objects from M-Files using the words that can be found in the file content. This topic lists the files whose contents are indexed by default and tells how to add file types to be indexed and how to exclude file types from indexing.

Note: Metadata is always indexed regardless of whether the file extension is in the list of file types to be indexed or in the blacklist of file types not to be indexed.

The following table lists the extensions of files whose contents are indexed by default when dtSearch or Micro Focus IDOL search engine is in use.

### Table 1: Extensions of File Types Indexed by Default

<table>
<thead>
<tr>
<th>File Extension</th>
<th>Information on File Extension</th>
</tr>
</thead>
<tbody>
<tr>
<td>123</td>
<td>Lotus</td>
</tr>
<tr>
<td>CSV</td>
<td>Comma separated values file</td>
</tr>
<tr>
<td>DOC</td>
<td>Microsoft Word</td>
</tr>
<tr>
<td>DOCM</td>
<td>Microsoft Word Open XML, macro-enabled document</td>
</tr>
<tr>
<td>DOCX</td>
<td>Microsoft Word</td>
</tr>
<tr>
<td>DOT</td>
<td>Microsoft Word template</td>
</tr>
<tr>
<td>DOTM</td>
<td>Microsoft Word macro-enabled template</td>
</tr>
<tr>
<td>EML</td>
<td>Email message</td>
</tr>
<tr>
<td>HTM</td>
<td>Hypertext Markup Language file</td>
</tr>
<tr>
<td>HTML</td>
<td>Hypertext Markup Language file</td>
</tr>
<tr>
<td>ICS</td>
<td>Universal calendar file</td>
</tr>
<tr>
<td>KEY</td>
<td>Apple</td>
</tr>
<tr>
<td>MSG</td>
<td>Microsoft Outlook email message</td>
</tr>
<tr>
<td>NUMBERS</td>
<td>Apple</td>
</tr>
<tr>
<td>ODF</td>
<td>OpenDocument</td>
</tr>
<tr>
<td>File Extension</td>
<td>Information on File Extension</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>ODG</td>
<td>OpenDocument</td>
</tr>
<tr>
<td>ODP</td>
<td>OpenDocument</td>
</tr>
<tr>
<td>ODS</td>
<td>OpenDocument</td>
</tr>
<tr>
<td>ODT</td>
<td>OpenDocument</td>
</tr>
<tr>
<td>ONE</td>
<td>OneNote</td>
</tr>
<tr>
<td>OTG</td>
<td>OpenDocument</td>
</tr>
<tr>
<td>OTP</td>
<td>OpenDocument</td>
</tr>
<tr>
<td>OTS</td>
<td>OpenDocument</td>
</tr>
<tr>
<td>OTT</td>
<td>OpenDocument</td>
</tr>
<tr>
<td>PAGES</td>
<td>Apple</td>
</tr>
<tr>
<td>PDF</td>
<td>Portable Document Format file created by Adobe Acrobat or another PDF application</td>
</tr>
<tr>
<td>POT</td>
<td>Microsoft PowerPoint template</td>
</tr>
<tr>
<td>POTX</td>
<td>Microsoft PowerPoint template</td>
</tr>
<tr>
<td>PPT</td>
<td>Microsoft PowerPoint</td>
</tr>
<tr>
<td>PPTM</td>
<td>Microsoft PowerPoint, macro-enabled</td>
</tr>
<tr>
<td>PPTX</td>
<td>Microsoft PowerPoint</td>
</tr>
<tr>
<td>PTM</td>
<td>Microsoft PowerPoint, macro-enabled template</td>
</tr>
<tr>
<td>QPW</td>
<td>Corel Quattro Pro</td>
</tr>
<tr>
<td>RTF</td>
<td>Rich Text Format file</td>
</tr>
<tr>
<td>STC</td>
<td>StarOffice</td>
</tr>
<tr>
<td>STI</td>
<td>StarOffice</td>
</tr>
<tr>
<td>STW</td>
<td>StarOffice</td>
</tr>
<tr>
<td>SXC</td>
<td>StarOffice</td>
</tr>
<tr>
<td>SXD</td>
<td>StarOffice</td>
</tr>
<tr>
<td>SXG</td>
<td>OpenOffice</td>
</tr>
<tr>
<td>SXI</td>
<td>StarOffice</td>
</tr>
<tr>
<td>SXW</td>
<td>StarOffice</td>
</tr>
<tr>
<td>TXT</td>
<td>Standard text document</td>
</tr>
<tr>
<td>WB1</td>
<td>Corel Quattro Pro</td>
</tr>
<tr>
<td>WB2</td>
<td>Corel Quattro Pro</td>
</tr>
<tr>
<td>WB3</td>
<td>Corel Quattro Pro</td>
</tr>
<tr>
<td>VDX</td>
<td>Microsoft Visio</td>
</tr>
<tr>
<td>WKS</td>
<td>Lotus</td>
</tr>
<tr>
<td>WPD</td>
<td>WordPerfect</td>
</tr>
</tbody>
</table>
**File Extension** | **Information on File Extension**
--- | ---
WPF | WordPerfect
WRI | Microsoft Write
VSD | Microsoft Visio
VSDX | Microsoft Visio
XLS | Microsoft Excel
XLSB | Microsoft Excel, binary format
XLSM | Microsoft Excel, macro-enabled
XLSX | Microsoft Excel
XLT | Microsoft Excel template
XLTM | Microsoft Excel, macro-enabled template
XLTX | Microsoft Excel template
XML | Extensible Markup Language data file
XPS | Microsoft page layout
XSL | XML style sheet

**Using Blacklist in Indexing**

If you do not want to use the default list of file types to be indexed, you can use the built-in blacklist instead. The blacklist contains a predefined set of file extensions specifying the file types that are not indexed.

Complete the following steps to set the built-in blacklist to be used in indexing:

1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select **Configurations**, and then in the gray navigation area, select **Advanced Vault Settings**.
2. Open the **Configuration** tab.

The advanced vault settings are shown.

3. Expand **Search > Full-Text Search**.

4. Set **Use File Extension Blacklist Instead of Whitelist in Indexing** to **Yes**.

5. Click **Save** to save your configuration.

**Defining Additional File Types for Indexing**

In addition to either the list of file types to be indexed or the list of file types not to be indexed, you can define other file types to be indexed. Also, you can define some file types you do not want to be included in indexing. For example, you have the list of file types to be indexed, but you would like to exclude one of the file types from indexing. To exclude the file contents from indexing, you must define the file extension according to the following instructions.

Complete the following steps to define file types to be indexed or not to be indexed:
1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select **Configurations**, and then in the gray navigation area, select **Advanced Vault Settings**.

2. Open the **Configuration** tab.

   ✓ The advanced vault settings are shown.
3. Expand **Search** > **Full-Text Search** > **Files to Index** or **Files Not to Index**.

4. Click **Add Extension**.

5. In the **Extension** field, enter the file extension, for instance **.dwg**.

6. Repeat the steps 4 and 5 for each file extension.

7. Click **Save** to save your configuration.

**Specifying Vault-Specific Locale Settings for Server-Side PDF Conversions**

When converting Microsoft Word documents that contain dynamic metadata fields (see **Insert M-Files Property**) to PDF using the server-side PDF conversion feature, M-Files refreshes the metadata fields before the PDF conversion is executed. Number and date values are formatted upon refreshing using the locale settings of the M-Files server computer. If you need to change the locale of the dates and numbers but cannot change the server locale, you can specify a locale for the vault to override the server locale.

To specify the vault locale, complete the following steps on the M-Files server computer:
1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select Configurations, and then in the gray navigation area, select Advanced Vault Settings.

2. Open the Configuration tab.

   The advanced vault settings are shown.
3. Expand **PDF Conversion > Word Files**.

4. In the **Formatting Locale** field, enter the language culture name, for instance `fi-FI`, `en-US`, or `sv-SE`.
   
   The value should be given as a Microsoft Windows language code identifier (LCID).

5. Click **Save** to save your configuration.

Number and date metadata fields in PDF conversions are now formatted according to the locale you have specified.

**Preventing Linked Documents from Being Removed**

If the user groups *All internal users* or *All internal and external users* do not have edit permissions on a linked document from an external file source, the document is removed from the external file source when it is added to M-Files.

This behavior can be prevented by making the following changes on the M-Files Server computer:
1. Add the following registry key and value:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server\MFServer</th>
<th>Value name</th>
<th>IgnoreACLsForExternalLinks</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Value type</td>
<td>REG_DWORD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description</td>
<td>Prevents linked documents from being removed from the external file source if document vault users do not have edit permissions to them.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Value</td>
<td>1</td>
</tr>
</tbody>
</table>

2. Use Windows Task Manager to restart the MFServer service:
   a) Right-click the taskbar and select Task Manager from the context menu.

   The Task Manager window is opened.
   b) Open the Services tab.
   c) Right-click the MFServer service and select Restart from the context menu.

Linked documents are now not removed from the external source even if document vault users do not have edit permissions to the linked documents.

The default behavior can be restored by setting the IgnoreACLsForExternalLinks value to 0, and then restarting the M-Files Server service via Windows Task Manager.

### Registry Setting for Extending Firebird Usability

Make the following changes on the M-Files server computer to extend Firebird usability in 64-bit installations:

1. Add the following registry entry:

<table>
<thead>
<tr>
<th>Key</th>
<th>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files&lt;version&gt;\Server\MFServer\Vaults&lt;vault GUID&gt;</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Value name</td>
</tr>
<tr>
<td></td>
<td>Value type</td>
</tr>
<tr>
<td></td>
<td>Description</td>
</tr>
<tr>
<td></td>
<td>Value</td>
</tr>
</tbody>
</table>

2. Use Windows Task Manager to restart the MFServer service:
   a) Right-click the taskbar and select Task Manager from the context menu.

   The Task Manager window is opened.
   b) Open the Services tab.
   c) Right-click the MFServer service and select Restart from the context menu.
3. Run the **Optimize Database (Thorough)** operation for the vault (see Vault Maintenance for more information).

**Settings for Vault Performance Measurement**

The vault performance tests (see Measuring Vault Performance for further information) have predefined threshold times. The test results indicate if a test takes longer than the time specified by the threshold value. See below for instructions on modifying the threshold values for vault performance tests.

**Defining the threshold time for the database insert speed test**

The default threshold time for the database insert speed test is 6,000 milliseconds. You may modify the threshold time by completing the following steps on the M-Files server computer:

1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand **Document Vaults**, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select **Configurations**, and then in the gray navigation area, select **Advanced Vault Settings**.

   ![Advanced Vault Settings Menu]

   - Advanced Vault Settings
   - Custom Vault Data
   - Metadata Card
   - Federated Authentication
   - Intelligence Services
   - External Repositories
   - Other Applications

2. Open the **Configuration** tab.

   ![Configuration Tab]

   - The advanced vault settings are shown.

4. In the Threshold field, enter the threshold time for the database insert speed test in milliseconds.

5. Click Save to save your configuration.

Defining the threshold time for the network round-trip test

The default threshold time for the network round-trip test is 1,500 microseconds. You may modify the threshold time by completing the following steps on the M-Files server computer:
1. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select Configurations, and then in the gray navigation area, select Advanced Vault Settings.

2. Open the Configuration tab.

   The advanced vault settings are shown.
3. Expand **Performance > Server Tests > Network Round Trip**.

4. In the **Threshold** field, enter the threshold time for the network round-trip test in microseconds.

5. Click **Save** to save your configuration.

---

**4. Frequently Asked Questions**

This section deals with some of the most common questions related to the use of M-Files.

This section deals with some of the most common questions related to the use of M-Files. The questions have been divided into the categories below.

**Daily use of M-Files**

- Can I do the same stuff with M-Files Mobile as with M-Files Desktop?
- How can I add a new item to a value list?
• How can I add a new property to a class?
• How can I create a document that is only visible to me?
• How can I create a new view in which the objects are displayed by customer?
• How can I find the documents I have created myself?
• How do I change the name of my computer without interfering with M-Files functionality?
• Why can’t I edit a document that has been checked out?

**Administration of M-Files**

• How can I add a new item to a value list?
• How can I add a new user to the document vault?
• How can I add a new property to a class?
• How do I change the login account of a user?
• How do I format the date in M-Files?
• How do I import e-mail messages from a specific IMAP folder?
• Why are there objects with the same ID in the vault?
• What is the difference between a user and a login account?
• Why does the intelligence service not extract metadata from some of the files?

**Maintenance of M-Files**

• How do I maintain the M-Files server machine?
• Why is my M-Files not as fast as it used to be?
• How do I migrate my document vaults to a new server?
• How do the automatic updates work?
• How much disk space do encrypting file data and taking backups require?
• How often should I make backups?
• How often should I reboot the M-Files server machine?
• What is not included in the backups?
• What kind of operations can I schedule to be run at specific intervals in M-Files?

**Common problems for document vault users**

• Why can’t I access the document vault?
• Why can’t I convert a document to PDF format or annotate a document?
• Why can’t I find the Checked Out to Me view?
• Why can’t I save an e-mail message as an Outlook message to M-Files?
• Why did a file with a grayed-out icon appear on the M-Files drive when I saved a new document in Microsoft Word?
• Why do document timestamps have the wrong time?

**General questions**

• Where can I find more information when I need it?
• What are the hardware requirements and recommendations?
• What's new in this M-Files version?
• How do the automatic updates work?
• Can I use M-Files programmatically?
• How do I write VBScript code for M-Files purposes?
• What is the difference between a named access control list (NACL) and a user group?
In this chapter

- Daily Use of M-Files
- Administration of M-Files
- Maintenance of M-Files
- Common Problems for Document Vault Users
- General Questions

4.1. Daily Use of M-Files

This section contains frequently asked questions related to the daily use of M-Files.

In this chapter

- Can I do the same stuff with M-Files Mobile as with M-Files Desktop?
- How can I add a new item to a value list?
- How can I add a new property to a class?
- How can I create a document that is only visible to me?
- How can I create a new view in which the objects are displayed by customer?
- How can I find the documents I have created myself?
- How do I change the name of my computer without interfering with M-Files functionality?
- Why can't I edit a document that has been checked out?

4.1.1. Can I do the same stuff with M-Files Mobile as with M-Files Desktop?

M-Files Mobile is available for the iOS and Android operating systems. The table below summarizes the differences between the mobile applications and M-Files Desktop.

For a more detailed description of the differences between the mobile applications, see M-Files Mobile Apps Feature Comparison.

<table>
<thead>
<tr>
<th>Feature</th>
<th>M-Files Desktop</th>
<th>M-Files Mobile for iOS</th>
<th>M-Files Mobile for Android</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open object files</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>View metadata</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Open objects from M-Files URLs</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Show subobjects</td>
<td>✔</td>
<td>✔</td>
<td>✘</td>
</tr>
<tr>
<td>Voice commands</td>
<td>✘</td>
<td>✘</td>
<td>✘</td>
</tr>
<tr>
<td>Edit metadata</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Edit files</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Add comments</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Add electronic signatures</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Add handwritten signatures</td>
<td>✘</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Feature</td>
<td>M-Files Desktop</td>
<td>M-Files Mobile for iOS</td>
<td>M-Files Mobile for Android</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------</td>
<td>------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Undo checkout</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Create new objects</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Mark assignments complete</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Create a copy of an object</td>
<td>✔</td>
<td>✘</td>
<td>✔</td>
</tr>
<tr>
<td>Create a template based on current object</td>
<td>✔</td>
<td>✔</td>
<td>✘</td>
</tr>
<tr>
<td>Save documents from other apps to M-Files</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Save email attachments as new objects</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Scan documents using the camera of the device</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Share public links</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Call phone numbers via the metadata card</td>
<td>✘</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Navigate to a website by clicking a hyperlink on the metadata card</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Create a new email message by clicking an email address on the metadata card</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Read files and metadata in offline mode</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Create objects in offline mode</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Edit object metadata in offline mode</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Mark objects for offline availability</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Mark views for offline availability</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>View annotations</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Annotate documents online</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Annotate documents offline</td>
<td>✔</td>
<td>✘</td>
<td>✘</td>
</tr>
<tr>
<td>Manage multiple vault connections</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Feature</td>
<td>M-Files Desktop</td>
<td>M-Files Mobile for iOS</td>
<td>M-Files Mobile for Android</td>
</tr>
<tr>
<td>--------------------------------------------------</td>
<td>-----------------</td>
<td>------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Quickly access assignments, favorites, and recent objects</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>View relationships to and from the selected object</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Add objects to favorites</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Open objects from .mflink attachments</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Access all views</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Add shortcuts to views</td>
<td>✔</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Show document collection members</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Participate in workflows</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Convert speech to text</td>
<td>X</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Create new objects via M-Files URLs</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Add pictures or photos to existing objects</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Attach other files to existing objects</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Create subobjects via the metadata card of the parent object</td>
<td>✔</td>
<td></td>
<td>X</td>
</tr>
<tr>
<td>Do a quick search</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Filter search by object type</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Limit search to metadata or file contents only</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Share files as email attachments</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Share objects and files as M-Files link attachments</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Share files via M-Files URLs</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Share or copy files to other applications</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Save phone numbers to contacts via the metadata card</td>
<td>X</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Feature</td>
<td>M-Files Desktop</td>
<td>M-Files Mobile for iOS</td>
<td>M-Files Mobile for Android</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-----------------</td>
<td>------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Send a text message via the metadata card</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Delete offline content</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Add vault connections via M-Files URLs</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Object type hierarchies</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Automatic filling of properties</td>
<td>✓</td>
<td>✓ (partly supported)</td>
<td>✓ (partly supported)</td>
</tr>
</tbody>
</table>

4.1.2. How can I add a new item to a value list?

You can add values to a value list while filling in the metadata card via the **Add Value** button in the toolbar. This function is available only if it has been defined in the value list properties that regular users can add new values to this list.

If you are an M-Files system administrator, go to **Value Lists** in M-Files Admin, right-click the desired value list, and select **Properties** in the context menu. Click the **Contents...** button and add a new item by clicking the **New Item** button. If you do not have administrator rights, check with the system administrator that the **Allow users to add new values to this list** check box is checked in the properties of the value list.

If the value list is based on an object type, the value list is edited through the object type. In this case, the new object type is created using the M-Files Desktop user interface.

4.1.3. How can I add a new property to a class?

If you are a regular M-Files user, you can add properties while filling in the metadata card. You can click **Add property** on the metadata card to add a new property for the object. Please note that this property is only added to this particular object, not all objects of the class.

If you are an M-Files system administrator and want to add a property to all documents of the class, go to **Classes** in M-Files Admin, right-click the desired class and select **Properties** from the context menu. You can add default properties for the class by clicking the **Add...** button. If the desired property cannot be found in the list, you need to create a new property definition (see **Property Definitions**).

4.1.4. How can I create a document that is only visible to me?

When filling in the metadata card, select **Only for me** in the **Permissions** field.

4.1.5. How can I create a new view in which the objects are displayed by customer?

1. In M-Files Desktop, click the **Home** tab to open the home view of the document vault.

2. Click the **Create** (`✚`) button and then select **View...** from the context menu.

   The **Define View** dialog is opened.

3. In the **Name** field, enter a descriptive name for the view, such as **Customers**.
4. Click the **Add...** button.

  The **Define Grouping Level** dialog is opened.

5. Use the **Property** drop-down menu to select the **Customer** property.

6. Click **OK** to close the **Define Grouping Level** dialog.

7. Click **OK** to close the **Define View** dialog.

Your new view is now listed in the **My Views** section.

For more information about views, see *Using Views*.

### 4.1.6. How can I find the documents I have created myself?

You can search for documents based on certain specifications via the **Additional Conditions** dialog.

1. Click the **Search options** button ( ), and then click the **Additional Conditions...** button.

2. Open the **Properties** tab.

3. Click the **Add Condition** button.

4. Specify **Created by** as the property, select the equals sign (=) as the operator, and your login account as the value.

5. Perform the search by clicking **OK** and then the **Search** button ( ).

**Note:** You can also create a view that shows only the documents you have created. For more information, see *Property-Based Conditions* and *Creating a View*.

### 4.1.7. How do I change the name of my computer without interfering with M-Files functionality?

If documents are checked out to the client in question when its name changes, edited information may be lost. This is because checkouts are user and computer-specific. The computer is identified by its name. After the name is changed, M-Files considers the checkouts to belong to another computer and does not allow the user to access the edited information.

Check in all documents and items from the computer before changing the computer's name.

### 4.1.8. Why can’t I edit a document that has been checked out?

You cannot edit the document because it has been checked out by another user who has not yet checked the document back in. This is to prevent the creation of several different copies in M-Files. With system administrator permissions, the document can be forced to be checked in, but the changes made to the document during the checkout will then be lost.

**Sending a check-in request**

If you need to edit a document that is currently checked out to some other user, you can send the user a check-in request by right-clicking the document and selecting **Send Check-in Request** from the context menu. The user then receives an e-mail message informing them that you are requesting the document to be checked in. The message also contains a link to the document in question. The check-in request is sent to the e-mail address associated with the user’s login account.
4.2. Administration of M-Files

This section contains frequently asked questions related to the administration of M-Files.

In this chapter

- How can I add a new item to a value list?
- How can I add a new user to the document vault?
- How can I add a new property to a class?
- How do I change the login account of a user?
- How do I format the date in M-Files?
- How do I import e-mail messages from a specific IMAP folder?
- What is the difference between a user and a login account?
- Why are there objects with the same ID in the vault?
- Why does the intelligence service not extract metadata from some of the files?

4.2.1. How can I add a new item to a value list?

You can add values to a value list while filling in the metadata card via the Add Value button in the toolbar. This function is available only if it has been defined in the value list properties that regular users can add new values to this list.

If you are an M-Files system administrator, go to Value Lists in M-Files Admin, right-click the desired value list, and select Properties in the context menu. Click the Contents... button and add a new item by clicking the New Item button. If you do not have administrator rights, check with the system administrator that the Allow users to add new values to this list check box is checked in the properties of the value list.

If the value list is based on an object type, the value list is edited through the object type. In this case, the new object type is created using the M-Files Desktop user interface.

4.2.2. How can I add a new user to the document vault?

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Users.
5. Click New User... on the task area.

The User Properties dialog is opened.
6. Use the **Login account** drop-down menu to select a login account for the new user.

   The **Login account** drop-down menu lists all login accounts that have not been added to the document vault. If you want to create an entirely new login account, see [Login Accounts](#).

7. Specify the permissions for the user and then click **OK**.
The new user is added to the document vault.

Note: For further instructions, see Creating a User.

4.2.3. How can I add a new property to a class?

If you are a regular M-Files user, you can add properties while filling in the metadata card. You can click Add property on the metadata card to add a new property for the object. Please note that this property is only added to this particular object, not all objects of the class.

If you are an M-Files system administrator and want to add a property to all documents of the class, go to Classes in M-Files Admin, right-click the desired class and select Properties from the context menu. You can add default properties for the class by clicking the Add... button. If the desired property cannot be found in the list, you need to create a new property definition (see Property Definitions).

4.2.4. How do I change the login account of a user?

Sometimes it may be necessary to change the login account for a user. The user’s login account may have to be changed when, for example, the user needs a new login account due to his or her last name being changed or when login accounts are moved from one domain to another.

When a user login account must be changed, it is important to preserve the vault user associated with the original login account and to associate the same user with the new login account to preserve the user history and the user’s personal settings in the vault.

Note: It is important to distinguish between login accounts and users:

- Login accounts are server-level (or in some cases vault-level) accounts that are used for authenticating users to M-Files Server. A login account can be associated with multiple users, but only one user per vault.
- Users are vault-level objects that store user-specific settings and user history and that have permissions to perform specific operations in a vault. A user is linked to one and only one login account.

Do the following steps to correctly change a login account for a user after new login accounts have been created in M-Files:

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
4. Still in the left-side tree view, select Users.

The Users list is opened in the right-side pane.
5. Right-click the user whose login account you need to change and select **Properties** from the context menu.

   If new login accounts are synchronized from an Active Directory source, M-Files automatically creates new users for the new login accounts. To associate the new login account with the correct existing user, you must first delete the new, automatically created user.

   ![Info](image)

   The **User Properties** dialog is opened.

6. Use the **Login account** drop-down menu to select a new login account for the user.

7. Click **OK** to close the **User Properties** dialog and to save your changes.

   The new login account is now correctly associated with the existing user. Now when the user logs in using the new credentials, their previous user history and personal settings in the vault are available.

### 4.2.5. How do I format the date in M-Files?

The **Date** data type of a property is used for displaying a date and time as a property value. If you wish to change the format of how date and time are displayed, you must modify the date and time format settings of the client operating system.

![Note](image)

**Note:** These instructions are for Windows 10, but the procedure is highly similar for other Windows versions.

Complete the steps below on the M-Files client computer to change the date format.

1. Right-click the Windows Start button and select **Settings** from the context menu.

   ![Check](image)

   The **Settings** window is opened.

2. Click **Time & language**, and then click **Additional date, time, & regional settings**.

   ![Check](image)

   The **Clock, Language, and Region** window is opened.

3. Under the **Region** section, click **Change date, time, or number formats**.

   ![Check](image)

   The **Region** dialog is opened.

4. On the **Formats** tab, click the **Additional settings...** button.

   ![Check](image)

   The **Customize Format** dialog is opened.

5. Open the **Time** tab, and enter a desired format in the **Short time** field.

6. Open the **Date** tab, and enter a desired format in the **Short date** field.

7. Click **OK** to close the **Customize Format** dialog.

8. Click **OK** to close the **Region** dialog.

   All the properties that use the **Date** data type should now be displayed in the format that you have specified in the steps above.
How do I format the date on the M-Files server computer?

Date and time information may be employed by various M-Files Server operations, such as script executions or PDF conversions. The date and time format settings of the M-Files server computer’s system account determine how dates and times are displayed in such operations.

Complete the steps below on the M-Files server computer to change the date format.

1. Right-click the Windows Start button and select Settings from the context menu.
   ✔ The Settings window is opened.

2. Click Time & language, and then click Additional date, time, & regional settings.
   ✔ The Clock, Language, and Region window is opened.

3. Under the Region section, click Change date, time, or number formats.
   ✔ The Region dialog is opened.

4. On the Formats tab, click the Additional settings... button.
   ✔ The Customize Format dialog is opened.

5. Open the Time tab, and enter a desired format in the Short time field.

6. Open the Date tab, and enter a desired format in the Short date field.

7. Click OK to close the Customize Format dialog.

8. Open the Administrative tab.

9. Click the Copy Settings... button.

10. Enable the option Welcome screen and system accounts.

11. Click OK to close the dialog.

12. Click OK to close the Region dialog.

All dates and times generated by the M-Files server computer should now be displayed in the format that you have specified in the steps above.

For instructions on specifying vault-specific locale settings for server-side PDF conversions, see Specifying Vault-Specific Locale Settings for Server-Side PDF Conversions. You may use these instructions to override the server locale settings for PDF conversions if you cannot change the server locale settings.

4.2.6. How do I import e-mail messages from a specific IMAP folder?

M-Files allows you to automatically import e-mail messages from a specific e-mail folder on an IMAP server to a document vault of your choice. You can accomplish this by using the Connections to External Sources function in M-Files Admin and by specifying a new connection to a mail source.

For instructions on specifying a connection to an IMAP e-mail server, see Mail Sources.
4.2.7. What is the difference between a user and a login account?

The concepts of a user and a login account are both integral parts of M-Files, but there is an important difference between them:

- Users are vault-level objects that store user-specific settings and user history as well as permissions for performing certain operations in a vault. A user object is always linked to one and only one login account.
- Login accounts are server-level (or in some cases vault-level) accounts that are used for authenticating users to M-Files Server. A login account can be associated with multiple users, but only one user per vault.

Example

A&A Consulting hires a new engineer, Amanda Reade, and she naturally needs to have access to the M-Files vaults of the company.

1. The M-Files administrator of the company creates the login account AmandaR via M-Files Admin.
   - Amanda can now be authenticated to M-Files Server.
2. The administrator creates the vault user AmandaR to all the appropriate vaults.
   - Amanda now has access to the vaults specified by the administrator.

As a result, the login account AmandaR is linked to all the newly created users, and the vault user AmandaR in all the appropriate vaults is linked to the said login account. The new engineer now also has access to all the required M-Files vaults.

4.2.8. Why are there objects with the same ID in the vault?

Depending on where an object has originated from, it may have one or more of the following types of IDs:

- Internal ID
- External ID
- Original ID

The ID that is displayed on the metadata card of an object, on the other hand, is called the display ID and it can obtain the value of either the external ID, the original ID, or the internal ID.

**Internal ID**

Each object in the vault has an internal ID.

Internal ID is unique to each object per object type in a single vault. If the object is not imported from an external database or replicated from another vault, it has an internal ID only. When referring to an object in a vault, like for example in a script, you must refer to it by its internal ID.

**External ID**

Objects imported from an external database have an external ID, which is the ID the object is identified by in the external database.
Original ID

Objects replicated from another vault have an original ID, which is the ID that the object was given in the vault in which the object was originally created.

Display ID

Display ID is the identifier that is displayed on the metadata card of an object. The display ID obtains its value from one of the three aforementioned IDs in the following order of priority:

1. External ID
2. Original ID
3. Internal ID

In other words, if an object has an external ID, it is displayed as the ID of the object on the metadata card.

If an object has an original ID, but no external ID, the original ID is displayed as the ID of the object on the metadata card.

If an object has no external or original ID, the internal ID is displayed as the ID of the object on the metadata card.

A Case of Similar IDs

The three aforementioned types of IDs may use the same values to identify different objects within a vault. An object in the vault may have an internal ID 100 while another object may have an external ID 100, and thus the displayed ID for the two objects may be the same. Therefore there may be objects in the vault with seemingly the same IDs.

Note: You may use the %INTERNALID% placeholder for a property of the Text data type to add the internal ID to the object metadata as an automatic property value. For detailed instructions, see Simple concatenation of properties and Specifying an Automatic Value for a Property.

4.2.9. Why does the intelligence service not extract metadata from some of the files?

In some situations, intelligence services such as M-Files Information Extractor are unable to produce metadata suggestions based on the content of certain files. The issue may be caused by the simple fact that M-Files Server is not able to read the file content, and therefore not able to provide the content to the intelligence service for analysis.

You may come across this kind of issue, for example, if your organization is using password-protected PDF files. If opening the PDF file without a password or copying content from it is restricted via the security settings of the PDF file, M-Files will not be able to access the file content. For more information about password-protected PDF files, see this Adobe article.

4.3. Maintenance of M-Files

This section contains frequently asked questions pertaining to the maintenance of M-Files.

In this chapter

- How do I maintain the M-Files server machine?
- Why is my M-Files not as fast as it used to be?
• How do I migrate my document vaults to a new server?
• How do the automatic updates work?
• How much disk space do encrypting file data and taking backups require?
• How often should I make backups?
• How often should I reboot the M-Files server machine?
• What is not included in the backups?
• What kind of operations can I schedule to be run at specific intervals in M-Files?
• How do I check the location of the active search indexes?

4.3.1. How do I maintain the M-Files server machine?

The M-Files system administrator should carry out the below maintenance tasks on the M-Files server machine to maintain its operational efficiency.

<table>
<thead>
<tr>
<th>Frequency</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Daily</td>
<td>Checking Windows Event Logs</td>
</tr>
<tr>
<td>Monthly</td>
<td>Verifying Resource Usage</td>
</tr>
<tr>
<td></td>
<td>Clearing Replication Conflicts</td>
</tr>
<tr>
<td>Quarterly</td>
<td>Manual Optimization</td>
</tr>
<tr>
<td>Biannual and annual</td>
<td>Running Verify and Repair</td>
</tr>
<tr>
<td></td>
<td>Rebuilding Search Indexes</td>
</tr>
<tr>
<td></td>
<td>Archiving M-Files Event Logs</td>
</tr>
</tbody>
</table>

Follow the links for further instructions on carrying out a specific task.

In this chapter

• Checking Windows Event Logs
• Verifying Resource Usage
• Clearing Replication Conflicts
• Manual Optimization
• Running Verify and Repair
• Rebuilding Search Indexes
• Archiving M-Files Event Logs

Checking Windows Event Logs

Check events related to M-Files in the Windows event log on a regular basis for any issues, especially ones pertaining to backups. You might want to also consider using a PowerShell script or a third-party application for sending e-mail notifications when aforementioned events occur.
1. Press ⊞ Win + R on the M-Files server computer.

   The Run dialog is opened.

2. In the Open text field, type in eventvwr and click OK.

   Event Viewer is opened.

3. Expand the Windows Logs node.

4. Select the Application node.

   The application log is displayed:

   ![Event Viewer Application Log](image)

   5. Click Filter Current Log... on the Actions pane in the Application section to list only the entries that are related to M-Files.

      The Filter Current Log dialog is opened.

6. In the Event sources drop-down menu, select all the applications related to M-Files, such as M-Files, M-Files Compliance Kit, and MFClient.

7. Click OK to close the Filter Current Log dialog.

   The application event log should now list only the entries that are related to M-Files.

   Note: If the disk space on the server computer allows, we recommend expanding the maximum log size of the Application log to, for instance, 200,000 KB to cover more events. In some error cases, a large number of events may be recorded to the log, thus filling the default log size of about 20 MB very quickly. This may make it impossible to track down the origin of the issue. You can change the log size by right-clicking the Application node in the left-side tree view and then selecting Properties from the context menu. Expanding the log size of the client computers is rarely needed, but may be of use in some cases.

Verifying Resource Usage

It is important to keep track of how much resources are needed to run the M-Files system. If the resource consumption reaches certain thresholds, it might be time to consider upgrading your system. See also System Requirements to view the hardware and system operating requirements.

Monitor at least the following resource components:
• vault metadata and file data size

Note: You can check the location of the metadata file and the file data folder in the Document Vault Properties dialog in M-Files Admin. See Checking the Size of a Firebird Metadata File for detailed instructions.

• memory
• disk space and health
• backup size and duration (should not overlap with optimization)

Clearing Replication Conflicts

Regularly verify that all your scheduled replication tasks are producing the expected results and that there are no replication conflicts in any of the document vaults. For instructions on how to find and resolve replication conflicts, see Conflicts and their resolution.

Replication conflicts should be cleared at least once a month, but it might also be a good idea to appoint a designated user to check the conflicts each week.

Manual Optimization

If your organization is using Microsoft SQL Server as the database engine and you are storing the file data in a file system folder (instead of the document vault database), manually run the Optimize Database (Thorough) operation from one to four times a year. This is the only way to remove any destroyed files from the file data server in this type of setup. The operation should also be run after an exceptionally large number of files have been destroyed at once, for instance after files have been archived to another vault.

Note: Make sure that the optimization is not performed between file data and metadata backups.

Note: The operation forces Firebird and Microsoft SQL Server vaults to be taken offline for the duration of the operation. Before executing the operation for Firebird vaults, make sure that the server has at least thrice the amount of hard disk space required by the metadata file of the vault. For instructions on how to check the size of the vault metadata file, see Checking the Size of a Firebird Metadata File.

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults.
4. Right-click the document vault of your choice and select Maintenance > Optimize Database (Thorough) from the context menu.
5. Click Yes at the prompt.

The database of the selected document vault is optimized.

Note: Depending on the size of the vault, the operation may take an extensive amount of time to complete.

Running Verify and Repair

The Verify and Repair (Thorough) operation can be used for verifying that the database is intact, that all the data has been saved correctly to M-Files, and that the file sizes and the file checksums of the physical files in the vault data server location match those reported by the metadata database.
If errors are found, some of them can be repaired automatically by M-Files, but some errors might need additional user actions. If you have errors that cannot be resolved automatically, please contact our support (see Contacting Support).

Run the operation twice per year.

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults.

4. Right-click the document vault of your choice and select Maintenance > Verify and Repair (Thorough) from the context menu.

The selected document vault is verified and repaired.

Note: The document vault can be used when the Verify and Repair operation is locating issues in the document vault. If flaws are found, however, the document vault should be taken offline for the duration of the operation. Note that, depending on the size of the vault, the operation may take an extensive amount of time to complete.

Rebuilding Search Indexes

If you notice a considerable decrease in free-text search performance, it may be a good idea to rebuild the search index. For large repositories, this is usually a time-consuming operation. For detailed instructions on how to rebuild the index of a server using dtSearch as the search engine, refer to the document Rebuilding the dtSearch Full-Text Search Index.

Note: Running the operation might cause the quick search to not function optimally in the document vault. Other than that, users should be able to continue using the document vault normally. Note that, depending on the size of the vault, the operation may take an extensive amount of time to complete.

Archiving M-Files Event Logs

If your organization is using unlimited event logs, it is a good idea to archive M-Files event logs once or twice per year. For instance, all installations using M-Files Compliance Kit also use unlimited event logs.

You can export all the events currently recorded in the event log by completing the following steps:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.

4. Still in the left-side tree view, select Event Log.

5. Click Export... in the task area.

6. Click the Export All Events... button.

The Browse For Folder dialog is opened.
7. Select the folder in which you want to export the events and click OK.

   The Confirm Delete dialog is opened.

8. Click Delete to delete the exported events from the event log.

   Once you have completed these steps, the events from the M-Files event log should be archived in the location of your choice as an XML file.

4.3.2. Why is my M-Files not as fast as it used to be?

If M-Files users are experiencing noticeable performance issues in their day-to-day use of M-Files, carry out the procedures outlined below to pinpoint the potential source or sources of the problem. System slowness may be caused by various factors, such as hardware or infrastructure issues, vault structure or periodic maintenance operations, or issues related to opening views or files, and so on.

When contacting our support about performance issues, consider attaching the following information to your request:

- Windows application event log copy for M-Files events (see Saving a Copy of M-Files Errors in the Windows Application Event Log for instructions)
- an export of Server Activity Monitor data via M-Files Admin
- screenshot of the Windows Task Manager tab displaying CPU and RAM usage
- page file information
- hardware specifications of the server(s)

Performance issues caused by factors related to hardware or infrastructure

Performance issues may be caused by hardware or infrastructure related problems. Inspect the following performance counters on the M-Files Server computer as well as the Microsoft SQL Server computer (if they are separate servers):

- The page file usage: Use Performance Monitor to check the current and peak page file usage. Note that Windows always uses the page file no matter how much RAM you have, but if the page file peak usage is higher than around 10 percent, it may indicate that the system is at least periodically low on RAM or that RAM usage is excessive. See Inspecting Page File Usage in Performance Monitor for instructions on checking page file usage.
- Current RAM usage via Windows Task Manager.
- The CPU load via Windows Task Manager: If the load spikes close to 100 percent, the system may be under-resourced or some of the processes may be hoarding excessive amounts of resources.
- The network connectivity between the server computers if M-Files Server and Microsoft SQL Server are running on separate servers. Network latency between the servers may cause noticeable slowness for the end users.
- Make sure the Microsoft SQL Server instance has been assigned a memory limit. It should be set high enough to provide as much RAM for the SQL Server as possible but low enough to prevent the system from swapping. In general, leave from 3 to 4 GB for the host operating system and its services, and if M-Files Server runs on the same system, allocate from 2 to 3 GB for it and other processes. See Modifying the Memory Limit for a Microsoft SQL Server Instance for instructions on setting the memory limit for the Microsoft SQL Server instance.

   Note: These values are approximates and depend on multiple factors, such as the number of vaults, the use of server side vault applications, and so on.
Performance issues caused by vault structure or periodic maintenance operations

System slowness may also be caused by issues in the vault structure, and periodic maintenance operations may be perceived as performance issues by the end user.

The following factors related to vault structure or maintenance operations may cause (temporary) system slowness:

- The metadata of the vault may not be optimal. There should not, for instance, be value lists with tens of thousands of entries or classes with hundreds of obligatory properties.
- Modifying named access control lists causes the permissions of every affected document to be updated and may thus induce temporary system slowness.
- Running background jobs like optimizations and backups may cause temporary slowness. These operations should not be run during high usage hours.
- Having a large number of export and import jobs running at short intervals may cause performance issues.
- The event log in M-Files Admin may be used to reveal instances of exceptional vault use, such as excessive number of file downloads.
- For Firebird vaults, the metadata file size should be no larger than 2 GB per vault. See Registry Setting for Extending Firebird Usability for instructions on defining the maximum metadata file size and Checking the Size of a Firebird Metadata File for instructions on checking the metadata file size.

Performance issues in opening views or performing searches

Perform the following checks to verify if system slowness occurs in conjunction with opening views or performing searches:

1. Use M-Files Desktop on the M-Files server computer and use Local Procedure Call as the protocol for connecting to the vault to rule out potential network-related issues. See Adding a Vault Connection for instructions on defining the vault connection and using Local Procedure Call as the protocol.
2. Log in to the vault as a normal user, not as administrator, so that permission checks are not bypassed when using the vault and thus you can verify whether or not the issue is related to permission checks.
3. Try changing the properties of a view, and then press \Shift + F5 to fully refresh the view after its properties have been changed. Try modifying different properties of views, such as filters or grouping levels, to see if the problem is related to views.

**Note:** You can create a copy of an existing view so that you do not need to change the properties of the original view. Right-click a view of your choice and select **Copy** from the context menu, then right-click on an empty space in the listing area and select **Paste** from the context menu.

In this chapter

- Saving a Copy of M-Files Errors in the Windows Application Event Log
- Inspecting Page File Usage in Performance Monitor
- Modifying the Memory Limit for a Microsoft SQL Server Instance
- Checking the Size of a Firebird Metadata File

Saving a Copy of M-Files Errors in the Windows Application Event Log

**Note:** These instructions are for Windows 10, but the procedure is highly similar for other Windows versions.
If every M-Files user in your organization is experiencing the same issue, it is recommended to save a copy of the application event log on the M-Files server computer. If the issue is an isolated one, on the other hand, you should only save a copy of the log on the computer where the issue occurs. Complete the steps below on the appropriate computer.

1. Right-click the Start icon and select Event Viewer from the context menu.

   ![The Event Viewer window is opened.]

2. In the left-side tree view, expand Windows Logs and then select Application.

3. Click Filter Current Log... on the Actions pane.

   ![The Filter Current Log dialog is opened.]

4. Open the Event sources drop-down menu and select M-Files and any other applications related to M-Files, such as M-Files Compliance Kit or MFClient.

5. Click OK to close the Filter Current Log dialog.

6. Click Save Filtered Log File As... on the Actions pane.

   ![Specify a location and a file name, and then click Save.]

A copy of the filtered application event log is saved to the location that you have specified. The copy contains only the errors that are related to M-Files.

Inspecting Page File Usage in Performance Monitor

Do the following steps to inspect page file usage in Performance Monitor:

1. Via the Windows start menu, open Administrative Tools, and then open Performance Monitor.

2. In the left column, expand Monitoring Tools and then select Performance Monitor.

3. Right-click on the graph and select Add Counters... from the context menu.

   ![The Add Counters dialog is opened.]

4. From the Available counters list, select Paging File.

5. Click on the down-arrow icon to the right of Paging File.

6. Select % Usage under Paging File and then click the Add button to add the counter on the Added counters list.

7. Click OK to close the Add Counters dialog.

Modifying the Memory Limit for a Microsoft SQL Server Instance

Do the following steps to adjust the memory usage of a Microsoft SQL Server instance:

1. Open Microsoft SQL Server Management Studio.

2. Log in to your server.
3. In Object Explorer, right-click a server of your choice and select Properties from the context menu.

   The Server Properties dialog is opened.

4. Click the Memory node.

5. Under Server memory options, enter the desired amounts in the Minimum server memory and Maximum server memory fields.

6. Click OK to close the Server Properties dialog.

Checking the Size of a Firebird Metadata File

The metadata file of a Firebird vault is by default stored under the following location on the server computer:

C:\Program Files\M-Files\Server Vaults\<vault name>\MetaData

Do the following steps to check the size of the metadata file:

1. Open M-Files Admin.

2. In the left-side tree view, expand the desired connection to M-Files Server.

3. In the left-side tree view, right-click the document vault of your choice and select Properties from the context menu.

   The Document Vault Properties dialog is opened.
4. Open the **Advanced** tab.

5. Under the **Use Firebird** option, click the **Define...** button.

   ✔️ The metadata file location along with the file data location is shown at the bottom of the dialog.
6. Open the metadata file folder you have located in the previous step and select the metadata file.

7. Check the file size in the status bar.

4.3.3. How do I migrate my document vaults to a new server?

When migrating document vaults to a new server, use the same version of M-Files on both the old and the new server. If you need to upgrade M-Files in conjunction with the migration, upgrade M-Files on the new server only after the migration is complete and you have verified that the document vaults are functional on the new server.

Migrating document vaults to a new server when using Firebird as the database engine

If your document vaults use Firebird, complete the following steps to migrate the vaults to a new server:

1. Make sure there are no documents checked out on any workstation.
   
   You may create a view that contains all the documents that are currently checked out in the vault by using the **Checked out** status filter for a view.

   For instructions on specifying a view, see Creating a View.

2. Take the vaults offline.

   For instructions, see Taking a Vault Offline.

3. Back up the master database and copy the backup file to the new server computer.

   For instructions, see Backing Up the Master Database.
4. Take full backups of your document vaults and copy the backup files to the new server computer.

   The backup files contain file data regardless of whether the file data is stored in the default location, or in a separately specified location, so there is no need to copy the file data separately.

   For instructions, see Backing Up a Document Vault.

5. Install M-Files to the new server computer:
   a) In the M-Files Setup wizard, click Next, select I accept the license agreement, and then click Next again.
   b) Select the Evaluation installation option.

      By selecting the Evaluation installation option, you do not have to install a license on the new server because the existing license is taken into use when you restore the master database.
   c) Complete the installation.

6. Open M-Files Admin on the new server computer.

7. Restore the master database.

   For instructions, see Restoring the Master Database.

8. Restore the document vaults from the backups using the option Restore using original identity.

   Pay attention to file data locations when restoring the vaults. If in doubt, check the settings on the old M-Files server.

   For instructions, see Restoring a Document Vault.

9. Copy the search indexes from the old server computer to the new one:
   a) In M-Files Admin, in the left-side tree view, right-click a document vault and select Properties from the context menu.
   b) Open the Advanced tab, and then click the Define... button.

      By default, the Indexes folder can be found under the location specified in the Location for vault data on server field.

      In larger vaults, the search indexes might be placed in an alternate location. Check the index location according to the instructions in How do I check the location of the active search indexes?.
   c) Copy the Indexes folder to the new server for each vault that you want to migrate.

10. Optional: Specify notification settings if you wish to enable notifications.

    For instructions, see Editing Notification Settings in M-Files Admin.

11. Specify backup jobs and update the backup file locations if necessary.

    For instructions, see Scheduled Backup Jobs.

12. Stop and disable the M-Files Server service on the old server computer to make sure no users accidentally connect to it in the future.
13. Either:
   a. If you are using a DNS alias for your M-Files Server, update the alias to point to the new server computer. This way you do not have to distribute new vault connection settings to client computers.
   
      or
   
   b. Edit the document vault connection settings on the client computers so that they connect to the new server address. For instructions, see Adding a Vault Connection.

14. Make sure that any external systems that point towards M-Files use either the DNS alias, or the DNS name or IP address of the new M-Files server.

15. Disconnect the old server computer.

Migrating document vaults to a new server when using Microsoft SQL Server as the database engine

The instructions assume that Microsoft SQL Server is not changed during the migration. If Microsoft SQL Server is installed on the same computer as M-Files Server and therefore also requires migration, see Migrating the Vault Database from One Microsoft SQL Server to Another for further instructions. It does not matter whether you migrate M-Files Server before migrating the document vaults or the other way around.

If your document vaults use Microsoft SQL Server, complete the following steps to migrate the vaults to a new server:

1. Make sure there are no documents checked out on any workstation.

   You may create a view that contains all the documents that are currently checked out in the vault by using the Checked out status filter for a view.

   For instructions on specifying a view, see Creating a View.

2. Take the vaults offline.

   For instructions, see Taking a Vault Offline.

3. Back up the master database and copy the backup file to the new server computer.

   For instructions, see Backing Up the Master Database.

4. In Microsoft SQL Server Management Studio, take full backups of your document vaults as a precaution.

5. If the file data is stored on the file system, complete the following steps:
   a) In M-Files Admin, in the left-side tree view, right click the a document vault and select Properties from the context menu.
   b) Open the Advanced tab and click the Define... button.
   c) Click the File Data Location... button.

   The File Data Location dialog is opened.
d) Click the Define... button.

The File-System Folder dialog is opened.

e) Using File Explorer or any other file managing application, copy the file data folders from the location shown in the File-System Folder dialog to the new server computer or network share.

6. Attach the document vaults in Microsoft SQL Server using the original identities of the vaults.

   If the file data is stored on the file system, make sure to specify the correct file data location when attaching the vaults.

   For instructions, see Attaching a Document Vault and Changing the Location of the Vault File Data.

7. Copy the search indexes from the old server computer to the new one:
   a) In M-Files Admin, in the left-side tree view, right-click a document vault and select Properties from the context menu.
   b) Open the Advanced tab, and then click the Define... button.

   By default, the Indexes folder can be found under the location specified in the Location for secondary data on the M-Files server field.

   In larger vaults, the search indexes might be placed in an alternate location. Check the index location according to the instructions in How do I check the location of the active search indexes?.
   c) Copy the Indexes folder to the new server for each vault that you want to migrate.

8. Optional: Specify notification settings if you wish to enable notifications.

   For instructions, see Editing Notification Settings in M-Files Admin.
9. Specify backup jobs and update the backup file locations if necessary.

For instructions, see Scheduled Backup Jobs.

10. Stop and disable the M-Files Server service on the old server computer to make sure no users accidentally connect to it in the future.

11. Either:
   
a. If you are using a DNS alias for your M-Files Server, update the alias to point to the new server computer. This way you do not have to distribute new vault connection settings to client computers.

   or

b. Edit the document vault connection settings on the client computers so that they connect to the new server address. For instructions, see Adding a Vault Connection.

12. Make sure that any external systems that point towards M-Files use either the DNS alias, or the DNS name or IP address of the new M-Files server.

13. Disconnect the old server computer.

Additional configuration required for M-Files Web

If M-Files Web is installed on the M-Files application server, you need to install Internet Information Services and M-Files Web on the new server computer after installing M-Files Server on the new server computer.

If M-Files Web is installed on a separate proxy server instead, the following steps must be completed.

1. If you upgrade M-Files Server after migrating to a new server computer, upgrade the M-Files Web proxy server to the same M-Files version as the one you installed on the new application server.

2. In the Microsoft Windows registry of the M-Files Web proxy computer, update the following setting to point to the new M-Files application server:

<table>
<thead>
<tr>
<th>Key</th>
<th>Value name</th>
<th>Value type</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>HKEY_LOCAL_MACHINE\SOFTWARE\Motive\M-Files &lt;version&gt;\Server\MFWA</td>
<td>Server</td>
<td>REG_SZ</td>
<td>The DNS name of the M-Files application server.</td>
</tr>
</tbody>
</table>

Additional configuration required if you use RPC over HTTPS

On the RPC proxy computer, update the HOSTS file so that the server hostname (the one that clients use for connecting to the M-Files server) points to the IP address of the new M-Files application server.

For further information, see the document Enabling RPC over HTTPS Connections to M-Files Server.

4.3.4. How do the automatic updates work?

M-Files automatically checks for software updates. When an M-Files update becomes available, the update is downloaded to your computer and installed automatically. You can delay the update for a limited time if you are working on something important while an update becomes available.
The feature obtains the latest update information from the update server using HTTPS on TCP port 443. This means that normally you do not need to change any firewall settings.

Note: Users do not need local administrative rights on their computers for the automatic updates to run.

See also Updating M-Files.

4.3.5. How much disk space do encrypting file data and taking backups require?

If you enable encrypting file data at rest or backups on the M-Files server computer, it is essential that you ensure that there is enough disk space on the server computer at all times to accommodate encrypted file data and backup data.

Disk space needed for encrypting file data at rest

Encrypting file data at rest makes an encrypted copy of your file data while leaving the unencrypted file data temporarily in place, which essentially doubles the space needed for vault file data on the disk. Thus enabling encryption requires at least double the amount of disk space that your vault file data takes. You can determine the location of the vault file data via the database engine settings located under the advanced properties of your document vault.

We recommend that you run the Optimize Database (Thorough) operation after you have enabled encryption and ensured that your vault content is accessible. The Optimize Database (Thorough) operation removes the unencrypted file data of the vault.

Disk space needed for backups

As a general rule of thumb, the server machine should always have at least an equal amount of free disk space as the overall disk space required for 1) the file data and metadata of your document vaults and 2) the server-specific data of the M-Files Server instance. However, it is highly recommended that you keep several backups of the vault and server data to give yourself several chances to recover data in the event of system failure or data loss. Therefore the recommended disk space needed for backups is dependent on the backup policy used in your organization.

For more comprehensive backup instructions, please see the M-Files knowledge base article M-Files Backup Policy.

4.3.6. How often should I make backups?

The M-Files server is used to save important data, so it is very important to take care of backup procedures. A regular backup should be made of each document vault and master database on the server. Backups are easy to set up via the scheduled jobs in the M-Files Admin tool. We recommend setting M-Files to run backups every night.

Each backup produces files that should be transferred to a safe place.

Example: Your organization has a separate disk server. The master database and document vault backups are run on the M-Files server every night using the scheduled jobs. The jobs are set up so that each produces a single file that replaces the older one. Backup files are set to be transferred to the disk server and from there to a tape drive. In the event of problems, like hardware failure, the backups allow quickly returning M-Files to working order.
4.3.7. How often should I reboot the M-Files server machine?

M-Files Server itself does not necessarily require the M-Files server machine to be rebooted, but you should schedule periodic reboots of the server machine because of the added benefit and security of installing Microsoft Windows updates. Keeping a server online without periodic updates and restarts leads to potential vulnerabilities and even failures due to pending operating system updates.

For best practices on scheduling periodic reboots, the article Best Practices with Microsoft Windows Server Update Services provides examples on better control on restarting the server after installing Microsoft Windows updates when avoiding a reboot is not an option.

4.3.8. What is not included in the backups?

The vault backup operation can be used to store your vault file data and metadata so that in the event of data loss, your document vault can be recovered from a backup. See Backing Up a Document Vault for instructions on backing up a document vault.

Data that is collected or generated by someone or something else than vault users and administrators is considered secondary data, and such data is not included in the backups as it is generally not needed for successfully restoring a document vault.

Below is a categorization of secondary data that is not included in the vault backup files. Note that you generally do not need to worry about this type of data when considering backups as this data is always automatically generated by the M-Files system whenever needed. Below information is therefore mainly for your reference only.

Search indexes

M-Files generates and maintains indexes of your vault document contents and metadata by periodically going through the contents of the document vault. These indexes are used for locating objects when the M-Files search function is used.

Index data may be stored in the following locations on the M-Files server computer:

C:\Program Files\M-Files\Server Vaults\Indexes
C:\Program Files\M-Files\Server Vaults\<vault>\Indexes\n
This type of data need not be preserved for backups or when migrating document vaults to a new server computer.

Image thumbnails

Image thumbnail files are generated by M-Files when the thumbnail view is used in M-Files Desktop. For more information on different view modes, see Display mode settings.

Thumbnail data may be stored in the following locations on the M-Files server computer:

C:\Program Files\M-Files\Server Vaults\Thumbnails
C:\Program Files\M-Files\Server Vaults\<vault>\Thumbnails

This type of data need not be preserved for backups or when migrating document vaults to a new server computer.
Document preview files

Document preview data is generated by M-Files when documents are previewed in the Preview tab in the M-Files client.

Document preview data may be stored in the following folders on the M-Files server computer:

- C:\Program Files\M-Files\Server Vaults\ViewerFiles
- C:\Program Files\M-Files\Server Vaults\<vault>\ViewerFiles

This type of data need not be preserved for backups or when migrating document vaults to a new server computer.

Logs

M-Files creates log files in various locations on the M-Files server computer after certain processes are run. The log files generally have either the LOG or the TXT file extension. Log files are often used for troubleshooting purposes and may be requested by our customer support for further analysis of an issue.

This type of data need not be preserved for backups or when migrating document vaults to a new server computer.

4.3.9. What kind of operations can I schedule to be run at specific intervals in M-Files?

The following operations can be scheduled and run by M-Files Server as background processes:

- updating object workflow states
- sending notifications
- updating external object types
- updating external value lists
- making a backup of a vault
- optimizing vault database
- exporting content
- importing content
- backing up master database

See the links above for instructions on how you can specify a schedule to determine when each operation is run.

4.3.10. How do I check the location of the active search indexes?

By default, the Indexes folder can be found under the location specified in the properties of the vault. Check the index location:

1. In M-Files Admin, in the left-side tree view, right-click a document vault and select Properties from the context menu.
2. Open the Advanced tab, and then click the Define... button.

By default, the Indexes folder can be found under the location specified in the Location for secondary data on the M-Files server field.

In larger vaults, the search indexes might be placed in an alternate location. Check the alternate index location:
3. In M-Files Admin, access the advanced vault settings.
   a) Open M-Files Admin.
   b) In the left-side tree view, expand the desired connection to M-Files Server.
   c) In the left-side tree view, expand Document Vaults, and then expand the document vault of your choice.
   d) Still in the left-side tree view, select Configurations, and then in the gray navigation area, select Advanced Vault Settings.

4. Open the Configuration tab.

   ✓ The advanced vault settings are shown.
5. Expand Search > Indexes.

6. Check the active indexes from Active Metadata Index and Active Filedata Index or Active Combined Index.

7. Check the path to the indexes from the Path field of the index.


This section contains frequently asked questions related to common issues that document vault users may encounter.

In this chapter

• Why can't I access the document vault?
• Why can't I convert a document to PDF format or annotate a document?
• Why can't I find the Checked Out to Me view?
• Why can't I save an e-mail message as an Outlook message to M-Files?
• Why did a file with a grayed-out icon appear on the M-Files drive when I saved a new document in Microsoft Word?
• Why do document timestamps have the wrong time?

4.4.1. Why can't I access the document vault?

The cause of the problem can be either authentication or the network connection.

If there are problems with the network connection, an error message usually reveals the cause of the problem. As regards authentication, there can be a few problems that should be solved by making the following checks.

1. Check that you have an active login account in M-Files Admin (refer to Login Accounts) and that a user (refer to Users) has been created for the login account in the document vault.
2. Ensure that your password is correct.
3. Check that you are using the authentication method (Windows/M-Files) specified for your login account. You can see your authentication method in the Authentication column in the login accounts.

If the problem cannot be solved, contact the M-Files system administrator.

4.4.2. Why can't I convert a document to PDF format or annotate a document?

This topic offers you guidance if you are experiencing problems in one of the following situations when using M-Files Desktop:

• You right-click a document and select Sharing, E-mail and PDF > Save as PDF... from the context menu.
• You right-click a document and select Sharing, E-mail and PDF and then select either Convert to PDF (replaces original file) or Convert to PDF (adds separate file) from the context menu.
• You right-click a document and select Scanning and Text Recognition (OCR) > Convert to Searchable PDF... from the context menu.
• You right-click a document and select Create > Annotation... from the context menu.

Issues surrounding PDF conversions and annotations may be related to the same root cause since annotating a document requires that it is first converted to PDF format. See below for common solutions to these issues.

Reinstall the PDF converter

You may need to reinstall the PDF converter used by M-Files if you receive one of the following error messages after attempting to convert a document to PDF or after attempting to add annotations to a document:

• The M-Files PDF printer driver is not properly installed. Class not registered.
• Unspecified error.

First you need to uninstall PDF-XChange from your computer:

1. On the Windows Start menu, select Settings.
2. Select System > Apps & features.
3. Select PDF-XChange and click Uninstall.

Next, reinstall PDF-XChange:
1. Open the file C:\Program Files\M-Files\<version>\Client\PDFX6SA_sm.exe.
2. Follow the installer instructions to complete the installation.

Make sure that your computer has an application for opening the original document

To be able to convert a document to PDF format in M-Files, you need to have an application for opening the document installed on your computer. So for instance, if you wish to convert a Microsoft Word document to PDF, you need to have Microsoft Word installed on your computer. And similarly, if you want to convert a Microsoft Excel workbook to PDF, you must have Microsoft Excel installed on your computer.

Make sure the document is not checked out

Ensure that the document you are trying to convert is not checked out by another user. You need to able to check out the document to convert it to PDF format.

Make sure the document is not protected by password

Ensure that the document that you are trying to convert is not password-protected. If the document is protected by a password, M-Files is unable to open it and in such cases you are unable to convert the document to PDF format or to add annotations to it.

Make sure the document is not too large

If you attempt to add annotations to your document but the annotation toolbar is not shown, the file size of the document may be too large.

Similarly, your document may be too large if you try to convert it to PDF format but the conversion fails and an error message similar to the following is displayed:

Conversion of the file "Document.docx" to PDF format failed.
The size of the file, 11437522 bytes, exceeds the maximum size 10485760 bytes specified for Word conversions.

By default, the maximum allowed file sizes for PDF conversions for different file formats are the following:

- E-mail messages: 10 MB
- Microsoft Excel documents: 10 MB
- Images: 10 MB
- PDF documents: 10 MB
- Microsoft PowerPoint documents: 10 MB
- Visio documents: 10 MB
- Microsoft Word documents: 10 MB

Another limitation of converting large documents to PDF is time. If your PDF conversion takes more than 120 seconds to complete, the conversion fails with an error message similar to the following:

Conversion of the file "Document.docx" to PDF format failed.
The maximum execution time of 120 seconds was exceeded.

These limitations can be increased by modifying advanced vault settings on the M-Files server computer. For instructions, see Modifying PDF Conversion Limitations.
4.4.3. Why can’t I find the Checked Out to Me view?

Each user has the Checked Out to Me view, and it cannot be destroyed. However, the view may have been hidden.

Note: You can hide views by clicking the view and selecting Hide View from the View menu.

Do the following steps to display hidden views:

1. In the listing area, right-click on an empty area and select Unhide Views... from the context menu.

The Unhide Views dialog is opened.

2. Select the hidden view from the list and click Unhide.

3. Click Close to close the Unhide Views dialog.

4.4.4. Why can’t I save an e-mail message as an Outlook message to M-Files?

If you are an M-Files system administrator, you must enable saving attachments in Outlook format and install Microsoft Exchange Server or a 32-bit MAPI client on the M-Files server computer that hosts the document vault. For more information, see Mail Sources.

If you are a document vault user, inform your M-Files system administrator about this issue and refer the administrator to this page.

4.4.5. Why did a file with a grayed-out icon appear on the M-Files drive when I saved a new document in Microsoft Word?

The file became a temporary local file in the document vault. You can convert the temporary local file to a document. For instructions, see Converting a temporary local file to a document.

4.4.6. Why do document timestamps have the wrong time?

The Created timestamp shown on the metadata card title area indicates the original creation date and time of a file. It is not to be confused with the date and time a file was imported to M-Files.

Thus if your vault contains documents imported from an external source, the Created timestamp reflects the original creation date and time of the documents and not the date and time the documents were imported to M-Files. On the other hand, if you have created a new document in M-Files, the Created timestamp is the document creation date and also the date the document was added to M-Files.

When a document is added to M-Files, M-Files Server stores the Created timestamp in the UTC-0 format and the M-Files client then adjusts the displayed timestamp according to the time zone settings of your operating system.

4.5. General Questions

This section contains general questions about M-Files.

In this chapter

• Where can I find more information when I need it?
• What are the hardware requirements and recommendations?
• What's new in this M-Files version?
• How do the automatic updates work?
• Can I use M-Files programmatically?
• How do I write VBScript code for M-Files purposes?
• What is the difference between a named access control list (NACL) and a user group?

4.5.1. Where can I find more information when I need it?

In addition to this guide, you can look for help in the Getting started with M-Files guide or consult your organization's M-Files system administrator.

Customer Support

The M-Files upgrade agreement covers customer support (see also Contacting Support).

Customer support e-mail: support@m-files.com, tel.: +358 3 3138 7500.

Please note that customer support does not provide instructions on using the software.

More Information

For more information, you may consult the following sources:

• M-Files knowledge base
• M-Files Community

If you are a developer or an M-Files system administrator, you might be interested in our documentation for:

• M-Files API
• M-Files Web Service
• M-Files UI Extensibility Framework

For a full list of M-Files documentation, please visit m-files.com.

4.5.2. What are the hardware requirements and recommendations?

For technical specifications, refer to System Requirements and Technical Details.

In a system with fewer than 40 users, the M-Files server can be run on a computer meeting the Windows operating system requirements. The higher the number of concurrent users, the more is required of the hardware. Free space requirements depend on the number of documents and other objects. The version history, however, does not expand the disk space requirement in a linear fashion, because M-Files Server saves the data in the form of changes between different versions.

The M-Files server and its document vault can be easily transferred to another server machine as system requirements increase.

4.5.3. What's new in this M-Files version?

For more information about new, version-specific M-Files features, refer to the M-Files web site https://www.m-files.com/latest-ecm-features.
4.5.4. How do the automatic updates work?

M-Files automatically checks for software updates. When an M-Files update becomes available, the
update is downloaded to your computer and installed automatically. You can delay the update for a limited
time if you are working on something important while an update becomes available.

The feature obtains the latest update information from the update server using HTTPS on TCP port 443.
This means that normally you do not need to change any firewall settings.

Note: Users do not need local administrative rights on their computers for the automatic updates to
run.

See also Updating M-Files.

4.5.5. Can I use M-Files programmatically?

M-Files includes an ActiveX/COM API. Supported languages include VB.NET, C#, Visual Basic, VBScript,
and C++. Additionally, M-Files includes the M-Files Web Service API that allows programmatic access to
M-Files through a REST-like interface. See Application programming interface (API).

4.5.6. How do I write VBScript code for M-Files purposes?

You may use VBScript ("Microsoft Visual Basic Scripting Edition") code in M-Files for the following
functions:

• calculating automatic property values
• validating property values automatically
• triggering state transitions
• executing custom actions in a workflow state
• specifying custom conditions for workflow states for objects to be moved into or out of
  the said state
• defining customized events that are executed when specific events occur

See the links above for instructions on adding VBScript code in each instance.

You can access and manage objects contained in the document vault by means of M-Files API and
VBScript in the above-mentioned circumstances.

VBScript basics

Below are some elementary basics of VBScript to get you started. Note that we are just scratching the
surface here. See Useful resources for further instructions. If you are new to scripting and unfamiliar with
concepts such as variables and functions, it might be helpful to first read a beginner’s guide to scripting,
such as Learn Beginning Scripting.

Statements

In VBScript, a line break ends a statement and thus there is no separate termination character for ending
statements. The example below contains two statements:

Dim szPropertyName
szPropertyName = PropertyDef.Name
If you want to divide a statement into separate lines, you may use the underscore character ( _) to indicate that a statement is continued on the next line:

```vbscript
Err.Raise MFScriptCancel,
    "The document vault already contains an object with the same title. Please choose another title."
```

**Commenting**

Always comment what you are doing in your code so that others reading your code understand what is going on. You can add a comment in your code using the ' character:

```vbscript
' Get the title of the object.
Dim szCurrentTitle
szCurrentTitle = oCurrentTitleProp.GetValueAsUnlocalizedText
```

It is a good approach to add a comment above any line of code that you may think is not immediately obvious to the reader.

**Variables**

Variables are declared using the **Dim** keyword:

```vbscript
Dim szCurrentTitleProp
```

Values are assigned to variables using the equals (=) sign. You should always declare you variables before assigning them new values:

```vbscript
Dim szCurrentTitleProp
szCurrentTitleProp = PropertyValues.SearchForProperty( iTitleProperty ).GetValueAsUnlocalizedText
```

You may use the **Option Explicit** statement to force explicit declaration of all variables. If you attempt to use an undeclared variable when **Option Explicit** is enabled in your script, your script will not work. For instance, the following script would not work since the variable `szValue` has not been declared before it is assigned a value:

```vbscript
Option Explicit
szValue = PropertyValue.GetValueAsUnlocalizedText
```

When you are scripting in M-Files, you have a number of predefined variables at your disposal. The variable **PropertyValue**, for example, can be used for fetching the value of a property. See [Available VBScript Variables](#) for the complete list of predefined variables.

**Note:** We recommend you to use the so-called Hungarian notation when naming variables. This way you, or whoever reading your code, has a clear understanding of the data type of the value stored in the the variable. You can use, for instance, the following notation:

- "sz" for strings
- "o" for objects
- "i" for integers
• "b" for Booleans
• "f" for floating-point numbers
• "d" for dates

Constants

You can use constants for storing values that must remain constant throughout the script:

```vbnet
Const iMaxNumberOfItems = 50
```

Note that you must assign a literal value to a constant. You cannot use a variable, another constant or a function to initialize a constant.

Objects

Objects are assigned to variables using the Set statement. You may create a new instance of an M-Files API object and assign it to a variable in the following fashion:

```vbnet
Dim oTitleSearch
Set oTitleSearch = CreateObject("MFilesAPI.SearchCondition")
```

Objects are components that have their own properties and methods. Methods are functions that belong to a specific object and that can be used in the context of the object. Properties, on the other hand, are used to view or set values of an object. You access the properties and methods of an object using dot notation:

```vbnet
oTitleSearch.Set oTitleExpression, MFConditionTypeEqual, oTitleTypedValue
```

Method arguments, such as `oTitleExpression, MFConditionTypeEqual, and oTitleTypedValue` in the above example, are listed after the method and separated by a comma. Parameters are passed either by value or by reference. If a method takes a parameter by value, the method copies the value passed as the argument and thus the original value is unchanged. If, on the other hand, a method takes a parameter by reference, any changes the method may cause to the argument also impact the original reference. The value `Nothing` should be used if the default value of the parameter is to be used.

When scripting in M-Files, you will take advantage of the objects available in VBScript, and more importantly, the objects available in M-Files API. See M-Files API Documentation for complete details.

Concatenating strings

You may concatenate two or more strings into one using the `&` operator:

```vbnet
' Get proposal number.
Dim szNumber
szNumber = PropertyValues.SearchForProperty(1156).TypedValue.DisplayValue

' Get customer.
Dim szCustomer
szCustomer = PropertyValues.SearchForProperty(1288).TypedValue.DisplayValue

' Create proposal title.
Dim szName
szName = "Proposal #" & szNumber & " / " & szCustomer
```
In the above example, the proposal title, stored in the variable `szName`, is the result of the concatenation of the following strings:

- string literal `Proposal #`
- the proposal number, stored in the `szNumber` variable
- another string literal `/`
- the customer name, stored in the `szCustomer` variable

The resulting proposal title could thus be, for example, `Proposal #5577 / ESTT`.

You can add a line break to your string by concatenating the `VbCrLf` constant with your strings:

```vbnet
Err.Raise MFScriptCancel, 
    "The document vault already contains an object with the same title." & 
    VbCrLf & "Please choose another title."
```

### Raising errors

If you need to, say, validate a property value with VBScript, it is necessary to display an error message to the user if the value the user entered is invalid. You can raise an error in VBScript using the `Raise` method of the `Err` object:

```vbnet
Err.Raise MFScriptCancel, "The property "" & szPropertyName & "" must have a value of at least 10 characters."
```

The method takes the error number and description as parameters. For M-Files scripting purposes, the `MFScriptCancel` variable is used as it stores the M-Files error number.

### If statements

If statements are used for executing a group of statements if the condition specified in the `If` statement evaluates to true:

```vbnet
If Len( szValue ) < 10 Then 
    Err.Raise MFScriptCancel, "The property "" & szPropertyName & "" must have a value of at least 10 characters."
End If
```

The if block must end with an `End If` statement. All the statements between `If` and `End If` are executed if the condition specified between `If` and `Then` evaluates to true. You can use the `And` operator to specify multiple conditions that must all be true for the if block to be executed, or the `Or` operator to specify multiple operators, one of which must be true for the if block to be executed. You can use the following comparison operators for specifying the condition:

- `==` checks if the value of two operands are equal or not, if yes, then the condition is true.
- `<>` checks if the value of two operands are equal or not, if not, then the condition is true.
- `>` checks if the value of the left operand is greater than the value of the right operand, if yes, then the condition is true.
- `<` checks if the value of the left operand is less than the value of the right operand, if yes, then the condition is true.
• $\geq$ checks if the value of the left operand is greater than or equal to the value of the right operand, if yes, then the condition is true
• $\leq$ checks if the value of the left operand is less than or equal to the value of the right operand, if yes, then the condition is true

You can also nest an If statement inside another If or, say, an Else statement or use the ElseIf statement to create a deeper branching logic in your script.

**Functions and subroutines**

You can use a subroutine to define a section of code to be used multiple times by reference in your code:

```vbscript
Sub CloseFile()
    oMyFile.Close
    Set oMyFile = Nothing
End Sub
```

Or, you can define a function to use multiple times a section of code that returns a value of some kind:

```vbscript
Function IsOdd( iValue )
    If iValue MOD 2 = 0 Then ' Even value.
        IsOdd = False
    Else ' Odd value.
        IsOdd = True
    End If
End Function
```

To call a subroutine or function in your script, just refer to it by name:

```vbscript
Closefile()
IsOdd( 5 )
```

**Useful resources**

Your most valuable sources of information on scripting within M-Files are the following:

- M-Files API Documentation
- Available VBScript Variables

The M-Files API documentation is an exhaustive reference to the M-Files API objects, methods, interfaces, properties, and enumerations that you can take advantage of within VBScript code. The latter resource, on the other hand, lists and explains all the variables with preassigned values that you can readily utilize in your VBScript code.

In addition to the two aforementioned resources, you may find the following external websites useful:

- VBScript User's Guide
- VBScript Functions
- Learn Beginning Scripting
Example

The example below is a script that can be used for validating a property when the user attempts to save metadata changes on the metadata card. The script ensures that the entered property value must be at least 10 characters in length. Let us take a closer look at the script:

```vbscript
Option Explicit
Dim szPropertyName, szValue
szPropertyName = PropertyDef.Name
szValue = PropertyValue.GetValueAsUnlocalizedText
If Len(szValue) < 10 Then
    Err.Raise MFScriptCancel, "The property "" & szPropertyName & "" must have a value of at least 10 characters."
End If
```

First, the variables `szPropertyName` and `szValue` are declared, after which the name of the property and its value we are validating are stored in the variables we have just declared. We use the `GetValueAsUnlocalizedText` method (see M-Files API Documentation for more information) to obtain the property value as unlocalized text.

Our condition for validating the property value is that the value must have at least 10 characters. We evaluate that condition in an `If` statement. We have defined in the condition of the `If` statement that the length of the property must be less than 10 characters for the statement inside the `If` statement to be executed. If the property value is 10 characters or more, the `If` code block is not executed and the script execution is finished.

In the if block, we send an error message to the user where we state that the property value that the user entered must have at least 10 characters, thus instructing the user to add a longer value. After the error message is displayed, the metadata card is displayed again, allowing the user to modify the invalid property value.

For complete instructions on validating property values with VBScript, see Automatically Validating Property Values.

4.5.7. What is the difference between a named access control list (NACL) and a user group?

M-Files allows you to use named access control lists and user groups to manage information related to a group of individuals, but they essentially serve a very different purpose.

With **user groups**, administrators can arrange individuals into separate groups based on common features, such as their position in the organization (for example "HR" and "Managers"), their physical location (for instance "Vermont office" and "Chicago office"), or their expertise (such as "Legal matters" and "Translation"). User groups can be managed with M-Files Admin (see User Groups).

**Named access control lists**, on the other hand, can be used for specifying various access rights to objects in a vault. They contain a list of subjects (individual users, user groups or pseudo-users) coupled with a list of permissions, essentially controlling rights for reading, editing and deleting objects as well as for changing their permissions. Named access control lists can also be managed with M-Files Admin (see Named Access Control Lists).
Example: Employment agreements to be visible to the HR department only

The vault contains a large number employment agreements that are currently visible to all vault users. The HR manager wants them to be visible to the HR team only.

The first thing she needs to do is create a user group for all the users that belong to the HR team. Now, as she cannot use the user group to directly control any access rights, she also needs to create a named access control list for associating the newly created user group with the access rights of her choice.

**Note:** Users whose login account has the System administrator system role, and users who have either the See and read all vault content or Full control of vault rights are able to see all vault content.

Finally, the HR manager has to associate the newly created named access control list with the employment agreements. She can achieve this via the properties of the employment agreement class.

**Opening the properties dialog for a class:**

1. Open M-Files Admin.
2. In the left-side tree view, expand the desired connection to M-Files Server.
3. In the left-side tree view, expand Document Vaults.
4. Still in the left-side tree view, expand the document vault of your choice, and then expand Metadata Structure (Flat View) and finally select Classes.
5. Via the listing area on the right, select the class representing the employment agreements.
   - If there is no class for employment agreements, you can create a new class for this purpose.
6. From the task bar on the left side of the listing area, select Properties.

**Setting the class to use the named access control list:**

7. Open the Automatic Permissions tab.
8. Check the Restrict the permissions of objects that refer to this class check box.
9. Check the Use named access control list check box.
10. Select the newly created named access control list via the drop-down menu below the check box.
11. Click OK to close the Class Properties dialog.
12. Optional: If an information dialog about disabled automatic permissions for certain property definitions is displayed, note down the property definitions mentioned in the Property definitions currently disabled list and click OK.

To make sure that the permission settings are activated when the class for an employment agreement is selected as the value of any of the properties mentioned in the list, you need to explicitly allow automatic permissions to be used for these property definitions.
13. In the dialog changed automatic permissions, select either:

   a. **Change Objects' Permissions** to apply the new access rights to all the objects that will be created from this moment forward.

      Note: Object permissions are updated as an asynchronous background task. Object permissions may be updated when, for example, a named access control list, a user, a user group, or the value of a pseudo-user (such as a project manager) is modified. You may monitor the progress of the task in M-Files Admin in the **Background Tasks** section. For more information, see Monitoring Background Tasks.

   or

   b. **Change and Activate Objects' Permissions** to apply the new access rights to all the existing objects as well as to all the objects that will be created from this moment forward.

   or

   c. **Cancel** to return to the **Class Properties** dialog.

**Enabling automatic permissions to be used via related properties:**

14. In the left-side tree view, under **Metadata Structure (Flat View)**, select **Property Definitions**.

15. Double-click one of the property definitions that you noted down in step 12.

16. Select the **Enable automatic permissions via this property** check box and click **OK**.

17. Select either **Change Objects' Permissions** or **Change and Activate Objects' Permissions** (see step 13).

18. Repeat the steps from 15 to 17 for all the property definitions noted down in step 12.


Depending on what you selected in step 13, either a) only new objects or b) both new and existing objects whose class represents the employment agreements are now visible only to the user group whose members are part of the HR department. As explained in this note, this does not, however, apply to system administrators and vault users with rights to see and read all vault content.

**5. Contacting Support**

See this section for information on contacting our customer support if you are unable to find the answer to your question in the FAQ section.

If you cannot find a solution to your problem in the user guide, you may want to search the M-Files knowledge base for an answer. You can also create a support ticket at M-Files Support or contact the M-Files customer support at support@m-files.com.

When contacting support, in addition to a written description of the problem, please include as much of the following information as possible to speed up the support process:

- your Windows version and system type (64-bit or 32-bit)
- the complete M-Files Desktop and M-Files Server version numbers (such as 11.3.4330.130, for instructions on determining the version numbers, see Checking the Full Version Number of M-Files Desktop and M-Files Server)
• the number of affected users
• the frequency of the problem
• the exact sequence of steps for reproducing the problem
• application-level error messages in Windows Event Viewer (for instructions on retrieving M-Files errors from Windows Event Viewer, see Saving a Copy of M-Files Errors in the Windows Application Event Log)
• the name and complete version number of the installed antivirus software
• the contents of the M-Files error message dialog including a copy of the complete error stack trace, see example:

![M-Files 2017 error message dialog](image)

• The error stack trace can be displayed in the error dialog by clicking the Details button. Note that the screenshot does not show the entire error stack trace and thus you should copy it as text in its entirety.
• When did you start experiencing the issue and have you made any significant changes to your M-Files environment before the issue occurred?
• If a file cannot be opened via M-Files, can it be dragged to desktop and accessed on the local drive?

You should also be able to describe the status of your document vault and answer the following questions:

• Does the document vault use Firebird or Microsoft SQL Server as the database engine? If the latter is used, is Microsoft SQL Server installed on the same computer as M-Files Server, or is it installed on a separate computer?
• Is the file data included in the database or stored in a separate location?
• Has the document vault been optimized recently?
  • Optimization procedures take the document vault offline.
  • Has the vault been verified and repaired recently?
  • If M-Files Admin is used for verifying and repairing the document vault, does it report any errors?
  • Has the document vault been indexed lately?
• Does the M-Files installation include integrations or other add-ons (Dynamics, SharePoint, Salesforce, and so on)?
  • Provide the full version information of any integrations or add-ons.

If you are having issues with using M-Files with Office products, provide the following additional details:

• Microsoft Office version
• the program (Word, Excel, Outlook, PowerPoint) causing the problem

Note: Any relevant screenshots of the situation and settings are always helpful. You may also attach to your support request any files related to your issue.
In this chapter

- Checking the Full Version Number of M-Files Desktop and M-Files Server
- Saving a Copy of M-Files Errors in the Windows Application Event Log

5.1. Checking the Full Version Number of M-Files Desktop and M-Files Server

**Note:** These instructions are for Windows 10, but the procedure is highly similar for other Windows versions.

Complete the steps below either on the M-Files Desktop client computer to identify the full version number of M-Files Desktop or on the M-Files Server computer to identify the full version numbers for both M-Files Desktop and M-Files Server.

1. Right-click the Windows taskbar and select Task Manager from the context menu.
   - The Task Manager window is opened.

2. Open the Services tab.

3. Locate the MFClient (M-Files Desktop) and MFServer (M-Files Server) services in the Name column.

4. Take note of the full version number of each service in parentheses in the Description column.

5.2. Saving a Copy of M-Files Errors in the Windows Application Event Log

**Note:** These instructions are for Windows 10, but the procedure is highly similar for other Windows versions.

If every M-Files user in your organization is experiencing the same issue, it is recommended to save a copy of the application event log on the M-Files server computer. If the issue is an isolated one, on the other hand, you should only save a copy of the log on the computer where the issue occurs. Complete the steps below on the appropriate computer.

1. Right-click the Start icon and select Event Viewer from the context menu.
   - The Event Viewer window is opened.

2. In the left-side tree view, expand Windows Logs and then select Application.

3. Click Filter Current Log... on the Actions pane.
   - The Filter Current Log dialog is opened.

4. Open the Event sources drop-down menu and select M-Files and any other applications related to M-Files, such as M-Files Compliance Kit or MFClient.

5. Click OK to close the Filter Current Log dialog.

6. Click Save Filtered Log File As... on the Actions pane.
7. Specify a location and a file name, and then click **Save**.

A copy of the filtered application event log is saved to the location that you have specified. The copy contains only the errors that are related to M-Files.

---

### 6. Add-on Tools

This section contains the user guides for the M-Files add-on tools.

The M-Files add-on tools are integrated with the M-Files platform to offer additional features and capabilities.

**Note:** The add-on tool guides are available in English only.

---

**In this chapter**

- **M-Files Process Maps Tool**

  The M-Files Process Maps tool is an add-on application that allows users to create visual representations of their organization's business processes.

---

### 6.1. M-Files Process Maps Tool

The M-Files Process Maps tool is an add-on application that allows users to create visual representations of their organization's business processes.

This section of the user guide is intended for M-Files Process Maps users. Its aim is to instruct users on how to use the design tool to create process maps.

If you are unable to find the guidance or support you need in this user guide, please see the M-Files user guide or contact M-Files support.

---

**In this chapter**

- **Introduction to M-Files Process Maps**
- **Designing Process Maps**

---

### 6.1.1. Introduction to M-Files Process Maps

M-Files Process Maps provides users a visual navigation experience. As regulations become more complicated and demanding, being able to demonstrate good governance is a critical organizational need. Using the Process Maps Designer, users can create maps that represent their organization's business processes. These maps not only demonstrate good governance, but they also ensure organizational consistency, improve process efficiency, and facilitate overall transparency.

Maps can be viewed in M-Files Desktop, M-Files Web, and M-Files Mobile.

Maps can be exported in SVG format and imported to Microsoft Office applications like Word, PowerPoint, or Visio.
Process Maps Designer

With the designer, you can create and edit various types of business process maps, including BPMN maps, flow charts, EPC maps, and freely-modeled maps.

Figure 140: Process Map Designer User Interface

See Creating, Accessing, and Editing Maps in M-Files to learn how to open the Process Maps Designer.

Map Preview

The Map Preview gives users read-only access to existing process maps in M-Files. With the Map Preview, you can view, navigate, consume content, and invoke process map commands. For more information, see Using the Map Preview.
In this chapter

- Creating, Accessing, and Editing Maps in M-Files
- Using the Map Preview
- Getting Familiar with the Process Maps Designer User Interface
- Getting Familiar with Process Map Classes

Creating, Accessing, and Editing Maps in M-Files

Process Maps function like any other object in M-Files.

They can be managed through key M-Files capabilities like metadata, permission settings, and workflows.
In this chapter

- Creating a Process Map in M-Files
- Accessing Process Maps in M-Files
- Editing Process Maps in M-Files
Creating a Process Map in M-Files

Using the M-Files Create menu, you can create new process maps.

**Videos/creating_new_maps/creating_new_maps.mp4**

**Creating a Process Map Object and Opening the Designer**

Complete the following steps to successfully create a Process Map in M-Files.

1. Using the Create menu, create a Process Map object.
2. Specify what sort of map you would like to create.
   a. Select a process map class.
   or
   b. Create a map using a template.
3. Click Next.
4. Fill out the rest of the metadata card.
5. Click Create.

M-Files automatically opens the Process Maps Designer.

**Accessing Process Maps in M-Files**

Performing searches or using views are the most typical ways of finding process map objects in M-Files.

**Accessing Objects Using Simple or Advanced Searches**

Search for and access objects via simple or advanced searches in the Filters tab. Perform searches via keywords, metadata, and file content.

![Search Functions](image)

**Figure 143: Search Functions**

For more comprehensive guidance about search functions, see Searching for Documents and Searching.

**Accessing Objects Using Views**

Views are virtual folders that group documents and other objects according to specific criteria or metadata. You can access all process maps in the Process Maps common view.
For more comprehensive guidance about using views and creating new views, see Getting Familiar with Views and Using Views.

**Editing Process Maps in M-Files**

Users with editing rights can modify existing process maps in M-Files using the Process Maps Designer.

There are two ways you can open the designer for editing:

**Checking Maps In and Out**

Use the check in/check out features in M-Files. See Checking Out a Document and Checking In a Document.

**Editing Commands**

Use the Editing Command icon in the Map Preview. See Using the Map Preview.

**Using the Map Preview**

The Map Preview allows users to navigate through map content in an interactive manner.

**The Preview Tab**

You can select a map in M-Files and use the Preview tab labeled Map to view and navigate through map content.

**The Preview Pop-out Window**

You can also navigate map content in the Preview window by accessing the read-only version of the map.
Preview Features - Toolbar

- 1 - Refresh Page
- 2 - Hide or Show Command Icons
- 3 - Navigation Commands
- 4 - Zoom Capabilities
- 5 - Edit/Open Designer Tool

Navigating Between Maps

You can also use the Map Preview to navigate between maps and objects in M-Files.

Invoking Commands

You can enact established commands in the Map Preview. See Working with Commands for more information.

Zoom Capabilities

You can control the zoom capabilities via the following:

- The Zoom Navigator in the toolbar.
- CTRL + + or -
- CTRL + w

Getting Familiar with the Process Maps Designer User Interface

With the Process Maps Designer, you can create new maps and edit existing maps in M-Files.

For more information on opening the designer, please see Creating, Accessing, and Editing Maps in M-Files.

Note: The user interface varies depending on the selected process map class. See Getting Familiar with Process Map Classes for more information.

User Interface

The user interface of the designer contains the following areas:
• **Toolbar** - Contains standard shapes and attribute options.
• **M-Files Objects Menu** - Pane for searching, browsing, and selecting M-Files objects.
• **Canvas** - Design area that holds the various drawing elements.
• **Canvas Navigator** - Controls the canvas display.
• **Zoom Navigator** - Contains zoom controls.
• **Shapes and Symbols Menu** - Pane for searching, browsing, and selecting various map shapes and symbols.
• **Properties Menu** - Contains options for assigning properties, such as commands and values to elements.

**Note:** The Properties menu is only accessible when an element is selected.

Videos/user_interface_introduction/user_interface_introduction.mp4

**Key Terms**

Please review the table below to become familiar with the key terminology of the designer.

**Table 2: Process Maps Designer Terminology**

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Element</strong></td>
<td>Inclusive term referring to graphical items used for drawing or creating process maps. Includes symbols, shapes, M-Files objects, and connecting lines.</td>
</tr>
<tr>
<td><strong>Symbol</strong></td>
<td>Symbols are pre-defined drawing elements that have specific meanings and contexts according to particular workflow notations. Symbols can be loaded with additional attributes. They are accessible in the <em>Shapes and Symbols Menu</em>.</td>
</tr>
<tr>
<td><strong>Shape</strong></td>
<td>Shapes are pre-defined drawing elements that can be manipulated and modified. These do not necessarily represent any specific action or step in a process and are independent of a specific workflow notation. Shapes offer green ports for modification. They are accessible in the <em>Shapes and Symbols Menu</em>.</td>
</tr>
<tr>
<td><strong>Node</strong></td>
<td>Nodes are present in all elements. Nodes are points that are connected by edges.</td>
</tr>
<tr>
<td><strong>Edge</strong></td>
<td>Edges are lines in shapes that connect nodes. Edges and Nodes serve as the technical core concepts of the M-Files Process Maps tool.</td>
</tr>
<tr>
<td>Term</td>
<td>Definition</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Port</td>
<td>Ports are represented in red and green. Green ports give you the ability to modify the shape’s appearance. Red ports are offered when drawing connections between elements. See <a href="#">Connecting Elements</a></td>
</tr>
<tr>
<td>Connector</td>
<td>Connectors are lines that connect ports.</td>
</tr>
<tr>
<td>Selector</td>
<td>Selectors enable you to select different elements. Selectors are represented in grey.</td>
</tr>
<tr>
<td>Property</td>
<td>Properties are attributes that an element can carry. Properties can be edited via the <a href="#">Properties Menu</a> of the designer.</td>
</tr>
<tr>
<td>Value</td>
<td>Values are characteristics assigned to particular graphical items. Values can be edited via the <a href="#">Properties Menu</a> of the designer.</td>
</tr>
</tbody>
</table>
### Term | Definition
--- | ---
**Command** | Commands offer users additional interactivity and functionality in the Map Preview. Any object, symbol or shape can be assigned commands, like opening documents or emailing a colleague. See [Using the Map Preview](#) and [Working with Commands](#) for more information.

**Zoom Capabilities**
You can control the zoom capabilities via the following:

- The Zoom Navigator in the bottom right-hand corner of the Process Maps Designer.
- CTRL + Mouse wheel
- CTRL + 0, 1, 2, 3, or 4

**Getting Familiar with Process Map Classes**
The M-Files Process Maps tool offers four built-in process map methodologies: traditional flow charts, event-driven process chain (EPC) diagrams, business process modeling and notation collaboration diagrams (BPMN), and portfolios. Each of these methodologies offers drawing and design elements consistent with the conventions of these methods. For this reason, the user interface of the Process Maps Designer varies per methodology.

You can use these built-in methodologies by creating a process map object and selecting the suitable metadata class. For more information on how to create a process map object, see [Creating, Accessing, and Editing Maps in M-Files](#).

**Flowchart**
Traditional Flowchart Drawing Elements
EPC Diagrams

EPC Diagram Drawing Elements
BPMN Diagrams

BPMN diagrams offer additional properties for *task* or *event* elements. These properties are consistent with common BPMN conventions.

These properties can be accessed by selecting any *task* or *event* element, and accessing the properties pane. See *Getting Familiar with the Process Maps Designer User Interface* for information on accessing the properties pane.
### Table 3: Property Options for Task and Event elements

<table>
<thead>
<tr>
<th>Element Type</th>
<th>Property Options</th>
</tr>
</thead>
</table>
| **Task**     | **Tasks Types**: task, send, receive, user, manual, business rule, service, script  
|              | **Task Markers**: loop, parallel MI, sequential MI, ad hoc, compensation, call  |
| **Event**    | **Event Class**: catching, interrupt, non-interrupt, throwing  
|              | **Event Types**: none, message, timer, escalation, conditional, off page, error, cancel, compensation, signal, multi, parallel multi  |

BPMN Collaboration Drawing Elements
Portfolio

Portfolio Drawing Elements
6.1.2. Designing Process Maps

Using the Process Maps Designer, you can easily create dynamic and interactive visual maps that reflect your organization's business processes.

The designer offers pre-defined symbol sets for traditional flowcharts, BPMN collaboration diagrams, and EPC diagrams, but also allows users to freely create maps. See Getting Familiar with Process Map Classes to learn more.

In addition to the drawing capabilities, the following features are available:
• **Commands** - Add commands to maps for further interactivity. Any symbol or shape can be assigned commands, like opening documents or emailing a colleague. See [Working with Commands](#).

• **Metadata** - Process maps function as M-Files objects and are empowered by metadata. Each process map has a metadata card allowing for easy map control, accessibility, and security.

• **Linking information** - Insert any M-Files object in your process maps. This includes other process maps, images, documents, videos, and much more. This feature enhances the navigation experience and allows you to find relevant content quickly and easily. See [Inserting M-Files Objects](#).

**Drag and Drop**

The drawing and mapping experience extensively uses drag and drop principles. Simply drag and drop elements on the canvas and use the cursor to move the elements and edit them freely.

[Videos/drag_and_drop_demo/drag_and_drop_demo.mp4](#)

**Drawing Elements**

Drawing Elements can be added by selecting the appropriate icon on the toolbar and placing the element on the canvas by click-dragging with the primary mouse button.

[Videos/drawing_demo/drawing_demo.mp4](#)

**In this chapter**

• [Working on the Process Maps Design Canvas](#)
• [Working with Process Map Elements](#)

**Working on the Process Maps Design Canvas**

The process maps design canvas serves as the main drawing area for the designer. The canvas offers various functionalities to make the drawing experience easier for each user.

**Canvas Modes**

The design canvas has two modes: unlimited canvas mode and page mode.

• Unlimited mode offers unlimited drawing space.
• Page mode divides the canvas into pages which allows for easy printing.

[Videos/canvas_modes/canvas_modes.mp4](#)

**Canvas Grid**

The grid is an optional overlay that you can enable to structure map content. The grid is a set of measurements the designer uses to align and size objects within a given format.

When the grid is enabled, content is automatically aligned and sized according to grid measurements.

You can show/hide the grid using the *Grid* icon in the toolbar.
For more information about the canvas navigator and zoom capabilities, see Getting Familiar with the Process Maps Designer User Interface.

**Working with Process Map Elements**

The Process Maps Designer offers limitless capabilities when it comes to customizing and connecting elements.

**Getting familiar with element functions on the canvas**

Once elements are placed on the canvas, you can employ the following functions to facilitate the map design experience.

**Single-click Select**

Single-click an element to select it for modification. Videos/1_click_select/1_click_select.mp4

**Double-click Select**

Double-click an element for text editing and formatting. Videos/2_click_select/2_click_select.mp4
Group Select and Select All

You can select multiple elements by clicking an area on the canvas and dragging the selection box over the desired elements.

Videos/group_select_demo/group_select_demo.mp4

To select all elements on the canvas, use the keyboard command CTRL + A

Snaplines

Snaplines assist users to accurately position elements on the canvas.

Note: To show or hide snaplines, click the icon in the toolbar.

Note: Holding the ALT key while click-dragging an element disables snapline and grid alignment, allowing you to place elements on the canvas freely.

Videos/snaplines_demo/snaplines_demo.mp4

Copying and Pasting Elements

You can easily copy and paste elements by selecting an element and using one of the following keyboard commands:

• CTRL + C to copy and CTRL + V to paste
• Holding CTRL + Shift and click-drag the element to paste

Videos/Copy_paste_demo/Copy_paste_demo.mp4

Layers and Element Order

Layers are simultaneous, over-lapping components of a map. You can modify the layer order using the Drawing Order menu.

Right-click an element to access its context menu and select an option from the Drawing Order menu. Videos/element_layers_order/element_layers_order.mp4

In this chapter

• Formatting Elements
• Connecting Elements
• Reusing and Publishing Content to Process Maps Store
• Working with Text and Labels
• Working with Commands
• Working with Anchors and Viewports
• Inserting M-Files Objects

Formatting Elements

The Process Maps Designer offers unlimited options for formatting and customizing elements. You can change element lines and fill colors, add shadows, and assign certain behaviors.
**Toolbar Formatting Options**

The toolbar formatting options are enabled by single-clicking an element. Elements include shapes, symbols, and lines. Using the toolbar options, you can adjust line attributes, fill color, and shadows. Videos/toolbar_formatting/toolbar_formatting.mp4

**Resizing and Modifying Elements**

**Resizing Elements**

You can resize elements by selecting and click-dragging to the desired size.

![Modification](image)

**Modifying Using Nodes**

Shapes offer nodes that you can click-drag for further modification. Nodes are represented in green.

![Modification](image)

**Editing Polylines**

Using the *Editing Polylines* feature, you can also freely modify points in a shape or line. Videos/editing_polylines/editing_polylines.mp4

**Formatting Element Behavior**

By right-clicking an element, you are presented with the context menu. In the *Behavior* menu, you can assign certain behaviors to elements.
- **Container** - Dictates whether the element can contain other elements or objects.
- **Deletable** - Dictates whether other users editing the map can delete this element.
- **Movable** - Dictates whether other users editing the map can move this element.

**Format Copying and Pasting**

The designer allows users to copy and paste formatting onto other elements. This can be done through the copy and paste format options in the context menu.

Videos/formating_copying_pasting/formating_copying_pasting.mp4

**Deleting Elements**

To delete an element, select it and press the Delete key.

**Connecting Elements**

In the Process Maps Designer, you can use various lines to demonstrate how certain process elements are connected to each other.

**Drawing Lines and Using Ports**

Choose from various connecting line styles by selecting the icon in the toolbar.

> **Note:** Line styles vary depending on the process map class. See Getting Familiar with Process Map Classes for more information.

Elements are connected through ports, represented in red.
To draw the line, select the line style from the toolbar menu and click-drag the line from the desired port of the starting element to the ending element.

**Note:** Shapes have multiple ports users can select from.

**Note:** Connecting elements through ports ensures that if one element moves or changes, the connection remains.

---

### Formatting Connecting Lines

Lines operate like any other element in terms of formatting. See [Formatting Elements](#) for more information.

### Reusing and Publishing Content to Process Maps Store

The Process Maps Designer offers ways for users to reuse map content through the store.

You can reuse and publish content to and from personal and public stores.

- **Personal** - content in the personal store is only accessible to the current user.
- **Public** - content in the public store is accessible to all users in the organization.

### Adding Elements to the Store

The store can be accessed by selecting or group-selecting elements and using the selecting from the *Add to store* option in the right-click context menu.

[Videos/using_the_store/using_the_store.mp4](#)

### Inserting Elements from the Store

Using the store, you can reuse previous published elements. To reuse published content, right-click and select the *Insert from store* option from the context menu.
Working with Text and Labels

You can display text using either text boxes or labels.

Creating Text boxes

Text boxes are stand-alone elements that display text. Draw text boxes on the canvas using the text box icon in the toolbar.

Working with Labels

Most elements have labels. You can modify, remove, and add labels freely.

To access an element's label, click the element twice.

Label Positioning

You can select and freely position the label by click-dragging on the canvas or through the automatic label positioning features in the toolbar.

Adding Additional Labels

You can add additional labels by right-clicking an element and selecting the Add Label option from the context menu.

Videos/label_positioning/label_positioning.mp4

Videos/textboxes/textboxes.mp4

Videos/inserting_from_store/inserting_from_store.mp4
Formatting Text

You have two options when it comes to formatting text: the formatting pop-up menu that appears when text is highlighted and the toolbar formatting options when a text element is selected.

![Text Formatting Pop-up Menu](image)

Figure 150: Text Formatting Pop-up Menu

![Toolbar Formatting Options](image)

Figure 151: Toolbar Formatting Options

Working with Commands

M-Files Process Maps offers command features that enable users to perform various tasks when navigating through map content.

You can invoke commands using the Map Preview. See Using the Map Preview for more information.

Commands can be established using the Process Maps Designer.

Defining Commands

When establishing commands, you must define how the command is to be carried out.
## Table 4: Defining Commands in Process Maps Designer

<table>
<thead>
<tr>
<th>Term</th>
<th>Meaning</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>What to click on?</td>
<td>Icons include</td>
</tr>
<tr>
<td>Trigger</td>
<td>How to trigger the action?</td>
<td>Triggering actions include clicking, double-clicking, hovering, and key commands.</td>
</tr>
<tr>
<td>Action</td>
<td>What is the action? What is to happen?</td>
<td>Actions include show, open, M-Files view, edit, create, jump or navigate to. See the table Table 5: Command Action Definitions.</td>
</tr>
<tr>
<td>Term</td>
<td>Meaning</td>
<td>Options</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Target</td>
<td>What receives the action?</td>
<td>Targets can be an M-Files object, anchor, M-Files view, HTTP URL.</td>
</tr>
</tbody>
</table>

Table 5: Command Action Definitions

<table>
<thead>
<tr>
<th>Action</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Metacard</td>
<td>Shows the metadata card for the object.</td>
</tr>
<tr>
<td>Show</td>
<td>Shows the established target. Optional targets include M-Files objects or views in the desktop client, or HTTP URLs.</td>
</tr>
<tr>
<td>Open</td>
<td>Shows the check-out dialog and opens the document in the default application.</td>
</tr>
<tr>
<td>View</td>
<td>Opens the document in the default application in read-only mode without prompting the user to check it out.</td>
</tr>
<tr>
<td>Edit</td>
<td>Checks out the object and opens it for editing in the default application.</td>
</tr>
<tr>
<td>Create</td>
<td>Prompts users to create a new object, for example a new document based on a particular template.</td>
</tr>
</tbody>
</table>

Example: The following is an example of command settings that will enable a user to open an M-Files document when double-clicking a particular symbol.

- Item:
  - Trigger: double-clicking
  - Action: show
  - Target: M-Files object

Creating an Action Command

You can add commands to elements through the Properties pane.

Videos/creating_commands/creating_commands.mp4

Editing and Deleting Commands

To edit or delete a command, select the element and use the edit and delete icons in the Properties pane.
Working with Anchors and Viewports

Anchors and viewports allow users to navigate from one element, or group of elements to another within a single map using the map preview. See Using the Map Preview.

Viewports are windows that display a portion of the total map content.

Anchors create connections between one viewport and an element.

GIF_Animations/Anchoring_and_viewports_preview/Anchoring_and_viewports_preview.mp4

You can create viewports and anchors in the Process Maps Designer, see Creating Viewports and Anchors.

Editing Anchor Mode

To successfully create anchors and viewports, you must enable the Edit Anchor mode in the Process Maps Designer. Enabling the Edit Anchor mode allows you to create viewports and anchors, and also view, modify, or delete existing ones.

To enable and disable the Edit Anchor mode, click the corresponding icon in the toolbar.
**Note:** You must disable the *Edit Anchor* mode to be able to save the map.

**Icons and Definitions**

Using the viewport icons, you can create initial viewports and anchors.
Table 6: Anchor and Viewport Icons and Definitions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>★</td>
<td>Initial Viewport - Marks the current viewport as the initial viewport. See Creating an Initial Viewport.</td>
</tr>
<tr>
<td>⬆️</td>
<td>Anchor Options - You can choose either option to create an anchor from the current viewport to an element in the map. See Creating Viewports and Anchors.</td>
</tr>
<tr>
<td>🕵️‍♀️</td>
<td>Hide/open anchor options - Access the anchor options.</td>
</tr>
</tbody>
</table>

In this chapter

- Creating an Initial Viewport
- Creating Viewports and Anchors

Creating an Initial Viewport

After enabling the Edit Anchor mode, you can use the Create Viewport feature to draw viewports on the design canvas. As an option, you can establish an initial viewport that launches when the map is opened in the Map Preview.

Initial viewports are enabled using the ★ icon.

GIF_Animations/Creating_Initial_viewport/Creating_Initial_viewport.mp4

Creating Viewports and Anchors

Viewports are content windows within a single map. You can navigate between content windows using anchors.
Working with Anchors

Anchors tell the Map Preview what content to display when an element or viewport has been clicked.

To successfully create an anchor, you must first establish the following:

• **Item**: Which element or viewport do you click on?
• **Target**: Where does it lead to?

To create an anchor, click-drag the anchor from the target content to the item.

GIF_Animations/Anchoring_and_viewports/Anchoring_and_viewports.mp4

Drawing Viewports

Create viewports by enabling the *Edit Anchor* mode and using the *Create Viewport* feature in the toolbar to draw a viewport on the design canvas.

GIF_Animations/Anchoring_and_drawing_viewports/Anchoring_and_drawing_viewports.mp4

Inserting M-Files Objects

Using Process Maps Designer, you can insert pre-existing M-Files objects on the map.

Placing objects on maps automatically creates action commands that can be invoked in the Map Preview. See Using the Map Preview for more information.

Browsing for M-Files Objects

The designer toolbar offers various methods for accessing M-Files objects.

- The icon allows you to filter objects by type.
- With the icon, you can add a new object.
- You can adjust search settings with the icon.

Videos/browsing_for_objects/browsing_for_objects.mp4

Dragging and Dropping Objects

Like other elements, you can drag and drop objects onto the canvas from the left-hand menu. Videos/drag_drop_objects/drag_drop_objects.mp4

Modifying Automatic Commands

Objects placed on the canvas have pre-configured action commands. You can view and edit these commands by selecting the object element and accessing the command settings in the properties pane. See Working with Commands for more information.

Videos/edit_automatic_commands/edit_automatic_commands.mp4
Index

A
access control list 541
additional conditions 163
additional information 726
administrative rights 492
advanced vault settings 556, 645
alias 400, 402
Android 54
annotations 726
enabling 275
using 106
application 106
configuration 549
connector 530
disable 547
enable 547
export 547
install 547
intelligence service 627
license 547
type
client application 206, 547
server application 206, 547
uninstall 547
archiving 98, 359
assignment 85
AutoCAD 85
M-Files functions 119
automatic updates
registry settings 238, 664
settings 212, 235
automatic value
VBScript 463

B
back up a search index 303, 303, 303
back up a vault 297
background tasks 357
backup
differential 261
full 261
secondary data 711
blacklist 670
bring online 310
business Intelligence 586

C
cache 211
CFR 223
check in
check in with comments 105
check out 99, 688
class
class group 487
create 484
clear archiving marker 98
clear local cache 209
cloud authentication
configuration 549
co-authoring 100, 103
collection members 124
comments 108
common rule 200
compare document content 111
counter-specific settings 193, 206
concurrent editing 99
configuration
add 551
modify 551
configurations
advanced vault settings 556, 645
custom vault data 559
export 554
import 555
connection status 38
connections to external locations 327
convert to multi-file document 71
convert to single-file document 71
copy a document vault 291
create
document 67
object 67
Created
timestamp 717
custom vault data 559

d
data set 588
data type 153
database engine
Firebird 275, 278, 678
Microsoft SQL Server
file data location 286
database insert speed 358
default search filters 149
default vault language 324
delete a vault 306
DELETE statement 422, 445
destroy 98
destroy a vault 306
detach 296
detect duplicate files 59
digest message 200
document
collection 7
deleted document 151
file 60
document collection 124
Document Compare 111
document comparison 111
domain 187
duplicate content 59
duplicate file 59

E

electronic signature 531, 535
Electronic Signatures and Advanced Logging module 223
email integration 97
event handler
  execution order 623
Excel
  insert property 116
  M-Files functions 115
export
  export results of views or searches 185
Export languages 319
external object
  refresh 212
external repository
  log in 635
  log out 635
external source
  delete 346
external sources
  e-mail source 348, 693
  linked document 677
  metadata 330

F

facet search 149
facet search 149
FDA 21 CFR Part 11 223, 275
file data location 286
filters tab 137

G

getting started 11
go offline 127
go online 128
ground link
  configuration 640, 641, 644
  proxy 640, 641, 644
grouping level
  reference direction 658

H

hit highlighting 137
home screen 38
hotkeys 56

I

ID
  external ID 694
  internal ID 694
  original ID 694
IMAP
  folder 693

IML 625
import languages 322
indexing views 177
indirect view 170
individual ID 151
inherited property definitions 481
INSERT INTO statement 422, 445
installation 234
intelligence service
  metadata suggestions 695
Intelligent Metadata Layer
  architecture 625
  connector
    add 630
    authentication 634
    configuration 549, 631
  external repository
    authentication 634
  external repository user
    add 628
    configuration 549, 629
    promote 637
interactions between vaults 399
iOS 54
IP address 187, 247

K

keyboard shortcuts 56

L

language
  select 323
  software 208, 323
  vault 208, 323
license
  management 250
link path 129
listing 41
listing area 15, 38, 41
log in 37
log out 37
logging in automatically 187
login account
  change login account 259

M

M-Files Admin 245, 247
M-Files authentication 187
M-Files Desktop
  launch 13
  open 13
  settings 186
M-Files flag 98
M-Files Server
  deployment options 217
  named value settings 645
  registry settings 645
<table>
<thead>
<tr>
<th>M-Files URL 129</th>
</tr>
</thead>
<tbody>
<tr>
<td>M-Files Web</td>
</tr>
<tr>
<td>appearance 581</td>
</tr>
<tr>
<td>make copy 89</td>
</tr>
<tr>
<td>mark for archiving 98</td>
</tr>
<tr>
<td>master database</td>
</tr>
<tr>
<td>back up 268</td>
</tr>
<tr>
<td>restore 271</td>
</tr>
<tr>
<td>measuring vault performance 358</td>
</tr>
<tr>
<td>menu view 185</td>
</tr>
<tr>
<td>metadata</td>
</tr>
<tr>
<td>external source 330</td>
</tr>
<tr>
<td>structure 405</td>
</tr>
<tr>
<td>suggestions 43, 627</td>
</tr>
<tr>
<td>metadata card configuration 549, 562</td>
</tr>
<tr>
<td>option ribbon 43</td>
</tr>
<tr>
<td>prevent toggle location 648</td>
</tr>
<tr>
<td>preview 43</td>
</tr>
<tr>
<td>metadata definition 402</td>
</tr>
<tr>
<td>Microsoft Office 115</td>
</tr>
<tr>
<td>mobile access 576</td>
</tr>
<tr>
<td>mobile app 54</td>
</tr>
<tr>
<td>multi-file document MFD 71</td>
</tr>
<tr>
<td>multi-language metadata structure 314</td>
</tr>
</tbody>
</table>

N

NACL |
| create 541 |
| named access control list create 541 |
| named value storage 559 |
| network name 187, 247 |
| notification personalization 566, 566 |

O

object |
| conflict 403 |
| create 73, 75 |
| deleted object 98 |
| history 109 |
| managed 637 |
| pinning 50 |
| type 407 |
| unmanaged promote 637 |

object type |
| external 422, 428, 445, 449 |
| refresh 428, 449 |

OCR 77, 343

OCR module 335

OCR value source 335

ODBC 422, 445

office for the web editor 578

office online 578

offline mark for offline availability 126

remove offline availability 126

offline filter 126

OLE DB connection string 422, 445

online 310

operating system 225

operator 153

Outlook folder 94
rule 92
Send and Save to M-Files 657

P

paginated listing 41

pagination 41

password change password 209

PDF conversion locale 675
settings 667

performance configuration options 679

permissions automatic 275, 436

effective 82

metadata-driven permissions 275

restriction 82

pinned 38, 50

pinning items 50

placeholder 564

POP3 348

PowerPoint insert property 116

M-Files functions 115

pre-shared key 222

property edit multiple 65
toolbar 64

property definition create 456
data type date 451

number (integer) 451

number (real) 451

protocol 247

public link configuration options 654

publication settings 578

Q

quick search 140, 143, 660

R

redlining enabling 275

using 106

relationships 120

replace with file 78
replication
  export 361, 367
  import 372
  schedule 382
report access identity 592
report URL 594
reporting data services 588
reports 586
restore document vault 300
right pane 38
roll back 109
round-trip time to the database server 358

S
sample vault 234
scanning 77
scheduled 260, 261
scripting
  execution order 623
search
  additional conditions 150
  advanced search 146
  boolean 140
  criterion 98
  filter 148
  Filters tab 146
  fuzzy 659
  grouping search results 165
  indirect search 140
  operators 140, 143
  phonic 659
  quick search
    inflected forms 661
  refinement 148
  results
    sorting 662
    search bar 38
  search results in other vaults 137
  subordination of search criteria 140
  synonym 140, 660
  wildcard 140, 143
search filters 149
search index
  backup 303, 303, 303
  dtSearch 303, 670
  file format 670
  IDOL 303, 670
  Micro Focus IDOL 670
search refinements 148
search result sorting 137
searchable PDF 343
SELECT statement 422, 445
send by E-mail 129
send check-in request 99, 688
setup 234
share
  e-mail 135
  public link 133
  share public link 133, 654
shortcuts
  metadata card 50
single-file document
  SFD 71
space requirements 225
substitute user 207
support 726
system administrator 167, 253
system administrator permissions 556
system administrator versus vault administrator 253
system requirements 225

T
take offline 310
task area 15, 38, 52
temporary local files 167
terminology 7
text recognition 77, 343
traditional folder 185
transferring files to M-Files 60
translate object titles 324
translation 314

U
undelete 98
update
  manually 242
UPDATE statement 422, 445
user
  external repository user 503
  external repository user group 506
  logging in as a different user 38
  new user 492
  pseudo-user 84
  user from metadata 84
  user group 498, 724
user interface 15
user vault language 324
user-specific settings 191

V
validating property values 468
validation 468
value list
  contents 433
  external refresh 428, 449
  icons for value list items 433
vault
  access 13, 222
  attach 294
  authentication 289
  backup
    Microsoft SQL Server 283
  connection 187
  copy 291
  create 273
delete 306
destroy 306
detach 296
language 208, 323, 324
maintenance 312
operation 273
performance 358, 679
vault administrator permissions 556
VBScript
  variables 616
version compatibility 212, 235, 242
version number 728
view
  Common Views 41
  External Views 41
  My Views 41
  Other Views 41
  quick view 38
view hierarchy 451
virtual folder 179
virus scanning 220
VPN 222

W

web access 576
web publication 578
whitelist 670
wildcard 153
Word
  insert property 116
  M-Files functions 115
workflow
  state 515
workflow assignment 518